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WILLKOMMEN

Willkommen

Willkommen bei der Adobe FrameMaker-Hilfe. Machen Sie sich in folgenden Kapiteln mit allen Details
von FrameMaker vertraut:

. Erste Schritte

. Grundlagen in FrameMaker

. Seitenlayout und Vorlagen

. Bearbeiten von Inhalten

. Tabellen

. Grafiken und Objekte

. Projekte, Biicher und lange Dokumente
. Inhalte aus Einzelquellen

. Review und Zusammenarbeit

. Strukturiertes Authoring

. Strukturiertes Authoring mit DITA
J Drucken und Verdffentlichen

e  Ubersetzung

o Content Management-Systeme

. Scripting in FrameMaker

J Anhang

. Rechtliche Hinweise




ERSTE SCHRITTE

Erste Schritte

Beginnen Sie, mit FrameMaker zu arbeiten, und erfahren Sie mehr tber die leistungsstarken Funktionen,
die FrameMaker Ihnen fiir Authoring und Veroéffentlichung von Inhalten bietet.

Adobe FrameMaker ist eine Komplettlésung zum Erstellen von Inhalten, die auch fiir komplexe Autore-
numgebungen und hohe Anforderungen an die Veroffentlichung geeignet ist.

Bevor Sie die Arbeit mit FrameMaker beginnen, nehmen Sie sich einen Moment Zeit, um sich mit dessen
Leistungsumfang und den Einzelheiten der Installation, Aktivierung und Registrierung vertraut zu

machen. Zusatzlich zu den Informationen in diesem Handbuch stehen lhnen Videoanleitungen, Plug-Ins,
Vorlagen, Benutzercommunitys, Seminare, Lehrgange, RSS-Feeds und vieles mehr online zur Verfligung.

Um auf eine Vielzahl von FrameMaker-Ressourcen zuzugreifen, besuchen Sie die FrameMaker-Hilfe.
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WASs IST FRAMEMAKER

Was ist FrameMaker

FrameMaker ist eine vielseitige Lésung, mit der Sie strukturierte oder vorlagenbasierte Dokumente
erstellen, mehrere Content Management-Systeme fiir Reviews und Zusammenarbeit nutzen und Doku-
mente auf einer Vielzahl von Geraten veroffentlichen kénnen.

In diesem Thema

Einfiihrung

Inhalt erstellen und optimieren
Verwalten und zusammenarbeiten
Veréffentlichen auf mehreren Kandlen
Unterstlitzte Software

Einfihrung

Wenn Sie eine flexible Losung suchen, die all Ihre Wiinsche hinsichtlich Erstellung und Veroffentlichung
von Inhalten erfiillt, werden Sie bei FrameMaker flindig:

Ob Sie durchstrukturierte Dokumente erstellen oder auf Vorlagen zurlickgreifen mochten, Sie
finden in FrameMaker fiir alle Falle leistungsstarke und benutzerfreundliche Tools, die Einzelnut-
zern und Teams die Arbeit enorm erleichtern.

Mit den erweiterten Review- und Zusammenarbeit Funktionen in FrameMaker, kdnnen Sie Uber-
prifungskommentare nahtlos integrieren und beantworten.

Sie kdnnen mit FrameMaker mihelos Dateien in Adobe Experience Manager, OpenText Docu-
mentum, Microsoft, DitaExchange oder ein anderes Content Management System lhrer Wahl
einbinden.

Dank umfassender Veréffentlichungsoptionen konnen Sie Ihre Inhalte fiir verschiedenartige Gerate
anpassen und an diese senden.
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WASs IST FRAMEMAKER

Inhalt erstellen und optimieren

Wahrend bestimmte Dokumente strukturiertes Authoring erfordern, konnen Sie flir andere Dokumente
den Modus fiir freies Gestalten verwenden. Grafiken, Tabellen und Objekte der ersten Schritte sind nur
einige Verfahren, mit denen Sie Inhalte weiter aufwerten kénnen. FrameMaker bietet Flexibilitat bei der
Auswahl des Authoring-Modus kann mit verschiedenen Optionen zur Optimierung der Inhalte
aufwarten.

fm | .book | .mif
Unstrucured s
Authoring f
fm
Structured
FrameMaker
Structured

xml
Fm Structured
- Create Structed applications FrameMaker

- Manage Templates
- Publish

Verwalten und zusammenarbeiten

Geschwindigkeit und Genauigkeit sind wichtig fiir die Gewahrleistung von Aktualitat und Relevanz des
Inhalts. Sie haben mehrere Méglichkeiten zur Uberpriifung des Inhalts und zur Sicherstellung einer
reibungslosen Zusammenarbeit der Teammitglieder. Verwenden Sie entsprechend den jeweiligen
Anforderungen Anderungsleisten, aktivieren Sie die Verfolgung von Textianderungen oder richten Sie
gemeinsame PDF-Reviews ein. Sie kdnnen mit FrameMaker auch direkt auf Content-Manage-
ment-Systeme zugreifen und Elemente hochladen.
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Manager

H> SharePoint

opentext” | Documentum

Ausfiihrliche Informationen finden Sie unter Strukturiertes Authoring.

Veroffentlichen auf mehreren Kanidlen

Die heutigen Anforderungen an das Veroffentlichen von Inhalt zwingen zur Unterstiitzung einer stetig
steigenden Zahl von Formaten und Geraten. FrameMaker erfiillt auch komplexe Anforderungen an die
Veroffentlichung und erweist sich dabei als duerst benutzerfreundlich und effizient. Sie kénnen neben
anderen Formaten auch PDF-Dokumente, Responsive HTMLS5, oder eine Ausgabe fiir Kindle-Gerate
generieren. Sie konnen aullerdem lhre Ausgabe anpassen, indem Sie die Stile und Designs dandern,
Vorlagen festlegen, die Codierung aktivieren oder Suchoptionen fiir den Inhalt einrichten. Erstellen Sie
in einem Zug ein einzelnes Outputformat oder mehrere Formate.
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Ausfiuhrliche Informationen finden Sie unter Verdffentlichung auf verschiedenen Kandlen.

Unterstiitzte Software

FrameMaker-Workflows unterstiitzten die folgende Software:

. Microsoft® Word 2013, 2010 oder Office 365 (nur aus Office 365 heruntergeladenes Dokument)
. Acrobat Desktop Application Versionen Xl, Pro (Ausgabe 2017), neueste Version

L OpenText EMC Documentum

. Microsoft® SharePoint Online oder 2013

. Microsoft SharePoint Online

] Adobe Experience Manager 6.5, 6.4 oder 6.3

. Adobe XML Documentation fiir Adobe Experience Manager




AUTHORING-MoODI

Authoring-Modi

Lernen Sie die verschiedenen Authoring-Umgebungen in Adobe FrameMaker fiir unstrukturierten und
strukturierten Inhalt (XML-Bearbeitung) kennen und wie Sie zwischen ihnen wahlen kénnen.

In diesem Thema

. Einftihrung

. Wadhlen Sie einen Authoring-Modus aus

. FrameMaker-Modus

. Strukturierter FrameMaker-Modus

Einfuhrung

Adobe FrameMaker bietet folgende Authoring-Modi:
. FrameMaker-Modus

. Strukturierter FrameMaker-Modus

J XML-Quellcode-Editor

Je nachdem, ob Sie den strukturierten oder unstrukturierten Ansatz fiir die Inhaltserstellung wahlen oder
XML-Quellcode bearbeiten mochten, kénnen Sie einen geeigneten Authoring-Modus fir lhre Inhalte
auswahlen.

Waihlen Sie einen Authoring-Modus aus

Beim ersten Starten von FrameMaker, ist der Standarderstellungsmodus auf strukturierten FrameMaker
festgelegt. Sie konnen den Modus im Dialogfeld Voreinstellungen andern:

1)  Waihlen Sie Bearbeiten > Voreinstellungen, um das Dialogfeld Voreinstellungen zu 6ffnen.
2)  Wabhlen Sie im Dialogfeld Voreinstellungen die Optionen Global > Allgemein.

3) Inder Dropdown-Liste Produktoberfliche wahlen Sie den FrameMaker-Modus aus und klicken
dann auf OK.

Sie werden aufgefordert, FrameMaker neu zu starten, damit die Voreinstellung wirksam wird.

Die FrameMaker-Benutzeroberfliche erméglicht einen nahtlosen Ubergang zwischen unstrukturiertem
und strukturiertem FrameMaker-Authoring. Die Menlioptionen und anderen Elemente der Benutzer-
oberflache sind zwischen beiden Modi konsistent. Die Optionen hangen jedoch vom Modus ab, in dem
Sie gerade arbeiten.
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The section provides general background information about the
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Der FrameMaker-Modus ist flir das Authoring von Inhalt geeignet, der nicht an eine starre Struktur
gebunden ist. Das stilbasierte Authoring beruht auf einer Vorlage zur Definition der Inhaltsdarstellung.
Absatze, Zeichen, Tabellen und andere Objektstile basieren haufig auf Stilvorgaben und Schreibregeln
seitens der Redakteure. Sie, als Autor, entscheiden Uber Textfluss und Formatierung. Beispielsweise
kénnen Sie, je nach Art lhres Inhalts, nach Uberschriften Absitze oder Grafiken folgen lassen. Dies
bedeutet, dass in einem unstrukturierten Authoring-Workflow relativ frei angelegte Dokumente erstellt
werden, die grolRtenteils auf Stilen basieren.

Ein typischer Workflow fir Standard-Authoring in FrameMaker umfasst folgende Aufgaben:

. Erstellen Sie einzelne Dok

umente.

. Stellen Sie mehrere Dokumente zu einem Buch zusammen.
o Geben Sie an, wie Inhalt angezeigt wird, indem Sie Absatz-, Zeichen-, Tabellen- und Objektstile

definieren.

. Erstellen Sie Vorlagen mit vordefinierten Stilen, die von mehreren Autoren gemeinsam genutzt

werden konnen.

o Verwenden Sie das Dokumentfenster, um den Inhalt zu erstellen.
. Arbeiten Sie in einem der unterstiitzten Formate: Standarddokumente (. £m), Maker Interchange

Format-Dokumente (.mi

HINwEIS: Im FrameMaker-Modus kdnnen Sie XML- und strukturierte Dokumente nicht 6ffnen.

£) und Bicher (.book).
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Verwenden Sie den strukturierten FrameMaker-Modus fiir Dokumente, die einer Struktur folgen
mussen. Die Struktur wird durch die verfligbaren Elemente und Attribute sowie die giiltige Position
dieser Elemente in der Struktur definiert.

Jeder Teil eines Dokuments (z. B. Absédtze, Abschnitte, Themen und Tabellen) wird als Element ange-
geben. Wenn Sie ein strukturiertes Dokument erstellen, miissen Sie sicherstellen, dass jedes Element an
einer strukturell gliltigen Position vorhanden ist. Strukturiertes Authoring stellt die Konsistenz der
Struktur zu dhnlichen Materialien sicher.

Im Folgenden finden Sie einige Beispiele fiir strukturelle Regeln:

J Eine Liste mit Auszeichnungspunkten muss mindestens drei Elemente enthalten.

. Ein Abschnitt muss mit einer Uberschrift beginnen.

. Nach einer Uberschrift muss ein Absatz folgen.

J Eine Tabelle muss eine Kopfzeile aufweisen.

J Eine Grafik muss eine Beschriftung aufweisen.

Ein typischer Workflow fir strukturiertes Authoring in FrameMaker umfasst folgende Aufgaben:

J Erstellen Sie einzelne strukturierte Dokumente oder schlieBen Sie Dokumente in eine DITA Map
oder ein Buch ein.

] Verwenden der vorhandenen strukturierten Samples oder Erstellen einer benutzerdefinierten
Struktur, die auf EDDs oder DTD-Dateien basiert.

. EinschlieRen der richtigen Elemente, um den Textfluss des Inhalts zu definieren. Einige Elemente
enthalten auch Formatierungsinformationen, die Sie zum Festlegen von Stilen verwenden kénnen.
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. Die zugrundeliegende Struktur stellt die Konsistenz der Inhalte in einer Multiautorenumgebung
sicher.

. Verwenden Sie den Katalog Elemente oder Tastenkombinationen, um neue Elemente fiir Text,
Bilder, Tabellen und andere Objekte einzufligen.

. Verwenden Sie die Strukturansicht, um durch Ihr Dokument zu navigieren und Elemente zu
verschieben. Die Strukturansicht zeigt auch die Glltigkeit des Dokuments bezliglich der zugrunde-
liegenden Struktur an.

. Arbeiten Sie in einem der unterstiitzten Formate: strukturierte Dokumente (. £m), XML-Doku-
mente (.xml, .dita)und Bicher (.book, .ditamap).

Sehen Sie sich das Video Einfuhrung in strukturierten FrameMaker an.

HINwEIS: AulRerdem haben Sie die Moglichkeit, mit unstrukturierten Dokumenten im strukturierten
Modus zu arbeiten. Alle Funktionen des FrameMaker-Modus sind im strukturierten Modus verfligbar.
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Neue Funktionen in Adobe FrameMaker

Erfahren Sie, welche Neuerungen in Adobe FrameMaker (Release Sommer 2020) enthalten sind.

Adobe FrameMaker bietet eine Reihe neuer Funktionen, Updates und Verbesserungen. In diesem Thema
erhalten Sie eine Ubersicht zu allem, was sich in der Hauptversion von FrameMaker geindert hat. Im
GroBen und Ganzen weist dieses Release von FrameMaker neue Funktionen und Verbesserungen in fast
allen wichtigen Bereichen auf, wie Plattform, Authoring, Inhaltsmigration, Erstellen von Inhalten mithilfe
von Rich Media, Online-Uberpriifung, Ubersetzung und Verdffentlichung.

Tipp: Schauen Sie sich auch dieses Einfiihrungsvideo zu FrameMaker an.
Werfen wir einen Blick auf die Anderungen in der neuesten Hauptversion von FrameMaker:
Aktualisierte Bibliotheken fiir hohere Stabilitat

Die Hauptversion von Adobe FrameMaker unterstiitzt Windows 10 auf einem 64-Bit-System. Die Kern-
bibliotheken von FrameMaker wurden um die neuesten Adobe- und Open-Source-Bibliotheken
erweitert. Mit dieser Erweiterung erhalten Sie eine deutlich verbesserte Leistung bei der Erstellung und
Veroffentlichung Ihrer groBen Dokumente. Diese Verbesserung bringt auch mehr Stabilitat mit weniger
Abstlirzen und Schutz vor haufig auftretenden Risiken.

Figure 1: FrameMaker benétigt Windows 10 mit 64-Bit-System
Neue Navigationsansicht fiir FrameMaker-Dokumente

Beim Authoring ist es hilfreich, die Gesamtstruktur des Dokuments zu kennen, an dem Sie arbeiten.
Durch ein langes Dokument zu scrollen bietet diese Informationen, ist jedoch keine nahtlose Erfahrung.

FrameMaker bietet eine einheitliche Ansicht der Uberschriften oder der Struktur Ihres aktuellen Doku-
ments. Offnen Sie die neue Navigationsansicht, und die Struktur des aktuellen Dokuments wird im Navi-
gationsansichtsfenster angezeigt. Diese Funktion wird derzeit nur fir auf Stilen basierende
FrameMaker-Dokumente unterstiitzt. Die in diesem Feature verwendete Logik zeigt Ihnen eine Liste aller
Uberschriften und Unteriiberschriften in lhrem Dokument an.

Sie starten die Navigationsansicht Gber Ansicht > Fenster > Navigationsansicht oder mit der Tastenkom-
bination Esc n v.

12


http://www.adobe.com/go/learn_fm_16_intro_de

NEUE FUNKTIONEN IN ADOBE FRAMEMAKER

EDITING CONTENT
TEXT AND SPECIAL CHARACTERS

g Navigation View =
\ L Search by Headings |
KEYWORDS: EDIT CONTENT IN FRAMEMAKER +
DESCRIPTION: LEARN HOW TO EDIT CONTENT IN FRAMEMAKER 4 Editing content
FrameMaker provides you with a yarietvafontions-and-taotstora Text and special characters
add graphics, images, tables, and i Ppandi] + Add text and special characters
equations and QR codes. Collapse All

= Copy, move, and delete text
Select Heading And Content

« Drag and drop text
Delete J P

rTeXt and SpEClaI chara Importing and linking files

Equations
Markers

KEYWORDS: ADD TEXT, ADD SPECIAL CHARACTERS, DISPLAY PARAGRAPH SYMBOL

DESCRIPTION: KNOW HOW TO ADD TEXT AND SPECIAL CHARACTERS TO THE DOCUMEN

As an authoring environment, FrameMaker provides you will the |t Hypertext commands

special characters) to a document. While text includes the standar Multiple Undo/Redo
numbers, you can also enter characters such as tab, bullet symbols Search

Add text and special characters |

Figure 2:  Navigationsansicht mit Kontextmenii

Wenn Sie in der Navigationsansicht auf eine Uberschrift klicken, gelangen Sie zum Uberschrifteninhalt.
Mit dem Kontextmenii navigieren Sie schnell zum Ein- bzw. Ausblenden von Themen oder |6schen sogar
eine ganze Uberschrift (oder ein Thema) aus dem Dokument.

Weitere Informationen finden Sie unter Navigationsansicht.
Schauen Sie sich ein Video zur Navigationsansichtsfunktion an.
YouTube-Videos einfiigen

YouTube ist eine der am hdufigsten verwendeten Plattformen zum Speichern und Teilen von Videos.
Wenn Sie alle lhre Produktvideos in einem YouTube-Kanal verwalten, kénnen Sie diese Videos ganz
einfach lhren Inhalten hinzufiigen.

Mit der Funktion zum Einfliigen von Onlinevideos kdnnen Sie YouTube-Videos in FrameMaker-Doku-
mente, DITA- oder LwDITA-Dokumente einfligen. Um ein YouTube-Video einzufligen, gehen Sie zu
Einfligen > Multimedia > Onlinevideo und geben die URL Ihres YouTube-Videos an.

B ' Online Video X

URL or Embed HTML.:

https:/fwww.youtube.com/watch?v=6QvGCz_EAsU

Insert Cancel

Figure 3:  Einbetten von YouTube-Videos
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Wenn Sie eine PDF- oder Responsive-HML5-Ausgabe generieren, wird ein Link zum YouTube-Video auch
in die Ausgabe (bernommen. Wenn Sie auf den Link klicken, wird das Video in der HTML5-Ausgabe
ausgespielt bzw. bei PDF-Ausgaben wird das Video im Standardbrowser wiedergegeben.

Weitere Informationen finden Sie unter YouTube-Videos einfiigen.
Schauen Sie sich ein Video zum Einbetten von YouTube-Videos an.
Sprachspezifische typographische Anfiihrungszeichen

FrameMaker ist eine mehrsprachige Authoring- und Veroffentlichungslosung. Es kommt haufig vor, dass
ein einzelnes Dokument in mehreren Sprachen erstellt und veréffentlicht wird. Jede Sprache hat eigene
spezifische Syntax, Semantik und alphabetische Systeme. Um lhnen eine bessere Kontrolle tber die
Erstellung zu geben, kdnnen Sie mit FrameMaker sprachspezifische typographische Anfiihrungszeichen
angeben.

Sie kdnnen die einzelnen und doppelten Anfiihrungszeichen definieren, die FrameMaker wahrend der
Erstellung verwenden soll. Im FrameMaker-Dialogfeld ,Voreinstellungen” wurde ein neuer Satz von
Einstellungen fir typographische Anflihrungszeichen eingefiihrt, mit dem Sie die Anflihrungszeichen fiir
Ihre Sprache angeben kdnnen. Mdchten Sie auf die Einstellungen fir typographische Anfliihrungszeichen
zugreifen, gehen Sie zu Bearbeiten > Voreinstellungen > Rechtschreibung > Typographische
Anfiihrungszeichen. Nach der Definition Gbernimmt FrameMaker die Anfiihrungszeichen, die Sie fir Ihre
Sprache festgelegt haben, aus den Einstellungen fiir typographische Anfiihrungszeichen oder derim
Absatzstil festgelegen Sprache.

Preferences X
= Global Smart Quotes Settings
i----GeneraI 1 Arabic N
~Graphics Single Quote o
~Interface Double Quote «»
Alerts —| Bulgarian
Launch Single Quote
- Dropbox Double Quote
©CMS = C.atalan
. Single Quote
T Sipelhng Double Quote
~Dictionary —| Chinese (Simplified)
Single Quote
~Spelling Options Double Quote
XML —| Chinese (Traditional)
MathML Single Quote
Double Quote
—| Croatian
Single Quote
Double Quote
—| Czech
Single Quote
Double Quote - v
OK Cancel

Figure 4:  Einstellungen fir typographische Anfiihrungszeichen im Dialogfeld ,Voreinstellungen”

Weitere Informationen finden Sie unter Anfiihrungszeichen.
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Schauen Sie sich ein Video zum Verwenden sprachspezifischer typographischer Anfihrungszeichen an.
Formatierung von GroR-/Kleinschreibung des Satzes

StandardmaRig bietet FrameMaker viele Textformatierungsfunktionen, mit denen Sie lhre
FrameMaker-Dokumente schnell erstellen kénnen.

TTTI%TT%abAbABAb

Figure 5:  Option fur die GroR-/Kleinschreibung in Sdtzen in der Symbolleiste , Textformatierung”

Sie kdnnen einfach den Text auswahlen und Formate lhrer Wahl mit einem Klick anwenden. Formate wie
etwa fett, kursiv, Herauf- oder Herabsetzen der SchriftgroRe, Wechsel von GroR-/Kleinschreibung und
anderes sind in der Symbolleiste , Textformatierung” verfligbar.

Mit der Hauptversion von FrameMaker kénnen Sie ganz einfach die GroR-/Kleinschreibung in Satzen auf
ausgewahlte Satze oder Absatze anwenden. Die GroR-/Kleinschreibung in Satzen und andere Textfor-
matierungsoptionen sind in der Symbolleiste , Textformatierung” verfiigbar. Um die Symbolleiste ,Text-
formatierung” zu 6ffnen, wahlen Sie Ansicht > Symbolleisten > Textformatierung.

Intelligentere FuBnotenverarbeitung

Sollten Sie mit vielen FuRRnoten arbeiten, werden Sie sich liber die Verbesserung der neuesten
FrameMaker-Version freuen. Wenn in lhrem Dokument mehrere FuRnoten vorhanden sind, nutzt
FrameMaker den verfligbaren Platz auf der Seite intelligent, um so viele FuRnoten wie moglich unter-
zubringen. Wenn auf der Seite kein Platz mehr vorhanden ist, verschiebt FrameMaker die FulRnote
automatisch auf die nachste Seite und setzt die FuBnotennummerierung zuriick, um eine korrekte
Referenz sicherzustellen. Unabhangig davon, ob Sie an einem ein- oder mehrspaltigen Dokument arbe-
iten, werden lhre FuRnoten korrekt in der jeweiligen Spalte angezeigt. Die FuRnoten und ihre Quellver-
weise befinden sich nun in der gleichen Spalte.
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WelcomeScreen X GeneralDescription.fm X

Tip: Click any of the formatted Animations: Show Animatior

terms t th t = 7
SRS S0 SEERIRESIDONRT Major Components: Rear Wall, Propeller, Cylinder, Crankcase,

highlighted in theillustration= F - —13]
i A Cylinder Head, Spinner, Intake, Cam Housing?

Views: Default, Left, Right, Front, Back, Bottom*

1. Footnote in colufmn 1 )
2. Sample footnote two |
3. Sample footnote three
| 4. Sample footnote four

4/23/20 83-3844-8 |5 |

Figure 6: Intelligentere FuRnotenverarbeitung

Weitere Informationen finden Sie unter Erstellen und Bearbeiten von Fufsnoten.
Schauen Sie sich ein Video zur intelligenteren Fulinotenverarbeitung an.
Aufteilen von Dokumenten in Kapitel

Jedes Mal, wenn Sie Inhalte von einer Plattform auf eine andere migrieren, besteht die erste Heraus-
forderung nach dem Importieren darin, den migrierten Inhalt zu teilen. Das Aufteilen groRer Dokumente
kann lange dauern. Mit der Hauptversion von FrameMaker kdnnen Sie diese komplexe Aufgabe in
wenigen Minuten erledigen.

Nachdem Sie Ihre Inhalte in FrameMaker importiert haben, starten Sie die Funktion zum Teilen des Doku-
ments mit Datei > Dienstprogramme > Aktuelles Dokument teilen, um lhre langen Dokumente einfach
aufzuteilen. Mit dieser Funktion kdnnen Sie jeweils an einer Datei arbeiten, wodurch Sie mehr Kontrolle
Uber den Aufteilungsprozess haben. Sie konnen ihr Dokument auf der Grundlage von Markierungen oder
Absatzformaten aufteilen.

Es gibt auch eine Vorschaufunktion, die Ihnen zeigt, wie die endgiiltige Ausgabe generiert wird. Sollten
Sie mit der vorgeschlagenen Struktur unzufrieden sein, konnen Sie Themen auch zusammenfiihren oder
aufteilen. So konnen Sie genauer bestimmen, wie das endgiiltige Buch und die Kapitel generiert werden
sollen.
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Split a document X Split a document X

Seurce document | GeneralDescription.fm = GeneralDescription.book

~1.fm
Create a new book =) History of flight.fm

Create in folder C:\Kuldip\Data\Work\temp\Fm-2020\sample-docs\Unstructure | .. | ~Overview
*Vehicle structure.fm

Characters in file names Split a document
Whitespaces in file names

Select a custom marker | Split
) : « - AND --

Special characters in file names (e.g. *,\, etc.)
Selected paragraph formats
DT_DefinitionTerm
FC_FigureCaption
FF_FigureFrame

Next FN_Footnote Remove from file-list

H2_Heading2 [ Vehicle structure | [fm Rename document
H3_Heading3
HB_HeadingBook Back Start the split

L1_ListLevel01_Begin
L1_ListLevel01_Continue
L2_ListLevel02
NC_Caution -

Back Analyse

Figure 7:  Konfigurieren der Dokumentenaufteilungsfunktionen

Weitere Informationen finden Sie unter Teilen grofier Dokumente.
Schauen Sie sich ein Video zum Aufteilen von Dokumenten in Kapitel an.
Verbesserte Rechtschreibpriifung und Satzzeichenkorrektur

FrameMaker ermdglicht IThnen sogar die Kontrolle iber Details wie die Einfligung von Leerzeichen vor
oder nach Satzzeichen oder Sonderzeichen. Mit noch besserer Verarbeitung von Leerzeichen und
Zeichensetzung ist die Rechtschreibpriifung genauer als zuvor. Bei der Rechtschreibprifung wird die
Zeichensetzung dort berlcksichtigt, wo andernfalls ein falsches Wort gemeldet wiirde.

Figure 8: Bessere Rechtschreibpriifung
Weitere Informationen finden Sie unter Rechtschreibhilfe.
Schneller Zugriff auf Maps und Buchdateien

Im Buchfenster wird die Liste der Dateien angezeigt, die Teil des Buches sind. Sie kénnen mehrere Biicher
(.book)undDITA Maps (. ditamap)in derselben Sitzung 6ffnen. Wenn Sie drei oder mehr Buchdateien
offnen, Giberlappen sich die Buchregisterkarten. Bei sich (iberlappenden Registerkarten kdnnen es Ihnen
Blcher mit ahnlichem Anfang ein wenig erschweren, das richtige Buch zu finden.
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In FrameMaker kénnen Sie miihelos mit nur einem Klick zum richtigen Buch navigieren. Klicken Sie im

Buchfenster auf das Symbol = und die Liste aller in der aktuellen Sitzung gedffneten Biicher oder
Map-Dateien wird angezeigt. Wahlen Sie das Buch oder die Map-Datei in der Liste aus, um den Fokus auf
dieses Buch/diese Map zu verlagern.

File Edit View XSLT CMS Window Help

WelcomeScreen X | ¢ adiust the <ea

| UserGuide. m_generald{ m_operating m_systems.ditamap = Close
Ll | b
E‘i D @ D-[g 1 3 ?G p Close Tab Group al'
=B systems UserGuide.book
2 systems xml m_generaldescription.ditamap
Slc escape_system.xml m_operatinglimitations.ditamap te
~@c_launch_pad_escape.xml ¥ m_systems.ditamap
" @c_cabin_escape.xml UserGuide_master.ditamap )
c_landing_escape.xml ——
il c_crew_and_passenger_system.xml Current ve
~kc_hygiene.xml
~@c_sleep.xml RECENT FILES PrOd uc
= c_landing_system.xml )
- Bc_landing_gear.xml UserGuide book Click to fill
-lic_braking xml using-framemaker-201...
L D R (O [ S | R Create

Figure 9: Registerkartengruppen-Meni im Buchfenster
Gleichzeitige Dokument- und Buchansicht fiir DITA Maps

Wenn Sie zur Dokumentansicht Ihrer Map-Datei wechselten, war die Buchansicht oder die Ansicht der
DITA Map-Dateien nicht mehr vorhanden. Dann hatten Sie keine Informationen Uber die Dateien in Ihrer
DITA Map. Viele von Thnen mochten Aktualisierungen in einer DITA-Map-Datei mit der Dokumentansicht
vornehmen und wiinschen sich auch, dass die Liste der Dateien in Ihrer Map gleichzeitig verfigbar ist.

Mit FrameMaker konnen Sie in der Dokumentansicht arbeiten, wahrend Sie die Buch- oder
DITA-Map-Ansicht beibehalten. Dies bedeutet, dass Sie jetzt an allen Ansichten arbeiten kénnen —
WYSIWYG, Dokumentenansicht oder XML-Ansicht gleichzeitig —, ohne die Buchansicht zu verlieren.
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B File Edit View XSLT Window Help QUNE  xMustuctured » L= =] X
UserGuide master.ditamap % r_launch and landing site.xml X | #
m ide_master.ditamap -
BERRBIRE"ER R A 22
=@ Personal Spaceship Operations Manual ';"”‘
[ Cover\personal_spaceship_operations_manual.xml - 9|
i Legailegalxm Personal Spaceship Ope
[ Contacts\contacts.xml oo
1 GeneralDescription\m_generaldescription.ditamap * (Cover/personal_spaceship_ -
13 Systems\m_systems.ditamap LaunCh and Iandlni i
[2 OperatingLimitations\m_operatinglimitations.ditamap » (Legalllegal.xml) 3:;
* (Contacts/contacts.xml) Ensure the launch site meets minimun Ill
i Vicw [ = . (GeneralDescription,’m_gene . The launch site must meet physit
il .
O search by Element Name, Attribute or Content @ « (Systems/m_systems.ditamz - atleast5 miles” long;
4 task . z SR L t_adjust_the seat temperature.xml x
* (OperatingLimitations/m_op¢ | o= e Te—r—
- title
K B < »
2 <IDOCTYPE task PUBLIC "-//OASIS//DTD DI
« shortdesc 3 <task id="id_jw4fU6E6dEI5">
4 ctitle>Adjust the seat temperaturec,
s 5 <shortdesc>Everyone likes to have a
4 taskbody 3 comfortable to them and the sea
7 <ctaskbody>
4 context 8 <context)
+ indexterm 9 <indexterm>seat temperature
10 <p>There is a minimum and m:
11 your administrator to el
g 12 </contexty
13 <steps>
14 <step>
ctonc 2 B —
Line:)g | Column:[18 |} DITA_1.3 task > -3 -+

Figure 10: Simultane Dokument-, WYSIWYG- und XML-Ansicht
Schauen Sie sich ein Video zur simultanen Dokument- und Buchansicht fir DITA Maps an.
Unmittelbarer Wechsel zwischen Ansichten

In einer typischen Authoring-Umgebung kénnen Sie gleichzeitig mit verschiedenen Dokumenttypen
arbeiten. Moglicherweise wird ein FrameMaker-Dokument zusammen mit einem strukturierten Doku-
ment gedffnet, und zwar in verschiedenen Ansichten — WYSIWYG oder XML. Die WYSIWYG-Ansicht steht
fur alle Dokumentenarten zur Verflugung, die XML-Ansicht dagegen nur fiir DITA-/XML-Dokumente.
Wenn Sie zur XML-Ansicht wechseln, werden alle Nicht-XML-Dokumente von der Benutzeroberflache
entfernt. Um an ihnen zu arbeiten, missen Sie wieder zur WYSIWYG-Ansicht wechseln. Dieser Wechsel
zwischen Ansichten nimmt einige zusatzliche Sekunden Ihrer Authoring-Zeit in Anspruch.

Mit dem neuen FrameMaker kdnnen Sie nahtlos an verschiedenen Dokumentformaten in verschiedenen
Ansichten arbeiten, ohne ein Dokument aus dem Auge zu verlieren. Dies bedeutet, dass Sie die
XML-Ansicht fur Ihr FrameMaker-Dokument gedffnet haben und auch zu einem unstrukturierten Doku-
ment wechseln konnen, ohne die Ansicht in der Symbolleiste dndern zu miissen. FrameMaker verwaltet
nun die Dokumentansicht auf Dokumentebene. Sie kénnen gleichzeitig an der XML-Ansicht oder
WYSIWYG-Ansicht fur strukturierte oder FrameMaker-Dokumente arbeiten.

Schauen Sie sich ein Video zum unmittelbaren Wechsel zwischen Ansichten an.
Uberlegene Unterstiitzung fiir CSS 3-Stile

Fiir jede FrameMaker-Anwendung enthalt ein Elementdefinitionsdokument oder EDD die Elementdefi-
nitionen, Attributdefinitionen, Formatierungsregeln und andere unterstiitzende Informationen, die das
Einflgen von Elementen regeln.

In den Cascading Style Sheets (CSS) werden die Formatierungsinformationen fiir die Elemente gespe-
ichert. Die meisten erfahrenen Benutzer arbeiten bequem mit CSS, um die Stil- und Formatierungsinfor-
mationen fir ihren Inhalt zu definieren. FrameMaker bietet Ihnen eine erweiterte CSS-Importfunktion,
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mit der Sie Stilinformationen direkt aus CSS importieren kdnnen. Mit der Unterstiitzung der neuesten
CSS 3-Standards erhalten Sie mehr Kontrolle tGber Stil und Prasentation Ihrer Inhalte. Dariber hinaus
kénnen Sie diese CSS 3-Formate direkt in die EDD Ihres strukturierten Dokuments importieren, um
prasentablere und gut aussehende Dokumente zu erstellen.

The CSS File

ph{

font—-family: "Franklin Gothic Demi Cond", "Arial Black", serif;

forit=aize:rx=large; Before Importing the CSS
color:Maroon; o I Cpe
background-color:rgb (254, 254, 216); Fonts tab example

font-style:oblique;

Thisis the short desaription After Importing the CSS

font=stretch:280;

n example of the €553 import.

Thisis a <p>element with <ph> element withi
font-weight :bold; e an s e Fonts tab example

font-variant:small-caps;

sy . The <ph> elem hin the <ul> ele
vertical-align: super; This is the short description.
NOTE: This is a<p> element within <note >, whi

font-kerning: normal; le of the CS53 import
xample of the CS$3 impor

--fm-letter-spacing:10.32126849878325; Thisis a <p> element with <ph> element within it.
o Thisis anunordered list.
--fm-font-variation:Wide; . The
. ELEMENT 1S WITHIN THE
text-decoration=line:line-through,overline,underline; <ph> <ul>

element

text-decoration-style:double; woTE: This is a<p> element within <note, which as

L”,E,,<ph>7£',t EMENT IN I T

Figure 11: CSS-Datei vor und nach dem Import in EDD

Weitere Informationen finden Sie unter XML und CSS (Cascading Style Sheets).
Schauen Sie sich ein Video zur Unterstitzung fur CSS3-Stile an.

Brandneue Strukturansicht

Die Strukturansicht ist eine der am haufigsten verwendeten Funktionen des strukturierten
FrameMaker-Formats. Mit der Hauptversion von FrameMaker wurde diese Funktion weiter verbessert
und ihre Leistung optimiert. Die neue Strukturansicht ist jetzt auch wahrend der Arbeit in der
XML-Ansicht verflgbar. Dies bedeutet, dass die alte Baumstrukturansicht jetzt durch die vollig neue,
funktionsreiche Strukturansicht ersetzt wird.

Mit der neuen und deutlich verbesserten Strukturansicht konnen Sie die folgenden Aufgaben (in der
XML-Ansicht eines Dokuments) ausfiihren:
o Suche nach Element, Attribut oder Inhalt.

. Navigieren Sie mittels Klicken auf ein beliebiges Element in der Strukturansicht durch den
XML-Code.

. Ausschneiden, Kopieren, Einfligen und Loschen von Elementen Giber das Kontextmendi.
] Fligen Sie mithilfe des Kontextmends ein Element vor oder nach einem Element ein.
J Zeigen Sie Attribute in der Strukturansicht an und bearbeiten Sie sie dort direkt.
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QUHE  XMUStructured ~ = B X

WelcomeScreen X t_adjust_the seat temperature.xml X |
task » taskbody » context » indexterm StouctureView =

B <« ?> \,O Search by Element Name, Attribute or Content & |

2 <!DOCTYPE task PUBLIC "-//OASIS//DTD DITA Composite 4 ek

3 <task id="id_jw4fUGE6dEJIS">

4 <title>Adjust the seat temperature</title> - title L |

5 <shortdesc>Everyone likes to have a seat at a s P o

6 comfortable to them and the seat coolness o USRS SERS SRR

Z <Easkbody> » shortdesc —

8 kcontext> | e S Y

3 T Everyone likes to have c at a se

9 <indexterm>seat temperature</indexterm>|

18 <p>There is a minimum and maximum defin| 4 taskbody —

31 your administrator to ensure seats

= | </context>| 4__context

13 (steps> Undo Ctri+Z T [

14 <step> Redo Shift+Z

15 <cmd>Launch your at temperature

16 </step> Cut Ctrl+X

a7 Sstep> Copy Ctrl+C o

18 <cmd>Select ere Hgagn

19 <uicontrol>s: Insert Before

28 </cmd> Insert After

21 </step> Pasts Ctrl+\ t

22 <step>

23 <cmd>Tap Paste Before

24 <uicontrol>L Paste After

25 </cmd>

" <Jsteps Delete Del

27 <step>

28 <cmd>Tap

29 <uicontrol>Temperature</uicontn|

3e </cmd>

31 </step>

32 <step>

33 <cmd>Adjust the temperature up or d

34 <info>

35 <p>

36 <image href="../media/Warmc|

37 </p> T

Figure 12: Neue Strukturansicht in der XML-Ansicht eines Dokuments
Weitere Informationen finden Sie unter XMIL-Ansicht.
Verbesserte WYSIWYG-Ansicht (XML)

In einem friiheren Release von FrameMaker wurde die Funktion ,,vereinfachte XML-Ansicht” eingefiihrt,
um Ilhnen miheloses Erstellen von DITA-Dokumenten zu ermoglichen. Jetzt wurde die vereinfachte
XML-Ansicht mit der WYSIWYG-Ansicht kombiniert. Mit dieser Anderung sind jetzt alle Funktionen der
vereinfachten XML-Ansicht in der WYSIWYG-Ansicht verfligbar. Sie kdnnen die gleichen Tastenkombina-
tionen verwenden, die in der vereinfachten Ansicht verfligbar waren, um etwa Textformatierungen wie
fett (Strg+b), kursiv (Strg+i) oder Unterstreichung (Strg+u) anzuwenden. Andere Funktionen, die friiher
nur in der vereinfachten Ansicht verfligbar waren, sind jetzt in der WYSIWYG-Ansicht |hrer DITA-Doku-
mente verflgbar.

Weitere Informationen finden Sie unter WYSIWYG-Ansicht.
Schauen Sie sich ein Video zur verbesserten WYSIWYG-Ansicht an.
Einsatzbereite LWDITA-Unterstiitzung

Lightweight DITA (LwDITA) ist eine vereinfachte Version von DITA. Sie besteht aus einem viel kleineren
Satz von Elementen, Attributen, Inhaltsmodellen und Features. Dies ist der kommende Standard fir die
Erstellung strukturierter Dokumentation. LWDITA ist in FrameMaker sofort einsatzbereit. Sie kénnen
direkt eine LWDITA-Map oder ein Thema mit dem Men( Datei > Neu erstellen.
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Dank einer einfachen Karten- und Themenvorlage lassen sich LwDITA-Maps und -Themen kinderleicht
erstellen. Zusatzlich zu den Erstellungsvorlagen helfen Ihnen die sofort einsatzbereiten Veroffentli-
chungsvorlagen beim Generieren der Ausgabe fir lhre LwDITA-Map/-Themen.

Um die LwDITA-Anwendung zu verwenden, wechseln Sie zu LW DITA Applications inden
DITA-Optionen-Einstellungen:

DITA Options X
DITA Version: General Options:
Use DITA Version: 1.3 ) Auto-Load Topicrefs On File Open
Auto-Load Conrefs On File Open
Use Application Mapping: [LW_DITA_Applications i Auto-Load Xrefs On File Open

DITA_1.3_Applications

DITA 13 Learning_Applications [ipegtcadlGaphcsBecineriniCny)

Defaults: LW DITA Applications [[] Cenditionalize Proleg On File Open
‘New' Type: "xml M [T Conditionalize Comments On File Open
Auto-Add IDs If Required By Element
ID Prefix: (id Always Update Navtile While Updating TopicRef

Always Display Navtile On File Open
Indexterm To Index Marker Conversion
URI notation for paths

Application Mappings... Save Cancel

Figure 13: Wechseln zu ,,LW_DITA_Applications”in ,,DITA-Optionen”

Nachdem Sie die Einstellungen gedndert haben, kdnnen Sie die LwDITA-Map oder das Thema liber das
Meni Datei erstellen:

File | Edit Insert View Element Structure Review Window Help
New > Document... Ctrl+N
abc
Open... Ctrl+O Book Esc fN 2 [
Open Recent > DITA > <topic> EscNT1 ‘en X
— p P _L
— Close Ctrl+W XML... Esc f X <map> Esc N M 1
E Save Ditamap Ctrl+S Project Escprn m Adobe |:
@« Save Ditamap As... Escfa New EDD EscfDN
=g Save As PDF... Escfwp
Save As Review PDF > Recent ltems
l Revert to Saved Escfr
PROJECTS
Import >
Package... EscFlp |
. Publish Escph
Utilities >
S , rexml RECENT FILES
o wure_display.xml .
Print Ditamap... Ctrl+P UserGuide_mast...
Print Setup... .
rint Setup - «ml Ch1_Overview#2...
File Info... Escfil ml
CMS > frm_text_tx.fm
Exit frm_text_txxml

Figure 14: Anderungen im Menii , Datei” zum Anzeigen unterstiitzter LwDITA-Dokumente
Schauen Sie sich ein Video zur sofort einsatzbereiten Unterstitzung von LwDITA an.
Weitere Informationen finden Sie unter Arbeiten mit LwDITA in FrameMaker.

Akronymreferenzierung mit <abbreviated-form>
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Sie kdnnen nunin lhren DITA-Dokumenten mit dem Element auf einen Glossareintragsbegriff verweisen,
der die lange und kurze Form des Begriffs enthalt. Die FrameMaker-Veroffentlichungs-Engine liest den
Kontext, in dem das -Element referenziert wird, und verwendet entweder die lange oder kurze Form des
Begriffs.

< di%1 3

ABBREVIATED FORM

Figure 15: Unterstltzung von <abbreviated-form>
Einfiigen von Rich Media mithilfe von DITA-Elementen

Mit FrameMaker kénnen Sie Rich-Media-Dateien miihelos in Ihre Dokumente einfligen. Ganz gleich, ob
Sie in einem FrameMaker-, DITA- (XML-) oder LwDITA-Dokument arbeiten, kdnnen Sie einfach Video-
und Audiodateien importieren. In strukturierte Dokumente fugt FrameMaker die Video-/Audiodateien
mit den glltigen Elementen ein. Sie miissen nicht zum Quellcode lhres strukturierten Dokuments
wechseln, um das giiltige Element zu dndern oder anzuwenden.

Verwenden Sie das Menl Einfligen > Multimedia und folgen Sie dem Dateieinfligevorgang. FrameMaker
Ubernimmt den Rest der Aufgabe, Ihre Mediendateien hinzuzufiigen. Diese Mediendateien werden auch
wie vorhanden in den PDF- und Responsive-HTML5-Ausgaben veroffentlicht.

File Edit | Insert | Format View Graphics Table Element Structure Review

o ‘ it Image... Escfii T W == ui'
g Multimedia > Audio... Escfia | ¥
Anchored Frame... Escsa Video... Escfiv
P Cross-Reference... Escsc ; Online Video.... Escfio VI c_history.
m_generaldescr External Reference EsclER
@ Eﬁ ﬂ m Conref... EsclIC
o general_desc  Element Cul+1 ube video:
=@ gener;l des MathML Equation... Escnm|
@c_history Conditional Tags... EscsC
Zic_overvieyv Marker... Escsm
. [@r_space: Variables... Escsv
¢ ~@r_launch Hypertext... Escsh

Figure 16: Meni ,Einfliigen > Multimedia“

Weitere Informationen finden Sie unter Importieren von Audio- und Videodateien sowie und
3D-Objekten.

Schauen Sie sich ein Video zum Einfiigen von Rich Media mit DITA an.
Konvertieren von Word- und Markdown-Inhalten in DITA

FrameMaker verfiigt Gber eine leistungsstarke Word-Importfunktion. Mit dieser Funktion kdnnen Sie
Ihre Word-Dokumente ganz einfach in FrameMaker-Dateien (. fm) konvertieren. Mit der Hauptversion
von FrameMaker kénnen Sie nun |hre Word-Dokumente auch in DITA-Dokumente konvertieren. Der
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Prozess ist ganz einfach. Sie missen die Speicherorte des Eingabe- und Ausgabeordners zusammen mit
der Konvertierungszuordnungs-Datei angeben und das Dokument wird in DITA-Dokumente konvertiert.
Im Konvertierungsprozess erhalten Sie eine Reihe von . dita-Dateien und eine . ditamap-Datei.

Damit ein Word-Dokument erfolgreich konvertiert werden kann, sollte es gut strukturiert sein. lhr Doku-
ment sollte z. B. einen Titel haben, gefolgt von Uberschrift 1, Uberschrift 2 usw. Jede der Uberschriften
sollte einen gewissen Inhalt haben.

Sie kénnen auch lhren Markdown-Inhalt in FrameMaker einbringen. Bei der Markdown-Konvertierung
kommt eine integrierte Zuordnungslogik zum Einsatz. Deshalb missen Sie beim Konvertieren lhrer Mark-
down-Dokumente keine Zuordnungsdatei angeben. Geben Sie einfach die Eingabe-DITA-Map mit Ihrer
Markdown-Datei als <topicref> und den Ausgabe-Speicherort an, um Ihre Markdown-Dateien ins
DITA-Format zu konvertieren.

Word (.docx) in DITA konvertieren X

Eingabs-Word-Dokument ( docx

Datei:
Release 2020\ Word-to-DI TA-migration-sample-doc.docx Durchsuchen...

Sti-zu-Tag-Zuordnung

Datei:
rameMaker\16\X2DITA\Word 2DITA styletagMap xmi|  [Durchsuchen

DiTA-Ausgabedateien: | pjarkdown in DITA konvertieren
Verzeighnis
[C:Dats otk Zoerdng i Konveienung von Makdonn Engabe 2u DITA {dtanap):

Datei

[\Reserach\markdown to-ita\markdown+o-dta.ditamap| | Durchsuchen

[ Ausfiihriiche Protol

O

DITA-Ausgabedateien:

Verzeichnis:

|'-HE\Ease 12020"Research‘markdowno-dita‘converted|  Durchsuchen..

[] Ausfiihriiche Protokolienung

Konvertieren Abbrechen

Figure 17: Konvertieren Sie lhre Word- und Markdown-Dokumente in DITA

Weitere Informationen finden Sie unter Word-Dokumente (.docx) in DITA konvertieren und Mark-
down-Dokumente (.docx) in DITA konvertieren.

AuRerdem erfahren Sie in Videos, wie Sie Word-Inhalte in DITA importieren und Markdown in DITA
importieren kénnen.

Hinzufiigen von Referenzdokumenten innerhalb der PDF-Ausgabe

Sehr oft miissen Sie zusatzliche Referenzdokumente mit Ihrer Quell-PDF-Datei verkniipfen. Dazu
erstellen Sie zunachst eine PDF-Datei und fligen dann das Referenzdokument mit Adobe Acrobat als
Anlage hinzu. Mit einer Funktion in FrameMaker kénnen Sie Referenzdokumente zum Zeitpunkt der
Erstellung hinzufligen. Wenn Sie lhre endgliltige PDF-Datei generieren, wird das Referenzdokument der
PDF-Datei hinzugefiigt, ohne dass zusatzliche Aktionen in Acrobat erforderlich sind.

Um ein Referenzdokument hinzuzufiigen, wechseln Sie zu Einfiigen > Datei in PDF einbetten oder Datei
an PDF anhangen. Je nachdem, welche PDF-Veroffentlichungsvoreinstellung Sie verwenden, miissen Sie
entweder die Option zum Einbetten oder Anhdangen der Datei auswahlen.
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WelcomeScreen X | GeneralDescription.fm X |

1.3.3 Thermal protection

Heat protection against burnup and cold protection against the
oid of space is provided by materials applied to the outer skin of
the vehicle to maintain acceptable temperatures.

The outside of the vehicle is made of aluminum and epoxy.
Reentry temperatures can exceed 3000° F'. Outside tem peratures
can plummet to minus 250° F2.

Materials are usedin a preferred order and include:

1. Reinforced carbon fiber.
High temperature reusable surface insulation.

Low temperature reusable surface insulation.

> W N

Specialized materials for other exposed internal surfaces.
a) Flexible surface insulation over standard shapes

b)_Insulating blankets strapped to non-standard shapes
Embedded PDF:

Attached PDF: i

1] q M 14 (120f12)* E

Figure 18: Eingebettete und angehangte PDF-Datei im Quelldokument

Weitere Informationen finden Sie unter Anhdngen oder Einbetten von Dateien.

Schauen Sie sich ein Video zum Hinzufligen von Referenz-PDFs innerhalb einer PDF-Datei an.
Generieren von PDF/A- und PDF/X-konformen PDFs

Es gibt verschiedene Industriestandards flr die PDF-Erstellung. Diese Standards definieren den Zweck
und die Verwendung des PDF-Dokuments. Beispielsweise werden PDF/X-Standards fur den Austausch
grafischer Inhalte angewendet, PDF/E-Standards flir den interaktiven Austausch technischer Dokumente
und PDF/A-Standards fur die Langzeitarchivierung elektronischer Dokumente.

. PDF/X-Standards werden flr den Austausch grafischer Inhalte und von auf den Druck bezogenen
Anforderungen verwendet.

J PDF/E-Standards werden fir den interaktiven Austausch technischer Dokumente genutzt.
. PDF/A-Standards werden fir die Langzeitarchivierung elektronischer Dokumente eingesetzt.

Je nach den Anforderungen lhrer Organisation kdnnen Sie einen benutzerdefinierten Standard zum
Erstellen von PDFs definieren. Diese Standards werden in Form einer . joboptions-Datei erstellt.
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Figure 19: PDF/A- und PDF/X-konform

Mit FrameMaker kdnnen Sie Ihren eigenen benutzerdefinierten Standard oder die vordefinierten Stan-
dards zum Erstellen von PDF/A- oder PDF/X-kompatiblen PDF-Dokumenten verwenden. Sie mussen lhre
. Jjoboptions-Datei an einen bestimmten Speicherort kopieren. AnschlieBend tibernimmt
FrameMaker die Aufgabe, Ihr Dokument mit den in der . joboptions-Datei definierten Einstellungen
zu veroffentlichen.

Weitere Informationen finden Sie unter PDF-Einstellungen.

Sehen Sie sich ein Video unter Generieren von PDF/A- und PDF/X-konformen PDF-Dokumenten
an.

Brandneue HTML-Engine

Nutzen Sie die neue, hochmoderne, HTML-Engine, die von Grund auf neu geschrieben wurde, um die
Responsive-HTML5-Ausgabe reibungslos und schnell zu generieren. Erfassen Sie mehr Stilinformationen
mit CSS3-Erweiterungen wie automatischer Nummerierung und Pseudoklassengenerierung.

Figure 20: Neue, leistungsstarke HTML-Engine

Einige der wichtigsten Verbesserungen in der HTML-Engine sind:

. Exportieren Sie Grafiken in Ihren Inhalten als SVG mit mehr Kontrolle tber die Angabe von Ansichts-
fenster- und Ansichtsfeldeinstellungen.

. Steuern Sie die Formatierung lhrer Tabellenliberschriften und -zeilen mithilfe lhres benut-
zerdefinierten CSS.

. Stark verbesserte Logik zum Erstellen des TOC.
. Klassennamen von Absatz-, Zeichen- und Tabellenformaten verwenden jetzt denselben Namen,
der in ihren jeweiligen Katalogen definiert ist.

Weitere Informationen finden Sie unter Verdffentlichung auf verschiedenen Kandlen.

26


https://video.tv.adobe.com/v/32429t1
https://www.w3.org/TR/SVG11/coords.html#ViewportSpace
https://www.w3.org/TR/SVG11/coords.html#ViewportSpace
https://www.w3.org/TR/SVG11/coords.html#ViewBoxAttribute

NEUE FUNKTIONEN IN ADOBE FRAMEMAKER

Sehen Sie sich ein Video Uber die brandneue HTML-Engine an.

Besserer Zugriff auf PDF-Inhalte

FrameMaker unterstitzte bereits das Generieren von 508-kompatiblen PDF- und Respon-
sive-HTML5-Ausgaben. Die Hauptversion von FrameMaker werden PDF 2.0-Standards noch stringenter
eingehalten. Ihre PDFs werden nun nahtlos auf der mobilen Version von Adobe Acrobat Reader geren-
dert. Dies geschieht zusatzlich zur bereits vorhandenen Tagging-Funktion, die es in FrameMaker fir die
PDF-Generierung gibt.

Schauen Sie sich ein Video zum besseren Zugriff auf PDF-Inhalte an.

Figure 21: GroRere Barrierefreiheit fur Inhalte

Weitere Informationen finden Sie unter Lesezeichen und Tags.
Schauen Sie sich ein Video zum besseren Zugriff auf PDF-Inhalte an.
Problemlose Zusammenarbeit mit Adobe Acrobat

Der Review eines Dokuments ist ein integraler Bestandteil des Dokumenterstellungsprozesses. Das
Generieren einer PDF-Datei und eine gemeinsamer Review ist in vielen Organisationen weltweit ein sehr
gebrauchlicher Workflow. Sie konnen die Review-PDF-Datei ganz einfach direkt in FrameMaker erstellen
und mit lhren Reviewern teilen.

Wenn Sie Abonnent von Adobe Technical Communication Suite sind, wird das Erstellen von
Review-PDF-Dateien jetzt noch einfacher. Die Hauptversion von FrameMaker lasst sich in die Adobe
Document Cloud integrieren. Sie kdnnen Review-PDFs erstellen, sie in lhrem Document Cloud-Konto
hosten und fiir Ihre internen oder externen Experten freigeben, damit diese die priifen kdnnen. Sie beno6-
tigen nur Anmeldedaten, um iber Adobe Document Cloud auf die zu Gberprifende PDF-Datei zuzu-
greifen.
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Sobald die Uberpriifung abgeschlossen ist, kdnnen Sie Bewertungskommentare direkt in das Quelldoku-
ment importieren. Mit dem neuen Review-Fenster kdnnen Sie durch die Kommentare navigieren und
entsprechend darauf reagieren.

Datei Bearbeiten Einfigen Format Ansicht Grafik Tabelle Element Struktur |[ReMiew | Fenster Hilfe

| IR =] ] S8 2 o £ L Fiir Onlinereview senden...

H Als Review-PDF speichern —
ChapterTitle = |i 7] Af

Kommentare importieren >

Onlinereviews verwalten... ]:

Fenster Review" anzeigen

Fiir Onlinereview senden x Onlinereviews verwalten x

Dokument fiir Review

Reviews suchen

\Genera\-Desmmmn pif |

Review bearbsiten Review loschen Kommentare importisren =
Reviewname

[review | Reviewname Dokumert Status Startdatum des Deadine Re

Fres review General Deseription pdf ACTIVE 20200522 20200609 e

[EMal engeben Pt fdk_reference fak_reference pof ACTIVE  2020:05:22 pa

General Deseription - General-Description pdf ACTIVE 20200522 pa

Aktuelle Reviewer T Tp.pdf ACTIVE  2020-05-21 P2

reviewer@adobe com
reviewer2@adobe com

< >

Loschen

Deadine festiegen
[ & 92020 B Bearbsten Schishen

obecen

Figure 22: Online-Reviewprozess

Weitere Informationen finden Sie unter Einrichten einer PDF-Onlinereview.

Schauen Sie sich ein Video zur problemlosen Zusammenarbeit mit Adobe Acrobat an.
Unterstitzung fiir 2FA/SSO im Adobe Experience Manager-Connector

Adobe Experience Manager ist eine umfassende Content Management-Losung zum Erstellen von
Websites, mobilen Apps und Formularen. Adobe FrameMaker ist nativ in Adobe Experience Manager
integriert. Mit dem CMS-Connector in FrameMaker kénnen Sie ganz einfach eine Verbindung mit Adobe

Experience Manager herstellen, um lhre technischen und Marketinginhalte zu erstellen und bereitzus-
tellen.

Mit Funktionen wie dem automatischen Einchecken von Dateien beim SchlieRen oder dem Auschecken
von Dateien beim Offnen kdnnte die Arbeit mit Adobe Experience Manager fiir Benutzer von
FrameMaker kaum einfacher sein. Weitere Steuerelemente wie das Einchecken mehrerer Dateien,
Auschecken und Abbrechen erméglichen Ihnen, nahtlos mit Adobe Experience Manager zu arbeiten.

Wenn lhre Organisation die Zwei-Faktor-Authentifizierung (2FA) oder Single Sign-On (SSO) verwendet,
verwenden Sie die Option SSO im Verbindungsmanager, um sich mit lhrem AEM-Server zu verbinden.
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Connection Manager X

Connectto a Favorite: Choose Connection:

|Adobe Experience Manager v ‘

Connection Details:

Name: |AEM Server ‘

Server: |hnp:!!lccalhost:4502 ‘

(e.g. protocol://server:port)

[_] Use single sign-on (SSO)

User Name: |u5ername ‘

Password:

Save password

Workspace: |crx.def‘ault ‘

Local Folder: |C:\Temp ‘ B

Remove Clear

Connect Cancel

Figure 23: Adobe Experience Manager-Verbindungseinstellungen mit SSO-Option

Weitere Informationen finden Sie unter Einrichten des Adobe Experience Manager-Connectors.
Sehen Sie sich dazu das Video Uber die native Integration in Adobe Experience Manager an.
Nutzung von Anpassungen mithilfe von Adobe Partner-Plugins

Das Partnernetzwerk Adobe Technical Communication ist ein groRer Pool von Experten und
Unternehmen, die lhnen dabei helfen kdnnen, benutzerdefinierte Plugins oder Lésungen nach Ihren
Bediirfnissen zu erhalten. Sie kdnnen direkt von FrameMaker aus auf unser Partnernetzwerk zugreifen,
indem Sie Hilfe > Trainings-/Consultingpartner aufrufen.
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Type solution partner

- - I Tap into our global network of Adobe Technical Communication Partners to receive local sales and technical
Filters = expertise in your region. Partners provide a range of services, from tools training and support in local languages to

Choose Product plugins and fulfilment of custom requirements.

109 Results

Adobe FrameMaker -- Order By -- v

Adobe FrameMaker Publishing
Server 4XScripts - Ute Mitschke

4XScripts unterstiitzt technische Redaktionen mit Automatisierungslosungen fiir
Adobe RoboHelp

#f Adobe FrameMaker, Entwicklung von XML-Strukturen, Schulung, Training und
Consulting.

Adobe RoboHelp Server

Adobe Technical Communication

Suite >

Choose services
Absolute Data Group Pty Ltd

ADG is an award-winning technology company that specializes in creating,
managing and leveraging technical data and maintenance information for clients

Choose country

Choose language

@®ADG

Absolute Data Group across a variety of industries....

Figure 24: Adobe Technical Communication-Partnerseite

Zusatzlich zum Partnernetzwerk konnen Sie auch auf einige der am haufigsten verwendeten Plugins
zugreifen, die von unseren Partnern erstellt wurden, indem Sie zu Hilfe > Plugins/Add-ons von Drittan-
bietern wechseln.

Partner Portal

A | Technical
W Type solution partner Q

Communication

Home Products ~ Customer success stories Customer support Contact us

4 Back to Home Page

FrameMaker.dk

intelligent <ontent ralutions

Templates Plugins | Paid

3
& 80 active installs < 0 active installs

Eclipse iSpec CMM/SB

The plug-in leverages the
printing capability of Adobe
FrameMaker to...

Tahona - An A4
FrameMaker 2019
template
We made the "Tahona - Tequila
driven, FrameMaker 2019
Template"...

Figure 25: Seite zu Plugins von Drittanbietern

Schauen Sie sich ein Video zum Zugriff auf die Adobe Technical Communication-Partner- und Plugin-Seite

an.

TXTAOMEDIA

Plugins  Paid

& 66 active installs

Live Action Video

The Animated Videos can be
transformed into Live Action
Videos...

TXTOMEDIA

Plugins Paid

& 65 active installs

Sample Animated Video

Text, illustrations, and images
used in the written manuals
and...
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StandardmiRige Ubersetzungsunterstiitzung

Die Hauptversion von FrameMaker bietet sofort einsatzbereite Unterstiitzung fiir das Ubersetzungs-
framework. Sie kdnnen Ihr FrameMaker-Buch oder eine DITA Map ganz einfach ins XLIFF-Format (XML
Localization Interchange File Format) konvertieren und zur einfachen Verarbeitung mit lhrem Lokalis-
ierungsanbieter teilen. Sobald Sie die libersetzten Dateien zurilickerhalten haben, verwenden Sie die
Importfunktion, um den konvertierten Inhalt wieder in FrameMaker einzubringen. Mit einer Vielzahl von
Optionen, mit denen Sie steuern kénnen, was in lhrem Ubersetzungspaket enthalten ist, haben Sie eine
bessere Kontrolle liber lhre Inhalte.

B XUFF-Exporteinstellungen X

Ausgangssprache | Deutsch N
] Skelttin XUIFF einbeteen (empfoblen)

MIF Enstclungen

blenden’ o cross eference fomats v

(] nbalt externer Querverweise cinblenden

Eretelingensichen Aobrechen

Figure 26: XLIFF-Exporteinstellungen
Weitere Informationen finden Sie unter Ubersetzung.

Sehen Sie sich dazu auch die Videos zu standardmaiRiger Unterstiitzung von Ubersetzungen und vorseg-
mentierten XLIFF-Dokumenten fiir eine einfachere Ubersetzung an.
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Neue Funktionen in Adobe FrameMaker Update 1

Erfahren Sie, welche Neuerungen die Adobe FrameMaker-Version fir Update 1 enthalt.

Update 1 der FrameMaker-Sommerversion 2020 umfasst zahlreiche Verbesserungen und Fehlerbehe-
bungen im Bereich Authoring und Publishing, wie DITA-Indexmarker, HTML-Inhaltsverzeichnis und
-Index, getaggte PDF-Uberschriftenidentifikation und vieles mehr.

HiNwEIS: Weitere Einzelheiten zu den in dieser Version behobenen Problemen finden Sie im Artikel Beho-
bene Probleme.
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Neue Funktionen in Adobe FrameMaker Update 2

Erfahren Sie, welche Neuerungen die Adobe FrameMaker-Version fir Update 2 enthalt.

Update 2 der FrameMaker-Sommerversion 2020 umfasst zahlreiche Verbesserungen und Fehlerbehe-
bungen im Bereich Authoring, Veroffentlichung und Verwalten von Inhalten. Funktionen, die Ihnen
helfen, effizienter mit Bildern zu arbeiten, LWDITA; Verbesserungen zur Ver6ffentlichung von PDF- und
Kindle-Ausgaben; Verwalten von Materialien in AEM, SharePoint und vieles mehr.

HiNnweEIs: Weitere Einzelheiten zu den in dieser Version behobenen Problemen finden Sie im Artikel Beho-
bene Probleme.

Werfen wir einen Blick auf die neuen und geanderten Funktionen ab Update 2 von FrameMaker:
Beibehalten der DPI-Werte fiir Bilder beim Skalieren oder beim Andern der GroRe

Bilder sind integraler Bestandteil eines Dokuments. Es ist wichtig, die Qualitat Ihrer Bilder beizubehalten,
wenn Sie ihre GrofSe in einem Dokument dndern. Adobe FrameMaker umfasst eine Reihe von Funk-
tionen, die Ihnen helfen, Bilder einzufiigen und auszurichten. In diesem Release wurde eine neue Funk-
tion eingefiihrt, mit der die Bildqualitat selbst dann beibehalten wird, wenn Sie die Bilder skalieren oder
ihre Grolle anpassen.

Wenn Sie ein Bild importieren und es skalieren oder die Funktion An Rahmen anpassen (proportional)
verwenden, andern sich die Auflésung und die Qualitat des Bildes. In Update 2 behalt FrameMaker die
Bildauflosung mit dem bestmoglichen DPI-Wert (Dots per Inch) bei, wenn Sie ein Bild anpassen, wobei
das urspriingliche Seitenverhaltnis beibehalten wird. Dieser Wert wird auch im Fenster Objekteigen-
schaften angezeigt.

Zum Offnen des Fensters Objekteigenschaften wihlen Sie Grafik > Objekteigenschaften.
Weitere Informationen finden Sie unter Andern der Gréf2e von importierten Grafiken.

Mit Update 2 von FrameMaker bleibt die Bildqualitat erhalten, wenn Sie Bilder an verschiedenen Posi-
tionen sowohl in strukturierten als auch in unstrukturierten Dokumenten einfliigen. Angenommen, Sie
fligen ein Bild ein, das groRer ist als der ibergeordnete Textrahmen oder die Tabellenzelle. In diesem Fall
Uberschreitet das Bild die GroRe des verankerten Rahmens. Wenn Sie die GrofSe des Bildes so anpassen,
dass es in den verankerten Rahmen passt, verliert das Bild seinen DPI-Wert. In Update 2 behalt
FrameMaker die Bildqualitat bei und skaliert das Bild proportional, sodass es in den ibergeordneten
verankerten Rahmen passt, wobei der bestmogliche DPI-Wert beibehalten wird.

Soll das Bild automatisch skaliert werden, wahlen Sie Bearbeiten > Voreinstellungen > Grafik und
wahlen Sie Automatisches Skalieren des Bildes nach der Breite (beim Einfligen).
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Voreinstellungen >

= G_Inbal Standardeinstellungen
i -Allgemein Bildimpaort

- Grafilk Veranken_lngspositinrl Unter der aktuellen Zeile r |
- Benutzeroberflach

Textausricht .

- Warnmeldungen =] |Zerrtnert ~ |

... Starten DPI | 72 - |
i - Dropbox
4 CMS i Automatisches Skalieren des Bildes nach der Brefte ibeim. Einfiaenk
+- Rechtschreibung Bildexport
L KL
H Rasterbilder-DP1 in 300 ~

MathhL HTML-Ausgabe | |

Abbrechen

Figure 1:  Option zum automatischen Skalieren von Bildern im Dialogfeld ,Voreinstellungen”
Weitere Informationen finden Sie unter Automatisches Skalieren eines Bildes in einem Grafikrahmen.
Unterstiitzung fiir ,xml:lang“-Attribut beim Authoring von XML- oder DITA-Inhalten

FrameMaker unterstiitzt das Authoring und die Veroffentlichung in mehreren Sprachen sowohl in struk-
turierten als auch in unstrukturierten Dokumenten. Mit der neuen Verbesserung fir strukturierte Inhalte
kénnen Sie Ihren Inhalt in verschiedenen Sprachen erstellen und Korrektur lesen.

Sie kdnnen nun eine der mit FrameMaker geblindelten 46 Sprachen auswahlen und als Attributwert fir
@xml : 1ang fur lhren strukturierten Inhalt hinzufigen.

Zur Unterstltzung dieser Funktion wurde die strukturierte Authoring-Vorlage (DITA 1.2, DITA 1.3 und
LwDITA) aktualisiert. In der Vorlage legt FrameMaker die verschiedenen Eigenschaften der Absatzgestal-
tung auf der Grundlage der Spracheinstellung im @xm1l : 1ang-Attribut aus Ihrer XML-Datei fest.

Folgende Eigenschaften der Absatzgestaltung werden automatisch beim Angeben des Attributwerts fir
@xml : lang festgelegt:

. Sprache

. Textrichtung

. Schriftfamilie

] Unterschneiden

) Composer fiir asiatische Schrift verwenden
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Figure 2:  In der Absatzgestaltung konfigurierte Einstellungen zur Unterstiitzung des @xml : 1ang-Attributs

| » | =

Sl |Bndy v|

Basis Schrift Seitenumbruch | Nummerierung
Erweitert Asiatisch Zele Richtung

Familie: Groke

[M3 Gothic v||[1200 v

Farbe: Hintergrund:

W schwarz ~ Keine v

Starke: Neigung: Variation:

Regular ~ | | Regular ~ | Regular ~

[ | Unterstreict ~ | [] Uberstreichen ] Durchetreichen

Buchstabenabstand: Streckung: Sprache:
[0.0% | [100.0% || lJapaniech  ~
| Hochgestelt ~ | O | Kapitalchen ~

[ Anderungsbalken [ Tsume

fo 20s Umbenennen | Stil aktualisieren

Absatzgestaltung | » = | Zeicl Absq Zeic| Tabq Objg Variz > | =
sti: [Body v 5t [Haupttext ~|
Basis Schrft Setenumbruch | Nummerienung Basis Schiit | Setenumbruch | Nummerierung
Emveitert Asiatisch Zelle Richiung Enwettert Asiatisch Zelle
Abstand Latcinisch/Asiatisch (% des Schri Fichtung
Minimum Maximum: Optimum: Ubemehmen -

Joox | [50.0% | [250% |

Zeichenabstand Asiatisch (% des Schriftgrads)
Minimum Maximum: Optimum:
Joox | [10.0% | [0 |

Interpunktion verkleinem:
Komprimieren, fals erforderich v
Composer iir asiatische Schift verwenden

(Empfohlen fir Chinesisch, Japanisch, Koreanisch und ahniiche
Sprachen)

$+|[C  Unbenennen [sti aktualisieren $-|[3  Unbenennen [Sil aktualsieren

(¥

Weitere Informationen finden Sie unter Sprach- und Schrifteinstellungen in strukturierten Dokumenten.

Metadaten-Zuordnung von FrameMaker zu PDF

Mit der neuen Verbesserung erzielen Sie beim Veroffentlichen der PDF-Ausgabe ein einheitlicheres
Resultat. Die Metadaten, die ein Benutzer einem FrameMaker-Dokument im Dialogfeld

Datei-Informationenhinzufiigen kann, werden nunmehr den PDF-Metadaten zugeordnet, wenn Sie lhren
Inhalt im PDF-Format veréffentlichen. Zum Abrufen der Metadateninformationen der Datei in
FrameMaker wahlen Sie Datei > Datei-Informationen.

. Copyright-Status

. Copyright-Vermerk

. Copyright-Informationen-URL

Die Titel werden auBerdem in den Metadaten der PDF-Ausgabe aktualisiert, wenn Sie die Veroffentli-

chung als PDF vornehmen. Zum Abrufen der Metadaten einer PDF 6ffnen Sie die PDF in Adobe Acrobat
und wahlen Sie Datei > Eigenschaften. Auf der Registerkarte Beschreibung wird eine Zusammenfassung
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der Metadaten der PDF angezeigt. Zum Abrufen der vollstandigen Metadaten klicken Sie auf Zuséatzliche

Metadaten.

Datei-Informationen X
Autor: ABCDEF
Titel This is a sample test document

Thema This document shows formatting

features.

Schiiisselwarter: | FrameMaker, Adobe

Copyright Adobe

Web-Anweisung: [itps://www adobe.com/de/legalpermi

ssions hitml

Aufragsreferenz: |Test-check 1|

Markiert: Unbekannt

Erstellungsdatum: Monday. June 7, 2021 4:54.16 AM
Anderungsdatum: Monday, June 7, 2021 4:54:16 AM
Datum der Metadaten: Monday. June 7, 2021 4:54:16 AM

Zuweisen

Abbrechen

{Kein "Riickgangia")

Figure 3:

Datei-Informationen in FrameMaker

Figure 4:

Sample.pdf X
[Description  [NEEEE ] »
Advanced

Document Title: | This is a sample test document. v ]
Author: | ABCDEF ‘
Author Title: [
Description: [ This document shows formatting features. [~]
Description Writer:
Keywords: [“FrameMaker, Adobe”
@ commas can be used to separate keywords
Copyright Status: | Unknown v
Copyright Notice: [ adobe
Copyright Info URL: [ https; v.adobe.com/de/legal/ html
Go To URL...
Created: 5/25/2021 9:06:34 PM
Modified: 5/25/2021 9:11:40 PM
Powered By Application: FrameMaker 16.0.2
X Format: application/framemaker
ance

Zugeordnete Titel in PDF-Metadaten

Weitere Informationen dazu finden Sie unter Hinzuftigen von Metadaten zu einem Dokument.

Unterstiitzung fiir Kindle Previewer

eBooks sind eine beliebte und komfortable Option fiir Leser in dieser digitalen Welt. FrameMaker bietet

eine leistungsfahige Umgebung fir die Veroffentlichung fiir Amazon Kindle. Da KindleGen mittlerweile
veraltet ist, hilft Ihnnen unser Update, die aktuelle Version von Kindle Previewer herunterzuladen.

Sie kénnen Kindle Previewer Uber Einstellungen fiir Veréffentlichungen, Ausgaben, Aligemein, Kind-

leGen-Pfad herunterladen.

Formatvorlagenzuordnung  Ausgaben

POF

Responsive HTMLS
Mobile App:

ePub

Kindle:

Microsoft HTML Help
Basic HTML

Aligemein  Metainformationen

Thel: ‘K]rvd\e Book

Sprache: | Deutsch (Deutschland) v | Ewetet

Einstelungen fiir das Inhaksverzeichnis:

Index

(] Vorage fiir HTML:Sete verwenden » -
[ Formatvariagen fir diese Ausgabe Uberschreiben | 5 +
Hbsolte Bidgralle in reltive Bidgrake konvertieren

Absolute Tabellengrife in relative Grifie konvertieren

1

[ KindieGen-Protokolle anzeigen KindleGen-Pfad..
‘ Zur KindleGen-Downloadssite
etz
T Speiche Speichem unter.. peichem und schiiefen| Abbrechen

Figure 5:

Weitere Informationen finden Sie unter Ausgabeneinstellungen.

Pfad von Kindlegen.exe in den Einstellungen fur Kindle-Veréffentlichungen
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Die neue Funktion von FrameMaker eréffnet lhnen eine reibungslose Benutzererfahrung beim Offnen
und Lesen von Kindle-eBook-Dateien. Mit dem zweiten Update von FrameMaker erhalten Sie eine
bessere Kontrolle tber lhre Kindle-Ausgabe. Nun miissen Sie nicht immer zum Ausgabeordner wechseln
und zum Offnen auf die Kindle-Datei klicken. Wenn Sie die Verdffentlichung Ihrer Kindle-Datei (iber Datei
> Veroffentlichen vornehmen, konnen Sie die Dateien direkt nach dem Veroffentlichen 6ffnen.

Klicken Sie im Dialogfeld Veroffentlichungsergebnis auf Ausgabe anzeigen, um lhr eBook direkt in Kindle
Previewer zu 6ffnen.

Unterstiitzung fiir die Veroffentlichung UUID-basierter Dateien liber den Connector fiir Adobe Experi-
ence Manager (AEM)

XML Documentation for Adobe Experience Manager (AEM), das DITA-CCMS von Adobe, unterstiitzt das
UUID-basierte Dateireferenzsystem (Universally Unique Identifier). Der AEM-Connector von
FrameMaker wurde erweitert und unterstiitzt nunmehr die Veroffentlichung von Inhalten Gber das
UUID-basierte Dateireferenzsystem.

Zur Unterstltzung UUID-basierter Referenzen in Dateien wurde die neue Option Auf UUID-basierte
Referenzen verwenden in die Voreinstellungen des AEM-Connectors aufgenommen.

Wahlen Sie Bearbeiten > Voreinstellungen > CMS > Adobe Experience Manager und wahlen Sie Auf
UUID-basierten Referenzen verwenden.

Voreinstellungen X

bal CMs

Allgemein I 5
Grafike Datei beim Einchecken schiiefen [ Unfangreiche Protokolierung

Datei beim Auschecken dffnen

Debuginformationen

Benutzeroherfliche
Warnmeldungen #Aut ULIID-basierte Referenzen verwenden:
Starten

Dropbox Automatisches Auschecken

S [] Automatisches Auschecken aktivieren
Documentum

Microsoft SharePeint
DitaBxchange

Adobe Experience Manage

Beim Speichem der Datei

r Datei

Eingabeaufforderung anzeigen

htschreibung Proxy
L Proxytyp:

thiL Server: ~

Aebrechen

Figure 6: Neue Option fiir UUID-basierte Referenzen im Dialogfeld ,Voreinstellungen”

Nach Aktivierung dieser Option kdnnen Sie nun Dateien mit UUID-basierten Dateireferenzen aus AEM
herunterladen. Sobald die Dateien auf Ihrem System verfiigbar sind, kdnnen Sie diese Dateien in
FrameMaker veroffentlichen und damit die gewiinschte Ausgabe generieren.

Weitere Informationen finden Sie unter Unterstiitzung fir die Verdffentlichung UUID-basierter Dateien.
Verbessertes Herunterladen abhangiger Dateien im Microsoft SharePoint-Connector

Zusammenarbeit und Versionsverwaltung sind integrale Bestandteile des Dokumenterstellungsproz-
esses. In Adobe FrameMaker kénnen Sie Ihre Dateien zur Review freigeben, wahrend Sie verschiedene
Versionen der Dokumente mit SharePoint erstellen und verwalten kénnen.

Wenn |hr Hauptdokument beim Authoring in FrameMaker abhangige Elemente umfasst, konnen Sie die
abhdngigen Dateien auch lber SharePoint herunterladen oder auschecken. Zur Unterstiitzung diser
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Funktion ist die Option Abhdngige Dateien standardmaRig auschecken in den Microsoft Share-
Point-CMS-Einstellungen im Dialogfeld Voreinstellungen verfiigbar.

Die Ablaufe beim Auschecken von Dateien mit abhangigen Elementen sind nunmehr starker integriert.
Ab Update 2 von FrameMaker ist diese Option besser mit dem SharePoint-Server und dem Docu-
mentum-Server synchronisiert.

Wenn Sie eine Datei vom SharePoint-Server auschecken, wird ein Dialogfeld angezeigt, in dem das
Herunterladen der abhangigen Dateien bestéatigt werden muss. Die Option Alle abhangigen Dateien
auschecken im Dialogfeld ist nunmehr mit der Option Abhédngige Dateien standardmaRig auschecken
im Dialogfeld Voreinstellungen synchronisiert.

Voreinstellungen X

Global

Grafik

ach
Wamnmeldungen O Nachste Nebenversion

Name <Kein Wert>
arePoint Datentyp Zeicherfolge
Adtributtyp Text

[[]#bhangige Dateien standardmalig auschecken

< >

OK Abbrechen

Figure 7:  Einstellung flir Microsoft SharePoint im Dialogfeld ,Voreinstellungen

Checkout X

aCerebml resuscitation mif
Version: 0.3

[[] Checkout all dependent files

o | (o]

Figure 8: Bestatigungsdialogfeld fiir das Herunterladen abhangiger Dateien
Weitere Informationen finden Sie unter Auschecken von Dateien.
Direkter Zugriff auf S1000D-Hilferessourcen iiber das Hilfemenii

Der S1000D-Standard ist die effiziente, moderne Methode zum Erstellen, Verwalten und Veroffentlichen
technischer Dokumentation in den Bereichen Luft-/Raumfahrt und Verteidigung. S1000D wurde
urspriinglich von der militarischen Luft- und Raumfahrtindustrie in Europa entwickelt, wird aber
inzwischen in Landern in aller Welt in den verschiedensten Branchen angewendet. Adobe FrameMaker
unterstitzt die Erstellung und Veroéffentlichung von S1000D-Dokumenten.

Angenommen, Sie arbeiten mit S1000D/ATA und anderen militarischen XML-Standards. In diesem Fall
erhalten Sie im neuen FrameMaker-Men Hilfe noch starkere Unterstiitzung und Anleitung.

Der Schnellzugriff auf die S1000D/ATA-Ressourcen wurde im Meni Hilfe > S1000D-Funktionalitét bere-
itgestellt. Die neuen Menielemente unter $1000D-Funktionalitat lauten:

. Haufig gestellte Fragen
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. Anwendungspaket-Handbuch
. Verbesserte Drittanbietererweiterung fiir S1000D/ATA von Mekon

Datei  Bearbeiten  Einfigen  Ansicht Element  Struktur  Review  Fenster [

oK E R = a ] =N Hilfethemen F

= Beispiele... Escqs

Nicht anwendbar - B
x| Support..

Registrierung...

Adobe FrameMaker Deaktivieren...

Abtualisierungen...

Plug-Ins/Add-Ons von Drittanbietern...

Vorherige Elemente Updates Tainings-/Consultingpartner
ELE @ Aktuell 51000D-Funktionalitst > Haufig gestellte Fragen..
B T Ezom [Baendiopakeeia AUl
Aktuelle Version 16,02 Verbesserte Drittanbietererweiterung fur S1000D/ATA von Mekon...
Ubgr FrameMaker..

r

U ET7T VEOWENDETE DATREN - =

Figure 9: Neue Menloption fir S1000D-Funktionalitat

Weitere Informationen finden Sie unter S1000D im Erstellen von X\ML-Dokumenten-Topic.
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Neue Funktionen in Adobe FrameMaker Update 3

Erfahren Sie, welche Neuerungen die Adobe FrameMaker-Version fir Update 3 enthalt.

Update 3 von FrameMaker Version Sommer 2020 enthalt viele Verbesserungen zur Verarbeitung von
Bildern in der HTML5-Ausgabe.

HiNnweEIs: Weitere Einzelheiten zu den in dieser Version behobenen Problemen finden Sie im Artikel Beho-
bene Probleme.

Werfen wir einen Blick auf die neuen und gednderten Funktionen in Update 3 von FrameMaker:

Verbesserungen bei der HTML5-Ausgabe

Die HTML5-Ausgabe ist ein wichtiges Veroffentlichungsformat fiir FrameMaker-Dokumentation, und die
Veroffentlichung von Bildern ist ein integraler Bestandteil dieses Ausgabevorgangs. In Update 3 wurden
viele neue Verbesserungen fiir die Veroffentlichung von Bildern in der HTML5-Ausgabe vorgenommen.

FrameMaker verbessert jetzt die Funktion, Bilder in lhren unstrukturierten Dokumenten zu referen-
zieren, wahrend Sie die HTML5-Ausgabe fiir sie erzeugen. FrameMaker behalt auch die Qualitat der
Bilder in der HTML5-Ausgabe Ihrer Dokumente bei.

Originalbild-Verweis

Die Beibehaltung der korrekten Dateinamen von Bildern ist wichtig, wenn Sie die HTML5-Ausgabe fir
Ihre Dokumente erstellen. Jetzt wird die folgende Namenskonvention fiir die verschiedenen Bilder
befolgt, die Sie in lhre unstrukturierten Dokumente importieren, wenn Sie die HTML5-Ausgabe fiir sie
erzeugen:

. Die Originalnamen der Bilder, auf die in dem Dokument verwiesen wird, bleiben unverandert
erhalten.

. Wenn es mehrere referenzierte Bilder mit demselben Namen gibt (Dateien mit demselben Namen,
die sich an verschiedenen Orten befinden), wird ihre Bild-ID als Suffix hinzugefligt, um die
Eindeutigkeit der Bilder zu erhalten. Beispielsweise Bildname BildID.

. Den Bildern, die in das Dokument kopiert wurden, wird ein neuer Name mit der Konven-
tionDokumentname BildID zugewiesen. Wenn Sie zum Beispiel zwei PNG-Bilder in Ihr Doku-
ment ,mydoc . fm“ kopieren, erhalten sie neue Namen wie ,meinDok 1.png"“und
»,meinDok 2.png“.

HINWEIS: Fir eine ordnungsgemalie Konvertierung von Bildern vermeiden Sie die Verwendung von
Sonderzeichen in den Bildnamen wie Hashtag (#), Apostroph (') und Ampersand (&).

Bildformate, die auf Webseiten unterstiitzt werden

In den friiheren Versionen von FrameMaker durchliefen Bilder einen Konvertierungsprozess, wahrend
sie in der HMTL5-Ausgabe veroffentlicht wurden. Dabei wurde die GroRe der Bilder gedndert und die
Qualitat verringert. AuBerdem wurden GIF-Bilder als statische Bilder veroffentlicht.

Ab Update 3 von FrameMaker werden alle Bildformate, die auf Webseiten unterstiitzt werden (wie PNG,
SVG, JPG oder GIF), in Ihre unstrukturierten Dokumente importiert, in der HTML5-Ausgabe unverandert
beibehalten und nicht konvertiert. Die Skalierung der Bilder wird vom Browser gerendert, und Qualitat
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sowie angegebene BildgroRe werden beibehalten. Mit Update 3 kdnnen Sie auch GIF-Animationen in
Ihrer HTML5-Ausgabe wiedergeben und lhre Inhalte ansprechender gestalten.

Andere Bildformate

In friiheren Versionen von FrameMaker durchliefen andere Bildformate, die auf Webseiten nicht unter-
stltzt werden, wie BMP und TIFF, einen Konvertierungsprozess, wahrend sie in der HMTL5-Ausgabe
veroffentlicht wurden. Dabei wurden sie in GIFs umgewandelt, was zu einem Qualitatsverlust fihrte.

Ab Update 3 von FrameMaker werden andere Bildformate in JPG konvertiert. Dabei verbessert sich die
Qualitat der Bilder im Vergleich zu den Vorgangerversionen.

Weitere Informationen zu den Einstellungen fiir die HTML5-Ausgabe finden Sie unter Ausgabeeinstel-
lungen.

Figure 1: HTML5-Ausgabe eines Figure 2: HTML5-Ausgabe eines
(.png-)Beispielbildes in Update 2 (.png-)Beispielbildes in Update 3

Veraltete Version

Die folgende Funktion ist in FrameMaker nun veraltet:
Kennwortgeschiitzte PDF-Dateien

Die Funktion zum Kennwortschutz lhrer PDF-Datei ist seit Update 2 der

FrameMaker-Sommerversion 2020 veraltet. Da das Kennwort in der STS-Datei gespeichert wurde, hatte
dies zu einem Sicherheitsproblem fiihren kénnen. Sie kdnnen die PDF-Ausgabe jedoch aus FrameMaker
generieren, in Adobe Acrobat 6ffnen und dann ein Kennwort festlegen. In Acrobat kénnen Sie

Datei > Mit Kennwort schiitzen oder Werkzeuge > Schiitzen > Mit Kennwort schiitzen auswahlen.
Weitere Informationen finden Sie unter Sichern von PDF-Dateien mit Kennwaortern in der Adobe
Acrobat-Dokumentation.

HINwEIS: Wenn Sie ein Dokument veréffentlichen, das mit der alteren Einstellungsdatei (STS) gespeichert
wurde (alter als FrameMaker Update 3) und lber ein Sicherheitskennwort verfiigt, wird ein Konsolen-
protokollfehler angezeigt. Sie missen ein Upgrade auf die neueste Einstellungsdatei (STS) Uber die ange-
zeigte Upgrade-Aufforderung durchfiihren. Der Konsolenprotokollierungsfehler tritt nicht mehr auf,
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nachdem Sie die Einstellungsdatei (STS) aktualisiert haben. Weitere Informationen finden Sie unter
PDF-Einstellungen.
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Neue Funktionen in Adobe FrameMaker Update 4

Erfahren Sie, welche Neuerungen die Adobe FrameMaker-Version fir Update 4 enthalt.

Update 4 von FrameMaker Version Sommer 2020 enthalt viele Verbesserungen, z. B. die Unterstiitzung
des Erstellens von Inhalten mithilfe des UUID-basierten Dateireferenzierungssystems, das Hinzufligen
von Beschriftungen wahrend des Eincheckens und die Bereitstellung von FDK als herunterladbare
ZIP-Datei.

Hinwels: Weitere Einzelheiten zu den in dieser Version behobenen Problemen finden Sie im Artikel Beho-
bene Probleme.

Werfen wir einen Blick auf die neuen und gedanderten Funktionen in Update 4 von FrameMaker:

Unterstiitzung von UUID-basierten Dateien fiir XML-Dokumentation fiir
Adobe Experience Manager als Cloud-Dienst

In der letzten FrameMaker-Version wurde der AEM Connector erweitert, um das Erstellen und Veroffen-
tlichen von Inhalten zu unterstiitzen, die das UUID-basierte Dateireferenzierungssystem verwenden.
Diese Funktion ist fir XML-Dokumentation fiir Adobe Experience Manager als Cloud-Dienst verfligbar
(Version vom Januar 2022 und spater). UUID-Dateien werden als flache Dateien ohne hierarchische
Ordnerstruktur heruntergeladen.

Jede Datei hat eine eindeutige UUID, mit der sie im Dateisystem identifiziert werden kann. Sobald Sie die
Dateien von AEM auf |hr System heruntergeladen haben, kdnnen Sie sie in FrameMaker bearbeiten und
veroffentlichen. Mit der flachen Dateihierarchie werden alle referenzierten Themen und Mediendateien
in einem einzigen Ordner gespeichert. Da alle Referenzen in der XML-Dokumentationslosung
UUID-basiert sind, unterstiitzt die flache Hierarchie die Pflege der Referenzen. Diese Verweise andern
sich nicht, auch wenn Sie die Dateien von einem Ort zum anderen verschieben.

Die folgenden Screenshots zeigen UUID-basierte Dateien, die in FrameMaker zur Bearbeitung getffnet
wurden. Im Buchfenster werden die UUIDs der Dateien angezeigt, die Teil der DITA Map sind. Wenn Sie
eine Datei 6ffnen, wird die UUID als Titel des Dokumentfensters angezeigt.

cture eview  Window lldp
CDPD S S RO TEEE =
wea — ~[[i]T T T 7.

eference » title

F ¥ i <« >
E== 2 <!DOCTYPE refer: PUBLIC "-//0ASIS//DTD DITA Composite//EN" "technicalContent/dtd/ditabase.dtd">
3 <reference id="1d_CZi5X12Nc "

4 <titlerTakeoff</titler
5 <shortdescyThe maximum airsoeed for the venicle is 492 knots eguivalent airspeed (KEAS) where
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13 <fig 1d="i721322">
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Figure 1:  Flache UUID-Hierarchie Figure 2:  Referenzen in einer UUID-basierten Datei
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NEUE FUNKTIONEN IN ADOBE FRAMEMAKER UPDATE 4

Das Authoring von UUID-Dateien ist eine erweiterte Funktion in FrameMaker und unterstltzt verschie-
dene Dateioperationen wie Auschecken, Einchecken und Aktualisieren. Weitere Einzelheiten zu
Dateivorgangen finden Sie unter Arbeiten mit Dateien.

Weitere Informationen zur Aktivierung der UUID-basierten Dateireferenzierung Giber FrameMaker
finden Sie unter Aktivieren der Unterstiitzung UUID-basierter Dateien.

Hinzufiigen von Bezeichnungen beim Uberpriifen von Dateien in AEM

Mit der neuesten Version bietet FrameMaker eine Funktion, mit der Sie beim Einchecken lhrer Dateien
die in der XML-Dokumentationslosung definierten Bezeichnungen (Metadaten) verwenden kénnen.

Die in der XML-Dokumentationslésung definierten Bezeichnungen erscheinen als Dropdown-Liste, aus
der lhre Benutzer mehrere Bezeichnungen auswahlen kénnen. Das erleichtert die Erstellung einheitli-
cher Bezeichnungen. So kénnen lhre Fachexperten in der XML-Dokumentationsldsung beispielsweise
Bezeichnungen wie , Technische Uberpriifung”, ,,Redaktionelle Uberpriifung” oder , Qualititsiiberprii-
fung” definieren. Benutzer kénnen diese dann in FrameMaker verwenden, um die Versionen beim
Einchecken ihrer Dateien zu definieren. Nach dem Einchecken Ihrer Dateien werden die Bezeichnungen
zum Einchecken im Versionsverlauf des Dokuments in der Benutzeroberflache der XML-Dokumentation-
slésung angezeigt.

Der folgende Screenshot zeigt die Dropdown-Liste der Bezeichnungen, die in der XML-Dokumentation-
slosung definiert wurden und angezeigt werden, wenn Sie lhre Dateien in FrameMaker einchecken.

Checkin *
atopichi
Cument Version: Latest
Version Label: TesiLabel1 TestLabel2 V|
Checkin Comment [v| Testlabel?
[ | Testlabel3
Cancel

Wenn lhre Bezeichnungen nicht in der XML-Dokumentationslésung definiert sind, kénnen Sie in
FrameMaker durch Kommata getrennt neue hinzufiigen.

Weitere Einzelheiten finden Sie unter Hinzufiigen von Beschriftungen beim Uberpriifen von Dateien in
AEM.

Auf dem neuesten Windows 11-Betriebssystem getestet und zertifiziert

Ab Update 4 ist Adobe FrameMaker 2020 auf dem neuesten Windows 11-Betriebssystem getestet und
zertifiziert. Alle Funktionen von FrameMaker Update 4 funktionieren auch unter Windows 11 und 10.
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NEUE FUNKTIONEN IN ADOBE FRAMEMAKER UPDATE 4

Update 3 und friihere Versionen von FrameMaker 2020 Release funktionieren weiterhin unter
Windows 10.

FDK als ZIP-Datei zur Verfiligung gestellt

Mit dem Adobe FrameMaker Developer Kit (FDK) kdnnen Sie Plug-Ins erstellen, die lhre Anforderungen
an die Produktion von Inhalten erfiillen. Mit Update 4 von FrameMaker 2020 wird FDK nun als ZIP-Datei
zur Verfligung gestellt. Sie konnen die Datei herunterladen und entpacken, um loszulegen. Dieses neue
Verfahren l6st das Problem, dass die bestehende Version des FDK-Ordners tberschrieben wird, wenn
eine neue Version des FDK installiert wird.

Sie konnen die FDK-ZIP-Datei unter Adobe.io herunterladen.
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WEITERE FRAMEMAKER-FUNKTIONEN (VERSION 2019)

Weitere FrameMaker-Funktionen (Version 2019)

Erfahren Sie mehr tiber weitere FrameMaker-Funktionen aus der Version 2019, die lhnen helfen, lhre
Dokumente einfach zu erstellen und zu veroffentlichen.

Schnellere Dateileistung

Mit Verbesserungen in den Dateivorgangen und der Veroffentlichungs-Engine erhalten Sie eine viel
bessere Erfahrung, wenn Sie einen Dateivorgang oder eine Veroffentlichungsaufgabe ausfiihren.
Vorginge wie das Offnen und Speichern einer Datei sind viel schneller und reibungsloser. Die Zeit,
die zum Offnen oder Veréffentlichen von Dateien im PDF- oder Responsive HTML5-Format benétigt
wird, ist viel kiirzer.

Sehen Sie sich ein Video unter Schnellere Dateileistung an.

Interaktive Echtzeit-Fortschrittsleiste

Mit der Einflihrung informativer Fortschrittsleisten wissen Sie immer, in welchem Stadium sich ein
Buchaktualisierungs- oder Veroffentlichungsprozess befindet. Wenn Sie beispielsweise ein Buch
aktualisieren, zeigt die Fortschrittsleiste den Status an, z. B. Offnen einer Datei, Verarbeiten einer
Datei, Erstellen von Indexdateien. Wenn Sie eine Veroffentlichungsaufgabe ausfihren, zeigt die
Fortschrittsleiste in dhnlicher Weise an, welche Verarbeitung flir die Dateien ausgefiihrt wird, z. B.
Datei 6ffnen, Konvertierungsprozess, Anwendung einiger Transformationen und so weiter.

Die folgenden Screenshots wurden in verschiedenen Phasen der Buchaktualisierungs- und
Veroffentlichungsaufgaben erfasst.
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WEITERE FRAMEMAKER-FUNKTIONEN (VERSION 2019)

Saving as PDF

Converting Legal fm

Preparing document ...

Updating book

Saving as book with Fm components
Scanning contacts fm
Cipening m_systems ditamap -
- - Traversing document ...
Saving as PDF

Creating composite document of ditamap...

Cpening m_systems ditamap

Sehen Sie sich ein Video unter Interaktive Echtzeit-Fortschrittsleiste an.

Verbesserte Bildverarbeitung

Das gleichzeitige Einfigen mehrerer Bilder war in FrameMaker eine Herausforderung. Mit dieser
Version kénnen Sie jedoch Hunderte von Bildern ohne Verzogerung in Ihr Dokument importieren.
Mit dem neuen Bildbearbeitungsprozess funktioniert das Scrollen durch |hr viele Bilder enthal-
tendes Dokument nahtlos.

Sehen Sie sich ein Video unter Verbesserte Bildbearbeitung an.

StandardmaRige Unterstiitzung fiir Microsoft SharePoint 2016

Der Verbindungs-Manager unterstitzt jetzt Microsoft SharePoint Online- und Microsoft SharePoint
2016-Server. Greifen Sie auf lhre Dateien von der neuesten Version des SharePoint-Servers zu,
ohne ein Drittanbieter-Plugin zu verwenden.

Sehen Sie sich ein Video unter Standardmalige Unterstitzung fir Microsoft SharePoint 2016 an.

Schneller Zugriff auf den BegriiBungsbildschirm

Der Begriifsungsbildschirm (auch bekannt als Startbildschirm) ist jetzt Gber das Dropdown-Menii
»Arbeitsbereich” verfligbar. Der BegriifSungsbildschirm bietet schnellen Zugriff auf kirzlich bearbe-
itete Dokumente, Dokumentvorlagen, Repository-Verbindungen und vieles mehr. AuRerdem kann
der Begriifsungsbildschirm gemal} lhren Authoring- und Publishing-Anforderungen angepasst
werden. Sie kdnnen beispielsweise Verknlipfungen zu den am haufigsten verwendeten Dokument-
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WEITERE FRAMEMAKER-FUNKTIONEN (VERSION 2019)

vorlagen hinzufligen oder Anweisungen zum Erstellen eines bestimmten Dokumenttyps bereit-
stellen. Sie haben jetzt jederzeit Zugriff auf den BegriiBungsbildschirm, ohne lhre ge6ffneten
Dokumente zu schlieRen.

[XML/Structured - ]l - | & | X J

Authoring
Blank
Design
Manage Graphics
Review
v XML/Structured

Save workspace
Manage workspace

Reset workspace

Show Welcome Screen

Weitere Informationen finden Sie unter Begriifsungsbildschirm.

Neue Duden-Worterbuchunterstiitzung
Die Unterstlitzung fiir deutsche Worterblicher wurde komplett Gberarbeitet. Aus dem friiheren
Hunspell-Woérterbuch unterstitzt FrameMaker nun das Duden-Worterbuch fiir deutsche Benutzer.
Das Duden-Wérterbuch wird regelmaRig aktualisiert und ist eines der von deutschen Benutzern am
haufigsten verwendeten Woérterblicher.

Preferences X
= Global Dictionary Provider Settings
General — German - Austria (2006 Reform) "
~Graphics [Speling 1) -
Interface Hyphenation
- Alerts — German - Germany (1901 Duden: Konservativ
Launch Spellng Duden: Towran
- Dropbox yphenation T P
—| German - Germany (1996 Reform)
ECMS .
Spelling Duden
= Spelling Hyphenation Duden All
Dictionary —/ German - Germany (2006 Reform)
~Smart Quotes Spelling Duden
Spelling Options Hyphenation Duden All
XML Thesaurus Proximity
MathML = Ge@an - Swiss (1901 OId rules)
Spelling Hunspell
Hyphenation Hunspell
Thesaurus Proximity
—| German - Swiss (1996 Reform)
Spelling Duden
Hyphenation Duden All
—| German - Swiss (2006 Reform) v
OK Cancel

Sehen Sie sich ein Video unter Neue Duden-Woadrterbuchunterstitzung an.
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WEITERE FRAMEMAKER-FUNKTIONEN (VERSION 2019)

Interaktive HTML5-Dialogfelder fiir Plug-Ins

FrameMaker unterstiitzt jetzt Rich HTML5-Dialogfelder. Mit HTML5, CSS3 und JavaScript kénnen
Sie interaktive HTML5-Dialogfelder fiir die Plug-Ins erstellen, die Sie flir hre Benutzer erstellen. Die
Unterstitzung flr interaktive HTML5-Dialogfelder reduziert den Aufwand, der friiher zum Erstellen
von Dialogfeldern mit DRE-Dateien bendtigt wurde, erheblich.

Neues Windows-basiertes Dialogfeld zum Offnen von Dateien

Das vorhandene Dialogfeld , Datei 6ffnen” wurde erweitert, um eine nahtlosere Arbeitserfahrung
zu ermoglichen. Das Dialogfeld , Datei 6ffnen” basiert auf der leistungsstarken nativen Dialogfeld-
technologie von Windows, die eine Vielzahl von Anpassungsoptionen bietet.

WebP und ICO Bildunterstiitzung

FrameMaker unterstiitzt jetzt das Importieren von WebP- und ICO-Bildern (Symbolbilder) in Ihren
Dokumenten. Das WebP-Bildformat wurde von Google entwickelt und unterstiitzt sowohl verlust-
behaftete als auch verlustfreie Komprimierung. Es gilt aufgrund seiner kleineren Dateigrof3e und
besseren Bildqualitat als Alternative zu PNG- und JPEG-Dateiformaten. Wahlen Sie beim Einfligen
eines Bildes das Format WEBP (*.webp) oder ICO (*.ico) aus der Dropdown-Liste Dateityp um
Ihrem Dokument ein WebP oder ein Symbolbild hinzuzufiigen.

Mehr Kontrolle tiber PDF

Die neue PDF-Generierung enthalt umfassende Veroffentlichungseinstellungen. Die Einstellungen
fir die PDF-Veroffentlichung sind in flinf Kategorien aufgeteilt: Allgemein, Marken und Anschnitte,
DITA-Vorlage und DITA-Optionen.

Mit den allgemeinen Einstellungen kénnen Sie die Ausgabevoreinstellung, den PDF-Standard, die
Kompatibilitat, Anzeigeoptionen und mehr konfigurieren. Mit der Einstellung ,,Marken und
Anschnitt” kdnnen die Zuschneide-, Anschnitt- und Registrierungsmarkierungen sowie die
Anschnitt- und Slug-Einstellungen festgelegt werden. Mit den Einstellungen fir DITA-Vorlagen
werden die Vorlagen konfiguriert, die Sie zum Veroffentlichen des Dokuments verwenden
mochten. Wenn Sie schlielllich die PDF-Datei tiber ein Buch speichern mochten, kdnnen Sie mit den
DITA-Optionen festlegen, was in der veroffentlichten PDF-Datei ein- oder ausgeschlossen werden
soll.

Weitere Informationen finden Sie unter PDF-Ausgabe.

WYSIWYG-Farbausgabe

Beim Generieren der PDF-Ausgabe miissen Sie nicht mehr die RGB- oder CYMK-Farbeinstellungen
auswahlen. Die neue Technologie zur PDF-Generierung veroffentlicht die gleichen Text- und Bild-
farben wie beim Authoring. Dadurch erhalten Sie ein einheitliches Erscheinungsbild Ihres Doku-
ments, unabhangig davon, ob Sie die verdffentlichte Ausgabe erstellen oder anzeigen.

Schnellere Handhabung von XML-Dateien

FrameMaker verwendet eine neue Java-basierte XML-Parsing-Engine, die die zum Analysieren von
XML-Dateien erforderliche Zeit erheblich reduziert. Mit der neuen Parsing-Engine ist das Offnen,
Bearbeiten, Speichern oder sogar Verpacken lhrer XML-Dateien viel schneller.

Sehen Sie sich ein Video unter Schnellere Handhabung von XML-Dateien an.
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WEITERE FRAMEMAKER-FUNKTIONEN (VERSION 2019)

Miihelose Erstellung von EDDs

Die EDD-Erstellung kann ein zeitaufwandiger und komplexer Prozess sein. FrameMaker bietet
Ihnen jetzt eine benutzerfreundliche Oberflache, mit der Sie EDD schnell und einfach erstellen
konnen. Diese neue EDD-Erstellungsfunktion unterstitzt die Dokumenttypen Lightweight DITA und
DITA 1.3.

Das neue Plug-In DITA anpassen verwendet das RELAXNG-Schema. Derzeit wurden in diesem
Plug-In die Spezifikationen DITA 1.3 und Lightweight DITA verwendet. Sie kdnnen die vorhandenen
DITA-Shells anpassen, indem Sie innerhalb einer Shell Module, Domadnen oder Elemente
einschlieRen oder ausschlieBen. AuBerdem kdnnen Sie mit dem Plug-In einfach ein CSS anwenden,
um dem DITA-Topic ein neues Erscheinungsbild zu geben. Sobald Sie lhre Anpassungen vorge-
nommen haben, kdnnen Sie ein neues Dokument erstellen, indem Sie einfach im Men( Datei > Neu
> DITA wahlen.

Weitere Informationen finden Sie im Thema Anpassen von DITA mithilfe des Plugins im Handbuch
zum Anpassen von DITA fir Adobe FrameMaker.

Saxon Enterprise Edition

FrameMaker wird mit SAXON Enterprise Edition ausgeliefert. Sie kdnnen eine Vielzahl von Vor-
und Nachbearbeitungsszenarien erstellen oder die XSLT-Transformation fiir XML-Dateien
ausfiihren. Sie konnen den Umfang der Transformationsaufgaben definieren, die fiir eine Datei, alle
Dateien in einem Ordner, DITA Map oder alle untergeordneten Themen eines Buchs ausgefihrt
werden sollen und die Moglichkeiten von XPATH 3.0 und XSLT 3.0 sowie das Leistungspotenzial der
SAXON Enterprise Edition nutzen.

Unterstiitzung fiir XPATH 3.0

FrameMaker unterstiitzt XPATH 3.0 Gber SAXON Enterprise Edition. Verwenden Sie
XPath-Abfragen, um Elemente und Attribute in einem langen XML-Dokument schnell zu finden. Mit
dem Abfrage-Generator kénnen Sie problemlos benutzerdefinierte XPath-Abfragen erstellen,
Vorschlage abrufen, den Umfang der Abfragen definieren, das Dropdown-Menii ,Verlauf”
verwenden und die Suchergebnisse zur spateren Verwendung speichern.

Unterstiitzung fiir XSLT 3.0

FrameMaker unterstiitzt XSLT 3.0 Gber den SAXON Enterprise Edition-Prozessor. Sie kdnnen eine
Vielzahl von Transformationsszenarien erstellen, indem Sie vordefinierte oder angepasstes XSLT
auf XML-Dateien anwenden und sie mit einer Reihe von JAXP-kompatiblen Prozessoren ausfiihren.
Sie kdnnen den Umfang der Transformationsaufgaben definieren, die fiir eine Datei, alle Dateien in
einem Ordner, DITA Map oder alle untergeordneten Themen eines Buchs ausgefiihrt werden
sollen.

Verbesserter Packager

Der Paketmanager wurde erweitert, um Pakete mit Unterstiitzung der neuen Parsing-Engine
schnell zu erstellen. Sie kdnnen auf einfache Weise ein eigenstandiges Paket mit Ihren Doku-
menten, Blichern oder DITA Maps erstellen —einschlieRlich aller referenzierten Dateien, Bilder und
Konfigurationen.

Weitere Informationen finden Sie unter Erstellen von Paketen.
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Sehen Sie sich ein Video unter Verbesserter Packager an.
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SYSTEMANFORDERUNGEN

Systemanforderungen

Erfahren Sie mehr Gber die Systemanforderungen fiir die Installation von Adobe FrameMaker.

Stellen Sie vor Installation von FrameMaker sicher, dass Sie Gber die erforderliche Hardware und Soft-
ware verfligen:

. Core i5-Prozessor oder schneller

. Nur 64-Bit-Versionen (32-Bit wird nicht unterstiitzt)

. Microsoft® Windows® 10

. 4 GB RAM oder hoher

. 64 GB freier Festplattenspeicher fir die Installation; zusatzlicher freier Festplattenspeicher
wahrend der Installation erforderlich (die Installation auf Dateisystemen, die zwischen GroR3- und
Kleinschreibung unterscheiden, oder Flash-Wechselspeichermedien ist nicht moglich).

. JRE 8 (ist fiir den Veréffentlichungsprozess erforderlich)

HINWEIS: Hochste unterstiitzte Auflésung: 4K (3.480 x 2.160 Pixel, 8,3 Megapixel, Seitenverhéltnis 16:9)

Die Software funktioniert nicht ohne Aktivierung. Fiir die Aktivierung der Software, die Validierung von
Abonnements und den Zugriff auf Online-Dienste sind eine Internetverbindung und eine Registrierung
erforderlich.

HINWEIS: Eine Aktivierung per Telefon ist nicht moglich.

Verfiigbare Benutzeroberflaichensprachen

FrameMaker ist in folgenden Sprachen verfligbar:
. Englisch

. Franzdsisch

. Deutsch

. Japanisch

RELATED LINKS:
Detaillierte Systemanforderungen
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INSTALLATION UND REGISTRIERUNG

Installation und Registrierung

Befolgen Sie diese Anweisungen, um FrameMaker auf Ihrem Computer einzurichten.

Das Installationsprogramm von FrameMaker basiert auf der neuesten Installationstechnologie von
Adobe. Das Installationsprogramm bendtigt weniger Platz und ist schnell.
Gehen folgendermaBen vor, um FrameMaker zu installieren:

1) Laden Sie das FrameMaker-Installationsprogramm von der Produktseite
https://www.adobe.com/de/products/framemaker/download-trial/try.html herunter.

2)  SchlielRen Sie alle Adobe- und Microsoft-Anwendungen.

3) Doppelklicken Sie im Download-Ordner auf Set-up.exe, um den Installationsprozess zu starten.
Befolgen Sie die Anweisungen auf dem Bildschirm, um die Installation durchzufiihren.

4)  Starten Sie nach Abschluss der Installation FrameMaker.

Wahrend des Installationsverfahrens stellt die Adobe-Software eine Verbindung zu einem Adobe-Server
her, um die Lizenzaktivierung abzuschlieBen. Dabei werden keine personlichen Daten tGbertragen.

Weitere Informationen zur Produktaktivierung finden Sie auf der Adobe-Website unter
https://helpx.adobe.com/download-install/kb/activate-deactivate-products.html

HINWEIS: Wenn Sie lhre FrameMaker-Instanz aus irgendeinem Grund deaktivieren mochten, klicken Sie
auf Hilfe > Abmelden

. Sie werden aufgefordert, alle nicht gespeicherten Dokumente zu speichern, bevor die
FrameMaker-Anwendung geschlossen wird.

Mehrere Versionen von FrameMaker kdnnen parallel auf Ihrem Computer installiert sein.
Der standardmalige FrameMaker-Installationspfad auf einem 64-Bit-System lautet:
C:\Programme\Adobe\AdobeFrameMaker2020

In diesem Handbuch wird der standardmaRige Installationsspeicherort von FrameMaker als <Fm_Instal-
lationspfad> bezeichnet.
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LERNRESSOURCEN

Lernressourcen

Erhalten Sie Zugriff auf die neuesten Lernressourcen von Adobe FrameMaker.

Ressource

URL

Adobe FrameMaker-Benutzerhandbuch
(PDF)

http://www.adobe.com/go/learn_fm16_ug de

Handbuch fiir erste Schritte mit Adobe
FrameMaker

http://www.adobe.com/go/learn_fm_16 _gsg de

Einfihrung in Adobe FrameMaker

http://www.adobe.com/go/learn_fm_16_intro_de

Videotutorials

https://helpx.adobe.com/de/framemaker/video-hub.
html

Haufig gestellte Fragen

http://www.adobe.com/go/learn_fm_faq_de

Systemanforderungen

http://www.adobe.com/go/learn_fm_sys_req_de

Adobe FrameMaker
Benutzer-zu-Benutzer-Forum

https://community.adobe.com/t5/framemaker/bd-p/f
ramemaker

Adobe TechComm-Blog

http://blogs.adobe.com/techcomm/

Adobe TechComm auf Twitter

https://twitter.com/adobetcs

Adobe TechComm auf Facebook

https://www.facebook.com/adobetcs/

Adobe TechComm auf YouTube

https://www.youtube.com/user/AdobeTCS/

Adobe TechComm LinkedIn-Gruppe

https://www.linkedin.com/groups/2381149/

Adobe FrameMaker LinkedIn-Gruppe

https://www.linkedin.com/groups/2204291/

Adobe Schulungs- und Beratungspartner

https://partners.adobetechcomm.com

Plug-Ins/Add-Ons von Drittanbietern

https://partners.adobetechcomm.com//view_all_dow
nloads
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GRUNDLAGEN IN FRAMEMIAKER

Grundlagen in FrameMaker

Beginnen Sie mit einer Einflihrung in die Grundlagen von Adobe FrameMaker.

Adobe FrameMaker bietet eine umfangreiche Benutzeroberflache, auf der Sie alle Authoring- und
Veroffentlichungsaufgaben problemlos ausfiihren kénnen.

Erfahren Sie mehr Gber die verschiedenen Elemente der Benutzeroberflache von FrameMaker, wie Sie
mit dem Erstellen eines Dokuments beginnen und wie Sie mit bidirektionalem Inhalt arbeiten.
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BENUTZEROBERFLACHE

Benutzeroberflache

Erfahren Sie, wie Sie mit der Benutzeroberflaiche von Adobe FrameMaker arbeiten

Weitere Informationen zur Benutzeroberflache finden Sie in den Unterthemen.
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BegriiBungsbildschirm

Lernen Sie den Begriilungsbildschirm in FrameMaker und die Aufgaben kennen, die gemaR der entspre-
chenden, im BegriRRungsbildschirm ausgewahlten Option ausgefiihrt werden kdénnen.

FrameMaker zeigt abhangig vom aktuellen Modus einen BegriiBungsbildschirm an.

Der BegriiBungsbildschirm bietet Optionen zum Durchfiihren haufig verwendeter Aufgaben, die fiir den
aktuellen Modus von FrameMaker relevant sind.

Offnen eines zuletzt verwendeten Projekts oder Dokuments
Im Modus FrameMaker: Erstellen neuer Projekte, Dokumente, Blicher

Im Modus Strukturierter FrameMaker: Erstellen von DITA Maps, DITA-Dateien, XML-Dateien,
Andern der DITA-Version

Suchen nach und Offnen von Dateien

Erstellen einer neuen CMS-Verbindung, Offnen einer zuletzt verwendeten Verbindung, Suchen
nach Dateien am Remote-Speicherorten anhand ihrer URL

FrameMaker-Vorlagen

FrameMaker-Lernressourcen

Zugriff auf Support, Produktaktualisierungen, Developer Center, Foren, Marketing-Inhalt
Wiederherstellen der letzten Sitzung

Sie kdnnen auch den BegriRRungsbildschirm anpassen, indem Sie dort Informationen neu anordnen oder
hinzufligen. Die Anpassung des BegriRRungsbildschirms erfolgt durch Aktualisieren der Datei
welcome.html, die an folgendem Ort verfligbar ist:

$appdata%$\Adobe\FrameMaker\16\resources\welcomeScreen\

Der Begriifungsbildschirm, wie in der folgenden Abbildung dargestellt, wird beim Starten von
FrameMaker im strukturierten Modus angezeigt.
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Figure 1:  BegriiBungsbildschirm

HINWEIS: Um den neuen Begriifsungsbildschirm optimal nutzen zu kdnnen, wird empfohlen, Internet
Explorer ab Version 11 zu verwenden. Wenn Sie eine friihere Version von Internet Explorer verwenden,
sieht der Begriifungsbildschirm moglicherweise verzerrt aus.

Zugriff auf den BegriiBungsbildschirm

Der BegriiBungsbildschirm wird standardmaRig beim Start von FrameMaker angezeigt. Wenn Sie ein
Dokument erstellen oder ein vorhandenes Dokument 6ffnen, wird das Dokument in einem Fenster mit
Registerkarten angezeigt. Zu diesem Zeitpunkt dndert sich der BegriifSungsbildschirm aullerdem in ein
Registerkartenfenster. Sie kénnen auf den BegriifSungsbildschirm zugreifen, indem Sie zur Registerkarte
des BegruBungsbildschirms wechseln.

Waéhrend der Arbeit miissen Sie moglicherweise den BegriiBungsbildschirm schlieBen. Um den
Begriifsungsbildschirm neu zu starten, wahlen Sie BegriiBungsbildschirm anzeigen im Umschalterment
Arbeitsbereich aus.

RELATED LINKS:
Arbeitsbereiche
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Arbeitsbereiche

Lernen Sie die Anordnung von Elementen und Fenstern in FrameMaker sowie die Typen von Arbeitsbere-
ichen und deren Funktionen kennen.

In diesem Thema

L Einflihrung

o Standardarbeitsbereiche

. Speichern eines benutzerdefinierten Arbeitsbereichs

. Wechseln der Arbeitsbereiche

J Zurlicksetzen eines Arbeitsbereichs

. Umbenennen eines benutzerdefinierten Arbeitsbereichs

J Léschen eines benutzerdefinierten Arbeitsbereichs

Einfiihrung

Eine bestimmte Anordnung von Elementen, zum Beispiel Fenster, die Sie beim Bearbeiten von Doku-
menten haufig verwenden, nennt man Arbeitsbereich. Sie konnen diese Elemente andocken, stapeln,
minimieren oder schwebend tUber dem Arbeitsbereich platzieren. Sie kénnen aus mehreren
vordefinierten Arbeitsbereichen auswahlen oder einen eigenen Arbeitsbereich erstellen. Wenn Sie die
Fenster angeordnet haben, konnen Sie die Einstellungen fiir den Arbeitsbereich speichern, um spater
wieder darauf zurtickgreifen zu kénnen.

Die FrameMaker-Oberflache besteht aus folgenden Komponenten.

. Die Anwendungsleiste, die quer am oberen Rand verlduft, enthalt die Moglichkeit zum Umschalten
zwischen den einzelnen Arbeitsbereichen. Darliber hinaus enthalt sie Menis und andere Elemente
zur Anwendungssteuerung.

. Im Dokumentfenster sehen Sie die Datei, an der Sie gerade arbeiten. Dokumentfenster lassen sich
in Form von Registerkarten anordnen; in einigen Fallen ist auch das Gruppieren und Andocken
moglich.

. Fenster helfen Ihnen beim Uberwachen und Veriandern lhrer Arbeit. Beispiele: Fenster fiir Zeichen-,

Absatz- und Tabellengestaltung sowie Fenster fiir Marken, Variablen und Querverweise. Sie
kénnen Fenster minimieren, gruppieren, stapeln oder andocken.

. Die Statuszeile bietet Textformatierungs- und Seitenumbruchinformationen zum aktuellen Doku-
ment. Bei strukturierten Dokumenten zeigt die Statusleiste auch den genauen Pfad des derzeit
ausgewadhlten Elements als Breadcrumbs an.

Standardarbeitsbereiche

Sie kdnnen aus Standardarbeitsbereichen auswahlen oder benutzerdefinierte Arbeitsbereiche erstellen
und zwischen ihnen wechseln. Standardarbeitsbereiche sind fir ein schnelles Wechseln zwischen den
Arbeitsbereichen vorgesehen und auf die auszufiihrende Arbeit abgestimmt. Beispiel: Der Review-Arbe-
itsbereich hat Review-Symbolleisten, hdufig verwendete Fenster und bereits angeordnete Fenster, die
Sie beim schnellen Review eines Dokuments unterstitzen sollen.

. Authoring
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. Leer

. Gestaltung

. Verwalten von Grafiken

. Review

. XML/Strukturiert (nur im strukturierten FrameMaker verfligbar)

Speichern eines benutzerdefinierten Arbeitsbereichs

1) Konfigurieren Sie den Arbeitsbereich entsprechend, und wahlen Sie in der Anwendungsleiste im
Arbeitsbereich-Umschalter Arbeitsbereich speichern.

2)  Geben Sie einen Namen fiir den Arbeitsspeicher ein, und klicken Sie auf OK.

FrameMaker erinnert sich in jeder Sitzung an den zuletzt verwendeten Arbeitsbereich. Wenn Sie z. B. im
Review-Arbeitsbereich arbeiten und anschlieBend FrameMaker schlieffen und erneut starten, wird der
Review-Arbeitsbereich geladen.

Wechseln der Arbeitsbereiche

Um den Arbeitsbereich zu wechseln, wahlen Sie im Arbeitsbereich-Umschalter auf der Anwendung-
sleiste einen Arbeitsbereich aus.

© | Authoring -~ |= o] X
| Authoring

Blank

Design

Manage Graphics

Review

KML/Structured

Save workspace
Manage workspace

Reset workspace

Show Welcome Screen

Figure 1: Verwenden Sie den Arbeitsbereich-Umschalter, um zwischen Arbeitsbereichen im Arbeitsablauf zu
wechseln.

Zuriicksetzen eines Arbeitsbereichs

Wenn Sie die aktuelle Konfiguration von Fenstern als benannten Arbeitsbereich speichern, kdnnen Sie
den Arbeitsbereich wiederherstellen, auch nachdem ein Fenster verschoben oder geschlossen wurde.
Die Namen gespeicherter Arbeitsbereiche werden im Arbeitsbereich-Umschalter auf der Anwendung-
sleiste angezeigt.

Wahlen Sie im Arbeitsbereich-Umschalter auf der Anwendungsleiste Arbeitsbereich zuriicksetzen aus.
Umbenennen eines benutzerdefinierten Arbeitsbereichs

1)  Wahlen Sie im Arbeitsbereich-Umschalter auf der Anwendungsleiste Arbeitsbereich verwalten.
2)  Waihlen Sie den Arbeitsbereich, und klicken Sie auf Umbenennen.
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3) Geben Sie einen neuen Namen ein, und klicken Sie zweimal auf OK.

Léschen eines benutzerdefinierten Arbeitsbereichs

Wihlen Sie im Arbeitsbereich-Umschalter auf der Anwendungsleiste die Option Arbeitsbereich
verwalten aus, wahlen Sie den Arbeitsbereich aus und klicken Sie dann auf Loschen.
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Dokumentfenster

Machen Sie sich mit dem Dokumentfenster und Dokumenten mit Registerkarten in Adobe FrameMaker
vertraut.

Beim Offnen eines strukturierten oder FrameMaker-Dokuments wird ein Dokumentfenster gedffnet. In
diesem Fenster wird das Dokument angezeigt, wobei der Text formatiert ist, alle Grafiken und sonstige
Elemente so wie im fertigen Dokument angeordnet sind und die gesamte Seite im Seitenlayout angezeigt
wird. Wenn Sie mehrere Dokumente 6ffnen, erscheint jedes Dokument in einem eigenen Dokumentfen-
ster.

Das Dokumentfenster ist das einzige im FrameMaker-Standardarbeitsbereich verfiigbare Fenster. Im
strukturierten FrameMaker-Arbeitsbereich kdnnen Sie auch die Elementgrenzen im Dokumentfenster
anzeigen.

Dokumente mit Registerkarten

Wenn Sie mehr als eine Datei 6ffnen, werden die Dokumentfenster als Registerkarten angezeigt. Sie
konnen Dokumente als gleitende Fenster 6ffnen, indem Sie die Option Dokumente als Registerkarten
o6ffnen in Voreinstellungen > Allgemein > Benutzeroberfldche |6schen.

Untitledl.fm x | Untitled2fm x | Untitled3.fm x |
lo_. 1 . [1 1 . 2, 1 . 3, 1
i EUIL} AT T AT
N Zip Code
5] Dear Sir:
Ridebis, et licet rideas. Ego ille «
fmmam s Bl e U Gam oman mim b ol emmdi o

Figure 1: In der Dokumentenansicht werden Dokumente als Registerkarten angezeigt

Wenn Sie jedoch eine generierte Datei wie zum Beispiel ein Inhaltsverzeichnis hinzufligen, erscheint

diese minimiert links unten in Ihrem Arbeitsbereich. Sie haben mehrere Méglichkeiten zum Anordnen

von gleitenden und angedockten Dokumentfenstern.

. Wenn Sie ein Dokumentfenster an eine Gruppe von Fenstern andocken méchten, ziehen Sie das
Fenster in die Gruppe.

. Wenn Sie die Anordnung der Dokumentfenster andern mochten, ziehen Sie die Registerkarte eines
Fensters an die gewlinschte neue Position in der Gruppe.

. Wenn Sie ein Dokumentfenster aus einer Gruppe von Fenstern abdocken mochten, ziehen Sie die
Registerkarte des Fensters aus der Gruppe heraus.

HINWEIS: Wenn Sie ein gleitendes Dokumentfenster minimieren, verdeckt es einen Teil der
FrameMaker-Statuszeile. Sie kdnnen das minimierte Fenster nicht an einen neuen Ort verschieben.

Es gibt verschiedene andere Aufgaben, die Sie (iber das Kontextmeni eines Dokuments mit Registerk-
arten ausfiihren kénnen. Klicken Sie mit der rechten Maustaste auf das Dokumentfenster mit Registerk-
arten, und Sie konnen die folgenden Aufgaben ausfiihren:

. Dokumentfenster konsolidieren
. SchlieBen der ausgewahlten Registerkarte oder aller ge6ffneten Dokumente
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Verschieben der ausgewadhlten Registerkarte in ein neues Fenster
Offnen des Speicherorts der Datei im Windows Explorer

Erstellen eines Dokuments

Offnen von Dokumenten
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Fenster

Lernen Sie Adobe FrameMaker-Fenster kennen, und erfahren Sie, wie sie in einem Arbeitsbereich
angeordnet werden kdnnen.

Fenster sind gleitende Fenster mit einer Benutzeroberflache, die lhre Arbeit erleichtert.

Die wichtigsten in FrameMaker verfligbaren Fenster sind folgende:

Fenster ,,Bedingungs-Tags”
Fenster , Querverweise”
Fenster ,,Marken”

Fenster ,,Schriften”
Fenster ,,Einschiibe”
Fenster , Variablen”
Fenster ,Referenzen”
Fenster , Offene Dateien”
Prifkommentare

D Marker Text

Markers =
B—E 7 i & I v &—C
Search text | L %]
Mar... Docum... =~ Page Hement Tag 2
=9357: HZ_HeadingZ: 1.3.1 ... Cross-Ref Generl-Des... 13 <Unstructured:
20034: HZ2_HeadingZ: 1.3.2 ... Cross-Ref Geneml-Des... 18 <Unstructured:>
21943: H1_Headingl: 1.1 Hi... Cross-Ref General-Des... 8 <Unstructured:
22811 H1_Heading1: 1.20... Cross-Ref General-Des... 11 <Unstructured

E CTEW Erea
drink dispenser
flight overview history of flight
gotoObjectld -2 939617
|_gotoObjectld :2 999682

nntoCihiectld -2 955711
<

24113 H2_Heading2: 1.3.3 ..
683597 H1_Heading1: 1.3 P...

Crosg Marker Text: 22811: H1_Heading1: 1.2 Overview

Crosy Marker Type: Cross-Ref

Indedf Docurment: General-Description.fm F
Inded Page: 11

Indes ElEment Tag: <Unstructured>

Hyperexd (General-Des... 7 <Unstructured:>

Hyperted General-Des... 7 <Unstructured:

Hwmedet Geneml-Nes 7

2| Instn icthored | b
>

Figure 1:  Fensterbenutzeroberflache

G
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A. Suchfenstereintrage — bei lhrer Eingabe durchsucht FrameMaker alle Spalten nach Treffern und zeigt
diese an. B. Fensterspezifische Symbolleistenschaltflachen. C. Filter, um das aktuelle Dokument, alle
gedffneten Dokumente oder ein bestimmtes Dokument auszuwahlen. D. Der Pfeil in der Spaltenkopf-
zeile zeigt die Sortierreihenfolge an. E. Bereich der Fensterliste. F. Quickinfo. G. In den Details jeder
Instanz ist die Position angegeben. Sie konnen die Position im Dialogfeld , Fensterpositionskriterien”
anpassen.

HINwWEIS: StandardmaRig werden Fenster im Bereich der Fensterliste im rechten Fensterbereich ge6ffnet.
Wenn Sie die Fenster verschieben, merkt sich FrameMaker die Fensterposition. Wenn Sie das nachste
Mal das Fenster 6ffnen, wird es an der Position angezeigt, an der es zuletzt geschlossen wurde.

SchlieRen von Fenstern und Registerkartengruppen

Fenster verfligen Uber eine Schaltflache auf der rechten Seite der Titelleiste. Klicken Sie auf diese Schalt-
flache, um ein Fenster oder eine Registerkartengruppe (Gruppe von Fenstern) zu schlieRen.

o]

g Close
i i Close Tab Group

Document -
Untitled 1 fm
Untitled 1 fm
Untitled 1 fm
Untitled 1 fm
Untithed 1 fm
Untitled 1 fm

Figure 2:  Schliefen von Fenstern und Registerkartengruppen
. SchlieBen: Schliel3t nur das Fenster im Fokus (in diesem Fall das Fenster ,,Marken®)
. Registerkartengruppe schlieBen: Schlief3t alle Fenster in der Registerkartengruppe

Wenn Sie auf den Titel eines Fensters doppelklicken, kdnnen Sie das Fenster sowie die gesamte Register-
kartengruppe, zu der das Fenster gehort, minimieren oder maximieren.

Bereich der Fensterliste

In der Dropdwon-Liste Auswahlen werden alle offenen Dokumente einschlieRlich Biicher und Ditamaps
aufgelistet.

Wenn Sie Alle ge6ffneten Dokumente auswahlen, werden im Bereich der Fensterliste alle Variablen aller
gedffneten Dokumente angezeigt. Wenn Sie ein bestimmtes gedffnetes Dokument auswahlen, werden
im Bereich der Fensterliste alle Variablen des ausgewahlten Dokuments angezeigt, auch wenn Sie zu
anderen geoffneten Dokumenten wechseln. Im Bereich der Fensterliste wird weiterhin die Liste der
Instanzen des ausgewahlten Dokuments angezeigt.

Wenn Sie die Option Aktuelles Dokument auswahlen, wird im Bereich der Fensterliste eine Liste der
Instanzen des ausgewahlten Dokuments angezeigt. Wenn Sie von einem Dokument zu einem anderen
Ubergehen, wird der Listenbereich aktualisiert. Wenn Sie jedoch von einem Fenster zu einem anderen
wechseln, missen Sie auf die Schaltflache Aktualisieren klicken.

Bei Auswahl eines gedffneten Dokuments (<Dateiname>) gilt Folgendes:

65



] Sie kdnnen auch auf eine Instanz im Fenster klicken, um die entsprechende Instanz im Dokument
anzuzeigen. Sie konnen beispielsweise eine Grafik aus dem Fenster ,Einschiibe” auswahlen, und
diese wird somit auch in der Dokumentansicht ausgewahlt.

. Durch Doppelklicken auf eine Instanz stehen die folgenden Méglichkeiten fiir jedes Fenster zur
Auswahl.

Die folgenden Fenster sind verflgbar:

Fenster ,,Bedingungs-Tags”
Zeigt das Fenster Bedingungs-Tag hinzufiigen/bearbeiten fur die ausgewahlte Bedingung an.

Fenster , Querverweise”

Zeigt das Fenster Querverweis fiir die Bearbeitung des ausgewahlten Querverweises an.

Fenster ,,Marken*

Zeigt das Fenster Marken an, sodass Sie die ausgewdhlte Markendefinition bearbeiten kénnen.

Fenster ,Schriften”
Zeigt das Fenster Schrift ersetzen zum Auswahlen einer Ersatzschrift an.

Fenster ,Einschiibe”

Zeigt das Fenster Objekteigenschaften fir den ausgewahlten Einschub an.

Fenster ,Variablen“

Fligt die ausgewahlte Variable an der Einfligemarke im aktuellen Dokument ein.

Fenster ,Hotspots”
Zeigt das Fenster Hotspots zum Bearbeiten des ausgewdhlten Hotspots an.

Offene Dateien

Ermoglicht die Verwaltung und Navigation durch eine grofRe Anzahl von offenen Dateien.
HINwEIS: Klicken Sie auf einen Spaltennamen, um die Daten im Listenbereich in auf- oder in absteigender
Reihenfolge anzuzeigen.
Fenster , Konsole”

Zeigt das Fenster Konsole an, in dem Warnungen und Fehlermeldungen aufgelistet sind.

Fenster ,Referenzen”
Zeigt das Suchergebnis fir Speicherorte an, an denen ein bestimmtes Element referenziert wird.
Dieses Fenster ist nur fir DITA-Dokumente relevant.

Priifkommentare

Zeigt die von Prifern eingegangenen Priifkommentare an und gibt Ihnen die Moglichkeit, die zu
verwalten.
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Symbolleisten

Lernen Sie die Typen von Symbolleisten, Symbolleistensymbole, Einstellungen und Anpassungen von
Symbolleisten in Adobe FrameMaker kennen.

In diesem Thema

L Einflihrung

J Symbolleisten-Symbole

. Festlegen von Symbolleisten-Voreinstellungen
. Anpassen von Symbolen der Symbolleiste

Einfiihrung

Uber folgende Symbolleisten haben Sie Zugriff auf alle hiufig in strukturierten und unstrukturierten
Dokumenten verwendeten Befehle. Sie kdnnen eine Symbolleiste (iber das Meni Darstellung > Symbol-
leisten anzeigen.

Grafiksymbolleiste
Enthalt Befehle zum Erstellen und Bearbeiten von Grafiken.

Symbolleiste fiir Kurzmeniis
Enthilt Befehle zur Arbeit mit Dokumenten und zum Offnen und Speichern von Text, Grafiken und
Tabellen.
Zugriff (Strukturiert)
Enthalt Befehle zum Arbeiten mit einem strukturierten Dokument, z. B. Hinzufligen eines
XML-Dokuments, Offnen eines Elementkatalogs, Bearbeiten von Attributen und mehr.
Textformatierung
Enthalt Befehle zum Formatieren von Text, wie beispielsweise fiir Schriftstile.

Tabellenformatierung
Enthalt Befehle zum Bearbeiten von Tabellen, wie beispielsweise zum Hinzufligen von Zeilen und
Spalten, zum Kombinieren von Zellen und zum Ausrichten von Text in Tabellenzellen.
Absatzformatierung
Enthalt Befehle zum Formatieren von Absatzen, wie beispielsweise Tabulatoren, Textausrichtung,
Abstande sowie die Absatzstilliste.
Schnellelement
Enthalt Befehle zum Einfligen und Eingliedern allgemein strukturierter Dokumentelemente.

Objektausrichtung
Enthilt Befehle zum Andern der Reihenfolge und Ausrichtung von Objekten.
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Objekteigenschaften
Enthélt Befehle zum Gruppieren von Objekten, Andern der Ebenenreihenfolge, zur Umformung
und Skalierung sowie zum Einrasten von Objekten.

Verfolgen von Textanderungen

Enthalt Befehle zum Verfolgen, Annehmen und Ablehnen von Textanderungen.

Richtungs-Symbolleiste

Enthalt Befehle zur Arbeit mit bidirektionalen Dokumente.

Zusatzlich stehen Tastaturbefehle fir alle in Symbolleisten und Menis enthaltenen Befehle zur Verfi-
gung.

Symbolleisten-Symbole

FrameMaker bietet lhnen eine vordefinierte Auswahl an Symbolen in Graustufen- und in farbiger
Darstellung. Die Grof3e dieser Symbole wird gemal der Aufldsung lhres Gerats angepasst. Standard-
maRig verwendet FrameMaker Graustufen-Symbole. Sie kdnnen zu farbigen Symbolen wechseln, indem
Sie die Einstellungen fiir die Symbole im Dialogfeld Voreinstellungen dandern.

Festlegen von Symbolleisten-Voreinstellungen

Legen Sie mit Symbolleisten-Voreinstellungen fest, ob farbige oder graue Symbole ausgewahlt werden
sollen:

1)  Wahlen Sie Bearbeiten > Voreinstellungen.

2)  Wabhlen Sie im Dialogfeld Voreinstellungen Benutzeroberflache aus und legen Sie die Voreinstel-
lungen fir Symbole fest — Graustufen oder Farbig.

3) Starten Sie FrameMaker neu, damit die neuen Symbolvoreinstellungen wirksam werden.

Anpassen von Symbolen der Symbolleiste

In FrameMaker konnen Sie auch lhre eigenen benutzerdefinierten Symbole hinzufligen. Sie miissen die
.xm1-Datei der Symbolleiste aktualisieren, die an zwei Speicherorten verfigbar ist —im
FrameMaker-Installationsordner und im Ordner%appdata%. Wenn Sie |hre benutzerdefinierte Symbol-
leiste dauerhaft speichern mochten, missen Sie die Symbollistendatei im Installationsordner von
FrameMaker aktualisieren. Andernfalls kénnen Sie auch die Symbolleistendateien aktualisieren, die im
Ordner $appdata% verflgbar sind.

Wenn Sie beispielsweise die Symbolleiste fiir Schnelles Einfligen von Elementen in der WYSIWYG-Ansicht
aktualisieren mochten, kénnen Sie die Datei quick element.xml am folgenden Speicherort aktuali-
sieren:

<Fm install location>\fminit\WorkSpaces\Structured\WYSIWYGView\toolbars

Die bevorzugte Methode ist, die Symbolleistendateien im Benutzervoreinstellungsordner zu aktualis-
ieren ($appdata%):

C:\Users\<username>\AppData\Roaming\Adobe\FrameMaker\<version>\Work-
Spaces\Structured\WYSIWYGView\toolbars
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GleichermalRen miissen Sie den Basispfad des Bildverzeichnisses in der Datei maker.ini angeben.
Verwenden Sie in der Datei maker.ini die Eigenschaft ToolbarCustomImageDir, um den Basi-
spfad lhres Symbolordners anzugeben. Auch hier ist die Datei maker. ini im FrameMaker-Installation-
sordner und in lhrem %$appdata%-Ordner verfligbar. Wenn Sie den Basispfad zu beiden Speicherorten
angeben, gibt FrameMaker dem in der Datei
%appdata%\Adobe\FrameMaker\<version>\maker.ini Vorrang.

Fiihren Sie die folgenden Schritte aus, um Symbolleistensymbole in FrameMaker anzupassen:
1)  Erstellen und speichern Sie alle Symboldateien auf lhrem System. Sie kdnnen Symbole an einem
beliebigen Ort speichern, einschlieBlich im $appdata%-Ordner.

2)  GebenSie den Basispfad des Symbolordners in der Eigenschaft ToolbarCustomImageDirinder
Datei maker.ini an. Zum Beispiel, wenn lhre Symbole in der folgenden Ordnerstruktur gespe-
ichert sind:

v custom
v icons
v structured
v toolbar
Feature-A
Feature-B

Feature-C

Figure 1:  Beispielordnerstruktur zum Speichern benutzerdefinierter Symbole
Dann miissen Sie den Basispfad als C: \custom\icons\structured\toolbar angeben.

3)  Suchen Sie die . xm1-Datei der Symbolleiste, die fiir Ihre Ansicht und Ihren Modus relevant ist, und
offnen Sie sie zur Bearbeitung.

4)  Suchen Sie das zum Element <ACTION> zugehdrige Symbol, das angepasst werden soll. Ein
Beispiel des Elementcodes <ACTION> ist unten angegeben:

<ACTION command="CenterPara">
<images base="Feature-B/P TextAlignCenter Md"/>

5)  Fugen Sie die Basisbezeichnung des Symbols zum @base-Attribut des Bildelements hinzu.

HINWEIS: In unserem Beispiel befinden sich die Symbole innerhalb der Unterordner, daher miissen
wir den relativen Pfad angeben.

6) Erstellen Sie mindestens sechs Symbolbilder fiir verschiedene Zoomstufen des Monitors. Die unter-
stitzten Zoomstufen sind 100 %, 150 % und 200 %. Fir jede Zoomstufe benotigen Sie zwei Bilder -
eines fur den aktivierten Modus und eines fir den deaktivierten Modus.

In der folgenden Tabelle sind die Namen und Abmessungen flir die Verwendung benutzerdefinierter
Graustufen-Symbole aufgefiihrt. Wenn der Basisname lhres Symbols beispielsweise , xyz“ ist, erh-
alten Sie sechs Bilddateien fiir die folgenden méglichen Kombinationen von Zoomstufen:

Symbolbezeichnungen
Empfohlene GréRe der

Zoomstufe Aktiviert Deaktiviert Symbole in Pixel

100 % XY7Z.png xyz_ D.png 18x18
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Symbolbezeichnungen

Empfohlene GroRe der

Zoomstufe Aktiviert Deaktiviert Symbole in Pixel
150% xyz 3TO2X.png xyz D 3TO2X.png 27x27
200% xyz 2X.png xyz D 2X.png 36x36

Beachten Sie, dass fiir deaktivierte Symbole Dim Dateinamen angegeben werden muss, wie in der
obigen Tabelle gezeigt. Ahnlich wird bei einer Zoomstufe von 150 % 3T02X im Dateinamen ange-
geben, und _2Xxwird fiir Symbole angegeben, die bei einer Zoomstufe von 200 % verwendet werden

sollen.

Wenn Sie farbige Symbole verwenden méchten, benennen Sie die Dateien mithilfe der folgenden

Syntax:

<Basisname> C <Zoomstufe>.png

Die oben erwdhnte Syntax gilt fiir die aktivierten Symbole. Verwenden Sie die folgende Dateinamen-
syntax, um deaktivierte Symbole zu erstellen:

<Basisname> C D <Zoomstufe>.png

RELATED LINKS:
Tastaturbefehle
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Smart-Kataloge

Erfahren Sie, wie Sie einen Smart-Katalog in Adobe FrameMaker verwenden.

Sie konnen den Smart-Katalog als einen bequemen Tastaturbefehl fir die in Adobe FrameMaker verfiig-
baren Kataloge verwenden. Um z. B. einen Absatzstil in einem Dokument festzulegen, kénnen Sie
Smart-Kataloge verwenden, um schnell nach dem erforderlichen Absatzstil zu suchen und ihn auszu-
wahlen. In einem strukturierten Dokument kdnnen Sie die erforderlichen Elemente und Attribute schnell
finden, um sie am einem bestimmten Punkt im Dokument einzufligen.

Ein Video dazu finden Sie unter Smart-Kataloge.

Verwenden des Smart-Katalogs:
1)  Platzieren Sie den Cursor an der erforderlichen Stelle im Dokument.

Platzieren Sie den Cursor fiir Zeichen- und Absatzstile innerhalb eines Absatzes. Platzieren Sie den
Zeiger fiir Elemente und Attribute in einem strukturierten Dokument in der Strukturansicht am Ein-
fligepunkt des Elements.

2)  Klicken Sie auf den Tastaturbefehl Smart-Katalog. Die Tastaturbefehle fiir Smart-Katalog sind nach-
folgend definiert.

Das Dialogfeld Smart-Katalog wird angezeigt.

<TEXT=> »
abbreviated-form {(Abbreviated Form)

apiname (APl Name)

b (Bold)

boolean (deprecated)

cite (Citation—bibliographic source)
cmdname (Command Name)

codeblock (Code Block)

codeph (Code Phrase)

data (Data element) v

L T T

4.

Figure 1: ,Element einfigen“-Smart-Katalog in Adobe FrameMaker
Der Fokus des Zeigers befindet sich jetzt innerhalb des Textfelds oben im Dialog.

3)  Umim aktuellen Katalog nach einem Element zu suchen, geben Sie entweder den Namen oder die
Beschreibung des Elements ein. Wahrend Sie tippen, wird die Liste in dem Dialog kiirzer.

Wenn Sie z. B. ein Listenelement in ein strukturiertes Dokument einfliigen méchten, kénnen Sie den

Namen des Listenelements eingeben: <ul>, <ol> oder <d1>. Sie kénnen aber auch die Beschrei-

bung des Elements, der Liste eingeben, und die Liste wird auf die verfiigbaren Listenelemente im EI-
ementkatalog eingegrenzt.
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list

dl {Definition List)

ol {Ordered List)
parml (Parameter List)
sl (Simple List)

ul (Unordered List)

L.

Figure 2:  Gefilterte Elemente im Smart-Katalog ,Element einfliigen”

HINwWEIS: Die Liste der angezeigten Elemente im Dialogfeld ist auf zehn Eintrdge begrenzt. Wenn die Liste
zehn Uberschreitet, konnen Sie mithilfe der Bildlaufleiste nach oben und unten navigieren.

Table 1: Tastaturbefehle fiir Smart-Katalog

Tastaturbefehl Smart-Katalog Gilt fiir...
F8, STRG+8 Zeichenformatkatalog Strukturiert und unstrukturiert
F9, STRG+9 Absatzkatalog Strukturiert und unstrukturiert
Strg+1 Elementkatalog Strukturiert
Strg+2 Element eingliedern Strukturiert
Strg+3 Element dndern Strukturiert
Strg+4 Bedingung anwenden Strukturiert und unstrukturiert
Strg+5 Bedingung entfernen Strukturiert und unstrukturiert
Strg+7 Attribute Strukturiert
ESC+Q+0O Objektstilkatalog Strukturiert und unstrukturiert
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Befehlssuche

Erfahren Sie, wie Sie die Funktion Befehlssuche in Adobe FrameMaker verwenden.

In FrameMaker gibt es Hunderte von Befehlen und jeder Befehl flihrt eine bestimmte Aufgabe aus.
Manchmal ist es schwierig, die gewlinschte Aufgabe (iber das Hauptmen zu finden. FrameMaker erle-
ichtert Ihnen das Finden einer Aufgabe mithilfe der Funktion Befehlssuche. Klicken Sie zum Offnen der
Befehlssuche auf der Anwendungsleiste auf das Lupensymbol oder verwenden Sie den Tastaturbefehl F7:

11
Merge with last element (Esc E M) Element > Merge Into Last
Merge elements (Esc Em) Element > Merge
SiD_CustomizeDitaHtml  Structure = DITA > Customize DITA » Customize DITA shell
Insertimage (Escfii) Insert > Image..
SiD_BackupUserDir Structure > DITA = Customize DITA > Backup Customizations
SiD_RestoreUserDir  Structure = DITA » Customize DITA = Restore Customizations
Create a new DITA glossary group (Esc N T6) File > New = DITA » <glossgroup>
COpen graphic runaround Properties (Esc g R) Graphics = Runaround Properties...
Create a new DITA glossary entry (Esc M T5) File > New = DITA > <glossentry>
Open Character palette  Insert > Character > Character Palette...

Figure 1: ,Befehlssuche” in FrameMaker

Wenn Sie mit der Eingabe der Aufgabe beginnen, die Sie ausfiihren mochten, werden die verfligbaren
Befehle herausgefiltert. Wenn Sie beispielsweise das Wort ,Absatz” eingeben, werden im Fenster Befe-
hissuche nur die Befehle angezeigt, die Sie beim Arbeiten mit dem Absatz verwenden kénnen.

1| paragrapﬂ
Apply 15 line spacing in paragraph (Esc)
Apply custom spacing between paragraphs (Escj w)
Apply custom line spacing in paragraph (Esc j u)
Update paragraph format (Esc o pu)
Create a new paragraph format (Escopn)
Add list of paragraphs (Esclo p) Insert = List Of » Elements Paragraphs..
Add alphabetical paragraph list {Esclo P} Insert > List Of > Elements Paragraphs (Alphabetical)...
Left align paragraph (Esc )
Center align paragraph (Esc ¢}
FocusinParagraphDesigner (Esc Fip) View » Focus > Focus In Paragraph Designer

Figure 2: Befehlsuche-Beispiel: Suche nach , Absatz”

Sie kénnen einen Befehl aus der Liste auswahlen und die Eingabetaste driicken, um den ausgewahlten
Befehl auszufihren. Im Fenster Befehlssuche werden auch die Esc-Tastenfolge und der Meniipfad der
Befehlsausfiihrung angezeigt.
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Statuszeile

Erfahren Sie, wie Sie die Statuszeile in Adobe FrameMaker verwenden.

In diesem Thema

. Einfiihrung

. VergréfSern und Verkleinern der Ansicht

. Seitenwechsel und Einstellen von Bldttern

. Navigieren durch Seiten in einem Dokument

Einfiihrung

Die Adobe FrameMaker-Statuszeile enthalt Navigationssteuerungen, Paginierungsinformationen und
Zoomsteuerungen.

A BCD EF G H I

Fow: A E: concept > conbody > p 4 4|2 > M 20f90" 32 PO = 100% v | g

Figure 1:  Navigationssteuerungen in der Statuszeile

A. Seitenfluss- und Element-Breadcrumb (strukturiert) oder Absatzstil (unstrukturiert) B. Erste Seite C.
Vorherige D. Wechseln zu Seitennummer E. Nachste F. Letzte Seite G. Wechseln zu Zeilennummer H.
Wechseln zu Einfligepunkt I. Zoomsteuerungen

VergroBern und Verkleinern der Ansicht

. Um Text oder Objekte zu verkleinern oder vergrofRern, klicken Sie in der Statuszeile auf die Schalt-
flachen + (VergroRRern) oder - (Verkleinern). FrameMaker stellt den Bereich der Seite, in dem sich
die Einfligemarke oder ein markiertes Objekt befindet, vergroBert oder verkleinert dar. Ist keine
Einflgemarke oder Auswahl im Dokument vorhanden, vergroRert FrameMaker die Darstellung
ausgehend von der Mitte der Seite.

] Wahlen Sie einen Prozentsatz in der Dropdown-Liste Zoom, um Text und Objekte in einer bestim-
mten prozentualen VergroRerung anzuzeigen.

] Wahlen Sie Seite an Fenster anpassen in der Dropdown-Liste Zoom, um die vollstandige Seite im
aktuellen Fenster anzuzeigen.

. Um die Seite oder den Textrahmen an das Fenster anzupassen, wahlen Sie in der Dropdown-Liste
Zoom die Option Fenster an Seite anpassen oder Text an Fensterrahmen anpassen. Wenn die
Darstellungsoption , Gegeniberliegende Seiten” aktiviert ist, wird die FenstergrofSe gedandert,
damit zwei Seiten nebeneinander passen.

. Um die verfligbaren Zoomeinstellungen zu dndern, klicken Sie in der Dropdown-Liste Zoom auf
Zuweisen, wahlen Sie den zu dndernden Prozentsatz, und geben Sie den neuen Prozentsatz ein. Sie
kénnen jeden beliebigen Prozentsatz zwischen 25 % und 1600 % eingeben. Klicken Sie auf
Zuweisen. Um wieder zu den voreingestellten Prozentwerten zuriickzukehren, klicken Sie auf Stan-
dard.

HINwEIS: Der Standardlevel der Zoomfunktion wird gemaR der Auflésung des Anzeigegerats festgelegt.
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Seitenwechsel und Einstellen von Bldttern

Dariber hinaus kdnnen Sie auch festlegen, wie FrameMaker die Seiten anzeigt, wenn Sie ein Dokument
von oben nach unten, von links nach rechts oder zwei Seiten gleichzeitig durchblattern.

1)  Bringen Sie das entsprechende Dokument- oder Buchfenster als aktives Fenster in den Vorder-
grund. Wenn ein Buchfenster aktiv ist, wahlen Sie die gewilinschten Dokumente aus.

2)  Wahlen Sie Darstellung > Optionen.
3)  Wahlen Sie eine der folgenden Optionen in der Dropdown-Liste Blattern:

- Um Seiten von oben nach unten zu durchblattern (z. B. Seite 2 unter Seite 1), wahlen Sie
Vertikal.

- Um Seiten von links nach rechts zu durchblattern (z. B. Seite 2 rechts neben Seite 1), wahlen
Sie Horizontal.

- Um zwei nebeneinander liegende Seiten gleichzeitig abzurollen, wahlen Sie Gegeniiberlieg-
ende Seiten.

- Um so viele Seiten abzurollen, wie von links nach rechts in das Fenster passen, wahlen Sie
Variabel.

4) Klicken Sie auf Festlegen.

Navigieren durch Seiten in einem Dokument

Sie kdnnen mithilfe der Steuerelemente in der Statuszeile in Dokumenten navigieren.

Fiihren Sie eine der folgenden Aktionen aus:

. Um zur nachsten Seite zu gelangen, klicken Sie auf das Symbol Nachste Seite.

. Um zur vorherigen Seite zu gelangen, klicken Sie auf das Symbol Vorherige Seite.

. Um zur ersten Seite im Dokument zu gelangen, klicken Sie auf das Symbol Erste Seite.
J Um zur letzten Seite im Dokument zu gelangen, klicken Sie auf das Symbol Letzte Seite.

J Um zu einer bestimmten Seite zu wechseln, klicken Sie in den Seitennummer-Bereich, und geben
Sie die anzuzeigende Seitennummer ein.

. Um zu einer bestimmten Zeile zu wechseln, klicken Sie in den Bereich Zeilennummer, und geben
Sie die anzuzeigende Zeilennummer ein.

. Um zu der Seite mit der Einfligemarke zu gelangen, klicken Sie auf Einfligemarke.

. Um schnell einen Uberblick tGiber die Seiten zu bekommen, durchblittern Sie das Dokument von
oben nach unten.

Wenn das Dokument, das Sie durchblattern, zu einem ge6ffneten Buch gehoért, werden Sie von
FrameMaker moglicherweise in einer Meldung gefragt, ob Sie das nachste oder vorherige Dokument im
Buch 6ffnen mochten. Wenn Sie beispielsweise auf der ersten Seite eines Dokuments auf Vorherige
Seite klicken und im Meldungsfenster Ja wahlen, wird das vorherige Dokument im Buch ge6ffnet. Die
letzte Seite dieses Dokuments wird angezeigt.

Tipp: Wahlen Sie bei strukturierten Dokumenten ein Element in der Strukturansicht aus, um die entspre-
chende Seite im Dokumentfenster anzuzeigen.
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Darstellungsoptionen

Erfahren Sie mehr Gber die verschiedenen Darstellungs- und Anzeigeoptionen in Adobe FrameMaker.

In diesem Thema

. Darstellungsoptionen

. Mafeinheit

. Schriftgrade

. Lineale und Rasterlinien

] Zeilennummern

J Visuelle Hilfsmittel

. Steuerzeichen

. Begrenzter Satz von Meniibefehlen

. Arbeitsbereich mit hohen Kontrastwerten

. Schnelleres Anzeigen von Seiten

Darstellungsoptionen

HINwEIs: Die Lineale, Rasterlinien, Rahmen auf Objekten, Textsymbole und Grafiken sind Sitzungseigen-
schaften und keine Dokumenteigenschaften. Sie wirken sich auf alle Dokumente aus, die in der aktuellen
Sitzung gedffnet wurden.

In Adobe FrameMaker erfordern einige Felder in Dialogfeldern eine MalReinheit fiir den eingegebenen
Wert, z. B. Punkt oder Zentimeter.

Sie kdnnen eine Standardmaleinheit fiir den Schriftgrad und den Zeilenabstand (MaReinheit fiir den
Schriftgrad) sowie fir weitere Einheiten (MalReinheiten fir die Anzeige) im Dialogfeld Darstellungsop-
tionen angeben.

Die Standardmaleinheit wird in Feldern der Dialogfelder rechts neben dem Wert angezeigt.

Sie kdnnen kurze und lange Formen von Einheiten in Textfelder von Dialogfeldern eingeben:
. pc, pi oder pica flr Pica-Werte,

J pt oder Punkt fiir Punkte

. px fur Pixel

. dd fur Didots

. cc oder Cicero fur Ciceros

. Q fir Q-Einheiten (bezieht sich nur auf SchriftgréBe und Zeilenabstand fiir Japanisch).

Wenn Sie einen Wert ohne MaReinheit in solche Textfelder eingeben, verwendet FrameMaker die Stan-
dardmaReinheit.

Wenn Sie einen Wert eingeben, dessen Malleinheit nicht der unter Darstellungsoptionen definierten
Standardeinheit entspricht, rechnet FrameMaker automatisch den Wert in den Standardwert um. Wenn
beispielsweise die Standardmaleinheit fir Ihr Dokument ,,Pica” ist und Sie einen Absatzeinzug von 2 cm
festlegen mochten, geben Sie 2 cm in das Feld Erster Einzug der Absatzgestaltung ein. Sobald Sie auf
Anwenden klicken, wird der eingegebene Wert (2 cm) in den entsprechenden Pica-Wert umgerechnet.
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Wahlen Sie Ansicht > Optionen..., um das Dialogfeld Darstellungsoptionen zu 6ffnen.

View Options X
Page Scrolling: Variable e
Units:

Display Units: Inch v

Eont Units: Point ©
Snap:

[1Grid Spacing:

Rotation: 0,25 0
Display:

[ ]Rulers: 1/8" v

[ ]Grid Lines: 172 i

Borders on Objects

Text Symbols

Graphics
Cancel

Figure 1: Dialogfeld ,Darstellungsoptionen”

MafReinheit

Wihlen Sie die Werte fir Anzeigeeinheiten aus. Sie kdnnen zwischen den folgenden Standardeinheiten
wahlen:

. cm (Zentimeter)
. mm (Millimeter)

. Zoll

. Pica

. Punkt
. Didot

L Cicero
] Pixel

Klicken Sie auf Festlegen.

Schriftgrade

Wihlen Sie die Werte fir Schriftgrade aus. Sie kdnnen zwischen den folgenden Standardeinheiten
wahlen:

J Punkt

. Q (nur flr Japanisch)
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Klicken Sie auf Festlegen.

Lineale und Rasterlinien

Wihlen Sie eine Einstellung aus der Dropdown-Liste Lineale und der Dropdown-Liste Rasterlinien aus.

Klicken Sie auf Festlegen.

Zeilennummern

Waihlen Sie Ansicht > Zeilennummern, um Zeilennummern anzuzeigen/auszublenden.

Mithilfe von Zeilennummern in FrameMaker-Dateien kénnen Sie bestimmte Zeilen des Inhalts identifi-
zieren. Zeilennummern werden auf Dokumentebene (bei FM-Dateien) festgelegt und vor jeder in
einem FrameMaker-Dokument eingefligten Zeile angezeigt.

2iLine numbers in FrameMalker file
:set at a document level (for a .fm
siument.

Figure 2: Zeilennummern und Anderungsbalken in einem FrameMaker-Dokument

Wichtige Punkte zu Zeilennummern

J Unterstiitzung von Formaten mit mehreren Spalten und mehreren Textfliissen: Bei Dateien mit
mehrspaltigen Formaten werden Zeilennummern fiir Text in jeder Spalte angezeigt. Bei Doku-
menten mit mehreren Textflissen werden die Zeilennummern entsprechend der Textfllisse
berechnet und entsprechend fortgesetzt.

. Neuberechnung: Wenn Sie Text in einen Absatz, fiir den Zeilennummern aktiviert sind, einfligen,
werden die Zeilennummern entsprechend neu berechnet.

J Eigenschaft auf Dokumentebene: Bei Zeilennummern handelt es sich um eine Eigenschaft auf
Dokumentebene. Daher kann diese Funktion flr ein Dokument (FM-Datei) aktiviert/deaktiviert
werden. Zeilennummern kénnen auf Dokumentebene so festgelegt werden, dass die
Nummerierung auf der nachsten Seite fortgesetzt oder auf jeder Seite neu gestartet wird.

o Textflisse: Bei Dokumenten mit mehreren Textfllissen richten sich die Zeilennummern nach den
Textflissen und werden diesen entsprechend fortgesetzt.

o XML-Dokumente: Zeilennummern werden in XML-Dokumenten nicht beibehalten. Sie konnen
jedoch in der Anwendungsvorlage aktiviert werden.

. Drucken: Zeilennummern sind auf gedruckten Dokumenten und in liber die Option Als PDF
speichern erstellten PDFs sichtbar.

Achten Sie bei der Verwendung von Zeilennummern und Anderungsbalken darauf, dass diese sich nicht
Uberlagern.
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Gehen Sie wie folgt vor, um Zeilennummern anzuzeigen:

1)  Wahlen Sie Format > Dokument > Zeilennummern. Das Dialogfeld Eigenschaften der Zeilen-
nummer wird angezeigt:

Line Number Properties X
Width: (D2 |
Font:  Segoe Ul Symbol v
Size:  |7.0pt v |
Color:  |Dark Grey ~
[ ] Restart at Each Page

[ ]Show line humbers

Set Cancel

Figure 3: Dialogfeld ,Eigenschaften der Zeilennummer”

2)  Wahlen Sie im Dialogfeld Eigenschaften der Zeilennummer die Option Zeilennummern anzeigen,
und geben Sie Folgendes an:

Breite: Abstand der Zeilennummern von der Spalte. Der Abstand ist relativ zu den Spalten mit Text.
Schrift: Schriftart der Zeilennummern.

Gréfie: Grofse der Zeilennummern.

Farbe: Farbe der Zeilennummern.

Auf jeder Seite neu starten: Bei Auswahl dieser Option wird die Nummerierung von Zeilen auf jeder
Seite neu gestartet.

Zeilennummern anzeigen: Mit dieser Option werden die Zeilennummern angezeigt.
3) Klicken Sie auf Festlegen.

Visuelle Hilfsmittel

Sie kdnnen verschiedene visuelle Hilfsmittel in einem Dokumentfenster anzeigen:
J Begrenzungslinien um Textrahmen, Grafikrahmen und importierte Objekte
J Marken, Absatzmarke (f)und andere Steuerzeichen im Textfluss

J Lineale am oberen und linken Rand des Fensters

Dariiber hinaus kénnen Sie ein Raster aus horizontalen und vertikalen Linien fiir das Zeichnen, Skalieren
und Ausrichten von Grafiken einblenden. Visuelle Hilfsmittel sind nicht-druckbare Zeichen. Daher ist es
nicht erforderlich, sie vor dem Drucken auszublenden. Bringen Sie das entsprechende Dokument- oder
Buchfenster als aktives Fenster in den Vordergrund.

Fiihren Sie eine der folgenden Aktionen durch:
J Um Rahmen ein- oder auszublenden, wahlen Sie Ansicht > Begrenzungslinien.
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o Um die Lineale ein- oder auszublenden, wahlen Sie Ansicht > Lineale.

o Um Rasterlinien ein- oder auszublenden, wahlen Sie Ansicht > Rasterlinien.

. Zum Ein- oder Ausblenden von Elementgrenzen wahlen Sie Darstellung > Elementgrenzen oder
Elementgrenzen (mit Tag) in der strukturierten Version von FrameMaker. FrameMaker wechselt
automatisch zwischen diesen zwei Optionen.

WIcHTIG: Die visuellen Hilfslinien wirken sich auf alle ge6ffneten Dokumente in der aktuellen Sitzung aus.
In friiheren Versionen von FrameMaker galten die visuellen Hilfslinien nur flr das ausgewahlte Doku-

ment.

Steuerzeichen

Um die Textsymbole ein- oder auszublenden, wahlen Sie Darstellung > Textsymbole.

Steuerzeichen Bedeutung
9 Absatzende
§ Textflussende und Zellenende in Tabellen
) Tabulator
L Verankerter Rahmen und Tabellenanker
T Marke
[ Erzwungener Zeilenumbruch
| Manueller Ausrichtungspunkt fur eine Gleichung
u Umbruchgeschiitztes Leerzeichen
—_ Wahlweiser Trennstrich

Trennunterdriickung

Begrenzter Satz von Meniibefehlen

Sie kdnnen mit einem begrenzten Satz von Menlibefehlen, so genannten Kurzmendis, arbeiten.
Kurzmenis enthalten keine Befehle fiir Textformatierung, weiterhin fehlen einige Befehle fiir die Grafik-
bearbeitung und das Einfligen bestimmter Objekte wie z. B. Marken und Variablen.

Wenn Sie nicht alle Menibefehle sehen, werden wahrscheinlich die Kurzmeniis angezeigt.

HINWEIS: Wenn Sie ein strukturiertes Dokument verwenden, hat Ihr Anwendungsentwickler unter
Umstdnden die in den vollstandigen Menls verfligbaren Befehle gedandert.

. Um Kurzmens anzuzeigen, wahlen Sie Darstellung > Meniis > Kurzmentdis.

. Um das vollstandige Menl wiederherzustellen, wahlen Sie Darstellung > Meniis > Vollmeniis.

. Um Menis anzupassen, finden Sie weitere Informationen zum Hinzufligen, Verschieben und
Entfernen von Menis und Befehlen im Onlinehandbuch Anpassen von FrameMaker-Produkten auf
der Adobe-Website www.adobe.com/go/Ir FrameMaker support de.
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Arbeitsbereich mit hohen Kontrastwerten

In Adobe FrameMaker werden fiir den Hintergrund der Fenster, fir Text und Grafiken Systemfarben
verwendet. Benutzer mit Problemen bei der Farbunterscheidung und der Erkennung von Kontrasten
oder Benutzer mit geringer Sehscharfe kénnen Farbschemata mit besonders hohen Kontrastwerten
einrichten und die Farben fir Text und Hintergrund anpassen. Mit dieser Einstellung werden die Infor-
mationen auf der Benutzeroberflache leichter erkennbar.

Um die Eingabehilfenoptionen in Windows zu konfigurieren, legen Sie die Eingabehilfenoptionen in der
Windows-Systemsteuerung fest.

HINwEIS: Die Farbe kann in FrameMaker jedoch nicht fiir alle Elemente angepasst werden. Dazu gehoéren
die Hintergrundfarbe sowie die Fillfarbe von Grafikobjekten.

Schnelleres Anzeigen von Seiten

So zeigen Sie Seiten schneller an:

Offnen Sie das Dokument und unterdriicken Sie dabei die Aktualisierung von importierten Grafiken,
Querverweisen und Texteinschiiben. Wenn Sie ein Dokument ohne Aktualisierung von Querver-
weisen 6ffnen, beschleunigt dies den Offnungsvorgang, kann aber die Anzeige der einzelnen Seiten
verlangsamen.

Schalten Sie die Anzeige von Grafiken aus, indem Sie Darstellung > Optionen wahlen und die
Option Grafiken deaktivieren. Klicken Sie auf Festlegen.

WicHTIG: Wenn Sie die Option Grafiken deaktivieren und eine PDF-Datei erzeugen, werden die
Grafiken nicht in der PDF-Datei angezeigt.

Zeigen Sie kleinen Text in Form grauer Balken an, indem Sie Datei > Voreinstellungen > Allgemein
wahlen. Geben Sie eine PunktgréRe in das Feld Text wird stilisiert, wenn kleiner als ein. Klicken Sie
auf Zuweisen. Wenn Text in lhrem Dokument kleiner als in der hier festgelegten Grof3e vorhanden
ist, erscheint dieser Text als grauer Balken am Bildschirm.
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FrameMaker-Voreinstellungen

Erfahren Sie, wie Sie mit dem Dialogfeld ,, Dialogfeld Voreinstellungen zum Andern verschiedener Adobe
FrameMaker-Einstellungen.

Im Dialogfeld Voreinstellungen (Bearbeiten > Voreinstellungen) konnen Sie FrameMaker-Einstellungen
andern. Die Einstellungen sind in die folgenden Abschnitte unterteilt:

Figure 1:

Global: In diesem Abschnitt kdnnen Sie Einstellungen fiir die Produktschnittstelle, das Importieren

von Grafiken, Quickinfos, Warnmeldungen, Fenster, Startskripte und die Dropbox-Integration

vornehmen.

CMS (Content Management System): In diesem Abschnitt kénnen Sie Einstellungen fir die Arbeit
mit den unterstiitzten CMS konfigurieren.

Rechtschreibung: In diesem Abschnitt kénnen Sie Einstellungen flr unterstitzte Wérterblcher,

typographische Anfiihrungszeichen und Rechtschreibpriifungsoptionen konfigurieren.

XML: In diesem Abschnitt konnen Sie das Erscheinungsbild der XML-Ansicht konfigurieren.

MathML: In diesem Abschnitt konnen Sie den MathML-Installationspfad, Lizenzinformationen und
andere zugehodrige Optionen konfigurieren.

Preferences

~ Global
General
Graphics
~Interface
~Alerts
Launch
Dropbox
= CMS
~Documentum
~Microsoft SharePoint
DitaExchange
Adobe Experience Mani
= Spelling
~Dictionary
Smart Quotes
Spelling Options
XML
MathML

Product Interface:

|Structured FrameMaker b

Automatic Backup on Save
[_] Auto Save Every 5 Minutes

Show File Translation Errors
Greek Screen Text Smaller Than
Checkout HTTP Files on Open

Upload HTTP Files on Save

Image Padding

Import Image by Reference

Show Tabbed Welcome Screen

[] Do not check for Updated Images &
Multimedia

Compatibility

0] Save Framelmage with Imported

Graphics

Lock File on Network

Remember Missing Font Names

Embed in PDF
Adobe Flash Files
3-D Objects

Multimedia Objects

Cursor Movement

(® Logical () Visual

OK

Cancel

Dialogfeld ,,FrameMaker-Voreinstellungen”

Die Einstellungen im Dialogfeld ,,Voreinstellungen” werden nachfolgend erléutert.

In diesem Thema

Global > Allgemein
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] Global > Grafik

. Global > Benutzeroberfliiche
. Global > Warnungen

. Global > Starten

J Global > Dropbox

o CMS > Documentum

. CMS > Microsoft SharePoint
. CMS > DitaExchange

J CMS > Adobe Experience Manager

. Rechtschreibung > Wérterbuch

. Rechtschreibung > Typographische Anfiihrungszeichen

J Rechtschreibung > Rechtschreiboptionen

. XML
. MathML

Global > Aligemein

Die folgenden Einstellungen sind in diesem Abschnitt verfligbar:

Einstellung

Beschreibung

Produktoberflache

StandardmaRig wird FrameMaker im strukturierten
FrameMaker-Authoring-Modus geoffnet. Wenn Sie in den
unstrukturierten FrameMaker-Authoring-Modus wechseln
mochten, wahlen Sie in der Liste der Optionen ,,“ aus und
starten Sie FrameMaker neu.

Weitere Informationen finden Sie unter Authoring-Modi.

Automatisch Sicherungskopie
anlegen

Wahlen Sie diese Option, um bei jedem Speichern eines
Dokuments eine Sicherungsdatei zu erstellen.

Weitere Informationen finden Sie unter Automatisches Erstellen
von Sicherungskopien und Speichern.

Automatisch speichern alle

Wahlen Sie diese Option und geben Sie das Zeitintervall fir die
automatische Speicherung der Datei in Minuten an.

Weitere Informationen finden Sie unter Automatisches Erstellen
von Sicherungskopien und Speichern.

Konvertierungsfehler anzeigen

Wahlen Sie diese Option, um beim Importieren eines
Dokuments aus einem anderen Format wie Word
Fehlermeldungen anzuzeigen.
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Einstellung

Beschreibung

Text wird stilisiert, wenn kleiner als

Wahlen Sie diese Option, um kleinen Text als graue Balken
anzuzeigen. Wenn Text in Ihrem Dokument kleiner als in der hier
festgelegten GrofRe vorhanden ist, erscheint dieser Text als
grauer Balken am Bildschirm.

Weitere Informationen finden Sie unter Schnelleres Anzeigen
von Seiten.

HTTP-Dateien beim Offnen
auschecken

Wihlen Sie diese Option, wenn Sie eine Datei beim Offnen von
einem WebDAV-Server auschecken mochten.

HTTP-Dateien beim Speichern
hochladen

Wahlen Sie diese Option, wenn Sie eine Datei nur einmal beim
SchlieBen einchecken mochten.

Bildauffillung

Geben Sie den Standardfillwert (Leerzeichen) fir ein Bild und
seinen verankerten Rahmen an. Wenn Sie ein Bild einfligen, fligt
FrameMaker eine Liicke (Abstand) zwischen dem Bild und dem
verankerten Rahmen hinzu.

Der Standardwert ist 6.0 pt.

Bildimport durch Referenz

Wahlen Sie diese Option, um den Bildimport durch Referenz als
Standardmethode zum Importieren von Bildern festzulegen.

Begriifungsbildschirm mit
Registerkarten anzeigen

Wahlen Sie diese Option, um den BegriiBungsbildschirm als
Dokument mit Registerkarten anzuzeigen. Wenn Sie diese
Option nicht auswahlen, wird der BegriifSungsbildschirm beim
Starten von FrameMaker angezeigt. Wenn Sie jedoch ein
Dokument 6ffnen oder erstellen, wird der
Begriifsungsbildschirm geschlossen.

AnschlieBend kénnen Sie den Begriifsungsbildschirm im Meni
,Arbeitsbereich-Umschalter” 6ffnen.

Nicht nach aktualisierten Bildern
und aktualisierten
Multimediaobjekten suchen

Wenn Sie auf einem Netzlaufwerk arbeiten, wahlen Sie diese
Option aus, um zu verhindern, dass FrameMaker auf dem
Netzlaufwerk nach aktualisierten Bildern und
Multimediadateien sucht. Sie miissen diese Option vor der
Veroffentlichung deaktivieren, andernfalls enthalt lhre
veroffentlichte Ausgabe moglicherweise veraltete
Mediendateien.

Kompatibilitat
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Einstellung

Beschreibung

Framelmage mit importierten
Grafiken speichern

Wenn Sie eine Grafik in ein FrameMaker-Dokument kopieren,
speichert das FrameMaker-Dokument die Grafikdaten in einer
oder mehreren Facetten. Jede Facette enthalt Daten in einem
bestimmten Grafikformat. FrameMaker verwendet Facetten
zum Anzeigen und Drucken von Grafiken.

Wahlen Sie diese Option, um die Daten eines Bilds in Form einer
Facette mit der importierten Grafik zu speichern.

Dateien auf Netzwerk sperren

Wahlen Sie diese Option, um eine Datei zu sperren, wahrend sie
geoffnet ist. Dies verhindert, dass andere Benutzer die Datei
andern.

Weitere Informationen finden Sie unter Offnen von
Dokumenten in Verwendung.

Namen fehlender Schriften
speichern

Wenn Sie diese Option auswahlen, behalt FrameMaker die
Namen nicht verfligbarer Schriftarten bei, die im Dokument
verwendet werden. Die Originalschriften werden beim Offnen
des Dokuments auf einem Computer, auf dem die Schriften
installiert sind, dann wieder angezeigt, auch wenn Sie ein
Dokument mit Ersatzschriften 6ffnen.

Weitere Informationen finden Sie unter Fehlerbehebung bei
nicht verfiigbaren Schriften.

In PDF einbetten

Adobe Flash-Datei

Wahlen Sie diese Option, um die PDF-Datei mit eingebetteten
Adobe Flash-Dateien zu erstellen, die im Dokument verwendet
werden.

3-D-Objekte

Wahlen Sie diese Option, um die PDF-Datei mit eingebetteten
3D-Objekt-Dateien zu erstellen, die im Dokument verwendet
werden.

Multimedia-Objekte

Wahlen Sie diese Option, um die PDF-Datei mit eingebetteten
Multimedia-Objekten (wie MP3, MP4, AVI) zu erstellen, die im
Dokument verwendet werden.

Cursor-Bewegung

Logisch/visuell

Wahlen Sie die Cursorbewegung als logisch oder visuell,
wahrend Sie in einem Dokument mit aktivierter Rechts nach
links-Richtung arbeiten.

Weitere Informationen finden Sie unter Position des Caret und
Bewegung.
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Global > Grafik

Die folgenden Einstellungen sind in diesem Abschnitt verflgbar.

Einstellung

Beschreibung

Bildimport

Verankerungsposition

Wahlen Sie die Standardverankerungsposition aus, die beim
Importieren eines Bildes verwendet werden soll.
StandardmaRig werden alle Bilder in einen verankerten Rahmen
importiert, der unterhalb der aktuellen Linie positioniert ist.

Ausrichtungstyp

Wahlen Sie die Standardausrichtung fir den verankerten
Rahmen aus. StandardmaRig ist der verankerte Rahmen
zentriert ausgerichtet.

DPI

Geben Sie die Standard-DPI-Einstellung zum Importieren eines
Bildes an. StandardmaRig werden 72 DPIl zum Importieren eines
Bildes verwendet.

Automatisches Skalieren des Bildes
nach der Breite (beim Einfligen)

Waihlen Sie diese Option, wenn Sie ein Bild in einen Textrahmen,
eine Tabellenzelle, eine Uberschrift, eine seitliche Uberschrift
oder eine Spalte einfligen. Das Bild wird automatisch skaliert,
sodass es passt.

Wenn das Beispiel beispielsweise grofSer als der Textrahmen ist,
wird es automatisch proportional skaliert, der bestmogliche
DPI-Wert wird beibehalten, und seine Passform wird an den
Rahmen angepasst.

Bild exportieren

Rasterbilder-DPl in HTML-Ausgabe

Fir die in lhren Dokumenten verwendeten Rasterbilder kdnnen
Sie die DPI-Werte zum Konvertieren dieser Bilder angeben.
Diese Einstellung ist nur anwendbar, wenn Sie eine Responsive
HTML5-Ausgabe generieren.

Global > Benutzeroberflache

Die folgenden Einstellungen sind in diesem Abschnitt verfligbar.

Einstellung

Beschreibung

Quickinfos-Darstellung

Waihlen Sie das Erscheinungsbild der QuickInfo.
Die moglichen Optionen sind Normal, Schnell
und Versteckt.

Fenster
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Einstellung

Beschreibung

Symbolfenster automatisch minimieren

Wahlen Sie diese Option, um ein Fenster
automatisch auf ein Symbol zu reduzieren, wenn
sich der Fokus vom Fenster wegbewegt.

Fenster beim SchlieBen ausblenden

Wahlen Sie diese Option, um Fenster
auszublenden, wenn sie geschlossen sind. Auf
diese Weise bleiben die Fenster auf der
Benutzeroberflache ausgeblendet, jedoch im
Systemspeicher aktiv. Wenn diese Option nicht
ausgewahlt ist, wird das Fenster geschlossen und
aus dem Systemspeicher entfernt.

Menupfad in der Befehlssuche anzeigen

Widhlen Sie diese Option, um den Menlipfad eines
Befehls in der Befehlssuche anzuzeigen. Weitere
Informationen finden Sie unter Befehlssuche.

Dialogfelder

Windows-Dateibrowser verwenden

Wihlen Sie diese Option, um beim Offnen oder
Speichern von Dateien das systemeigene
Windows-Dialogfeld ,, Dateibrowser” zu
verwenden.

Dokumente

Dokumente als Registerkarten 6ffnen

Wahlen Sie diese Option, um gedffnete
Dokumente in separaten Registerkarten
anzuzeigen. Wenn sie nicht ausgewahlt ist,
werden Dokumente in separaten Fenstern
geodffnet.

Einzelne Registerkarten in Dokumenten
ausblenden

Wenn Dokumente in einem separaten Fenster
angezeigt werden, wird der Dateiname nicht in
einer Registerkarte angezeigt.

Keine Dokumentregisterkarten beim Ziehen

Wahlen Sie diese Option, um
Dokumentregisterkarten zu vermeiden.

Zusammengesetzte Dokumente als
Registerkarten 6ffnen

Wahlen Sie diese Option, um zusammengesetzte
Dokumente als Registerkarten zu 6ffnen.

Nach Drag/Drop Dokument 6ffnen

Wahlen Sie diese Option, um Dokumente zu
offnen, wenn sie per Drag & Drop in das
Dokumentfenster gezogen werden.

Symbole
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Einstellung

Beschreibung

Graustufen/Farbig

Wahlen Sie die Option , Graustufen”, wenn Sie in
der Benutzeroberflache von FrameMaker
Graustufen-Symbole verwenden mochten,
andernfalls die Option ,Farbig“.

Strukturansicht

Entsprechend der Cursorposition im
Dokumentfenster automatisch erweitern

Wahlen Sie diese Option, um die Cursorposition
im Dokumentfenster mit der Elementauswahl in
der Strukturansicht zu synchronisieren. Wenn Sie
beispielsweise den Cursor irgendwo im
Dokumentfenster platzieren, wird das
entsprechende Element in der Strukturansicht
automatisch hervorgehoben. Wenn Sie ein
Element in der Strukturansicht auswahlen, wird
der entsprechende Text im Dokumentfenster
ausgewahlt.

Global > Warnungen

Die folgenden Einstellungen sind in diesem Abschnitt verfligbar.

Einstellung

Beschreibung

Beim Loschen des Verlaufs Warnmeldungen
anzeigen

Wahlen Sie diese Option, um eine Warnmeldung
anzuzeigen, wahrend Sie einen Loschvorgang fir
den Verlauf ausfiihren. Sie kdnnen diese
Warnmeldung weiter einschranken, sodass sie
nur einmal fur jede Art von Vorgang oder fir alle
Vorgdnge angezeigt wird.

Datei enthalt ungeloste Querverweise

Waihlen Sie diese Option, um Warnungen
anzuzeigen, wenn nicht aufgel6ste Querverweise
im Dokument gefunden werden.

Dokument einer alteren Version wird gedffnet

Wahlen Sie diese Option, um Warnungen
anzuzeigen, wenn ein Dokument aus einer
alteren FrameMaker-Version ge6ffnet wird.

Alte Version des Buch wird gedffnet

Wahlen Sie diese Option, um Warnungen
anzuzeigen, wenn eine Buchdatei in einer alteren
FrameMaker-Version gedffnet wird.
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Einstellung

Beschreibung

Datei, die nicht verfligbare Schriften enthalt

Wahlen Sie diese Option, wenn Sie Warnungen
anzeigen mochten, wenn die im Dokument
verwendeten Schriftarten auf dem System, auf
dem das Dokument geoffnet wird, nicht
verflgbar sind.

Worterbuchanbieter stimmt nicht Gberein

Wahlen Sie diese Option, wenn Sie Warnungen
anzeigen mochten, wenn der
Worterbuchanbieter im Dokument nicht dem des
Systems, in dem das Dokument geoffnet wird,
entspricht.

HINwEIS: Der Worterbuchdienstanbieter kann
Uber Voreinstellungen > Rechtschreibung >
Worterbuch eingestellt werden.

Datei nicht unterstiitzt in Modus

Wihlen Sie diese Option, wenn Sie beim Offnen
einer strukturierten Datei im unstrukturierten
Modus Warnungen anzeigen mochten.

Datei nicht unterstitzt in Ansicht

Wihlen Sie diese Option, wenn Sie beim Offnen
einer Datei in einer nicht unterstiitzten Ansicht
Warnungen anzeigen mochten.

Automatisch zu Composer fiir asiatische Schrift
wechseln

Wahlen Sie diese Option, um automatisch zum
Modus fiir asiatische Schrift zu wechseln.
Weitere Informationen finden Sie unter
Unterstiitzung flir asiatische Sprachen.

Warnmeldungen bei Sitzungswiederherstellung
anzeigen

Wahlen Sie diese Option, um Warnungen beim
Wiederherstellen einer friheren Sitzung
anzuzeigen. Dies kann passieren, wenn Sie
FrameMaker nach einem Absturz neu starten.

Kontextbezogene Hinweise anzeigen

Wahlen Sie diese Option, um kontextbezogene
Tipps zu dem in FrameMaker ausgefiihrten
Vorgang anzuzeigen.

Weitere Informationen finden Sie unter
Kontexthinweise.

Global > Starten

Die folgenden Einstellungen sind in diesem Abschnitt verfligbar.
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Einstellung

Beschreibung

Adobe-Schriften beim Start laden

Diese Option ladt beim Start von FrameMaker
Adobe-Schriftarten. Adobe-Schriftarten werden
im

Ordner<Fm_install location>\fminit\
fonts gespeichert. Wenn Sie diese Option
deaktivieren, steht keine der Adobe-Schriftarten
zur Verwendung zur Verfligung.

Laden der Clients verzogern

Wenn Sie diese Option auswahlen, wird keiner
der Clients (zum Beispiel MathFlow und
PDF-Importkommentare) beim Start geladen.
Diese Option verbessert die Startzeit von
FrameMaker, einige der Client-Anwendungen
sind jedoch nicht sofort nach dem Start von
FrameMaker verfiigbar.

Laden der Sprachenanbieter verzégern

Wahlen Sie diese Option, um den Start aller
Sprachdienstanbieter bis nach dem Start von
FrameMaker zu verzogern. Wenn diese Option
ausgewahlt ist, werden beim Starten nur die
englischen Worterbuchdienste geladen. Andere
Worterbuchdienstanbieter werden nach dem
Start von FrameMaker geladen.

Startskripte nicht laden

Geben Sie eine Liste von Skripten an, die
FrameMaker beim Start nicht laden soll. Zum
Beispiel werden standardmaRig
S$1000D-Dienstprogramme und Menuskripte in
dieser Liste angegeben. Wenn Sie die
S1000D-Skripte aus dieser Liste entfernen,
werden sie ausgefiihrt und Sie sehen die
S$1000D-Mentioption.

Global > Dropbox

Die folgenden Einstellungen sind in diesem Abschnitt verflgbar.

Einstellung

Beschreibung

Derzeit ausgewahlter Dropbox-Ordner

Geben Sie einen Speicherort an, der als
Standardspeicherort fiir Dateien aus Dropbox
festgelegt werden soll.

Loschen Sie alle Dateien aus Dropbox, nachdem
Sie eine lokale Kopie erstellt haben

Waihlen Sie diese Option, um Dateien von der
Festplatte zu I6schen, nachdem die Dateien in
den Dropbox-Ordner hochgeladen wurden.
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Einstellung

Beschreibung

Ordnerstruktur fir Abhangigkeiten beim
Hochladen oder beim Download erstellen

Wahlen Sie diese Option, um eine Ordnerstruktur
zu definieren, die alle abhadngigen Dateien in den
Dropbox-Ordner verschiebt.

CMS > Documentum

Die folgenden Einstellungen sind in diesem Abschnitt verfligbar.

Einstellung

Beschreibung

Bei Dateiupload

Objekt tGberschreiben und speichern als

Wahlen Sie diese Option, um den
Versionierungsmechanismus anzugeben. Sie
kdnnen eine vorhandene Version der Datei
Uberschreiben und ihre Versionsnummer auf die
gleiche, die nachste Hauptversion oder die
nachste Nebenversion festlegen.

Ausgeblendete Objekte anzeigen

Waihlen Sie diese Option aus, um Dateien
anzuzeigen, die im Documentum-Repository als
ausgeblendet markiert sind. Die versteckten
Dateien werden auch im Fenster des
Repository-Managers angezeigt.

Private CAB-Dateien anzeigen

Wahlen Sie diese Option, um die privaten
CAB-Dateien im Documentum-Repository
anzuzeigen. Die privaten CAB-Dateien werden im
Fenster Repository-Manager angezeigt.

DFS-SDK-Pfad

Suchen Sie den Pfad des Documentum
Foundation Services-(DFS-)SDK auf Ihrem System,
und wahlen Sie ihn aus.

Benutzerdefinierte Attribute

Geben Sie ein beliebiges benutzerdefiniertes
Attribut an, das Sie in Documentum verwenden
mochten.

Weitere Informationen finden Sie unter
Benutzerdefinierte CMS-Attribute hinzufiigen.

CMS > Microsoft SharePoint

Die folgenden Einstellungen sind in diesem Abschnitt verflgbar.

Einstellung

Beschreibung

Bei Dateiupload

91




Einstellung

Beschreibung

Objekt tGberschreiben und speichern als

Wahlen Sie diese Option, um den
Versionierungsmechanismus anzugeben. Sie
kdnnen eine vorhandene Version der Datei
Uberschreiben und ihre Versionsnummer auf die
nachste Hauptversion oder die nachste
Nebenversion festlegen.

Benutzerdefinierte Attribute

Geben Sie ein beliebiges benutzerdefiniertes
Attribut an, das Sie in Microsoft SharePoint
verwenden mochten.

Weitere Informationen finden Sie unter
Benutzerdefinierte CMS-Attribute hinzufiigen.

Abhangige Dateien standardmaRig Giberprift

Wenn das Hauptdokument abhangige Dateien
enthalt, wahlen Sie diese Option, um das
Hauptdokument zusammen mit den
Abhangigkeiten auszuchecken. Diese Option wird
mit der Option Alle abhdngigen Dateien
auschecken im Bestatigungsdialogfeld
synchronisiert. Das Dialogfeld wird angezeigt,
wenn Sie die Dateien vom Sharepoint-Server
auschecken.

CMS > DitaExchange

Die folgenden Einstellungen sind in diesem Abschnitt verflgbar.

Einstellung

Beschreibung

Bei Dateiupload

Objekt Gberschreiben und speichern als

Waihlen Sie diese Option, um den
Versionierungsmechanismus anzugeben. Sie
kdnnen eine vorhandene Version der Datei
Uberschreiben und ihre Versionsnummer auf die
nachste Hauptversion oder die nachste
Nebenversion festlegen.

CMS > Adobe Experience Manager

Die folgenden Einstellungen sind in diesem Abschnitt verfligbar.

Einstellung

Beschreibung

CMS
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Einstellung

Beschreibung

Datei beim Einchecken schlieRen

Wahlen Sie diese Option, um eine Datei zu schlieRen, wenn sie
wieder in AEM eingecheckt wird .

Auf UUID-basierte Referenzen
verwenden

Wahlen Sie diese Option zum Herunterladen von Dateien, fiir
die das UUID/GUID-basierte Dateireferenzierungssystem
verwendet wird. Sie kdnnen diese Dateien in FrameMaker
veroffentlichen, um die erforderliche Ausgabe zu generieren.

Datei beim Auschecken 6ffnen

Wahlen Sie diese Option, um eine Datei zu 6ffnen, wenn sie von
AEM ausgecheckt wird.

Automatisches Auschecken

Automatisches Auschecken
aktivieren

Wihlen Sie diese Option aus, um die Datei beim Offnen oder
Speichern automatisch auszuchecken. Wenn Sie diese Option
auswahlen, sind die Optionen Beim Speichern der Datei und
Beim Offnen der Datei aktiviert. Die Option
Eingabeaufforderung anzeigen kann mit den Optionen Beim
Speichern der Datei und Beim Offnen der Datei kombiniert
werden.

Wenn Sie eine Kombination aus Auschecken , Beim Offnen der
Datei” und ,Eingabeaufforderung anzeigen” verwenden, wird
eine Eingabeaufforderung beim Offnen einer Datei aus dem
AEM-Repository angezeigt. Wenn Sie die Datei auschecken, wird
die Datei exklusiv gesperrt, und Sie kdnnen die Datei
bearbeiten. Wenn Sie die Datei nicht auschecken mochten, wird
die Datei im schreibgeschitzten Modus geoffnet.

Wenn Sie eine Kombination aus Auschecken ,,Beim Speichern
der Datei” mit ,,Eingabeaufforderung anzeigen” verwenden,
wird eine Eingabeaufforderung zum Auschecken der Datei beim
Speichern angezeigt. Wenn die Datei nicht ausgecheckt ist und
Sie versuchen, die Datei zu speichern, werden Sie aufgefordert,
einzugeben, ob Sie die Datei auschecken méchten. Wenn Sie die
Datei nicht auschecken moéchten, werden die Updates nicht
gespeichert.

Proxy

Proxytyp Wenn Sie sich hinter einem Proxyserver befinden, missen Sie
hier die Proxyserverdetails angeben, um eine Verbindung mit
Ihrem AEM-Server herzustellen. Wahlen Sie das Serverprotokoll
aus, das von lhrem AEM-Server verwendet wird. Mogliche
Optionen sind HTTP und HTTPS.

Server/Port Geben Sie die IP-Adresse oder den Domanennamen des

Proxyservers und den Port an, auf dem er empfangsbereit ist.
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Einstellung

Beschreibung

Debuginformationen

Umfangreiche Protokollierung

Wahlen Sie diese Option aus, um detaillierte Protokolle zu
speichern, die zum Debuggen von Problemen verwendet
werden kénnen.

Rechtschreibung > Woérterbuch

Verwenden Sie diese Einstellungen, um Proximity- oder Hunspell-Worterbucher fiir die Rechtschreibung,
Silbentrennung und Thesaurus fir verschiedene Sprachen festzulegen. Fir deutsche Sprachvarianten

kénnen Sie das Duden-Woérterbuch verwenden.

Rechtschreibung > Typographische Anfiihrungszeichen

Verwenden Sie die Einstellungen fiir typographische Anfihrungszeichen, um die einzelnen oder
doppelten Anflihrungszeichen fiir die unterstitzten Sprachen anzugeben. Die Anflihrungszeichen, die Sie
hier angeben, werden automatisch Glbernommen, wenn Sie sie in lhrem Dokument verwenden.

Rechtschreibung > Rechtschreiboptionen

Die folgenden Einstellungen sind in diesem Abschnitt verfigbar.

Einstellung

Beschreibung

Automatische Rechtschreibpriifung

Verwenden Sie die Rechtschreibpriifung in einem
Dokument direkt beim Schreiben. Wenn ein Wort
falsch geschrieben wurde, erscheint darunter
eine rote Schlangellinie.

Suchen

Wort wiederholen

Wahlen Sie diese Option fiir die
Rechtschreibprifung, um wiederholte Worter in
Ihrem Dokument zu finden.

Uniibliche Trennung

Waihlen Sie diese Option fiir die
Rechtschreibpriifung, um unibliche
Silbentrennung in Ihrem Dokument zu finden.

Unibliche GroR-/Kleinschreibung

Wahlen Sie diese Option fir die
Rechtschreibprifung, um unibliche
GroR-/Kleinschreibung (z. B. Griin) in lhrem
Dokument zu finden.

Doppelte

Waihlen Sie diese Option aus, und geben Sie
Zeichen an, die von der Rechtschreibpriifung
markiert werden sollen, wenn sie in Folge
gefunden werden.
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Einstellung

Beschreibung

Gerade Anflihrungszeichen

Wahlen Sie diese Option fir die
Rechtschreibprifung, um gerade
Anfuhrungszeichen in Ihrem Dokument zu finden.

Zusatzliche Leerzeichen

Wahlen Sie diese Option fir die
Rechtschreibprifung, um zusatzliche Leerzeichen
zwischen zwei Wortern zu finden.

Leerzeichen vor

Wahlen Sie diese Option, und geben Sie Zeichen
an, die von der Rechtschreibpriifung markiert
werden sollen, wenn ein Leerzeichen davor
gefunden wird.

Leerzeichen nach

Wahlen Sie diese Option, und geben Sie Zeichen
an, die von der Rechtschreibprifung markiert
werden sollen, wenn ein Leerzeichen danach
gefunden wird.

Standard abrufen

Klicken Sie auf diese Schaltflache, um die
Rechtschreiboptionen auf die Standardauswahl
zurlickzusetzen.

Ignorieren

Worter mit einem einzelnen Zeichen

Wahlen Sie diese Option, um Woérter, die aus
einem einzelnes Zeichen bestehen, von der
Rechtschreibprifung ignorieren zu lassen.

Worter in GroRbuchstaben

Wahlen Sie diese Option, um Worter von der
Rechtschreibprifung ignorieren zu lassen, die in
GroRbuchstaben geschrieben sind.

Worter mit

Wahlen Sie diese Option und geben Sie Zeichen
an, die, wenn sie in einem Wort gefunden
werden, nicht von der Rechtschreibpriifung
markiert werden sollen.

Romische Ziffern (nicht zutreffend fir Hunspell)

Wahlen Sie diese Option, um rémische Ziffern,
die von der Rechtschreibpriifung gefunden
werden, zu ignorieren.

Worter mit Ziffern

Wahlen Sie diese Option, um alle Worter, die
Ziffern enthalten, von der Rechtschreibprifung
ignorieren zu lassen.
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Einstellung

Beschreibung

Voran- und nachgestellte typographische
Anflihrungszeichen

Wahlen Sie diese Option aus, um die
typographischen Anfiihrungszeichen, die unter
den Typographische
Anflihrungszeichen-Einstellungen angegeben
sind, in den Bereich vor und nach der Regel
einzuschlieBen.

XML

Die folgenden Einstellungen sind in diesem Abschnitt verfligbar.

Einstellung

Beschreibung

Syntaxfarben

Waihlen Sie die Farben fir die Anzeige von
Attributen, Kommentaren, Entitaten,
Elementnamen und anderen Objekten in der
XML-Ansicht aus.

Zeilennummern anzeigen

Wahlen Sie diese Option, um die Zeilennummern
in der XML-Ansicht anzuzeigen.

Zeilenumbruch

Wahlen Sie diese Option, wenn die Zeilen in der
XML-Ansicht umbrochen werden sollen.

Schriftfamilie

Wahlen Sie die Schriftfamilie aus, die fiir die
Darstellung von XML-Code in der XML-Ansicht
verwendet werden soll.

MathML

Die folgenden Einstellungen sind in diesem Abschnitt verflgbar.

Einstellung

Beschreibung

MathFlow

Installationspfad

Suchen Sie den Installationspfad von MathFlow
auf lhrem System und wahlen Sie ihn aus.

Pfad zur Lizenzdatei

Suchen Sie den Pfad der MathFlow-Lizenzdatei
auf lhrem System und wahlen Sie ihn aus.

Editortyp

Wahlen Sie den MathFlow-Editor, den Sie
verwenden méchten. Mogliche Optionen sind
Stileditor und Struktureditor.

Weitere Informationen finden Sie unter Erstellen
von Gleichungen mit MathML.
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Einstellung

Beschreibung

Einstellungen fiir MathFlow

DPI

MathML-Gleichungen werden in lhrem
Dokument in Form eines Bilds eingefligt. Geben
Sie die DPIs fiir die MathML-Gleichungsbilder an.

Inline einbetten

Wahlen Sie diese Option, um das Gleichungsbild
eingebunden mit dem umschlieRenden Absatz
einzubetten.

Absatzstil anwenden

Wahlen Sie diese Option, um die Formatierung
des umschlieRenden Absatzes auf die
MathML-Gleichung anzuwenden.

Als PNG exportieren

Wahlen Sie diese Option aus, um die
MathML-Gleichungen als PNG-Bilder in die
PDF-Ausgabe zu exportieren.

Schriftgrad Geben Sie die SchriftgréRe in Pixel fiir die
MathML-Gleichung an. Die StandardschriftgréRe
ist auf 14px festgelegt.

Warnung

Warnung fiir Testlizenz anzeigen

Wahlen Sie diese Option, um eine Warnung
anzuzeigen, wenn Sie eine Testlizenz fur
MathFlow verwenden.
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Kontexthinweise

Erfahren Sie, wie Kontexthinweise Ihnen dabei helfen, die neuen Funktionen von Adobe FrameMaker zu
finden.

Uber die Kontexthinweise kénnen Sie neue in FrameMaker eingefiihrte Funktionen finden, oder eine
alternative Methode zum Ausfiihren einer reguldren Aufgabe. Wenn eine Funktion mit der aktuell durch-
gefiihrten Aufgabe verknipft ist, werden in den Kontexthinweisen die verkniipften Funktionsinforma-
tionen in Form eines Tipps angezeigt. Mit diesen niitzlichen Tipps kdnnen Sie lhre Aufgaben einfach und
effizient durchfihren.

Wenn Sie beispielsweise zum ersten Mal ein neues Dokument 6ffnen, wird ein Tipp in der rechten
unteren Ecke des FrameMaker-Arbeitsbereichs angezeigt.

Tips (7) (x)

*ou can also use the multi-device publizhing feature to publish your
content to @ vanety of output formats other than POF. such as
Respansive HTMLS, EPUE. and \WebHelp.

Showhie Details

Figure 1:  Kontexthinweise in FrameMaker

Das Dialogfeld Tipps enthalt die folgenden Schaltflachen:

. ?: Halten Sie den Mauszeiger lber diese Schaltflache, um zu sehen, wie diese Tipps aktiviert oder
deaktivier werden.

J ShowMe: Diese Schaltfliche wird nur fiir bestimmte Tipps angezeigt. Uber diese Schaltfliche wird
das entsprechende Fenster gedffnet, auf das im Tipp Bezug genommen wird.

. Details: Durch Klicken auf diese Schaltflache wird der entsprechende Hilfeinhalt aufgerufen.

. X: Durch Klicken auf diese Schaltflache wird der Tipp geschlossen. Anweisungen dazu, wie das
Anzeigen weiterer Meldungen gestoppt wird, finden Sie unter Voreinstellungen fiir Kontexthin-
weise.

Jeder Tipp wird nur einmal fiir einen bestimmten Arbeitsablauf angezeigt. Wenn Sie beispielsweise das
nachste Mal ein Dokument 6ffnen, wird der Tipp nicht mehr angezeigt. Es wird versucht, lhnen wertvolle
Informationen bereitzustellen, ohne dabei aufdringlich zu sein. Wenn Sie dabei einen Arbeitsablauf
ausfiihren, nimmt FrameMaker an, dass Sie entweder die Informationen im Tipp genutzt haben oder
diese Informationen nicht benotigen.

Voreinstellungen fiir Kontexthinweise

Wahlen Sie zum Anpassen der Voreinstellungen fiir Kontexthinweise Bearbeiten > Voreinstellungen >
Global > Warnungen. Die folgenden mit den Kontexthinweisen verkniipften Optionen sind am unteren
Rand des Dialogfelds verfiigbar:
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Kontextbezogene Hinweise anzeigen

Heben Sie die Auswahl fiir diese Option auf, damit keine weiteren Meldungen mehr angezeigt
werden. Dies bedeutet, dass, wenn Sie eine Aufgabe zum ersten Mal ausfiihren, Sie keinen Tipp
oder Nachricht angezeigt bekommen.

Kontextbezogene Hinweise zuriicksetzen

Durch Klicken auf die Schaltflaiche Kontexthinweise neu starten werden die Tipps fiir die Arbe-
itsablaufe erneut angezeigt, die bereits ausgefiihrt wurden. Beispielsweise wird ein Tipp beim
Speichern eines Dokuments angezeigt. Sie konnen die Kontexthinweise zurlicksetzen, indem Sie
auf diese Schaltflache klicken und beim nachsten Speichern des Dokuments wird dieser Tipp wieder
angezeigt.
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Verwalten von offenen Dateien

Erfahren Sie, wie Sie in FrameMaker den Pod Fenster Offene Dateien.
Im Fenster Offene Dateien konnen Sie eine grolRe Anzahl offener Dateien verwalten und darin navigieren.

Im Fenster Offene Dateien kénnen Sie die folgenden Aktionen ausfiihren:
1)  Dateien priifen und mit nicht gespeicherten Anderungen speichern.

2)  Nach einer Datei mit bestimmtem Namen oder nach in einem bestimmten Ordner gespeicherten
Dateien suchen.

3)  Durch verschiedene Dateien navigieren.
4) Die Pfade verschiedener gedffneter Dateien prifen.
5) Bestimmte Dateien nach dem Speichern bzw. ohne Speichern schliel3en.

- s
0 xen Fi es é_
AHHB x v &
|Search texdt | L X|
G 1 Name Path
General-Descri...  K:temp'2018\user-guide*.Sample-unstructuredGeneral-Description fm
H [ Operating-Limit... K:‘temp'2018\user-guide.Sample-unstructured \Operating-Limitations fm
] Personal Spac... K’temp'2018'wser-quide’Sample-unstructured'\Personal Spaceship ...
[ Systemsfm K-\ temp'201 8'\wuser-guideSample-unstructured"Systems fm

Figure 1:  Das Fenster ,Offene Dateien”

A. Speichern Sie Dateien, und halten Sie sie offen. B. Speichern Sie die ausgewahlten Dateien, und
schlieBen Sie sie. C. SchlieRen Sie die ausgewahlten Dateien —wenn die Dateien, die Sie schlieRen
mochten, nicht gespeicherte Anderungen enthalten, wird das Dialogfeld ,Dateien speichern angezeigt.
D. Suchen — wahrend lhrer Eingabe werden die Eintrage in allen Spalten darauf tiberprift, ob sie den
Suchkriterien entsprechen. Verwenden Sie das Kreuzsymbol neben dem Suchtextfeld, um den eingege-
benen Suchtext zu I6schen. E. Wahlen Sie zum Filtern , Alle”, ,,Nicht gespeicherte” oder , Gespeicherte”.
F.Aktualisieren Sie die Dateiliste. G. Wahlen Sie alle Dateien in der Liste. H. Liste der derzeit gedffneten
Dateien

Sie kdnnen das Fenster Offene Dateien anzeigen, indem Sie Ansicht > Fenster > Offene Dateien oder
Ansicht > Offene Dateien wahlen.

Ein Video dazu finden Sie unter Offene Dateien.
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Speichern von Dateien beim SchlieBen der Dateien und Beenden

FrameMaker zeigt das Dialogfeld Dateien speichern an, wenn Sie eine der folgenden Aktionen ausfiihren:

Beenden von FrameMaker durch

- Klicken auf die Schaltflache SchlieRen
- Auswahlen von Datei > Beenden

- Verwenden von Alt+F4 auf der Tastatur

Auswahl einer Datei bei gedriickter Umschalttaste und Auswahl einer der folgenden Optionen
- Alle gedffneten Dateien schlieBen

- Alle Dateien des Buchs schlieRen

- Alle Dateien in Ditamap schlieSen

Versuchen Sie im Fenster Offene Dateien, Dateien ohne Speichern zu schlieRRen.

Save Files *

Do you want to save your changes to the selected files?

] Name = Path
OperatingLimitations fm™ K- Kuldip  Work\FM"Release’ 201 7 UserGuide \Operating Limitati
Systems fm* K- \KuldipWordd\FM'\Release' 2017 UserGuide Systems fm

< >

Save Don't Save Cancel

Figure 2:  Das Dialogfeld , Dateien speichern”

Im Dialogfeld ,,Dateien speichern” kénnen Sie Dateien mit nicht gespeicherten Anderungen tiberpriifen
und speichern. Sie kénnen die Anderungen auch verwerfen, indem Sie das Auswéhlen der Dateien
aufheben und auf Speichern klicken.

Speichern und SchlieBen von offenen Dateien

Sie kdnnen eine Liste der derzeit geéffneten Dokumente im Fenster Gedffnete Dateien anzeigen. Im
Fenster Offene Dateien kénnen Sie die Dateien und Anderungen auswéhlen, die gespeichert und
verworfen werden sollen.

1)

2)

Wahlen Sie Ansicht > Fenster > Offene Dateien.

FrameMaker zeigt das Fenster Offene Dateien an. Nicht gespeicherte Dateien und Dateien mit nicht
gespeicherten Anderungen sind mit einem Sternchen (*) gekennzeichnet. Um Dateien in einer lan-
gen Liste zu finden, geben Sie Text in das Feld Suchen ein. FrameMaker sucht nach dem Text im
Namen der Datei sowie im Pfad.

Wihlen Sie die zu speichernden Dateien aus und fiihren Sie eine der folgenden Aktionen aus:
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Klicken Sie auf Speichern.

FrameMaker speichert die ausgewdhlten Dateien. Sie werden von FrameMaker aufgefordert,
den Namen und Pfad der Dateien anzugeben, die noch nicht auf der Festplatte gespeichert
sind.

Klicken Sie auf Speichern und schlieRen.
FrameMaker speichert und schlief3t die ausgewdhlten Dateien.
Dateien schlieRen.

FrameMaker schlief3t die ausgewdhlten Dateien. Wenn Sie Dateien mit nicht gespeicherten
Anderungen schliefSen, wird das Dialogfeld ,, Dateien speichern” angezeigt.
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Wiederherstellen der letzten Sitzung

Erfahren Sie, wie FrameMaker lhnen die Wiederherstellung der letzten Sitzung, Schritte und Voreinstel-
lungen ermoglicht.

In diesem Thema

L Einflihrung

] Bedingungen zum Wiederherstellen der letzten Sitzung

. Wiederherstellen der letzten Sitzung
. Voreinstellungen fiir Warnmeldungen bei Wiederherstellung
Einfiihrung

FrameMaker ermoglicht es lhnen, die letzte Sitzung wiederherzustellen, an der Sie gearbeitet haben, als
Sie FrameMaker zuletzt beendet haben oder das Programm abgestiirzt ist. Wenn Sie FrameMaker nach
einem Absturz erneut starten, wird eine Warnmeldung angezeigt und Sie konnen entscheiden, ob die
letzte Sitzung wiederhergestellt werden soll oder nicht. Durch die Wiederherstellung der letzten Sitzung
konnen Sie Folgendes reaktivieren, da Sie daran in der letzten Sitzung gearbeitet haben:

o Ansicht: XML-Code, WYSIWYG oder Autor
o Arbeitsbereich
o Das aktive Dokument

. Die in der letzten Sitzung gedffneten Dateien (mit Ausnahme der in der letzten Sitzung tber den
CMS Connector gedffneten Dateien)

] Aktive Seitennummern fiir verschiedene Dokumente

o Der Bildlaufbereich fiir die Vorgabe-, Arbeits- und Referenzseiten
. Tabulatorreihenfolge der Dokumente

. Paletten (wie z. B. Gleichung, Vorlagen und Thesaurus-Browser)

J stuctapps.fm-Datei: Die zuletzt gelesene structapps.fm-Datei (bei der Wiederherstellung wird die
zuletzt gelesene structapps . fm-Datei erneut gelesen)

Ein Video dazu finden Sie unter Wiederherstellen der Sitzung mit einem Klick.

Bedingungen zum Wiederherstellen der letzten Sitzung

Sind folgende Bedingungen erfiillt, konnen Sie die letzte Sitzung wiederherstellen:

1) Eswaren Dateien gedffnet, als Sie FrameMaker beendet haben oder das Programm abgestirzt ist.
Mit anderen Worten: Aus der letzten Sitzung kann etwas wiederhergestellt werden. Wenn Sie
Dateien nach dem manuellen SchlieBen in FrameMaker beenden, kann nichts wiederhergestellt
werden.

2)  Essind keine Dateien gedffnet, wenn Sie versuchen, die letzte Sitzung wiederherzustellen.

3) Der aktuelle FrameMaker-Modus (strukturiert oder unstrukturiert oder XML-Autor) ist derselbe
wie beim letzten Beenden.
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Wiederherstellen der letzten Sitzung

Um die letzte Sitzung in FrameMaker wiederherzustellen, starten Sie FrameMaker und fiihren Sie eine
der folgenden Aktionen aus:

. Klicken Sie auf Letzte Sitzung wiederherstellen auf dem BegriiSungsbildschirm.
ODER

J Wahlen Sie Datei > Zuletzt verwendete 6ffnen > Letzte Sitzung wieder herstellen.
ODER

J Verwenden Sie den Tastaturbefehl Esc+r+s.

] Wenn Sie FrameMaker nach einem Absturz erneut starten, wird eine Warnmeldung angezeigt und
Sie kdnnen auf Ja klicken, um die letzte Sitzung wiederherzustellen.

FrameMaker stellt die letzte Sitzung wieder her. Falls einige Dateien nicht wiederhergestellt werden
konnten, zeigt FrameMaker eine Fehlermeldung an und listet die Dateien im Fenster Konsole auf.
HiNwels: Wahlen Sie zum Starten des Fensters Konsole Ansicht > Fenster > Konsole, oder driicken Sie
Esc+c+P.

Voreinstellungen fiir Warnmeldungen bei Wiederherstellung

Im Dialogfeld Voreinstellungen konnen Sie auswahlen, ob die Warnmeldungen, z. B. zu fehlenden
Schriften und ungelésten Querverweisen, bei der Sitzungswiederherstellung angezeigt werden sollen.
Die Warnmeldungen, bei denen eine Aktion durch den Benutzer erforderlich ist, z. B. fehlende Grafiken,
werden angezeigt, auch wenn Sie die Warnmeldungen deaktiviert haben.
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Wiederherstellen der Abmessungen der Ressourcenmanager-Ansichten

Erfahren Sie, wie FrameMaker die Abmessungen der Ressourcenmanager-Ansichten beim Beenden und
Neustarten beibehilt.

FrameMaker behilt die Abmessungen fir die folgenden Ressourcenmanager-Ansichten beim Beenden
und Neustarten bei:

] Ressourcenmanager-Ansicht fiir Buch

o Ressourcenmanager-Ansicht flir CMS Repository Browser

o Ressourcenmanager-Ansicht fiir eine DITA Map

FrameMaker behilt die Abmessungen fiir die Ressourcenmanager-Ansichten bei und verwendet sie als
Standardabmessungen fiir diese Ressourcenmanager-Ansichten, wenn Sie sie schliefen und erneut
offnen.

. Bei abgedockten Ressourcenmanager-Ansichten behalt FrameMaker die Breite sowie die H6he bei.
] Bei angedockten Ressourcenmanager-Ansichten behalt FrameMaker die Breite bei.
Die fir an- und abgedockte Ressourcenmanager-Ansichten beibehaltene Breite ist unterschiedlich. Die

fir verschiedene Ressourcenmanager-Ansichten (zum Beispiel Buch und DITA Map) beibehaltenen
Abmessungen sind identisch.
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Tipps fiir die Arbeit mit der Benutzeroberflache

Lernen Sie einige Tipps und Verknlpfungen fur die Arbeit mit Benutzeroberflache, Helligkeit, Dokument-
fenstern, Fenstern und Symbolen in Adobe FrameMaker kennen.

Kombinieren von Dokumentfenstern

Klicken Sie zum Zusammenfiihren aller (gleitenden, minimierten oder angedockten) Dokumentfen-
ster mit der rechten Maustaste auf die Registerkartenleiste des angedockten Dokumentfensters,
und wahlen Sie im Men( Alle bis hier zusammenfiigen.

Offnen Sie die Datei im Windows Explorer

Um den Speicherort einer Datei im Windows Explorer zu 6ffnen, klicken Sie mit der rechten
Maustaste auf die Registerkartenleiste des angedockten Fensters mit dem Dokument, und wahlen
Sie im Kontextmenii den Befehl Ubergeordneten Ordner 6ffnen. Die Datei des Dokuments wird im
Windows Explorer automatisch ausgewahlt.

Dokumentfenster gleiten lassen

Klicken Sie auf das Symbol Dokumente anordnen in der Anwendungsleiste oben, und wahlen Sie
Alle in schwebenden Fenstern. Daraufhin werden alle Dokumentfenster kaskadenartig als
gleitende Fenster angeordnet.

Dokumente nebeneinander oder untereinander anordnen

Benutzen Sie das Symbol Dokumente anordnen, um Dokumente nebeneinander oder unterein-
ander anzuordnen. Diese Ansicht ist besonders hilfreich beim manuellen Vergleich von Doku-
menten.

Einblenden ausgeblendeter Fenster
Bei der Arbeit mit gleitenden Dokumentfenstern oder beim Wechseln von Arbeitsbereichen kann
es manchmal schwierig erscheinen, Fenster einzublenden.

. Docken Sie die Fenster ab, indem Sie sie an der Fenstertitelleiste nach vorne ziehen.

. Alle gleitenden Dokumentfenster andocken Klicken Sie mit der rechten Maustaste auf die anged-
ockte Registerkartenleiste, und wahlen Sie Alle bis hier zusammenfiigen, oder ziehen Sie die
gleitenden Dokumentfenster und docken Sie sie an.

Reduzieren von Fenstern auf Symbole
Klicken Sie mit der rechten Maustaste auf die Registerkartenleiste des Fensters, und wahlen Sie im
Meni Auf Symbole reduzieren. Diese Option ist nur bei gleitenden Fenstern verfligbar, nicht bei
angedockten. Klicken Sie zum Reduzieren angedockter Fenster auf einen beliebigen Ort in der
Registerkartenleiste.

Erneutes Offnen der Fenster
Wahlen Sie Ansicht > Fenster, und klicken Sie auf einen beliebigen Fensternamen. Unten im Arbe-
itsbereich wird die gesamte Fenstergruppe angezeigt.

Erneutes Offnen eines Fensters
Wabhlen SieFenster > Fenster
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, und wahlen Sie das Fenster, das Sie erneut 6ffnen mochten.

Reduzieren aller offenen Fenstergruppen auf Symbole
Klicken Sie mit der rechten Maustaste auf die Registerkartenleiste der Fenstergruppe, und wahlen
Sie Auf Symbole reduzieren.

Vollbildmodus beenden

Klicken Sie mit der rechten Maustaste im Dokumentfenster auf den Bereich auRerhalb des
Textrahmens, und wahlen Sie Bildschirmmodus umschalten.

RELATED LINKS:
Bildschirmmodi
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EINGABEHILFEN

Eingabehilfen

Lernen Sie die Funktionen kennen, mit denen FrameMaker den Zugriff fir Benutzer mit eingeschrankten
Sehfahigkeiten verbessert.

Die FrameMaker-Software enthalt eine Reihe von Funktionen, die den Zugriff flir Benutzer mit einges-
chrankten Sehfahigkeiten verbessern. Ganz konkret sind das:
. Unterstitzung der Anzeige mit hohen Kontrastwerten fiir Benutzer mit geringer Sehscharfe.

] Erstellung von mit Tags versehenen Adobe PDF-Dateien bei der Konvertierung von
FrameMaker-Dateien in Tagged PDF-Dateien. Dadurch wird Personen, die Bildschirmlesesoftware
verwenden, das Navigieren durch Dokumente in der richtigen Lesefolge erleichtert. Weitere Infor-
mationen zur Umwandlung von FrameMaker-Dokumenten in Adobe Tagged-PDF-Dateien finden
Sie unter Ausgabe von Tagged-PDF-Dateien.

. Unterstitzung von Technologien wie Bildschirmlesesoftware fiir die Plattform von Windows®

Bildschirmlesesoftware erméglicht sehbehinderten Benutzern die Interaktion mit dem Computer, indem
sie das Bildschirmgeschehen interpretiert und diese Informationen dann an Sprachsynthesegerate
sendet. Dabei folgt die Bildschirmlesesoftware der logischen Struktur des Dokuments. Bildschirmlese-

software kann in FrameMaker angezeigte FrameMaker-Dokumente lesen sowie in Adobe Acrobat” oder

Adobe Reader’ angezeigte Tagged-PDF-Dokumente. Informationen zur Installation lhrer Bildschirmlese-
software und zu deren Verwendung mit in FrameMaker oder Acrobat angezeigten Dokumenten finden
Sie in der Dokumentation lhrer Bildschirmlesesoftware.

Weitere Informationen zur Barrierefreiheit in Adobe Acrobat und Adobe PDF-Dokumenten finden Sie in
der Onlinehilfe zu Acrobat und auf der Website von Adobe.

Starten der Bildschirmtastatur
1)  Wahlen Sie im Startmeni Programme > Zubehor > Eingabehilfen > Bildschirmtastatur.
2)  Klicken Sie auf ,,OK“. Nun kénnen Sie mit der Verwendung der Bildschirmtastatur beginnen.

RELATED LINKS:
Arbeitsbereich mit hohen Kontrastwerten
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DOKUMENTE

Dokumente

Verstehen der verschiedenen Methoden zum Erstellen von Dokumenten in FrameMaker. Verwenden Sie
die integrierten Vorlagen, um lhre Dokumente zu erstellen.

Weitere Informationen zum Arbeiten mit Dokumenten finden Sie in den Unterthemen.
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Erstellen eines Dokuments

Erfahren Sie, wie Sie ein Dokument in Adobe FrameMaker aus einem leeren Dokument oder einer
Vorlage erstellen. Erfahren Sie, wie Sie die Richtung des Dokuments festlegen (von links nach rechts/von
rechts nach links).

FrameMaker bietet verschiedene Vorlagen fiir Ihre Dokumente. Alternativ kdnnen Sie auch eine von
Ihrem Unternehmen definierte Vorlage verwenden oder ein leeres Dokument erzeugen.

Standardmafig haben FrameMaker-Dokumente die Erweiterung . fm.
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Erstellen von leeren Dokumenten

Erfahren Sie, wie Sie ein leeres Dokument mit der Standardvorlage in Adobe FrameMaker erstellen.
Wenn Sie eine Vorlage fiir lhr Unternehmen oder |hr Team erstellen, ist es moglicherweise sinnvoll, mit
einem leeren FrameMaker-Dokument zu beginnen.

1)  Waéhlen Sie Datei > Neu > Dokument.

2) Geben Sie das grundlegende Seitenlayout an:

- Wenn Sie ein einspaltiges Standarddokument erstellen wollen, klicken Sie auf Hochformat
oder Querformat.

- Um ein Dokument mit benutzerdefinierten Einstellungen fiir SeitengréRe, Spalten, Spalten-
rander und Seitenumbruch zu erstellen, klicken Sie auf Benutzerdefiniert, und geben Sie die
gewlinschten Werte ein. Klicken Sie auf Erstellen.

Sie kénnen auch eine MafSeinheit fiir das Dokument auswdhlen. In FrameMaker werden die
Mafe in Dialogfeldern und in der Statuszeile des Dokumentfensters in der ausgewdhlten
MafSeinheit angezeigt.

3)  Fillen Sie das Dokument mit Inhalt.
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Erstellen von Dokumenten aus Vorlagen

Erfahren Sie, wie Sie ein neues FrameMaker-Dokument basierend auf einer Vorlage erstellen.

In diesem Thema

. Einflihrung

J Standardvorlagen

. Strukturierte Vorlagen

. Benutzerdefinierte Vorlagen
J Rechts-nach-links-Vorlage

Einfiihrung

Sie kdnnen Dokumente aus Vorlagen erstellen. Thr Unternehmen hat méglicherweise Vorlagen fiir
verschiedene Arten von Dokumenten vordefiniert. Wahlen Sie Datei > Neu > Dokument, um ein neues
Dokument zu erstellen.

Fiihren Sie zum Erstellen von Dokumenten aus einer vordefinierten Vorlage die folgenden Schritte durch.

Standardvorlagen

So erstellen Sie ein FrameMaker-Dokument aus einer Standardvorlage:
1) Klicken Sie auf Standardvorlagen durchsuchen.

2)  Wahlen Sie im Dialogfeld ,,Standardvorlagen” eine Vorlage aus. Benutzerhandbuch — rechtliche
Hinweise.

3) Klicken Sie auf Erstellen, um ein Dokument aus der ausgewahlten Vorlage zu erstellen.

HINwEIS: Alternativ kdnnen Sie auch auf Beispiel anzeigen klicken, um das Dokument auf einer
neuen Registerkarte anzuzeigen. Dadurch wird das Dialogfeld Standardvorlagen geschlossen. Um
nach dem Anzeigen der Vorlage zum Dialogfeld zurlickzukehren, wahlen Sie erneut Datei > Neu >
Dokument > Standardvorlagen durchsuchen.

4)  Fullen Sie das Dokument mit Inhalt.

Strukturierte Vorlagen

So erstellen Sie ein strukturiertes Dokument aus einer strukturierten Vorlage:

1)  Klicken Sie auf Strukturierte Vorlagen durchsuchen.

2)  Wahlen Sie im Dialogfeld ,Strukturierte Vorlagen” eine Vorlage aus. Beispiel: Business — Memo.
3) Klicken Sie auf Erstellen, um ein Dokument aus der ausgewahlten Vorlage zu erstellen.

HINweEIs: Alternativ kdnnen Sie auch auf Beispiel anzeigen klicken, um das Dokument auf einer
neuen Registerkarte anzuzeigen. Dadurch wird das Dialogfeld Strukturierte Vorlagen geschlossen.
Um nach dem Anzeigen der Vorlage zum Dialogfeld zuriickzukehren, wahlen Sie erneut Datei > Neu
> Dokument > Strukturierte Vorlagen durchsuchen.

4)  Fullen Sie das Dokument mit Inhalt.
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Benutzerdefinierte Vorlagen

So wahlen Sie eine benutzerdefinierte Vorlage aus:
1)  Navigieren Sie zu dem Dokument, das als Vorlage fiir das neue Dokument dienen soll.
2)  Klicken Sie auf Neu.

Rechts-nach-links-Vorlage

So erstellen Sie ein Rechts-nach-links-Dokument aus einer Rechts-nach-Links-Vorlage:
1)  Navigieren Sie zum Ordner ,Vorlagen” (SFMHOME \ Templates).

2) Klicken Sie auf die RTLTemplate. fm.

3) Klicken Sie auf Neu.

4)  Fullen Sie das Dokument mit Inhalt.

HINweEIs: Auf diese Weise erstellen Sie ein leeres Dokument mit der Schreibrichtung von rechts nach links.

113



Offnen von Dokumenten

Erfahren Sie, wie Sie verschiedene Dateien und Dokumente in FrameMaker 6ffnen kdnnen. Erfahren Sie,
wie Sie vorgehen, wenn Schriftarten nicht verfiigbar sind.

Neben FrameMaker-Dokumenten kdnnen Sie auch Textdateien, MIF-Dateien (Maker Interchange
Format), MML-Dateien (Maker Markup Language) sowie XML- und SGML-Dokumente 6ffnen. Wenn der
erforderliche Filter installiert wurde, konnen dariiber hinaus auch in anderen Anwendungen (z. B. Micro-

soft” Word) erstellte Dateien ge6ffnet werden. Beim Offnen der Datei bleiben die meisten Format-
ierungen erhalten.

Hinwels: Wenn Sie Dateien 6ffnen mochten, die mit FrameMaker 7 oder friiher erstellt wurden, miissen
Sie sie als MIF-Dateien speichern.

Datei 6ffnen

1)  Waibhlen Sie Datei > Offnen.

B open x
U c« 2018 » user-guide » Sample-unstructured v | D Search Sample-unstructured 0
Organize + Mew folder ==~ [ 0
v Adobe FrameMaker 2018 » Name - Date modified Type ~

AMT

media 1:09 PM File folder

APCZO output 1210 PM File folder
clipart Settings File folder
CustomHooks a Backpagefm 1 Adobe Fram
dict a Contacts.fm A Adobe Frarr

a Contents.fm A Adobe Frarr
Documents

a Cover.fm VI Adobe Frarr

us
en- a General-Description.fm AM  Adobe Frarr
ExtendScriptResources a Index fm 1 Adobe Fran
Features a Legal fm A Adobe Frarr
filters a Operating-Limitations.fm A Adobe Frarr
frinit “Fn| Personal Spaceship User Guide - EN-US.b... 6/ VI Adobe Frarr ,
Fontdir I >
File name: v| All FrameMaker Documents (*14 ~

Figure 1: Dialogfeld , Datei 6ffnen”

Die Dialogfelder Offnen und Dokument speichern basieren auf den nativen Windows-Dialogfeldern
,Offnen” und ,,Speichern”, die einen einfachen Zugriff auf Dateien auf lhrem System ermdglichen.

HINWEIS: Wenn Sie das alte Dialogfeld Offnen verwenden mdchten, deaktivieren Sie die Einstellung
Windows-Dateibrowser verwenden im Dialogfeld Windows-Dateibrowser verwenden im Dialog-
feld Bearbeiten > Voreinstellungen > Global > Benutzeroberflache.

2)  Suchen Sie das Dokument, und klicken Sie auf Offnen.

Beim Offnen eines Dokuments werden normalerweise durch Referenz importierte Grafiken, Textein-
schiibe, Querverweise und Systemvariablen (falls vorhanden) aktualisiert. Die zuletzt gedffneten Dateien
sind unten im Men ,,Datei” aufgefiihrt.

Manchmal werden Meldungen zu moéglichen Problemen mit der jeweiligen Datei angezeigt. Sie kénnen
auf OK klicken und die Probleme spater beheben.
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HINwEIS: AuBerdem kdnnen Sie Dateien aus Windows Explorer in das Dokumentenfenster, leere Ul-Bere-
iche, Symbolleisten, Menilileisten oder Fenster ziehen, um die Dateien zu 6ffnen.

Offnen von Textdateien

Nur-Text-Dateien enthalten keine Grafiken oder Formatinformationen. Beim Offnen einer
Nur-Text-Datei missen Sie bestéatigen, dass es sich um eine Textdatei handelt.

1)  Wabhlen Sie Datei > Offnen und 6ffnen Sie eine TXT-Datei. Das Dialogfeld Unbekannter Dateityp
wird angezeigt.

2)  Wahlen Sie die Option Text.

3)  Klicken Sie auf Konvertieren.

4)  Wahlen Sie eine der folgenden Optionen aus:

- Wenn Zeilenumbriiche nur bei Leerzeilen eingefligt werden sollen, wahlen Sie Zeilenenden
einlesen als Zeilenumbriiche. Setzen Sie diese Option fiir absatzorientierte Textdateien ein,
z. B. fir Dateien, die Dokumenttext enthalten.

- Soll am Ende jeder Zeile ein Umbruch erfolgen, wahlen Sie Zeilenenden einlesen als Absatz-
enden. Diese Option eignet sich fiur zeilenorientierte Textdateien, z. B. fir Dateien, die
Computercode enthalten.

- Wenn Text in eine Tabelle konvertiert werden soll, wahlen Sie Text in Tabelle konvertieren.
Verwenden Sie diese Option, wenn der Inhalt der Quelldatei aus Tabellen besteht.

Sie kénnen im Dialogfeld In Tabelle konvertieren weitere Optionen wdhlen, wie etwa die An-
zahl der Spalten, die Trennlinien zwischen den Zellen oder Kopfzeilen, und erhalten so die Dat-
en in der gewlinschten Tabellenform.

5)  Wahlen Sie das gewiinschte Codierungsschema. StandardmaRig ist das ANSI-Codierungsschema
(Windows) ausgewahlt.

6) Klicken Sie auf Einlesen. Der Text wird in einem mit einer speziellen Vorlage erstellten Dokument
angezeigt. Sie konnen diese Vorlage dandern, um die Formatierung von Dokumenten anzupassen,
die aus Textdateien erstellt werden.

Offnen von Dokumenten in Verwendung

Bei jedem Offnen eines Dokuments wird eine Sperrdatei (* . 1ck) erstellt. Diese Sperrdatei verhindert,
dass andere Anderungen an der Datei vornehmen, an der Sie gerade arbeiten. Eine Sperrdatei befindet
sich im selben Ordner wie das Originaldokument und wird beim Schlieen des Dokuments entfernt. Das
Sperren von Dateien kann deaktiviert werden.

Wenn Sie versuchen, ein bereits ge6ffnetes Dokument aufzurufen und tGber Schreibzugriff auf das Doku-
ment verfligen, wird ein Dialogfeld mit dem Namen des Dokuments, dem letzten Benutzer, dem Zeit-
punkt der Verwendung und dem dabei verwendeten Computer angezeigt. Dasselbe Dialogfeld wird
manchmal auch nach einem Systemabsturz angezeigt, wenn Sie ein Dokument 6ffnen, das Sie zuletzt
verwendet haben.

Offnen Sie die Datei und fiihren Sie einen der folgenden Schritte aus:

o Wenn Sie die Datei lediglich ansehen, aber nicht andern mochten, klicken Sie auf Nur zum Lesen
o6ffnen und anschliefend auf Fortfahren. Das Dokument wird dann im Viewerformat angezeigt.
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. Wenn Sie eine Kopie der Datei bearbeiten mochten, klicken Sie auf Kopie fiir Bearbeitung 6ffnen
und anschlieBend auf Fortfahren. Es wird eine Kopie der Datei gedffnet und wenn Sie diese Datei
speichern mochten, werden Sie zur Angabe eines neuen Dateinamens aufgefordert.

. Wenn Sie die Datei bearbeiten moéchten und sich sicher sind, dass kein anderer Benutzer sie
geoffnet hat, klicken Sie auf Sperre zuriicksetzen und 6ffnen und anschlieRend auf Fortfahren. Mit
dieser Option kdnnen nach einem Systemabsturz Dokumente bearbeitet werden, die zur Zeit des
Absturzes getffnet waren.

Offnen von Dokumenten ohne Aktualisierung der Querverweise

Das Offnen einer Datei nimmt relativ viel Zeit in Anspruch, wenn sie viele Querverweise auf andere
Dateien, groBe importierte Grafiken oder viele Texteinschiibe enthalt. Wenn Sie die Aktualisierung von
importierten Grafiken, Querverweisen und Texteinschiiben unterdriicken, kdnnen Sie Dokumente
schneller 6ffnen. Bei dieser Methode miissen Sie jedoch beachten, dass FrameMaker Sie nicht Gber
fehlende Dateien oder ungeldste Querverweise informiert. Aus diesem Grund ist es ratsam, Dokumente
gelegentlich auf normale Weise zu 6ffnen.

1)  Wabhlen Sie Datei > Offnen und anschlieRend die zu 6ffnende Datei.
2)  Halten Sie die Strg-Taste gedriickt, und klicken Sie auf Offnen.

Wenn die Datei gedffnet ist, werden Grafiken in FrameMaker nach Bedarf seitenweise importiert und
angezeigt. Sie kdnnen Querverweise und Texteinschilbe mit Bearbeiten > Referenzen aktualisieren
manuell aktualisieren. Wenn der Seitenaufbau zu langsam erfolgt, 6ffnen Sie das Dokument zur
Beschleunigung des Vorgangs in der Ublichen Weise erneut.

SGML, XML, MIF und MML sind Textformate. Sie konnen also im unstrukturierten Modus als Textdateien
geodffnet werden.

Im Fall von XML- oder MIF-Dateien im strukturierten Authoring-Modus klicken Sie bei gedriickter
Strg-Taste auf die Schaltfliche Offnen, um sie als Textdateien zu 6ffnen. Sie werden im Dialogfeld Text-
datei einlesen zur Angabe der Optionen zum Einlesen von Text aufgefordert. Wenn Sie diese Dateien als
Textdatei 6ffnen, kdnnen Sie das Markup anzeigen oder bearbeiten.

<chapter draftversion = "Alpha Draft"><title><clj
</chapnumber>
<chapname>Doors</chapname ></title>
<reviewinfo></reviewinfo>
<chapintro><autohead></autohead>
<chapoverview><autohead></autohead>
<section><head>Procedures in This Chapter</hg
<para>This chapter describes maintenance procq
doors on the AstroLiner T440B and T442 light rai
safety guidelines, an overview of door componer|

Figure 2:  Markup in SGML-Dateien

Erneutes Offnen von Dateien nach Systemabsturz

Wenn ein Systemabsturz stattfindet, werden Dateien in folgenden Situationen automatisch gespeichert:
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o Wenn im Dialogfeld ,Voreinstellungen” die Option ,, Automatisch speichern” aktiviert wurde,
werden im angegebenen Zeitabstand automatisch gespeicherte Dateien (mit der Erweiterung
.auto) erstellt. Diese automatisch gespeicherte Datei wird geldscht, wenn Sie die Datei, auf die sie
sich bezieht, speichern und schlieRen.

. Wenn das System instabil wird, versucht FrameMaker, eine Wiederherstellungsdatei (mit der
Erweiterung . recover) anzulegen, die die letzten Anderungen enthilt.

Eine automatisch gespeicherte Kopie der Datei enthilt die neuesten Anderungen an der Datei.
1)  Offnen Sie die Datei, an der Sie zuletzt gearbeitet haben.
2)  Fihren Sie eine der folgenden Aktionen aus:

- Wenn eine Wiederherstellungsdatei existiert, 6ffnen Sie diese nach entsprechender
Aufforderung und priifen Sie, ob lhre letzten Anderungen noch vorhanden sind. Ist das der
Fall, speichern Sie die Wiederherstellungsdatei unter dem Namen, den das Dokument vor
dem Systemausfall trug, und lI6schen Sie die Wiederherstellungsdatei.

- Wenn keine Wiederherstellungsdatei vorhanden ist, 6ffnen Sie nach entsprechender
Aufforderung das automatisch gespeicherte Dokument und speichern Sie es unter dem
urspriinglichen Dateinamen. Die automatische Sicherungskopie enthilt alle Anderungen bis
zum Zeitpunkt der letzten automatischen Sicherung. Der Umfang der verlorenen Arbeit hangt
von dem als Speicherintervall festgelegten Zeitraum und vom Zeitpunkt des Absturzes ab.

Fehlerbehebung bei nicht verfiigbaren Schriften

Manchmal wird ein Meldungsfenster mit dem Hinweis angezeigt, dass in dem zu 6ffnenden Dokument
nicht verfligbare Schriften verwendet werden. Wenn Schriften nicht zur Verfiigung stehen, kann dies
verschiedene Griinde haben:

J Das Dokument wurde auf einem anderen System und unter Verwendung von Schriften, die auf
Ihrem System nicht installiert sind, bearbeitet.

) Eine Schrift wurde entfernt oder beschadigt.
. Der Standarddrucker fir Ihr System hat sich geandert.

Wenn die Option ,Namen fehlender Schriften speichern” im Dialogfeld ,Voreinstellungen” aktiviert
wird, bleiben die Namen nicht verfligbarer Schriften erhalten. Die Originalschriften werden bei Auswahl
dieser Option dann wieder angezeigt (auch wenn Sie ein Dokument mit Ersatzschriften 6ffnen), wenn Sie
das Dokument auf einem System 6ffnen, auf dem die fehlenden Schriften installiert sind.

Zur Fehlerbehebung bei fehlenden Schriften kénnen Sie folgendermalien vorgehen:

Uberpriifen der Schriften auf Beschiadigung

Stellen Sie fest, ob die in FrameMaker fehlenden Schriften auf Ihrem System installiert und in einer
anderen Anwendung verfiigbar sind. Wenn eine andere Anwendung auf die Schriften zugreifen
kann, sind sie ggf. beschadigt. Installieren Sie die Schriften mithilfe der Originalmedien neu.
Weitere Informationen zur Fehlerbehebung bei Problemen mit Schriften, zur Isolierung
beschadigter Schriften oder Schriften-Ordner oder zur Neuinstallation von PostScript-Schriften
finden Sie auf der Website von Adobe.
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Neuzuordnen fehlender Schriften

Wenn die fehlenden Schriften nicht installiert bzw. nicht erneut installiert werden kdnnen, haben
Sie die Moglichkeit, diese Schriften verfiigbaren Schriftarten zuzuordnen, so dass das Meldungsfen-
ster beim Offnen des Dokuments nicht wieder angezeigt wird. Dazu deaktivieren Sie vor dem
Offnen der Datei im Dialogfeld Voreinstellungen die Option Namen fehlender Schriften speichern.
Bei dieser Vorgehensweise miissen Sie jedoch beachten, dass alle Informationen zu Origi-
nalschriften verloren gehen, auf die im Dokument verwiesen wird.

Andern des Druckers

FrameMaker liest die im Druckertreiber gespeicherten Schriftinformationen. Dadurch werden die
im Drucker gespeicherten Schriften in FrameMaker verfligbar. In bestimmten Fallen kann die
Anderung des Standarddruckers die Verfiigbarkeit einer oder mehrerer Schriften in FrameMaker
beeinflussen.

Erwerben und Installieren der fehlenden Schriften

Wenn Sie z. B. dieselben Dokumente wie ein Kollege bearbeiten und dazu dieselben Schriften
verwenden moéchten, sollten Sie den Kauf und die Installation einer Kopie dieser Schriften in
Betracht ziehen.
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Dokument oder Buch speichern

Lernen Sie die verschiedenen Methoden zum Speichern eines Dokuments in FrameMaker kennen.
Verstehen von Dateinamenerweiterungen und Formaten, die in FrameMaker verwendet werden.
In diesem Thema

L Einflihrung

J Speichern von Blichern

. Speichern aller gedffneten Dokumente

. Wiederherstellen der zuletzt gespeicherten Version von Dokumenten

J Automatisches Erstellen von Sicherungskopien und Speichern

Einfihrung

Dokumente kénnen unter ihrem aktuellen Namen und Verzeichnis gespeichert werden. Sie kdnnen aber
auch eine Kopie des Dokuments unter einem anderen Namen und in einem anderen Verzeichnis
speichern. Sie kénnen Dokumente in verschiedenen Formaten speichern: Hypertext Markup Language
(HTML), Extensible Markup Language (XML), Rich Text Format (RTF) und Portable Document Format
(PDF).

Wenn ein Dokument oder ein Buch nicht gespeicherte Anderungen enthélt, wird im Seitenstatus-Bereich
der Statuszeile ein Sternchen (*) angezeigt.

Flow: & T:#5_Mumbersection I 4 M| 3qord> M| = 100% v+

Figure 1:  Ein Sternchen zeigt nicht gespeicherte Anderungen an.

Um ein Dokument zu speichern, gehen Sie wie folgt vor:
. Um Anderungen in der aktuellen Datei zu speichern, wihlen Sie Datei > Speichern.

] Um die Datei in einem anderen Ordner unter einem anderen Dateinamen zu speichern, wahlen Sie
Datei > Speichern unter.

Wenn Sie Datei > Speichern unter wahlen oder die Datei bisher noch nicht gespeichert wurde, geben Sie
den neuen Dateinamen und das neue Verzeichnis an. Wenn Sie die Datei in einem anderen Format
speichern mdchten, wahlen Sie dieses in der Dropdown-Liste aus.

Klicken Sie auf Speichern. Wenn Sie das Format Nur Text gewahlt haben, geben Sie an, wie Text und
Tabellen im Dokument umgesetzt werden sollen.

Speichern von Biichern

1)  Flhren Sie eine der folgenden Aktionen aus:

- Wihlen Sie zum Uberschreiben der aktuellen Version auf der Festplatte Datei > Buch
speichern.

- Um die Datei in einem anderen Ordner unter einem anderen Dateinamen zu speichern,
wahlen Sie Datei > Buch speichern unter.

2)  Wenn Sie den Befehl Datei > Buch speichern unter wahlen oder die Datei bisher noch nicht gespe-
ichert wurde, geben Sie den neuen Dateinamen und das neue Verzeichnis ein.
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Speichern aller ge6ffneten Dokumente

Halten Sie die Umschalttaste gedriickt, und wahlen Sie Datei > Ge6ffnete Dateien speichern.

Wiederherstellen der zuletzt gespeicherten Version von Dokumenten

Wahlen Sie Datei > Zuriick zur gespeicherten Version. Klicken Sie auf OK.

Automatisches Erstellen von Sicherungskopien und Speichern

FrameMaker kann automatisch Sicherungskopien Ihres Dokuments erzeugen und lhre Arbeit speichern.

1)  Wahlen Sie Bearbeiten > Voreinstellungen.
2)  Fihren Sie unter Allgemein in den Voreinstellungen folgende Schritte aus:

- Um bei jedem Sicherungsvorgang eine Sicherungsdatei anzulegen, wahlen Sie Automatische

Sicherungskopie anlegen. Mit dieser Option wird vor dem Speichern der aktuellen

Anderungen eine Kopie der Datei erstellt. Wenn eine Sicherungsdatei vorhanden ist, wird sie
durch die neue Sicherungsdatei Gberschrieben. Die Dateinamen der Sicherungsdateien haben

die Erweiterung .backup.

- Um eine Datei in regelmaRigen Zeitabstanden automatisch zu speichern, wahlen Sie Autom-
atisch speichern alle und geben Sie den gewiinschten Zeitraum (in Minuten) in das entspre-

chende Feld ein. Bei diesem Verfahren wird regelmaRig eine Kopie der Datei gespeichert,

ohne dass Sie Datei > Speichern wahlen miissen. Die Dateinamen automatisch gespeicherter

Dateien haben die Erweiterung . auto. Wenn Sie manuell speichern oder den Stand der

letzten Speicherung mit dem Befehl Zuriick zur gespeicherten Version wiederherstellen, wird

die automatisch gespeicherte Datei geldscht.
3) Klicken Sie auf ,,OK“.

RELATED LINKS:
Speichern als PDF

Importieren von Eigenschaften aus einer Vorlage
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Navigationsansicht

Erfahren Sie, wie Sie die Navigationsansicht verwenden, um einen schnellen Uberblick iiber Ihre Doku-
mentstruktur zu erhalten.

In diesem Thema

L Einflihrung

J Verwenden der Navigationsansicht

Einfihrung

Wenn Sie in einem langen Dokument arbeiten, kdnnen Sie das Bedienfeld ,Navigationsansicht”
verwenden, um die gesamte Struktur des Dokuments anzuzeigen. Die Navigationsansicht verwendet
einen intelligenten Algorithmus, um die Uberschriften in Inrem Dokument zu verstehen, um die Struktur
des Dokuments anzuzeigen.

Verwenden der Navigationsansicht

Um die Struktur lhres Dokuments zu tUberprifen, rufen Sie im Hauptmeni Ansicht > Fenster > Naviga-
tionsansicht die Navigationsansicht auf, oder verwenden Sie die Tastenkombination Escnv.

EDITING CONTENT
TEXT AND SPECIAL CHARACTERS

g Navigation View =
[ £O search by Headings a |
KEYWORDS: EDIT CONTENT IN FRAMEMAKER t
DESCRIPTION: LEARN HOW TO EDIT CONTENT IN FRAMEMAKER 4 Editing content
FrameMaker provides you with a yarietev-atortionsand-tooistora) 4 Text and special characters
add graphics, images, tables, and |i Expand All - Add text and special characters
equations and QR codes. Collapse All
= Copy, move, and delete text
Select Heading And Content
Delet » Drag and drop text
1 { elete
’TEXt and spec'al charac___ Importing and linking files
Equations
KEYWORDS: ADD TEXT, ADD SPECIAL CHARACTERS, DISPLAY PARAGRAPH SYMBOL
DESCRIPTION: KNOW HOW TO ADD TEXT AND SPECIAL CHARACTERS TO THE DOCUMEN Markers
As an authoring environment, FrameMaker provides you will the [t Hypertext commands
special characters) to a document. While text includes the standar Multiple Undo/Redo
numbers, you can also enter characters such as tab, bullet symbalg Search
i

Add text and special characters

Figure 1:  Fenster ,Navigationsansicht” und Kontextmen

Die folgenden Funktionen sind im Fenster ,,Navigationsansicht” verfligbar:

o Suchen Sie nach einer Uberschrift, indem Sie einige Schliisselwdrter in das Textfeld Suchen nach
Uberschrift eingeben.

o Wechseln Sie zu einer Uberschrift im Hauptinhalt, indem Sie auf den Uberschriftentext klicken.
o Wechseln Sie zum oberen Rand des Dokuments, indem Sie auf die Pfeiltaste nach oben klicken.

Der folgende Funktionsbereich ist im Kontextmeni des Fensters , Navigationsansicht” verflgbar:
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Alle einblenden: Erweitern Sie alle untergeordneten Uberschriften der aktuell ausgewihlten Uber-
schrift, und blenden Sie sie ein.

Alle ausblenden: Reduzieren Sie alle untergeordneten Uberschriften der aktuell ausgewihlten
Uberschrift, und blenden Sie sie aus.

Uberschrift und Inhalt auswihlen: Wihlen Sie die Uberschrift und den Inhalt aus, der Teil der
ausgewdhlten Uberschrift ist. Wenn die ausgewéhlte Uberschrift untergeordnete Uberschriften
hat, wird auch der gesamte Inhalt ausgewahlt.

Léschen: Léschen Sie die aktuell ausgewihlte Uberschrift und deren Inhalt.
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Formate zum Speichern von Dateien

Erfahren Sie mehr Gber die Dateiformate, die FrameMaker speichern kann, und wie Sie
FrameMaker-Dokumente zwischen Versionen austauschen kdonnen.

In diesem Thema

L Einflihrung

J FrameMaker-Dateiformate

. Dateiformate fiir eine DITA Map

. Austausch von Dokumenten mit FrameMaker 8 und héher

J Austausch von Dokumenten mit FrameMaker 7.2 oder friiher

o Andere Dateiformate (nur Text, SGML, HTML, XML, RTF)

Einfiihrung

Sie kdnnen den Befehl Datei > Speichern unter verwenden, um ein FrameMaker-Dokument in den
verschiedenen Formaten zu speichern. Sie kdnnen im FrameMaker-Dateiformat speichern, das in der
vorherigen Version von FrameMaker geoffnet werden kann, in Maker Interchange Format (MIF) fir
dltere FrameMaker-Versionen oder in Nur-Text, SGML, HTML, XML und RTF.

FrameMaker-Dateiformate

Buch 2020 (* .book)
Speichert das FrameMaker-Buch als Buch, das im aktuellen Release von FrameMaker gedffnet und
bearbeitet werden kann.

Buch 2019 (* .book)
Speichert das FrameMaker-Buch als Buch, das in FrameMaker (2019 Release) gedffnet und bearbe-
itet werden kann.

Dokument 2020 (* . £m)
Speichert das FrameMaker-Dokument als Dokument, das im aktuellen Release von FrameMaker
geodffnet und bearbeitet werden kann.

Dokument 2019 (* . £m)
Speichert das FrameMaker-Dokument als Dokument, das in FrameMaker (2019 Release) gedffnet
und bearbeitet werden kann.

MIF 2020 (* .mif)

Erstellt eine Textdatei mit FrameMaker -Anweisungen, die den gesamten Text und alle Grafiken
beschreiben. Damit das Originaldokument nicht tGberschrieben wird, muss die MIF-Datei unter
einem anderen Namen gespeichert werden. Fligen Sie dem Namen z. B. eine .mi £-Erweiterung
hinzu.

Weitere Informationen zu MIF finden Sie in der MIF-Referenz.
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Nur Ansicht 2020

Speichert FrameMaker-Dokumente oder -Biicher als schreibgeschiitztes Dokument oder Buch, das
im aktuellen Release von FrameMaker geoffnet und angezeigt werden kann.

Dateiformate fiir eine DITA Map

XML (*.xml, .ditamap)
Speichert die Map-Datei als . xm1- oder . ditamap-Datei, die Sie in jedem XML-Editor bearbeiten
kénnen.

Zusammengesetztes Dokument 2020 (* . £m)
Speichert die Map-Datei und alle darin enthaltenen Themen als einzelnes FrameMaker-Dokument.
Sie kdnnen dieses Dokument im aktuellen Release von FrameMaker 6ffnen und bearbeiten.

Buch 2020 mit fm-Komponenten (* .book)

Speichert die Map-Datei als . book-Datei und alle enthaltenen Topics als FrameMaker (. £m)-Doku-
mente. Sie konnen diese Dokumente im aktuellen Release von FrameMaker 6ffnen und bearbeiten.
Es werden auch andere Buchkomponenten wie Listen von Abbildungen, Tabellen und ein Index
generiert.

Austausch von Dokumenten mit FrameMaker 8 und héher

Um FrameMaker-Dateien mit dlteren FrameMaker-Versionen auszutauschen, speichern Sie das Buch
oder Dokument im Maker Interchange Format-Format (MIF) der aktuellen Version. Offnen Sie diese
Datei in der dlteren FrameMaker-Version, und speichern Sie sie im nativen Format dieser Version.

Weitere Informationen zu MIF finden Sie im Onlinehandbuch MIF-Referenz.

Austausch von Dokumenten mit FrameMaker 7.2 oder frither

Um FrameMaker-Dateien mit FrameMaker-Versionen vor Version 7.2 auszutauschen, speichern Sie das
Buch oder Dokument im Format MIF 7.0 (* . mi£). Offnen Sie diese Datei in FrameMaker 7.2 oder friiher,
und speichern Sie sie im nativen Format dieser Version.

Weitere Informationen zu MIF finden Sie im Onlinehandbuch MIF-Referenz.

WARNING: Das MIF 7.0-Dateiformat unterstiitzt Unicode nicht. Alle Zeichen, die in FrameMaker 7.2 oder
friher nicht unterstitzt werden, werden als Fragezeichen (,,?“) angezeigt oder gehen verloren. Doku-
mente aus FrameMaker 8 oder héher in MIF 7.0 zu speichern, wird aufgrund der fehlenden
Unicode-Unterstiitzung in FrameMaker-Versionen vor Release 7.2 nicht empfohlen.

Andere Dateiformate (nur Text, SGML, HTML, XML, RTF)

Nur Text

Erstellt eine Nur-Text-Datei ohne Grafiken oder Formatierungsinformationen. Damit das Original-
dokument nicht tiberschrieben wird, muss die Textdatei unter einem anderen Namen gespeichert
werden. Fligen Sie dem Namen z. B. die . txt-Erweiterung hinzu.
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SGML

Erzeugt eine SGML-Datei mit den Inhalten, Elementen und Attributen Ihres Dokuments.

HTML

Erzeugt ein HTML-Dokument, das im World Wide Web betrachtet werden kann. Informationen
zum Anpassen der Zuordnungen von Absatz- und Zeichenstilen zu vordefinierten HTML-Elementen
finden Sie unter HTML-Zuordnungen einrichten und anpassen.

HINWEIS: Wenn Sie ein strukturiertes FrameMaker-Dokument im HTML-Format speichern, werden alle
gleichnamigen Attribute dem gleichen Wert zugeordnet, auch wenn die Attribute fiir verschiedene
Elemente unterschiedliche Werte annehmen. Um fiir diese Attribute nach dem Export unterschiedliche
Werte zu verwenden, bearbeiten Sie die Ergebnisdatei in einem Texteditor.
XML
Erzeugt ein Dokument im XML-Format (Extensible Markup Language), das zum Datenaustausch
verwendet und im World Wide Web betrachtet werden kann.
Informationen zu XML finden Sie unter https://www.w3.org/standards/xml/.

RTF-Format von Microsoft

Erstellt Dateien im Rich Text Format 1.9 (RTF), welches von vielen Textverarbeitungsprogrammen
unterstitzt wird und von anderen Anwendungen gelesen werden kann. Die meisten Format-
ierungen bleiben erhalten, da Formate in der Regel in das entsprechende Format des Textverarbe-
itungsprogramms umgewandelt werden.

Informationen zu RTF finden Sie in der RTF-Spezifikation (Microsoft Rich Text Format).

RELATED LINKS:
Speichern von FrameMaker-Dokumenten im Format ,,Nur Text”

Speichern von FrameMaker-Standarddokumenten im XML-Format
Speichern strukturierter FrameMaker-Dokumente im SGML- oder XML-Format

HTML-Zuordnungen einrichten und anpassen
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Speichern von FrameMaker-Dokumenten im Format ,,Nur Text”

Erfahren Sie, wie Sie ein FrameMaker-Dokument als reine Textdatei speichern, die richtige Codierung
und die Einschrankungen dieses Formats auswahlen.

WIcHTIG: Es wird nur einfacher Text (in Textrahmen und Tabellen) gespeichert. Grafiken, Bildbes-
chriftungen, FuRnoten und Formatierungsinformationen werden nicht gespeichert. Formatieren Sie
gegebenenfalls Zeilenlangen und Trennungen neu, bevor Sie die Datei speichern.

Sie kénnen ein FrameMaker-Dokument als reine Textdatei speichern. Das Speichern eines Dokuments im
Format ,Nur Text” erzeugt eine Textdatei mit einer Textcodierung Ihrer Wahl.

Wenn bestimmte Zeichen in der gewahlten Textcodierung nicht verfligbar sind, werden sie in der Text-
datei ersetzt. Wenn Sie beispielsweise ein Dokument im Format ,,Nur Text“ mit ANSI- (Windows) oder
ASClI-Codierung speichern, werden Leerzeichen (einschlieflich t-, n-, m- und numerischer Leerzeichen)
in normale Leerzeichen konvertiert.

1)  Wahlen Sie Datei > Speichern unter.
2)  Geben Sie den Dateinamen und das Verzeichnis an, und wahlen Sie als Format Nur Text.
3)  Klicken Sie auf Speichern. Das Dialogfeld Sichern als Text wird angezeigt:

Save As Text X
Put a Carriage Return:

(O Atthe End of Each Line
@ Only between Paragraphs

Include Text from Table Cells:

(® Row by Row
(O Column by Column

Separate Each Table Cell With: EE
Separate Each Row/Column With: E

Encoding: UTF-8 ~

Save Cancel

Figure 1: FrameMaker-Dialogfeld ,Sichern als Text”

4)  Fuhren Sie eine der folgenden Aktionen aus:

- Soll jede Zeile als eigener Absatz interpretiert werden, wahlen Sie Am Ende jeder Zeile. Mit
dieser Option werden die urspriinglichen Zeilenumbriiche und Leerzeilen einer Datei beibe-
halten. Daher eignet sie sich fir zeilenorientierte Textdateien, z. B. fiir Dateien, die Comput-
ercode enthalten.

—  Wenn zusammenhdngende Zeilen als Absatz interpretiert werden und ein Absatzende nur
fiir eine Leerzeile eingefiigt werden soll, klicken Sie auf Nur zwischen Absdtzen. Setzen Sie
diese Option fiir absatzorientierte Dateien ein, z. B. flir Dateien, die Dokumenttext enthalten.

5)  Wenn Sie Tabellentext speichern mochten, wahlen Sie Text von Zellen iibernehmen. Gehen Sie
anschlieRend folgendermaRen vor:
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6)

- Legen Sie die Reihenfolge fest, in der die Tabellenzellen gespeichert werden sollen (Zeilen-
weise oder Spaltenweise).

- Legen Sie durch Auswahl von Elementen in den Dropdown-Listen fest, ob die Tabellenzellen
durch Tabulatoren (\t) oder Zeilenschaltungen (\ r) voneinander getrennt werden sollen.

Wenn die Textdatei auf einer Plattform mit einer anderen Textcodierung eingesetzt werden soll,
wahlen Sie die entsprechende Codierung in der Dropdown-Liste Textcodierung aus, und klicken Sie
anschliefend auf Speichern.

Sie kénnen zwischen den folgenden Codierungen wdéhlen:
- UTF-8

- ISO Latin-1 (Unix)

- ASCII

- ANSI (Windows)

- Macintosh

—  Japanisch (JIS)

- Japanisch (Shift-JIS)

- Japanisch (EUC)

- Traditionelles Chinesisch (Big5)

- Traditionelles Chinesisch (EUC-CNS)
- Vereinfachtes Chinesisch (GB)

- Vereinfachtes Chinesisch (HZ)

- Koreanisch

- UTF-16 (Big Endian)

- UTF-16 (Little Endian)

- UTF-32 (Big Endian)

- UTF-32 (Big Endian)

RELATED LINKS:

Formate zum Speichern von Dateien
Speichern von FrameMaker-Standarddokumenten im XML-Format

Speichern strukturierter FrameMaker-Dokumente im SGML- oder XML-Format
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Speichern von FrameMaker-Standarddokumenten im XML-Format

Erfahren Sie, wie Sie ein FrameMaker-Standarddokument im XML-Format speichern.
Sie kdnnen sowohl strukturierte als auch unstrukturierte Dateien in XML exportieren.

Bei strukturierten Dokumenten (FrameMaker-Dateien mit eingebetteter Struktur) wird die strukturierte
Anwendung zum Speichern im XML-Format verwendet.

Bei unstrukturierten Dokumenten (FrameMaker-Dateien ohne eingebettete Struktur) wird die Zuord-
nung verwendet, um anzugeben, welches Element fiir jeden Absatz, jedes Zeichen, jeden Querverweis
erstellt werden soll. In der FrameMaker-Quelldatei ist auf der Referenzseite ,XML" in der ,XML-Zuord-
nungstabelle“definiert.

Die Exportfunktion erstellt eine XML-Datei und ein entsprechendes Cascading Style Sheet (CSS), welches
gemeinsam mit dem Dokument verwendet werden kann.
1)  Fihren Sie eine der folgenden Aktionen aus:

- Wadhlen Sie Datei > Als XML speichern, oder driicken Sie Esc+f+w+x.

- Wahlen Sie Datei > Speichern unter, und wahlen Sie in der Dropdown-ListeDateien speichern
unter ,XML" aus.

Fligen Sie dem Dateinamen die Erweiterung . xm1 hinzu.

2)  Geben Sie einen Speicherort fiir die Datei an.

3) Klicken Sie auf Speichern.

RELATED LINKS:
Formate zum Speichern von Dateien
Speichern von FrameMaker-Dokumenten im Format ,,Nur Text”
Formate zum Speichern von Dateien

Speichern strukturierter FrameMaker-Dokumente im SGML- oder XML-Format
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Speichern strukturierter FrameMaker-Dokumente im SGML- oder XML-Format

Erfahren Sie, wie Sie ein strukturiertes Dokument im SGML- oder XML-Format in FrameMaker speichern.

Sie kénnen alle strukturierten FrameMaker-Dokumente als SGML oder XML speichern. Der Inhalt, die
Elemente und die Attribute des Dokuments bleiben erhalten. Formatierungen gehen jedoch verloren. Sie
kdnnen in einem anderen strukturierten Dokumenttyp als dem urspriinglichen (beispielsweise SGML
oder XML) speichern. Moglicherweise treten jedoch auf Grund von Unterschieden in den DTDs Fehler
auf.

Wenn Sie Unicode-Inhalt als XML-Datei speichern, gibt FrameMaker die Codierung automatisch an.
FrameMaker verwendet standardmalig das UTF-8-Codierungsformat.

Bevor Sie ein Dokument im SGML- oder XML-Format speichern, sollten Sie es priifen und alle Fehler in
den Elementen und Attributen korrigieren (siehe ,Uberpriifen von Dokumenten®). Andernfalls kénnten
die Markierungen unglltig werden.

Achten Sie beim Speichern eines XML-Dokuments darauf, dass gtiltige XML-Elementnamen mit einem
Buchstaben beginnen und nur alphanumerische Zeichen, Punkte oder Bindestriche enthalten. Leerze-
ichen, Unterstriche oder andere Zeichen in XML-Elementnamen sind ungliltig und werden entweder zu
einem Bindestrich (-) konvertiert oder erzeugen einen Fehler.

Kopfzeilen, Tabellen und Referenzseiten werden nicht in XML exportiert, und fir die Namen der Standar-
delemente werden einfach die Stilnamen verwendet.

Die Standard-Codierungseinstellungen zum Exportieren strukturierter Dokumente sind 1ISO-8859-1 fiir
SGML und UTF-8 fir XML. Wenn das strukturierte Dokument eine importierte SGML- oder XML-Datei ist,
verwendet FrameMaker die Codierungseinstellungen der Originaldatei anstatt der Standardeinstel-
lungen.

1)  Wahlen Sie Datei > Speichern unter.

2)  Geben Sie den Dateinamen und den Speicherort an. Sie konnen dem Dateinamen die entsprech-
ende Erweiterung (wie . sgm oder . xm1) hinzufiigen.

3)  Wabhlen Sie SGML oder XML aus der Dropdown-Liste aus. Klicken Sie auf Speichern. Wenn dem
Dokument eine Anwendung zugeordnet ist, wird es gespeichert.

4)  Wenn das Dialogfeld Strukturierte Anwendung zuweisen angezeigt wird, wahlen Sie einen Anwend-
ungsnamen aus der Dropdown-Liste Strukturierte Anwendung zuweisen aus. Klicken Sie auf Fort-
fahren. Fiihren Sie anschlieBend eine der folgenden Aktionen aus:

- Wahlen Sie den Namen einer Anwendung, um dem Dokument eine Anwendung zuzuordnen.

- Um die Standardzuweisung und keine Lese-/Schreibregeln auszuwahlen, wihlen Sie <Keine
Anwendung>.

Wenn FrameMaker beim Speichern eines Dokuments Fehler in der Struktur findet, listet das Programm
die entsprechenden Fehlermeldungen in einer schreibgeschiitzten Fehlerprotokolldatei auf. Wenn sich
die Meldung auf einen Fehler in dem FrameMaker-Dokument bezieht, wird sie mit dem Dokument
verknlipft. Bei den meisten Fehlern kénnen Sie auf die Meldung klicken, um zum Ort des Fehlers zu
gelangen.

Importieren Sie Elementdefinitionen, wenn Sie das strukturierte Dokument 6ffnen. Vermutlich miissen
Sie noch einige Korrekturen an ihren Strukturen vornehmen.
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RELATED LINKS:
Importieren von Elementdefinitionen in strukturierte Biicher
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Hinzufiigen von Metadaten zu einem Dokument

Erfahren Sie, wie FrameMaker die integrierte Extensible Metadata Platform (XMP) unterstitzt
FrameMaker bietet integrierte Unterstltzung flr Extensible Metadata Platform (XMP).

Metadaten oder Datei-Informationen sind ausfiihrliche Information, die von einem Computer gesucht
und verarbeitet werden konnen. Verwenden Sie diese, um Informationen zu den Inhalten eines Doku-
ments zu erstellen und Informationen zu einem Dokument zu bewahren, das in einer anderen
Adobe-Anwendung gedffnet wird. Wenn Sie die Datei in ein PDF-Format exportieren, werden viele dieser
Metadaten in Acrobat angezeigt.

Metadaten-Tags begleiten das Dokument und beschreiben dessen Inhalt. Durch Einbetten in Ihre Doku-
mente, ist es einfacher, die Dokumente zu verfolgen, zu verwalten und abzurufen.

HiNweEls: Die Metadaten einer Buchdatei kbnnen manchmal die Metadaten einer Dokumentdatei Gber-
schreiben. Wenn das Dokument Bestandteil einer Buchdatei ist, 6ffnen Sie die Buchdatei und wahlen Sie
das Dokument vor dem Hinzufligen der Metadaten aus.

1) Bringen Sie das entsprechende Dokument- oder Buchfenster als aktives Fenster in den Vorder-
grund. Wenn ein Buchfenster aktiv ist, wahlen Sie die gewlinschten Dokumente aus.

2)  Waihlen Sie Datei > Datei-Informationen.
3) Geben Sie in das Feld neben einer oder allen Kategorien die gewiinschten Informationen ein.

4)  Wahlen Sie fur Markiert fiir urheberrechtlich geschiitzte Dokumente Ja und fiir Dokumente, die
ausdricklich der 6ffentlichen Doméane angehéren, Nein aus. Wenn Sie sich nicht sicher sind,
wahlen Sie Unbekannt.

5) Klicken Sie auf Festlegen.
Die Informationen des Dialogfelds Datei-Informationen werden in den Metadaten der PDF-Ausgabe

angezeigt, wenn Sie die Veroffentlichung als PDF vornehmen. Geben Sie beispielsweise die Informa-
tionen in die jeweiligen Felder ein, und sie werden in den Metadaten der PDF-Ausgabe angezeigt.

Table 1: Den Metadaten zugeordnete Datei-Informationen

Datei-Informationen in FrameMaker Zugeordnete Titel in den PDF-Metadaten
Authoring Authoring
Titel Dokumenttitel
Thema Beschreibung
Schlusselworter Schlusselworter
Copyright Copyright-Vermerk
Web-Anweisung Copyright-Informationen-URL
Markiert Copyright-Status
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Zum Anzeigen der Metadaten einer PDF-Datei 6ffnen Sie die PDF-Datei in Adobe Acrobat, und gehen Sie
wie folgt vor:

1)  Waihlen Sie Dateieigenschaften.
2)  Zeigen Sie auf der Registerkarte Beschreibung eine Zusammenfassung der Metadaten an.
3)  Zum Abrufen der vollstandigen Metadaten klicken Sie auf Zusatzliche Metadaten.
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FrameMaker-Dateierweiterungen

Lernen Sie die FrameMaker-Dateierweiterungen . fm, .mif, .book, .xml, .dita und .ditamap.

Wenn Sie eine Datei zum ersten Mal in Windows speichern, fligt FrameMaker automatisch die folgenden
Erweiterungen hinzu:

. . fm flir FrameMaker-Dokumente

. .mif fur FrameMaker MIF-Dokumente (Maker Interchange Format)
. .book fiir FrameMaker-Buchdokumente

o .xml/.dita fur XML-Dokumente

] .ditamap fir DITA-Karten- und Bookmap-Dateien

Mit diesen Dateinamenerweiterungen werden die Dateien vom Betriebssystem Windows als
FrameMaker-Dateien erkannt.

Sollen diese Erweiterungen nicht an die gewahlten Dateinamen angefligt werden, setzen Sie die Datein-
amen in doppelte Anfliihrungszeichen. Windows erkennt eine Datei ohne diese Dateinamenerweiter-
ungen nicht als FrameMaker-Datei, aber Sie kbnnen die Datei immer noch in FrameMaker 6ffnen.

Wenn Sie eine Erweiterung zuweisen, die durch eine andere Anwendung registriert ist, wie etwa . doc
oder . docx, wird die Erweiterung nicht durch die FrameMaker-Erweiterung ersetzt und Sie konnen die
Datei nach wie vor in FrameMaker 6ffnen.

133



DOKUMENTRICHTUNG

Dokumentrichtung

Machen Sie sich mit den Funktionen vertraut, mit denen FrameMaker lhnen das Erstellen von Doku-
menten sowohl in von links nach rechts (Left-To-Right, LTR) als auch in von rechts nach links geschrie-
benen Sprachen (Right-To-Left, RTL) wie Arabisch, Hebraisch und Farsi ermoglicht.

In diesem Thema

J Andern der Richtung des aktuellen Dokuments
J Vererbungsdesign

] Position des Caret und Bewegung

Einfihrung

Mit FrameMaker ist es moglich, Dokumente sowohl in von links nach rechts (Left-To-Right, LTR) als auch
in von rechts nach links (Right-To-Left, RT) geschriebenen Sprachen wie Arabisch, Hebraisch und Farsi zu
erstellen. Sie konnen auch multidirektionale Dokumente erstellen. Das bedeutet: Ein Dokument, das Sie
in einer bestimmten Richtung schreiben, kann Teile enthalten, die in die andere Richtung geschrieben
sind. Sie kdnnen z. B. ein Dokument in einem LTR-Skript auf Deutsch schreiben, das Absatze und Tabellen
enthalt, die in RTL-Skripten wie Arabisch, Hebraisch und Farsi erstellt wurden. Sie kdnnen auch ein Doku-
ment mit mehreren Textfllissen erstellen, das einen Textfluss (Textrahmen) in einer LTR-Sprache und
einen anderen Textfluss in einer RTL-Sprache enthalt.

‘Thiz'is a multi-direction FrameNaker document that includes a parag raph avthored in Arabicd
é Topal Sl R
:And a table authored in Hebrew :
EmR0A 51009 PRI
SRR SR
g iR

Figure 1: Dokument mit Text in LTR-Skripten (Englisch) und RTL (Arabisch, Hebraisch und Farsi)

Sie kénnen in einem Dokument nicht nur die Textrichtung, sondern auch die Ausrichtung der Bilder in
einem Dokument dndern, basierend auf der Dokumentrichtung (siehe Andern der Richtung eines Objekte
enthaltenden Dokuments). Sie konnen den Bildern in Ihren Dokumenten Textzeilen mit verschiedenen
Schreibrichtungen hinzufligen Hinzufligen einer Textzeile zu einer Grafik).

Es ist moglich, ein Mini-Inhaltsverzeichnis in einem FrameMaker-Dokument mit LTR- oder RTL-Schrei-
brichtung zu definieren. Verwenden Sie Richtungspfeile in lhrem Dokument (Einfiigen > Richtung-
smarken), um Marken des Typs LRT RTL-Einbettung, Marke oder der Aufhebung zu setzen.

Sie kdnnen solche Texte auch kopieren und in FrameMaker-Dokumente einfligen oder umgekehrt (siehe
Importieren von Microsoft Word-Dateien).
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DOKUMENTRICHTUNG

HINWEIS: Wenn Sie Text mit einer bestimmten Richtung in ein FrameMaker-Dokument importieren oder
kopieren, missen Sie sicherstellen, dass die Textrichtung der Zielposition (Dokument, Tabelle oder
Absatz) auf dieselbe Richtung eingestellt ist.

In FrameMaker gibt es eine standardmaRige Unterstitzung zur Dokumentenrichtung sowohl fiir unstruk-
turierte Dokumente als auch fiir DITA-Themen. Jedoch muss der Anwendungsentwickler fur strukturierte
Dokumente, die auf anderen strukturierten Anwendungen basieren, die Eigenschaft dir im EDD
definieren. Weitere Informationen finden Sie im Handbuch Referenz fir Entwickler fur , Strukturierte
Anwendung”.

Andern der Richtung des aktuellen Dokuments

Gehen Sie wie folgt vor, um die Richtung des aktuellen Dokuments zu andern:

1)  Wahlen Sie Format > Dokument > Richtung > Links nach rechts, um die Dokumentrichtung auf von
links nach rechts zu andern.

2)  Waihlen Sie Format > Dokument > Richtung > Rechts nach links, um die Dokumentrichtung in von
rechts nach links zu dandern.

Die Position der Einfligemarke dandert sich basierend auf der Richtung des Dokuments.

Vererbungsdesign

Die Unterstltzung zur Erstellung der Richtung in FrameMaker basiert auf einem Vererbungsdesign. Stan-
dardmaRig erben die Objekte in einem Dokument die Richtung des Dokuments. Beispielsweise ist der
Richtung der Absdtze oder Tabellen, die in ein RTL-Dokument eingefligt werden, ebenfalls RTL.
FrameMaker verwendet dieses Vererbungsdesign, damit Sie multidirektionale Dokumente erstellen
kdnnen.

Position des Caret und Bewegung

StandardmaRig verschiebt sich der Cursor in einem RTL-Dokument beim Schreiben von rechts nach links.
FrameMaker verfiigt jetzt Gber ein System mit einem starken (primaren) und einem schwachen
(sekundéren) Caret. Das starke Caret zeigt an, wo ein eingefligtes Zeichen angezeigt wird, wenn die Rich-
tung des Zeichens dieselbe ist wie die Basisrichtung des Texts. Das schwache Caret zeigt an, wo ein einge-
fligtes Zeichen angezeigt wird, wenn die Richtung des Zeichens die entgegengesetzte Richtung zur
Basisrichtung hat.

So andern Sie das Bewegungsverhalten des Caret:

1)  Wahlen Sie Bearbeiten > Voreinstellungen.
2)  Wahlen Sie in der Gruppe Caretbewegung die Option Logisch aus, um sicherzustellen, dass die
Hauptverschiebung mit der logischen Reihenfolge der eingefligten Zeichen lbereinstimmt.

Wiihlen Sie Visuell, um sicherzustellen, dass die Cursorbewegung mit der Richtung der Tasten
libereinstimmt. Beispielsweise verschiebt die Nach-Links-Taste den Cursor nach links.

RELATED LINKS:
Global > Allgemein
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DOKUMENTRICHTUNG

Rechts-nach-links-Vorlage

Fliefsrichtung festlegen

Andern der Textrichtung in strukturierten Dokumenten
Andern der Textrichtung in einer Tabelle

Absatzgestaltung

Andern der Richtung eines Objekte enthaltenden Dokuments
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UNTERSTUTZUNG FUR ASIATISCHE SPRACHEN

Unterstitzung flir asiatische Sprachen

FrameMaker bietet erweiterte Unterstlitzung fiir die Bearbeitung und Veroéffentlichung in asiatischen
Sprachen. Das Layout-Modul kann auf Absatzebene angegeben werden, indem der Composer fiir asiat-
ische Schrift angegeben wird.

Wenn Sie in der Absatzgestaltung eine Schriftart auswahlen, die Doppel-Byte-Codierung verwendet oder
eine CJK-Schrift (flir Chinesisch, Japanisch oder Koreanisch) ist, miissen Sie in der Absatzgestaltung die
Option Composer fiir asiatische Schrift verwenden aktivieren.

Beim Offnen eines dlteren Dokuments wird diese Eigenschaft fiir alle Absitze aktiviert, die eine
Doppel-Byte-Schrift oder Rubi-Text enthalten, sodass fiir diese Absatze das Layout-Modul fur asiatische
Schriften verwendet wird.

Da die zwei Layout-Engines unterschiedliche Funktionen haben, kénnen Situationen entstehen, in denen
keine der beiden Engines den Text richtig verarbeiten kann. Wenn beispielsweise ein Absatz Rubi und
arabischen Text enthalt, kann keine der beiden Engines den Text richtig bearbeiten.

Sie kdnnen auch festlegen, dass diese Warnung nicht angezeigt werden soll und FrameMaker anweisen,
automatisch zur Unterstiitzung fir asiatische Sprachen zu wechseln.

1)  Waihlen Sie Bearbeiten > Voreinstellungen, um das Dialogfeld Voreinstellungen zu 6ffnen.

2) Rufen Sie die Registerkarte Global > Warnmeldungen auf.

3)  Aktivieren Sie das KontrollkdstchenAutomatisch zu Composer fiir asiatische Schrift wechseln.
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SEITENLAYOUT UND VORLAGEN

Seitenlayout und Vorlagen

Eine FrameMaker-Vorlage besteht aus mehreren Komponenten. Zu diesen Komponenten zdhlen Absatz-
stile, Zeichenstile, Vorgabeseitenlayouts, Referenzseiten und Querverweisformate.

Fiir sowohl unstrukturierte als auch strukturierte Vorlagen ist vor dem Erstellen der Vorlage eine sorgfal-
tige Planung und vorausgehende Gestaltung erforderlich.
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FORMATE

Formate

Erfahren Sie mehr Gber die Absatzformatierung in FrameMaker und erstellen Sie Absatzstile.
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Absatzstile

Erfahren Sie, was Absatzstile sind und wie Sie Absatzstile in Adobe FrameMaker erstellen.

In diesem Thema

] Einfiihrung

. Absatzgestaltung

. Absatzkatalog

. Erstellen eines neuen Absatzstils

] Aktualisieren eines vorhandenen Absatzstils
] Aktualisieren eines vorhandenen Absatzstils
] Hinzufiigen von Grafiken zu Absatzstilen

Einfihrung

Absatzstile in Adobe FrameMaker enthalten Einstellungen zur Textdarstellung und das Format wird auf
den gesamten Absatz angewendet.

Absatzstile sind die Grundlage der Dokumentformatierung in unstrukturierten FrameMaker-Doku-
menten, sie kdnnen jedoch auch die Grundlage der Dokumentformatierung in strukturierten
FrameMaker-Dokumenten sein.

Absatzgestaltung

Mithilfe der Absatzgestaltung werden Absatzstile erstellt und die Absatzformatierung verwaltet.

Wahlen Sie Format > Absdtze > Absatzgestaltung... oder Ansicht > Fenster > Absatzgestaltung..., oder
driicken Sie Strg+m, um die Absatzgestaltung zu 6ffnen.

Paragraph Designer

Style: ‘BB_BodyBegin_new o

| Basic Font Pagination Numbering

Advanced Asian Table Cell Direction
Indent
First: Left: Right:
‘o.a" ‘ |o.0" ‘ ‘o.a" ‘
Spacing
Above Paragraph: Below Paragraph:
lsopt | [sopt ~|
Others
Alignment: [] Tab Stops:
Justified VA New Tab Stop
Line Space:

16.0 pt ~ | [] Eixed

Next Paragraph Tag:
‘BC?BodyConlent ~ ‘ Edit...

ﬁ - c Rename Create Style Apply
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Figure 1:  Absatzgestaltung

Grundeinstellungen

Absatzeigenschaften wie Einzug, Abstand, Ausrichtung, Tabulatorstopps und Zeilenabstand und
nachster zu verwendender Absatzstil.

Schrift
Schrifteigenschaften wie Schriftfamilie, GrofRe, Winkel, Schriftstarke, Hintergrundfarbe und
Sprache. In der Dropdown-Liste ,Sprache” konnen Sie LTR-Sprachen wie Englisch, Deutsch oder
Thai und RTL-Sprachen wie Arabisch, Hebraisch und Farsi wahlen.

Seitenumbruch
Seitenumbrucheinstellungen wie ,,Umbruch mit“ und Formatierungseigenschaften wie ,,In Spalte”,
,Uber alle Spalten”.

Nummerierung

Verwenden Sie die verfligbaren Bausteine, um ein Nummerierungsformat zu definieren.

Erweitert
Eigenschaften wie automatische Silbentrennung und Wortabstande.

Asiatisch

Wenden Sie asiatische Spracheinstellungen wie asiatischen Zeichenabstand an. Beinhaltet das
Kontrollkdstchen Composer fiir asiatische Schrift verwenden, um die FrameMaker-Layout-Engine
(siehe Unterstiitzung fiir asiatische Sprachen) auszuwahlen.

Tabellenzelle

Auf eine Tabellenzelle angewendete Absatzeigenschaften.

Richtung

Legen Sie die Absatzrichtung auf ,,Ubernehmen” (Standard) fest, von links nach rechts und von
rechts nach links.

Absatzkatalog

Im Absatzformatkatalog werden alle Absatzstile aufgelistet, die fiir ein Dokument verfiigbar sind.

Wahlen Sie Format > Absatze > Absatzformatkatalog oder Ansicht > Fenster > Absatzformatkatalog, um
den Absatzformatkatalog zu 6ffnen.

Um einen Absatzstil anzuwenden, wahlen Sie den Text, und wahlen Sie den Stil im Absatzformatkatalog.

Sie kdnnen Teile eines Stilnamens in das Suchfeld eingeben, um die Liste der Stile auf die Stile zu reduz-
ieren, deren Namen enthalten.
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Figure 2:  Absatzkatalog

Erstellen eines neuen Absatzstils

So erstellen Sie einen neuen Absatzstil:
1)  Wahlen Sie Format > Absdtze > Absatzgestaltung... oder Ansicht > Fenster > Absatzgestaltung...,

um die Absatzgestaltung zu

offnen.

2)  Klicken Sie in einen Absatz, der ahnlich formatiert ist wie der, den Sie erstellen mdchten. Achten Sie

darauf, dass Sie nicht mehrere Absatze auswahlen.
3)  Offnen Sie die Absatzgestaltung, und geben Sie in das Textfeld Stil einen Namen fiir das neue

Format ein.
4)  Klicken Sie auf Stil erstellen.

Der neue Absatzstil wird erstellt, und der Stil wird dem Absatzformatkatalog des Dokuments hinzuge-

fagt.

Hinwels: Die Schaltflache Stil aktualisieren dndert sich zu Stil erstellen. Alle neuen Absatzstile werden

automatisch im ,, Absatzkatalog.

Aktualisieren eines vorhandenen

Absatzstils

So aktualisieren Sie einen vorhandenen Absatzstil:
1)  Wahlen Sie Format > Absatze > Absatzgestaltung... oder Ansicht > Fenster > Absatzgestaltung...,

um die Absatzgestaltung zu

2)  Klicken Sie in einen Absatz mit dem Stil, den Sie aktualisieren mochten.
3)  Andern Sie in der Absatzgestaltung die gewiinschten Eigenschaften.

offnen.

4)  Klicken Sie auf Stil aktualisieren.
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Definieren des Stils fiir den folgenden Absatz

In gut durchdachten Vorlagen werden Stile oft so verkniipft, dass ein bestimmter Stil in FrameMaker
automatisch fir den nachfolgenden Absatz verwendet wird.

So definieren Sie den Stil fir den folgenden Absatz:

1) Klicken Sie in den Absatz.

2)  Zeigen Sie die Basis-Eigenschaften der Absatzgestaltung an, und wahlen Sie einen Stil in der Drop-
down-Liste Nachster Absatzstil. Dieser Stil wird in FrameMaker auf den neuen Absatz angewendet,
wenn Sie die Eingabetaste driicken, um einen Absatz zu erstellen.

3) Klicken Sie auf Anwenden.

Hinzufiigen von Grafiken zu Absatzstilen

Ein Absatzstil kann eine Linie oder eine andere Grafik enthalten, die ober- bzw. unterhalb des Absatzes
angezeigt wird. Beispielsweise kann unter allen Uberschriften der obersten Ebene eine lange diinne Linie
angezeigt werden.

So fligen Sie Grafiken einem Absatzstil hinzu:

1)  Zeichnen oder importieren Sie die Grafik auf der Referenzseite in einem Referenzrahmen oder
verwenden Sie eine bereits vorhandene Grafik.

2)  Klicken Sie in den Absatz, den Sie andern mochten. Um eine Grafik tiber oder unter mehreren
benachbarten Absatzen zu platzieren, wahlen Sie die Absatze aus.

3) Zeigen Sie die Eigenschaften vom Typ Erweitert der Absatzgestaltung an, und wahlen Sie in der
Dropdown-Liste Rahmen iiber oder Rahmen unter den Namen eines Referenzrahmens. In den
Dropdown-Listen werden alle Referenzrahmen angezeigt.

4)  Klicken Sie auf Anwenden.
Tipp: Da mit den Einstellungen Rahmen liber und Rahmen unter keine Grafik rechts oder links neben

einem Absatz platziert werden kann, kdnnen Sie mit diesen Einstellungen kein Rechteck um den Text
zeichnen. Zu diesem Zweck kdnnen Sie eine einzellige Tabelle mit Umrandung verwenden.
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Zeichenstile

Erfahren Sie, was Zeichenstile sind und wie Sie in Adobe FrameMaker einen Zeichenstil erstellen.
In diesem Thema

. Einfiihrung

. Zeichengestaltung

. Zeichenformatkatalog

. Erstellen von Zeichenstilen

Einfiihrung

Mit Zeichenstilen konnen Sie Zeichen oder Worter in einem Absatz formatieren.

Durch Anwenden der Zeichenstile konnen Sie Text schnell formatieren, ohne die Eigenschaften des gesa-
mten Absatzes zu liberschreiben.

Durch das Erstellen von Zeichenstilen werden Formate einheitlich gestaltet und Formatanderungen
global angewendet.

Zeichenstile dienen auch als Bausteine fiir andere FrameMaker-Funktionen, wie beispielsweise Querver-
weisformate oder Variablen.

Zeichengestaltung

Mithilfe der Zeichengestaltung kdnnen Sie Zeichenstile erstellen und verwalten. Alle Zeichenstile sind im
Zeichenformatkatalog aufgelistet.

Character Designer

Style: ‘DB?DiangBoxComponenL v ‘
Family: Size:
‘Mvriad Pro v ‘ v
Color: Background:

M CorporateColor_Secondar Asls ~
Weight: Angle: Variation:

Regular v ltalic ~ | |Asls >
[m] Underline v [m]Qverline [m] Strikethrough
Letter Spacing: Stretch: Language:

|| | Asks v

[m] Superscript ~ | [m] Small Caps v
[m] Pair Kern [m] Change Bar [®] Tsume

-ﬁ- v c Rename Create Style Apply

Figure 1:  Zeichengestaltung

Mithilfe der Zeichengestaltung konnen Sie einen neuen Zeichenstil erstellen oder einen vorhandenen
Zeichenstil aktualisieren. Eine Vielzahl von Zeichenformatierungsoptionen ist zum Entwerfen von
Zeichenstilen gemaR Ihren Anforderungen verfligbar.
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Zeichenformatkatalog

Im Zeichenformatkatalog sind alle fiir ein Dokument verfiigbaren Zeichenstile aufgelistet. Um einen
Zeichenstil anzuwenden, wahlen Sie den Text, und wahlen Sie den Stil im Zeichenformatkatalog.

Character Catalog

< 1

[ oemitirom

DE_DialoaBexComponent
" DT_DialogTitle
 EH_EmphasisHeawy
+ El_Emphasistalic
o LT_Link Text
W MO _MenuCption
PMN_PageMNumber
W SN_StepMumber
i WD_Wingdings

Figure 2: Zeichenformatkatalog

Erstellen von Zeichenstilen

1) Klicken Sie in einen Textbereich, der dhnlich formatiert ist wie der, den Sie erstellen mochten.
Achten Sie darauf, dass Sie nicht mehrere Absatze auswahlen.

2)  Offnen Sie die Zeichengestaltung, und geben Sie im Textfeld Stil einen Namen fiir den neuen Stil
ein.
HINwEIs: Die Schaltflache Stil aktualisieren dndert sich zu Stil erstellen. Alle neuen Zeichenstile
werden automatisch im ,, Zeichenformatkatalog.

3) Andern Sie die Eigenschaften, die Sie in den neuen Zeichenstil aufnehmen mdochten.

4)  Klicken Sie auf Stil erstellen.
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Verwalten von Stilen

Erfahren Sie, wie Adobe FrameMaker Funktionen zum Verwalten verschiedener Absatz-, Zeichen- und
Tabellenstile bereitstellt.

In diesem Thema

J Anwenden von Stilen

L Aktualisieren von Stilen

. Aktualisieren eines Absatzstils

. Aktualisieren eines Zeichenstils

J Aktualisieren bestimmter Stileigenschaften oder einzelner Eigenschaftengruppen
. Neuformatieren aller Abséitze mit einem neuen Stil

o Léschen eines Absatzstils aus dem Dokumentstilkatalog

J Léschen eines Zeichenstils aus dem Dokumentstilkatalog

J Umbenennen eines Stils

. Tipps fiir das Erstellen neuer Stile

Anwenden von Stilen

Absatzstile gelten auf Absatzebene, Zeichenstile auf Zeichen- bzw. Wortebene und Tabellenstile fir
ganze Tabellen.

o Absatz- und Tabellenstile: Setzen Sie den Cursor in den Absatz bzw. die Tabelle und wahlen Sie
einen Stil im Katalog aus.

] Zeichenstile: Wahlen Sie den Text aus und klicken Sie im Katalog auf einen Stil.

Aktualisieren von Stilen

Sie kénnen die Stileigenschaften dndern und anschlieRend die gespeicherten Stile und somit den gesa-
mten Text im Dokument, dem sie zugewiesen sind, neu definieren oder aktualisieren.

Beim Aktualisieren eines Stils kdnnen Sie alle Einstellungen oder nur eine bestimmte Einstellungsgruppe

andern. Sie konnen beispielsweise die Standardschriftfamilie aller Stile in einem Dokument dndern, ohne

andere Einstellungen zu andern.

. Um einen Absatzstil oder alle Absatzstile im Dokument mit einer Einstellungsgruppe eines Absatzes
zu aktualisieren, klicken Sie in diesen Absatz oder wahlen Sie mehrere aufeinander folgende
Absdtze aus.

. Um mehrere, jedoch nicht alle Absatzstile zu aktualisieren, wahlen Sie aufeinander folgende
Absatze, die die zu aktualisierenden Stile enthalten.

AuBBerdem kénnen Sie Absatz- oder Zeichenschriftdefinitionen Giber den Befehl Datei > Formate > impor-
tieren importieren.
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Aktualisieren eines Absatzstils

So erstellen Sie einen Absatzstil in Adobe FrameMaker:

1)
2)

3)

Wahlen Sie Format > Absdtze > Absatzgestaltung, um die Absatzgestaltung zu 6ffnen.

Um die Eigenschaften des Stils (mit irregularen Formaten) anzuzeigen, markieren Sie den zu analy-
sierenden Text.

Um die Eigenschaften des Stils wie fiir den Stil definiert anzuzeigen, wéhlen Sie den Stil erneut in der
Dropdownliste Stil aus.

Andern Sie gegebenenfalls Eigenschaften und klicken Sie anschlieRend auf Stil aktualisieren.
FrameMaker fragt Sie, ob Sie irreguldare Formate entfernen mochten.

Tiep: Wenn Sie Eigenschaften im Gestaltungsfenster andern und sich dann gegen die Aktualisierung des
Stils entscheiden, kdnnen Sie den Vorgang abbrechen und die Einstellungen wieder auf die urspringli-
chen Werte zurlicksetzen, indem Sie in den Text klicken.

Aktualisieren eines Zeichenstils

So aktualisieren Sie einen Zeichenstil in Adobe FrameMaker:

1)
2)

3)

Wahlen Sie Format > Absatze > Absatzgestaltung, um die Absatzgestaltung zu 6ffnen.

Um die Eigenschaften des Stils (mit irregularen Formaten) anzuzeigen, markieren Sie den zu analy-
sierenden Text.

Um die Eigenschaften des Stils wie flir den Stil definiert anzuzeigen, wéhlen Sie den Stil erneut in der
Dropdownliste Stil aus.

Andern Sie gegebenenfalls Eigenschaften und klicken Sie anschlieRend auf Stil aktualisieren.
FrameMaker fragt Sie, ob Sie irregulare Formate entfernen mdchten.

Tiep: Wenn Sie Eigenschaften im Gestaltungsfenster andern und sich dann gegen die Aktualisierung des
Stils entscheiden, kdnnen Sie den Vorgang abbrechen und die Einstellungen wieder auf die urspriingli-
chen Werte zurilicksetzen, indem Sie in den Text klicken.

Aktualisieren bestimmter Stileigenschaften oder einzelner Eigenschaftengruppen

So aktualisieren Sie eine bestimmte Eigenschaft eines Absatz- oder Zeichenstils in Adobe FrameMaker:

1)

2)

3)
4)

Wenn Sie eine bestimmte Eigenschaft eines Absatzstils aktualisieren mochten, wahlen Sie Format
> Absatze > Absatzgestaltung, um die Absatzgestaltung zu 6ffnen.

Wenn Sie eine bestimmte Eigenschaft eines Zeichenstils aktualisieren méchten, wdhlen Sie Format
> Zeichen > Zeichengestaltung, um die Zeichengestaltung zu éffnen.

Wenn Sie bestimmte Stileigenschaften aktualisieren, andern Sie nur die Eigenschaft, die Sie aktual-
isieren mochten.

Wenn Sie eine einzelne Eigenschaftengruppe eines Stils aktualisieren, wéihlen Sie Alle Einstellungen
auf '‘Beibehalten’ in der Dropdown-Liste Befehle des Gestaltungsdialogfelds, um alle Format-
ierungsdefinitionen auf Beibehalten festzulegen. Andern Sie die Einstellungen wie gewiinscht.
Wahlen Sie Optionen fiir globale Aktualisierung aus der Dropdown-Liste Befehle.

Wenn Sie einen Absatzstil aktualisieren, wahlen Sie aus, ob Sie die Stildefinition mit allen Eigen-
schaften aller Eigenschaftengruppen (Alle Eigenschaften) oder nur mit den in der aktuellen Eigen-
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schaftengruppe vorgenommenen Anderungen (<Name der Eigenschaftengruppen>
(Einstellungen) aktualisieren méchten.

Die Optionen fiir globale Aktualisierung der Zeichengestaltung beinhalten diese Option nicht, da
die Zeichengestaltung nur eine Eigenschaftengruppe hat.

5)  Im Abschnitt Absatzstile aktualisieren / Zeichenstile aktualisieren:

- Um den ausgewahlten Stil auf alle Absatze/Zeichen im aktuellen Dokument anzuwenden,
wahlen Sie Alle Absatze und Katalogeintrage oder Alle Zeichen und Katalogeintrage aus.

- Wahlen Sie Alle libereinstimmenden Tags in der Auswahl aus, um die gedanderte Stildefini-
tion auf alle Absatze oder Zeichen im aktuellen Dokument anzuwenden, auf die dieselben
Stile wie auf die ausgewahlten Absatze/Zeichen angewendet werden.

- Wahlen Sie Alle des Typs aus, um den aktuellen Stil aller Absatze/Zeichen im aktuellen Doku-
ment in einen neuen Stil zu andern. Weitere Einzelheiten finden Sie im Abschnitt Neuforma-
tieren aller Absditze mit einem neuen Stil.

6) Klicken Sie im Gestaltungsdialogfeld auf , Stil aktualisieren”,

Neuformatieren aller Absatze mit einem neuen Stil

In Adobe FrameMaker konnen Sie die Absatzstile aller Absatze im aktuellen Dokument in einen neuen
Stil andern. Sie kdnnen z. B. alle mit dem Stil ,Normal” formatierten Absatze im aktuellen Dokument in
,Haupttext” dndern.

So wenden Sie einen anderen Stil auf alle Absatze im aktuellen Dokument an:

1)  Waihlen Sie einen Absatz mit dem neuen Stil, den Sie auf alle Absdtze mit dem aktuellen Stil
anwenden mochten.

2)  Wabhlen Sie Format > Absdtze > Absatzgestaltung, um die Absatzgestaltung zu 6ffnen.

3)  Wabhlen Sie Optionen fiir globale Aktualisierung aus der Dropdown-Liste Befehle in der Absatzge-
staltung.

4)  Wahlen Sie den Zielstil aus der Dropdown-Liste Alle des Typs.

5) Klicken Sie auf Aktualisieren.

6) BestatigenSie die Frage , Alle Typen <Name des aktuellen Stils>in <Name des neuen Stils>andern?“
mit OK.

FrameMaker formatiert alle im aktuellen Dokument mit <Name des aktuellen Stils>formatierten Absatze
mit <Name des neuen Stils> neu.

Loschen eines Absatzstils aus dem Dokumentstilkatalog

NOTICE: Das Loschen eines Stils aus dem Dokumentstilkatalog wirkt sich nicht auf den Inhalt aus, auf den
dieser Stil angewendet wurde. Auf den Inhalt wird einfach ein Stil angewendet, der nicht im Katalog
enthalten ist.

So l6schen Sie einen Absatzstil aus dem Dokumentstilkatalog:

1)  Wahlen Sie Format > Absatze > Absatzkatalog. Der Absatzkatalog wird angezeigt.

2)  Klicken Sie auf die Schaltflache Léschen. Die Option Formate aus Katalog I6schen wird angezeigt.
3) Wahlen Sie den Absatzstil aus, den Sie |6schen moéchten.
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4)  Klicken Sie auf Léschen.
5) Klicken Sie auf OK, um das Dialogfeld zu schlieBen.

Loschen eines Zeichenstils aus dem Dokumentstilkatalog

NOTICE: Das Loschen eines Stils aus dem Dokumentstilkatalog wirkt sich nicht auf den Inhalt aus, auf den
dieser Stil angewendet wurde. Auf den Inhalt wird einfach ein Stil angewendet, der nicht im Katalog
enthalten ist.

So l6schen Sie einen Zeichenstil aus dem Dokumentstilkatalog:

1)  Wahlen Sie Format > Zeichen > Zeichenformatkatalog. Der Zeichenformatkatalog wird angezeigt.
2)  Klicken Sie auf die Schaltflache Léschen. Die Option Formate aus Katalog l6schen wird angezeigt.
3)  Wahlen Sie den Zeichenstil aus, den Sie I16schen mochten.

4)  Klicken Sie auf Léschen.

5)  Klicken Sie auf OK, um das Dialogfeld zu schlieRen.

Umbenennen eines Stils

So benennen Sie einen Absatz- oder Zeichenstil in einem Adobe FrameMaker-Dokument um:

1)  Wenn Sie einen Absatzstil umbenennen mochten, wahlen Sie Format > Absdtze > Absatzformat-
katalog, um den Absatzformatkatalog zu 6ffnen.

Wenn Sie einen Zeichenstil umbenennen méchten, wdhlen Sie Format > Zeichen > Zeichenformat-
katalog, um den Zeichenformatkatalog zu éffnen.

2)  Wabhlen Sie den Stil, den Sie umbenennen mdchten, in der Dropdown-Liste Stil aus.
3) Geben Sie einen neuen Namen in die Dropdown-Liste Stil ein, und klicken Sie auf Umbenennen.

Hinzufiigen von Stilen, die im Stilkatalog fehlen

Das Loschen eines Stils aus dem Dokumentstilkatalog wirkt sich nicht auf den Inhalt aus, auf den dieser
Stil angewendet wurde. Auf den Inhalt wird einfach ein Stil angewendet, der nicht im Katalog enthalten
ist.

So fligen Sie Absatz- oder Zeichenstile hinzu, die auf Absatze oder Zeichen angewendet werden, aber in
den Stilkatalogen fehlen:

Wahlen Sie Datei > Dienstprogramme > Formate anlegen und anwenden, und klicken Sie dann auf
Weiter. FrameMaker nimmt dann alle im Dokument verwendeten Absatz- oder Zeichenstile wieder in
den Katalog auf.

HiNnweEIS: FrameMaker erstellt auch neue Stile und fligt sie dem Stilkatalog fiir jeden irreguldre Absatz-
oder Zeichenstilformatierung hinzu Wenn Sie z. B. mehrere Absatze mit dem Stil ,,Haupttext” haben und
jeder von ihnen irreguldare Formatierungen aufweist, erstellt FrameMaker neue Stile wie ,Haupttext1”,
»Haupttext2“, ,Haupttext3“ fiir jede irreguldre Formatierung. FrameMaker wendet die neuen Stile auch
auf diese Absatze an und flgt die neuen Stile dem Dokumentstilkatalog hinzu.
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Tipps fiir das Erstellen neuer Stile

Wenn Sie eine neue Vorlage entwerfen oder die verwendete Vorlage unvollstandig ist, miissen Sie mogli-
cherweise neue Stile erstellen. Die Eigenschaften eines bereits vorhandenen Stils zu andern ist die
einfachste Moglichkeit, einen Stil zu erstellen.

Beachten Sie beim Erstellen neuer Stile Folgendes:

Verwenden Sie eine einheitliche Namenskonvention fir dhnliche Arten von Absatzen und Textele-
menten in einem Absatz, wie , Uberschrift1“ und , Uberschrift2“.

Um Stile mit der Tastatur anzuwenden, benennen Sie sie so, dass die oft verwendeten Stile
eindeutig sind oder zuerst in ihrer Buchstabengruppe erscheinen, wie ,,H1 Titel2“ oder ,, H2 Titel2".

Geben Sie den Stilen einen bedeutungsvollen Namen, der einfach zu merken, zu erkennen und
einzugeben ist. Wenn Sie einen Stil nach seinem Verwendungszweck und nicht nach seiner Darstel-
lung zuweisen, konnen Sie die Stileigenschaften dndern, ohne dass der Stilname gedndert werden
muss. Wenn Sie z. B. einen Zeichenstil erstellen mochten, um einen Ausdruck fett zu markieren,
konnen Sie den Zeichenstil mit Ausdruck anstelle von ,,Fett” benennen. Sie konnen die Schriftstarke
»Fett” fur diesen Zeichenstil definieren. Wenn Sie spater alle Ausdriicke kursiv statt fett format-
ieren mochten, missen Sie nur die Schriftstarke- und Schriftwinkeldefinition des Zeichenstils
Ausdruck andern. Dank dieser Namenskonvention muss der Stil nicht umbenannt und neu definiert
werden, wahrend gleichzeitig seine Bedeutung beibehalten wird.

Achten Sie auf die GroR- und Kleinschreibung. Bei Stilnamen wird die GroRR-/Kleinschreibung
beachtet. In einigen Fallen sollen auch miteinander in Beziehung stehende Stile im Katalog untere-
inander angezeigt werden, bei Namen wie ,,Haupttext” und , HaupttextEinzug”.

Beim Erstellen von Stilen fiir strukturierte Vorlagen wird die Pflege der Vorlage haufig komforta-
bler, wenn Sie einem Stil den Namen des Elements geben, das diesen Stil verwendet. Wenn Sie
beispielsweise ein Element wie <shortdesc> verwenden, kénnen Sie den Absatzstil auch mit
shortdesc benennen.
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Stilkataloge

Lernen Sie Stilkataloge in Adobe FrameMaker kennen.

In diesem Thema

. Einfiihrung

. Konfigurieren, welche Stile in einem Stilkatalog angezeigt werden
. Léschen von Stilen

Einfihrung

Adobe FrameMaker enthilt erweiterte Funktionen zum Verwalten und Anwenden von Absatz-, Zeichen-
und Tabellenstilen. Dies ist mit den jeweiligen Katalogen moglich. StandardmaRig enthalt ein Katalog alle
Stile im aktuellen Dokument. Sie kdnnen festlegen, welche Stile Sie im Katalog anzeigen méchten. Kata-
loge unterstiitzen Sie auch beim Anwenden und Verwalten von Stilen.

FrameMaker markiert die verwendeten Stile in einem Katalog. Die nicht verwendeten Stile sind nicht
markiert. Diese Verwendungsinformationen werden nicht aktualisiert, wenn Sie die Stile auf das Doku-
ment anwenden. Zum Aktualisieren der Verwendungsinformationen klicken Sie unten im Katalog auf
Katalog aktualisieren. Die Verwendungsinformationen werden auch aktualisiert, wenn Sie ein Doku-
ment offnen.

Konfigurieren, welche Stile in einem Stilkatalog angezeigt werden

So konfigurieren Sie, welche Stile in einem Stilkatalog sichtbar sind, und andern deren Reihenfolge:

1)  Offnen Sie einen Katalog (fiir Absatz, Zeichen oder Tabelle), und klicken Sie auf Optionen. Das
Dialogfeld Verfiigbare Formate festlegen wird angezeigt.

2)  Wabhlen Sie eine der folgenden Moglichkeiten:
- Wahlen Sie Alle anzeigen aus, um alle verfligbaren Stile anzuzeigen.

- Wadhlen Sie Verwendete vor nicht verwendeten anzeigen, um verwendete Stile vor nicht
verwendeten Stilen im Katalog anzuzeigen.

- Wahlen Sie Nur verwendete Formate anzeigen, um nicht verwendete Stile im Katalog
auszublenden, sie jedoch im Dokument beizubehalten.

- Wahlen Sie Nur nicht verwendete Formate anzeigen, um verwendete Stile im Katalog
auszublenden, sie jedoch im Dokument beizubehalten.

- Wahlen Sie Alle nicht verwendeten Formate I6schen, um alle nicht verwendeten Stile ohne
Warnung oder Bestatigung aus dem aktuellen Dokument zu I6schen.

- Wahlen Sie Spezielle Liste und klicken Sie auf Bearbeiten, um anzupassen, welche Formate
der Katalog in welcher Reihenfolge anzeigt.

3) Die Stile, die im aktuellen Dokument verwendet werden, sind im Katalog markiert. Wahrend Sie das
Dokument bearbeiten, wird der Verwendungsstatus moglicherweise nicht automatisch aktualis-
iert. Klicken Sie auf Katalog aktualisieren, um die Liste zu aktualisieren.

HinweEls: Die festgelegten Anzeigeoptionen sind Arbeitsbereichseigenschaften und auf die
FrameMaker-Dokumente anwendbar, die auf lnrem Rechner ge6ffnet sind.
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Loschen von Stilen

So l6schen Sie Stile aus einem Dokumentkatalog:
. Offnen Sie den Katalog, falls er nicht bereits ge6ffnet ist.

- Wahlen Sie Ansicht > Fenster > Absatzformatkatalog, um den Absatzformatkatalog zu
offnen.

- Wahlen Sie Ansicht > Fenster > Zeichenformatkatalog, um den Zeichenformatkatalog zu
offnen.

- Wahlen Sie Ansicht > Fenster > Tabellenformatkatalog, um den Tabellenformatkatalog zu
offnen.
. Klicken Sie auf Loschen.
. Wahlen Sie im Fenster ,,Formate aus Katalog |I6schen” ein Format aus und lI6schen Sie es.

. Klicken Sie auf OK, um die Stile aus dem Dokument zu l6schen oder schlieRen Sie das Fenster, um
den Vorgang rickgangig zu machen.
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Schriften

Lernen Sie Schriftarten, Anderungsbalken, Sprache und Unterschneiden, japanische und westliche
Schriftarten in FrameMaker kennen.

In diesem Thema

J Ersetzen von Schriften mithilfe des Fensters , Schriften”

e Manuelles Andern der Schrift

. Schriftinderungen mithilfe der Gestaltungsfenster

. Anpassen von hochgestelltem und tiefgestelltem Text und Kapitdlchen

J Anpassen von hochgestelltem und tiefgestelltem Text und Kapitdlchen

. Verdichten und Erweitern von Zeichen

o Erstellen oder Andern kombinierter Schriften mit japanischen und lateinischen Zeichen

Ersetzen von Schriften mithilfe des Fensters , Schriften”

Mit dem Fenster Schriften konnen Sie alle Schriftarten identifizieren, die in einem oder allen gedffneten
Dokumenten verwendet werden. In der Fensterliste sind alle in einem Dokument verwendeten Schriften
aufgeflihrt. Mithilfe des Fensters ,,Schriften” konnen Sie alle in einem Dokument verwendeten Schriften
ersetzen, einschlieflich fehlender Schriften. Die fehlenden Schriften sind durch ein rotes Kreuz gekennt-
zeichnet.

A B cC D
B
= Y O

Font = Document
E—+Gisha Legal fm

Figure 1: Im Fenster ,Schriften” sind alle in einem Dokument verwendeten Schriften aufgefihrt.

A. Nur fehlende Schriften oder alle in einem Dokument verwendeten Schriften anzeigen. B. Schrift
ersetzen, um das Fenster ,Schrift ersetzen” anzuzeigen. C. Das/die derzeit ge6ffnete(n) Dokument(e)
auswahlen. D. Liste der Schriften aktualisieren, die in der Fensterliste angezeigt werden. E. Fehlende
Schriften werden durch ein rotes Kreuz markiert.
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So ersetzen Sie eine Schrift:

1)  Wahlen Sie eine Schrift aus der Liste und klicken Sie auf das Symbol Ersetzen.

2)  Wabhlen Sie im Fenster Schrift ersetzen im Listenfeld Ersetzen durch die neue Schrift, und klicken Sie

auf Anwenden.
Replace Font L. b =3
A - FontName: Gisha
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C- Document Legalfm Apply
Locations
Page Size Angle Weight Vanation
D == 3 120pt Regular Regular Regular
3 240 pt Regular Bold Regular
4 120pt Regular Regular Regular
Left 8.0 pt Regular Regular Regular
Left 120pt Regular Regular Regular
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Right 8.0 pt Regular Regular Regular
Right 120pt Regular Regular Regular
HTML 6.0 pt Regular Regular Regular
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Figure 2: Im Fenster ,Schrift ersetzen” sind alle Absatze in einem Dokument aufgefiihrt, in denen die

ausgewahlte Schrift verwendet wird.

A. Name der ausgewdhlten Schrift. B. Im Listenfeld , Ersetzen durch” sind alle Schriften aufgefiihrt,
die in Ihrem System installiert sind. C. In der Liste , Positionen” sind alle Abséitze im Dokument auf-
gefiihrt, in denen die ausgewdhlte Schrift verwendet wird. D. Durch Doppelklicken auf ein beliebiges
Element in der Liste kénnen Sie an die Position im Dokument wechseln, das die ausgewdhlte Schrift

verwendet.

Manuelles Andern der Schrift

Formatanderungen, die Sie mit den Befehlen des Meniis ,,Format“ vornehmen, werden sofort wirksam.

Wenn Sie Schrifteigenschaften dndern, beriicksichtigen Sie Folgendes:
. Um andere Formatierungseigenschaften zu entfernen, wahlen Sie Format > Stil > Standard.

] Wenn Sie die Schrifteigenschaften fir markierten Text andern, werden diese Eigenschaften beim

spateren Aktualisieren der Eigenschaften fir den gesamten Absatz beibehalten.

. Sie kdnnen die Schrifteigenschaften von Absatztext und von Text andern, der mit dem Werkzeug

Textzeile erstellt wurde.

. Wenn eine Schrift mehrere Starken hat (z. B. Helvetica’ Condensed Bold und Helvetica Condensed
Black), wird im Untermeni Format > Stil nur der Eintrag ,Fett” angezeigt. Wenn Sie Text mit den
anderen Schriftstarken anzeigen mochten, verwenden Sie die Schrifteigenschaften der Absatzge-

staltung, oder verwenden Sie stattdessen die Zeichengestaltung.

Schriftanderungen mithilfe der Gestaltungsfenster

Im Dialogfeld ,Absatzgestaltung” kénnen Sie die Standardschrifteigenschaften eines ganzen Absatzes
festlegen. Welche Schriftfamilien und Stile verfiigbar sind, hangt davon ab, welche Schriften installiert
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wurden. Um einen bestimmten Text in einem Absatz zu andern, markieren Sie den Text, und wahlen Sie
die Zeichengestaltung.

Wahrscheinlich kennen Sie viele der Einstellungen bereits aus anderen Textverarbeitungsprogrammen.
Einige sind jedoch moglicherweise neu fir Sie.

Numerisch unterstreichen

Wahlen Sie die Option ,,Numerisch unterstreichen”, um unabhangig von der Schriftart und der
Grol3e des Zeichens nur einen Abstand und eine Starke fir eine Unterstreichung zu verwenden.
Tabulatorzeichen werden weder von der Option ,,Unterstreichen” noch ,Numerisch unterstre-
ichen” gedndert. Sollen auch Tabulatoren unterstrichen werden, formatieren Sie den Tabulator-
stopp so, dass ein umbruchgeschitztes Zeichen als Fiihrungszeichen verwendet wird.

Mt. Everest is 25,028 .

Mt. Everest is29.025 i1

Figure 3: Numerisches und einfaches Unterstreichen

Anderungsbalken
Um einen Anderungsbalken neben dem Text anzuzeigen, wihlen Sie Anderungsbalken.

Farbe

Um den Text in einer anderen Farbe anzuzeigen, wahlen Sie in der Dropdown-Liste ,,Farbe” die
gewlinschte Farbe aus. Wenn Sie eigene Farben definiert haben, werden diese in der Drop-
down-Liste angezeigt.

Abstand

Der Abstand zwischen den Zeichen kann vergroRert bzw. verkleinert werden, indem Sie in dieses
Feld den entsprechenden Prozentwert eingeben. Der Wert wird in Prozent eines m-Leerzeichens
angegeben. Der normale Abstand entspricht 0 %.

On looking towards
On looking towards
On looking towards

Figure4: —10 % Abstand (oben), 0 % Abstand (zentriert), 10 % Abstand (unten)

Streckung
Mit diesem Wert kdnnen Sie die Breite der Zeichen festlegen.

GroB-/Kleinschreibung
Wahlen Sie Kapitdlchen, wenn in Kleinschreibung vorliegender Text in verkleinerten GroBbuchs-
taben (Kapitdlchen) angezeigt werden soll.

Wenn einem Text in einem Gestaltungsfenster ein GroRR-/Kleinschreibungsstil zugewiesen wird,
andert dies nur die Anzeige des Textes (klein geschriebener Text wird beispielsweise in GroRbuch-
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staben angezeigt). Um den Text selbst dauerhaft zu dndern, verwenden Sie das Dialogfeld
Grof3-/Kleinschreibung. Dort konnen Sie den ausgewahlten Text durch Text in GroBbuchstaben,
Kleinbuchstaben oder Kleinbuchstaben mit grolen Anfangsbuchstaben ersetzen.

HiNnwels: Sie rufen das Dialogfeld ,,GroRR-/Kleinschreibung” mit der Tastenkombination Esc, e Umschalt-
taste+c auf.
Sprache

Sie kénnen die dem Text zugewiesene Sprache dandern, indem Sie den gewiinschten Eintrag in der

Dropdown-Liste ,,Sprache” wahlen. Die gewahlte Sprache hat sowohl Auswirkungen auf den Text

in Systemvariablen als auch auf die Rechtschreibprifung und die Silbentrennung. Wenn Sie den

Wert ,Keine” wahlen, wird auch keine Rechtschreibprifung fir den markierten Text durchgefiihrt.
Unterschneiden

Aktivieren Sie die Option ,Unterschneiden”, um den Abstand zwischen zwei Zeichen im selben
Wort anzupassen. Die definierten Unterschneidungen sind abhangig von der Schriftart.

1y || Ty

Figure 5:  Aktivierte und deaktivierte Unterschneidungen

Tsume

Wenn Sie ein japanisches Zeichen ndher an die angrenzenden Zeichen schieben moéchten, wahlen
Sie Tsume. Die Strecke, um die ein Zeichen mit veranderlicher Breite (wie eine Klammer)
verschoben werden kann, ist abhangig von der Metrik flir dieses Zeichen.

Anpassen von hochgestelltem und tiefgestelltem Text und Kapitdlchen

Anderungen der Eigenschaften fiir tiefgestellten und hochgestellten Text (einschlieRlich FuRnotenver-
weise) und Kapitalchen wirken sich auf jeden derartigen Text im Dokument aus.

1) Geben Sie im Dialogfeld , Textoptionen” Gréf3e, Abstand und Streckung in Prozent an.

Beim Berechnen der Gréfie und des Abstands wird der von lhnen eingegebene Prozentsatz von
FrameMaker mit dem Schriftgrad der betreffenden Zeichen multipliziert. Wenn Sie beispielsweise
fiir den Abstand fiir hochgestellten Text den Wert 40 % angeben, wird ein Zeichen mit 10 pt um 4 pt
erhoht.

Die Prozentangabe fiir die Streckung entspricht dem Wert, um den die Zeichen verdichtet oder aus-
geweitet werden.

2) Klicken Sie auf Anwenden.

Verdichten und Erweitern von Zeichen

Durch das Strecken von Zeichen konnen Sie bestimmte Effekte erzielen.
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On Jooking towards
On looking towards
On looking towards

Figure 6: Kondensierter (oben), normaler (Mitte) und um 75 % gestreckter Text (unten)

1)  Wabhlen Sie je nachdem, ob Sie den gesamten Absatz oder bestimmten Text im Absatz andern, eine
der folgenden Maoglichkeiten:

- Schriftart aus der Dropdown-Liste ,,Eigenschaften” in der Absatzgestaltung.
—  Zeichengestaltung.

2) Geben Sie in das Feld Streckung einen Prozentwert ein. Ein Wert von 100 % bedeutet, dass die
Zeichenbreite den Schrifteinstellungen entspricht. Ein Wert unter 100 % verringert die Breite
(Verdichtung), wahrend ein Wert tGber 100 % die Breite erhoht (Erweiterung).

3) Klicken Sie auf Anwenden.

Tipp: In japanischen Dokumenten kénnen Sie mit einem Wert, der groRer als 100 ist, Heitai (hori-
zontal gedehnte Zeichen) simulieren. Sie kdnnen einen Streckungswert von unter 100 verwenden
und den Schriftgrad fur den Text maximieren, um Chotai (vertikal gestreckte Zeichen) zu simu-
lieren.

Sie kdnnen auch die Breite einer Textzeile durch Ziehen andern und damit den Text strecken.

1)  Wahlen Sie die zu dndernde Textzeile aus und ziehen Sie einen ihrer Ziehpunkte, bis der Text
entsprechend lhren Wiinschen gestreckt ist. Wenn Sie einen Eckpunkt ziehen, werden Schriftgrad
und Zeichenbreite gedndert. Sie konnen auch ein gruppiertes Objekt, das eine Textzeile enthalt,
wahlen.

Erstellen oder Andern kombinierter Schriften mit japanischen und lateinischen Zeichen

Japanische Schriften enthalten auBer dem vollstandigen Satz der japanischen Silben auch einen Satz
lateinischer Zeichen, um die Eingabe von nicht-japanischen Zeichen und Zahlen zu erleichtern. Sie
konnen lhre eigenen kombinierten Schriften definieren (unter einer kombinierten Schrift versteht man
eine Schrift, in der eine bestimmte lateinische zusammen mit einer bestimmten japanischen Schrift
verwendet wird).

Sollten Sie mit einem System arbeiten, das japanischen Text unterstiitzt und kombinierte Schriften als
Teil einer Vorgabe enthilt, sind diese automatisch verfiigbar. (Die angegebenen Schriften missen instal-
liert sein.) Wenn das System die Eingabe von japanischem Text in Dokumente und Dialogfeldern unter-
stutzt, werden die kombinierten Schriften zusammen mit den lateinischen und japanischen Schriften am
Anfang der Schriftenlisten angezeigt.

FrameMaker unterstitzt japanische Singlebyte-Katakana-Zeichen halber Breite in kombinierten
Schriften. Anderungen an kombinierten Schriften wirken sich auf das gesamte Dokument aus.
1)  Wahlen Sie im Dialogfeld ,,Kombinierte Schriften” eine der folgenden Méglichkeiten:

- Soll eine neue kombinierte Schrift erstellt werden, geben Sie einen Namen in das Feld ,Name
der kombinierten Schrift” ein.

- Wenn Sie eine andere kombinierte Schrift verwenden mochten, wahlen Sie aus der Liste
,Kombinierte Schriften” den gewlinschten Namen aus.
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2)  Fihren Sie eine der folgenden Aktionen durch:

- Um die japanische Schriftart anzugeben, wahlen Sie sie aus der Dropdown-Liste der Schrift-
familien im Bereich Text in asiatischen Schriften.

- Um die westliche Schriftart anzugeben, wahlen Sie sie aus der Dropdown-Liste der Schriftfam-
ilien im Bereich Text in lateinischer Schrift.

- Wenn Sie die relative Grof8e und den Grundlinienabstand des lateinischen Textes anpassen
mochten, geben Sie die gewlinschten Werte fiir die Einstellungen GréRBe und Abstand an.
GroBe und Abstand von Text in lateinischer Schrift werden als Prozentwerte des asiatischen
Schriftgrads angegeben. Verwenden Sie einen negativen Abstand, um den Text unter die
Grundlinie zu bewegen.

3)  Klicken Sie auf Hinzufiigen oder Andern.
4)  Klicken Sie auf Fertig.

Hinwels: Sie kdnnen die Einstellung Fett und Kursiv zulassen unter Text in asiatischen Schriften im

Dialogfeld Kombinierte Schriften bearbeiten deaktivieren, damit beim Einstellen von Fett oder Kursiv flr

lateinische Schrift nicht automatisch auch der asiatische Text fett oder kursiv gesetzt wird.

1)  Wahlen Sie zum Kopieren eines Satzes mit kombinierten Schriften Datei > Importieren > Formate,
und wahlen Sie Kombinierte Schriften.
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Hintergrundfarbe

Erfahren Sie, wie Sie Abschnitte eines Adobe FrameMaker-Dokuments hervorheben, indem Sie die
Hintergrundfarbe fir Text oder den gesamten Absatz festlegen.

In diesem Thema

L Einflihrung

J Festlegen der Hintergrundfarbe fiir Text innerhalb eines Absatzes

. Festlegen der Hintergrundfarbe fiir einen ganzen Absatz

. Festlegen der Hintergrundfarbe fiir ein Absatzfeld

Einfiihrung

Sie kdnnen Abschnitte eines Dokuments hervorheben, indem Sie die Hintergrundfarbe fiir Doku-
mentteile in folgenden Szenarien festlegen:

] Festlegen der Hintergrundfarbe fiir einen bestimmten Textteil innerhalb eines Absatzes

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam
accumsan, urna nec gravida feugiat, nisl arcu egestas urna, id feugiat
lectus risus eget lectus.

Sed vehicula cursus interdum. Donec id turpis pellentesque, commodo
sem in, vestibulum leo. Sed purus ante, tincidunt eget diam id, ultrices
ornare elit. Praesent id sapien tristique risus finibus convallis. Sed et
nulla ante. Nulla pulvinar, lectus n on consectetur feugiat, nibh mauris
mollis odio, ut gravida dui libero et ligula.

Figure 1:  Hintergrundfarbe fiir Text
J Festlegen der Hintergrundfarbe fiir den gesamten Text eines Absatzes.

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam
accumsan, urna nec gravida feugiat, nisl arcu egestas urna, id feugiat
lectus risus eget lectus.

Sed vehicula cursus interdum. Donec id turpis pellentesque, commodo
sem in, vestibulum leo. Sed purus ante, tincidunt eget diam id, ultrices
ornare elit. Praesent id sapien tristique risus finibus convallis. Sed et
nulla ante. Nulla pulvinar, lectus n on consectetur feugiat, nibh mauris
mollis odio, ut gravida dui libero et ligula.

Figure 2:  Hintergrundfarbe fiir Absatz
. Festlegen der Hintergrundfarbe von Absatzfeldern, die den Absatz umschlieRen.
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Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam
accumsan, urna nec gravida feugiat, nisl arcu egestas urna, id feugiat
lectus risus eget lectus.

Sed vehicula cursus interdum. Donec id turpis pellentesque, commodo
sem in, vestibulum leo. Sed purus ante, tincidunt eget diam id, ultrices
ornare elit. Pragsent id sapien tristique risus finibus convallis. Sed et
nulla ante. Nulla pulvinar, lectus n on consectetur feugiat, nibh mauris
mollis odio, ut gravida dui libero et ligula.

Figure 3:  Farbe fir Absatzfeld

Festlegen der Hintergrundfarbe fiir Text innerhalb eines Absatzes

So legen Sie die Hintergrundfarbe fiir einen Teil des Textes in einem Absatz fest:

1)  Wahlen Sie den Text im Absatz aus.

2)  Offnen Sie die Zeichengestaltung.

3)  Wahlen Sie in der Dropdown-Liste Hintergrundfarbe eine Farbe aus und klicken Sie auf
Anwenden.

Die Hintergrundfarbe ist nur fiir den ausgewahlten Text im Absatz festgelegt.

Festlegen der Hintergrundfarbe fiir einen ganzen Absatz

So legen Sie die Hintergrundfarbe fiir einen ganzen Absatz fest:
1) Positionieren Sie den Cursor an eine beliebige Stelle innerhalb des Absatzes.
2)  Offnen Sie die ,,Absatzgestaltung” und rufen Sie die Registerkarte , Schrift“ auf.

3)  Wahlen Sie in der Dropdown-Liste Hintergrundfarbe eine Farbe aus und klicken Sie auf
Anwenden.

Die Hintergrundfarbe ist fir den gesamten Text im Absatz festgelegt.

Festlegen der Hintergrundfarbe fiir ein Absatzfeld

So legen Sie die Hintergrundfarbe eines Absatzfeldes fest:

1) Positionieren Sie den Cursor an eine beliebige Stelle innerhalb des Absatzes.

2)  Offnen Sie die ,,Absatzgestaltung” und rufen Sie die Registerkarte ,Erweitert” auf.

3) Waihlen Sie in der Dropdown-Liste Absatzfeld eine Farbe aus und klicken Sie auf Anwenden.

Die Hintergrundfarbe ist flir das gesamte Feld festgelegt, das den Absatz umschlief3t.

Wenn Sie die Hintergrundfarbe des Texts im Absatz festlegen, erstreckt sich die Farbe tGber den Text des
Absatzes. Im Falle des Absatzfelds erstreckt sich der Text (iber den gesamten Bereich des Absatzes vom
linken zum rechten Rand.
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Einzug, Ausrichtung und Zeilenabstand

Erfahren Sie mehr lber Einzug, Ausrichtung und Zeilenabstand in Adobe FrameMaker. Lernen Sie Tabu-
latorstopps und Platzierung in japanischen Dokumenten kennen.

Andern der Absatzausrichtung

Die Ausrichtung eines Absatzes bestimmt, wie dieser zwischen dem linken und dem rechten Einzug posi-
tioniert wird und nicht zwischen den Randern der Textspalte.
Fiihren Sie eine der folgenden Aktionen aus:

. Wenn Sie das Lineal verwenden mdéchten, ziehen Sie das Einzugssymbol an eine neue Position im
Lineal.

UntitledL.im X

Figure 1: A. Einzug 1. Zeile B. Linker Einzug C.Rechter Einzug

. Wenn Sie einen Einzugswert verwenden mochten, zeigen Sie im Dialogfeld Absatzgestaltung die
Basiseigenschaften an. Geben Sie die gewlinschten Einziige in die Felder 1. Zeile, Links und Rechts
ein, und klicken Sie anschliefend auf Anwenden.

J Wahlen Sie in der Formatierungsleiste oder in den Basiseigenschaften der Absatzgestaltung eine
Ausrichtung aus.

HINWEIS: Wenn Sie mit Umschalttaste+Eingabetaste einen erzwungenen Zeilenumbruch in einen Absatz
im Blocksatz einfligen, wird der Blocksatz fiir die Zeile mit dem erzwungenen Umbruch aufgehoben.

Tipp: Wenn Sie einen Einzug an einer Lineaturmarke ausrichten méchten, aktivieren Sie das Magnetraster
(verwenden Sie Grafik > Anordnen > Magnet). Wenn Sie anschlieRend das Einzugssymbol mit der Maus
ziehen, rastet es an Positionen des Magnetrasters ein.

Tabulatoren @andern

In diesem Thema

J Einflihrung

J Andern von Tabulatoren in der Formatierungsleiste

. Andern von Tabulatoren in der Absatzgestaltung

J Definieren eines Flihrungs- oder Dezimaltabulatorzeichens

Einfiihrung

Wenn Sie die Tab-Taste driicken und sich die Einfligemarke nicht bewegt, wurde kein Tabulatorstopp
definiert.
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Es gibt vier Arten von Tabulatorstopps: links, zentriert, rechts und dezimal.

A e C D

Everest Everest Everest 2.6794
Lhotse Lhotse Lhotse ]

K2 K2 K2 18.36

A. Linker Tabulatorstopp B. Mittlerer Tabulatorstopp C.Rechter Tabulatorstopp d.Dezimaler Tabulator-
stopp

Sie konnen auch ein Zeichenmuster (Fihrungszeichen) angeben, das zwischen dem Tabulator und dem
nachfolgenden Zeichen eingefiigt wird Normalerweise besteht ein Flihrungszeichen aus einer Reihe von
Punkten. Tabulatorflihrungszeichen sind vor allem in Tabellen mit grolRen Leerrdaumen zwischen den
Spalten hilfreich.

Andern von Tabulatoren in der Formatierungsleiste

1)  Wahlen Sie Ansicht > Symbolleisten Symbolleiste Absatzformatierung. Es werden nur die Tabula-
torstopps auf dem oberen Lineal angezeigt, die in allen ausgewahlten Absatzen vorhanden sind.

2)  Fihren Sie eine der folgenden Aktionen aus:

- Um einen Tabulatorstopp hinzuzufiigen, klicken Sie auf ein Tabulatorsymbol in der Symbol-
leiste Absatzformatierung und klicken an die gewlinschte Position unterhalb des oberen
Lineals.

- Wenn Sie einen Tabulatorstopp verschieben méchten, ziehen Sie ihn einfach an eine neue
Position.

Tiep: Um Tabulatorstopps an Linealmarkierungen auszurichten, aktivieren Sie das Magnetraster
(Grafiken > Anordnen > Magnet). Wenn Sie dann ein Tabulatorsymbol mit der Maus ziehen, rastet
es an der entsprechenden Position ein.

- Sie konnen auch mehrere Tabulatorstopps in gleichmaRigen Abstanden hinzufliigen. Doppelk-
licken Sie zundchst im oberen Lineal auf den vorhandenen Tabulatorstopp, der dupliziert
werden soll. Das Dialogfeld Tabulator bearbeiten wird angezeigt.
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Figure 2:

Edit Tab Stop X

Current Position 0,25"

New Position:

Alignment: Leader:
O Left (O None
O Center ® ...

O....
(O Right O----
(® Decimal O

Align On: |:| (O Custom: D
[ ] Repeat Every:

Delete Delete All

Dialogfeld , Tabulator bearbeiten”

Geben Sie dann den gewiinschten Abstand zwischen den Stopps in das Feld Wiederholinter-
vall ein, und klicken Sie auf Bearbeiten.

Sie kénnen einen Tabulatorstopp andern, indem Sie auf ihn doppelklicken, seine neue Posi-
tion in das Feld Neue Position eingeben und eine andere Ausrichtung wahlen. Die Position ist
der Abstand zwischen dem linken Spaltenrand und dem Tabulatorstopp. Klicken Sie dann auf
Bearbeiten. Sie kénnen im Lineal auch einen neuen Tabulatorstopp auf einen vorhandenen
ziehen, um diesen zu ersetzen.

Um einen Tabulatorstopp zu I6schen, ziehen Sie ihn nach unten aus dem Bereich des oberen
Lineals.

Wenn alle Tabulatorstopps geléscht werden sollen, doppelklicken Sie auf einen beliebigen
Stopp, und klicken Sie auf Alle 16schen.

Andern von Tabulatoren in der Absatzgestaltung

1) Zeigen Sie im Dialogfeld Absatzgestaltung die Einstellungsgruppe Basis an.

2) Im Bereich Tabulatoren kdnnen Sie entsprechende Einstellungen erstellen, bearbeiten oder
[6schen.

3) Klicken Sie auf Anwenden.
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Definieren eines Fiihrungs- oder Dezimaltabulatorzeichens

1) Doppelklicken Sie auf den Tabulatorstopp auf dem Lineal. Das Dialogfeld Tabulator bearbeiten wird
angezeigt.

Edit Tab Stop X

Current Position 0,25"

New Position:

Alignment: Leader:
O Left (O None
O center ®...

O....
O Right O L
(® Decimal O

Align On: |:| (O Custom: |:|
[] Repeat Every:

Delete Delete All

Cancsl

Figure 3: Dialogfeld ,Tabulator bearbeiten”

2)  Fihren Sie eine der folgenden Aktionen aus:

—  Wahlen Sie im Dialogfeld unter Flihrungszeichen eines der vordefinierten Fiihrungszeichen,
oder geben Sie ein eigenes Zeichen ein, und klicken Sie anschliefend auf ,Bearbeiten”.

- Um ein Dezimalzeichen (beispielsweise eine Komma bei europadischen Dezimalzahlen)
anzugeben, geben Sie im Bereich ,,Ausrichtung” im Feld ,,Ausrichten” ein Dezimalzeichen ein
und klicken Sie auf ,,Bearbeiten®.

Andern von Absatz- und Zeichenabstinden

In diesem Thema

. Einflihrung
. Anpassen des vertikalen Abstands
J Horizontalen Abstand anpassen

Einfiihrung

Der vertikale Abstand ist der Abstand zwischen Absatzen und Zeilen. Der horizontale Abstand ist der
Abstand zwischen Wortern und Zeichen. Abstandseinstellungen haben je nach Kontext verschiedene
Bezeichnungen. Der Abstand zwischen Zeichen wird oft als Unterschneidung bezeichnet, das Anpassen
des Buchstabenabstands in einer Zeile als Abstand oder Verteilung und der Zeilenabstand in einem
Absatz (gemessen von der Grundlinie der einen Zeile zur Grundlinie der nachsten) als Durchschuss.
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Anpassen des vertikalen Abstands

Beachten Sie beim Anpassen des vertikalen Abstands Folgendes:

. Befindet sich ein Absatz am Anfang einer Spalte, wird die Einstellung Abstand: Oben in
FrameMaker ignoriert.
Bei einem Absatz am Ende einer Spalte wird die Einstellung Abstand: Unten in FrameMaker ignori-
ert.

. Wenn unterhalb der aktuellen Zeile ein verankerter Rahmen platziert wird, dessen Ankersymbol
sich in der letzten Zeile eines Absatzes befindet, erscheint der Bereich unter dem Absatz in der

Regel zwischen dem Rahmen und dem nachsten Absatz. Wenn der Rahmen in einem verbundenen
Absatz verankert ist, wird der Bereich unterhalb verworfen.

Ist der Rahmen ein verbundener Rahmen, der jedoch nicht in einem verbundenen Absatz verankert
ist, wird der darunter liegende Bereich zwischen dem Ankersymbol und dem Rahmen angezeigt.

. In einem mehrspaltigen Layout kdnnen Sie auch den vertikalen Abstand in Spalten durch einen
Héhenausgleich des Textes anpassen.

Fiir den vertikalen Abstand eines Absatzes sind mehrere Eigenschaften verantwortlich: der Abstand
oberhalb des Absatzes, der Abstand unterhalb des Absatzes und der Zeilenabstand.

1) Zeigen Sie im Dialogfeld Absatzgestaltung die Einstellungsgruppe Basis an, und fiihren Sie eine der
folgenden Aktionen aus:

- Geben Sie Werte fiir Abstand: Oben und Abstand: Unten an. Der Abstand zwischen zwei
Absadtzen wird durch die Einstellung Abstand: Unten des ersten Absatzes oder die Einstellung
Abstand: Oben des zweiten Absatzes bestimmt (je nachdem, welcher Wert groRer ist).

- Wihlen Sie anschliefend in der Dropdown-Liste Zeilenabstand einen Zeilenabstand, oder
geben Sie einen Wert in das Feld ein.

2)  Wenn der Zeilenabstand bei hoch-/tiefgestelltem Text, Rubi-Text und groBeren Schriftgraden bei
Bedarf vergrofRert werden soll, deaktivieren Sie die Option Fest.

3) Klicken Sie auf Anwenden.

Horizontalen Abstand anpassen

Beim Fiillen einer Textzeile wird der Abstand zwischen den Zeichen in FrameMaker entsprechend den
Unterschneidungs- und Verteilungseinstellungen angepasst. Der Wortabstand basiert auf den folgenden
Werten, die als Teil des Absatzstils gespeichert werden:

J Der minimale Abstand gibt den kleinsten zuldssigen Wortabstand an.

J Der maximale Abstand gibt den groRRten zuldssigen Wortabstand an, bevor FrameMaker versucht,
eine Silbentrennung durchzufiihren oder in Absatzen mit Blocksatz den Buchstabenabstand zu
vergroRern.

] Der optimaleAbstand ist der Abstand, den FrameMaker zu erreichen versucht.
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Diese Werte werden in Prozent des Standardleerzeichens der Standardschrift eines Absatzes angegeben.
Werte unter 100 % fiihren zu einem kleineren Abstand, dhnlich wie beim Blocksatz. Werte tGber 100 %
flihren zu einem grofReren Abstand mit einem ungleichmaRigen rechten Rand.

1) Umden Abstand zwischen Wortern anzupassen, klicken Sie auf einen Absatz oder wahlen Sie
mehrere Absatze aus, deren Abstand Sie andern mochten.

2) Zeigen Sie im Dialogfeld Absatzgestaltung die Eigenschaften unter Erweitert an, und geben Sie die
Werte fir den minimalen, maximalen und optimalen Wortabstand ein.

3) Klicken Sie auf Anwenden.

HINWEIS: Bei Textzeilen in einem Absatz mit Blocksatz kann der maximale Wortabstand Giber-
schritten werden, wenn in FrameMaker ein Wort nicht in eine Zeile passt und es nicht getrennt
werden kann. Sie kdnnen dies verhindern, indem Sie unter ,, Wortabstand” mit der Option ,Autom-
atisch sperren” das automatische VergroRern des Zeichenabstands aktivieren.

4) Um Unterschneidung oder Abstand anzuwenden, wahlen Sie in der Zeichengestaltung Unter-
schneiden oder definieren einen Wert im Feld Abstand.

Anpassen des Abstands in japanischen Dokumenten

In diesem Thema

J Einfiihrung
J Anpassen des Abstands von Zeichen und Interpunktionszeichen
J Anpassen von GréfSe, Platzierung und Abstand von Rubi-Text

Einflihrung
Wenn |hr System die Eingabe von japanischem Text in Dokumente und Dialogfeld unterstitzt, kbnnen

Sie die folgenden Abstandseigenschaften anpassen:

J Spezielle Eigenschaftengruppe im Dialogfeld Absatzgestaltung, die bestimmte Aspekte des japa-
nischen Zeichenabstands steuert.

o GroRe, Abstand und Ausrichtung von Rubi-Text im gesamten Dokument.

. Abstand von japanischen Zeichen unterschiedlicher Breite durch die Auswahl der Schrifteigen-
schaft Tsume.

Anpassen des Abstands von Zeichen und Interpunktionszeichen

Um den Abstand um Zeichen und Satzzeichen in japanischen Inhalten anzupassen, 6ffnen Sie die Absa-
tzgestaltung und zeigen die Registerkarte Eigenschaften asiatischer Schriftarten an an. Fiihren Sie eine
der folgenden Aktionen durch:

J Wenn Sie den Abstand zwischen japanischen und westlichen (lateinischen) Zeichen anpassen
mochten, verwenden Sie die obere Gruppe von Feldern; wenn Sie den Abstand zwischen japa-
nischen Zeichen anpassen mochten, verwenden Sie die untere Gruppe von Feldern. Geben Sie den
minimalen, maximalen und optimalen Prozentsatz ein.

. Legen Sie den Abstand zwischen den Zeichen und speziellen Interpunktionszeichen (Yakumono)
fest, indem Sie einen Eintrag in der Dropdown-Liste Interpunktion wahlen.
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Komprimieren, falls erforderlich bedeutet, dass der Abstand um Interpunktionszeichen nur verrin-
gert wird, wenn eine spezielle Behandlung von Interpunktionszeichen durchgefiihrt wird (Kinsoku
Shori).

Die Option Nie komprimieren legt fest, dass der Abstand um Interpunktionszeichen nicht angepasst
wird.

Mit Immer komprimieren kénnen Sie festlegen, dass der Abstand um Interpunktionszeichen immer
verringert wird.

Damit japanischer Text so aussieht wie bei Verwendung einer Schriftart mit fester Zeichenbreite,
mussen Sie Nie komprimieren in der Dropdown-Liste Interpunktion wahlen und die Option Tsume
deaktivieren.

Anpassen von GréfSe, Platzierung und Abstand von Rubi-Text

Rubi-Text besteht aus kleinen Zeichen (in der Regel Kana), die oberhalb eines anderen Textes mit der
Bezeichnung Oyamoji erscheinen. Diese Einstellungen wirken sich auf den Rubi-Text im gesamten Doku-
ment aus.

1)

2)

3)

4)

Wahlen Sie im Dialogfeld Format > Dokument > Rubi-Einstellungen einen Wert aus der Drop-
down-Liste GroBe aus oder geben einen Wert in das Feld ein. Der Wert kann in Prozent des Schrift-
grades der Oyamoji-Zeichen, als Schriftgrad oder in einer beliebigen anderen Malieinheit
(einschlieflich Q-Einheiten) angegeben werden.

Flhren Sie eine der folgenden Aktionen durch:

- Damit Rubi-Text Nicht-Oyamoji-Text tiberdecken kann, wahlen Sie Rubi lGiber die Hira-
gana-Umgebung hiangen lassen.

- Um Leerzeichen vor oder hinter Rubi-Text zu entfernen, wenn dieser sich am Anfang oder
Ende einer Zeile befindet, klicken Sie auf Alle Zeichen an Zeilengrenzen ausrichten.

Klicken Sie auf eine Option unter Rubi-Ausrichtung fiir japanische Oyamoji-Zeichen oder
Rubi-Ausrichtung fiir andere Oyamoji-Zeichen. In der Abbildungen im Dialogfeld wird angezeigt,
welcher Abstand und welche Ausrichtung fir den Rubi-Text verwendet wird, wenn er sich oberhalb
von japanischen oder nicht-japanischen Zeichen befindet und wenn er langer oder kirzer als der
darunter liegende Text ist.

Klicken Sie auf Festlegen.
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Listen und automatische Nummerierung

Erfahren Sie, wie Sie in Adobe FrameMaker Listen erstellen, die automatische Nummerierung markieren
und Symbole verwenden. Lernen Sie Buchkomponenten-Nummerierung, japanische Nummerierungsop-
tionen und RTL-Nummerierungsoptionen kennen.

Sie erstellen nummerierte Listen und Listen mit Auszeichnungspunkten, indem Sie Absatzstile
verwenden, in denen eine automatische Nummerierung definiert ist. Beim Hinzufligen von Absatzen mit
automatischer Nummerierung werden diese in FrameMaker automatisch nummeriert; bereits vorhan-
dene Absatze werden ggf. neu nummeriert.

Absdtze mit automatischer Nummerierung werden in einem Textfluss durchgehend nummeriert. Wenn
Ihr Dokument mehrere Textflisse enthalt, erfolgt die automatische Nummerierung in jedem Textfluss
unabhangig von den anderen Textfllssen.

Die automatische Nummerierung wird mit der Eigenschaftengruppe ,Nummerierung” im Dialogfeld
»Absatzgestaltung” durchgefiihrt. Ein Format der automatischen Nummerierung muss keine Absatznum-
merierung beinhalten. Wenn das Format ohne Bausteine verwendet wird, kdnnen mit ihm auf einfache
Weise automatischer Text oder Symbole eingefligt werden. Ein Format der automatischen
Nummerierung kann eine Serienbezeichnung, einen Zahler, Tabulatoren und beliebigen zusatzlichen
Text enthalten.

Serienbezeichnung

Serienbezeichnungen geben verschiedene Arten von Nummerierungsserien in demselben Textfluss
an. Wenn Sie beispielsweise Abbildungen unabhingig von Tabellen oder Uberschriften nummeri-
eren méchten, verwenden Sie einfach mehrere Serien fiir jedes Formatierungselement (Uber-
schriften, Abbildungen und Tabellen).

Tabellen- und Abbildungsnummern missen jedoch zu derselben Serie gehdren, um auf
Abschnittsnummern zu basieren.

Zdhler

Ein Zahler ist ein Platzhalter (Baustein), der in FrameMaker durch eine Ziffer oder einen Buchstaben
ersetzt wird. So erhoht beispielsweise der Zahler <n+> die Absatznummer um 1. Ist der Absatz der
zweite in einer Serie, wird <n+> in FrameMaker durch die Zahl 2 ersetzt. Sie kdnnen in einem

Format auch mehrere Zahler verwenden. Sie kdnnen in einem Format mehrere Zahler verwenden.

Sie kdnnen in ein Format auch Bausteine fir Kapitel <$chapnum> und Band <$volnum>
einfligen.
Tabulatoren, Text und Interpunktion

Ein Format der automatischen Nummerierung kann auch Tabulatoren, Auszeichnungspunkte, Leer-
zeichen und Interpunktionszeichen enthalten.
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Formatieren von Text als nummerierte Liste

Das Erstellen einer nummerierten Liste erfordert manchmal das Formatieren des ersten Elements in der
Liste mit einem Absatzstil, der den Zahler auf 1 zuriicksetzt. AnschlieRend kdnnen die weiteren Elemente
mit einem anderen Stil formatiert werden, mit dem der Zahler heraufgesetzt wird. So kénnen Sie z. B.
dem ersten Listenelement das Format ,,Schritt1“ zuweisen und auf alle weitere Listenelemente das
Format ,SchrittNachster” anwenden. Die Vorlage definiert auch manchmal Formate in einer Weise, dass
ein einzelnes Format auf alle Elemente einer nummerierten Liste angewendet werden kann.

1) Zeigen Sie die Eigenschaften flir die Nummerierung der Absatzgestaltung an, und geben Sie in das
Feld Format eine Serienbezeichnung ein, wenn in dem Dokument mehrere automatische
Nummerierungsserien verwendet werden sollen.

Eine Serienbezeichnung besteht aus einem einzelnen druckbaren Zeichen und einem Doppelpunkt
(z. B. S:). Wenn eine Serienbezeichnung verwendet wird, muss sie am Anfang des Stilnamens ange-
geben werden.

2)  GebenSie beliebigen Text ein, der bei dem Format der automatischen Nummerierung automatisch
angezeigt werden soll. Tabulatoren und Zahler kdnnen mithilfe der Auswahlliste Bausteine ange-
geben werden. Wenn Sie einen Eintrag wahlen, wird er an der Einfiigemarke in das Feld Format der
automatischen Nummerierung eingefiigt.

3)  Wahlen Sie im Popupmenii Zeichenstil einen Zeichenstil fir die automatische Nummerierung.
Wenn Sie kein Format angeben, wird die Zahl in der Standardschrift des Absatzes angezeigt.

4) Wahlen Sie in der Dropdown-Liste Position eine Position fiir die automatische Nummerierung. Bei
der automatischen Nummerierung wird die Zahl selten am Absatzende angezeigt. Eine Ausnahme
sind Gleichungsformate.

5)  Klicken Sie auf Anwenden.

6) Wenn Siein Schritt 2 einen Tabulator (\ t) eingefiigt haben, legen Sie einen zugehdrigen Tabulator-
stopp fur den Absatzstil auf der Registerkarte Basis der Absatzgestaltung fest.

Formatieren von Text als Liste mit Auszeichnungspunkten

Neben dem normalen Auszeichnungspunkt, der in allen Schriften vorhanden ist, konnen Sie alle Zeichen
der installierten Schriften verwenden (einschlielich der Dingbat-Schriften wie Zapf Dingbats®).

1) Klicken Sie in einem einzelnen Absatz oder wahlen Sie aufeinander folgende Abséatze aus, die als
Liste mit Auszeichnungspunkten angezeigt werden sollen.

2) Zeigen Sie in der Absatzgestaltung die Eigenschaften fiir die Nummerierung an, und klicken Sie auf
die Auszeichnungs- und Tabulatorsymbole (\b und \ t) in der Auswahlliste Bausteine.

3) Klicken Sie auf Anwenden.

4)  Wenn Sie in Schritt 2 einen Tabulator (\ t) eingefligt haben, miissen Sie den zugehdrigen Tabula-
torstopp flir den Absatzstil festlegen.

Angeben eines speziellen Auszeichnungssymbols

Vor dem Angeben eines speziellen Auszeichnungssymbol missen Sie einen Zeichenstil mit der Schrift
erstellen, die das gewiinschte Auszeichnungssymbol enthdlt. Wenn beispielsweise Zapf Dingbats mit
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Schriftgrad 9 verwendet werden soll, erstellen Sie einen Zeichenstil mit dieser Schrift. Geben Sie dem
Format einen beschreibenden Namen (z. B. AuszSchrift).

1)  ZeigenSieim Dialogfeld , Absatzgestaltung” die Eigenschaften der Nummerierung an und geben Sie
in das Feld ,,Format der automatischen Nummerierung” das dem gewiinschten Auszeich-
nungssymbol entsprechende Zeichen ein.

Wenn Sie beispielsweise ein Zapf Dingbats-Quadrat verwenden méchten, geben Sie den Kleinbuch-
staben n ein, der in dieser Schrift als ? angezeigt wird. Das Zeichen, das dem von lhnen gewiinschten
Auszeichnungssymbol entspricht, finden Sie, indem Sie sich den Zeichensatz der entsprechenden
Schrift ansehen.

2) Klicken Sie in der Auswabhlliste ,,Bausteine” auf das Tabulatorsymbol (\t), oder geben Sie Leerze-
ichen ein.

HINWEIS: Manche Zeichen, wie umbruchgeschiitzte Leerzeichen und m-Leerzeichen, miissen gege-
benenfalls mithilfe spezieller Codes eingegeben werden.

3)  Klicken Sie in der Dropdown-Liste Zeichenstil auf den zuvor erstellten Auszeichnungssymbol-Stil.
4) Klicken Sie auf Anwenden.

Entfernen von automatischer Nummerierung oder von Auszeichnungspunkten aus Absatzen

1) Deaktivieren Sie das Format der automatischen Nummerierung in den Eigenschaften fiir die
Nummerierung der Absatzgestaltung. Klicken Sie zweimal auf die Option, um die Einstellung zu
deaktivieren, denn beim ersten Klicken wird der Wert zu Beibehalten gedandert.

2)  Klicken Sie auf Anwenden.

Zahler in Formaten der automatischen Nummerierung

Ein Zdhler besteht aus spitzen Klammern (< >), in die ein Anzeigestil und ein Inkrementierungswert
eingeschlossen sind. Die Funktion zur benutzerdefinierten automatischen Nummerierung unterstiitzt
den Unicode-Standard zur Textcodierung.

A. Anzeigestil B. Inkrementierungswert

Um den Anzeigestil anzugeben, verwenden Sie einen Zahler mit einem der folgenden Buchstaben.

Nummerierungsart Waihlen Sie
Numerisch (1, 2, 3, ...) n
Rémisch, klein (i, ii, iii, iv, ...) r
Romisch, groR (1, 11, 111, 1V, ...) R
Alphabetisch, klein (a, b, c, ..., aa) a
Alphabetisch, groR (A, B, C, ..., AA) A
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Um anzuzeigen, wie die Nummer erh6ht wird, verwenden Sie einen Zahler mit einem Inkrementierung-
swert.

Funktion Wabhlen Sie
Beibehalten des Wertes <n>
Setzen des Wertes auf 1 oder auf eine beliebige Zahl, die Sie nach dem <n=1>
Gleichheitszeichen eingeben.
Erhéhen des Zdhlers um 1 <n+>
Beibehalten des Wertes, ohne ihn anzuzeigen < >
Zuricksetzen auf 0 (oder eine andere Zahl), ohne den Wert anzuzeigen < =0>

StandardmaRig wird jeder Zahler zunachst auf null gesetzt. Der aktuelle Wert des Zahlers kann beibe-
halten, um 1 erh6ht oder auf einen anderen Wert gesetzt werden. Verwenden Sie beispielsweise <n=1>
in dem Format, das die Nummerierung am Anfang einer Gruppe von nummerierten Arbeitsschritten
auf 1 zuricksetzt.

Wenn ein Wert beibehalten werden soll, ohne dass er angezeigt wird, geben Sie zwischen den spitzen
Klammern ein Leerzeichen ein. Wenn Sie das Leerzeichen weglassen, werden die Klammern als Bestand-
teil des Formats der automatischen Nummerierung angezeigt.

Basieren der automatischen Nummerierung auf Buchkomponentennummern

Sie kdnnen die Bausteine <Svolnum>, <Schapnum>, <Ssectionnum> oder <Ssubsectionnum> in Absatz-
stile einfligen. Die Buchkomponentennummern werden anhand der Einstellungen im Dialogfeld ,Eigen-
schaften fiir Nummerierung” definiert.

Beispiel Nummerierungsformat

Band 3 Band <$volnum>
Kapitel 3 Kapitel <S$chapnum>

In der folgenden Tabelle wird dargestellt, wie Sie den Kapitel-Baustein mit anderen Bausteinen
kombinieren kénnen.

Beispiel Nummerierungsformat
Abschnitt 1.1 S:Abschnitt <$chapnum>.<n+><=0>
Abschnitt 1.1.1 S:Abschnitt <Schapnum>.
Abbildung 1-1 <n>.<n+>
Tabelle 1-1 F:Abbildung <$chapnum>-<n+>
T:Tabelle <Schapnum>-<n+>
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Basieren der automatischen Nummerierung auf Abschnittsnummern

Tabellen- und Abbildungsnummern miissen sich alle in derselben Serie fiir die automatische
Nummerierung in Absatzen befinden, wie in der folgenden Tabelle dargestellt:

Abschnittsnummer Abbildung Tabelle
Abschnitt 1 Abbildung 1-1 Tabelle 1-1
1.1 Abbildung 1-2 Tabelle 1-2
1.2
Abschnitt 2 Abbildung 2-1 Tabelle 2-1
2.1 Abbildung 2-2 Tabelle 2-2
2.2

Um diese Art der Nummerierung durchzufiihren, missen Sie Formate der automatischen Nummerierung
in einer einzigen Serie und mit der gleichen Serienbezeichnung fir jedes Format erstellen. In der
folgenden Tabelle sind mogliche Formate der automatischen Nummerierung aufgefiihrt. Die Darstellung
erfolgt in tabellarischer Form, damit Sie die Position der Zahler in der Zeichenfolge deutlich erkennen

konnen. Die Zahlerposition bestimmt, wie der Zahler erhéht wird.

Nummerierun
Absatzstil gsformat

AbschnTitel H:Abschnit | <$chapnum> < =0> < =0> < =0>
t

Titell H: <$chapnum> <n+> < > < >

AbbTitel H:Abbildun | <$chapnum> < > -<n+> < >
g

TabTitel H:Tabelle <$chapnum> < > < > -<n+>

Sobald ein Absatz mit dem Stil ,,AbschnTitel” auftritt, erhoht sich die Abschnittsnummer um 1 und die
verbleibenden Zahlerwerte werden auf 0 zuriickgesetzt. Die <n+>-Zahler in den verbleibenden
Formaten beziehen sich auf einen anderen Elementtyp und werden daher unabhangig voneinander
erhoht.

Die < >-Zahler verhindern, dass FrameMaker Werte auf null zuriicksetzt.
Verwenden von mehreren Zahlern in einem Format der automatischen Nummerierung

Ein Format der automatischen Nummerierung kann mehrere Zahler enthalten. Beispielsweise sind zwei
Zahler fur die Nummerierung von Abschnitts- und Unterabschnittstiteln moglich.

Zahler Format Anzeige

<$chapnum>.<n=0> Titell 1.0
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Zahler Format Anzeige
<$chapnum>.<n+> Titel2 11
<$chapnum>.<n+> Titel2 1.2
<$chapnum>.<n=0> Titell 2.0

Die beiden Zahler mit ihrem jeweiligen Format werden unabhangig voneinander gefiihrt. Die Position
eines Zahlers in der Zeichenfolge bestimmt, wie er angezeigt und erhoht wird. Beim Erhdhen eines
Zahlers legt FrameMaker den Wert im entsprechenden Zahler des vorhergehenden, automatisch
nummerierten Absatzes im selben Textfluss zugrunde.

Das folgende Beispiel enthadlt mehrere Zahler in Abschnitts- und Unterabschnittstiteln. Der Zahler vor
dem Punkt wird unabhangig vom Zahler nach dem Punkt erhoht.

Beispiel Nummerierungsformat Tag
1.0 Erste Schritte <n+>.<n=0>\t Uberschriftl
1.1 Installation <n>.<n+>\t Uberschrift2
1.2 Sicherung <n>.<n+>\t Uberschrift2
1.2.1 Fehler <n>.<n>.<n+>\t Uberschrift3
1.3 Dateneingabe <n>.<n+>\t Uberschrift2

Das folgende Beispiel enthalt Formate der automatischen Nummerie

rung im Gliederungsstil.

Beispiel Nummerierungsformat Tag
| Erste Schritte <R+>< =0>\t Uberschriftl
A Installieren < ><A+>\t Uberschrift2
B Sicherung < ><A+>\t Uberschrift2
Il Dateineingabe <R+>< =0>\t Uberschriftl
A Datei 6ffnen < ><A+>\t Uberschrift2
B Datei speichern < ><A+>\t Uberschrift2

Die automatische Nummerierung in der Uberschrift Datei 6ffnen beginnt wieder bei A. Der zweite Zihler
im Format des vorherigen Abschnitts setzt die Nummerierung auf null zurlick (ohne dies anzuzeigen),
somit erhoht <A+> den Zahler auf 1 oder A.

Der Zdhler < > im Format von Uberschrift2 behilt den Wert des ersten Z&hlers bei, zeigt ihn aber nicht
an. Befindet sich der Zahler < > nicht an dieser Position, bezieht sich <A+> im Format ,Titel2” auf den
ersten Zahler (nicht auf den zweiten). Dies fihrt in FrameMaker zu folgender Anzeige:
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Figure 1:

e s P —

I Getting started
B Installing the product
C Backing up the files
IV  Entering data
E Opening a file
~ F Saving afile

—

Zuriicksetzen einer Serie fiir die automatische Nummerierung

-

Ungtiltiges Format der automatischen Nummerierung im Gliederungsstil

Einige Nummerierungsserien (z. B. Listen mit nummerierten Arbeitsschritten) beginnen immer wieder
bei 1. Sie kénnen solche Serien auf zwei Arten zurlicksetzen.

In dem ersten Beispiel wird gezeigt, wie Sie festlegen kénnen, dass die Nummerierung einer Serie von
vorn beginnt, indem Sie den Baustein <n=1> fir den ersten Arbeitsschritt und den Baustein <n+> fir
nachfolgende Arbeitsschritte verwenden.

Beispiel Nummerierungsformat Tag

Schrittl. Entpacken. S:Schritt <n=1>.\t Schrittl
Schritt2. Sicherungskopie S:Schritt <n+>. NachsterSchritt
anfertigen. \t NachsterSchritt
Schritt3. Installieren. S:Schritt <n+>. Schrittl
Schrittl. Datei speichern. \t

S:Schritt <n=1>.

\t

In dem zweiten Beispiel wird eine weitere Moglichkeit dargestellt, wie Sie den Zahler so zurlickzusetzen
konnen, dass Sie kein eigenes Format verwenden missen, wenn eine nummerierte Liste angefangen
werden soll. Stattdessen verwendet der Absatz vor der Liste ein Format, das den Zahler zuriicksetzt.

Beispiel

Nummerierungsformat

Tag

So installieren Sie die Software:
Schritt 1. Entpacken.

Schritt2. Sicherungskopie
anfertigen.

Schritt3. Installieren.

S:< =0>
S:Schritt <n+>.\t
S:Schritt <n+>.
\t

S:Schritt <n+>.
\t

SchrittAnfang
Schritt
Schritt
Schritt

Der Zdhler < =0> im Format ,,SchrittAnfang” setzt die Serie S auf null zuriick, zeigt den Wert aber nicht

an.

Wenn ein Zahler erhdht wird, werden alle nicht angegebenen Zahler der Serie, die sich rechts von diesem
befinden, auf null zuriickgesetzt. Die folgenden Nummerierungsformate sind beispielsweise gleich-

wertig:
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S:<n+>< =0>\t
S:<n+>\t
Japanische Nummerierungsoptionen

Folgende Zahler in Formaten der automatischen Nummerierung sind in japanischem Text und mit japa-
nischen Schriften zulassig.

Baustein Bedeutung Zeichensortierung
<zenkaku a> Romisches Alphabet, A b, e doe f g b0
Kleinbuchstaben fester Breite R L L
<zenkaku A> Rémisches Alphabet, A B CDEF G H T
GroRRbuchstaben fester Breite R B
<zenkaku n> Arabische Ziffern fester Breite 0 12545 6 7n
<kanji kazu> Kanji-Standardnummerierung - Cmon
, bei der zweistellige Zahlen R s

aus den herkdmmlichen
Kanji-Zeichen fiir zehn,
hundert usw. bestehen

<kanji n> Zahlen fir Hausnummern, S
Telefonnummern, Postleitzahl k. —Q.
usw., bei denen zweistellige
Zahlen aus den Kanji-Zeichen
fur null bis neun bestehen

<daiji> Zahlen fur kaufmannische O & & & W& E A
Aufgaben, die aus den alten h, B, BE-
Kanji-Ziffern bestehen

<hira gojuon> Hiragana-Zeichen in der e
Standardreihenfolge S

<kata gojuon> Katakana-Zeichen in der e
Standardreihenfolge b :

<hira iroha> Hiragana-Zeichen in der a
literalen Reihenfolge (selten) gl
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Baustein

Bedeutung

Zeichensortierung

<kata iroha>

Katakana-Zeichen in der
literalen Reihenfolge (selten)

Rechts-nach-Links-Nummerierungsoptionen

Die folgenden Zahler in Formaten der automatischen Nummerierung sind in Rechts-nach-Links-Sprachen
wie Arabisch, Hebraisch und Farsi zulassig. Weitere Informationen zu Formaten finden Sie unter Zdhler
in Formaten der automatischen Nummerierung.

Fiir das Farsi-Sprachskript

. <Farsi n>

. <Farsi n=1>
. <Farsi n+>
. <Farsi a>

. <Farsi a=1>
. <Farsi a+>

Fiir das Hebrdisch-Sprachskript

. <Hebrew n>

. <Hebrew n=1>
. <Hebrew n+>
. <Hebrew a>

. <Hebrew a=1>
. <Hebrew a+>

Fiir das Arabisch-Sprachskript

. <Alif Ba Ta n>

. <Alif Ba Ta n=1>
. <Alif Ba Ta n+>
J <Abjad n>

J <Abjad n=1>

J <Abjad n+>

. <Indic n>

. <Indic n=1>

. <Indic n+>
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ARBEITS-, VORGABE- UND REFERENZSEITEN

Arbeits-, Vorgabe- und Referenzseiten

Lernen Sie Arbeits-, Vorgabe- und Referenzseiten in Adobe FrameMaker und deren Verwendung kennen.
Erfahren Sie, was Vorlagentextrahmen, Hintergrundtextrahmen und Referenzrahmen sind.

FrameMaker-Dokumente enthalten drei Arten von Seiten, mit deren Hilfe Sie Ihr Seitenlayout einrichten
kénnen:
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A. Vorgabeseite: erste Seite und Seite rechts B. Arbeitsseiten: erste Seite des Kapitels und rechte Seite
C. Referenzseite

. Arbeitsseiten enthalten den Hintergrundtext und Grafiken der zugehdrigen Vorgabeseite sowie
den Inhalt des Dokuments.

. Vorgabeseiten geben das Seitenlayout und den Hintergrundtext fiir Arbeitsseiten an (z. B. Kopf-
und FuBzeilen).

] Referenzseiten konnen haufig verwendete Grafiken, Formatierungsinformationen, Hypertextbe-
fehle, Zuordnungen fiir die HTML-Konvertierung und Mustergrafiken enthalten.
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Vorgabeseiten

Lernen Sie Vorgabeseiten in Adobe FrameMaker und deren Verwendung kennen. Erfahren Sie, was
Vorlagentextrahmen und Hintergrundtextrahmen sind.

FrameMaker verwendet Vorgabeseiten, um das Seitenlayout eines Dokuments zu verwalten. Ein doppel-
seitiges Dokument besitzt mindestens zwei Vorgabeseiten: eine fiir die rechte und eine fiir die linke
Seite. Fiir ein einseitiges Dokument wird dagegen nur die rechte Vorgabeseite benotigt. Dokumente
kénnen auch spezielle Vorgabeseiten fiir bestimmte Seitenarten enthalten. AuRerdem besteht die
Moglichkeit, Layouts fiir eine einmalige Verwendung direkt auf den Arbeitsseiten zudefinieren.

Ist das Seitenlayout komplex oder werden Gestaltungselemente wie Kopf- und FuBzeilen bendtigt, arbe-
iten Sie direkt auf den Vorgabeseiten. Sie kénnen an jeder beliebigen Stelle der Vorgabeseite Grafiken
(z. B. Linien, Rechtecke oder Firmenlogos) zeichnen oder importieren und Text eingeben. Grafiken und
Text werden spater auf den Arbeitsseiten als Hintergrund dargestellt und zwar exakt so, wie sie auf der
Vorgabeseite definiert wurden.

CHAPTER

1 B General description

Figure 1:  Vorgabeseiten und Arbeitsseiten

Vorgabeseiten kdnnen zwei Arten von Textrahmen enthalten:

. Ein Vorgabetextrahmen enthalt einen gekennzeichneten Textfluss (d. h. einen Textfluss mit einem
Namen). Wenn Sie eine Arbeitsseite hinzufligen, wird der Vorgabetextrahmen in die neue Arbeits-
seite kopiert. Den Text des Dokuments geben Sie dann in diesen Rahmen auf der Arbeitsseite ein.
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Es ist auch moglich, Text auf der Vorgabeseite in den Vorgabetextrahmen einzugeben. Dieser Text
wird auf den Arbeitsseiten jedoch nicht angezeigt.

. Ein Hintergrundtextrahmen enthilt einen nicht gekennzeichneten Textfluss, d. h. einen Textfluss
ohne einen Namen. Der Inhalt dieses Rahmens wird auf den entsprechenden Arbeitsseiten ange-
zeigt, kann aber nur auf der Vorgabeseite bearbeitet werden. Hintergrundtextrahmen werden
h&ufig zur Definition von Kopf- und FulRzeilen verwendet.

BLURSIMNG HAF 1 4
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Figure 2: Vorgabeseite
A.Hintergrundtextrahmen ohne TagB.

Vorlagetextrahmen

Wenn Sie Text und Abbildungen auf den Arbeitsseiten eines Dokuments hinzufiigen, erstellt
FrameMaker bei Bedarf weitere Arbeitsseiten und verwendet automatisch das Seitenlayout der linken
oder rechten Vorgabeseite.
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Figure 3:  Auf Arbeitsseiten schreiben Sie in einem Textrahmen, der eine Kopie des Vorgabetextrahmens ist.

Spezielle Vorgabeseiten erstellen

Machen Sie sich mit dem Erstellen und Hinzufligen benutzerdefinierter Vorgabeseiten in FrameMaker
vertraut.

In diesem Thema

. Einflihrung
. Erstellen Sie eine leere benutzerdefinierte VVorgabeseite oder eine Seite basierend auf dem Layout
einer anderen Vorgabeseite

J Erstellen einer speziellen VVorgabeseite, die auf dem Layout einer Arbeitsseite basiert

Einfiihrung

Fiir Thre Dokumente bendtigen Sie moglicherweise Arbeitsseiten mit Layouts, die sich von denen der
linken und der rechten Vorgabeseite unterscheiden. Sie konnten z. B. die erste Seite eines Dokuments
anders gestalten oder in ein Dokument im Hochformat eine Seite im Querformat einfligen. Fiir derartige
Falle legen Sie spezielle Vorgabeseiten an. (Ein Dokument kann bis zu 100 Vorgabeseiten enthalten.)

Nach der Erstellung der neuen speziellen Vorgabeseite kénnen Sie ihr Spaltenlayout andern und Hinter-
grundtext und -grafiken hinzufligen. Die spezielle Vorgabeseite kann anschlieRend einer oder mehreren
Arbeitsseiten zugewiesen werden.

Erstellen Sie eine leere benutzerdefinierte Vorgabeseite oder eine Seite basierend auf dem Layout einer
anderen Vorgabeseite

1) Zeigen Sie die Vorgabeseite an, die als Grundlage fiir die neue Vorgabeseite dienen soll.

2)  Wahlen Sie Einfiigen > Vorgabeseite hinzufiigen, und geben Sie den Namen der neuen Vorgabe-
seite in das Feld Name ein.
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3) Fihren Sie eine der folgenden Aktionen aus:

- Wenn Sie fiir die neue Seite das Layout einer vorhandenen Vorgabeseite verwenden
mochten, wahlen Sie die betreffende Vorgabeseite in der Dropdown-Liste Von Vorgabeseite.

- Zur Erstellung einer leeren Vorgabeseite klicken Sie auf Leer.

4)  Klicken Sie auf Hinzufiigen.

Erstellen einer speziellen Vorgabeseite, die auf dem Layout einer Arbeitsseite basiert

1)  Nehmen Sie die gewiinschten Anderungen am Spaltenlayout einer Arbeitsseite vor.
2)  Zeigen Sie die Arbeitsseite an, und wahlen Sie Format > Seitenlayout > Neue Vorgabeseite.
3) Geben Sie den Namen der neuen Vorgabeseite ein und klicken Sie auf Erstellen.

RELATED LINKS:
Zuweisen von Vorgabeseiten zu Arbeitsseiten

Neuordnen spezieller Vorgabeseiten

Erfahren Sie, wie Sie Vorgabeseiten in Adobe FrameMaker neu anordnen.
Beim Neuordnen von speziellen Vorgabeseiten bleiben die Vorgabeseiten ,,Rechts” und , Links” immer
am Anfang.

1)  Offnen Sie eine Vorgabeseite, und wihlen Sie dann Format > Seitenlayout > Spezielle Vorgabe-
seiten neu ordnen.

2)  Wabhlen Sie in der Liste Spezielle Vorgabeseiten eine Vorgabeseite und klicken Sie auf Nach oben
bewegen oder Nach unten bewegen, um die Seiten entsprechend zu verschieben.

3) Klicken Sie auf Festlegen. Wenn Sie zuvor eine spezielle Vorgabeseite angezeigt hatten, wird nun
moglicherweise eine andere angezeigt.

Drehen einer Vorgabeseite

Erfahren Sie, wie Vorgabeseiten in Adobe FrameMaker gedreht werden.

Sie kdnnen eine spezielle Vorgabeseite erstellen, um die Ausrichtung einer Arbeitsseite zu andern. Eine
gedrehte Ausrichtung kann z. B. fiir eine Arbeitsseite mit einer sehr breiten Tabelle erforderlich sein.

~
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Figure 4: Die rechte Seite verwendet eine gedrehte Vorgabeseite.

1) Definieren Sie auf der neuen Vorgabeseite alle Textrahmen, Hintergrundtexte und Grafiken, die
dieselbe Ausrichtung (nicht gedreht) besitzen sollen wie die Kopf- und FuRzeilen auf den anderen
Vorgabeseiten.

2)  Wahlen Sie einen der Befehle unter Format > Spezielles Layout > Seite drehen. Wenn FrameMaker
die Seite dreht, ist wahrscheinlich ein Teil der Seite nicht mehr sichtbar. Sie kbnnen die Fenster-
grofRe anpassen, um von der Seite so viel wie moglich zu sehen.

3)  Erstellen Sie alle Textrahmen, Hintergrundtexte und -grafiken, die gedreht angezeigt werden
sollen.

Tipp: Sie kdnnen Text direkt in gedrehte Textrahmen eingeben oder deren Drehung aufheben, um die
Eingabe zu beschleunigen. Um die Drehung einer Seite aufzuheben, wahlen Sie Format > Spezielles
Layout > Drehung aufheben. Wenn Sie mit der Eingabe fertig sind, drehen Sie die Seite wieder in die
urspriingliche Lage.

RELATED LINKS:
Hintergrundtextrahmen erstellen und éndern

Loschen einer speziellen Vorgabeseite

Erfahren Sie, wie Sie eine spezielle Vorgabeseite in Adobe FrameMaker I6schen.
Um eine spezielle Vorgabeseite zu |6schen, zeigen Sie die Vorgabeseite an, und wahlen Sie Format >
DokumentSeite |6schen [Name der Vorgabeseite]>.

Hinwels: Die Vorgabeseiten Links und Rechts kdnnen nicht geléscht werden. AuBerdem kénnen die
Vorgabeseiten ,Rechts” und ,Links“ sowie alle momentan mit einer Arbeitsseite verbundenen Vorgabe-
seiten nicht geloscht werden.

Zuweisen von Vorgabeseiten zu Arbeitsseiten

Erfahren Sie, wie Sie in strukturierten und unstrukturierten FrameMaker-Dokumenten Vorgabeseiten
Arbeitsseiten zuweisen.

In diesem Thema

J Einfiihrung

J Zuweisen einer anderen Vorgabeseite

] Zuweisen von Vorlagenseiten zu Seiten mit festgelegten Absatzstilen

. Zuweisen einer Vorlagenseite zu Arbeitsseiten in strukturierten Dokumenten

Einfiihrung

Sie kdnnen einer Arbeitsseite jederzeit eine Vorgabeseite zuweisen. FrameMaker verwendet den
Vorgabetextrahmen der Vorgabeseite fir die Anzeige von Hintergrundtext und -grafiken auf der Arbeit-
sseite.

Esist auch moglich, einer Arbeitsseite keine Vorgabeseite zuzuweisen. Eine derartige Arbeitsseite enthalt
dann weder Kopf- und FuBzeilen noch Hintergrundtext und -grafiken. (Ein eventuell auf der Arbeitsseite
vorhandener Textrahmen wird dadurch nicht beeinflusst.) Wenn z. B. jedes Kapitel eines Buchs eine
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gerade Seitenanzahl enthalten soll, sich aber auf der letzten Seite eines Kapitels kein Haupttext befindet,
weisen Sie dieser Seite keine Vorgabeseite zu, damit sie vollstandig leer bleibt.

Zuweisen einer anderen Vorgabeseite

1)  Wahlen Sie bei angezeigter Arbeitsseite Format > Seitenlayout > Vorgabeseite zuweisen.
2)  Fihren Sie im Bereich Vorgabeseite eine der folgenden Aktionen aus:

- Um die linke oder rechte Vorgabeseite zuzuweisen, klicken Sie auf Rechts (in einem
einseitigen Dokument) bzw. auf Rechts/Links (in einem doppelseitigen Dokument).

- Um eine spezielle Vorgabeseite zuzuweisen, wahlen Sie den Namen der Seite in der Drop-
down-Liste Spezial.
- Um keine Vorgabeseite zuzuweisen, wahlen Sie Keine aus der Dropdown-Liste Spezial.

3)  Fuhren Sie unter Anwenden auf eine der folgenden Aktionen aus:
- Um die Anderung auf die aktuelle Arbeitsseite anzuwenden, klicken Sie auf Aktuelle Seite.

- Wenn die Anderung auf einen Seitenbereich angewendet werden soll, geben Sie die Nummer
der ersten und der letzten Seite des Bereichs in die Felder Seiten ein.

- Wenn die Anderungen nur auf die geraden oder ungeraden Seiten innerhalb eines Bereichs
angewendet werden sollen, wahlen Sie Gerade bzw. Ungerade.

- Um die Anderungen nur auf Seiten in einem Bereich anzuwenden, die aktuell eine bestimmte
Vorgabeseite verwenden, wahlen Sie die betreffende Seite in der Dropdown-Liste im Bereich
Anwenden auf aus.

4)  Klicken Sie auf Anwenden.

HINWEIS: Wenn die Vorgabeseite einen Vorlagentextfluss enthalt, der sich nicht auf der Arbeitsseite
befindet, fligt FrameMaker der Arbeitsseite die Textrahmen hinzu, die den Textfluss enthalten. Enthalt
die Arbeitsseite einen Textfluss, der nicht auf der Vorgabeseite definiert ist, behalt FrameMaker die
Textrahmen mit diesem Textfluss unverandert bei. Dadurch kann es zu einem Uberlappen der
Textrahmen kommen.

Zuweisen von Vorlagenseiten zu Seiten mit festgelegten Absatzstilen

Sie kdnnen Arbeitsseiten mit festgelegten Absatzstilen Vorgabeseiten zuweisen. Sie kénnen beispiels-
weise allen Seiten, die den Absatzstil , Titel” enthalten, eine spezielle Vorgabeseite mit dem Namen
,Erste Seite” zuweisen.

Die Zuordnung der Absatzstile zu den Vorgabeseiten erfolgt unter Verwendung der Zuordnungstabelle
Referenzseiten. Nach der Verwendung des Befehls Vorgabeseiten anwenden wird die Vorgabeseite auf
die Arbeitsseiten angewendet, die den referenzierten Absatzstil enthalten.
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to First Master

Figure 5: In diesem Beispiel wird die Vorgabeseite ,Erste Seite” auf Arbeitsseiten angewendet, die den

Absatzstil , Titel” enthalten.

1)  Wabhlen Sie Ansicht > Referenzseiten.

2)  Klicken Sie auf die Schaltfléiche Néichste Seite, bis die fiinfspaltige Tabelle UnstrukturierteVorgabe-
seitenzuordnung angezeigt wird.

Tiep: Wenn die Zuordnungstabelle nicht in den Referenzseiten angezeigt wird, wahlen Sie Format
> Seitenlayout > Vorgabeseiten anwenden.

3) Geben Sie unter Buchaktualisierung (Ja oder Nein) Ja oder Nein ein, um festzulegen, ob die ange-
gebene Vorgabeseite angewendet wird, wenn Sie in einem Buch Format > Seitenlayout > Vorgabe-
seiten anwenden wahlen.

4)  Fuhren Sie zur Bearbeitung der Zuordnungstabelle folgende Schritte aus:

Geben Sie unter der Tabellentberschrift ,Name des Absatzstils“ den Namen des Absatzstils
ein, auf den die Vorgabeseite angewendet werden soll. Diese Spalte ist erforderlich, damit
Vorgabeseiten angewendet werden konnen. Achten Sie bei der Eingabe des Namens des
Absatzstils auf die richtige Schreibweise einschlieRlich GroR-/Kleinschreibung.

Geben Sie unter der Uberschrift ,Rechte Vorgabeseite” den Namen der Vorgabeseite ein, die
Sie anwenden mochten. Diese Spalte ist erforderlich, damit Vorgabeseiten angewendet
werden kdnnen. Die angegebene Vorgabeseite wird auf alle Arbeitsseiten angewendet,
einschlieRlich der linken Seiten in doppelseitigen Dokumenten, auf denen die Absatzstile
enthalten sind, es sei denn, Sie geben unter , Linke Vorgabeseite” eine andere Vorgabeseite
an. In Namen von Vorgabeseiten wird zwischen Grol3- und Kleinschreibung unterschieden.

Geben Sie unter ,Linke Vorgabeseite” den Namen der Vorgabeseite ein, die in doppelseitigen
Dokumenten auf linke Arbeitsseiten angewendet werden soll, wenn sie die entsprechenden
Absatzstile enthalten. Diese Spalte ist optional.

Geben Sie unter ,,Bereichsindikatoren” Einseitig ein, wenn die Vorgabeseite nur auf die Arbe-
itsseite angewendet werden soll, auf der der Absatzstil vorhanden ist; geben Sie Doppel-
seiten ein, wenn die Vorgabeseite auf den gesamten Bereich der Seiten angewendet werden
soll, auf den der Absatzstil angewendet wird, oder geben Sie Giiltig bis Anderung ein, um die
Vorgabeseite auf alle Seiten anzuwenden, bis in der Zuordnungstabelle die ndachste Vorgabe-
seite mit einem abweichenden Absatzstil erkannt wird. Wenn diese Zelle leer ist, werden die
Vorgabeseiten auf einzelne Seiten angewendet.

Flgen Sie in der Spalte ,Kommentare” Anmerkungen hinzu. In diese Spalte eingetragener
Text wirkt sich nicht auf die Anwendung von Vorgabeseiten aus.
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5)
6)

7)

- Wenn Sie Absatzstilen weitere Vorgabeseiten zuweisen moéchten, miissen Sie zuséatzliche
Tabellenzeilen hinzufligen und ausfillen.

Wahlen Sie abschlieBend Darstellung > Arbeitsseiten.

Bringen Sie das entsprechende Dokument- oder Buchfenster als aktives Fenster in den Vorder-
grund. Wenn ein Buchfenster aktiv ist, wahlen Sie die gewlinschten Dokumente aus.

Wihlen Sie Format > Seitenlayout > Vorgabeseiten anwenden, und klicken Sie dann auf Ja, um die
angewendeten Vorgabeseiten zu Gberschreiben.

Adobe FrameMaker durchsucht alle Arbeitsseiten nach dem ersten Auftreten des in der Tabelle
»,Vorgabeseitenzuordnung” angegebenen Absatzstils. Wenn Text mit dem festgelegten Absatzstil
gefunden wird, wird die angegebene Vorgabeseite angewendet.

Zuweisen einer Vorlagenseite zu Arbeitsseiten in strukturierten Dokumenten

Wenn Sie Arbeitsseiten in strukturierten Dokumenten, die Elemente enthalten, Vorgabeseiten zuweisen
mochten, ordnen Sie die Elemente den Vorgabeseiten mithilfe der Zuordnungstabelle flir Referenzseiten
zu. Wenn Sie Format > Seitenlayout > Vorgabeseiten anwenden wahlen, wird die Vorgabeseite auf die
Arbeitsseite angewendet, die das referenzierte Element enthalt.

1)
2)

3)

Waidhlen Sie im strukturierten FrameMaker Ansicht > Referenzseiten.

Klicken Sie auf die Schaltflache ,,Nachste Seite”, bis die achtspaltige Tabelle StrukturierteVorgabe-
seitenzuordnung angezeigt wird.

Tiepr: Wenn Sie in einem Dokument arbeiten, das mit einer fritheren Version von FrameMaker
erstellt wurde, wahlen Sie Format > Seitenlayout > Vorgabeseiten anwenden, damit die Zuord-
nungstabelle in den Referenzseiten angezeigt wird.

Geben Sie rechts neben ,,Buchaktualisierung (Ja oder Nein)“ Ja oder Nein ein, um festzulegen, ob
die angegebene Vorgabeseite angewendet wird, wenn Sie in einem Buch , Vorgabeseiten
anwenden” wahlen.

Flihren Sie zur Bearbeitung der Zuordnungstabelle folgende Schritte aus:

- Geben Sie unter der Tabellentiberschrift ,,Name des Elements/Absatzstils” ein giltiges Prafix
ein (E: fur Elemente oder P: fiir Absatze), gefolgt vom Namen des Elements oder Absatzstils,
worauf die Vorgabeseite angewendet werden soll. Wenn kein Prafix verwendet wird, wird ein
Element angenommen. Achten Sie bei der Eingabe des Element- oder Absatzstilnamens auf
die richtige Schreibweise, einschlieflich der Grof3- und Kleinschreibung. Diese Spalte ist
erforderlich, damit Vorgabeseiten angewendet werden kénnen.

- Geben Sie unter der Uberschrift ,,Rechte Vorgabeseite” den Namen der Vorgabeseite ein, die
Sie anwenden mochten. Die angegebene Vorgabeseite wird auf alle Arbeitsseiten ange-
wendet, einschlielllich der linken Seiten in doppelseitigen Dokumenten, auf denen die
Elemente oder Absatzstile enthalten sind, es sei denn, Sie geben unter ,Linke Vorgabeseite”
eine andere Vorgabeseite an. In Namen von Vorgabeseiten wird zwischen Grol3- und Kleinsch-
reibung unterschieden. Diese Spalte ist erforderlich, damit Vorgabeseiten angewendet
werden konnen.

- Geben Sie unter,,Linke Vorgabeseite” den Namen der Vorgabeseite ein, die in doppelseitigen
Dokumenten auf linke Arbeitsseiten angewendet werden soll, wenn sie die entsprechenden
Elemente oder Absatzstile enthalten. Diese Spalte ist optional.
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- Geben Sie unter , Attributname” einen giiltigen Attributnamen ein, um den weiteren Zuord-
nungskontext zu definieren.

- Geben Sie unter , Attributwert” einen giltigen Attributwert ein, um den weiteren Zuordnung-
skontext zu definieren.

- Geben Sie unter , Kontext” einen Wert fiir die Kontextbezeichnung eines Elements ein, um
den weiteren Zuordnungskontext zu definieren.

- Geben Sie unter ,Bereichsindikatoren” Einseitig ein, wenn die Vorgabeseite nur auf die Arbe-
itsseite angewendet werden soll, auf der das Element oder der Absatzstil vorhanden ist;
geben Sie Doppelseiten ein, wenn die Vorgabeseite auf den gesamten Bereich der Seiten
angewendet werden soll, auf den das Element oder der Absatzstil angewendet wird, oder
geben Sie Giiltig bis Anderung ein, um die Vorgabeseite auf alle Seiten anzuwenden, bis in der
Zuordnungstabelle die nachste Vorgabeseite mit einem abweichenden Element oder Absatz-
stil erkannt wird. Wenn diese Zelle leer ist, werden die Vorgabeseiten auf einzelne Seiten
angewendet.

- Fligen Sie in der Spalte ,Kommentare” Anmerkungen hinzu. In diese Spalte eingetragener
Text wirkt sich nicht auf die Anwendung von Vorgabeseiten aus.

- Wenn Sie Elementen oder Absatzstilen weitere Vorgabeseiten zuweisen mochten, miissen Sie
zusatzliche Tabellenzeilen hinzufiigen und ausfillen.

5)  Wabhlen Sie Darstellung > Arbeitsseiten.

6) Bringen Sie das entsprechende Dokument- oder Buchfenster als aktives Fenster in den Vorder-
grund. Wenn ein Buchfenster aktiv ist, wahlen Sie die gewilinschten Dokumente aus.

7)  Wahlen Sie Format > Seitenlayout > Vorgabeseiten anwenden, und klicken Sie dann auf Ja, um die
angewendeten Vorgabeseiten zu Gberschreiben.

FrameMaker durchsucht alle Arbeitsseiten nach dem ersten Auftreten des in der Tabelle fir die Vorla-
genseitenzuordnung angegebenen Elements oder Absatzstils. Wenn Text mit dem festgelegten Element
oder Absatzstil gefunden wird, wird die angegebene Vorgabeseite angewendet.

Anzeigen von Vorgabeseiten

Erfahren Sie, wie Sie Vorgabeseiten anzeigen und von einer Vorgabeseite zu Arbeitsseiten zurickkehren.

In diesem Thema

o Einflihrung
o Anzeigen weiterer VVorgabeseiten bei einer bereits auf dem Bildschirm vorhandenen Vorgabeseite
. Wechseln zu Arbeitsseiten bei aktivierten Vorgabeseiten

Einfiihrung

Bei der Arbeit mit Vorgabeseiten miissen Sie zwischen Vorgabe- und Arbeitsseiten wechseln. Wenn eine
Vorgabeseite angezeigt wird, werden ihr Name und die Gesamtzahl der Vorgabeseiten des Dokuments
im Seitenstatus-Bereich der Statuszeile angezeigt.

1 b M| Rightilof2)* o ]| | = wo0%v +
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Figure 6: Seitenstatus-Bereich der Statuszeile

Wahlen SieAnsicht > Vorgabeseiten. Die Vorgabeseite fir die aktuelle Arbeitsseite wird angezeigt. Text-
und Spaltenrahmen sind sichtbar.

Anzeigen weiterer Vorgabeseiten bei einer bereits auf dem Bildschirm vorhandenen Vorgabeseite

. Flihren Sie eine der folgenden Aktionen aus:
- Klicken Sie auf die Schaltflache Nachste Seite oder Vorherige Seite.
- Driicken Sie die Bild-Auf- oder die Bild-Ab-Taste.
—  Verwenden Sie den Rollbalken.

Wechseln zu Arbeitsseiten bei aktivierten Vorgabeseiten

Wahlen Sie Ansicht > Arbeitsseiten. Es wird wieder die Arbeitsseite eingeblendet, die zuletzt angezeigt
wurde. Wenn FrameMaker feststellt, dass eine Arbeitsseite irregulare Layouts enthalt, werden Sie
gefragt, was mit diesen geschehen soll.

RELATED LINKS:
Irreguldre Layouts
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Referenzseiten

Sie konnen Grafiken, die in einem Dokument 6fter verwendet werden, auf Referenzseiten speichern und
sie bei Bedarf spater auf den Arbeitsseiten des Dokuments einfiigen. Nachdem eine Grafik in einen
Referenzrahmen (einen nicht verankerten Rahmen auf einer Referenzseite) platziert wurde, kann der
Rahmen als Eigenschaft eines Absatzstils eingesetzt werden. Um z. B. eine Uberschrift mit einer Linie
darunter zu definieren, zeichnen Sie die Linie in einem Referenzrahmen und nehmen den Referenz-
rahmen in den Absatzstil der Uberschrift auf.

FuBnote

Tabellenfulnote

Gefahr-Baustein

Vorsicht-Baustein

CHAPTER

"iThe section provides general background information about the
vehicle and its fuel systems.
: "History of flight” on page 5
"Overview" on page 7
"Vehicle structure” on page 9

Flight used to depend on an aircraft engine and propeller.
Today's modern Personal Spaceship is ready to go with a hydro-
‘gen and oxygen mix in an external tank and solid rockets for aux-
iliary takeoff power.

GEFAHR!  Dabei handelt es sich um einen Gefahrenhinweis.

¢ Vorsicht Dabei handelt es sich um einen Vorsichtshinweis.

Figure 1:  Referenzseite und Arbeitsseite

Referenzseiten konnen auch Mustergrafiken oder Clipart enthalten, die kopiert und auf Arbeitsseiten
eingefligt werden (z. B. Symbole zur Kennzeichnung von Hinweisen). Spezielle Referenzseiten kénnen
auch Hypertextbefehle, Formatinformationen fiir generierte Listen und Indizes, Definitionen fiir spezielle
FrameMath-Elemente und Zuordnungen fiir die Konvertierung in das XML- und das HTML-Format
enthalten.
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Ein Dokument besitzt normalerweise mindestens eine Referenzseite. Sie konnen Grafiken entweder
einer vorhandenen Referenzseite hinzufligen oder weitere Referenzseiten (maximal 100) anlegen.

Anzeigen, Erstellen und Léschen von Referenzseiten

Erfahren Sie, wie Referenzseiten angezeigt, erstellt und geléscht werden.

In diesem Thema

L Anzeigen von Referenzseiten

. Anzeigen anderer Referenzseiten bei einer bereits eingeblendeten Referenzseite
J Erstellen von Referenzseiten

J Wechseln zu Arbeitsseiten

] Umbenennen oder Loschen von Referenzseiten

Anzeigen von Referenzseiten

Waihlen Sie Ansicht > Referenzseiten. Der Name der aktuellen Referenzseite wird im Seiten-
status-Bereich der Statuszeile angezeigt.

Flow: MasterPageMaps .. | 14 4 b M| MasterPageMa.. W o= w0% v +

Figure 2:  Seitenstatus-Bereich

Falls das Dokument keine Referenzseiten enthdlt, wird das Dialogfeld ,,Referenzseite hinzufiigen” ange-
zeigt. Erstellen Sie die erste Referenzseite, indem Sie einen Seitennamen eingeben und auf , Einfligen”
klicken.

Anzeigen anderer Referenzseiten bei einer bereits eingeblendeten Referenzseite

. Klicken Sie auf die Schaltflaiche Nachste Seitey oder Vorherige Seitey.
o Drucken Sie die Bild-Auf- oder die Bild-Ab-Taste.
o Verwenden Sie den Rollbalken.

Erstellen von Referenzseiten

1) Zeigen Sie Referenzseiten an und wahlen Sie Einfligen > Referenzseite einfiigen.
2)  Geben Sie einen Namen fir die Referenzseite ein und klicken Sie auf Hinzufiigen.

Wechseln zu Arbeitsseiten

Wahlen Sie Ansicht > Arbeitsseiten. Es wird wieder die Arbeitsseite eingeblendet, die zuletzt angezeigt
wurde.

Umbenennen oder Léschen von Referenzseiten

Sie kdnnen eine Referenzseite umbenennen. Wenn Sie z. B. die Referenzseiten aus einer Vorlage in ein
vorhandenes Dokument importieren, kdnnen Sie durch Umbenennen verhindern, dass eine vorhandene
Referenzseite gleichen Namens liberschrieben wird.
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Wenn Sie eine Referenzseite |6schen, die eine in einem Absatzstil verwendete Grafik enthalt, wird die
Grafik in Absatzen mit diesem Stil nicht mehr angezeigt. In diesem Fall wird die Dropdown-Liste Rahmen

tiber bzw. Rahmen unter in den Eigenschaften Erweiterti=der Absatzgestaltung fiir die Absatze auf
Beibehalten eingestellt.

. Rufen Sie die Referenzseite auf und flihren Sie einen der folgenden Schritte aus:

- Um die Seite umzubenennen, klicken Sie in der Statuszeile auf den Seitennamen und geben
Sie den neuen Namen ein. Klicken Sie auf Festlegen.

- Um die Seite zu I6schen, wahlen Sie Format > Dokument > Seite <Name der Referenzseite>
I6schen.

Verwenden von Referenzrahmen auf Referenzseiten

Erfahren Sie, wie Sie Referenzrahmen auf Referenzseiten erstellen und verwenden und Mustergrafiken
auf Referenzseiten einrichten.

In diesem Thema

. Einflihrung

) Erstellen von Referenzrahmen auf einer Referenzseite

. Umbenennen von Referenzrahmen

. Andern anderer Eigenschaften eines Referenzrahmens

. Einrichten von Mustergrafiken auf Referenzseiten

Einfiihrung

Um eine Grafik als Teil eines Absatzstils zu verwenden, platzieren Sie die Grafik auf einer Referenzseite
in einem Referenzrahmen.
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Footnote

TableFootnote

DangerBlock

CautionBlock

The shapes to the left control the way that
buttons in the file look. To change ALL
appearances at once, select one of the
three shapes, then click Graphics >
Object Style Designer, change the Fill >
Color settings and lastly, click Update All
to change the appearances of buttons.

Figure 3:  Grafiken in Referenzrahmen

Nach der Auswahl eines Referenzrahmens auf einer Referenzseite wird sein Name in der Statuszeile nach
dem Wort ,Frame“ eingeblendet.

Erstellen von Referenzrahmen auf einer Referenzseite

1)

2)

3)

4)

Klicken Sie auf das Grafikrahmen-Werkzeug [#8lim Bereich Werkzeuge, und ziehen Sie dann, um den
Rahmen zu zeichnen. Durch Ziehen bei gedriickter Umschalttaste kénnen Sie einen quadratischen
Rahmen zeichnen.

Geben Sie in das Feld ,Name” einen Namen ein und klicken Sie auf Zuweisen. Verwenden Sie einen
kurzen, aussagekraftigen Namen, den Sie spater in den Dropdown-Listen Rahmen iiber und
Rahmen unter in den Eigenschaften Erweitert wiedererkennen kénnen [Eder Absatzgestaltung
wiedererkennen.

Platzieren Sie eine Grafik im Rahmen. Sie kénnen die Grafik zeichnen, eine Grafikdatei importieren
oder gezeichnete und importierte Grafiken kombinieren.

Passen Sie gegebenenfalls die RahmengroBe und -form an. Wenn Sie einen Referenzrahmen liber
oder unter einem Absatz auf einer Arbeitsseite verwenden, wird nicht nur die Grafik, sondern der
gesamte Rahmen auf der Arbeitsseite angezeigt. Die Hohe des Rahmens beeinflusst den Abstand
des Textes (iber und unter dem Rahmen.
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5) Geben Sie mithilfe des Textzeilen-Werkzeugs Giber dem Rahmen den Rahmennamen ein. Der einge-
gebene Name dient der raschen Identifizierung des Rahmens, wenn Sie die Referenzseite anzeigen.
Die Eingabe des Namens flihrt nicht zu einer Umbenennung des Referenzrahmens.

Umbenennen von Referenzrahmen

1)  Wabhlen Sie den Referenzrahmen aus und klicken Sie in der Statuszeile auf den Namen des
Rahmens.

2)  Geben Sie den neuen Namen ein und klicken Sie auf Zuweisen. Sie sollten den neuen Namen auch
in die Textzeile Gber dem Referenzrahmen eingeben. Wenn Sie einen Referenzrahmen
umbenennen, der in einem Absatzstil verwendet wird, miissen Sie das Format aktualisieren, damit
der neue Name verwendet wird.

Andern anderer Eigenschaften eines Referenzrahmens

Wahlen Sie den Rahmen aus. Wahlen Sie Grafik > Objekteigenschaften, um die Objekteigenschaften zu
andern. Alternativ kdnnen Sie die Optionen im Fenster Werkzeuge verwenden.

Einrichten von Mustergrafiken auf Referenzseiten

Sie kdnnen Mustergrafiken (z. B. spezielle Randsymbole) in verankerten Rahmen auf einer Referenzseite
einrichten. Spater konnen Sie die verankerten Rahmen auf die Arbeitsseiten kopieren. Die Grafiken
werden dann an der korrekten Position in ihren verankerten Rahmen angezeigt.

O

= 0 1Caution Symbeol

Hesding

Flgsira

Figure 4: Mustergrafiken kdnnen kopiert und in Arbeitsseiten eingefiigt werden.
Sie kénnen Grafiken auch direkt auf einer Referenzseite platzieren, sie anschlieBend kopieren und an
einer beliebigen Stelle auf Arbeitsseiten einfligen.

1) Legen Sie eine Referenzseite mit dem Spaltenlayout der Arbeitsseite an, in der die Grafik angezeigt
werden soll. Damit stellen Sie sicher, dass die Grafik beim Kopieren in die Arbeitsseiten korrekt
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2)

platziert wird. Um das Spaltenlayout zu definieren, kdnnen Sie den Textrahmen von einer Arbeits-
seite kopieren und auf der Referenzseite einfligen.

Richten Sie den verankerten Rahmen auf der Referenzseite exakt so ein, wie er auf den Arbeitsseiten
dargestellt werden soll.

Zeichnen Sie die Grafik im verankerten Rahmen. Sie kdnnen die Grafik auch in den Rahmen

einflgen oder importieren. Fligen Sie gegebenenfalls beschreibenden Text aullerhalb des
verankerten Rahmens hinzu. Beispielsweise wird in der Abbildung die Grafik durch das Symbol fiir

Achtung beschrieben.
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SEITENLAYOUTS

Seitenlayouts

Erfahren Sie, wie Sie in Adobe FrameMaker Referenzrahmen auf Referenzseiten erstellen und
verwenden und Mustergrafiken auf Referenzseiten einrichten.

Sie kénnen Anderungen am grundlegenden Seitenlayout eines Dokuments direkt auf einer Arbeitsseite
vornehmen. Bei jeder dieser Anderungen aktualisiert FrameMaker automatisch die linke und die rechte
Vorgabeseite und das Layout aller Arbeitsseiten, die diese Vorgabeseiten verwenden. Wenn in diesen
Arbeitsseiten irregulare Layouts enthalten sind, werden Sie aufgefordert, die Aktualisierung zu besta-
tigen.

Falls Ihr Dokument eine weitere Vorgabeseite verwendet (z. B. fiir die erste Seite), miissen Anderungen
am Layout auf dieser Vorgabeseite vorgenommen werden.

Andern des Seitenformats

Erfahren Sie, wie Sie die Grof3e einer Seite in Adobe FrameMaker andern.

1) Bringen Sie das entsprechende Dokument- oder Buchfenster als aktives Fenster in den Vorder-
grund. Wenn ein Buchfenster aktiv ist, wahlen Sie die gewlinschten Dokumente aus.

2)  Waihlen Sie Format > Seitenlayout > SeitengroRe.
3)  Fuhren Sie eine der folgenden Aktionen aus:
- Wahlen Sie ein Standardformat in der Dropdown-Liste Format. In den Feldern Breite und
Hohe werden die korrekten MaRe angezeigt.
- Geben Sie die Malie in die Felder Breite und Héhe ein. Benutzerdefiniert wird in der Drop-

downliste angezeigt. Das angegebene benutzerdefinierte Seitenformat kann je nach den
Randeinstellungen klein, aber auch sehr groR sein (ca. 548 x 548 cm).

4)  Klicken Sie auf Festlegen.

HINWEIS: Wenn Sie die PDF-Ausgabe fir ein Dokument generieren, das groRRer ist als eine A4-Seite,
ist es moglich, dass bestimmte Inhalte nicht auf die Seite passen und daher nicht veroffentlicht
werden konnen. Um den Verlust von Inhalten zu verhindern, missen Sie das Flag
UsePDFResolution=300 in der Dateimaker.ini im Ordner
<%appdata$%\Adobe\FrameMaker\16> hinzufigen. Weitere Informationen zur PDF-Ausgabe
finden Sie unter Generieren einer PDF-Datei.

HINWEIS: Wenn das Dokument benutzerdefinierte Vorgabeseiten enthilt, verhindert FrameMaker den
Wechsel zu einem Seitenformat, das die Textrahmen dieser Vorgabeseiten nicht aufnehmen kann.

Andern des Seitenumbruchs

Erfahren Sie, wie Sie den Seitenumbruch in Adobe FrameMaker festlegen und einseitige Dokumente in
doppelseitige Dokumente dndern oder umgekehrt.
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Sie kdnnen ein einseitiges Dokument in ein doppelseitiges Dokument andern (und umgekehrt). Beim
Definieren eines doppelseitigen Dokuments legen Sie fest, ob die erste Seite eine linke oder eine rechte
Seite ist.

1) Bringen Sie das entsprechende Dokument- oder Buchfenster als aktives Fenster in den Vorder-
grund. Wenn ein Buchfenster aktiv ist, wahlen Sie die gewlinschten Dokumente aus.

2)  Waihlen Sie Format > Seitenlayout > Seitenumbruch.

3) Klicken Sie auf eine der Optionen unter , Seitenumbruch”. Wenn Sie Doppelseitig wahlen, geben Sie
auch an, ob die erste Seite eine linke oder rechte Seite sein soll. Wenn Sie den Seitenumbruch in
einem Buch anwenden, konnen Sie Aus Datei einlesen auswahlen, um die in der Datei angegebene
Seite zu verwenden. Wahlen Sie Nachste verfiigbare Seite aus, um eine leere Seite zu vermeiden.

Je nach gewdhlter Option wird der vorherigen Datei im Buch unter Umsténden eine Leerseite
hinzugefiigt, damit das Dokument auf der angegebenen Seite beginnt.

4)  Klicken Sie auf Festlegen. Wenn das Dokument spezielle Vorgabeseiten oder irregulare Layouts
enthalt, werden Sie gefragt, wie Sie fortfahren mochten.

Hinzufiigen oder Loschen leerer Seiten

Erfahren Sie, wie Sie leere Seiten in Adobe FrameMaker hinzufligen oder I6schen und eine gerade oder
ungerade Anzahl von Seiten angeben.

Sie kénnen festlegen, ob ein Dokument eine gerade oder ungerade Seitenanzahl aufweisen soll. Falls
erforderlich, fligt FrameMaker am Ende des Dokuments eine Leerseite hinzu, um einen korrekten
Seitenumbruch vorzunehmen.

Andererseits konnen durch die Bearbeitung eines Dokuments unerwiinschte Leerseiten am Dokumen-
tende entstehen. Sie kdnnen FrameMaker anweisen, diese Leerseiten bei jedem Speichern oder Drucken
des Dokuments zu l6schen.

FrameMaker l6scht eine leere Seite nur, wenn sie die linke oder rechte Vorgabeseite verwendet und
keinen Textflussbeginn und keine irregularen Layouts enthalt. Eine Seite, die einen leeren Absatz enthilt,
ansonsten aber leer ist, wird von FrameMaker nicht geldscht.

Wenn Sie den Seitenumbruch eines Dokuments, das Teil eines Buchs ist, im Dokumentfenster andern,
werden die Einstellungen moglicherweise Gberschrieben, wenn Sie das Buch aktualisieren. Sie kdnnen
den korrekten Seitenumbruch im Buch sicherstellen, indem Sie die Einstellungen eines Dokuments im
Buchfenster andern.

1) Bringen Sie das entsprechende Dokument- oder Buchfenster als aktives Fenster in den Vorder-
grund. Wenn ein Buchfenster aktiv ist, wahlen Sie die gewlinschten Dokumente aus.

2)  Wabhlen Sie Format > Seitenlayout > Seitenumbruch.

3)  Wahlen Sie in der Dropdown-Liste Vor Speichern & Drucken eine Option aus und klicken Sie auf
Zuweisen.

Wenn die Leerseiten nicht wie erwartet hinzugefiigt oder geldscht werden, sollten Sie sich vergewissern,
dass alle Seiten des Dokuments automatisch verkettet sind.

RELATED LINKS:
Irreguldre Layouts
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Seitenrander und der Spaltenanzahl andern

Legen Sie in Adobe FrameMaker Seitenrander und Anzahl der Spalten fest, erstellen Sie ein mehrspal-
tiges Layout mit ungleichen Spaltenbreiten, richten Sie asymmetrische linke und rechte Rander ein.

Der Rand ist der Abstand zwischen dem Blattrand und dem Textrahmen. Bei einem einseitigen Doku-
ment legen Sie den oberen, unteren, linken und rechten Rand des Textrahmens fest. Bei einem doppel-
seitigen Dokument legen Sie den oberen, unteren, inneren und duReren Rand fest, um ein
symmetrisches Erscheinungsbild zu erzielen.

Um einen asymmetrischen linken und rechten Rand festzulegen, dndern Sie die Textrahmen direkt auf
den Vorgabeseiten. Sie kénnen z. B. die Textrahmen sowohl auf der linken als auch auf der rechten Seite
so anordnen, dass sie jeweils rechts auf der Seite angezeigt werden und links ein breiter Rand bleibt.

Ein Textrahmen kann zwei oder mehr Spalten gleicher Breite enthalten, die durch einen einheitlichen
Abstand voneinander getrennt sind. Wenn Sie ein mehrspaltiges Layout erstellen mdochten, in dem die
Spaltenbreiten und -abstande unterschiedlich sind, verwenden Sie fiir jede Textspalte einen Textrahmen
und ordnen Sie die Textrahmen nacheinander an. Sie kénnen alle Textrahmen zeichnen oder einen
Textrahmen nach lhren Vorstellungen einrichten und ihn dann duplizieren.

1) Platzieren Sie die Einfigemarke im Haupttextfluss, oder klicken Sie in den Seitenrand. Wenn ein
Buchfenster aktiv ist, wahlen Sie die gewlinschten Dokumente aus.

2)  Waihlen Sie Format > Seitenlayout > Spaltenlayout.
Bei einem asymmetrischen Layout (wenn z. B. die Anzahl der Spalten oder der dufSere und innere
Rand auf der linken und der rechten Vorgabeseite nicht identisch sind) werden Sie gefragt, ob Sie
den Vorgang fortsetzen méchten. Wenn Sie das asymmetrische Layout beibehalten méchten, miis-
sen Sie die Anderungen direkt auf den Vorgabeseiten vornehmen.

3) Umdie Rénder zu éndern, geben Sie unter ,,Rdnder” die gewiinschten Werte ein. Die Breite der
einzelnen Spalten ergibt sich aus den Randern und dem Abstand zwischen den Spalten.

4)  Wenn Sie die Anzahl der Spalten oder den Abstand zwischen den Spalten dndern méchten, geben
Sie unter ,Spalten” die neuen Werte ein.

Alle Spalten haben dieselbe Breite und einen einheitlichen Abstand.

5) Klicken Sie auf Gesamten Textfluss aktualisieren. Wenn die neue Spaltenbreite so klein ist, dass
bestimmte verankerte Rahmen oder Tabellen darin keinen Platz mehr finden, werden Sie gefragt,
ob Sie fortfahren mochten. Wenn Sie auf OK klicken, konnen Sie die GroRRe der Tabellen und
Rahmen manuell andern.

RELATED LINKS:
Andern des Seitenlayouts fiir bestimmte Seiten
Vorgabetextrahmen zu einer VVorgabeseite hinzufiigen

Textrahmen auf Arbeitsseiten hinzufiigen

Kopfzeilen, FuBzeilen und sonstiger Hintergrundtext

Richten Sie Kopfzeilen, FuRzeilen und Hintergrundtext ein. Erstellen und andern Sie in Adobe
FrameMaker Hintergrundtextrahmen, dndern Sie die Grof3e eines Hintergrundtextrahmens oder
verschieben Sie ihn.
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In diesem Thema

. Einflihrung

. Hintergrundtextrahmen erstellen und éndern
J Kopf- und Fufizeilentext eingeben

Einfiihrung

Sie erstellen Kopf- und FuRzeilen, indem Sie eine Vorgabeseite anzeigen und den gewiinschten Text in
Hintergrundtextrahmen eingeben. Der Inhalt der Hintergrundtextrahmen wird auf den Arbeitsseiten
angezeigt, Sie konnen ihn aber nur auf den Vorgabeseiten andern. Text- und FulRzeilen kénnen die
Seitennummer, das Datum, die Nummer und den Titel des Kapitels, die Nummer und den Titel des
Abschnitts, den Autor, die Revisionsnummer und die Entwurfsversion (z. B. vorlaufig oder endgiiltig)
enthalten.

Running IWF1 " 6/13/20

Figure 1:  Textrahmen fiir Kopf- und FuBzeilen auf Vorgabeseite

Der Text von Kopf- und FuBzeilen kann wie jeder andere Absatztext bearbeitet werden. Sie kénnen z. B.
Absatz- und Zeichenstile anwenden, Tabulatorstopps einfligen oder entfernen und Grafikelemente wie
z. B. eine Linie Uber oder unter dem Text hinzufligen. AuBerdem ist es moglich, Systemvariablen
einzufligen, um z. B. die Seitennummer oder das aktuelle Datum anzuzeigen. Auch GréRe und Position
der Textrahmen fiir Kopf- und FuBzeilen kdnnen gedndert werden. Wenn Sie diese Textrahmen auf einer
Vorgabeseite dandern, aktualisiert FrameMaker automatisch alle Arbeitsseiten, die diese Vorgabeseite
verwenden.

Sie kdnnen auch anderen Hintergrundtext in eine Vorgabeseite aufnehmen.
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Hintergrundtextrahmen erstellen und andern

Wenn Sie ein neues, leeres Dokument erstellen, legt FrameMaker Hintergrundtextrahmen fiir Kopf- und
FuRRzeilen auf der linken und der rechten Vorgabeseite an. Um Ihnen das Hinzufligen von zentrierten und
rechtsbiindig ausgerichteten Informationen zu erleichtern, fligt FrameMaker automatisch zentrierte und
rechtsbiindige Tabulatorstopps in der Mitte bzw. am rechten Rand des Rahmens ein. Sie kdnnen Hinter-
grundtextrahmen fiir zusatzliche Informationen in der Kopf- und FuRzeile oder fiir sonstigen Hinter-
grundtext zeichnen.

Hinwels: Mithilfe des Textzeilen-Werkzeugs ist es moglich, einzelne Hintergrundzeilen zu erstellen. Sie
kénnen in diesen Text jedoch weder Variablen einfligen, noch kénnen Sie auf den Text Absatzstile
anwenden.

So fligen Sie einen Hintergrundtextrahmen auf einer Vorgabeseite hinzu:

1)  Zeichnen Sie den Textrahmen mithilfe des Textrahmen-Werkzeugs.

2)  Klicken Sie im Dialogfeld Neuen Textrahmen einfiigen zunachst auf Hintergrundtext und
anschliefend auf Einfiigen. Der neue Textrahmen hat (wie auch alle anderen Textrahmen fir
Hintergrundtext auf einer Vorgabeseite) kein Tag.

3) Doppelklicken Sie in den Textrahmen, um die Einfligemarke zu platzieren. Fligen Sie dann die Kopf-
zeile, die FuRzeile oder den Hintergrundtext ein.

So andern Sie die GroRe eines Hintergrundtextrahmens oder verschieben ihn:
1)  Wahlen Sie den Textrahmen aus, indem Sie bei gedriickter Strg-Taste auf den Textrahmen klicken.
2)  Fihren Sie einen der folgenden Schritte aus:

- Um die GroRe des Textrahmens zu andern, ziehen Sie einen Auswahlpunkt.

- Um den Textrahmen zu verschieben, ziehen Sie seinen Rahmen (keinen Auswahlpunkt).

Kopf- und FuB3zeilentext eingeben

Sie kdnnen einfache Kopf- und FulRzeilen erstellen, indem Sie Text in die Kopf- und FuBzeilentextrahmen
auf den Vorgabeseiten eingeben. Sie kdnnen aullerdem Elemente wie die aktuelle Kapitel- und Seiten-
nummer, die Gesamtzahl der Seiten oder das aktuelle Datum aufnehmen. FrameMaker zeigt in der Kopf-
bzw. FuBzeile auf der Vorgabeseite eine Systemvariable an, fiir die auf den entsprechenden Arbeitsseiten
der korrekte Wert eingesetzt wird.

Sie kdnnen laufende Kopf- und FulRzeilen mit seitenbezogenen Informationen definieren. In der
folgenden Abbildung enthalt die laufende Kopfzeile die aktuelle Abschnittsiiberschrift, wahrend in der
FulRzeile die Seitennummer und der Text angezeigt werden, die direkt in den Hintergrundtextrahmen
eingegeben wurden.
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[Running HF 1| [|General description |

We've moved from the basics of flight to space travel as it was
imagined in fiction and seen in movies in under 100 years. Just
think about where the next 100 years will take us!

Today the promise of space flight is closer than ever. With your
own Personal Spaceship you can travel to the stars!

K the fallowing image.

None of the work on the Personal Spaceship would have been
possible without the research and work done over the years by
the good folks at NASA. To learn more about the history of their
great achievements, what they are doing at present, and what the
future of NASA holds, visit these sites!

Table 1: More information about space travel

Sitelocation QR Code (Scan/go)

http://www.nasa.gov/

[y ]t s s S e : i P

Figure 2: Laufende Kopf- und FulRzeilen

Sie erstellen laufende Kopf- und FuRzeilen, indem Sie auf den Vorgabeseiten entsprechende Systemvari-
ablen in Hintergrundtextrahmen eingeben.

Sie konnen die folgenden Variablen in eine Kopf- und FuBzeile auf der Vorgabeseite einfligen:

Nummerierung fiir Buchkomponenten
Bandnummer, Kapitelnummer, Abschnitthummer oder Unterabschnittnummer

Seitenzahlen

Aktuelle Seitennummer oder Seitenanzahl

Datumsinformationen
Aktuelles Datum (Lang), Aktuelles Datum (Kurz), Anderungsdatum (Lang), Anderungsdatum (Kurz),
Erstellungsdatum (Lang) oder Erstellungsdatum (Kurz)

Sonstige Variablen
Kapitelname, Dateiname (Lang), Dateiname (Kurz), Tabellenfortsetzung oder Tabellenabschnitt

So fligen Sie eine Variable in eine Kopf- und FuRzeile auf einer Vorgabeseite ein:

1) Klicken Sie auf einer Vorgabeseite auf die Kopf- oder FuRzeile, in die Sie die Information einfligen
mochten.

- Flgen Sie statischen Text ein, indem Sie ihn einfach eingeben.
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- Um Systemvariablen einzufligen, rufen Sie das Fenster Variablen auf und doppelklicken in der
Auswahlliste Variablen auf den Variablennamen. Sie kénnen eine beliebige Systemvariable
einfligen, z. B.:

- Um Benutzervariablen einzufligen, rufen Sie das Fenster Variablen auf und doppelklicken in
der Auswabhlliste Variablen auf den Variablennamen (falls bereits definiert).

Tipp: Um Informationen in Kopf- und FulRzeilen zentriert auszurichten, driicken Sie Tab, um die Eing-
abemarke an den mittleren Tabulatorstopp zu bewegen. Um Informationen rechts auszurichten,
driicken Sie Tab erneut, um die Einfigemarke an den rechten Tabulatorstopp zu bewegen.

RELATED LINKS:
Kopf- und Fuf3zeilentext eingeben

Variablen

Andern des Seitenlayouts fiir bestimmte Seiten

Andern des Seitenlayouts auf bestimmten Seiten, Erstellen eines asymmetrischen Layouts, Layoutiiber-
schreibungen, Vorlagentextrahmen, Aktualisieren des Layouts von Arbeits- und Vorgabeseiten. Erstellen
Sie in Adobe FrameMaker Seitenlayouts zur einmaligen Verwendung.

Durch Hinzufiigen oder Andern von Textrahmen direkt auf den Arbeitsseiten kénnen Sie ein asymme-
trisches Layout erzeugen. Beispielsweise konnten Sie auf der linken und rechten Seite eines Dokuments
einen linken Rand benotigen, der breiter als der rechte ist. Denkbar waren auch Dokumente, die auf der
linken Seite ein einspaltiges und auf der rechten Seite ein zweispaltiges Layout haben.

Sie kdnnten sogar ein Layout definieren, das Spalten mit verschiedener Breite oder unterschiedlichem
Abstand aufweist. Ein solches Layout kdnnen Sie erzeugen, indem Sie fir jede Spalte einen anderen
Textrahmen verwenden.

Irregulare Layouts

Wenn Sie Anderungen an einer Vorgabeseite vornehmen, aktualisiert FrameMaker automatisch alle
Arbeitsseiten, die diese Vorgabeseite verwenden. Wenn Sie Anderungen auf einer Arbeitsseite
vornehmen (z. B. durch die Anderung der Spaltenanzahl, des Spaltenabstands oder der Rander), setzen
Sie das Layout der Vorgabeseite auRer Kraft und erzeugen ein so genanntes irregulares Layout. Nach
einer derartigen Anderung kénnen Sie wie folgt vorgehen:

. Aktualisieren Sie die Vorgabeseiten und alle entsprechenden Arbeitsseiten mit den Anderungen.
. Erstellen Sie eine Vorgabeseite, die auf dem gedanderten Layout der Arbeitsseite basiert.
] Fiihren Sie keinen dieser Schritte aus. Das irregulare Layout wird dadurch zum einmaligen Seiten-
layout.
RELATED LINKS:
Layouts von Arbeits- und Vorgabeseiten aktualisieren

Spezielle Vorgabeseiten erstellen

Spezielles Seitenlayout fiir den einmaligen Gebrauch erstellen
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Rénder und Spaltenlayout auf bestimmten Seiten dndern

Mit den folgenden Arbeitsschritten erzeugen Sie entweder ein einspaltiges Layout oder ein mehrspal-
tiges Layout mit gleicher Spaltenbreite.

Wenn Sie ein mehrspaltiges Layout mit unterschiedlichen Spaltenbreiten oder Spaltenabstianden beno-
tigen, mussen Sie fir jede Spalte einen eigenen Textrahmen erstellen und die einzelnen Rahmen an der
gewlinschten Stelle platzieren.

1)  Wahlen Sie den Textrahmen aus, dessen Rander Sie andern moéchten, indem Sie bei gedriickter
Strg-Taste auf den Rahmen klicken.

2)  Wahlen Sie Format > Benutzerdefiniertes Layout > Spezieller Textrahmen.
3)  Fihren Sie eine der folgenden Aktionen durch:

- Um die Rinder zu dndern, geben Sie die neue GroBe und Position unter GréRe (nicht
gedreht) und Abstand von an. Mit Oben und Links legen Sie den oberen bzw. linken Rand
fest. Der untere und der rechte Rand ergeben sich aus der Breite und der Hohe des
Textrahmens.

- Andern Sie die Spaltenanzahl oder den Abstand zwischen den Spalten, indem Sie die betref-
fenden Werte unter Spalten eingeben.

4) Klicken Sie auf Festlegen.

Tipp: Sie kdnnen die Rander auch dndern, indem Sie einen Textrahmen auswahlen und einen Auswahl-
punkt verschieben. Wenn Sie die GroRe eines mehrspaltigen Textrahmens andern, passen sich die Spal-
tenbreiten an den Textrahmen an, der Spaltenabstand bleibt jedoch unverandert.

RELATED LINKS:
Vorgabetextrahmen zu einer Vorgabeseite hinzufiigen

Textrahmen auf Arbeitsseiten hinzufiigen
Vorgabetextrahmen zu einer Vorgabeseite hinzufiigen

Wenn Sie auf einer Vorgabeseite Textspalten mit unterschiedlicher Breite bendtigen oder das Layout fiir
ein Infoblatt oder ein Dokument einrichten, in dem die Artikel nicht fortlaufend von der ersten bis zur
letzten Seite flieRen sollen, missen Sie fiir jede Spalte einen eigenen Textrahmen definieren. Beispiels-
weise wiirden Sie fiir eine Seite mit zwei Spalten unterschiedlicher Breite einen zweiten Vorgabetex-
trahmen hinzufigen.

Sie kdnnen einen Vorgabetextrahmen hinzufiigen, indem Sie ihn neu zeichnen oder einen vorhandenen
Rahmen kopieren.

1) Verwenden Sie zum Zeichnen des Textrahmens das Werkzeug Textrahmen platzieren in der
Grafiksymbolleiste. Wenn Sie mehrere Rahmen benétigen, zeichnen Sie diese in der Reihenfolge,
in der sie miteinander verkettet werden sollen.

2) Klicken Sie im Dialogfeld Neuen Textrahmen einfiigen auf Vorlage fiir Textrahmen auf Arbeitsseite
und wahlen Sie ein Tag in der Dropdown-Liste Textfluss-Tag. Wahlen Sie den aktuellen Textflusstyp
aus, es sei denn, Sie definieren einen Textrahmen fir einen anderen Textfluss in einem Dokument
mit mehreren Textfllssen.
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3)  Geben Sie unter ,,Spalten” die Anzahl der Spalten im Textrahmen an und legen Sie (bei mehreren
Spalten) den Abstand zwischen benachbarten Spalten fest. Wenn Sie ein Layout mit unterschiedlich
breiten Spalten definieren, miissen Sie die Spaltenanzahl auf 1 einstellen, da fiir jede Spalte ein
eigener Textrahmen verwendet wird.

4)  Klicken Sie auf Hinzufiigen.

5)  Verschieben Sie den Textrahmen nach Bedarf.

Tipp: Um einen vorhandenen Textrahmen zu kopieren, wahlen Sie ihn aus. Wahlen Sie anschlieRend
Bearbeiten > Kopieren und dann Bearbeiten > Einfiigen. FrameMaker kopiert den Textrahmen mit
seinem Inhalt und seinen Eigenschaften (einschlieRlich des Textfluss-Tags).

Textrahmen auf Arbeitsseiten hinzufiigen

Wenn Sie einen Textrahmen auf einer Arbeitsseite zeichnen, werden Sie aufgefordert, die Anzahl der
Spalten und den Abstand zwischen den Spalten anzugeben. FrameMaker weist jedoch keinen Textfluss
zu und verkettet den Textrahmen nicht mit den Textrahmen, die bereits auf der Seite vorhanden sind.

Damit der neue Textrahmen in den Textfluss des Dokuments integriert wird, muss er mit dem Textfluss
verkettet werden.

Ist der neue Textrahmen der erste Rahmen im Textfluss, wahlen Sie Automatische Verkettung, damit
neue Seiten bei Bedarf automatisch hinzugefiigt werden.

RELATED LINKS:
Textrahmen verketten

Layouts von Arbeits- und Vorgabeseiten aktualisieren

Sie kénnen die Vorgabetextrahmen mehrerer Vorgabeseiten dandern und dann alle Arbeitsseiten gleich-
zeitig aktualisieren. Wenn dagegen Anderungen am Spaltenlayout einer Arbeitsseite vorgenommen
wurden, mussen Sie zunachst die entsprechende Vorgabeseite aktualisieren.

FrameMaker priift vor der Aktualisierung, ob Arbeitsseiten Spaltenlayouts enthalten, die ihre Vorgabe-
seiten auBer Kraft setzen. Fiir Seiten mit irreguldren Layouts kdnnen Sie festlegen, ob diese beibehalten
werden sollen.

Aktualisieren der Arbeitsseiten mit Anderungen auf Vorgabeseiten

1)  Zeigen Sie nach der Anderung des Layouts einer Vorgabeseite wieder die Arbeitsseiten an.

2)  Wenn FrameMaker ein Meldungsfenster einblendet, legen Sie fest, ob irreguldre Layouts beibe-
halten oder entfernt werden sollen. Klicken Sie anschlieBend auf Fortfahren. Wenn Sie die irreg-
uldren Layouts beibehalten, aktualisiert FrameMaker die betreffenden Arbeitsseiten mit dem
Hintergrundtext und den Hintergrundgrafiken der Vorgabeseite.

Aktualisieren einer Vorgabeseite mit Anderungen auf Arbeitsseiten

1)  Wahlen Sie Format > Spaltenlayout > Seitenlayout aktualisieren. Sie werden aufgefordert, die
Aktualisierung der Vorgabeseite und der Arbeitsseiten zu bestatigen.

2)  Klicken Sie auf Aktualisieren.
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3) Wenn FrameMaker ein entsprechendes Meldungsfenster anzeigt, geben Sie an, ob irreguldre
Layouts auf den zu aktualisierenden Seiten beibehalten oder entfernt werden sollen. Klicken Sie
anschlieBend auf Fortfahren.

RELATED LINKS:
Irreguldre Layouts

Spezielles Seitenlayout fiir den einmaligen Gebrauch erstellen

Manchmal muss nur das Layout einer einzigen Arbeitsseite im Dokument geandert werden. Es konnte
z. B. erforderlich sein, einen Rahmen zu verlangern, um Platz fiir eine zuséatzliche Textzeile zu schaffen,
oder einen Textrahmen zu verkleinern, damit eine Grafik direkt auf einer Arbeitsseite platziert werden
kann.

Wenn Sie das Spaltenlayout einer Arbeitsseite andern, ohne die entsprechende Vorgabeseite zu aktual-
isieren, erzeugen Sie ein sogenanntes irregulares Layout.

RELATED LINKS:
Rénder und Spaltenlayout auf bestimmten Seiten dndern

Textrahmen auf Arbeitsseiten hinzufiligen

Ausrichten von Text liber mehrere Spalten

Erfahren Sie, wie in Adobe FrameMaker Text Gber Spalten verteilt, ein Hohenausgleich von Text bis zum
Ende von Textrahmen durchgefiihrt und Grundlinien synchronisiert werden.

Ausgleichen von Text liiber mehrere Spalten

Erfahren Sie, wie Sie in Adobe FrameMaker in einem Textrahmen Text gleichmaRig Giber Spalten
verteilen.

In diesem Thema

J Einfiihrung

. Verteilen von Text in Spalten in einem Textfluss
J Textausgleich fiir die Spalten eines einzelnen Textrahmens
Einfiihrung

In einem Layout mit einem mehrspaltigen Textrahmen kénnen Sie den Text in Spalten verteilen, die nicht
vollstandig mit Text gefiillt sind. Dies ist z. B. bei Spalten auf teilweise leeren Seiten sinnvoll, die erzwun-
genen Seitenumbriichen vorausgehen, oder bei Spalten auf der letzten Seite eines Dokuments. Der
Ausgleich von Text kann entweder fir den gesamten Textfluss oder nur fir einzelne Textrahmen
erfolgen.
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Figure 3:

Mit und ohne Option , Ausgleichen”

Verteilen von Text in Spalten in einem Textfluss

1)  Wenn ein Dokumentfenster aktiviert ist, platzieren Sie die Einfligemarke im Haupttextfluss, oder
klicken Sie in den Seitenrand. Wenn ein Buchfenster aktiv ist, wahlen Sie die gewlinschten Doku-

mente aus.

2)  Waihlen Sie Format > Seitenlayout > Spaltenlayout.
3)  Wahlen Sie Spalten ausgleichen und klicken Sie auf Gesamten Textfluss aktualisieren.

Textausgleich fiir die Spalten eines einzelnen Textrahmens

Klicken Sie in den Textrahmen, und wahlen Sie Format > Benutzerdefiniertes Layout > Spezieller

Textrahmen.

Wahlen Sie Spalten ausgleichen und klicken Sie auf Zuweisen.

Hoéhenausgleich von Text bis zum Ende von Textrahmen

Erfahren Sie, wie Sie in Adobe FrameMaker einen Hohenausgleich von Text in einem Textrahmen durch-

fuhren.
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Beim Hohenausgleich von Text vergrofRert FrameMaker als Erstes den Abstand zwischen den Absatzen
bis zu einem von Ihnen angegebenen Grenzwert. Falls dies nicht ausreicht, wird der Abstand zwischen
den Zeilen bis zu einem weiteren angegebenen Grenzwert vergroflert. Wenn der Text in einem
Textrahmen um Grafiken flieRt, flihrt FrameMaker keinen Hohenausgleich durch.

PLATE BOUNDARLES 1y PLATE BOUNDARIES | €1

s ok A

£
I
:

Figure 4: Vor und nach dem Hohenausgleich

In einem mehrspaltigen Textrahmen mit verbundenen Elementen (Absatzen, Tabellen oder verankerten
Rahmen) vergroRert FrameMaker den vertikalen Abstand, um die Grundlinien des Textes in nebenein-
anderliegenden Spalten Uber jedem verbundenen Element auszurichten.

PLATE BOUNDARIES 13 PLATE BOUMDARIES Ci

§
i
]
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Figure 5:  Vor und nach dem Héhenausgleich mit Verbinden

1)  Wenn ein Dokumentfenster aktiviert ist, platzieren Sie die Einfligemarke im Haupttextfluss. Wenn
ein Buchfenster aktiv ist, wahlen Sie die gewiinschten Dokumente aus.

2)  Wahlen sie Format > Seitenlayout > Zeilenlayout.

3)  Wabhlen Sie Hohenausgleich und geben Sie den maximalen Abstand an, den FrameMaker zwischen
Zeilen (Maximaler Ausgleich zwischen Zeilen) und zwischen Absatzen (Maximaler Ausgleich
zwischen Absatzen) einfligen kann.

FrameMaker hdilt die von Ihnen festgelegten Grenzwerte fiir den Hohenausgleich ein. Sollte dies bei
einer Spalte nicht méglich sein, wird fiir diese Spalte kein Héhenausgleich durchgefiihrt.
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4)  Klicken Sie auf Textfluss aktualisieren.

Hinwels: Beim Hohenausgleich wird Platz geschaffen fur die groRtmaogliche Unterlange im gréRten
Schriftgrad, der in der Zeile verwendet wird. Dies gilt auch dann, wenn kein Zeichen mit der maximalen
Unterlange im Text enthalten ist. Falls die letzte Zeile einer Spalte zu hoch erscheint, iberprifen Sie, ob
die Spalte ein nicht druckendes Zeichen (z. B. ein Ankersymbol) in einer Schrift enthalt, die groRer als der
umgebende Text ist.

Synchronisieren von Textgrundlinien in einem Textfluss

Erfahren Sie, wie Sie in Adobe FrameMaker die Grundlinie von Textzeilen tber Spalten und Textrahmen
synchronisieren und ausrichten.

In diesem Thema

J Einflihrung
. Synchronisieren von Grundlinien liber Spalten
. Synchronisieren von Grundlinien in benachbarten Textrahmen

Einfiihrung

Wenn Sie Absatze in einem Textfluss synchronisieren (ausrichten), erstellt FrameMaker ein unsichtbares
Raster in jedem Textrahmen und richtet die Grundlinie der ersten Zeile jedes angegebenen Absatzes am
Raster aus. FrameMaker richtet auRerdem die erste Zeile aus, die auf einen verankerten Rahmen folgt,
und versucht, die erste Zeile jeder Spalte auszurichten.

HiNnweEls: Wenn fir einen Textfluss sowohl der Hohenausgleich als auch die Synchronisierung aktiviert ist,
hat der Hohenausgleich Vorrang. Die ersten Zeilen der Spalten werden jedoch miteinander synchronis-
iert.

LARIELLN I L AN LRI LRI LI LN LRI L LN R R R R R R R R

OUNDARIES ODUNDARIES

LINIEELNIN LRI LRI LI I LI LRI LI LR L] EEEE RSB FEE S FEE S FEE R FRE R FRE R ERE R R R

PI'I"I (LILIREIELINETE L]
Fangea

Figure 6:  Vor und nach der Synchronisierung von Text in einem Textfluss
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Da Uberschriften in groRen Schriftarten oft am Spaltenanfang erscheinen, kénnen Sie einen Grenzwert
flr die Synchronisierung der ersten Zeile angeben. Von diesem Grenzwert hangt es ab, ob die Grundlinie
einer Uberschrift am Anfang der Spalte auch dann auf der ersten Rasterlinie platziert wird, wenn der
Standardschriftgrad der Uberschrift fiir das Raster zu groR ist. Damit die Grundlinie einer Uberschrift auf
der ersten Rasterlinie platziert werden kann, lisst FrameMaker die Uberschrift (iber den Spaltenanfang
hinausreichen (vgl. Abbildung). Schriftgrade, die den von lhnen festgelegten Grenzwert Gberschreiten,
werden nicht synchronisiert.

Synchronisieren von Grundlinien tGiber Spalten

So synchronisieren Sie Grundlinien Uber Spalten hinweg:

1)  Uberprifen Sie die Absatzstile der Absatztypen, die synchronisiert werden sollen, um sicherzus-
tellen, dass alle denselben Standardschriftgrad und Zeilenabstand aufweisen. Dabei sollte die
Option ,Fester Zeilenabstand” aktiviert sein.

2) Klicken Sie in den Textfluss, den Sie synchronisieren wollen (oder wahlen Sie die gewlinschten
Dokumente im Buch aus), und wahlen Sie Format > Seitenlayout > Zeilenlayout.

3)  Wahlen Sie Grundlinien-Synchronisierung und deaktivieren Sie Hohenausgleich.

4)  Geben Sie unter Synchronisierung den gewiinschten Zeilenabstand fiir das Textrahmenraster in
das Feld Absatze synchronisieren - Zeilenabstand ein. Verwenden Sie dabei den Zeilenabstand der
Absatze, die synchronisiert werden sollen. Andernfalls synchronisiert FrameMaker die Absatze
nicht mit dem Textrahmenraster.

5) Geben Sie in das Feld Synchronisierungsgrenze fiir 1. Zeile den groRten Schriftgrad ein, der am
Spaltenanfang ausgerichtet werden soll. Nehmen Sie z. B. fiir Textabsatze einen Zeilenabstand von
12 Punkt, ein Spaltenraster von 12 Punkt und Uberschriften von 18 Punkt an. Um Uberschriften am
Spaltenanfang auszurichten, geben Sie 18 Punkt als Synchronisierungsgrenze fiir die erste Zeile an.

6) Klicken Sie auf Textfluss aktualisieren.

Da es Uber der ersten Zeile einer Spalte keine Unterlangen gibt, wird die erste Rasterlinie in einem
Abstand von zwei Dritteln des angegebenen Zeilenabstands vom Spaltenanfang positioniert.

Synchronisieren von Grundlinien in benachbarten Textrahmen

Wenn die Oberkanten benachbarter Textrahmen an unterschiedlichen Positionen auf der Seite
beginnen, miissen Sie moglicherweise die Oberkanten anpassen, damit die Textrahmen gleichmaBig an
den Rastern ausgerichtet werden.

Andern Sie dazu die GroRe der benachbarten Textrahmen so, dass der Abstand zwischen den Ober-
kanten ganzzahlig durch das Raster geteilt werden kann. Wenn das Raster z. B. 12 Punkt ist, kdnnen Sie
einen Textrahmen 144 Punkt (12 mal 12 Punkt) von der Oberkante eines benachbarten Textrahmens
beginnen.
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Figure 7:  Synchronisieren von Grundlinien in benachbarten Textrahmen

A. Rasterabstand B. Ein Vielfaches der RastergrofRe

Tipp: Mithilfe des Magnetrasters konnen Sie die Textrahmen korrekt ausrichten. Geben Sie ein Magnet-
raster an, das dem Textrahmenraster entspricht. Andern Sie dann die GréRe der Textrahmen, bis ihre
Oberkanten an einer Rasterposition ausgerichtet sind.
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Dokumente mit mehreren Textfliissen

Verwalten Sie separate Textfllisse, die jeweils liber eigene Textrahmenverbindungen verfligen. Erstellen
Sie zweisprachige Dokumente in FrameMaker.

Dokumente kdnnen mehrere, separate Textfllisse enthalten, von denen jeder eigene Textrahmenverket-
tungen aufweist. Dies ist beispielsweise bei einem mehrsprachigen Dokument der Fall, das nebenein-
ander verschiedene Ubersetzungen desselben Textes enthilt.

In einem Dokument mit mehreren Textfllissen kann FrameMaker angewiesen werden, keine neue Seite
hinzuzufligen. Sie kdnnen dann selbst Seiten hinzufligen und die Verkettungen festlegen. Da die autom-
atische Nummerierung in unterschiedlichen Textfllissen unabhangig voneinander erfolgt, konnen Sie
nummerierte Listen, Uberschriften, Abbildungstitel usw. fiir jeden Textfluss separat verwalten.

Einrichten von Dokumenten mit mehreren Textfllissen

Lernen Sie Textfluss- und Fluss-Tags kennen, richten Sie einen parallelen Textfluss ein, und richten Sie
einen Fluss fiir einen Newsletter oder ein Magazin in FrameMaker ein.

Textfliisse und Textfluss-Tags

Unter einem Textfluss versteht man eine Folge von Textrahmen, die miteinander verkettet sind und
dafiir sorgen, dass der Text durch ein Dokument flieRt. Die meisten Dokumente enthalten nur einen Text-
fluss, der sich von der ersten bis zur letzten Seite erstreckt. In diesem Fall sorgt FrameMaker fiir eine
automatische Verkettung der Textrahmen. Es gibt aber auch Dokumente, die mehrere Textfllisse
enthalten. In diesen Dokumenten legen Sie den Textfluss fest, indem Sie die Textrahmen selbst
verketten. Dies gilt beispielsweise fiir Infoblatter, in denen ein Artikel auf einer Seite beginnt und auf
einer spateren Seite fortgesetzt wird, wobei die Artikel auf den dazwischenliegenden Seiten lber-
sprungen werden.

Das Textfluss-Tag des aktuellen Textrahmens wird im Namensbereich der Statuszeile angezeigt.
Flow: & 9): Body
Figure 1: Tag-Bereich in der Statuszeile

Einrichten von parallelen Textfliissen

Das Layout eines Dokuments mit parallelen Textfliissen wird auf Vorgabeseiten gestaltet, auf denen die
Textrahmen angeordnet und miteinander verkettet werden. Da die Textrahmenverkettungen im gesa-
mten Dokument gleich sind, miissen in der Regel keine weiteren Anderungen auf Arbeitsseiten vorge-

nommen werden.

1) Richten Sie die Textfliisse auf einer der Vorgabeseiten ein. Verwenden Sie fiir jeden Textfluss einen
separaten Textrahmen und weisen Sie jedem Textrahmen ein anderes Textfluss-Tag zu. Verge-
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wissern Sie sich, dass fiir jeden Textfluss die automatische Verkettung aktiviert ist, damit eine neue
Arbeitsseite angelegt wird, wenn der Text das Ende eines Textflusses erreicht.

Fenning HIF § Fainkeg HAF A

L L T

Figure 2:  Linke und rechte Vorgabeseite fiir einen parallelen Textfluss

2)  Wiederholen Sie diese Schritte fiir alle weiteren Vorgabeseiten. Alle Vorgabeseiten sollten
dieselben Textfluss-Tags aufweisen. Andernfalls wechselt FrameMaker beim Hinzufligen von Arbe-
itsseiten nicht korrekt zwischen linker und rechter Vorgabeseite.

WicHTIG: Damit die neue Arbeitsseite korrekt angelegt wird, wenn das Ende eines Textrahmens
erreicht ist, muss die entsprechende linke oder rechte Vorgabeseite alle Textfluss-Tags enthalten,
die sich auf der aktuellen Arbeitsseite befinden. Fehlt ein Textfluss-Tag, erstellt FrameMaker die
neue Seite stattdessen mit der Vorgabeseite der aktuellen Arbeitsseite.

3)  Aktualisieren Sie die Arbeitsseiten mit Anderungen der Vorgabeseiten, indem Sie die Arbeitsseiten
anzeigen.

RELATED LINKS:
Vorgabetextrahmen zu einer VVorgabeseite hinzufiigen

Tag eines Textflusses und die Einstellung ,,Automatisch verbinden” édndern

Einrichten von Textfluissen fiir ein Infoblatt oder eine Zeitschrift ein:

Die Gestaltung des Spaltenlayouts eines Infoblattes oder einer Zeitschrift, fiir die mehrere, nichtparallele
Textflisse benotigt werden, erfolgt in der Regel auf Vorgabeseiten. Die Vorgabeseiten dienen jedoch
lediglich als grundlegendes Layoutraster. Das weitere Layout der Textrahmen erfolgt auf den Arbeits-
seiten. Sie konnen die Textrahmen auf den Arbeitsseiten vergréBern/verkleinern, [6schen, verketten
bzw. ihre Verkettung wieder aufheben, bis Sie mit dem Layout zufrieden sind. Mit dieser Methode
konnen Sie auf flexible Weise festlegen, wie der Text durch das Dokument flieRt.

HiNweEls: Wenn Sie Infoblatter oder Zeitschriften erstellen, deren Artikel fortlaufend von der ersten bis
zur letzten Seite flieRen, brauchen Sie die hier beschriebenen Techniken nicht einzusetzen. Verwenden
Sie stattdessen einen einzelnen Textfluss. Sie kdnnen spezielle Effekte erzielen, z. B. Text, der um
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Grafiken flieBt, oder Absatze, Tabellen und Rahmen, die sich (iber mehrere Spalten erstrecken. Die im

Lieferumfang von FrameMaker enthaltene Infoblatt-Vorlage bietet ein Beispiel fiir diese Technik.

1) Legen Sie die Anzahl der Spalten fest und platzieren Sie fiir jede Spalte einen einspaltigen
Textrahmen auf jeder Vorgabeseite. Alle Textrahmen sollten demselben Textfluss angehoren. Sie
konnen diese Textrahmen als Layoutraster verwenden, in dem der Textfluss enthalten ist.

Figure 3:  Erste Vorgabeseite

iy BOTL sy RF 2

Figure 4: Linke und rechte Vorgabeseite mit demselben Textfluss

2) Deaktivieren Sie ,,Automatische Verkettung”, damit FrameMaker nicht automatisch Seiten
hinzuflugt.

3)  Aktualisieren Sie die Arbeitsseiten mit den Anderungen der Vorgabeseiten, indem Sie die Arbeits-
seiten anzeigen.
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4)  VergroBRern oder verkleinern, trennen und verketten Sie nun Textrahmen auf jeder Arbeitsseite, um
das gewiinschte Layout zu erzeugen. Aktualisieren Sie die Vorgabeseiten nicht mit den Anderungen
der Arbeitsseiten.

5)  Wenn Sie die Textgrundlinien im Infoblatt synchronisieren mdéchten, stellen Sie sicher, dass die
Textrahmen entsprechend platziert sind. Falls das Dokument mehrere Textfliisse enthalt, missen
die Grundlinien fiir jeden Textfluss synchronisiert werden.

6) Fligen Sie bei Bedarf neue unverkettete Arbeitsseiten manuell hinzu.
7)  Verketten Sie die Textrahmen auf den einzelnen Seiten in der gewiinschten Weise.

RELATED LINKS:
Vorgabetextrahmen zu einer Vorgabeseite hinzufiigen

Steuern des Textflusses

Andern Sie die Tag-Einstellung oder Einstellung ,Automatische Verkettung” eines Flusses, andern Sie
getrennte Seiten oder Textrahmen in FrameMaker.

Die grundlegenden Eigenschaften eines Textflusses sind die Einstellung ,,Automatische Verkettung” und
das Textfluss-Tag. In einem Dokument mit einem einzelnen oder mehreren parallelen Textfllssen ist
L,Automatische Verkettung” normalerweise aktiviert. FrameMaker fligt dann eine neue Seite hinzu,
sobald die Textrahmen des Textflusses voll sind. Die neue Seite Gbernimmt das Spaltenlayout der
entsprechenden (linken oder rechten) Vorgabeseite und die Textrahmen auf der neuen Seite werden
automatisch mit den Textrahmen der Ursprungsseiten verkettet.

Bei der Bearbeitung eines Dokuments mit mehreren nicht parallelen Textflissen wird die Einstellung
»Automatische Verkettung” gewohnlich deaktiviert. Sie konnen dann jederzeit eine neue unverkettete
Arbeitsseite hinzufligen und die Verkettung zwischen dieser und den bestehenden Seiten steuern. Wenn
,Automatische Verkettung” deaktiviert ist und der Textfluss mehr Text enthalt, als seine Textrahmen
aufnehmen kénnen, lauft der Text am Ende des letzten Textrahmens Gber. Wenn die Anzeige von
Begrenzungslinien aktiviert ist, wird der untere Rand eines iberlaufenden Textrahmens als durchge-
hende Linie dargestellt.

0

FLATE BOUNDARIES

Earth's Dynamiz Platss

:
[
:

212



DOKUMENTE MIT MEHREREN TEXTFLUSSEN

Figure5: Textrahmen mit Uberlauftext

Beim Versuch, weiteren Text in einen Textrahmen mit Uberlauftext einzugeben, ertdnt ein Warnsignal.
Uberlauftext wird nicht geléscht, er ist lediglich ausgeblendet. Sobald Sie den Textrahmen, der den Uber-
lauftext enthalt, mit einem anderen Textrahmen verketten, wird der Text im nachsten Textrahmen
wieder angezeigt.

Sie konnen jederzeit ein Textfluss-Tag zuweisen (wenn Sie z. B. parallele Textfllisse anlegen). (In einem
neuen, leeren Dokument besitzt der Haupttextfluss das Tag A.) Jedem Textfluss muss nur einmal ein Tag
zugewiesen werden. Danach libernehmen alle Textrahmen, die mit dem Textfluss verkettet werden,
dieses Tag. Wenn Sie das Textfluss-Tag oder die Einstellung ,,Automatische Verkettung” in einem
Textrahmen des Textflusses dndern, gilt die Anderung fiir den gesamten Textfluss.

Tag eines Textflusses und die Einstellung ,,Automatisch verbinden” dndern

Normalerweise andern Sie Textfluss-Tags und die Einstellung ,,Automatische Verkettung” auf Vorgabe-
seiten. Wenn zwei Textrahmen verkettet sind, missen Sie die Verkettung aufheben, damit Sie einen der
Textfluss-Tags andern kdnnen.

1) Klicken Sie in einen Textrahmen des Textflusses.
2)  Waihlen Sie Format > Benutzerdefiniertes Layout > Spezieller Textrahmen.

3) Geben Sie in das Feld , Textfluss-Tag” ein Tag fiir den Textfluss ein. Geben Sie dem Textfluss einen
kurzen Tagnamen, damit er nicht andere Informationen im Namensbereich der Statuszeile
verdeckt. Sie kdnnen kein Tag zuweisen, das auf der aktuellen Seite bereits verwendet wird.

HINWEIS: Sie kdnnen auf einer Seite zwei Textrahmen mit demselben Textfluss-Tag erstellen, indem
Sie die Textrahmen miteinander verketten.

4)  Wenn FrameMaker automatisch eine neue Seite hinzufligen soll, sobald die letzte Spalte auf einer
Seite geflllt ist, aktivieren Sie die Einstellung ,,Automatische Verkettung”.

5) Klicken Sie auf Festlegen.
RELATED LINKS:
Textrahmen verketten

Textrahmen abtrennen

Hinzufiigen von neuer, unverketteter Seite

In Dokumenten mit einem Haupttextfluss oder zwei parallelen Textflissen fligen Sie normalerweise
keine unverkettete Arbeitsseite hinzu, sondern lassen FrameMaker bei Bedarf automatisch verkettete
Seiten anlegen. In einem Dokument mit mehreren Textfllissen, in dem ,,Automatische Verkettung” deak-
tiviert ist, oder in anderen speziellen Dokumenten kénnen Sie neue unverkettete Arbeitsseiten
hinzufligen. Sobald der Text das Ende eines Textrahmens erreicht, fligen Sie eine neue Seite hinzu und
verketten die Textrahmen.

1)  Wahlen Sie auf einer Arbeitsseite Einfiigen > Unverkettete Seiten einfiigen.
2) Legen Sie die Position und die Anzahl der Seiten fest, die hinzugefiigt werden sollen.
3) Wahlen Sie eine Vorgabeseite in der Dropdown-Liste Vorgabeseite und klicken Sie auf Hinzufiigen.
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Loschen von unverketteten Seiten

Wenn Sie in einem Dokument mit mehreren Textfliissen unverkettete Seiten I6schen, wird gleichzeitig
der Seiteninhalt geloscht.

1)  Klicken Sie auf die zu I6schende Seite, und wahlen Sie Format > Dokument > Seiten l6schen.

2) Legen Sie die erste und die letzte unverkettete Seite des zu I6schenden Bereichs fest und klicken
Sie auf Loschen. Wenn Sie nur eine einzelne Seite |6schen mochten, geben Sie ihre Seitennummer
in beide Felder ein.

Textrahmen verketten

Wenn zwei Textrahmen verkettet sind, flieRt der Text vom Ende des ersten Textrahmens zum Beginn des
zweiten. Sie kénnen einen Textrahmen auf einer Vorgabeseite mit einem beliebigen Textrahmen auf
derselben Vorgabeseite verketten. Es ist auch moglich, einen Textrahmen auf einer Arbeitsseite mit
einem Textrahmen auf einer anderen Arbeitsseite zu verketten. Ein Textrahmen in der Mitte eines Text-
flusses kann ebenfalls verkettet werden.

Beim Verketten zweier Textrahmen weist FrameMaker dem zweiten Textrahmen das Textfluss-Tag des
ersten Textrahmens zu. Besitzt der erste Textrahmen kein Textfluss-Tag, wird das Tag des zweiten
Rahmens verwendet. Daher gehoren alle verketteten Textrahmen demselben Textfluss an und haben
dasselbe Tag. Wenn der erste Textrahmen Uberlauftext enthilt, flieRt der Text in den zweiten Rahmen,
sobald die Verkettung hergestellt ist.

1)  Wahlen Sie die beiden Textrahmen in der Reihenfolge aus, in der Sie diese verketten mochten.
Klicken Sie zum Auswahlen der Textrahmen bei gedriickter Strg-Taste auf die Textrahmen.

Wenn sich die Textrahmen auf unterschiedlichen Seiten befinden, wird der erste Textrahmen nicht
als ausgewdhlt dargestellt, sobald Sie den zweiten auswdhlen. FrameMaker ,,merkt sich” jedoch die
erste Auswahl.

HINWEIS: Um einen Textrahmen in der Mitte eines Textflusses einzufligen, wahlen Sie zunachst den
Textrahmen aus, den Sie hinzufligen mdéchten, und dann den Rahmen, der darauf folgen soll.

2)  Waihlen Sie Format > Benutzerdefiniertes Layout > Textrahmen verbinden. Wenn sich der zuerst
ausgewahlte Textrahmen auf einer Seite befindet, die momentan nicht sichtbar ist, werden Sie von
gefragt, ob Sie den aktuellen Textrahmen mit diesem Textrahmen verketten mochten.

Textrahmen abtrennen

Sie trennen Textrahmen ab, um separate Textfllsse zu erstellen, z. B. um einen Artikel an einer bestim-
mten Position im Infoblatt einzufligen oder ein Textzitat zu erstellen. Wenn Sie einen neuen Textfluss in
der Mitte einer Spalte beginnen miissen, kdnnen Sie den Textrahmen mit der Spalte teilen und die
beiden Textrahmen dann abtrennen.

Sie kénnen einen Textrahmen vom vorhergehenden, vom nachfolgenden oder von beiden Textrahmen
abtrennen. Es ist auch moglich, einen Textrahmen aus der Mitte eines Textflusses zu entfernen.

Der enthaltene Text wird durch das Trennen der Textrahmen nicht beeinflusst. Wenn Sie Text in einen
anderen Textrahmen verschieben mochten, schneiden Sie ihn nach dem Abtrennen aus und fligen ihn
anschlieRend ein.

HINWEIS: Wenn Sie Textrahmen auf derselben Arbeitsseite abtrennen, FrameMaker legt separate Text-
flisse ohne Tag an. Werden Textrahmen auf unterschiedlichen Arbeitsseiten abgetrennt, erzeugt
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FrameMaker separate Textfliisse mit demselben Textfluss-Tag. Wenn Sie ein infoblattdhnliches Doku-
ment erstellen, in dem ,,Automatische Verkettung” fur alle Textfllisse deaktiviert ist, spielen die Text-
flusstags keine Rolle. FrameMaker erstellt nicht automatisch neue Seiten. Daher ist es nicht nétig, die
Textrahmen zu verketten.

1)  Wahlen Sie den Textrahmen aus, der abgetrennt werden soll, indem Sie bei gedriickter Strg-Taste
auf den Textrahmen klicken.

2)  Wahlen Sie Format > Benutzerdefiniertes Layout, und wahlen Sie dann Vorherigen abtrennen,
Nachste abtrennen oder Beide abtrennen.

Entfernen von Textrahmen aus der Mitte eines Textflusses

1)  Waéhlen Sie den Textrahmen direkt vor dem zu |6schenden Rahmen aus. Klicken Sie hierzu bei
gedriickter Strg-Taste auf den Textrahmen.

2)  Waihlen Sie den Textrahmen aus, der direkt auf den zu l6schenden Rahmen folgt.

3)  Wahlen Sie Format > Benutzerdefiniertes Layout > Textrahmen verbinden. Wenn sich der zuerst
ausgewadhlte Textrahmen auf einer Seite befindet, die momentan nicht sichtbar ist, werden Sie von
gefragt, ob Sie den aktuellen Textrahmen mit diesem Textrahmen verketten mochten.

Teilen oder Zusammenfiihren von Textrahmen

Sie kénnen einen Textrahmen teilen und anschlieend die Verkettung der beiden resultierenden
Textrahmen aufheben, um einen neuen Textfluss zu beginnen. Auf diese Weise kdnnen Sie z. B. einen
neuen Artikel mit eigenem Textfluss mitten in einem Textrahmen beginnen.

1 1
{Phibe Tadinik 1 ke Tedinsia 1
— — — L1
=Am A A mAm=B= B
Tk beare b1 P P il b o e e

Figure 6: Der mittlere Textrahmen wurde geteilt, vom ersten Textrahmen getrennt und mit einem neuen
Textfluss-Tag versehen.

Teilen von Textrahmen

1) Klicken Sie in die Zeile Gber der Stelle, an der Sie den Textrahmen teilen wollen, und wéhlen Sie
Format > Benutzerdefiniertes Layout > Textrahmen teilen. FrameMaker teilt den Textrahmen
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2)

3)

4)

horizontal unterhalb der Zeile mit der Einfligemarke und erstellt zwei separate, aber miteinander
verkettete Textrahmen.

Wahlen Sie den unteren Textrahmen aus, indem Sie bei gedriickter Strg-Taste auf den Textrahmen
klicken.

Trennen Sie den Textrahmen vom vorherigen Rahmen ab, indem Sie Format > Benutzerdefiniertes
Layout > Vorherigen abtrennen wahlen. Wenn dem Textfluss ein Tag zugewiesen war, wird dieses
entfernt. War vor der Trennung der Textrahmen die Einstellung ,Automatische Verkettung” aktiv-
iert, ist sie nun flir beide Textrahmen deaktiviert.

Andern Sie gegebenenfalls die GroRe der Textrahmen.

Zusammenfiihren von Textrahmen

Wenn Sie seit der Teilung des Textrahmens keine weiteren Anderungen vorgenommen haben,
wahlen Sie Bearbeiten > Riickgdngig machen.

Falls Sie eine Anderung durchgefiihrt, aber die beiden Textrahmen noch nicht abgetrennt haben,
[6schen Sie den unteren Rahmen und dndern dann die GroRe des verbleibenden Textrahmens, bis
er wieder die urspriingliche GréRe des ungeteilten Rahmens besitzt.

Wenn Sie die beiden Rahmen bereits getrennt haben, schneiden Sie den Text aus dem zweiten
Textrahmen aus und fligen ihn anschlieBend am Ende des ersten Rahmens ein. Danach I6schen Sie
den zweiten Textrahmen und vergrofRern den ersten Rahmen, bis er wieder die GroRRe des
urspringlichen, ungeteilten Rahmens hat. Wenn Sie ,,Automatisch verbinden” wieder aktivieren
oder dem Textfluss ein Fluss-Tag erneut zuweisen missen, verwenden Sie Format > Benut-
zerdefiniertes Layout > Spezieller Textrahmen.

Erstellen von Querverweisen auf abgetrennte Textrahmen

Wenn ein Artikel eines Infoblattes oder einer Zeitschrift auf einer anderen Seite fortgefiihrt wird, sollten
Sie dem Leser mithilfe von Querverweisen mitteilen, wo der Artikel fortgesetzt wird. Entsprechend
sollten Sie im Fortsetzungstextrahmen angeben, wo nach dem Ende des Artikels fortgesetzt wird.

=== S==
===5) | ===
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Figure 7:  Geben Sie an, wo der Textfluss weitergefiihrt wird und wo er begonnen hat.

1) VergroRern Sie die beiden Textrahmen, um Platz fiir die Querverweise zu schaffen. Verschieben Sie
den unteren Rand des ersten Textrahmens nach oben und den oberen Rand des Fortsetzungs-
rahmens nach unten.

2)  Zeichnen Sie einen kleinen Textrahmen unter dem Textrahmen auf der ersten Seite und
anschlieRend einen weiteren (iber dem Rahmen auf der Fortsetzungsseite. Verketten Sie die
Textrahmen mit keinem anderen Textrahmen.

3)  Fugen Sie einen Querverweis in den leeren Textrahmen auf der ersten Seite ein und verweisen Sie
darin auf die Fortsetzungsseite des Artikels.

4)  Fugen Sie einen Querverweis in den leeren Textrahmen auf der Fortsetzungsseite ein und
verweisen Sie darin auf die erste Seite des Artikels.

Verfolgen eines Textflusses

In einem Dokument mit vielen Textfllissen verlieren Sie leicht den Uberblick Giber den Verlauf eines Text-
flusses. Durch Zoomen kénnen Sie mehr Text eines Textflusses anzeigen oder von einem Textrahmen
eines Textflusses zum nachsten wechseln.

1) Zoomen Sie die Darstellung auf 25 % und passen Sie die FenstergrofRe so an, dass alle erforderlichen
Seiten sichtbar sind.

2)  Klicken Sie in den Fluss, den Sie Gberpriifen mochten, und wahlen Sie Bearbeiten > Alles im Fluss
auswahlen. Der Textfluss ist nun hervorgehoben und Sie kénnen seinen Verlauf auf den Dokument-
seiten verfolgen.

3)  Zum Blattern durch die Textrahmen eines Textflusses, gehen Sie wie folgt vor:

- Um den nachsten verketteten Textrahmen anzuzeigen, klicken Sie in die letzte Zeile eines
Textrahmens und driicken Sie die Nach-Unten-Taste.

- Um den vorhergehenden verketteten Textrahmen anzuzeigen, klicken Sie in die erste Zeile
eines Textrahmens und dricken Sie die Nach-Oben-Taste.

FlieBrichtung festlegen

Geben Sie in FrameMaker die Richtung des Textes in einem Textrahmen an (von links nach rechts oder
von rechts nach links).

Sie konnen die Richtung (LNR oder RNL) von Text in einem Textrahmen festlegen. Dies bedeutet, dass Sie
ein Dokument erstellen kénnen, in dem die Richtung des Textflusses unterschiedlich sein kann. Beispiels-
weise konnen Sie ein Dokument mit zwei Textfllissen erstellen, in dem eine LTR-Sprache (wie Englisch
oder Deutsch) im linken Textfluss bearbeitet wird und eine RTL-Sprache (wie Arabisch, Hebraisch oder
Farsi) im rechten Rahmen bearbeitet wird.

1)  Textrahmen auswahlen.
2)  Waihlen Sie im Men ,,Grafik” die Objekteigenschaften.

3)  Wabhlen Sie auf der Registerkarte ,Textrahmen“ die gewlinschte Richtung aus der Dropdownliste,
und klicken Sie auf ,,Ubernehmen®.
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Vorlagen

Erfahren Sie, was eine Vorlage in FrameMaker ist, und was strukturierte und unstrukturierte Vorlagen
sind.

Wenn Sie eine Vorlage definieren, gestalten Sie Vorgabeseiten, legen Formate fest, weisen sie zu und
definieren speziellen Text wie z. B. Querverweisformate und Variablen.

Tipp: Richten Sie flr die zu erstellenden Vorlagen einen Vorlagenordner ein, der die entsprechenden
Vorlagen sowie ein Dokument einer Beschreibung der Vorlagen und deren Verwendung enthalt.

Unstrukturierte Vorlagen

Eine Vorlage ist ein Dokument, in dem Eigenschaften gespeichert sind, die Sie mehrfach verwenden
kénnen. Sie kdnnen aus einer Vorlage ein neues Dokument erstellen, das samtliche Eigenschaften
der Vorlage besitzt, oder Sie konnen spater bestimmte Eigenschaften der Vorlage importieren.
Vorlagen sorgen fir eine einheitliche Gestaltung von Layout und Formatierung der Dokumente.

In Vorlagen kdnnen die folgenden Eigenschaften gespeichert werden:
. Absatz-, Zeichen- und Tabellenformate, die in den Elementdefinitionen Formatinformationen

verwenden

] Seitenlayouts, welche die Anzahl und Position von Spalten auf Seiten, sowie Hintergrundelemente,
wie laufende Kopfzeilen, festlegen

. Referenzseiten, auf denen wiederholt verwendete Grafik- und Formatinformationen gespeichert
werden

. Als Platzhalter verwendete Variablen fiir von FrameMaker aktualisierten Text
. Formatinformationen fiir Querverweise, Gleichungen und Bedingungs-Tags
. Definitionen fiir Farben, die Text und Objekten zugewiesen werden kdnnen

. Flr das gesamte Dokument giiltige Einstellungen, einschlieflich Funoteneinstellungen, spezielle
Markentypen und Héhenausgleich fiir den Zeilenabstand

. Spezifikationen flir kombinierte japanische und westliche Schriftarten (auf Systemen mit japa-
nischen Spracheinstellungen)
Strukturierte Vorlagen

Im Lieferumfang der strukturierten Version von FrameMaker sind strukturierte Vorlagen fiir Briefe,
Memos, Faxe, Umschldge, Meldungen, Gliederungen, Infoblatter, Blicher, FAQs und Biicher mit nur
einer Quelle enthalten.

In strukturierten Vorlagen konnen die folgenden Eigenschaften gespeichert werden:

o Elementdefinitionen, die zuldssige Inhalte, Attribute und Formate fir Elemente festlegen
. Abséatze und Zeichen, die in den Elementdefinitionen Formatinformationen verwenden

. Als Platzhalter verwendete Variablen fiir von FrameMaker aktualisierten Text

. Formatinformationen fiir Querverweise und Bedingungs-Tags

. Definitionen fir Farben, die Text und Objekten zugewiesen werden kénnen
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HiNnwels: Wenn Sie mit strukturierten Dateien arbeiten, wurden von dem Anwendungsentwickler mogli-
cherweise spezielle Dokumente angelegt, die die Umwandlung aus der und in die strukturierte
Anwendung steuern. Diese Dokumente kdnnen eine Vorlage beinhalten, die strukturierte Dateien in
FrameMaker formatiert. Diese Vorlage wird automatisch angewendet, wenn Sie aus einer strukturierten
Anwendung importieren.

Gestalten des Seitenlayouts

Entwerfen Sie das Seitenlayout und Textformate, standardisieren Sie Formate, richten Sie die
Nummerierung ein und definieren Sie speziellen Text in FrameMaker.

1)

2)

3)
4)

5)

Erstellen eines Dokuments. Sie kdnnen entweder mit einem neuen Dokument in Spezialformat
beginnen oder mit einer Kopie eines vorhandenen Dokuments, das Sie andern mdéchten.

Tipp: Bei der Gestaltung des Seitenlayouts konnen Sie sehen, wie gegeniberliegende Seiten wirken,
indem Sie diese nebeneinander anzeigen. Wahlen Sie Ansicht > Optionen, und wahlen Sie dann in
der Dropdown-Liste ,Blattern” den Eintrag ,,Gegenliberliegende Seiten”. VergrofRern Sie das Doku-
mentfenster und zoomen Sie die Darstellung bei Bedarf kleiner, damit beide Seiten im Fenster Platz
finden.

Definieren Sie das Spaltenlayout. Wenn Sie mit einem Dokument in Spezialformat begonnen
haben, sind Rander und Anzahl der Spalten bereits festgelegt. Wenn Sie ein existierendes Doku-
ment bearbeiten, ist méglicherweise eine Anderung des Spaltenlayouts erforderlich.

Fligen Sie bei Bedarf Vorgabeseiten hinzu und geben Sie ihnen einen Namen.

Geben Sie Hintergrundtext und -grafiken einschlieBlich Kopf- und FulRzeile auf den Vorgabeseiten
ein.

Wenn in einer laufenden Kopf- oder FufSzeile Text oder automatische Nummerierung fiir einen Do-
kumentabsatz angezeigt wird (z. B. ein Kapitel- oder Abschnittstitel), enthdlt sie eine Variable fiir

laufende Kopf- und FufSzeilen, die auf den entsprechenden Absatz verweist. Um diese Variable
einzurichten, bestimmen Sie den Stil fiir den Absatz.

Definieren Sie die speziellen Dokumenteigenschaften wie Nummerierung und Textoptionen, und
legen Sie die Darstellungsoptionen fest.

Entwerfen von Textstilen

Nach dem Gestalten des Seitenlayouts sollten Sie festlegen, wie der Text formatiert wird:

Wenn lhr Dokument auch auf anderen Computern geoffnet oder gedruckt wird, verwenden Sie
Schriften, die auf den meisten Rechnern installiert sind.

Absatzstile bilden die Basis der Textformatierung und sollten deshalb vor der Definition der
Zeichenstile festgelegt werden.

Geben Sie bei der Definition eines Zeichenstils im Dialogfeld ,Zeichengestaltung” fir alle Einstel-
lungen ,Beibehalten” an, und legen Sie nur die zu dndernden Einstellungen fest. Ein solcher Stil
eignet sich fir jeden Absatzstil.

Tag-Namen sollten nicht auf das Aussehen des Formats, sondern auf seinen Verwendungszweck
hinweisen. Nennen Sie z. B. ein Format fir hervorgehobenen Text nicht Fett, sondern Hervorhe-
bung. Wenn Sie spater beschlieBen, Kursivschrift fir Hervorhebungen zu verwenden, kdnnen Sie
das Format Hervorhebung umdefinieren, ohne den Namen zu andern.
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. Verwenden Sie Namen, die aussagekraftig und einprdagsam sind. Nennen Sie z. B. Stile fir nummeri-
erte Listen Schrittl und Schrittn, nicht SI und Sn. Wenn Sie Absatz- und Zeichenstile mithilfe der
Tastatur anwenden mochten, kénnen Sie die Tags sch1 Schritt1 und schn Schrittn nennen. Auf diese
Art konnen Sie mithilfe der Tastatur schnell auf Tags und Beschreibungen zugreifen.

J Wenn die Vorlage mehr als eine automatische Nummerierungsfolge enthalt, fligen Sie jedem
Format eine Kennung fir die automatische Nummerierung hinzu. Definieren Sie z. B. die automa-
tische Nummerierung fur Arbeitsschritte als S:<n+>, wobei S: die Schrittkennung ist.

o Verwenden Sie in Absatzstilen durchgehend , Abstand: Oben” oder ,Abstand: Unten®, um den
Abstand ober- und unterhalb von Absatzen festzulegen. (In FrameMaker wird nur der groRere der
beiden Werte zur Bestimmung der Abstdnde zwischen Absatzen verwendet.)

Standardisieren von Grafiken, Rahmen und Tabellen

Wenn die Dokumente spater Grafiken, Rahmen oder Tabellen enthalten, orientieren Sie sich an
folgenden Richtlinien, um ein einheitliches Aussehen zu garantieren:

. Platzieren Sie Standardelemente auf einer Referenzseite. Sie kdnnen Grafiken einfligen, die Benu-
tzer immer wieder benétigen, z. B. ein Symbol, das die Aufmerksamkeit auf Hinweise und
Warnungen lenkt, oder einen verankerten Rahmen mit Standardhéhe und -breite. Diese Elemente
kénnen dann von den Benutzern nach Bedarf kopiert und eingefligt werden.

J Definieren Sie einen Absatzstil fiir verankerte Rahmen. Damit erzielen Sie einheitliche Abstande um
Grafiken. Flr einen Absatzstil mit dem Namen Rahmen kdnnte z. B. die Einstellung ,Abstand:
Unten” auf 20 Punkt und die Einstellung ,,Zeilenabstand” auf null gesetzt werden. Jeder Rahmen
konnte dann in einem leeren Absatz mit dem Stil ,Rahmen” verankert werden. Eine Alternative
hierzu ware die Verwendung von einzelligen Tabellen und ihren Titeln flr Grafiken und deren
Beschriftung.

o Wenn Textrahmen fiir Bildbeschriftungen verwendet werden, sollten Sie einen Absatzstil fur die
Beschriftungen definieren. Werden fiir die Bildbeschriftungen Textzeilen benutzt, definieren Sie
einen Zeichenstil. (Auf eine Textzeile kann kein Absatzstil angewendet werden.)

. Wahlen Sie eine Farbpalette und definieren Sie bei Bedarf die Farben und Farbauszlige neu.

J Bereiten Sie Standardtabellenformate vor. Nicht alle Eigenschaften, die Sie fir Tabellen festlegen,
konnen in ein anderes Dokument importiert werden. Die Breite von Text (wie auch andere Eigen-
schaften) kann in den Tabellen erheblich variieren. Daher missen Benutzer einige Eigenschaften
wahrscheinlich immer selbst anpassen. Betrachten Sie Ihre Tabellen als Ausgangspunkt fiir die
Benutzer.

Einrichten der Nummerierung

Die Seitennummerierung flir neue Dokumente ist auf ,Wieder bei 1 beginnen” eingestellt.

Wenn Sie eine Vorlage fiir fortlaufende Seitennummerierung in Blichern erstellen, mochten Sie die
Seitennummerierung in der Vorlage vielleicht auf Nummerierung von voriger Seite im Buch weiter-
fiihren festlegen. Zusatzlich sollten Sie die Kapitelnummerierung auf Nummerierung von vorheriger
Datei im Buch weiterfiihren einstellen.

Definieren von speziellem Text und Schriften

Folgende Aktionen kénnen fiir das Definieren spezieller Textelemente erforderlich sein:
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o Legen Sie flr FuBnoten eine Nummerierungsart, ein Nummerierungsformat und weitere Eigen-
schaften fest.

L Definieren Sie Querverweisformate. Standardisieren Sie diese Formate so weit wie moglich. Wenn
Querverweise z. B. immer mit siehe beginnen sollen, nehmen Sie dieses Wort in die Formatdefini-
tion auf.

. Definieren Sie Benutzervariablen fir Produktnamen, Dokumentnamen und andere Elemente, die
sich im Projektverlauf andern kdnnen.

. Definieren Sie Bedingungs-Tags, Bedingungsformate und Anzeigeeinstellungen fiir Bedin-
gungs-Tags.

. Definieren Sie benutzerdefinierte Markentypen, wenn spezialisierte Indizes erstellt werden
mussen.

. Definieren Sie GleichungsgrofRen und -schriften, wenn Dokumente Gleichungen enthalten werden.

. Wenn Ihre Dokumente japanischen Text enthalten, missen die zu verwendenden kombinierten
Schriften definiert und die Eigenschaften fiir Rubi-Text festgelegt werden.

Festlegen von HTML-Optionen

Wenn Dokumente, die auf lhren Vorlagen basieren, in das HTML-Format konvertiert werden sollen,
miussen Sie die Zuordnungen und Konvertierungsmakros fiir die Konvertierung der Dokumente
einrichten.

] Richten Sie die Zuordnung der FrameMaker-Absatzstile und -Zeichenstile zu HTML-Tags ein.

. Erstellen Sie Konvertierungsmakros, die Querverweisformate in eine geeignete Form fiir Onlinedo-
kumente umwandeln.

. Erstellen Sie bei Bedarf weitere Konvertierungsmakros (z. B. zur Anzeige eines Logos am Anfang
jeder neuen Webseite oder zur Definition eines Titels fir das HTML-Dokument).

Erstellen von Vorlagen fiir generierte Dateien

Erstellen Sie Vorlagen fir generierte Dateien, aktualisieren Sie Formate in einer generierten Datei,
importieren Sie Formate, verwenden Sie die Formatierung einer vorhandenen Datei beim Generieren
der neuen Datei in FrameMaker.

Wenn Sie ein Inhaltsverzeichnis, einen Index oder eine andere generierte Datei in einem Ordner
erstellen, der neben dem Quelldokument oder der Buchdatei eine andere Datei mit demselben Namen
wie die generierte Datei enthalt, verwendet FrameMaker bei der Generierung der neuen Datei die
Formatierung der vorhandenen. Dabei dient die bestehende generierte Datei als Vorlage fiir die neue
Datei, als hatten Sie Formate aus ihr importiert. Mithilfe dieser Funktion kdnnen Sie Vorlagen fiir gener-
ierte Dateien erstellen, die Seitenlayout, Absatz- und Zeichenstile sowie Formatierungsinformationen
der Referenzseite enthalten.
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Es ist auch moglich, die Formate in einer generierten Datei durch den Import von Formaten aus einer
Vorlage zu aktualisieren. Allerdings muss die Datei nach dem Import der Formate wahrscheinlich neu
generiert werden, damit alle Formatierungen sichtbar sind.

1)  Offnen Sie die Dokument- oder Buchdatei, aus der Sie das Inhaltsverzeichnis, den Index oder eine
sonstige Datei generieren mochten.

2) Generieren Sie die Datei.
3) Formatieren Sie die generierte Datei. Diese formatierte Datei ist Ihre Vorlage.

4)  Speichern Sie die generierte Datei. Stellen Sie sicher, dass sich die aus der generierten Datei
erstellte Vorlage in dem Ordner mit der Dokument- oder Buchdatei befindet, aus der eine neue
generierte Datei erstellt werden soll.

RELATED LINKS:
Formate aus Vorlagen oder Dokumenten importieren

Erstellen von Vorlagen zum Andern der Einstellungen fiir Bedingungs-Tags

Erfahren Sie, wie Sie Vorlagen erstellen, um die Einstellungen fir Bedingungs-Tags in FrameMaker zu
andern.

Wenn Sie haufig die Ansicht von Bedingungsdokumenten in einem Buch @ndern, ist es hilfreich, wenn fiir
jede Ansicht eine Vorlage existiert. Sie kdnnen dann die Ansicht aller Dateien im Buch gleichzeitig andern,
indem Sie einfach die Einstellungen fiir Bedingungs-Tags aus einer der Vorlagen in die Buchdatei impor-
tieren.

Soll die Ansicht eines einzelnen Dokuments mit Bedingungs-Tags gedandert werden, ist es einfacher, die
Einstellungen von ,Ein-/Ausblenden” fir das Dokument zu dndern.

1) Definieren Sie eine Basisvorlage fir das Bedingungsdokument. Dabei missen alle Bedingungen und
Bedingungsformate eingeblendet sein. Aus dieser Vorlage importieren Sie spater die Einstellungen
fiir Bedingungs-Tags, bevor Sie ein Dokument bearbeiten.

2) Definieren Sie eine weitere Vorlage fiir jede Bedingungskombination, die angezeigt werden soll.
Diese Vorlagen dienen zum Anzeigen oder Drucken jeweils einer Variante des Dokuments. Sie
kénnen in diesen Vorlagen auch Variablen und Formate definieren, die jeweils nur zu einer Darstel-
lung gehoren.

Andern von Vorlagen fiir leeres Papier und Textdateien

Andern Sie Vorlagen fiir leere Papier- und Textdateien und aktualisieren Sie das Seitenlayout in
FrameMaker.

Sie konnen die spezielle Vorlage fiir leeres Papier andern, damit sie die gewlinschten Formate enthalt.
Die Vorlage kann die gleichen Formate enthalten wie jede andere Vorlage, ausgenommen das Seiten-
layout. Das Layout der Vorgabeseite, die Anzahl der Spalten und die Rander werden bei der Erstellung
der Dokumente festgelegt.

Es ist auch moglich, die spezielle Vorlage zu dndern, die FrameMaker beim Offnen von Textdateien
verwendet.
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HINWEIS: Sie konnen Sie den Dateinamen dndern, nach dem FrameMaker bei der Erstellung eines Doku-
ments mit leerem Papier oder beim Offnen einer Textdatei sucht.

Andern von Vorlagen fiir leeres Papier

1)  Andern Sie ein Dokument so, dass es die gewiinschten Formate und Einstellungen enthilt. Lassen
Sie vorhandene Vorgabeseiten leer und erstellen Sie keine speziellen Vorgabeseiten.

2) Loschen Sie alle Textrahmen aus linken und rechten Vorgabeseiten, selbst wenn das Dokument nur
Einzelseiten enthalt. Wahlen Sie in einem einseitigen Dokument Format > Seitenlayout >
Seitenumbruch, wahlen Sie Doppelseitig, und klicken Sie auf Festlegen. Wahlen Sie dann die
Textrahmen auf den Vorgabeseiten aus und I6schen Sie diese.

3)  Wabhlen Sie Format > Dokument > Seiten l6schen, und I6schen Sie alle Arbeitsseiten.

4)  Speichern Sie das Dokument mithilfe der Custom-Datei im FrameMaker-Ordner ,fminit“. (Wenn Sie
Neu > Adobe FrameMaker-Dokument im Kontextmeni in einem Ordner oder auf dem Desktop
wahlen, wird die Datei ,,Shellnew.fm“ verwendet.)

Andern von Vorlagen fiir Textdateien

1)  Andern Sie ein Dokument so, dass es die gewiinschten Formate und Einstellungen enthilt. Sie
konnen z. B. Kopf- und FuRzeilen, einen Absatzformatkatalog und Vorgabeseitengrafiken in das
Vorlagendokument einfiigen.

2)  Loschen Sie den gesamten Text aus den Arbeitsseiten.

3) Klicken Sie in den leeren Textrahmen auf Seite 1 und weisen Sie ihm den Absatzstil zu, der fir den
gesamten Text des Dokuments verwendet werden soll. Die Standardvorlage verwendet den Absa-
tzstil ,Haupttext”.

4)  Speichern Sie das Dokument, indem Sie die txttmplt-Datei im FrameMaker-Ordner ,fminit”
verwenden.

Formate aus Vorlagen oder Dokumenten importieren

Lernen Sie, wie Sie Formate aus einer Vorlage oder einem Dokument importieren, und erfahren Sie mehr
Uber Import- und Aktualisierungseinstellungen in FrameMaker.

Sie kdnnen Absatz- und Tabellenstile sowie Variablendefinitionen und andere Eigenschaften aus jedem
beliebigen Dokument importieren.

Es ist auch moglich, irreguldre Formate im Dokument beizubehalten oder zu I16schen, z. B. manuelle
Anderungen an einem Absatzformat, die nicht im Absatzkatalog gespeichert wurden.

Importieren von Stilen

1)  Offnen Sie das Dokument, dessen Formate Sie importieren wollen.

2) Bringen Sie das entsprechende Dokument- oder Buchfenster als aktives Fenster in den Vorder-
grund. Wenn ein Buchfenster aktiv ist, wahlen Sie die zu aktualisierenden Dokumente aus.

3)  Wabhlen Sie in dem Dokument oder Buch, das Sie aktualisieren, die Option Datei > Formate > impor-
tieren.
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4)  Fihren Sie eine der folgenden Aktionen aus:

- Um Formate aus einem Dokument zu importieren, wahlen Sie dieses Dokument aus der Drop-
down-Liste ,,Import aus Dokument”. In der Dropdown-Liste werden alle gedffneten, gespe-
icherten Dokumente aufgefihrt.

- Wenn Sie Formate des aktuellen Dokuments erneut anwenden wollen, wahlen Sie ,, Aktuelles
Dokument” aus der Dropdown-Liste ,,Import aus Dokument®”.

5)  Wabhlen Sie die Einstellungen fiir Importieren und Aktualisieren, die auf das aktuelle Dokument
angewendet werden sollen. StandardmaRig sind alle Optionen aktiviert. Um alle Optionen auf
einmal zu deaktivieren, klicken Sie auf ,,Auswahl aufheben” bzw. , Alles auswahlen”. Wenn Sie Vari-
ablendefinitionen, Querverweisformate oder FrameMath-Definitionen aktualisieren und in diesen
Elementen Zeichenstile verwenden, aktivieren Sie auRerdem ,Zeichenstile”, damit die Formate in
das Dokument (ibernommen werden.

6) Um Anderungen zu léschen, die an einzelnen Formaten vorgenommen, jedoch nicht im Katalog
gespeichert wurden, gehen Sie wie folgt vor:

- Um manuelle Seitenumbriiche zu entfernen, die nicht Bestandteil eines Formats im Absatz-
formatkatalog sind, wahlen Sie ,,Manuelle Seitenumbriiche”.

- Um irreguldare Zuweisungen aus Absatzen, Zeichen und dem Seitenlayout sowie der Tabellen-
formatierung zu entfernen, wahlen Sie Manuelle Format-/Layoutdanderungen.

7)  Klicken Sie auf Importieren.

RELATED LINKS:
Irreguldre Layouts

Einstellungen fiir Import und Aktualisierung

Beim Importieren von Formatinformationen aus einer Vorlage kombiniert FrameMaker die importierten
Formate mit den im Dokument vorhandenen, anstatt sie zu ersetzen. Wenn Sie z. B. Absatzstile impor-
tieren, fligt FrameMaker diese Stile dem Absatzkatalog des Dokuments hinzu. Wenn Stile in beiden Doku-
menten denselben Namen haben, wird der vorhandene Stil im Dokument durch den importierten
ersetzt. Alle anderen Stile bleiben unverandert im Dokument erhalten.

HINWEIS: Bei Formatnamen wird Gro3- und Kleinschreibung unterschieden. Beispiel: Body ist nicht gleich
body.

Absatzstile
Der Absatzkatalog der Vorlage wird in das Dokument eingelesen und alle Stile im Katalog werden
neu auf das Dokument angewendet. Die Einstellungen fiir PDF-Lesezeichen werden ebenfalls in das
Dokument kopiert.

Zeichenstile
Der Zeichenkatalog der Vorlage wird in das Dokument eingelesen und alle Stile im Katalog werden
neu auf das Dokument angewendet.

Seitenlayouts

Die Vorgabeseiten der Vorlage werden in das Dokument eingelesen und Arbeitsseiten werden mit
den Anderungen in den Vorgabeseiten aktualisiert. Wenn Vorlage und Dokument eine Vorgabe-
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seite gleichen Namens enthalten, ersetzt die Vorgabeseite aus der Vorlage diejenige des Doku-
ments. FrameMaker kopiert die Eigenschaften der Anderungsbalken, alle Einstellungen aus den
Dialogfeldern ,,Format” und , Seitenumbruch” sowie die meisten Einstellungen aus dem Dialogfeld
,Darstellungsoptionen®.

Tabellenformate

Der Tabellenformatkatalog der Vorlage und die Lineaturstile werden in das Dokument eingelesen
und alle Formate im Katalog werden neu auf das Dokument angewendet.

Farbdefinitionen

Die Farbdefinitionen und Farbausziige der Vorlage werden in das Dokument eingelesen.

Dokumenteigenschaften

Die speziellen Markentypen und FuBnoteneigenschaften, Band-, Kapitel-, Seiten-, Absatz-,
FuBnoten- und TabellenfuBnoten-Nummerierungen aus dem Dialogfeld ,Nummerierungseigen-
schaften”, die mit der Einstellung ,,Zeilenumbruch erlaubt nach” im Dialogfeld , Textoptionen” fest-
gelegten Zeichen sowie die Einstellungen der Option ,Hohenausgleich” im Dialogfeld
»Zeilenlayout” werden aus der Vorlage in das Dokument eingelesen. Die Einstellungen fir
PDF-Einrichtung (mit Ausnahme der Lesezeicheneinstellungen) werden ebenfalls in das Dokument
eingelesen. In Systemen mit japanischen Spracheinstellungen werden auch die Rubi-Eigenschaften
und Kumihan-Regeln (japanische typografische Regeln) in das Dokument eingelesen.

Referenzseiten

Alle Referenzseiten der Vorlage (auBer FrameMath-Referenzseiten) werden in das Dokument
eingelesen. Enthalten Vorlage und Dokument eine Referenzseite gleichen Namens, wird die
Referenzseite im Dokument durch diejenige aus der Vorlage ersetzt. Um FrameMath-Referenz-
seiten zu importieren, wahlen Sie ,FrameMath-Definitionen”.

Variablendefinitionen

Die Variablendefinitionen der Vorlage werden in das Dokument eingelesen.

Querverweisformate

Die Querverweisformate der Vorlage werden in das Dokument eingelesen und interne Querver-
weise werden aktualisiert.

Einstellungen fiir Bedingungs-Tags

Bedingungs-Tags und die Einstellungen fir ,Ein/Ausblenden” der Vorlage werden in das Dokument
eingelesen und auf Bedingungs-Tags angewendet.

FrameMath-Definitionen

Gleichungsgrofie und -schrift, spezielle FrameMath-Elementdefinitionen und Frame-
Math-Referenzseiten werden in das Dokument kopiert. Falls beim Einlesen der Referenzseiten ein
spezielles FrameMath-Element im Dokument geldscht wird, ersetzt FrameMaker dieses Frame-
Math-Element in Gleichungen durch den Namen des Elements und umgibt diesen mit Frageze-
ichen.
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Kombinierte Schriften

Auf Systemen mit japanischer Sprache werden die Einstellungen fiir Kombinationen aus japa-
nischer und lateinischer Schrift in das Dokument eingelesen und auf den Text im Dokument ange-
wendet, der kombinierte Schriften verwendet.
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Importieren von Formatierungseigenschaften

Erfahren Sie mehr Gber das Importieren von Formatierungseigenschaften in Adobe FrameMaker.

In diesem Thema

. Einfiihrung

. Formateinstellungen

J Importieren von Eigenschaften aus einer Vorlage

Einflihrung

Sie kénnen zahlreiche verschiedene Formatinformationen importieren, darunter Seitenlayouts, Absatz-
und Tabellenformate, Variablen- und Farbdefinitionen, Objekteigenschaften als Stil sowie Einstellungen
fir bedingte Tags. Wenn in Ihrem Quelldokument bedingte Ausdriicke erstellt wurden, werden diese
zusammen mit dem Status Nach Ausdruck anzeigen ebenfalls in die Ziel[dokumente importiert. Ebenso
werden bei strukturierten Dokumenten auch die von lhnen definierten Einstellungen fir Filtern nach
Attribut importiert.

1)  Offnen Sie die Vorlage mit den Formaten. Die Vorlage muss benannt und gespeichert sein.

2)  Offnen Sie das Dokument oder das Buch, das Sie aktualisieren méchten. Wenn ein Buchfenster
aktiv ist, wahlen Sie die zu aktualisierenden Dokumente aus.

3)  Wahlen Sie in einem Dokument oder Buch, das Sie aktualisieren, Datei > Importieren > Formate.

4)  Wahlen Sie in der Dropdwon-Liste Import aus Dokument die gewlinschte Vorlage. Das Menii listet
alle gedffneten benannten Dokumente auf.

Sie kénnen auch das aktuelle Dokument auswdhlen, um die Formate, die das Dokument bereits be-
sitzt, erneut anzuwenden. Dies eignet sich besonders zum Entfernen von Formatéinderungen, wie in
Schritt 6 beschrieben.

5)  Wabhlen Sie die Einstellungen fir Importieren und Aktualisieren, die auf das aktuelle Dokument
angewendet werden sollen.
- Wenn Sie Querverweisformate, mathematische Definitionen oder Variablendefinitionen
aktualisieren und eines dieser Elemente Zeichenstile verwendet, wahlen Sie zusatzlich
Zeichenformate, sodass dem Dokument alle neuen Stile hinzugefiigt werden.

- Wenn die HTML-Zuordnungen gedndert wurden, wahlen Sie Referenzseiten.

6) Wenn Sie Formatanderungen entfernen mochten, die nicht in Katalogstilen gespeichert sind,
gehen Sie wie folgt vor:

- Um Seitenumbriiche zu entfernen, die nicht Teil eines Absatzstils sind, wahlen Sie Manuelle
Seitenumbriiche.

- Um irreguldre Zuweisungen aus Absatzen, Zeichen und dem Seitenlayout sowie der Tabellen-
formatierung zu entfernen, wahlen Sie Manuelle Format-/Layoutidnderungen.

WIcHTIG: In den meisten Féllen sollten Sie die Option Manuelle Format-/Layoutinderungen in
einem strukturierten Dokument nicht verwenden, da die Elementdefinitionen manchmal spezielle
Formate verwenden.

7)  Klicken Sie auf Importieren.
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Formateinstellungen

Wenn Sie Stile importieren, liest FrameMaker die neuen Formatierungsinformationen in das Dokument
ein.

Wenn Sie z. B. Tabellenstile importieren, werden die Stile dem Tabellenformatkatalog hinzugefiigt.
Wenn ein bereits im Katalog befindlicher Stil denselben Namen besitzt wie ein importierter Stil, ersetzt
der importierte Stil den urspriinglichen. Alle anderen Stile bleiben unverdndert im Katalog erhalten.

Absatzstile

Der Absatzkatalog der Vorlage wird in das Dokument eingelesen, und alle Stile im Katalog werden
neu auf das Dokument angewendet.

Zeichenstile

Der Zeichenkatalog der Vorlage wird in das Dokument eingelesen, und alle Stile im Katalog werden
neu auf das Dokument angewendet.

Seitenlayouts

Die Vorgabeseiten der Vorlage werden in das Dokument eingelesen und Arbeitsseiten werden mit
den Anderungen in den Vorgabeseiten aktualisiert. Wenn sowohl die Vorlage als auch das Doku-
ment eine Vorgabeseite mit demselben Namen besitzen, ersetzt die Vorgabeseite der Vorlage
diejenige des Dokuments. FrameMaker kopiert die Eigenschaften des Anderungsbalkens, alle
Einstellungen in den Dialogfeldern Format und Seitenumbruch, und die meisten Einstellungen im
Dialogfeld Darstellungsoptionen.

Tabellenformate

Der Tabellenformatkatalog der Vorlage und die Lineaturstile der Vorlage werden in das Dokument
eingelesen, und alle Formate im Katalog werden neu auf das Dokument angewendet.

Farbdefinitionen
Die Farbdefinitionen und Farbausziige der Vorlage werden in das Dokument eingelesen.

Dokumenteigenschaften

Die speziellen Markentypen und FulRnoteneigenschaften, Band-, Kapitel-, Seiten-, Absatz-,
FuBnoten- und Tabellenfulnoten-Nummerierungen aus dem Dialogfeld ,,Nummerierungseigen-
schaften”, die mit der Einstellung ,,Zeilenumbruch erlaubt nach” im Dialogfeld , Textoptionen” fest-
gelegten Zeichen sowie die Einstellungen der Option ,,H6henausgleich” im Dialogfeld
»Zeilenlayout” werden aus der Vorlage in das Dokument eingelesen. Die Einstellungen fir
PDF-Einrichtung (mit Ausnahme der Lesezeicheneinstellungen) werden ebenfalls in das Dokument
eingelesen. In Systemen mit japanischen Spracheinstellungen werden auch die Rubi-Eigenschaften
und Kumihan-Regeln (japanische typografische Regeln) in das Dokument eingelesen.

Referenzseiten

Die Referenzseiten der Vorlage (auller FrameMath™-Referenzseiten) werden in das Dokument
eingelesen. Wenn sowohl die Vorlage als auch das Dokument eine Referenzseite mit demselben
Namen besitzen, ersetzt die Referenzseite der Vorlage diejenige des Dokuments. Wahlen Sie Fram-
eMath-Definitionen, um die FrameMath-Referenzseiten zu importieren.
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Variablendefinitionen

Die Variablendefinitionen der Vorlage werden in das Dokument eingelesen.

Querverweisformate
Die Querverweisformate der Vorlage werden in das Dokument eingelesen und interne Querver-
weise werden aktualisiert.

Einstellungen fiir Bedingungs-Tags
Die Bedingungs-Tags und die Einstellungen fiir Ein-/Ausblenden der Vorlage werden in das Doku-
ment eingelesen.

FrameMath-Definitionen

Gleichungsgrofie und -schrift, spezielle FrameMath-Elementdefinitionen und Frame-
Math-Referenzseiten werden in das Dokument kopiert. Falls beim Ubertragen der Referenzseiten
spezielle FrameMath-Elemente geloscht werden, ersetzt FrameMaker die FrameMath-Elemente in
Gleichungen durch den Namen des in Fragezeichen eingeschlossenen Elements.

HINwEIS: In FrameMaker-Gleichungen bezieht sich der Begriff FrameMath-Element auf einen Teil eines
Ausdrucks. Ein FrameMath-Element ist kein strukturelles Element.
Kombinierte Schriften
Auf Systemen mit japanischen Spracheinstellungen werden die Spezifikationen zusammenge-
setzter Schriften in das Dokument eingelesen.
Objektstile

Die Eigenschaften von in der Vorlage verfligbaren Objekten wie Bildern, verankerten Rahmen,
Grafiken, Gleichungen und anderen werden in das Dokument eingelesen.

Importieren von Eigenschaften aus einer Vorlage

Sie kdnnen Elementdefinitionen und andere Eigenschaften aus jedem FrameMaker-Dokument in |hr
Dokument importieren. Normalerweise ist dieses andere Dokument eine Vorlage, die Sie nicht fir die
Erstellung des Dokuments verwendet haben.

Wenn Sie Ihr Dokument mit der entsprechenden Vorlage erstellt haben, ist es nicht noétig, die Eigen-
schaften zu importieren. Das Dokument verfiigt bereits liber die erforderlichen Eigenschaften.

Wenn die Dokumentvorlage Uberarbeitet wurde, flihren Sie einen erneuten Import der Vorlage aus, um
Ihr Dokument zu aktualisieren.

Sie kdnnen Eigenschaften auch in alle Dateien eines Buches gleichzeitig importieren.

RELATED LINKS:
Importieren von Stilen in ein Buch

Irreguléire Formate
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Bearbeiten von Inhalten

Erfahren Sie, wie Sie Inhalte in Adobe FrameMaker bearbeiten.
FrameMaker bietet eine Vielzahl von Optionen und Tools fir die Erstellung von Inhalten.
Neben Text kénnen Sie Grafiken, Bilder, Tabellen und Links in Thre Dokumente einfligen.

AuRRerdem kdnnen Sie komplexe mathematische Gleichungen und QR-Codes einbeziehen.
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Text und Sonderzeichen

Erfahren Sie, wie Sie einem Dokument in Adobe FrameMaker Text und Sonderzeichen hinzufiigen.

Als Authoring-Umgebung bietet FrameMaker Ihnen Werkzeuge zum einfachen Hinzufligen von Text
(einschlieBlich Sonderzeichen) zu einem Dokument.

Wihrend Text die Standardzeichen wie Buchstaben und Zahlen einschlieRt, konnen Sie auch solche
Zeichen wie Tabulatoren, Aufzahlungspunkte, mathematische Symbole eingeben.

Hinzufiigen von Text und Sonderzeichen

Erfahren Sie, wie Sie in FrameMaker Text, Sonderzeichen, Tabulatoren, spezielle Leerzeichen und typog-
raphische Anflihrungszeichen hinzufiigen.

Die Einfligemarke kennzeichnet die Stelle, an der Sie Text eingeben oder bearbeiten. Die Position der
Einfligemarke bestimmt, auf welchen Absatz die Formatierungsbefehle zugewiesen werden.

Sie kénnen auch spezielle Textelemente wie Querverweise, Fuinoten, Variablen und Marken aus dem
Menii ,Spezial” einfligen. Wenn Sie auf ein spezielles Textelement wie z. B. einen Querverweis, eine Vari-
able oder einen Texteinschub klicken, wird das gesamte Element ausgewahlt.

Lasst sich die EinflUgemarke nicht in oder neben Text platzieren, kann dies folgende Ursachen haben:

] Es handelt sich wahrscheinlich um Hintergrundtext aus einer Vorgabeseite. Offnen Sie in diesem
Fall die betreffende Vorgabeseite und setzen Sie die Einfligemarke an die entsprechende Textstelle.

. Der Text wurde automatisch erstellt, z. B. mit Absatznummerierungen, Querverweisen oder Kopf-
und FuRzeilen.
RELATED LINKS:

Tabulatoren dndern

Text und Sonderzeichen

Sonderzeichen

In diesem Thema

. Einfiihrung

J Tabulatoren

. Leerraumzeichen

. Anfilihrungszeichen

Einfiihrung

Zusatzlich zu Standardzeichen konnen Sie Auszeichnungspunkte, Bindestriche, Leerzeichen mit fester
Breite, mathematische Symbole, internationale Zeichen und andere Sonderzeichen eingeben.

HINwEIS: In FrameMaker wurden keine Zeichenfolgen (Alt) fir die Schriften ,Dingbats” und ,,Symbol“
implementiert, weil standardmaRig Unicode-Entsprechungen von Codeseite 1252 fiir diese Schriften
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bereitgestellt werden. Zeichenfolgen (Alt) wurden nur fir die Schriftfamilie ,,MakerRoman® implemen-
tiert.

Ill

Eine Liste der Zeichen in den Schriften ,,Symbol” und , Zapf Dingbats” sowie eine Liste akzentuierter
Zeichen im Standardzeichensatz und Informationen (iber das Einfligen des Euro-Wahrungssymbols
finden Sie im Onlinehandbuch FrameMaker-Zeichensdtze.

Manche Sonderzeichen werden in Dialogfeldern auf eine andere Art und Weise eingegeben oder ange-
zeigt. Unter Windows geben Sie Zeichenfolgen ein, indem Sie mit einem umgekehrten Schragstrich (\)
beginnen. Eine Auflistung dieser Zeichenfolgen finden Sie unter Dialogfelder.

Tabulatoren

Jedes Mal, wenn Sie Tabulatortaste ? driicken, wird ein Tabulatorsymbol yin den Text eingebettet. Dieses
Symbol wird nur im Bildschirm angezeigt (sofern Steuerzeichen eingeblendet sind). Im gedruckten Doku-
ment ist es nicht sichtbar.

Wenn im aktuellen Absatz Tabulatorstopps gesetzt sind, versetzt FrameMaker die Einfligemarke und
nachfolgenden Text bei jedem Driicken von Tabulatortaste ? um einen Tabulatorstopp. Wenn keine
Tabulatorstopps definiert sind, zeigt das Driicken von Tabulatortaste ? keine Wirkung. Wenn Sie Tabula-
tortaste ? haufiger driicken, als Tabulatorstopps vorhanden sind, (iberlagern sich die Tabulatorsymbole.
Wenn Sie dem Absatz spater weitere Tabulatorstopps hinzufligen, richtet FrameMaker den Text korrekt
an ihnen aus.

FrameMaker verwendet keine relativen, sondern absolute Tabulatorstopps. Bei relativen Tabulator-
stopps bewegt sich die Einfligemarke mit jedem Driicken der Tabulatortaste an den nachsten verfiig-
baren Tabulatorstopp. Bei absoluten Tabulatorstopps bewegt sich die Einfligemarke beim n-ten Driicken
der Tabulatortaste an den n-ten Tabulatorstopp in einer Zeile. Falls sich dieser Stopp links von der
Einfigemarke befindet, bewegt sich die Einfigemarke nicht.

Leerraumzeichen

Durch Driicken der Leertaste wird ein proportionales Leerzeichen eingefligt (dessen Breite von den
benachbarten Zeichen abhdngt). Sie kdnnen auch spezielle Leerzeichen mit fester Breite einfligen, z. B.
um den Abstand zwischen zwei Wortern zu vergroBern. Worter, die durch solche Leerzeichen getrennt
sind, bleiben immer in einer Zeile zusammen.

Sie kdnnen folgende Typen spezieller Leerzeichen verwenden:

. Ein m-Leerzeichen hat eine mit dem Schriftgrad tGibereinstimmende Breite. Verwenden Sie z. B. eine
10-Punkt-Schrift, ist das m-Leerzeichen 10 Punkte breit.

. Ein n-Leerzeichen hat die halbe Breite des m-Leerzeichens.

o Numerische Leerzeichen haben die Breite des Zeichens Null (0) der aktuellen Schrift. Alle Ziffern

weisen in der Regel die gleiche Breite auf. Daher eignet sich dieses Leerzeichen fiir die Ausrichtung
von Zahlen in einer Spalte ohne Tabulatoren.

o Ein t-Leerzeichen hat 1/12 der Breite eines m-Leerzeichens. Es wird oft zwischen einer Zahl und
einer MaReinheit verwendet oder zwischen Zeichen, die zu nahe beieinander erscheinen, wie z. B.

/).

. Umbruchgeschiitzte Leerzeichen haben die Breite des Standardleerzeichens der aktuellen Schrift.
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TEXT UND SONDERZEICHEN

Wenn die Option ,Leerzeichenkontrolle” aktiviert ist, konnen Sie nicht mehrere aufeinander folgende
proportionale Leerzeichen eingeben. Die Eingabe mehrerer Leerzeichen fester Breite ist jedoch moglich.

Anfiihrungszeichen

Wenn typografische Anflihrungszeichen aktiviert sind, verwendet FrameMaker gekriimmte
Anfuhrungszeichen oder diejenigen Anfliihrungszeichen, die Sie im Dialogfeld Voreinstellungen festgelegt
haben. Wenn Sie ein einfaches oder doppeltes Anflihrungszeichen (4, ., oder ¢4) eingeben, wird das in den
Voreinstellungen festgelegte Anflihrungszeichen eingeblendet. Da typographische Anflihrungszeichen
sprachabhangig sind, bestimmt die flir den Absatzstil festgelegte Sprache, welche Anflihrungszeichen
eingefligt werden.

HINWEIS: Falls Sie gerade Anflihrungszeichen vorziehen, deaktivieren Sie die Option , Anfihrungsze-
ichen”.

Die Option ,, Anfiihrungszeichen” wird nicht fir Text in Dialogfeldern verwendet. Weitere Informationen
zum Eingeben von Anflihrungszeichen und Apostrophen in Dialogfeldern finden Sie unter Zeichensdtze.

1) Umintelligente Sonderzeichen einzurichten, wahlen Sie im Buchfenster die Dokumente aus, fiir die
sie gelten sollen.

2)  Waihlen Sie Formatieren > Dokument > Textoptionen.

3) Andern Sie die Einstellung der Option ,Leerzeichenkontrolle” oder , Typographische Anfiihrungsze-
ichen” und klicken Sie auf Anwenden.

Tiep: Wenn Sie ,, Anflihrungszeichen” aktivieren, andert FrameMaker keine bereits im Dokument vorhan-
denen Anfiihrungszeichen. Vorhandene gerade Anfiihrungszeichen und Apostrophe kdnnen Sie (iber die
Rechtschreibhilfe (siehe >) oder den Befehl ,,Suchen/Andern” dndern.
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IMPORTIEREN UND VERKNUPFEN VON DATEIEN

Importieren und Verkniipfen von Dateien

Erfahren Sie, wie Sie Dateien in FrameMaker importieren und verknipfen.
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Import- und Verkniipfungsmethoden

Lernen Sie die Import- und Verknipfungsmethoden zum Importieren von Text, Grafiken, Audio- und
Videodateien sowie Objekten kennen. Erfahren Sie, wie Sie die Befehle fiir Zwischenablage, Drag/Drop,
Importieren und Objekte in FrameMaker verwenden.

In diesem Thema

. Einflihrung

. Importieren aus der Zwischenablage

L Drag & Drop verwenden

J Import durch Referenz

L Datei in Dokument kopieren

o Verwenden des Befehls ,Datei” > ,,Importieren” >, Objekt”

Einfiihrung

Sie kdnnen andere Adobe FrameMaker-Dokumente, Dokumente aus anderen Anwendungen, Text-
dateien, Audio- und Videodateien (einschlielich YouTube-Videos) und Grafikdateien importieren. Sie
kénnen auch 3D-Objekte in FrameMaker-Dokumente importieren.

Ein importiertes Objekt kann einfach in das Dokument kopiert werden. Es kann auch verknipft werden,
z. B. beim Import durch Referenz. In diesem Fall bleibt es mit seiner Quelle verbunden und lasst sich
einfach aktualisieren.

Importieren aus der Zwischenablage

Am einfachsten kdnnen Sie Text und Grafiken importieren, indem Sie diese in die Zwischenablage kopi-
eren und anschlieRend einfligen. Wenn Sie diese Methode anwenden, beriicksichtigen Sie Folgendes:

1)  Wahlen Sie das zu kopierende Objekt oder den zu kopierenden Text aus, und wahlen Sie Bearbe-
iten > Kopieren. Der Inhalt wird in die Zwischenablage kopiert.

2)  Platzieren Sie die Einfligemarke an der Stelle im Dokument, an der Sie die Inhalte einfligen
mochten, und wahlen Sie dann Bearbeiten > Einfiigen.

Wenn Sie diese Methode anwenden, berlicksichtigen Sie Folgendes:

. Sie kdnnen durch Tabulatoren begrenzten Text mit dem Befehl Tabelle > In Tabelle konvertieren
umwandeln.

o Die Textformatierung geht verloren, es sei denn, Sie fligen die Inhalte in ein anderes
FrameMaker-Dokument ein.

o Die Auswahl von Bearbeiten > Einfiligen Spezial bietet Ihnen weitere Optionen. Beispiel: Sie kdnnen
den Text im RTF-Format oder als eingebettetes Microsoft Word-Dokument einfliigen. Wenn Sie
FrameMaker-Formate tibernehmen méchten, fligen Sie den Inhalt der Zwischenablage als Text ein.
Im Fall von Grafiken kdnnen Sie den Inhalt der Zwischenablage als eingebettete Bitmap, gera-
teunabhdngige Bitmap oder Metadatei einfligen.

. Wenn Sie Text einer bestimmten Richtung (LTR oder RTL) in ein FrameMaker-Dokument kopieren
und einfligen méchten, missen Sie sicherstellen, dass die Textrichtung (Dokument, Tabelle oder
Absatz) der Zielposition auf dieselbe Richtung eingestellt ist.
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Drag & Drop verwenden

Import und Export vereinfachen sich merklich, wenn Sie ein Objekt an eine neue Position ziehen kénnen.

FrameMaker unterstitzt beim Ziehen und Ablegen die folgenden Operationen:

. Sie kdnnen eine Grafik aus einem geoffneten FrameMaker-Dokumentfenster in ein anderes
verschieben, indem Sie die Grafik einfach ziehen. Sie konnen die Grafik auch kopieren, indem Sie
die Strg-Taste gedriickt halten und ziehen. Sie kdnnen auch ein Kontextmenu 6ffnen, indem Sie die
Grafik mit der rechten Maustaste ziehen und ablegen.

. Sie kdnnen eine Grafik aus einem gedffneten FrameMaker-Dokumentfenster in eine beliebige
andere Anwendung ziehen, die das Ziehen und Ablegen unterstitzt.

. Ziehen Sie eine Grafikdatei aus einem Ordner oder vom Desktop in ein gedffnetes Dokumentfen-
ster.

. Sie kdnnen eine oder mehrere Dokumentdateien in ein Anwendungsfenster ziehen und dort
offnen. Sie kdnnen auch eine einzelne Datei in ein Dokumentfenster ziehen, um sie dort
einzubetten.

Import durch Referenz

Beim Importieren durch Referenz bleibt die Verknlipfung des importierten Texts oder der importierten
Grafiken mit der Quelldatei erhalten. FrameMaker speichert den Pfad zur Quelldatei im Dokument. Bei
jedem Offnen des Dokuments sucht FrameMaker die Datei auf der Festplatte und zeigt sie an.

Wenn die Quelldatei geandert wurde, aktualisiert FrameMaker das Dokument mit der neuesten Version.
Das Importieren durch Referenz kann die DateigrofSe reduzieren, da Sie dasselbe Material an mehreren
Stellen verwenden kénnen, ohne den Text oder den Inhalt importierter Grafiken im FrameMaker-Doku-
ment zu speichern. Durch Referenz importierter Text wird als Texteinschub bezeichnet.

1)  Waihlen Sie Datei > Datei > importieren. Das Dialogfeld Importieren wird geoffnet.

2)  Wahlen Sie die Datei aus, die Sie importieren méchten, und wahlen Sie dann Import durch
Referenz aus.

3) Klicken Sie auf Importieren.

Informationen dariber, wie der Pfad beim Importieren durch Referenz gespeichert wird, finden Sie unter
Pfade beim Importieren durch Referenz verwenden.

Datei in Dokument kopieren

Das Importieren durch Kopieren erleichtert den Transfer von importiertem Material von einer Position
an eine andere, vergréRert jedoch das Dokument. Wenn Sie Anderungen am Quellmaterial durchfiihren,
mussen Sie auRerdem die Quelldatei erneut importieren, um das Dokument mit der neuesten Version zu
aktualisieren.

1)  Wahlen Sie Datei > Datei > importieren. Das Dialogfeld Importieren wird gedffnet.

2)  Wahlen Sie die Datei aus, die Sie in das Dokument kopieren mochten. Wahlen Sie In Dokument
kopieren aus.

3) Klicken Sie auf Importieren.
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Verwenden des Befehls ,Datei” > ,,Importieren” > ,,Objekt”

Der Hauptvorteil von Object Linking and Embedding (OLE) ist die Anzeige von Daten, die in anderen
Anwendungen als FrameMaker erstellt wurden. Die Option Datei > Objekt > importieren verknipft das
importierte Objekt mit dem Programm, mit dem es erstellt wurde, sodass Sie das Objekt in der nativen
Software-Anwendung bearbeiten kdnnen Sie kdnnen beispielsweise ein in Microsoft Excel erstelltes
Kreisdiagramm in ein FrameMaker-Dokument einfligen. Wenn Sie auf das eingefiigte Objekt doppelk-
licken, 6ffnet FrameMaker es in Microsoft Excel und Sie kdnnen es bearbeiten.

HINwEIS: Sie kdnnen keine Objekte einbetten und verknlipfen, deren native Anwendungen nicht auf dem
Computer installiert sind. Wenn Sie beispielsweise ein Dokument 6ffnen, das ein Photoshop-Bild enthilt,
dass Uber Datei > Importieren > Objekt eingebettet wurde, muss Photoshop auf Ihrem Computer instal-
liert sein, damit Sie dieses Bild bearbeiten kdnnen.

Berlicksichtigen Sie bei der Entscheidung, ob Text oder Grafiken durch Referenz importiert oder mit OLE
eingebettet oder verkniipft werden sollen, die folgenden Faktoren.

. Stammt das einzufiigende Material aus einem anderen FrameMaker-Dokument, importieren Sie
durch Referenz. Damit stehen Ihnen zahlreiche Importoptionen zur Verfligung.

. Soll eine verknipfte importierte Datei zum Symbol verkleinert und nicht in vollem Umfang in Ihrem
Dokument angezeigt werden, verwenden Sie eine Verknipfung mit OLE.

] Verwenden Sie OLE, wenn das einzufligende Material in einem Format vorliegt, das FrameMaker
nicht 6ffnen kann.

J Falls Sie Ihr Dokument auf mehreren Plattformen bearbeiten und anzeigen, flihren Sie einen Import
durch Referenz aus. OLE funktioniert nur unter Windows.

. Importieren Sie durch Referenz, wenn der Text oder die Grafiken, die Sie einfligen mdchten, aus
einer Anwendung stammen, die OLE nicht unterstitzt.

RELATED LINKS:
Text importieren

Grafiken importieren

,Objekte integrieren”
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Pfade beim Importieren durch Referenz verwenden

Erfahren Sie, wie Pfade in Adobe FrameMaker beim Importieren durch Referenz funktionieren und
welche Unterschiede zwischen relativen und absoluten Pfaden bestehen.

Wenn Sie lber die Option Datei > Datei > importieren nach Referenz importieren, kann der Pfad fiir die
Text- oder Grafikdatei absolut oder relativ sein. Ein relativer Pfad beginnt beim aktuellen Ordner oder bei
einem Ordner der nachsthoheren Hierarchiestufe und gibt von ihm ausgehend die Position der Datei an.
Ein absoluter Pfad beginnt im Stammverzeichnis des Dateisystems (dem obersten Ordner) und gibt von
ihm ausgehend die Position der Datei vollstandig an. Zwei Beispiele fiir absolute Pfade.

o D:\Graphics\Mountain.gif

. \\DocServer\Graphics\Mountain.gif

FrameMaker speichert relative Pfade wann immer dies moglich ist, damit das Programm eine
importierte Datei finden kann, wenn sowohl das Dokument als auch die Quelldatei verlagert wird.
Voraussetzung hierfir ist, dass die Dateien an denselben relativen Positionen verbleiben. Wenn Sie das
Dokument in einem anderen Ordner speichern, passt FrameMaker die Pfade der importierten Dateien
entsprechend an. Fihrt der Pfad zu der importierten Datei jedoch lber den Stammordner des Dateisys-
tems (den obersten Ordner) hinaus, verwendet FrameMaker absolute Pfade, die im Stammordner
beginnen.

Um sicherzustellen, dass FrameMaker relative Pfade verwendet, missen Sie dafiir sorgen, dass die Suche
nach der Datei nicht Gber den Stammordner hinausfihrt.
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Grafiken importieren

Lernen Sie Grafikformate kennen und erfahren Sie, wie Sie in FrameMaker Grafiken mit dem Dateiim-
portbefehl importieren, fehlende Grafiken finden, Grafiken zu strukturierten Dokumenten hinzufiigen
und verankerte Rahmen verwenden.

In diesem Thema

Einflihrung

Importieren von Grafiken

Importieren von JPEG 2000-Dateien

Importieren von SVG-Bildern

Importieren von Adobe Photoshop-Dateien

Importieren von Adobe lllustrator-Dateien

Ermitteln von Grafiken, die FrameMaker nicht finden kann

Anzeigen des Dateinamens einer importierten Grafikdatei

Einfihrung

Sie konnen zahlreiche Grafik-/Bildformate in ein FrameMaker-Dokument importieren. Die folgende Liste
enthalt einige der am haufigsten verwendeten Bilddateiformate, die Sie in FrameMaker importieren
kénnen:

Adobe lllustrator (Al)

Adobe Photoshop (PSD)

Adobe PDF

Bitmap (BMP)

Device-Independent Bitmap (DIB)

Drawing Interchange Format/Drawing Exchange Format (DXF)
Computer Graphics Metafile (CGM)

Enhanced Metafile (EMF)

Encapsulated Postscript (EPS)

Graphic Interchange Format (GIF)

Joint Photographic Experts Group Graphics (JPEG, JPEG2000)
Portable Network Graphics (PNG)

Scalable Vector Graphics (SVG)

Tagged Image File Format (TIFF)

Universal 3D (U3D)

WebP

Windows Metafile (WMF)

Icon (ico)

FrameVector

Framelmage
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Berlicksichtigen Sie beim Importieren von oder Arbeiten mit Bilddateien in FrameMaker die folgenden
Punkte:

Wahlen Sie Datei > Datei > importieren oder Bild > einfiigen, um Grafiken zu importieren.

Sie konnen eine Grafik in einen verankerten oder unverankerten Grafikrahmen, in ein Rechteck,
das als Bildrahmen dient, oder direkt auf eine Seite importieren. Wenn sich beim Bearbeiten des
Dokuments die Grafik mit dem Text verschieben soll (z. B. eine Grafik in Ilangeren Dokumenten oder
in Dokumenten, die fiir eine HTML-Konvertierung vorgesehen sind), importieren Sie diese in einen
verankerten Rahmen. Soll die Grafik an der Position bleiben, an der sie eingefligt wurde (z. B. ein
Logo in einem Briefkopf), importieren Sie diese auf die Seite und positionieren sie wie gewiinscht.

Sie kdnnen beim Importieren einer Grafik einen Importfilter basierend auf dem Grafikformat
angeben. Beim Import einer Bitmap konnen Sie die Skalierung in Dots per Inch (dpi) angeben. Je
groRer der dpi-Wert ist, umso kleiner wird die Bitmapgrafik auf der Seite dargestellt.

Beim Importieren von Bildern mit transparentem Hintergrund behalt FrameMaker die Transparenz
des Bilds beim Erstellen und beim Publizieren im PDF-Format bei.

Beim Kopieren eines Bilds oder beim Kopieren eines Bilds durch Referenz in ein Dokument kénnen
Sie den HTTP-Pfad angeben, von dem aus die Grafik importiert werden soll. Der HTTP-Pfad wird bei
XML-Roundtrips beibehalten.

StandardmaRBig importiert FrameMaker Bilder durch Referenz. Wenn Sie Bilder standardmaRig in
das Dokument kopieren mochten, deaktivieren Sie die Option Bildimport durch Referenz im
Dialogfeld Voreinstellungen im Abschnitt Global, Allgemein.

Sie kdnnen auch Grafiken importieren, indem Sie die Grafikdatei aus Windows Explorer in das
Dokument importieren. Das Bild wird in einen verankerten Rahmen eingefiigt. Im Falle eines struk-
turierten Dokuments wird das entsprechende Bildelement auf das eingefiigte Bild angewendet.

Importieren von Grafiken

1)

2)

3)

Legen Sie die Position der Grafik durch eine der folgenden Aktionen fest:

- Um die importierte Grafik in einen Grafikrahmen einzufiigen, wahlen Sie einen vorhandenen
Rahmen aus oder platzieren Sie eine Einfligemarke in einem Textrahmen.

- Um die importierte Grafik direkt auf der Seite einzufligen, klicken Sie auf den Seitenrand.

- Soll mithilfe eines gezeichneten Rechtecks die GroRe der importierten Grafik definiert
werden, wahlen Sie ein vorhandenes Rechteck aus oder zeichnen ein neues (wahlen Sie
keinen verankerten oder nicht verankerten Rahmen aus). Die Grafik ersetzt das Rechteck,
wenn beim Importieren die Option ,,In ausgewahltes Rechteck einpassen” aktiviert ist. Das
GroRenverhaltnis der Grafik bleibt dabei jedoch unverandert.

- Wenn Sie eine vorhandene Grafik ersetzen mochten, missen Sie diese zunachst markieren.

Wihlen Sie Datei > Datei > importieren, um das Dialogfeld Importieren zu 6ffnen.
Oder
wdhlen Sie Bild > einfiigen, um das Dialogfeld Bild einfiigen zu 6ffnen.

Wahlen Sie im Dialogfeld ,, Dateiimport” die zu importierende Grafikdatei aus oder geben Sie den
HTTP-Pfad der zu importierenden Grafikdatei an, und wahlen Sie die Importmethode aus. Wenn Sie
ein Bild ausgewahlt oder eine URL angegeben haben, klicken Sie auf Importieren.
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4)  Wahlen Sie im Dialogfeld Bild einfiigen die Grafikdatei aus, die Sie importieren méchten, und
klicken Sie auf Offnen.

5)  Wenn das Dialogfeld Unbekannter Dateityp angezeigt wird, wahlen Sie aus der Auswahlliste einen
Dateityp aus und klicken Sie auf Konvertieren.

6) Wenn das Dialogfeld Grafik mit Skalierung importieren angezeigt wird, wahlen Sie eine Skalierung-
soption oder In ausgewahltes Rechteck einpassen, und klicken Sie auf Festlegen.

Tipp: Die besten Druckergebnisse erzielen Sie, wenn Sie einen dpi-Wert wahlen, durch den die Auflésung
des Druckers oder der Setzmaschine ohne (oder nur mit einem kleinen) Rest teilbar ist. Die optimale
Auflésung am Bildschirm erreichen Sie mit einem dpi-Wert, durch den lhre Bildschirmaufldsung ohne
Rest teilbar ist. (Windows-Bildschirme haben normalerweise eine Auflésung von 96 dpi.)

Importieren von JPEG 2000-Dateien

FrameMaker unterstitzt JPEG 2000, eine Version des Bildkomprimierungsformats JPEG.

Beim Import von JPEG 2000-Dateien konvertiert der Filter die unterstitzten Farbmodi RGB, CMYK, Gray-
Scale und LAB, und verwirft nicht unterstiitzte Modi wie Index. Der Filter unterstitzt keine Bilder mit
16 Bit pro Kanal. Wenn beim Importieren das Dialogfeld ,,Unbekannter Dateityp“ angezeigt wird, wahlen
Sie JPC, J2C, JPX, JPF, J2K oder JP2 aus und klicken auf Konvertieren.

Das Verfahren zum Importieren der Datei entspricht dem im Abschnitt Importieren von Grafiken
beschriebenen Verfahren.

Importieren von SVG-Bildern

Sie kdnnen SVG-Dateien (Scalable Vector Graphics) in Ihr Dokument importieren.

FrameMaker druckt SVG-Bilder auf PostScript-Druckern aus, indem die Bilder mithilfe von Encapsulated
PostScript (EPS) als Vektorgrafiken dargestellt werden. Bei Druckern, die nicht PostScript-fahig sind,
verwendet FrameMaker das Framelmage-Format.

Wenn Sie anhand eines Dokuments, das ein SVG-Bild enthéalt, eine PDF-Datei erstellen, wird das Bild als
Vektoren angezeigt, was zu einer verbesserten Darstellung in Acrobat fiihrt und ein VergréRern und
Verkleinern der Anzeige ohne Pixelierung ermaoglicht.

HinweEls: Eingebettete SVG-Bildanimationen werden in FrameMaker nicht unterstitzt.

Importieren von Adobe Photoshop-Dateien

FrameMaker unterstitzt den Import von Adobe Photoshop(PSD)-Dateien. FrameMaker konvertiert
PSD-Dateien in das native Framelmage-Format und konvertiert den Farbraum (Photoshop RGB, CMYK,
LAB, Indiziert, GrayScale oder Bitmap) nach RGB.

Neu in FrameMaker (Release 2019): Beim Erstellen einer PDF-Datei mit der PDF-Engine von
FrameMaker (Release 2019) behalt FrameMaker den Farbraum der PSD-Datei (RGB oder CMYK) in der
veroffentlichten PDF-Datei bei. Wenn der Photoshop-Datei ein Farbprofil zugewiesen ist (z. B. SRGB
IEC61966-2.1, Adobe RGB, image P3, Euroscale Uncoated v2 usw.), wird das Farbprofil dem Bild in der
PDF-Ausgabe zugewiesen.
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Der Import von PSD-Dateien verlauft auf dieselbe Art wie der Import anderer Grafikarten.

Importieren von Adobe lllustrator-Dateien

Beim Importieren einer Adobe lllustrator-Datei in FrameMaker wird die Datei als Grafik behandelt, und
es kann jeweils nur eine Seite importiert werden. Sie kdnnen sie entweder durch Kopieren oder durch
Referenz importieren. Sowohl Prozess- als auch Schmuckfarben kénnen angezeigt und gedruckt werden.

HINwEIS: Der Ausdruck von Grafiken mit Transparenzeffekten auf einem PostScript Level 1-Drucker oder
einem nicht PostScript-fahigen Drucker kann vom erwarteten Ergebnis abweichen. Wenn Sie
FrameMaker mit der Option —noapi ausfihren (. /maker.exe -noapi), kdbnnen Sie keine
PDF-Dateien importieren.

1)  Wahlen Sie in FrameMaker Datei > Datei > importieren oder Bild > einfiigen, und geben Sie die
[llustrator-Datei an, die Sie importieren mochten.

2)  Wabhlen Sie im Dialogfeld ,Dateiimport” die zu importierende Grafikdatei aus oder geben Sie den
HTTP-Pfad der zu importierenden Grafikdatei an, und wahlen Sie die Importmethode aus. Wenn Sie
ein Bild ausgewahlt oder eine URL angegeben haben, klicken Sie auf Importieren.

3)  Wabhlen Sie im Dialogfeld Bild einfiigen die Grafikdatei aus, die Sie importieren mochten, und
klicken Sie auf Offnen.

4) Hat die Datei mehrere Seiten, geben Sie die gewlinschte Seitenzahl in das Feld ein.
5) Klicken Sie auf Auswdhlen.

Dateien von lllustrator werden entsprechend der SeitengréRe importiert. Andern Sie die GroRe des
verankerten Rahmens, um Leerrdume aus der Grafik herauszuschneiden.

Ermitteln von Grafiken, die FrameMaker nicht finden kann

Wenn Sie ein Dokument 6ffnen, das per Referenz importierte Grafikdateien enthalt, sucht FrameMaker
nach den referenzierten Grafikdateien. Falls FrameMaker keine referenzierte Grafikdatei findet, wird ein
Dialogfeld geoffnet.

1)  Wennin FrameMaker das Dialogfeld Fehlende Datei angezeigt wird, flihren Sie einen der folgenden
Schritte aus:

- Um die Grafik zu suchen und anzuzeigen, wahlen Sie diese aus der Auswahlliste aus und
klicken auf Dokument aktualisieren, neuer Pfad. FrameMaker verwendet beim Offnen des
Dokuments den neuen Pfad auch fiir die Suche nach weiteren fehlenden Dateien. Daher
missen Sie den neuen Pfad nur einmal angeben, wenn Sie alle Ihre Grafikdateien an eine
neue Position verlagert haben.

- Um die Grafikdatei zu Giberspringen, aktivieren Sie Diese Datei iibergehen. Die (ibersprun-
gene Grafik wird als graues Rechteck im Dokument angezeigt. Beim nichsten Offnen des
Dokuments versucht FrameMaker erneut, die Datei zu finden.

- Um alle weiteren Grafikdateien zu tGberspringen, die nicht gefunden werden kénnen, klicken
Sie auf Alle fehlenden Dateien Gibergehen.

2)  Klicken Sie auf Fortfahren.
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Anzeigen des Dateinamens einer importierten Grafikdatei

Wahlen Sie die Grafik aus, die per Referenz importiert wurde, und wahlen Sie Grafik > Objekteigen-
schaften. Der Name und der Pfad der Grafik werden im Fenster Objekteigenschaften angezeigt.

RELATED LINKS:
Pfade beim Importieren durch Referenz verwenden
Import- und Verkniipfungsmethoden
Andern der Gréfe von importierten Grafiken

,Objekte integrieren”
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Einfligen von importierten Grafikelementen in strukturierte Dokumente

Lernen Sie Grafikformate kennen und erfahren Sie, wie Sie in FrameMaker Grafiken mit dem Dateiim-
portbefehl importieren, fehlende Grafiken finden, Grafiken zu strukturierten Dokumenten hinzufiigen
und verankerte Rahmen verwenden.

In diesem Thema

. Einflihrung

. Einfiigen von importierten Grafikelementen

J Verwenden von ungiiltigen importierten Grafikelementen

. Hinzufiigen von importierten Grafiken in vorhandene verankerte Rahmen

Einfiihrung

Einige Grafikelemente sind so definiert, dass Grafik und Element gemeinsam importiert werden. Wenn
Sie das Element einfligen, zeigt FrameMaker ein Dialogfeld fiir den Import an. Die importierte Grafik wird
in einem verankerten Rahmen unterhalb der Linie mit dem Ankersymbol angezeigt, und die GroRe des
Rahmens wird der Grafik automatisch angepasst.

HINwEIs: StandardmaRig ist das @placement-Attribut des <image>-Elements auf break festgelegt. Sie
kénnen dieses Standardverhalten andern, sodass Bilder eingebunden eingefligt werden, indem Sie
OverrideDefaultImageRenderingToBreak=0inditafm. ini festlegen.

Figure 1: Importierte Grafik in einem verankerten Rahmen

Nach dem Einfiigen des Elements kdnnen Sie den Rahmen durch Verschieben, Andern der GréRe usw.
bearbeiten.

Sie kénnen eine Grafik auch in einen vorhandenen verankerten Rahmen importieren, z. B. wenn Sie ein
Grafikelement verwendet haben, das einen leeren Rahmen im Dokument platziert hat.

Wenn Sie ein Grafikelement importieren, kann dieses Bestandteil des Dokuments werden (Import durch
Kopieren) oder mit der urspriinglichen Anwendung bzw. dem urspriinglichen Dokument verkniipft
bleiben (Import durch Referenz).

Sie kdnnen auch Grafiken importieren, indem Sie die Grafikdatei aus Windows Explorer in das Dokument
importieren. Das Bild wird in einen verankerten Rahmen eingefligt.

Informationen iber das Einfligen einer importierten Grafik, die kein Element ist (ein Vorgang, der nur in
einem unstrukturierten Textfluss moglich ist), finden Sie unter Grafiken importieren.
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Einfligen von importierten Grafikelementen

1)  Klicken Sie an der Stelle, an der Sie den Rahmen verankern mochten.
2)  Wabhlen Sie im Elementkatalog ein importiertes Grafikelement aus und klicken Sie auf Einfiigen.

Sie kénnen auch den Befehl Datei > Importieren > Datei oder Einfiigen > Bild verwenden, um ein
Element einzufiigen. Wdihlen Sie eine Datei aus und klicken Sie auf Importieren. Wenn mehrere im-
portierte Grafikelemente verfiigbar sind, wird ein Dialogfeld gedffnet, in dem Sie das gewiinschte
Element in der Dropdown-Liste Element-Tag auswdhlen kénnen.

3)  Wabhlen Sie die gewiinschte Grafikdatei aus und geben Sie an, ob Sie durch Referenz oder Kopieren
importieren mdchten.

4)  Klicken Sie auf Importieren.

5)  Wenn das Dialogfeld Unbekannter Dateityp angezeigt wird, wahlen Sie aus der Auswahlliste einen
Dateityp aus und klicken Sie auf Konvertieren.

6) Wenn das Dialogfeld Skalierung von Grafiken angezeigt wird, wahlen Sie eine Skalierungsoption
oder die Option In ausgewdhltes Rechteck einpassen und klicken Sie auf Zuweisen. Je groRer der
dpi-Wert ist, umso kleiner wird die Bitmapgrafik auf der Seite dargestellt.

Ein verankerter Rahmen mit der importierten Grafik wird im Dokumentfenster mit einem Ankersymbol
1 an der Einfligemarke angezeigt. Eine Blase mit dem Textausschnitt <GRAPHIC> erscheint in der Struk-
turansicht.

Wenn an der gewlinschten Position kein importiertes Grafikelement verfiigbar ist, kdnnen Sie ein ungiil-
tiges Element verwenden. Informieren Sie sich nach Einfligen des Elements bei lhrem Entwickler
dariber, wie sich das Element an dieser Position in ein glltiges Element umwandeln lasst.

Verwenden von ungiiltigen importierten Grafikelementen

Fiihren Sie eine der folgenden Aktionen aus:

. Um ein Element zu verwenden, das in einem anderen Teil des Dokuments glltig ist, fligen Sie das
Element an einer gliltigen Position ein und verschieben es, oder benutzen Sie die Einstellung Alle
Elemente, um das Element Uberall verfligbar zu machen, und fligen Sie das Element dann an der
gewlinschten Position ein.

. Um ein ungiiltiges Element mit dem Standard-Tag <GRAFIK> einzufligen, benutzen Sie zum Impor-
tieren einer Grafik den Befehl Datei > Importieren > Datei oder Einfligen > Bild. Dieses Element ist
das Standardelement, wenn keine definierten importierten Grafikelemente verfligbar sind.

Hinzufiigen von importierten Grafiken in vorhandene verankerte Rahmen

Wihlen Sie den Rahmen aus und wahlen Sie zum Importieren der Grafik den Befehl Datei > Importieren
> Datei oder Einfligen > Bild.

RELATED LINKS:
Fiillen und Bearbeiten von verankerten Rahmen
Import- und Verkniipfungsmethoden
Datei in Dokument kopieren

Anzeigebereich fiir verfiigbare Elemente in einem strukturierten Dokument éndern
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Importieren von Audio- und Videodateien sowie und 3D-Objekten

Erfahren Sie, wie Sie Videodateien (einschlieflich YouTube-Videos), Audiodateien und 3D-Objekte
importieren. Erfahren Sie auch, wie Sie in FrameMaker Dokumente mit 3D-Objekten verwalten und
Ansichten und Beleuchtungsschemata sowie Posterdateien festlegen.

Das Einfligen von Multimedia-Dateien in Ihr Dokument ist sehr einfach. Mit FrameMaker kénnen Sie
Audiodateien (.mp3), Videodateien (* .mp4) und sogar YouTube-Videos in Ihre Dokumente einfligen
oder importieren.

Sie haben auch die Moglichkeit, 3D-Objekte (U3D-Format) entweder durch Kopieren oder durch
Referenz in Dokumente zu importieren. Sie konnen Parameter wie die Standardansicht, den Darstellung-
smodus, die Hintergrundfarbe und das Beleuchtungsschema fiir das 3D-Objekt einstellen. Sie kdnnen ein
3D-Objekt auch in einem verankerten oder nicht verankerten Rahmen darstellen lassen.

Wenn Sie sich Ubungen und Demos zur Verwendung von Rich Media beim Authoring mit FrameMaker
ansehen mochten, besuchen Sie den Technical Communication-Kanal auf Adobe TV.

Unterstitzte Audio- und Videodateiformate

Erfahren Sie mehr Gber unterstiitzte Audio- und Videoformate, das Importieren von Videos und das
Festlegen eines Posterbilds fur ein Audio- oder Videoobjekt in Adobe FrameMaker.

Sie kdnnen Audio- oder Videoobjekte zu Dokumente hinzufligen, indem Sie Mediendateien einbetten.
FrameMaker unterstiitzt die folgenden Medienformate:
J AIF/AIFF (Audio Interchange File Format) WMV
. ASF (Advanced Systems Format-Datei)

) AU (Audio Unit-Datei)

. AVI (Audio Video Interleave-Datei)

. FLV (Flash Video-Datei)

. IVF (Indeo Video Format-Datei)

. KAR (Karaoke MIDI-Datei)

. M1V (MPEG-1 Video-Datei)

. M3U (Playlisten-Datei)

e  MID (MIDI-Datei)

J MOV (Apple QuickTime Movie)

. MP2 (MPEG Layer Il, komprimierte Audiodatei)
. MP3 (MP3-Audiodatei)

L MP4 (MPEG-4 Video-Datei)

J MPA (MPEG-2-Audiodatei)

e MPE (MPEG-Filmdatei)

e  MPEG (MPEG-Film)

. MPG (MPEG-Videodatei)

. QT (Apple QuickTime-Film)
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e WAV (DTS-WAV-Datei)
. WMV (Windows Media Video-Datei)
o YouTube-Videos

Weitere Informationen finden sie unter ,,Objekte integrieren”.

Wenn Sie ein Dokument drucken, das einen QuickTime-Film enthalt, wird nur der Filmtitel ausgegeben.

HINwEIs: Verlagern oder I6schen Sie die urspriingliche QuickTime-Filmdatei auch dann nicht, wenn Sie die
Datei mithilfe der Option ,In Dokument kopieren” importiert haben. Der QuickTime-Film wird namlich
selbst mit dieser Option nicht vollstdndig in das Dokument kopiert.

Importieren von Audio- und Videodateien

Erfahren Sie, wie Sie Audio- und Videodateien in lhre strukturierten und unstrukturierten
FrameMaker-Dokumente importieren oder einfligen.

FrameMaker unterstiitzt den Import von Audiodateien (* .mp3) und Videodateien (* .mp4) in Ihr Doku-
ment. Wenn Sie das Dokument veréffentlichen, werden diese Dateien auch in die veroffentlichte
Ausgabe eingebettet.
1) Platzieren Sie die Einfligemarke an die Stelle im Dokument, an der die Mediendatei angezeigt
werden soll.
2) Jenach Dateityp, den Sie einfligen oder importieren méchten, fiihren Sie die folgende Aufgabe aus:
- Wahlen Sie Einfligen > Multimedia > Audio, um eine Audiodatei einzufligen oder zu impor-
tieren.
Der folgende Screenshot zeigt das Dialogfeld zum Einfligen von Audiodateien fiir ein unstruk-
turiertes Dokument:

Insert X
« v 4 « temp » Fm-2020 > sample-docs v U  Search sample-docs r
Organize ~ New folder = T @
Reading Material ~ [ Name De
Research LwDITA-samples 24
RoboHelp TravelDITA 24
RoboHelp Server Unstructured-UserGuide 14
Tags-optimization M & sample_audio.mp3 06
TCS
TCS_CSAT
temp
2017
Fm-2020
sample-docs
o v < >
File name: |sample_audio.mp3 ~ ‘ All Audios (*.mp3) »

Figure 1:  Dialogfeld zum Einfligen von Audiodateien fiir ein unstrukturiertes Dokument

- Wahlen Sie Einfiigen > Multimedia > Video, um eine Videodatei einzufligen oder zu impor-
tieren.
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Der folgende Screenshot zeigt das Dialogfeld zum Einfiigen von Videodateien fiir ein struktu-
riertes DITA-Dokument:

Insert Video X
Element: [object h
Key Name:
Reference:
Href: :\l.emp\Fm-ZO20\sample-docs\samplefvideo.mp4|| Browse...
Keyref: | v | Keyspace...
Path:
OK Cancel

Figure 2:  Dialogfeld zum Einfligen von Videodateien fir ein strukturiertes Dokument

3)  Navigieren Sie zu der Datei, die Sie einfiigen mdchten, und wahlen Sie diese aus.

4)  Klicken Sie auf Offnen.
Die ausgewdihlte Datei wird in das Dokument eingefiigt. Der folgende Screenshot zeigt die in ein Do-
kument eingefiigten Video- und Audiodateien.

Congratulations on your purchase of a Personal Spaceship andf
welcome to the documentation designed to help you get the;
most out of your vehicle.

Video file (*.mp4):

Audio file (*.

Figure 3: In ein Dokument eingefiigte Video- und Audiodateien
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YouTube-Videos einfiigen

Erfahren Sie, wie Sie YouTube-Videos in lhre strukturierten DITA- oder unstrukturierten
FrameMaker-Dokumente einfligen.

Sie kénnen ein YouTube-Video auf dhnliche Weise wie eine Audio- oder Videodatei in Ihr Dokument

einfligen.

1) Platzieren Sie die Einfligemarke an die Stelle im Dokument, an der das YouTube-Video eingefiigt
werden soll.

2)  Wahlen Sie Einfiigen > Multimedia > Onlinevideo.

3) Jenach Art des Dokuments, in dem Sie arbeiten, wird eins der folgenden Dialogfelder angezeigt:

- Unstrukturiertes Dokument: Wenn Sie in einem unstrukturierten Dokument arbeiten, wird
das folgende Dialogfeld Onlinevideo angezeigt:

B ' Online Video X

URL or Embed HTML.:

https://www.youtube.com/watch?v=6QvGCz_EAsU

Insert Cancel

Figure 4: YouTube-Videos in ein unstrukturiertes Dokument einfligen
Geben Sie die kurze oder die vollstindige URL oder den HMTL-Code zum Einbetten des Videos
in das Dialogfeld ein.
HINWEIS: Informationen zum Abrufen der kurzen oder vollstandigen URL eines
YouTube-Videos finden Sie in der YouTube-Hilfe.
—  Strukturiertes DITA- oder LWDITA-Dokument: Wenn Sie in einem strukturierten DITA 1.3-
oder LwDITA-Dokument arbeiten, wird das folgende Dialogfeld Einfiigen angezeigt:

WIcHTIG: Dieser Vorgang zum Einfligen von YouTube-Videos wird derzeit fiir spezialisierte
oder benutzerdefinierte XML-Anwendungen nicht unterstitzt.
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Insert Online Video X

Element: object i
Key Name:
Reference:
Href: https:Hyoutu.belEstSOBmUSIVI| Browse...
Keyref: M Keyspace...
Path:

Figure 5:  Einfligen von YouTube-Videos in ein strukturiertes Dokument

Geben Sie die kurze oder die vollstéindige URL des Videos in das Dialogfeld ein.

Hinwels: Das Einbetten von HTML-Code eines YouTube-Videos wird derzeit fiir strukturierte
Dokumente nicht unterstitzt.

4)  Klicken Sie auf Einfiigen.
Das YouTube-Video wird in Ihr Dokument eingefiigt.

Zusdtzliche Hinweise zum Einfiigen von Audio- und Videodateien sowie und YouTube-Videos in strukturi-
erte DITA-Dokumente

. Wenn Sie eine Offlinevideo- oder -Audiodatei oder ein YouTube-Online-Video in ein DITA-Doku-
ment einfligen, verwendet FrameMaker das Element <object>, um den Link der Datei zu
speichern. Das Element <object> enthalt das Element <param> mit den Attributen @name und
@value zum Definieren der Quelle und des Pfads der eingefligten Datei. Im Fall eines
YouTube-Videos enthalt das Attribut @value die URL oder den HTML-Code des YouTube-Videos.

Der folgende Screenshot zeigt die XML-Ansicht eines DITA-Dokuments mit einem eingefiigten You-
Tube-Video, einer eingefiigten lokalen Videodatei und einer eingefligten Audiodatei:
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<p>Video file (*.mp4)</p>

<p>
<object data="../sample_video.mp4" height="30.856pt" width="38.856pt">
<{param name="src" value="../sample_videoc.mp4"/>
</object>
</p>

<p>Audio File (*.mp3)</p>

<p>
<object data="../sample_audio.mp3">
<param name="src" value="../sample_audio.mp3"/>
</object>
</p>

<p>YouTube video</p>
<p>

<object data="https://youtu.be/ExHs80BmUSM"></object>
</p>

Figure 6: XML-Ansicht des eingefligten YouTube-Videos und der eingefiigten, Video- und Audiodateien im
DITA-Dokument

J Wenn Sie in einem Lightweight DITA-Dokument (LwDITA) arbeiten, werden das YouTube-Video und
die lokale Videodatei in einem <Video>-Element eingefligt, und die Audiodatei wird in einem
<Audio>-Element eingefligt. Die Elemente <video> und <audio> enthalten den Speicherort
der eingefiigten Datei im Attribut <value> des Elements @media-source. Das Attribut
<value> des Elements @media-source enthalt die URL oder den HTML-Code des
YouTube-Videos.

Der folgende Screenshot zeigt die XML-Ansicht eines LwDITA-Dokuments mit einem eingefligten
YouTube-Video, einer eingefiigten lokalen Videodatei und einer eingefiigten Audiodatei:

<p>YouTube video:</p>
<video height="72.000pt" width="72.8@ept">

<media-source value="https://www.youtube.com/watch?v=6QvGCz_EAsU"/>
</video>

<p>Video File (*.mp4)</p>
<video height="30.856pt" width="38.856pt">
<media-source
value="../../../../../Kuldip/Data/Work/temp/Fm-2020/sample-docs/sample_video.mp4"/>
</video>

<p>Audio File (*.mp3)</p>
<audio>
<media-source
value="../../../../../Kuldip/Data/Work/temp/Fm-2020/sample-docs/sample_audio.mp3"/>
</audio>

Figure 7:  XML-Ansicht des eingefligten YouTube-Videos und der eingefligten, Video- und Audiodateien im
LwDITA-Dokument
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Posterdatei fiir eine Mediendatei

Erfahren Sie, wie Sie in FrameMaker ein Posterbild fiir eine Mediendatei festlegen.

In diesem Thema

. Einflihrung

J Festlegen eines Posterbilds

. Zurlicksetzen des Posterbilds

Einfiihrung

Sie kénnen fir eine importierte Mediendatei eine Posterdatei festlegen. FrameMaker zeigt das entspre-
chende Platzhalterbild an.

Wenn bei strukturierten Dokumenten in der DTD fiir ein Grafikobjekt ein Attribut mit dem Namen
posterfile definiert ist, wird das Attribut automatisch der Postereigenschaft des verankerten
Rahmens zugewiesen. Sie kénnen auch mit einer Regel in der Lese-/Schreibdatei einem Poster ein beli-
ebiges Attribut zuweisen. Dabei wird die Datei, auf die im Attribut verwiesen wird, zum Poster.

Festlegen eines Posterbilds

FrameMaker legt das ausgewahlte Bild als Poster fest. Falls das als Poster festgelegte Bild fehlt, legt
FrameMaker ein Spezialbild als Poster fest.

1)  Klicken Sie mit der rechten Maustaste auf die eingefiigte Mediendatei.
2)  Wabhlen Sie Poster festlegen.
3)  Wabhlen Sie die Bilddatei aus (JPEG, PNG, BMP oder GIF) und klicken Sie auf OK.

Zurlicksetzen des Posterbilds

1) Klicken Sie mit der rechten Maustaste auf die eingefligte Mediendatei.
2)  Waihlen Sie Standardposter festlegen.
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Arbeiten mit 3D-Objekten in Adobe FrameMaker

Erfahren Sie, wie Sie in Adobe FrameMaker 3D-Objekte importieren, Dokumente mit 3D-Objekten
verwalten, Ansichten und Beleuchtungsschemata festlegen und ein Posterbild fir ein 3D-Objekt
festlegen.

In diesem Thema

. Importieren eines 3D-Objekts

. Speichern von Dokumenten mit 3D-Objekten als PDF und XML

. Speichern von Dokumenten mit 3D-Objekten im XML-Format

J Drucken von FrameMaker-Dateien mit 3D-Objekten

J Einstellen der Hintergrundfarbe von 3D-Objekten

. Einstellen der Beleuchtungsschemata von 3D-Objekten

. Einstellen der Ansichten fiir 3D-Objekte in FrameMaker

. Festlegen des Rendermodus fiir ein 3D-Objekt in FrameMaker

Importieren eines 3D-Objekts

1) Platzieren Sie die Einfligemarke an der Stelle im Dokument, an der das 3D-Objekt angezeigt werden
soll.

2)  Wahlen Sie Datei > Datei > importieren oder Bild > einfiigen.

3)  Wechseln Sie zur zu importierenden U3D-Datei und wahlen Sie diese aus.

4)  Wahlen Sie eine der Optionen In Dokument kopieren oder Import durch Referenz.
5)  Klicken Sie auf Importieren.

6) Wabhlen Sie den gewlinschten DPI-Wert und klicken Sie auf Zuweisen.

Wenn Sie auf Zuweisen klicken, wird die Bitmap des 3D-Objekts im Dokument angezeigt. Wenn Sie das
3D-Objekt durch Kopieren importiert haben, wird die U3D-Datei als gerdteunabhangige Bitmap (DIB,
vom Englischen ,device-independent bitmap“) in das Dokument eingebettet. Wenn Sie das 3D-Objekt
durch Referenz importiert haben, wird ein mit der U3D-Quelldatei verkniipftes Bitmapbild in das Doku-
ment eingefligt. Unabhangig von der Importmethode fir die 3D-Datei wird die Datei im Dokument als
Grafiktyp DIB angezeigt.

Wenn Sie das 3D-Objekt in ein Dokument importieren und dieses im PDF- oder XML-Format speichern,
werden alle Informationen zum 3D-Objekt beibehalten.

Speichern von Dokumenten mit 3D-Objekten als PDF und XML

Sie kdnnen Dokumente mit 3D-Objekten in den Formaten PDF und XML speichern.

1)  Wahlen Sie Datei > Offnen, und 6ffnen Sie dann das FrameMaker-Buch oder die FrameMaker-Datei
mit den 3D-Objekten.

2)  Wabhlen Sie Datei > Als PDF speichern.

3) Sie kdnnen den Speicherort und den Dateinamen bei Bedarf dndern. Klicken Sie anschliefend auf
Speichern.
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4)  Klicken Sie im Dialogfeld ,,PDF-Einstellungen” auf Zuweisen, um eine PDF-Datei mit den Stan-
dardeinstellungen zu generieren. Alternativ dazu legen Sie weitere Optionen fest und klicken
anschliefend auf Zuweisen. Die in das Buch bzw. die Datei importierte U3D-Datei und alle ihre
Ansichten werden ebenfalls gespeichert. Wenn Sie das PDF-Dokument 6ffnen, wird die zuletzt fir
das 3D-Objekt im Dokument ausgewahlte Ansicht im PDF-Dokument angezeigt.

HINWEIS: FrameMaker ist standardmaRig flir die Einbettung von 3D-Objekten in PDF-Dateien konfiguriert.
Sie kénnen diese Option jedoch auch deaktivieren.

Klicken Sie im PDF-Dokument auf das 3D-Objekt, um die 3D-Symbolleiste anzuzeigen und die interak-
tiven Funktionen des 3D-Objekts zu aktivieren. Mit der 3D-Symbolleiste von Adobe Acrobat, die tiber
jedem 3D-Objekt in einem PDF-Dokument angezeigt wird, kdnnen Sie 3D-Designs vergroflern,
verschieben, drehen und analysieren.

Speichern von Dokumenten mit 3D-Objekten im XML-Format

Sie kdnnen eine FrameMaker-Datei, die ein 3D-Objekt enthilt, als XML-Datei speichern. Wenn Sie die
XML-Datei in FrameMaker 6ffnen, bleibt das 3D-Objekt auch beim Speichern der XML-Datei (Roundtrip)
erhalten. Das 3D-Objekt wird extrahiert und zusammen mit der XML-Datei als unabhangige U3D-Datei
gespeichert. Wird die Datei erneut in FrameMaker gedffnet, befindet sich das 3D-Objekt an der Stelle, an
der es eingefligt wurde.

Wenn Sie die Anderungen beibehalten méchten, die wihrend eines Roundtrip in einer XML-Datei an
einem 3D-Objekt vorgenommen wurden, missen Sie im Grafikbereich der DTD-Datei das neue Attribut
insetdata mit den folgenden Einstellungen sowie weiteren Attribute (beispielsweise Of fset und
DPI) hinzuflgen:

insetdata CDATA #IMPLIED

In der XSD-Datei miissen Sie entsprechend die folgenden Zeilen hinzufiigen:

<xsd:attribute name="insetdata" type="xsd:string" use="optional"/>
HiNwEIs: Das Attribut @insetdata unterstitzt keine Lese-/Schreibregeln.
Auch wenn Sie die DTD- und XSD-Datei nicht andern, konnen Sie U3D-Dateien nach XML exportieren.

Beim Roundtrip werden jedoch in FrameMaker an der U3D-Datei vorgenommene Anderungen nicht
beibehalten.

1)  Waihlen Sie Datei > Offnen, und 6ffnen Sie die FrameMaker-Datei mit den 3D-Objekten.
2)  Wabhlen Sie Datei > Als XML speichern, oder driicken Sie Esc+f+w+x.
3)  Sie kdnnen den Speicherort und den Dateinamen dndern. Klicken Sie anschliefend auf Speichern.

HINWEIS: Wenn Sie die XML-Datei in einem 3D-kompatiblen XML-Editor 6ffnen, enthalt das entsprech-
ende Grafikelement eine Referenz auf die U3D-Datei, und Dateiname und Speicherort entsprechen der
U3D-Datei. Wenn Sie die XML-Datei in FrameMaker 6ffnen, wird das 3D-Objekt als Bitmapbild darg-
estellt.
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Drucken von FrameMaker-Dateien mit 3D-Objekten

Dokumente, die 3D-Objekte enthalten, kdnnen ausgedruckt werden. Die 3D-Objekte werden als Bitmap-
bilder gedruckt.

1)  Offnen Sie das Dokument mit den 3D-Objekten.
2)  Wabhlen Sie Datei > Drucken.
3) Legen Sie die weiteren Druckoptionen nach Bedarf fest und klicken Sie anschliefend auf Drucken.

Einstellen der Hintergrundfarbe von 3D-Objekten

Sie kénnen die Farbe dndern, die hinter einem 3D-Objekt angezeigt wird. Die standardmaRige Hinter-
grundfarbe ist Weil3.

1)  Wahlen Sie ein 3D-Objekt aus.

2)  Wahlen Sie Grafik > 3D-Meniioption > Hintergrundfarbe

3)

4)  Wahlen Sie die gewiinschte Farbe aus und klicken Sie auf OK.

Einstellen der Beleuchtungsschemata von 3D-Objekten

Sie kénnen aus einer groBen Bandbreite von 3D-Beleuchtungsschemata fiir 3D-Objekte auswahlen, die
unterschiedliche Lichtquellen verwenden. Das Standard-Beleuchtungsschema fir alle 3D-Objekte ist
,Licht aus Datei”.

1)  Wahlen Sie ein 3D-Objekt aus.
2)  Wahlen Sie Grafik > 3D-Meniioption > Beleuchtung, und wahlen Sie eine der folgenden

Lichtquellen: Licht aus Datei, Kein Licht, WeilSes Licht, Tageslicht, Helles Licht, Primarfarben-Licht,
Nachtlicht, Blaues Licht, Rotes Licht, Cube-Licht, CAD-optimiertes Licht oder Scheinwerfer.

Einstellen der Ansichten fiir 3D-Objekte in FrameMaker

Das 3D-Objekt, das Sie in ein Dokument importieren, kann vordefinierte Ansichten enthalten. Sie kénnen
den Ansichtssatz flir das Objekt andern, und die ausgewahlte Ansicht wird beim Speichern des Doku-
ments gerendert. Wenn Sie dieses FrameMaker-Dokument in eine PDF-Datei konvertieren, stehen alle
vordefinierten Ansichten des 3D-Objekts in der PDF-Datei zur Verfligung. Die letzte Ansicht, die Sie vor
dem Speichern im Dokument ausgewahlt haben, wird zur Standardansicht in der PDF-Datei.

1)  Wahlen Sie ein 3D-Objekt aus.
2)  Wahlen Sie Grafik > 3D-Meniioption > Bestehende Ansichten anzeigen, wahlen Sie in der im
Dialogfeld angezeigten Liste eine Ansicht aus, und klicken Sie auf OK.

HINWEIS: Wenn Sie das Dokument als PDF-Datei speichern, werden alle Ansichten der U3D-Objekte im
konvertierten Dokument verfiigbar.
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Festlegen des Rendermodus fiir ein 3D-Objekt in FrameMaker

Die Bandbreite der Darstellungsmodi fiir 3D-Objekte reicht von ,,Drahtrahmen” zu ,,Durchgezogen” und
,Transparenter Begrenzungsrahmen®. Der Standardmodus fiir die Darstellung ist ,,Durchgezogen®.

1)  Wahlen Sie ein 3D-Objekt aus.

2)  Wabhlen Sie Grafik > 3D-Meniioption > Darstellungsmodus, und wahlen Sie einen der folgenden
Darstellungsmodi: Begrenzungsrahmen, Transparenter Begrenzungsrahmen, Transparente
Begrenzungsrahmen-Kontur, Eckpunkte, Schattierte Eckpunkte, Drahtrahmen, Schattierter
Drahtrahmen, Durchgezogen, Transparent, Durchgezogener Drahtrahmen, Transparenter

Drahtrahmen, Abbildung, Durchgezogene Kontur, Schattierte Abbildung oder Ausgeblendeter
Drahtrahmen.
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Importieren von PDF-Dateien

Beim Importieren einer PDF-Datei in ein FrameMaker-Dokument wird die PDF-Datei als Grafik behan-
delt. Dabei lasst sich jedoch nur jeweils eine Seite der PDF-Datei in das FrameMaker-Dokument impor-
tieren. Sowohl Prozess- als auch Schmuckfarben kénnen angezeigt und gedruckt werden.

Der Ausdruck von Grafiken mit Transparenzeffekten auf einem PostScript Level 1-Drucker oder einem
nicht PostScript-fahigen Drucker kann vom erwarteten Ergebnis abweichen.

1)  Geben Sie die Position der Grafik an.

2)  Wahlen Sie Datei > Datei > importieren.

3)  Wabhlen Sie die zu importierende PDF-Datei und klicken Sie auf Importieren.

4) Wenn die PDF-Datei mehrere Seiten umfasst, geben Sie im Dialogfeld ,PDF-Seite auswahlen” die
Seitennummer an. Zeigen Sie mithilfe des Reglers eine Vorschau der gewiinschten Seite an und
klicken Sie dann auf Auswahlen.
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Importieren von Microsoft Excel-Dateien

Erfahren Sie, wie Sie Microsoft Excel-Dateien (XLS und XSLX) in Adobe FrameMaker importieren.

Sie konnen Microsoft Excel-Dokumente mit den Erweiterungen .xls und .xIsx in FrameMaker-Dokumente
importieren.

Wenn Sie das Microsoft Excel-Dokument im Arbeitsmappenformat von Excel 97 bis Excel 2003 gespe-
ichert haben, kdnnen Sie es mit dem Microsoft Excel- oder dem Microsoft Excel 2016-Filter importieren.
Wenn Sie jedoch ein Microsoft Excel 2016-Dokument importieren mochten, miissen Sie den Microsoft
Excel 2016-Filter verwenden.

1)

2)

3)

4)

5)

6)

Klicken Sie an der Stelle, an der Sie die Datei einfliigen wollen, und wahlen Sie Datei > Datei > impor-
tieren.

Geben Sie die zu importierende Datei an, wahlen Sie die Option Import durch Referenz bzw. In
Dokument kopieren und klicken Sie auf Importieren.

Je nach dem zu importierenden Dokument ist im Dialogfeld Unbekannter Dateityp der Filter ,,Mic-
rosoft Word” oder ,,Microsoft Word 2016“ ausgewdihlt.

Klicken Sie auf Konvertieren. Das Dialogfeld Textfluss durch Kopie importieren oder Textfluss durch
Referenz importieren wird gedffnet.

Wahlen Sie im Bereich Zu importierender Textfluss die Option Arbeitsseitenfluss oder die Option
Referenzseitenfluss aus.

Wahlen Sie im Bereich Importierten Textfluss formatieren eine der folgenden Optionen aus:

- Klicken Sie auf Mit Katalog des akt. Dokuments neu formatieren, um die Option Manuelle
Seitenumbriiche entfernen und die Option Sonstige irregulare Formatzuweisungen auszu-
wabhlen.

- Wenn Sie den importierten Inhalt in Standardtext konvertieren und dann in das Dokument
einfiigen moéchten, klicken Sie auf Als Standardtext formatieren.

- Wenn Sie das Originalformat des importierten Inhalts beibehalten und den Inhalt dann in das
Dokument einfliigen mdchten, klicken Sie auf Quellformatierung beibehalten.

Wahlen Sie im Dialogfeld Textfluss durch Referenz importieren eine der folgenden angezeigten
Optionen im Bereich Importierten Textfluss aktualisieren aus:

- Wenn der importierte Flussbereich automatisch aktualisiert werden soll, klicken Sie auf
Automatisch.

— Wenn Sie den importierten Flussbereich manuell aktualisieren moéchten, klicken Sie auf
Manuell.

Klicken Sie auf Importieren.
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Importieren von Microsoft Word-Dateien

Erfahren Sie, wie Sie Microsoft Word-Dokumente in ein FrameMaker-Dokument importieren.
Sie kdnnen Microsoft Word-Dokumente (. doc oder . docx) in FrameMaker-Dokumente importieren.

Wenn Sie das Microsoft Word-Dokument im Format von Word 97 bis Word 2003 gespeichert haben,
konnen Sie es mit dem Microsoft Word- oder dem Microsoft Word 2016-Filter importieren. Wenn Sie
jedoch ein Microsoft Word 2016-Dokument importieren méchten, missen Sie den Microsoft Word
2016-Filter verwenden. Sie konnen RTF-Dateien importieren, indem Sie den Microsoft RTF 1.9-Filter im
Dialogfeld Unbekannter Dateityp verwenden.

HinweEls: Wenn Sie die 64-Bit-Version von FrameMaker verwenden, stellen Sie sicher, dass Sie auch eine
64-Bit-Version der Microsoft Word-Anwendung verwenden. Die Verwendung von 32-Bit-Versionen von
Microsoft Word mit 64-Bit-Versionen von FrameMaker funktioniert moglicherweise nicht wie erwartet.
HINWEIS: Wenn Sie ein Word-Dokument einer bestimmten Richtung (LTR oder RTL) in ein

FrameMaker-Dokument importieren, miissen Sie sicherstellen, dass die Textrichtung (Dokument,
Tabelle oder Absatz) der Zielposition auf dieselbe Richtung eingestellt ist.

Sie kdnnen den angegebenen Vorgang befolgen, und Sie kdnnen aullerdem dieses Video unter

Word-Dokumente in FrameMaker importieren ansehen.

1) Platzieren Sie die Einfligemarke an der Stelle im Dokument, an der Sie den Text einfliigen méchten,
und wahlen Sie dann Datei > Datei > importieren.

2)  Geben Sie die zu importierende Datei an, wahlen Sie die Option Import durch Referenz bzw. In
Dokument kopieren und wahlen Sie dann Importieren aus.
Je nach dem zu importierenden Dokument ist im Dialogfeld Unbekannter Dateityp der Filter ,,Mic-
rosoft Word“ oder ,,Microsoft Word 2016“ ausgewdhlt.

3) Klicken Sie auf Konvertieren. Das Dialogfeld Textfluss durch Kopie importieren oder Textfluss
durch Referenz importieren wird geoffnet.

HinweEIs: Textmarken in Word-Dokumenten werden zu Querverweismarken. Anmerkungen in
Word-Dokumenten werden beim Importieren durch Referenz zu bedingten Tags mit der Bedingung
,Kommentar”. Verborgener Text in Word-Dokumenten wird beim Importieren zu bedingtem Text mit
der Bedingung , Verdeckt”.

Abhangig davon, ob Sie Import durch Referenz oder Datei in Dokument kopieren wiahlen, miissen Sie
die Schritte in einer der folgenden Prozeduren ausfihren:

Import durch Referenz

Wenn Sie in Schritt 2 oben Import durch Referenz auswahlen, gehen Sie folgendermalen vor:

1)  Wabhlen Sie im Bereich Zu importierender Textfluss einen Arbeitsseitenfluss oder einen Referenz-
seitenfluss aus.

2)  Wabhlen Sie im Bereich Importierten Textfluss formatieren eine der folgenden Optionen aus:
- Klicken Sie auf Mit Katalog des akt. Dokuments neu formatieren, um die Option Manuelle

Seitenumbriiche entfernen und die Option Sonstige irreguldre Formatzuweisungen auszu-
wahlen.
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3)

4)

—  Wenn Sie den importierten Inhalt in Standardtext konvertieren und dann in das Dokument
einfligen mochten, klicken Sie auf Als Standardtext formatieren.

- Wenn Sie das Originalformat des importierten Inhalts beibehalten und den Inhalt dann in das
Dokument einfligen méchten, klicken Sie auf Quellformatierung beibehalten.

Wihlen Sie im Dialogfeld Textfluss durch Referenz importieren eine der folgenden Optionen aus,
die im Bereich Aktualisierung von importiertem Textfluss angezeigt werden:

- Wenn der importierte Flussbereich automatisch aktualisiert werden soll, klicken Sie auf
Automatisch.

- Wenn Sie den importierten Flussbereich manuell aktualisieren mdchten, klicken Sie auf
Manuell.

Klicken Sie auf Importieren.

Datei in Dokument kopieren

Wenn Sie in Schritt 2 oben Datei in Dokument kopieren auswahlen, gehen Sie folgendermalien vor:

1)

2)

4)

5)

Wenn Sie ein . docx-Dokument importieren moéchten, werden Sie in einer Meldung gewarnt, dass
das Importieren eines Word-Dokuments vom Typ . docx einen Datenverlust nach sich ziehen
kann. Sie kdnnen das . docx-Dokument dennoch importieren, oder Sie brechen den Vorgang ab
und konvertieren das Dokument zuerst in Word in das Format . doc.

FrameMaker analysiert den Absatz und die Zeichenstile im Word-Dokument und ordnet diese dem
Absatz und den Zeichenstilen zu, die in der aktuellen FrameMaker-Vorlage festgelegt sind.

Das Dialogfeld ,, Word-Import“ zeigt eine Nachricht an, in der die Stile im Word-Quelldokument an-
gezeigt werden (griin markiert), die mit den Stilen in der FrameMaker-Zielvorlage (ibereinstimmen.
Wird ein FrameMaker-Stil nicht gefunden, werden die Formate des FrameMaker-Dokuments stan-
dardmdfig an den Word-Quellstil angepasst.

WIcHTIG: Die Stile werden auf Basis der Namen von Stilen zugeordnet, die in Word- und
FrameMaker-Dokumenten gefunden werden. Die Zuordnung wird nicht auf Basis der Format-
ierungsdefinition der Stile vorgenommen.

In der Liste der FrameMaker-Dokumentformate haben Sie fiir jeden Word-Stil die Option, einen al-
ternativen FrameMaker-Stil auszuwdhlen.

Wahlen Sie in der Dropdown-Liste einen FrameMaker-Stil, den FrameMaker auf die entsprech-
enden Word-Stile im importierten Dokument anwenden soll.

Wenn die FrameMaker-Vorlage einen Zuordnungsstil enthdlt, wird der FrameMaker-Stil standard-
mdflig in der Dropdown-Liste angezeigt. Sie kénnen diesen Stil verwenden oder jeden anderen Vor-
lagenstil aus der Dropdown-Liste auswdhlen.

Wenn fiir den Word-Stil kein FrameMaker-Zuordnungsstil gefunden wurde, wendet FrameMaker
standardmaRig die Formatierung des Word-Stils an. Allerdings kdnnen Sie aus der Dropdown-Liste
nach wie vor einen alternativen FrameMaker-Stil auswahlen.

Wenn der Word-Stil einen entsprechenden FrameMaker-Stil enthalt, klicken Sie auf Word-Format-
ierung beibehalten, um die Formatierung des Word-Stils beizubehalten.

Wenn Sie fir jede Stilzuordnung die Standardoption <Neues Format hinzufiigen> beibehalten oder
die Option Word-Formatierung beibehalten wahlen, werden die Word-Stildefinitionen in
FrameMaker importiert. Wenn ein Absatz oder Zeichenstil in Word ein Inlineformat aufweist,
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6)

7)

8)

wahlen Sie Word-Dokument-Inlineformate und Listenformate importieren, um Inlineformate in
das FrameMaker-Dokument einzufiigen.

Wihlen Sie fiir jede Tabelle im Word-Dokument die im Word-Dokument festgelegten Tabellenstile
oder wahlen Sie aus der Dropdown-Liste , Tabellen” einen FrameMaker-Tabellenstil.

Im Dialogfeld , Erweiterte Einstellung” konnen Sie manuelle Seitenumbriiche entfernen, die ggf. im
Word-Dokument enthalten sind.

Im Dialogfeld , Erweiterte Einstellung” kénnen Sie manuelle Seitenumbriiche entfernen, die im
Word-Dokument ggf. enthalten sind.

Klicken Sie auf Voreingestellte Datei speichern, um die aktuellen Einstellungen flir Absatz, Zeichen
und Tabellenstilzuordnung fiir eine voreingestellte Datei zu speichern.

Wenn Sie spdter andere Dokumente importieren, die dhnliche Stile verwenden, und Sie dieselbe Stil-

zuordnung verwenden miissen, klicken Sie auf die Schaltfliche Offnen, um die voreingestellte Datei
zu verwenden.
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Importieren von MIF -Dateien

Erfahren Sie, wie Sie Maker Interchange Files (MIF) in ein FrameMaker-Dokument importieren.

MIF ist ein Textformat, mit dessen Hilfe Sie Informationen zwischen FrameMaker und anderen Anwend-
ungen austauschen kénnen. Alle Arten von Format- und Seitenlayoutinformationen werden in
MIF-Befehle libersetzt. FrameMaker interpretiert die Befehle in der MIF-Datei und wandelt sie wieder in
Format- und Layouteinstellungen um.

Sie kdnnen Text aus dem speziellen Textfluss einer MIF-Datei genauso wie aus einer FrameMaker-Datei
importieren. Beim Import durch Kopieren werden alle Referenz- und Vorgabeseiten ebenso wie die
Arbeitsseiten importiert. Der Text wird auf einer unverketteten Seite angezeigt.

Weitere Informationen zu MIF finden Sie im Onlinehandbuch MIF Reference.

Verwenden des MIFWash-Dienstprogramms

Im Lieferumfang von FrameMaker ist das MIFWash-Dienstprogramm enthalten, das standardmaRig

installiert ist. Mit dem MIFWash-Dienstprogramm kdnnen Sie Folgendes:

J Einen Stapelprozess ausfiihren, mit dem alle alten . fm-Dateien in einem Buch in eine neuere
Version konvertiert werden, ohne jede Datei einzeln manuell konvertieren zu missen.

. Einen Stapelprozess ausfiihren, mit dem alle . fm-Dateien in einem Buch in das .mi f-Format
konvertiert werden. Hiermit kénnen Sie Informationen zwischen FrameMaker und anderen
Anwendungen austauschen.

. Einen Stapelprozess ausfiihren, mit dem alle Dateien in einem Buch ge6ffnet werden, ohne dass
Warnmeldungen zu fehlenden Schriften, fehlenden Bildern und anderen Problemen angezeigt
werden.

. Eine beschadigte FrameMaker-Datei reparieren.

Zum Verwenden des MIFWash-Dienstprogramms starten Sie FrameMaker und 6ffnen Sie eine Buchdatei

(.book). Im Hauptmend finden Sie das neue Menii Buchdienstprogramme. Fiihren Sie mit diesem Meni

folgende Aufgaben aus:

. Buch-MIFWash: Dieser Vorgang konvertiert alle Dateien in einem Buch in das MIF-Format. Bevor
Sie diese Aufgabe ausfiihren, sollten Sie eine Sicherung aller Dateien in lhrem Buch erstellen.

. Alle Buchkomponenten 6ffnen (Warnungen unterdriicken): Dieser Vorgang 6ffnet alle Dateien in
Ihrem Buch und unterdriickt dabei alle Warnmeldungen.

RELATED LINKS:
Textrahmen verketten

Formatierten Text importieren
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Anhangen oder Einbetten von Dateien

Erfahren Sie, wie Sie Dateien in Ihr Quelldokument einfligen und im generierten PDF-Dokument
veroffentlichen.

Wahrend des Authorings konnen Sie lhrem Quelldokument selbst Referenzdokumente hinzufiigen.
Diese Dokumente werden dann in die PDF-Ausgabe eingebettet oder daran angehdngt. Abhangig davon,
welche Voreinstellungen Sie fiir die PDF-Generierung verwenden, missen Sie entweder die Option fiir
das Einbetten oder Anhadngen einer Datei auswahlen. PDF/-A2-konforme PDFs beispielsweise ermogli-
chen das Einfigen anderer PDF/A-konformer Dateien, wahrend PDF/A3-konforme PDFs beliebige Date-
itypen als Anhang unterstitzen.

. Um eine Datei anzuhdngen, navigieren Sie zu Einfiigen > Datei an PDF anhangen.
. Um eine Datei einzubetten, navigieren Sie zu Einfiigen > Datei in PDF einbetten.

Navigieren Sie zu der Datei, die Sie einfligen méchten, und wdhlen Sie sie aus. Klicken Sie dazu auf
die Schaltfliiche Auswdhlen des Dialogfelds Datei auswdhlen.

Auf dem folgenden Screenshot ist zu erkennen, wie in Quelldokumente eingebettete oder daran an-
gehdngte Dateien aussehen:

............. i FrameMaker-Benutzerhandbuch

éDatei einbetten

XML-Quelldate1

Figure 1: An ein Quelldokument angehdngte bzw. darin integrierte Dateien

Wenn Sie die PDF-Ausgabe generieren, erscheinen die eingefligten Dateien in Adobe Acrobat unter den
Anhangen:

Datei hinzufiigen
R
FrameMaker-Benutzerhandbuch

Datei einbetten

*

XML-Quelldatei

Figure 2:  Eingefligte Dateien in der PDF-Ausgabe
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HINWEIS: Wir empfehlen, eine Datei am Dokumentenende einzubetten, da sie in der veréffentlichten PDF
dazu fuhren kann, dass an der Stelle der Einfligung ein Leerraum entsteht.
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TEXT IMPORTIEREN

Text importieren

Erfahren Sie, wie Sie in FrameMaker den Befehl ,, Datei importieren” verwenden, um formatierten und
unformatierten Text zu importieren.

In diesem Thema

. Einftihrung

. Formatierten Text importieren

. Unformatierten Text importieren

Einfihrung

Sie kdnnen den Befehl Datei > Datei > importieren verwenden, um Text auf allen Plattformen zu impor-
tieren. Diese Methode ist flexibler als die Verwendung der Zwischenablage.

Wenn Sie nur auf einer Plattform arbeiten, kénnen Sie den Import auch mithilfe einer plattformspezi-
fischen Technik ausfiihren. Weitere Informationen hierzu finden Sie unter ,0Objekte integrieren”.

Der importierte Text kann formatiert oder unformatiert sein. Unformatierter Text enthalt nur Worter
und keinerlei Informationen Gber Schriften, Einzlige, Abstdande, automatische Nummerierung usw..
Formatierter Text dagegen enthalt diese Informationen.

Formatierten Text importieren

Sie konnen formatierten Text aus folgenden Quellen in ein FrameMaker-Dokument importieren:
. einen Textfluss aus einem anderen Teil desselben Dokuments
. einen Textfluss aus einem anderen FrameMaker-Dokument

. einen Textfluss aus einem anderen FrameMaker-Dokument, bei dem es sich um eine MIF-Datei
(Maker Interchange Format) handelt

. eine in einer anderen Anwendung (z. B. Microsoft Word) erstellte Datei, fir die ein installierter
Filter vorhanden ist

Wenn Sie Text aus einem anderen FrameMaker-Dokument importieren, werden auch Querverweise,
FuRnoten, Variablen, Marken und verankerte Rahmen importiert. Auch Bedingungs-Tags im Textfluss
werden Ubertragen. Beim Import von Text aus einer anderen Anwendung werden (abhangig von den
Einstellungen der anderen Anwendung und von den verwendeten Filtern) einige dieser speziellen
Elemente ebenfalls importiert.

1) Klicken Sie an der Stelle, an der Sie den Text einfligen mochten, und wahlen Sie Datei > Datei >
importieren.

2)  Geben Sie die Datei, die den zu importierenden Textfluss enthalt, und die Importmethode an.

3) Klicken Sie auf Importieren.

4)  Wenn das Dialogfeld ,,Unbekannter Dateityp” angezeigt wird, wahlen Sie einen Dateityp aus und
klicken auf Konvertieren. Das nachste Dialogfeld hangt von der in Schritt 2 gewéahlten Import-

methode ab. Das Dialogfeld Textfluss durch Referenz importieren enthalt Einstellungen fir die
Aktualisierung des importierten Textflusses. Wahlen Sie einen Arbeitsseitenfluss oder einen
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TEXT IMPORTIEREN

5)

6)

7)

Referenzseitenfluss. Normalerweise stammt der zu importierende Text aus Arbeitsseiten.
Referenzseiten konnen Textfliisse mit Mustertext oder Mustergrafiken fiir die Verwendung auf
Arbeitsseiten enthalten.

Legen Sie fest, wie der importierte Text formatiert werden soll. Fiihren Sie dazu eine der folgenden
Aktionen aus:

- Um dem importierten Text fir alle Gbereinstimmenden Tags die Formate des aktuellen Doku-
ments zuzuweisen, klicken Sie auf Mit Katalog des akt. Dokuments neu formatieren.
Stimmen die Typen nicht iberein, bleibt die Formatierung des importierten Textes erhalten.
Gewohnlich wahlen Sie auch Optionen zum Loschen manueller Seitenumbriiche und anderer
Formatanderungen (wie Schrift- oder Tabulatoreinstellungen) aus, damit der importierte Text
das gleiche Aussehen wie der Text im aktuellen Dokument erhalt.

- Um die Formatierung des importierten Textes zu entfernen und die an der Einfligemarke
glltigen Zeichen- und Absatzformate zuzuweisen, klicken Sie auf Als Standardtext neu
formatieren. (Text in Tabellen oder verankerten Rahmen behilt die urspriingliche Format-
ierung des Quelldokuments bei.)

- Wenn die Formatierung aus dem Quelldokument beibehalten werden soll, klicken Sie auf
Quellformatierung beibehalten. Die Formate des importierten Textes werden nicht in die
Formatkataloge des aktuellen Dokuments aufgenommen. Wenn Sie spater die Formate des
aktuellen Dokuments d@ndern, sind die Formate des importierten Textes davon nicht
betroffen. Dies gilt auch dann, wenn die Typen im aktuellen Dokument mit denen im
importierten Text libereinstimmen.

Wenn Sie den Text durch Referenz importieren, geben Sie an, wie der Texteinschub aktualisiert

werden soll, indem Sie eine der folgenden Aktionen ausfihren:

- Soll der Texteinschub bei jedem Offnen des Dokuments aktualisiert werden, klicken Sie auf
Automatisch.

- Soll die Aktualisierung nur dann erfolgen, wenn Sie dies angeben, klicken Sie auf Manuell.

Klicken Sie auf Importieren. Wurde der Text durch Referenz importiert, erscheint er als Textein-
schub. (Ein Texteinschub ist mit dem Quelldokument verknipft und kann nur in diesem bearbeitet
werden.)

Unformatierten Text importieren

Wenn Sie Text aus einer unformatierten Textdatei importieren, kénnen Sie angeben, ob der Import
durch Kopieren oder Referenz erfolgen soll und wie die Zeilen in der Textdatei behandelt werden sollen.
Der importierte Text Glbernimmt die Zeichen- und Absatzformatierung, die an der Einfligemarke giiltig

ist.

1)

2)
3)

Platzieren Sie die Einfligemarke an der Stelle, an der Sie den Text einfligen mochten, und wahlen
Sie dann Datei > Datei > importieren.

Geben Sie die zu importierende Textdatei und die Importmethode an.

Klicken Sie auf Importieren. Das angezeigte Dialogfeld Importieren ist von der Importmethode
abhangig (Importieren durch Referenz oder In Dokument kopieren), die Sie wahlen.
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TEXT IMPORTIEREN

4)

5)

6)

7)

Legen Sie fest, wie der importierte Text behandelt werden soll, indem Sie eine der folgenden
Aktionen ausfiihren:

- Wenn Zeilenumbriiche nur bei Leerzeilen eingefiigt werden sollen, klicken Sie auf
Zeilenenden als Zeilenumbriiche einlesen. Setzen Sie diese Option flir absatzorientierte Text-
dateien ein, z. B. fiir Dateien, die Dokumenttext enthalten.

- Soll am Ende jeder Zeile ein Umbruch erfolgen, klicken Sie auf Zeilenenden als Absatzenden
einlesen. Diese Option eignet sich fur zeilenorientierte Textdateien, z. B. flir Dateien, die
Computercode enthalten.

- Um importierten Text in eine Tabelle zu konvertieren, klicken Sie auf In Tabelle konvertieren.
Legen Sie dafiir ein Tabellenformat und weitere erforderliche Einstellungen fest. Verwenden
Sie diese Option nur dann, wenn die Datei Text mit Begrenzungszeichen enthalt, z. B. die
Textausgabe eines Datenbankprogrammes.

Wenn Sie den Text durch Referenz importieren, geben Sie an, wie der Texteinschub aktualisiert
werden soll, indem Sie eine der folgenden Aktionen ausfiihren:

- Soll der Texteinschub bei jedem Offnen des Dokuments aktualisiert werden, klicken Sie auf
Automatisch.

- Soll die Aktualisierung nur dann erfolgen, wenn Sie dies angeben, klicken Sie auf Manuell.

Wihlen Sie, falls erforderlich, aus der Dropdown-Liste Codierung eine Zeichencodierung aus. Dies
empfiehlt sich nur, wenn Sie wissen, dass die eingestellte Codierung falsch ist. Wenn Sie eine unkor-
rekte Codierung erzwingen, werden eventuell Zeichen ersetzt oder anstelle mancher Zeichen
Fragezeichen angezeigt.

Klicken Sie auf Importieren. Wurde der Text durch Referenz importiert, erscheint er als Textein-
schub.
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TEILEN GRORER DOKUMENTE

Teilen groBer Dokumente

Erfahren Sie, wie Sie groRe Dokumente aufteilen, die Sie aus Word, Excel, MIF oder einem anderen
Erstellungssystem importiert haben.

In diesem Thema

. Einftihrung

. Dokument teilen

Einflihrung

Wenn Sie ein Dokument aus Word oder einer anderen Anwendung importieren, wird dieses in der Regel
als ein einziges groRes Dokument in FrameMaker importiert. Um ein solches Dokument fir die
Verwendung vorzubereiten, sollten Sie es kleinere, verwaltbare Abschnitte oder Kapitel aufteilen.
Verwenden Sie die Funktion ,, Aktuelles Dokument teilen”, um ein groRes FrameMaker-Dokument in klei-
nere Kapitel aufzuteilen.

Mit der Funktion ,Aktuelles Dokument teilen” kénnen Sie jedes grolRe Dokument mit einem oder
mehreren Absatzformaten oder Marken aufteilen. Wenn Sie ein Dokument importieren, erstellt
FrameMaker standardmaRig entsprechende Absatzformate im importierten Dokument. Sie kénnen auch
eine Marke erstellen und auf Uberschriftenebene dort anwenden, wo Sie das Dokument aufteilen
mochten. Sie kdnnen auch Markentext hinzufligen und zum Erstellen der Dateinamen der aufgeteilten
Kapitel verwenden. Am Ende des Dokumentaufteilungsprozesses generiert FrameMaker ein Buch und
zugehorige Kapitel, die auf Grundlage der Absatzformate oder Teilungsmarken erstellt werden.

Dokument teilen

Fiihren Sie die folgenden Schritte aus, um ein grofRes FrameMaker-Dokument zu teilen:

1)  Offnen Sie das Dokument, das Sie teilen méchten.

2)  Wabhlen Sie Datei > Dienstprogramme > Aktuelles Dokument teilen.
Das Dialogfeld Dokument teilen wird angezeigt.

3) Geben Sie im Dialogfeld Dokument teilen die folgenden Parameter fiir die Dokumentteilung an:
- Quelldokument: Gibt den Namen der zu teilenden Datei an.

- Erstellen in Ordner: Wahlen Sie einen Ordner aus, in dem die Buchdatei und die geteilten
Kapitel gespeichert werden sollen.

- Leerraum in Dateinamen: Beim Dokumentteilungsprozess wird eine Datei flir jedes entstan-
dene Kapitel erstellt. Der Dateiname wird aus dem Uberschriftentext erstellt. Falls der Uber-
schriftentext Leerzeichen enthalt, wahlen Sie aus, wie diese beim Erstellen der Dateinamen
behandelt werden sollen. Sie kdnnen den Leerraum in Dateinamen folgendermalen behan-
deln:

o Leerraum beibehalten.
o Leerraum loschen.
o Leerraum durch einen Unterstrich ersetzen
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4)
5)

6)

7)

9)
10)

o Leerraum durch einen Bindestrich ersetzen

- Sonderzeichen in Dateinamen: Ahnlich wie bei Lerrdumen kdnnen Sie auswihlen, wie ein
Sonderzeichen im Dateinamen behandelt werden soll. Sie haben folgende Optionen:

o Loschen
. Durch Unterstrich ersetzen
o Durch Bindestrich ersetzen

Klicken Sie auf Weiter.

Wahlen Sie aus, ob Sie eine Marke, Absatzformate oder beides zum Teilen des Dokuments
verwenden mochten.

HINWEIS: Sie konnen mehrere Absatzformate auswahlen, um das Dokument zu teilen. Um eine klare
und einfache Dokumentstruktur zu erhalten, sollten Sie nicht mehr als 2—3 Formate auswahlen.
Klicken Sie auf Analysieren.

FrameMaker zeigt eine Struktur des Buches und der Kapitel, die basierend auf den ausgewdhlten
Marken und/oder Absatzformaten erstellt werden.

(Optional) Benennen Sie die Buch- oder Kapiteldateien um.

- Die erste Datei in der Liste ist eine Buchdatei. Um die Buchdatei umzubenennen, wahlen Sie
sie aus, geben Sie den gewlinschten Dateinamen in das Textfeld ein und klicken Sie auf ,Buch
umbenennen”.

—  Wahlen Sie eine beliebige Kapiteldatei aus, geben Sie den gewilinschten Dateinamen in das
Textfeld ein und klicken Sie auf ,,Dokument umbenennen®”.

HiNnweEIs: Durch Doppelklicken auf den Dateinamen eines Kapitels gelangen Sie zur entsprechenden
Uberschrift bzw. zum entsprechenden Thema im Quelldokument.

(Optional) Wenn Sie fir ein Kapitel in der Liste keine separate Datei erstellen mochten, kdnnen Sie
das Kapitel entfernen und seinen Inhalt mit dem vorherigen Kapitel in der Liste zusammenfihren.

Um ein Kapitel mit einem anderen zusammenzufiihren, wahlen Sie es aus und klicken Sie auf Aus

Dateiliste entfernen. Das ausgewahlte Kapitel wird mit dem vorherigen Kapitel in der Liste zusam-
mengefihrt.

Wenn Sie eine separate Datei fiir ein zusammengefiihrtes Kapitel erstellen méchten, wéihlen Sie die
Kapiteldatei aus und klicken Sie auf In Datei konvertieren.

Beim Zusammenfiihren oder Aufteilen einer Datei (ibernimmt FrameMaker automatisch die Verwal-
tung der Sequenzierung der Datei- und Dokumentstruktur gemdfs dem Quelldokument.

Klicken Sie auf Teilung beginnen.
Klicken Sie auf Fertig.

Die Protokolldatei des Dokumentteilungsprozesses wird in einem Browser angezeigt, und die neue Buch-
datei wird in FrameMaker geotffnet.
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Gleichungen

Wissen Sie liber das Platzieren und Anzeigen von Gleichungen, Inline-Gleichungen in strukturierten
Dokumenten, Gleichungen in Grafikrahmen in FrameMaker.

Platzieren und Anzeigen von Gleichungen

Sie konnen eine Gleichung in einen Absatz integrieren oder als eigenen Absatz anzeigen. In beiden Féllen
erstellt FrameMaker einen verankerten Rahmen fir die Gleichung. Sie kénnen eine Gleichung auch
zusammen mit anderen Objekten in einem Grafikrahmen positionieren, z. B. um eine Grafik zu
beschriften. Grafikrahmen mit Gleichungen kdnnen verankert oder unverankert sein.

A Supposethat x = x,and y = ¥,

2 2
X—X —
B 0 + y fo =1
a? b=
" x—22+y—43=1
c ( ¥ ' 16 9
SO SR

Figure 1:  Grafische Rahmen mit Gleichungen

A. EingebundenB. Anzeige C. In einer Grafik zusammen mit anderen Objekten

Gleichungen in Absatztext und freigestellte Gleichungen in strukturierten Dokumenten

Ein Gleichungselement besteht aus einem Rahmen mit einem Gleichungsobjekt, in das Sie mathema-
tische Ausdriicke eingeben konnen. Wie ein verankerter Rahmen fiir Grafiken ist ein Gleichungsrahmen
an einer bestimmten Stelle im Text verankert.

Sie kdnnen ein Gleichungselement in den Absatztext eingliedern oder in einem separaten Absatz
anzeigen.

Suppose that the axes of an ellipse lie
, along the lines x = x; The ellipse is
represented by the following equation.

2 2
(x—x5) )’-J‘O( )_

a2 b=
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Figure 2:  Gleichungselement - Inline und in einem separaten Paagraph
A. Inline-Gleichung B. Gleichung anzeigen

Ein Gleichungselement wird in der Struktur des Dokuments an der Stelle angezeigt, an der es mit Text
verankert wurde, unabhdngig von der Position der Gleichung auf der Seite. In der Strukturansicht wird
das Gleichungselement durch ein Elementrechteck ohne abgerundete Ecken mit dem Textausschnitt
<GLEICHUNG> dargestellt Die Gleichung selbst ist nicht Teil der Struktur.

(—[Para ]
Inline Eqg |- <EQUATION=

(+[Para ]

Figure 3:  Gleichungselement

Wenn Sie in SGML oder XML exportieren, schreibt FrameMaker die Gleichung in eine separate Grafik-
datei (CGM-Format). FrameMaker figt dann eine Entity-Referenz fiir sie in der SGML- oder XML-Datei
ein.

Sie kdnnen das Dateiformat fur Gleichungen dndern, indem Sie eine Lese-/Schreibregel verwenden.
Wenn Sie das Dateiformat in MIF &ndern, verfolgt FrameMaker die Gleichungen und die entsprechenden
Dateinamen. Wenn die Gleichung mehrmals gespeichert wird, wird sie dennoch immer in der gleichen
Datei gespeichert. Es werden nicht mehrere Dateien erstellt, wie es in FrameMaker 9 der Fall war.

Beispiel:

Neues Verhalten Altes Verhalten
Die Gleichung 1 wird in einer Datei Die Gleichung 1 wird in einer Datei gespeichert, z. B.
gespeichert, z. B. als eql .mif alsegl.mif
Das Bearbeiten des FrameMaker-Inhalts und Das Bearbeiten des FrameMaker-Inhalts und das
das anschlieRende Speichern der Datei anschlielendes Speichern der Datei erstellt fir
speichert die Gleichung 1 in der gleichen Datei | dieselbe Gleichung 1 eine neue Datei, z. B.
egl.mif. eg2.mif.
FrameMaker erstellt NICHT bei jeder FrameMaker erstellt bei jedem Speichern der
Speicherung der gleichen Gleichung neue gleichen Gleichung neue Dateien.
Dateien.

Gleichungen in Grafikrahmen in strukturierten Dokumenten

Sie kénnen eine Gleichung auch in einen Rahmen einfligen, der bereits fir eine Grafik eingefiigt wurde.
Dies ist zweckmaRig, wenn Sie die Gleichung mit Grafikobjekten verbinden méchten. Wenn es sich bei
dem verankerten Rahmen um ein Element handelt, ist das Element Teil der Dokumentstruktur. Der
Rahmeninhalt, einschlielRlich der Gleichung, wird in der Struktur jedoch nicht angezeigt.

Eine Gleichung, die sich zusammen mit einer Grafik in einem verankerten Rahmen befindet, kann
wahrend des Exports zu SGML oder XML zu unerwiinschten Ergebnissen flihren. Fligen Sie daher nur ein
Objekt in den Rahmen ein, wenn Sie einen Export nach SGML oder XML vornehmen mochten.
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Uberblick tiber Fenster ,,Gleichungen”

Kennen Sie das Gleichungsbedienfeld und seine verschiedenen Einstellungen in FrameMaker.

Das Fenster ,Gleichungen” enthilt Befehle zum Erstellen und Andern von Gleichungen. AuRerdem
enthalt es die Symbole, Operatoren, Funktionen und anderen Elemente, die Sie fiir Gleichungen bend-
tigen. Um das Fenster anzuzeigen, klicken Sie auf die Schaltflache Gleichungens, oben rechts im Doku-
mentfenster.

Equations ]
- Sumbals Large Relations Matrices Pozitioning
Operators Delimiters Calculus Functions
al BT vl Al 5 =] & nlef of wf 1| [CStertstring [ Endstring ||
wlal sl wl -l =l El ol =) el =f o £ Diacritical Marks:
ol el I ) I I e e I e o] I 2 A I A K
a =+ [ =
l=fo [x[s[®]lelalv]-]-]-] dAHHEEHEE

Figure 4:  Gleichungen Fenster

A. Die Dropdown-Liste Gleichungen wird auf jeder Seite angezeigt. B. Dieser Teil des Fensters dndert sich
mit jeder Seite. C. Die Seitennamen werden hier angezeigt, wobei immer die aktuelle Seite hervorge-
hoben ist.

Das Fenster ,,Gleichungen” enthélt neun Seiten mit FrameMath-Elementen und Befehlen. Klicken Sie
oben im Fenster auf den Namen der Seite, die Sie anzeigen mdchten.

Symbole
Griechische Buchstaben, Elementarsymbole, Diakritika und Zeichenketten

Operatoren
Wurzeln, Exponenten, Vorzeichen, Tiefstellung, Hochstellung und logische Symbole

GroR
Summe, Produkt, Integral, Schnittmenge und Vereinigungsmenge

Klammern
Runde, eckige und geschweifte Klammern und Substitution

Relationen
Gleich, kleiner, groRer, ahnlich, Element von, Teilmenge von, Obermenge von und proportional zu

Analysis
Integrale, Ableitungen, partielle Ableitungen, Gradienten und Grenzen

Matrizen
Matrizen und Matrix-Befehle

Funktionen

Trigonometrische, hyperbolische und logarithmische Funktionen, Befehle zur Berechnung von
Ausdriicken und fir die Erstellung und Anwendung von Regeln
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Positionierung

Steuerung fir Position und Abstand eines Ausdrucks; Befehle fiir die Festlegung der Ausrichtung
und Befehle zum Einstellen und Loschen manueller Zeilenumbriiche

Gleichungen erstellen

Erfahren Sie, wie Sie Gleichungen erstellen und in Thren Dokumenten in FrameMaker verwenden.

Um eine Gleichung zu erstellen, fligen Sie ein Gleichungsobjekt in das Dokument und anschlieend Fram-
eMath-Elemente in die Gleichung ein.

Tipp: VergroRern Sie die Darstellung so lange, bis die Gleichung einfach zu lesen ist.

Erstellen von Gleichungen in Absatztext

1)

2)

3)

Klicken Sie an der Stelle in den Text, an der Sie die Gleichung einfligen mochten. Falls sich der Text
in einem gedrehten Textrahmen befindet, heben Sie die Drehung zunachst auf, indem Sie den
Rahmen auswéhlen und Esc+g+0 (null) driicken.

Wahlen Sie Einfiigen > Gleichungen, oder klicken Sie auf die Schaltflache Gleichungeny, auf der
rechten Seite des Dokumentenfensters.

Wahlen Sie im Fenster Gleichungen einen der Befehle fiir Neue Gleichung in der Dropdown-Liste
Gleichungen. Die Optionen Klein, Normal und GroR geben die SchriftgrofRe der neuen Gleichung
an.

Unterhalb der Zeile mit der Einfligemarke wird ein neues Gleichungsobjekt in Form eines Frageze-
ichens innerhalb eines verankerten Rahmens eingefligt. Dieses Fragezeichen wird durch das erste
von lhnen eingegebene FrameMath-Element ersetzt.

Suppose that the axes of an ellipse lie along
the line |

Figure 5: Neue Gleichung in Absatztext

4)

Fligen Sie die FrameMath-Elemente in die Gleichung ein, indem Sie sie manuell eingeben oder auf
die gewlinschten Elemente im Fenster Gleichungen klicken.

Suppose that the axes of an ellipse lie along
the line]

b

[

=
=

Figure 6: Eingefligte Elemente
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5)

Wahlen Sie In der Dropdown-Liste Gleichungen die Option Schrumpfungsgleichung aus. Durch
diese Option wird der Rahmen um die Gleichung verkleinert und die Gleichung in die Textzeile am
Ankersymbol eingefligt.

Suppose that the axes of an ellipse lie along
the line x = x, q

Figure 7:  In Absatztext eingepasste Gleichungen

6)

7)

Wenn die Gleichung auf beiden Seiten zu dicht am Text erscheint, fligen Sie vor bzw. nach dem
Rahmen ein Leerzeichen ein. FrameMaker behandelt einen Rahmen, der eine Gleichung im Absa-
tztext enthalt, als ein Zeichen und erzeugt kein zusatzliches Leerzeichen um ihn herum.

Uberschreitet die Gleichung die Zeilenhéhe, kénnen Sie Platz tiber oder unter der Gleichung
schaffen. Deaktivieren Sie dazu in der Formatierungsleiste in der Dropdown-Liste Zeilenabstand
den festen Zeilenabstand.

Erstellen einer Gleichung in einem eigenen Absatz (freigestellte Gleichung)

1)
2)

3)
4)

Klicken Sie in einen leeren Absatz.

Wenden Sie einen Absatzstil aus dem Absatzformatkatalog an, oder richten Sie Ihr eigenes Format
ein. Der Absatzstil bestimmt die Ausrichtung, den vertikalen Abstand und eventuelle automatische
Nummerierungen fiir den Absatz, der die Gleichung enthalt.

Tiep: Wenn das Dokument aus einer Buch- oder Berichtsvorlage erstellt wurde, verwenden Sie den
Absatzstil ,,Gleichung”. Sie kdnnen dieses Format auch in ein Dokument kopieren. In diesem Fall
werden Sie jedoch wahrscheinlich Anderungen vornehmen miissen (z. B. an den Eigenschaften
,Standardschrift” und ,, Abstand”).

Klicken Sie auf die Schaltflache Gleichungs, auf der rechten Seite des Dokumentenfensters.
Wahlen Sie im Fenster Gleichungen einen der Befehle fiir Neue Gleichung in der Dropdown-Liste
Gleichungen. Die Optionen Klein, Normal und GroB geben die SchriftgréRRe der neuen Gleichung
an.

Unterhalb des leeren Absatzes wird ein neues Gleichungsobjekt in Form eines Fragezeichens inner-
halb eines verankerten Rahmens eingefiigt. Dieses Fragezeichen wird durch das erste von lhnen
eingegebene FrameMath-Element ersetzt.
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The ellipse is represented by the following
equation:q

17

Figure 8: Neue Gleichung in einem verankerten Rahmen

5) Fugen Sie die FrameMath-Elemente in die Gleichung ein, indem Sie sie manuell eingeben oder auf
die gewlinschten Elemente im Fenster ,,Gleichungen” klicken.

The ellipse is represented by the following
equation:q
17
2 2
X—x ¥V
i ¢ -
a b~

Figure 9: Eingefligte Elemente

6) Wahlen Sie In der Dropdown-Liste Gleichungen die Option Schrumpfungsgleichung aus. Durch
diese Option wird der Rahmen um die Gleichung verkleinert und die Gleichung in den leeren Absatz

eingefiigt.
The ellipse is represented by the following
equation:
2 2
X—X —
o Y=o _ 1y
2 2
a b

Figure 10: In einen eigenen Absatz eingepasste Gleichungen

Erstellen einer Gleichung in einem Grafikrahmen mit anderen Objekten

1)  Klicken Sie auf die Schaltflache Gleichungs, auf der rechten Seite des Dokumentenfensters.
2)  Waihlen Sie einen Grafikrahmen oder ein Objekt in einem Grafikrahmen.

3)  Wabhlen Sie im Fenster Gleichungen einen der Befehle fiir Neue Gleichung in der Dropdown-Liste
Gleichungen. Die Optionen Klein, Normal und GroR geben die SchriftgrofRe der neuen Gleichung
an.

Ein neues Gleichungsobjekt wird als Fragezeichen in einem Rahmen angezeigt. Dieses Fragezeichen
wird durch das erste von lhnen eingegebene FrameMath-Element ersetzt.
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Its horizontal axis is 12 units long. Its vertical
axis is 7 unitslong]_ Y

Figure 11: Neues Gleichungsobjekt
4)  Fugen Sie die FrameMath-Elemente in die Gleichung ein, indem Sie sie manuell eingeben oder auf
die gewlinschten Elemente im Fenster Gleichungen klicken.

5) Um die Gleichung genau an der gewlinschten Position zu platzieren, wahlen Sie die Gleichung
zunachst aus, indem Sie bei gedriickter Strg-Taste darauf klicken.

6) Fihren Sie zum Verschieben einer Tabelle einen der folgenden Schritte aus:
- Ziehen Sie diese mit der Maus.
- Verschieben Sie die Gleichung mithilfe der Pfeiltasten.

—  Verwenden Sie den Befehl Grafiken > Objekteigenschaften, um die Gleichung genau zu posi-
tionieren.

RELATED LINKS:
Verschieben von Objekten

Erstellen von Gleichungen mithilfe des Fensters ,,Gleichungen”

Einfiigen von FrameMath-Elementen

Wissen Sie, wie mathematische Elemente und mathematische Ausdriicke einfliigen, kennen Sie den
Umfang der Operationen in FrameMaker.

Eine Gleichung enthalt aus FrameMath-Elementen bestehende Ausdriicke — Zeichen, Zeichenfolgen,
Operatoren und andere mathematische Elemente aus dem Fenster Gleichungen.

T B

|

x— a2 + = Radius?
c

o—|

Figure 12: Gleichung mit mathematischen Elementen
A. Alphanumerisches Zeichen B. Textzeichenfolge C. Ausdruck D. Operator

Nach der Erstellung eines Gleichungsobjekts fligen Sie FrameMath-Elemente ein, indem Sie sie manuell
eingeben oder im Fenster Gleichungen darauf klicken. Das Fenster Gleichungen kann geschlossen sein,
wenn Sie ein Element mit der Tastatur eingeben.
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HINWEIS: Mathematische Gleichungen unterstiitzen den Unicode-Standard zur Textcodierung.

Wirkungsbereich von Operationen

Wenn Sie ein FrameMath-Element in eine Gleichung einfligen, korrigiert FrameMaker die mathema-
tische Syntax. Das Ergebnis hangt vom Wirkungsbereich der Operation ab, d. h. von der Auswahl oder von
der Position der Einfligemarke. Wenn Sie z. B. x in einen Bruch eingeben, hangt das Ergebnis davon ab,
ob der Zahler, der Nenner oder der ganze Bruch ausgewihlt ist.

Multiplikation mit x Ergebnis

2y +7x
4

(2y +7)x
4

2y +7
- x
4

Im ersten Beispiel wird lediglich die 7 mit x multipliziert. Im zweiten Beispiel fligt FrameMaker runde
Klammern hinzu, um anzuzeigen, dass der gesamte Ausdruck 2y + 7 mit x multipliziert wird. Im letzten
Beispiel wird der gesamte Bruch mit x multipliziert. Die GréRe der Einfligemarke im ersten und letzten
Beispiel zeigt den Wirkungsbereich an.

Zahlreiche Fehler in Gleichungen resultieren aus einem fehlerhaften Wirkungsbereich, der beim
Einflgen eines Elements entweder zu gering oder zu grol} bemessen wurde. Gehen Sie bei der Auswahl
des gewlinschten Bereichs sorgfiltig vor, bevor Sie ein Element einfligen.

Einfligen eines FrameMath-Elements

1)  Wahlen Sie einen Ausdruck aus oder platzieren Sie die Einfligemarke in einer Gleichung.
2)  Fuhren Sie einen der folgenden Schritte aus:

- Klicken Sie auf das Element, um ein FrameMath-Element mithilfe des Fensters Gleichungen
einzufiigen.

- Wenn Sie ein alphanumerisches Zeichen bzw. ein Symbol tiber die Tastatur einfligen
mochten, geben Sie es ein. Sie kénnen runde Klammern, eckige Klammern, Plus-, Gleich-
heitszeichen usw. eingeben. Wenn Sie eine offene runde Klammer eingeben, fligt
FrameMaker die schlieBende Klammer ein.

- Um ein Element in einem Dialogfeld einzugeben, geben Sie einen umgekehrten Schragstrich
(\ ) gefolgt von der das Element definierenden Zeichenfolge ein und driicken die Eing-
abetaste. Um z. B. das Unendlichkeitssymbol einzufligen, o, geben Sie \infty ein und driicken
Sie die Eingabetaste.

- Einfligen eines speziellen FrameMath-Elements.
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Wenn fiir ein Element ein oder mehrere Operanden benétigt werden, wird fiir jeden Operanden ein
Fragezeichen angezeigt; M Ist kein Operand erforderlich, sehen Sie die Einfligemarke. Driicken Sie
die Tabulatortaste, um von einem Operanden zum ndchsten zu wechseln.

Einfligen einer Zeichenfolge

Eine Textfolge ist eine Folge von Zeichen, die als Einheit interpretiert wird. Im Unterschied zu Zeichen,
die einen Ausdruck darstellen, werden Zeichen in einer Zeichenfolge in der Regel nicht kursiv dargestellt
und nicht miteinander multipliziert.

one electronvolt = 1.60 10712 joule
|

A A

Figure 13: A. Zeichenfolgen

Zeichenfolgen besitzen keine mathematische Bedeutung in FrameMaker. So kann z. B. mit Berechnungs-
befehlen die Funktion tan, nicht aber die Zeichenfolge ,tan” berechnet werden.

1) Klicken Sie im Fenster Gleichungen auf der Seite ,Symbole” auf Textanfang. Es werden zwei
doppelte Anflihrungszeichen (" " ) angezeigt. Sie konnen zum Beginnen der Zeichenfolge auch
einen Apostroph (') oder doppelte Anflihrungszeichen (") eingeben.

2)  Geben Sie den Text der Zeichenfolge ein. Die Anflihrungszeichen werden ausgeblendet und der
Text wird in der eingegebenen Form angezeigt. Wenn Sie einen geraden Apostroph oder gerade
Anflhrungszeichen als Teil der Zeichenfolge eingeben mochten, halten Sie beim Driicken der betr-
effenden Taste die Strg-Taste gedriickt.

3) Klicken Sie auf Zeichenfolge beenden auf der Seite Symbole, oder driicken Sie die Eingabetaste.

Horizontale oder vertikale Liste mit Ausdriicken einfiigen, hinzufiigen oder bearbeiten

Ein Gleichungsobjekt beinhaltet in der Regel eine Gleichung oder einen Ausdruck. Sie kénnen jedoch eine
horizontale oder vertikale Liste einrichten, in der mehrere Ausdriicke im selben Objekt enthalten sind.
Wenn Sie eine Liste auswahlen, werden alle Ausdriicke in der Liste als ein Objekt ausgewahlt.

A—2XY 3ab

y=x-3 2
B
x2-6x+9

Figure 14: (A) Horizontale Liste (B) An Gleichheitszeichen ausgerichtete vertikale Liste
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FrameMaker richtet die Ausdriicke in der Liste automatisch aus. Wenn Sie die Liste verschieben,
behalten alle Ausdriicke ihre relative Position.

1)  Waihlen Sie den Ausdruck aus, der das erste Element in der Liste sein soll oder den Sie der Liste
hinzufligen mochten.

2) Klicken Sie im Fenster Gleichungen auf der Seite ,Operatoren” auf das Element fir horizontale

Listen 7 7 oder vertikale Listenelement : angezeigt. Um ein FrameMath-Element hinzuzufiligen,
geben Sie die Elemente ein, oder klicken Sie auf die Elemente im Fenster Gleichungen. Eine hori-
zontale bzw. vertikale Liste wird angezeigt. Der ausgewahlte Ausdruck erscheint als erstes Element
in der Liste. Ein zweites Element wird in der Liste als Fragezeichen angezeigt.

Vor dem Klicken Nach dem Klicken

7! ?

abc abe

" “(g)

Im ersten Beispiel wird eine horizontale Liste eingefligt. Im zweiten Beispiel wird eine vertikale Liste
eingefligt und der ausgewahlte Ausdruck wird zum ersten Element in der Liste. Im letzten Beispiel wird
eine vertikale Liste als Teil eines groReren Ausdrucks eingefiigt.

Einfligen von Symbolen

Die Seite ,,Symbole” des Fensters ,Gleichungen” enthalt das griechische Alphabet, sonstige Symbole und
diakritische Zeichen.

Griechische Buchstaben, die Entsprechungen im lateinischen Alphabet besitzen, wie z. B. das grol3e
Alpha (A), sind auf der Seite ,,Symbole“ nicht enthalten. Die folgenden Beispiele zeigen, wie sich das
Klicken auf das x auf der Seite ,Symbole” auswirkt.

Vor dem Klicken Nach dem Klicken

}r+?l y+7m

(y+ 7)m

Diakritische Zeichen werden auf dem Element links neben der Einfligemarke oder auf dem gewahlten
Ausdruck angezeigt. Klicken Sie einmal auf jedes diakritische Zeichen, das Sie einfligen mochten.
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HINWEIS: Damit Elemente fiir eine Summe, ein Produkt oder partielle Ableitungen berechnet und math-
ematisch manipuliert werden, fiigen Sie diese von der Seite ,GroR“ oder , Analysis” ein. Verwenden Sie
nicht die Elemente auf der Seite ,,Symbole”. Elemente der Seite ,,Symbole” werden nicht berechnet.

Einfligen von Operatoren

Die Seite ,Operatoren” des Fensters ,,Gleichungen” enthalt haufig verwendete Operatoren, Wurzeln,
Exponenten, Vorzeichen, Tiefstellungen, Hochstellungen und logische Symbole.

Wenn ein Ausdruck beim Einfligen eines Operators ausgewahlt ist, wird er zum ersten Operanden. Die
folgenden Beispiele zeigen, wie sich das Klicken auf das Pluszeichen 2 + # oder auf das Divisionszeichen
auf der Seite ,,Operatoren” auswirkt.

Vor dem Klicken Nach dem Klicken
2x] 2x+f
2| 2(x+@

€ Xy 3%
7

Mogliche Schreibweisen fur das Divisionszeichen sind Schragstrich (/), horizontaler Strich g — ¢ oder Divi-
sionszeichen ..

FrameMaker kann Exponenten mathematisch auswerten, nicht jedoch hochgestellten Text.

AR xt+2 = },2—3

Figure 15: (A) Hochgestellt (B) Exponent

Einfligen groBer Elemente

Die Seite ,,GroRR” des Fensters , Gleichungen” enthalt Summen, Produkte, Integrale, Schnittmengen und
Vereinigungsmengen.

Wenn ein Ausdruck beim Einfligen eines groRBen Elements ausgewahlt ist, wird er zum ersten Operanden.
Die folgenden Beispiele zeigen, welches Ergebnis das Klicken auf das Summensymbol ¥.7 auf der Seite
,Grofl“ hat.

Vor dem Klicken Nach dem Klicken

2x] 2x2. @
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Vor dem Klicken

Nach dem Klicken

Y.2x

Sie kdnnen nach dem Einfligen eines FrameMath-Elements von der Seite ,,GroR“ einen Operanden

hinzufiigen.

Einfligen von Klammern

Die Seite ,Klammern” enthalt Trennzeichen wie runde, eckige und geschweifte Klammern.

Wenn beim Einfligen eines Klammerpaares ein Ausdruck ausgewahlt ist, wird dieser zwischen die Klam-
mern platziert. Das folgende Beispiel zeigt, welches Ergebnis das Klicken auf die Klammern der Seite

,Klammern“ hat.

Vor dem Klicken

Nach dem Klicken

2x{ﬂ)

(EE3)

Sie kdnnen runde Klammern auch als eckige ([ ]) oder geschweifte ({ }) Klammern darstellen.

Einfligen von Relationen

Die Relationsseite enthélt Relationssymbole wie =, <, >, ., o, =, =, und .

Alle Relationssymbole, aulRer dem binaren Gleichheitszeichen ? = # gelten flir das Zeichen links oder
rechts des Eingabepunkts oder fir die Auswahl. Wenn Sie ein Relationssymbol zwischen multiplizierten
Elementen einfligen, wirkt sich dieses auf die Elemente auf beiden Seiten der Einfligemarke aus.

Bindre Gleichheitszeichen ¢ = ? werden rechts neben dem aktuellen Ausdruck (wie im zweiten Beispiel)
angezeigt. Wenn die Einfliigemarke oder die Auswahl tief- oder hochgestellt formatiert ist, wird das

Gleichheitszeichen tief- oder hochgestellt angezeigt.

Vor dem Klicken

Nach dem Klicken

gblc abc =

2xl-|— 3y 2x+ 3y = ﬂ
= +

Exﬁl 3y przﬂ 3y
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Einfligen eines zweiwertigen Gleichheitszeichens an der Einfligemarke

1)  Driicken Sie Esc+tm+=

Vor dem Klicken Nach dem Klicken

a

“ i
o e=R

Einfiigen von Analysis-Elementen

Die Seite ,Analysis” enthalt Integrale, Ableitungen, partielle Ableitungen, Gradienten und die
Limes-Funktion.

Wenn ein Ausdruck beim Einfligen eines Analysiselements ausgewahlt ist, wird er zum ersten
Operanden. Die folgenden Beispiele zeigen die Ergebnisse beim Klicken auf das Integralzeichen | auf der
Seite ,, Analysis”.

Vor dem Klicken Nach dem Klicken
2
X jﬂ

szdx

Sie kdnnen die Position von Operanden dndern und Operanden hinzufligen.

Einfligen von Matrizen

Die Seite ,,Matrizen” enthalt Elemente fiir Matrizen in den Gréflen 1 mal 1 bis 3 mal 3. Sie konnen einer
Matrix nach ihrer Erstellung Zeilen und Spalten hinzufligen.

Wenn ein Ausdruck beim Einfligen eines Matrizenelements ausgewahlt ist, wird der Ausdruck zur ersten
Zelle in der Matrix.

Vor dem Klicken Nach dem Klicken
3x 9
l 3x n :
7?7
‘i 9
5 e
77
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Einfligen von Funktionen

Die Seite ,Funktionen” enthalt trigonometrische, hyperbolische und logarithmische Funktionen sowie
die Funktionen Signum, Limes und allgemeine Funktionen.

FrameMaker fligt Funktionen an der Einfligemarke oder an der Auswahl ein. Wenn ein Ausdruck
ausgewahlt ist, wird er zum Argument der Funktion (aufer fiir die Limes-Funktion und die allgemeinen

Funktionen 2 und 5" angezeigt. Das folgende Beispiel zeigt, welches Ergebnis das Klicken auf die Funk-
tion ,,Sinus” auf der Seite ,, Funktionen” hat.

Vor dem Klicken Nach dem Klicken

T T sin H

Y

sINT

Einfligen eines speziellen FrameMath-Elements

Zusatzlich zu den in FrameMaker enthaltenen FrameMath-Elementen konnen Sie fiir ein Dokument
definierte FrameMath-Elemente einfligen.

Spezielle FrameMath-Elemente besitzen in FrameMaker keine mathematische Bedeutung. Ein spezielles
FrameMath-Element fiir einen Operator wird in einer Gleichung als Operator behandelt. Es kann jedoch
von FrameMaker nicht berechnet werden.

1)  Wabhlen Sie im Fenster Gleichungen den Eintrag FrameMath-Element einfiigen in der Drop-
down-Liste Gleichungen.

2)  Wahlen Sie den Namen des Elements aus und klicken Sie auf Einfiigen.

Anpassen oder Freilegen einer Gleichung

Verstehen Sie das Einpassen und Auspacken einer Gleichung in FrameMaker.

Beim Einpassen einer Gleichung wird der umgebende verankerte Rahmen so verkleinert, dass er die
Gleichung exakt umgibt. Die Ankerposition des Rahmens wird an die Einfligemarke verschoben und die
Einfligemarke selbst wird hinter dem Rahmen positioniert.

A circle whose center is at the origin and
whose radius is r is represented by the

equation

Pty =2

Figure 16: Vor dem Einpassen
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A circle whose center is at the origin and
whose radius is r is represented by the
equation ,2 +y2=r2q

Figure 17: Nach dem Einpassen

Passen Sie eine Gleichung ein, nachdem Sie diese fertiggestellt haben, sodass sie nur den mindestens
erforderlichen Platz einnimmt und an der Grundlinie des umgebenden Textes ausgerichtet wird. Legen
Sie eine Gleichung frei, um den verankerten Rahmen fiir eine leichtere Bearbeitung zu vergréRern.

1)  Klicken Sie auf die Gleichung oder wahlen Sie ihren Rahmen aus.

2)  Waihlen Sie im Fenster Gleichungen den Eintrag Gleichung einpassen oder Gleichung ausgliedern
in der Dropdown-Liste Gleichungen. Die Kanten einer eingepassten Gleichung werden in manchen
Fallen nicht auf dem Bildschirm angezeigt. Sie sind jedoch im gedruckten Dokument enthalten.

Bearbeiten von Gleichungen

Erfahren Sie, wie Sie eine Gleichung bearbeiten, Trennzeichen entfernen, mit Elementformaten und
Matrizen in FrameMaker arbeiten.

Sie konnen eine Gleichung auf die gleiche Weise bearbeiten wie Text. Sie kdnnen FrameMath-Elemente
hinzufligen, andern, neu anordnen und entfernen sowie Gleichungen ausschneiden, kopieren und
einfiigen. Wenn Sie eine Gleichung bearbeiten, wird die Syntax der Gleichung bei Bedarf angepasst.

Sie kdnnen Matrizen dndern — Zeilen und Spalten hinzufligen oder |6schen, Klammern |6schen sowie die
Zeilenhohe und Spaltenbreite dndern. Sie kénnen auch zwischen unterschiedlichen Darstellungen fir
einige FrameMath-Elemente, wie Klammern, wahlen. Sie kdnnen einigen Elementen Operanden
hinzufligen, wie Integrale und Summen.

Wenn lhre Gleichung eingepasst wurde, legen Sie diese vor der Bearbeitung frei. Dadurch wird der
verankerte Rahmen wieder in voller GrolRe angezeigt und Sie haben mehr Platz fiir die Bearbeitung zur
Verfligung.

HINWEIS: Um eine gedrehte Gleichung zu bearbeiten, bringen Sie zuerst die Gleichung bzw. den
Textrahmen wieder in die nicht gedrehte Position, indem Sie Esc+g+0 (null) driicken.

Erweitern einer Auswahl mit der Tastatur

o Driicken Sie die Leertaste. Die Auswahl wird zur Aufnahme des nachsthéheren Ausdrucks
erweitert. Das folgende Beispiel zeigt, welches Ergebnis das wiederholte Driicken der Leertaste
erzeugt.
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Urspringliche Auswahl

L b o aac

A

Nach einmaligem Driicken

_ b

PJE— dac

Nach zweimaligem Driicken

Andern der Auswahl

. Flihren Sie eine der folgenden Aktionen aus:

- Um die Auswahl nach rechts auf den nachsten Teilausdruck zu verlagern, driicken Sie die
Nach-Rechts-Taste.

- Um die Auswahl nach links auf den nachsten Teilausdruck zu verlagern, driicken Sie die
Nach-Links-Taste.

- Um die Auswahl zum nachsten Fragezeichen zu verlagern, driicken Sie die Tabulatortaste.

Ersetzen oder Loschen eines FrameMath-Elements oder einer Gleichung

1) Wihlen Sie das Element, das Sie l6schen mochten, und driicken Sie die Entf-Taste. Das Element

wird durch ein Fragezeichen ersetzt.
2)  Fihren Sie eine der folgenden Aktionen aus:

- Um das Element zu ersetzen, klicken Sie in das Fenster Gleichungen, oder geben Sie die
Ersetzung ein.

- Um das Element zu I6schen, driicken Sie erneut die Entf-Taste. FrameMaker entfernt alle
nicht mehr benoétigten Elemente, wie Pluszeichen oder Klammern.

- Halten Sie die Strg-Taste gedriickt, um die Gleichung auszuwahlen, und driicken Sie die

Entf-Taste.

Entfernen von Klammern

Nach der Eingabe oder Bearbeitung einer Gleichung kdnnen zusatzliche Klammern vorhanden sein —

runde, geschweifte oder eckige Klammern. Sie kdnnen diese zusatzlichen Klammern entfernen. Wenn Sie
jedoch spater Rechenbefehle verwenden, wertet FrameMaker die Gleichung so aus, als ob die Klammern
noch vorhanden waren.

. Um alle Klammern zu entfernen, wahlen Sie den Ausdruck aus. Klicken Sie auf der Seite Klammern

im Fenster Gleichungen auf Klammern entfernen.

Vor dem Klicken

Nach dem Klicken

( 21 ( ) ;|

2ab
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. Um eine Klammer zu entfernen, platzieren Sie die Einfligemarke rechts neben die Klammer und
driicken die Entf-Taste. Wenn die Klammer eine Entsprechung besitzt, wie die linke Klammer
zwischen a und b im folgenden Beispiel, wird diese ebenfalls entfernt.

Vorher Nachher

2a(b)| 2ab

Umschalten des Formats fiir ein Element

Einige FrameMath-Elemente kénnen auf unterschiedliche Arten dargestellt werden. Formate fiir Trenn-

zeichen sind beispielsweise (x}, [x] oder {x} angezeigt. Mogliche Schreibweisen fiir Divisionszeichen
X

sind X =¥, fof', oder J_fr

1)  Markieren Sie das gesamte Element.

2) Klicken Sie auf der Seite , Operatoren”, ,GrolR“, ,Klammern“ oder ,Analysis” im Fenster
Gleichungen auf Format umschalten. Der Befehl ist auf allen vier Seiten identisch und funktioniert
flr jedes Element mit mehreren Formaten. Moéglicherweise missen Sie mehrmals klicken, um das
gewlinschte Format zu erhalten.

Hinzufiigen eines Operanden zu einem FrameMath-Element

Wourzel- und Gradientzeichen sowie Logarithmen kdnnen einen oder zwei Operanden haben. Integrale
und andere Zeichen auf den Seiten ,GroR” und , Analysis” kdnnen einen, zwei oder drei Operanden
haben.

The ellipse is represented by the following
equationy

2 L2
(x_fo_) LU

1
a bz

Figure 18: Operanden

Sie kdnnen diesen Elementen Operanden hinzufligen, ohne noch einmal von vorne beginnen zu missen.
1) Klicken Sie auf den Ausdruck mit dem Element oder wahlen Sie einen beliebigen Teil des Ausdrucks
aus.

2)  Klicken Sie auf der Seite ,,GroRR“ oder , Analysis” auf Neuer Operand. Ein Fragezeichen wird an der
Stelle des einzufligenden Operanden angezeigt.
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Andern von Matrizen

Sie kdnnen die Anzahl der Zeilen und Spalten in einer Matrix andern und eckige Klammern um die Matrix
hinzufligen oder entfernen. AuRerdem kénnen Sie die Breite der Spalten je nach Inhalt variieren oder
allen Spalten dieselbe Breite zuweisen. Auch die Zeilenh6he kann von Zeile zu Zeile unterschiedlich fest-
gelegt werden.

Sie kdnnen eine Matrix auch transponieren und algebraische Operationen ausfiihren.

. Um einer Matrix eine Zeile oder eine Spalte hinzuzufiigen, platzieren Sie die Einfligemarke in die
Matrix. Wahlen Sie im Fenster Gleichungen auf der Seite ,Matrizen” in der Dropdown-Liste Matrix-
befehle die Option Neue Zeile oder Neue Spalte.

Vor ,,Neue Spalte” Nach , Neue Spalte”

a, ab
cd cd?
Mit ,,Neue Zeile” fiigen Sie eine Zeile am unteren Ende hinzu.
Mit ,,Neue Spalte” fiigen Sie eine Spalte auf der rechten Seite hinzu.

o Um eine Zeile oder eine Spalte aus einer Matrix zu I6schen, wahlen Sie die Zeile oder Spalte aus und
dricken die Entf-Taste.

. Um eckige Klammern um eine Matrix hinzuzufligen oder sie zu entfernen, wahlen Sie die gesamte
Matrix aus. Klicken Sie im Fenster Gleichungen auf der Seite ,,Matrizen” auf Klammern
hinzufiigen/entf..

. Um die ZeilenhOohe oder Spaltenbreite in einer Matrix zu andern, wahlen Sie die Matrix aus. Wahlen
Sie im Fenster Gleichungen auf der Seite ,,Matrizen” in der Dropdown-Liste Hohe der Matrixzeile
bzw. Breite der Matrixspalte entweder GleichmaRBig oder Proportional.

x+3 x+3
x
Y Y
x y-2 x y—-2

Figure 19: Gleiche Zeilenhohe (links) und proportionale Zeilenhdhe (rechts)

Wenn Sie Proportional wahlen, ist jede Zeile so hoch wie die hochste Zelle der Zeile. Jede Spalte ist so
breit wie die breiteste Zelle in der Spalte.

Wenn Sie GleichmaBig wahlen, ist jede Zeile so hoch wie die hdchste Zeile der gesamten Matrix. Jede
Spalte ist so breit wie die breiteste Zelle in der gesamten Matrix.
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Erstellen und Definieren von FrameMath-Elementen

Kennen Sie mathematische Elementtypen, dndern Sie integrierte mathematische Elemente, definieren
Sie benutzerdefinierte mathematische Elemente in FrameMaker.

Wenn Sie ein FrameMath-Element benétigen, das sich nicht im Fenster ,,Gleichungen” befindet, kénnen
Sie ein eigenes spezielles Element definieren, beispielsweise einen neuen Operator wie x angezeigt.
FrameMaker kann jedoch spezielle FrameMath-Elemente nicht mathematisch auswerten.

Um ein integriertes Element des Fensters in einem Dokument verandert anzuzeigen, konnen Sie das
Element neu definieren. Sie kdnnen beispielsweise die Funktion asin(inverser Sinus) derart neu
definieren, dass sie als sin—1 angezeigt wird. Sie kdnnen die Darstellungsweise eines integrierten
Elements neu definieren, jedoch nicht seinen Typ dndern.

Sie kdnnen auch FrameMath-Elementdefinitionen aus anderen Dokumenten importieren.

Die Definitionen spezieller FrameMath-Elemente werden auf einer oder mehreren Referenzseiten
gespeichert, deren Namen mit FrameMath beginnen. Jede Definition ist eine Textzeile in einem unver-
ankerten Grafikrahmen, dessen Name dem Namen des Elements entspricht.

Figure 20: (A) Grafikrahmen (B) Textzeile

RELATED LINKS:
Hinzufiigen von Text zu Grafiken

Verwenden von Referenzrahmen auf Referenzseiten

Gleichungsschriften im gesamten Dokument édndern

FrameMath-Elementtypen

Der Typ eines FrameMath-Elements bestimmt, wie sich das Element in Bezug auf andere Elemente in
seiner Umgebung verhalt. Ein Pluszeichen (+) ist z. B. vom Typ ,Einfligung”, d. h., es hat immer zwei
Operanden, einen auf der rechten und einen auf der linken Seite.

Sie kdnnen spezielle FrameMath-Elemente der folgenden Typen definieren.

Eingabe Beispiel Anzahl der Operanden
Atom (¥ Keine
Klammern (o) Einer
Funktion sino. Einer, rechts des Elements
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Eingabe Beispiel Anzahl der Operanden
Einflgung o+ ﬁ Zwei, links und rechts des Elements
GrofR o Bis zu drei, oberhalb, unterhalb und rechts des
sz Elements
1
Grenzwert 1 Bis zu zwei, unterhalb und rechts des Elements
lim =
x—}mx
Prafix Einer, links des Elements
—L
Suffix s Al Einer, rechts des Elements
Vertikale Liste o Zwei, einer Uber dem anderen (Die Textzeile, die eine
B spezielle vertikale Liste definiert, wird als Trennlinie
zwischen Listenelementen verwendet.)
Y
Sie kénnen keine speziellen FrameMath-Elemente der folgenden Typen definieren.
Eingabe Beispiel
Ableitung
d
dx
Diakritische Zeichen o,
Horizontale Liste Xy x+y
Matrix
o B
vy &
Wurzel
Skript 5
o, B,
Substitution xl ~
x=73
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Eingabe Beispiel

Bruch o!

Definieren eines speziellen FrameMath-Elements oder Andern der Definition eines integrierten Fram-
eMath-Elements

1)

2)
3)

4)
5)

Wahlen Sie Ansicht > Referenzseiten, und zeigen sie eine FramMath-Referenzseite an.

Wenn das Dokument keine FrameMath-Referenzseite enthdlt, zeigen Sie eine Referenzseite an, und
wdhlen Sie dann Einfiigen > Referenzseite einfiigen. Nennen Sie die neue Seite ,FrameMath1”. Ver-
wenden Sie die Grofsbuchstaben F und M wie gezeigt.

Zeichnen Sie mit dem Grafikrahmen-Werkzeug einen unverankerten Grafikrahmen auf der Seite.

Geben Sie im Dialogfeld ,,Rahmenname” einen Namen fiir das FrameMath-Element ein. Wenn Sie
ein integriertes Element andern mochten, geben Sie den Namen des betreffenden Elements ein.

Flgen Sie mit dem Textzeilen-Werkzeug eine Textzeile im Grafikrahmen hinzu.
Erstellen Sie in der Textzeile das FrameMath-Element und beachten Sie dabei folgende Regeln:

- Sie kénnen beliebige Zeichen in die Textzeile eingeben und die Formatierung der Zeichen
andern. Sie kdnnen die Zeichen auch mithilfe von Kurzbefehlen zur Feinpositionierung
verschieben.

- Fiir alle FrameMath-Elemente, mit Ausnahme von Klammern, wird in der Textzeile lediglich
das mathematische Symbol dargestellt, nicht der Operand. Wenn Sie das Element spater in
einer Gleichung einfligen, fligt FrameMaker die Operanden entsprechend des Typs des Fram-
eMath-Elements an der geeigneten Stelle ein. Ein groBes Element, wie ein Summen- oder ein
Integralzeichen, besitzt beispielsweise bis zu drei Operanden: einen oberhalb, einen unter-
halb und einen rechts vom Symbol.

- Ein spezielles Trennzeichen kann nur einen Operanden enthalten, auch wenn einige integri-
erte Trennzeichen bis zu drei enthalten. Fligen Sie ein Leerzeichen in die Textzeile ein, um die
Position des Operanden anzuzeigen. Wenn Sie kein Leerzeichen in die Textzeile einfligen, fligt
FrameMaker den Operanden zwischen zwei Kopien des Trennzeichens ein.

Figure 21: (A) Zeichen in Klammer (B) Leerraum zur Angabe des Operanden

6)
7)

- FrameMaker verwendet die erste Textzeile im Rahmen fiir das spezielle FrameMath-Element.
Stellen Sie daher sicher, dass sich innerhalb des Rahmens nur eine Textzeile befindet.
Wahlen Sie den Grafikrahmen aus.

Wahlen Sie im Fenster Gleichungen in der Dropdown-Liste Gleichungen den Eintrag Definition zu
Katalog hinzufiigen.
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8) Wenn Sie ein spezielles mathematisches Element definieren, wahlen Sie einen Elementtyp aus der
Dropdown-Liste aus und klicken auf Hinzufiigen.

Suchen des Namens eines FrameMath-Elements

1) Setzen Sie die Einfligemarke in eine Gleichung.

2)  Wahlen Sie im Fenster Gleichungen den Eintrag FrameMath-Element einfiigen in der in der Drop-
down-Liste Gleichungen.

3) Deaktivieren Sie ,Nur Spezialelemente anzeigen” und blattern Sie durch die Elementnamen.

4)  Klicken Sie auf Abbrechen.

Andern oder Lschen der Definition eines speziellen FrameMath-Elements

1) Zeigen Sie die FrameMath-Referenzseite an, die das FrameMath-Element enthalt. Fiihren Sie dazu
einen der folgenden Schritte aus:

- Wenn das spezielle mathematische Element zu einer Gleichung gehort, wahlen Sie zunachst
das Element und danach im Fenster Gleichungen in der Dropdown-Liste Gleichungen die
Option Definition aktualisieren. Klicken Sie anschliefend auf Zu Rahmen wechseln.

- Wenn Sie das benutzerdefinierte FrameMath-Element nicht in eine Gleichung eingefligt
haben, wahlen Sie Ansicht > Referenzseite. Zeigen Sie anschlieffend die gewlinschte Frame-
Math-Referenzseite an.

2)  Fihren Sie eine der folgenden Aktionen aus:

- Bearbeiten Sie die Textzeile, die das FrameMath-Element enthélt. Wenn Sie eine Arbeitsseite
erneut anzeigen, verwendet FrameMaker die veranderte Definition und passt die
Gleichungen erneut ein.

- Loschen Sie den Grafikrahmen. Wenn das Element in einer Gleichung verwendet wird, zeigt
FrameMaker anstatt des Elements den Elementnamen umgeben von Fragezeichen an.

Positionieren von FrameMath-Elementen in einer Gleichung

FrameMaker positioniert FrameMath-Elemente entsprechend ihrer mathematischen Bedeutungin einer
Gleichung. In manchen Fallen kann jedoch eine Feinpositionierung von Elementen erforderlich sein, um
den optimalen Abstand zwischen den Elementen in der Gleichung zu erreichen.

10 10
Y 2k-7 Y 2k-7
k= k=

Figure 22: Vor und nach der Feinpositionierung

Sie konnen auch den Abstand auf jeder Seite des Elements festlegen.
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Figure 23:

a— A+ B
e—A + B
c— A+B

(A) Standardabstand (B) GroRRerer Abstand links und rechts (C) Kein Abstand links und rechts

. Flihren Sie im Fenster Gleichungen auf der Seite ,,Positionierung” einen der folgenden Schritte aus:

Figure 24:

Um einen ausgewahlten Ausdruck zu positionieren, klicken Sie auf einen Feinpositionierung-
spfeil. Klicken Sie so haufig wie erforderlich. Jedes Klicken verlagert einen Ausdruck am Bild-
schirm um ein Pixel. VergrofRern Sie die Ansicht flir eine héhere Prazision.

wha
- -
e

IEAENE
C3E 2516

Feinpositionierungspfeile
Um die Feinpositionierung zu entfernen, klicken Sie in der Mitte des Bereichs ,Feinposition-
ierung” auf die Schaltflache E3.

Um die Abstande zu Uiberprifen und per Angabe von numerischen Werten anzupassen,
klicken Sie auf Positionseinstellungen. Die exakten Abstande werden im Dialogfeld ,Position-
ierung von FrameMath-Elementen” im Bereich ,Abstand bei Feinpositionierung” angezeigt.
Geben Sie die entsprechenden Werte im Bereich ,,Abstand bei Feinpositionierung” ein und
klicken Sie auf Zuweisen.

Klicken Sie auf ein Pluszeichen (+), um den Abstand zu vergréRern, bzw. auf ein Minuszeichen
(=), um den Abstand zu verkleinern. Klicken Sie so haufig wie erforderlich. Durch jedes Klicken

wird ein Abstands-Pixel hinzugefligt oder entfernt. VergréBern Sie die Ansicht fiir eine hohere
Prazision.

HINwWEIS: Wenn Sie den Abstand um den FrameMath-Elementtyp ,,Einflgung”, ,Prafix“, , Suffix”
oder ,Klammern“ @ndern mochten, passen Sie stattdessen den Abstand benachbarter Frame-
Math-Elemente an. Sie konnen beispielsweise ein Leerzeichen auf jeder Seite des Pluszeichens im
Ausdruck a+bhinzufiigen, indem Sieaauswdhlen. Fiigen Sie das Leerzeichen auf der rechten Seite
hinzu. Wdhlen Sie anschliefSendb. Fiigen Sie das Leerzeichen auf der linken Seite hinzu.

Um Abstandswerte anzupassen, klicken Sie auf Positionseinstellungen. Die exakten Abstande
werden im Bereich ,, Abstand” des Dialogfelds , Positionierung von FrameMath-Elementen”
angezeigt. Geben Sie zum Anpassen der Abstandswerte die entsprechenden Werte im
Bereich , Abstand” ein und klicken Sie auf Zuweisen. Um die Standardabstandswerte wieder-
herzustellen, klicken Sie in der Mitte des Bereichs ,,Feinpositionierung” auf die Schaltflache
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Andern der Abstandswerte eines FrameMath-Elements bei jedem Auftreten

Einige Definitionen von FrameMath-Elementen (,Einfligung”, ,,Prafix“, ,Suffix“, ,,GroR”, ,Hoch-/Tiefstel-
lung” und ,,Bruch”) kdnnen mit neuen Abstanden aktualisiert werden. FrameMaker passt den Abstand
um das Element bei jedem Auftreten im Dokument an und passt die Gleichungen neu ein.

Sie kdnnen auch den Zeichenabstand in allen kleinen, mittleren und grof3en Gleichungen gleichmalig
andern.
1)  Markieren Sie das Element, nachdem Sie den Abstand um das Element in einer Gleichung ange-
passt haben.
2)  Wahlen Sie im Fenster Gleichungen in der Dropdown-Liste Gleichungen die Option Definition aktu-
alisieren.
3)  Fuhren Sie eine der folgenden Aktionen aus:
- Um den Abstand fiir das Element im gesamten Dokument zu andern, klicken Sie auf Aktuali-
sieren.
- Wenn Sie den Standardabstand wiederherstellen mochten, klicken Sie auf Standard abrufen.

Festlegen von Zeilenumbriichen und Ausrichten von Gleichungen

Wissen Sie, wie Linienumbriche definiert und Gleichungen entlang eines Punkts in einem Frame oder in
einer Liste in FrameMaker ausgerichtet werden.

Sie kénnen festlegen, wann ein Zeilenumbruch innerhalb einer Gleichung auftreten soll und wie die
Zeilen in einer mehrzeiligen Gleichung oder die Elemente in einer Liste oder Matrix ausgerichtet werden
sollen. Sie kdnnen auch mehrere Gleichungen aneinander ausrichten, selbst wenn sie in unterschiedli-
chen Rahmen platziert sind.

2a+3b—c=2x+1
3a—b = 4x

2b+tc=3x-7

2a-3b+7c—-2 = 2x+4

Figure 25: Ausrichten an der linken Seite des Gleichheitszeichens

Gleichungsobjekte werden genauso wie andere Objekte bearbeitet. Sie kdnnen Elemente in einer verti-
kalen Liste und Zeilen in einer mehrzeiligen Gleichung automatisch und manuell ausrichten. Die manuell
eingegebenen Ausrichtungspunkte setzen die automatische Ausrichtung auBer Kraft.
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O
l

2nr = md C =2nr = nd

Figure 26: Ausrichtung an der linken Seite und an einem manuellen Ausrichtungspunkt

Die Elemente einer horizontalen Liste konnen an ihren oberen und unteren Randern und an ihren Grun-
dlinien ausgerichtet werden.

Figure 27: Ausrichtung an der Grundlinie

Die Zellen in den einzelnen Matrixzeilen kdnnen an ihren oberen und unteren Randern und an ihren
Grundlinien ausgerichtet werden. Die Zellen in jeder Spalte kdnnen rechtshiindig, linksbiindig, zentriert
oder am Gleichheitszeichen ausgerichtet werden.

A ’-x +tv x

2
T X

Figure 28: Ausrichtung an:
A. Grundlinien B. Mitte

RELATED LINKS:
Kopieren und Anordnen von Objekten

Horizontale oder vertikale Liste mit Ausdriicken einfiigen, hinzufiigen oder bearbeiten

Andern von Zeilenumbriichen in einer Gleichung

Wenn eine Gleichung in mehrere Zeilen umbrochen wird, bleibt sie in einem einzigen verankerten
Rahmen. Sie kdnnen festlegen, wo die Zeilen in der Gleichung automatisch umbrochen werden. Wenn
Sie die Zeilenlange fiir den Umbruch dandern, wird die Gleichung entsprechend der neuen Breite neu
formatiert.
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Urspriingliche Gleichung

(x+1)F = xt+4x3+6x2 +4x+1

(x+ 1) = x¥+4x3
+6x2+4x+1

Figure 29: Gleichung wird an einer bestimmten Position umbrochen

Sie kdnnen einen Zeilenumbruch an einer bestimmten Position in der Gleichung erzwingen. Verwenden
Sie den manuellen Zeilenumbruch jedoch nicht zur Erstellung von separaten Gleichungen. Fligen Sie stat-
tdessen eine vertikale Liste mit Ausdriicken ein.

Fir Anderungen an den einzelnen Zeilenumbriichen stehen lhnen folgende Méglichkeiten zur Verfi-

gung:

J Um die automatische Zeilenldange fiir den Umbruch zu dndern, klicken Sie in die Gleichung oder
wahlen Sie einen Teil der Gleichung aus. Wahlen Sie Grafik > Objekteigenschaften. Bearbeiten Sie
den Wert im Feld Automatischer Zeilenumbruch nach und klicken Sie auf Zuweisen. Der Wert ist
auf die Rahmenbreite der Gleichung voreingestellt.

. Um einen manuellen Zeilenumbruch einzufiigen, klicken Sie an der Position, an der die Gleichung
in zwei Zeilen umbrochen werden soll. Wahlen Sie im Fenster Gleichungen auf der Seite ,,Position-
ierung” in der Dropdown-Liste Zeilenumbruch die Option Manuell einstellen. Ein Zeilenum-
bruchssymbol ; wird an der Einfligemarke angezeigt, wenn die Anzeige der Steuerzeichen aktiviert
ist.

{x+1)8 = x%+ 8x7+ 28x%+ 56x°+ (
70x* +56x> +28x2 + 8x + 1

Figure 30: Manueller Zeilenumbruch

. Um einen manuellen Zeilenumbruch zu entfernen, wahlen Sie den Teil der Gleichung aus, in dem
sich das Symbol flir den Zeilenumbruch befindet. Wahlen im Fenster Gleichungen auf der Seite
Positionierung in der Dropdown-Liste Zeilenumbruch die Option Manuell I6schen.

Ausrichten von freigestellten Gleichungen

Die Ausrichtung einer freigestellten Gleichung (linksbiindig, zentriert, rechtsbiindig) wird vom Format
des Absatzes bestimmt, in dem sie sich befindet.
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The ellipse is represented by the following
equationy

(x— %) (Y=%o)

— =11
@ b-

Figure 31: Zentrierte Absatzausrichtung

1)
2)

Klicken Sie in den Absatz, der die Gleichung enthalt (jedoch nicht auf die Gleichung selbst).

Wahlen Sie in der Formatierungsleiste oder der Absatzgestaltung in der Dropdown-Liste Ausrich-
tung eine Ausrichtung aus.

Festlegen der automatischen Ausrichtung fiir eine vertikale Liste oder eine mehrzeilige Gleichung

1)
2)

Klicken Sie in die Gleichung oder Liste.

Wihlen Sie im Fenster Gleichungen auf der Seite ,Positionierung” in der Dropdown-Liste
Links/Rechts ein Element. Wenn Sie Links von = oder Rechts von = auswéahlen, werden die Zeilen
an einer Seite des Gleichheitszeichens ausgerichtet. Eine Zeile ohne Gleichheitszeichen wird am
linken Rand ausgerichtet.

Festlegen eines manuellen Ausrichtungspunkts fiir eine mehrzeilige Gleichung oder fiir ein Element einer
vertikalen Liste

1)

2)

Flihren Sie eine der folgenden Aktionen aus:

- Klicken Sie in die erste Zeile einer mehrzeiligen Gleichung auf den Punkt, an dem die nachfol-
genden Zeilen ausgerichtet werden sollen.

- Klicken Sie auf den Punkt eines Elements in einer vertikalen Liste, an dem der Ubrige Teil der
Liste ausgerichtet werden soll.

Wahlen Sie im Fenster Gleichungen auf der Seite ,,Positionierung” in der Dropdown-Liste

Links/Rechts die Option Manuell einstellen. Ein manuelles Ausrichtungssymbol | wird an der
Einflgemarke angezeigt, wenn die Anzeige der Steuerzeichen aktiviert ist. Die folgenden Zeilen
einer mehrzeiligen Gleichung werden linksblindig an dem manuellen Ausrichtungspunkt
ausgerichtet. Elemente in vertikalen Listen werden mit anderen Elementen in der Liste an dem
manuellen Ausrichtungspunkt ausgerichtet.

Loschen eines manuellen Ausrichtungspunkts

1)
2)

Wahlen Sie den Teil der Gleichung aus, der den manuellen Ausrichtungspunkt enthalt.

Wahlen Sie im Fenster Gleichungen auf der Seite Positionierung in der Dropdown-Liste
Links/Rechts die Option Manuell I6schen. Sie kdnnen einen manuellen Ausrichtungspunkt auch
|6schen, indem Sie einen anderen festlegen.
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Ausrichten von Elementen in einer horizontalen Liste

1)  Klicken Sie in die Liste.

2)  Waihlen Sie im Fenster Gleichungen auf der Seite Positionierung in der Dropdown-Liste
Oben/Unten ein Element.

Ausrichten von Zellen in einer Matrix

1) Klicken Sie in die Matrix.

2)  Wahlen Sie im Fenster Gleichungen auf der Seite Positionierung in der Dropdown-Liste
Oben/Unten oder Links/Rechts ein Element. Die Befehle Links/Rechts und Oben/Unten wirken
sich auf die gesamte Matrix aus. Zur Ausrichtung von einzelnen Zellen verwenden Sie die Feinposi-
tionierung.

Uberpriifen der Ausrichtungseinstellungen fiir eine horizontale oder vertikale Liste bzw. fiir eine
Matrix

1)  Fdhren Sie zur Auswahl der Gleichung einen der folgenden Schritte aus:
- Ziehen Sie den Zeiger (iber die Liste oder die Matrix.
- Platzieren Sie die Einfligemarke in der Matrix und driicken Sie wiederholt die Leertaste.

2)  Klicken Sie im Fenster Gleichungen auf der Seite Positionierung auf Positionseinstellungen.

Ausrichten von Gleichungen in einem Rahmen (linksbiindig, zentriert oder rechtsbiindig)

Sie kénnen auf die gleiche Weise, wie Sie andere Objekte ausrichten, mehrere Gleichungsobjekte in
einem Grafikrahmen aneinander ausrichten. Sie kdnnen auch unterschiedliche Gleichungsobjekte an
einem manuellen Ausrichtungspunkt ausrichten, auch wenn sie sich in unterschiedlichen Grafikrahmen
befinden.

x+2 2 =|x2+4x+4

x+3 x-2 =|x2+x—-5

Figure 32: An manuellen Ausrichtungspunkten ausgerichtete Gleichungen

FrameMaker behalt die Ausrichtung der Gleichungsobjekte bei, wenn die Gleichungen bearbeitet
werden. Wenn z. B. zwei Gleichungen linksblindig ausgerichtet sind und sich die Lange der Gleichungen
andert, wird die linksbiindige Ausrichtung beibehalten.

1)  Wahlen Sie die Gleichungen aus, die ausgerichtet werden sollen, indem Sie bei gedriickter
Strg-Taste auf die erste Gleichung klicken und dann bei gedriickter Strg- und Umschalttaste auf die
anderen Gleichungen klicken.

Stellen Sie sicher, dass die letzte Gleichung, die Sie auswdihlen, diejenige ist, an der Sie ausrichten
mdéchten.
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2)  Waihlen Sie Grafik > Anordnen > Ausrichten.

Align bt

Figure 33: Ausrichtungsoptionen
3)  Wabhlen Sie die gewiinschte Ausrichtung und klicken Sie auf OK.

Ausrichten von Gleichungen an einem Punkt

1) Platzieren Sie den manuellen Ausrichtungspunkt in einer der auszurichtenden Gleichungen.

Wenn Sie keinen manuellen Ausrichtungspunkt festlegen, richtet FrameMaker Gleichungen links-
biindig aus.

2) Klicken Sie in der Gleichung und wahlen Sie Grafik > Objekteigenschaften.

3)  Wabhlen Sie in der Dropdown-Liste Ausrichtung die Option Manuell und legen Sie unter Abstand
des Ausrichtungspunkts die Position des Ausrichtungspunkts innerhalb des Rahmens fest. Der linke
Abstand ist der Abstand zwischen dem linken Rand des Rahmens und dem manuellen Ausrichtung-
spunkt.

Der obere Abstand muss nicht genau festgelegt werden. Sie kénnen die Gleichung wie alle anderen
Objekte nach oben oder nach unten verschieben.

4)  Klicken Sie auf Festlegen.

5)  Wiederholen Sie die Schritte 1 bis 4 fiir jede Gleichung, die ausgerichtet werden soll. Verwenden
Sie fur jede Gleichung denselben Abstand zwischen dem linken Rand und dem Ausrichtungspunkt,
andern Sie aber den oberen Abstand, um die Gleichung vertikal im Rahmen zu positionieren.
Befinden sich die auszurichtenden Gleichungen in unterschiedlichen verankerten Rahmen, miissen
Sie darauf achten, dass die linken Rander der Rahmen aneinander ausgerichtet sind.

Andern der Schrifteinstellungen in Gleichungen

Erfahren Sie, wie Sie Schriftart- und Formateinstellungen fiir Gleichungen in FrameMaker andern.

Ein Dokument besitzt Schrifteinstellungen, die fir alle Gleichungen des Dokuments wirksam sind. Diese
Einstellungen bestimmen den Schriftgrad und den Abstand fir kleine, normale und groRe Gleichungen.
Sie legen aulBerdem das Zeichenformat fest, das fiir griechische Buchstaben sowie fiir Symbole, Funk-
tionen, Ziffern, Zeichenfolgen und Variablen verwendet wird.

Sie kdnnen die vordefinierte GroRe der gesamten Gleichung andern. Sie konnen auch das Zeichenformat
einzelner mathematischer Elemente dndern, z. B. die Farbe oder eine bestimmte Schrift.
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Es ist auch moglich, die Schriftgrade und Zeichenformate zu dndern, die fir alle Gleichungen in einem
Dokument verwendet werden.

Andern des Zeichenstils in einzelnen Gleichungen

Die Eigenschaften fiir Zeichenabstand, Streckung, Hochstellung, Tiefstellung, Unterstreichung, Uberstre-
ichung, Durchstreichung, Anderungsbalken oder Unterschneidung lassen sich fiir kein Element dndern.

Auch die Schriftfamilie kann fir einzelne griechische Buchstaben und Symbole und fiir einige Operatoren
nicht gedandert werden.

J Um die vordefinierte GroRRe oder Farbe einer Gleichung zu dandern, klicken Sie in der Gleichung,
wahlen Sie Grafik > Objekteigenschaften, und fiihren Sie einen der folgenden Schritte durch:

- Um den Schriftgrad der Gleichung zu andern, wahlen Sie in der Dropdown-Liste GroBe den
Schriftgrad aus und klicken auf Zuweisen. Eingepasste Gleichungen werden von FrameMaker
neu eingepasst.

- Um die Schriftfarbe der Gleichung zu dndern, wahlen Sie in der Dropdown-Liste Farbe eine
Farbe aus und klicken auf Zuweisen.

. Um den Zeichenstil zu dndern, wéhlen Sie das Element oder den Ausdruck aus und dndern das
Format wie bei Text.

. Um ein hoch- oder tiefgestelltes Zeichen zu erstellen, fliigen Sie den gewilinschten Operator ein.

. Um den Zeichenabstand zu dndern, legen Sie die Feinpositionierung der Zeichen auf der Seite ,,Posi-
tionierung” des Fensters Gleichungen fest.

. Um eine Zeile (iber oder unter dem Ausdruck einzufiigen, verwenden Sie die diakritischen Zeichen
auf der Seite ,,Symbole” des Fensters Gleichungen.

Gleichungsschriften im gesamten Dokument dandern

Sie kdnnen Schriftgrad und Abstand fir alle kleinen, normalen und groRen Gleichungen in einem Doku-
ment dndern. Bei einer solchen globalen Anderung formatiert FrameMaker alle Gleichungen im Doku-
ment neu und passt alle eingepassten Gleichungen neu ein.

III

Griechische Zeichen und Symbole in Gleichungen werden normalerweise in der Schrift ,Symbol“ ange-
zeigt. Sie kdnnen auch Schriften wie ,Mathematical Pi“ und ,Universal Greek” verwenden, sofern diese
Schriften auf Ihrem System installiert sind.

Fiir die Darstellung von Funktionen, Ziffern und Zeichenfolgen wird normalerweise die Schrift Times New
Roman oder Times verwendet. Variablen werden in der Regel kursiv dargestellt. Sie konnen die Zeichen-
formatierung fir jedes dieser Elemente dndern. Sie kénnen z. B. alle Elemente in Helvetica anzeigen und
far Funktionen und Variablen zusatzlich Fettschrift verwenden.

HINWEIS: Loschen Sie keine Stile aus dem Zeichenformatkatalog, wenn Sie diese zum Angeben des
Zeichenformats von mathematischen Elementen verwenden. Wenn Sie solche Zeichenstile |6schen,
werden alle Gleichungen im Dokument mit der Standardschrift neu formatiert.

Wahlen Sie im Fenster Gleichungen in der Dropdown-Liste ,Gleichungen” die Option ,Schriftgrade fir
Gleichungen®, um Folgendes zu dndern:

. Um die Gleichungsschriften im gesamten Dokument zu dndern, fiihren Sie einen der folgenden
Schritte aus:

299



GLEICHUNGEN

- Legen Sie die Schriftgrade und den Zeichenabstand fest und klicken Sie auf Zuweisen. Der
Zeichenabstand wird als prozentualer Schriftgradanteil ausgedrickt. Positive Werte
vergroBern den Abstand um die Elemente, negative Werte verringern ihn.

- Klicken Sie auf Standardwerte abrufen.

. Um die Schrift fir griechische Zeichen und Symbole zu dndern, wahlen Sie in der Dropdown-Liste
FrameMath-Symbole eine der verfligbaren Schriften und klicken auf Zuweisen.

o Um den Zeichenstil fiir Funktionen, Ziffern, Zeichenfolgen und Variablen zu dndern, erstellen Sie
zuerst den gewiinschten Zeichenstil. Wahlen Sie den Zeichenstil dann in einer der Dropdown-Listen
Funktionen, Zahlen, Zeichenfolgen oder Variablen und klicken Sie auf Zuweisen. FrameMaker
zeigt den Stil an, den Sie in den Dropdownlisten erstellt haben.

Berechnen von Gleichungen

Wissen Sie, wie Gleichungen, Gleichungstransformation, Gleichungsmatrix, Addition, Multiplikation,
Division, Regeln Pop-up und Uberschreibungen in FrameMaker zu bewerten.

Nach der Erstellung eines Ausdrucks oder einer Gleichung kénnen Sie ihn bzw. sie umwandeln, indem Sie
die mathematische Darstellung andern. Sie kdnnen beispielsweise Polynome multiplizieren, Terme ausk-
lammern, Ausdriicke vereinfachen und Briiche zusammenfassen.

Urspriingliche Auswabhl _ 3
y=(x+4)

Ausgeschrieben y={'x+4'} {'x+ 4'} {'x+4'}

Ausmultipliziert

y=(xt+t4)(x*+t8x+16)

Noch einmal ausmultipliziert

y=x3+12x2+48x+64

Sie kdnnen einen Ausdruck auch auswerten, indem Sie Werte ersetzen und Berechnungen durchfihren.

Ursprungliche Auswabhl )
x3|
x=1
Ausgeschrieben x3| N xa
x=73 x=1
Wert ersetzt 27 — 1
Ergebnis berechnet 26
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Umwandeln oder Berechnen eines Ausdrucks

1)  Wabhlen Sie den Ausdruck ganz oder teilweise aus.

2)  Waihlen Sie einen Befehl aus der Seite ,Matrizen” oder ,Funktionen” des Fenstes , Gleichungen”.
Wahlen Sie beispielsweise einen Ausdruck, und wahlen Sie Ausmultiplizieren in der Dropdown-Liste
Multiplikation auf der Seite Funktionen.

3)  Um einen Ausdruck umzuwandeln oder zu berechnen, verwenden Sie die Befehle in der Drop-
down-Liste Matrix-Befehle auf der Seite Matrizen und die sechs Dropdown-Listen auf der Seite
Funktionen.

RELATED LINKS:
Andern von Matrizen

Dropdown-Liste Matrixbefehle

Matrix transponieren

Transponiert Zeilen und Spalten der ausgewahlten Matrix.

Ausgewadhlte Matrix Nach der Transponierung
abc ad
de b e
c

Matrix-Algebra

Flhrt Matrix-Multiplikation und -Addition durch und berechnet Skalar- und Vektorprodukte in
einer ausgewahlten Matrix.

Ausgewadhlte Matrix (oder Matrizen) Nach der Berechnung
54 b 2a 2b
cd 2¢ 2d
2a 2b 2a+bc 2b+ be
2¢ 2d ac+2cd bet 2de
25+ 3 4 2+3b+4d

301




GLEICHUNGEN

Ausgewadhlte Matrix (oder Matrizen) Nach der Berechnung
+
a a aa+ b2+ cc
bl* |2
€] L
1 a 2¢-3b
2| X |b 3a—-1c¢
3] |c 1b-2a

Nach der Durchfiihrung der Matrix-Algebra konnen Sie mithilfe des Befehls , Vereinfachen”

ahnliche Terme zusammenfassen.
Dropdown-Liste fiir Addition

Briiche addieren

Addiert ausgewahlte Briiche und driickt das Ergebnis als einzelnen Bruch aus. Dieser Befehl fasst

auch ahnliche Terme zusammen.

Ausgewahlter Bruch Nach der Addition
1,4 17
3 5 15
a,2a lla
4 3 12
2x | 3a 2bx + 3ay
y b by

Wenn der ausgewahlte Ausdruck die Summe von mehr als zwei Briichen enthilt, addiert ,,Briiche
addieren” lediglich die beiden ersten. Verwenden Sie diesen Befehl wiederholt, um alle Briiche

zusammenzufassen.

Ausgewahlter Ausdruck Z_x N 3_45; B z_g
y b 3b
Einmal addiert 2bx+ 3;11"_ E
by 3b
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Zweimal addiert

3b(2bx+3ay)—2aby
3y b2

Geordnete Summe

Ordnet Polynome nach absteigenden Potenzen einer ausgewahlten Variablen an.

Vor der Sortierung

Nach der Sortierung

W +2x7—4xt+1

2x7 +x3 —4x2+1

Umgekehrt geordnete Summe

Ordnet Polynome nach aufsteigenden Potenzen einer ausgewdhlten Variablen. Im folgenden
Beispiel wurde vor der Wahl von ,,Umgekehrt geordnete Summe*“ ein (beliebiges) x ausgewahlt.

Vor der Sortierung

Nach der Sortierung

B +2x° —4x2+1

1 —4x2+x34+2x3

Dropdown-Liste Multiplikation

Mit den Befehlen der Dropdown-Liste fiir Multiplikation auf der Seite ,Funktionen” kénnen Terme
ausgeklammert, Ausdriicke ausmultipliziert und das Distributivgesetz angewendet werden.

Ausklammern

Klammert einen ausgewadhlten Term aus einem Produkt aus.

Vor dem Ausklammern

Nach dem Ausklammern

ze ke
@+ 2a+1 a(a+2+l)
a

Teilweise ausklammern

Klammert einen ausgewahlten Term nur aus den Termen aus, in denen er enthalten ist.

Vor dem Ausklammern

Nach dem Ausklammern

EByt+2x+v

v+(y+2)x
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Ausmultiplizieren

Vereinfacht den ausgewahlten Ausdruck und multipliziert die Gleichung vor dem Addieren aus.
Dieser Befehl entwickelt auch einen ausgewahlten Term, der zu einer positiven ganzzahligen
Potenz erhoben ist.

Ausgewadhlter Ausdruck Nach der Multiplikation
(a—3)(2a+4) 2a2—2a-12
(a+2b)? a’ + dab + 4b?

Der Befehl ,Vereinfachen” vereinfacht ebenfalls den ausgewahlten Ausdruck.

Einmal ausmultiplizieren
Multipliziert die ersten beiden Faktorpaare auf der linken Seite eines ausgewahlten Ausdrucks.

Ausgewadhlter Ausdruck Nach der Multiplikation

a{b+c)(2a) ab(2a)tac(2a}

Wenn Sie diesen Befehl mehrmals verwenden, werden die Ergebnisse in anderer Form angezeigt.

Verteilen

Flihrt je nach gewahltem Ausdruck verschiedene Operationen durch. Nachstehend werden einige
Beispiele gezeigt:

. Wendet das Distributivgesetz an.

Ausgewadhlter Ausdruck Ergebnis

at+b
C

L

[ o o

Mit dem Befehl ,Briiche addieren” fiihren Sie die Umkehroperation durch.
] Lost eine Klammer durch Ausmultiplizieren der eingeklammerten Summe auf.

Ausgewadhlter Ausdruck Ergebnis

a(b+c) ab+ ac

Mit dem Befehl ,Ausklammern” fiihren Sie die Umkehroperation durch.

. Formt Produkte und Quotienten mit Wurzeln und Exponenten in einen einzelnen potenzierten
Ausdruck um.
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Ausgewadhlter Ausdruck Ergebnis
ab? (Jab)?
a’bh? (a2p)?
a®./b Jath

Mit dem Befehl ,,Vereinfachen” fiihren Sie die Umkehroperation durch.

Auf beiden Seiten anwenden
FUhrt auf beiden Seiten eines Gleichheitszeichens dieselbe Operation durch.

Ausgewadhlter Ausdruck Ergebnis
(x=y)z Xz = yz
(x=y)-5 xX—5=9y-5
(x=y) x? =y

Division Dropdown-Liste

Division mit Rest
Flhrt eine Division mit Rest in einem Bruch durch, der in Zdhler und Nenner ein Polynom enthalt.
Im folgenden Beispiel wahlen Sie vor der Auswahl von ,,Division mit Rest” ein (beliebiges) xaus.

Danach wahlen Sie ein x im ersten Ergebnis aus und wahlen erneut den Befehl ,Division mit Rest”,
um das zweite Ergebnis zu erhalten.

Vor der Division Eg Faxt1
x+1
Einmal dividiert [
o BT
x+1
Zweimal dividiert x+1

Division umwandeln

Konvertiert in einem ausgewahlten Ausdruck Division in Multiplikation, indem positive in negative
Exponenten gedandert werden und umgekehrt.
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Ausgewadhlter Ausdruck Nach der Umwandlung
X xy‘z
},2
byt (b+cd)x!
x

Um negative Exponenten in eine Division umzuwandeln, verwenden Sie den Befehl ,Negative
Potenz umwandeln®.
Division Stufe 1 umwandeln

Konvertiert wie ,,Division umwandeln” Division in Multiplikation. Dieser Befehl gilt jedoch nur fir
die erste Stufe einer Division.

Ausgewadhlter Ausdruck Nach der Umwandlung
2
Y
C C
b+ - (b + -)x‘l
d d
X

Um die erste Stufe negativer Exponenten in Divisionsoperatoren umzuwandeln, verwenden Sie den
Befehl ,,Negative Potenz Stufe 1 umwandeln®.
Negative Potenz umwandeln

Konvertiert in einem ausgewahlten Ausdruck negative Exponenten in Divisionsoperatoren, indem
Multiplikation durch Division ersetzt wird (und umgekehrt).

Ausgewadhlter Ausdruck Nach Umwandlung negativer Potenzen
xy x
2
Y
-1, -1 c
(bt+cd ")x h+ &
d
X
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Negative Potenz Stufe 1 umwandeln

Dieser Befehl hat dieselbe Funktion wie ,Negative Potenz umwandeln”, gilt jedoch nur fir die erste
Stufe. Wenn der ausgewahlte Ausdruck Uber keine negativen Exponenten in der ersten Stufe
verfligt, hat dieser Befehl keine Wirkung.

Ausgewadhlter Ausdruck Nach Umwandlung negativer Potenzen
(b+c'y™? _ 1
(b+c1)?
—2 -2
xy XY 7 (Keine Veranderung)

Dropdown-Liste der Evaluierung

Ausrechnen

Andert in einem ausgewihlten Ausdruck Ganzzahlen in Gleitkommazahlen und berechnet dann
den Ausdruck.

Ausgewihlter Ausdruck Nach der Berechnung
3m -

sin

-3 3

log2e?-1 2.6230813

e + 77 29.380205

Mit dem Befehl , Alle Stellen zeigen” zeigen Sie bis zu 15 Dezimalstellen in einer Gleitkommazahl an.

»Ausrechnen” zeigt flir Operationen, die nicht definierte Ergebnisse liefern, ,NaN“ (Not a Number
= keine Zahl) an. Fiir Operationen, die zu grolRe Werte liefern, wird ,,Unendlich” angezeigt. Kleine
Zahlen kénnen zu null ausgewertet werden.

Ausgewadhlter Ausdruck Nach der Berechnung

NaN

el )
ol B
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Ausgewadhlter Ausdruck

Nach der Berechnung

!
0

Infinity

Alle Stellen zeigen

Zeigt die volle Anzahl der Stellen einer Gleitkommazahl in Rechnergenauigkeit.

Ausgewadhlte Zahl

Ergebnis

3.1415927 ...

3.1415926535897

Berechnen

Berechnen des ausgewahlten Ausdrucks. Die durchgefiihrten Operationen hdngen von der Art des
Ausdrucks ab. Nachstehend finden Sie einige Beispiele.

o Umformen eines Ausdrucks, der zu einer Potenz von weniger als 20 erhoben ist, in ein Produkt.

Ausgewadhlter Ausdruck

Nach der Berechnung

a’

aad

. Berechnen der Fakultat fir eine Ganzzahl. Wenn das Ergebnis zu groR ist, um berechnet zu werden,

wird ,Unendlich” als Ergebnis angezeigt.

Ausgewadhlter Ausdruck

Nach der Berechnung

5!

120

o Berechnen der Determinante einer 1 x 1- oder 2 x 2-Matrix.

Ausgewadhlter Ausdruck

Nach der Berechnung

ad—bc
ab
cd
) Herausziehen eines Terms aus einer Summe oder einem Produkt
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Ausgewadhlter Ausdruck

Nach der Berechnung

5
1+ ¥ x°

x=2

Berechnen einer Ersetzung (wie mit dem Befehl ,Einsetzen®)

Umformen eines Operators ,, Berechnen” in eine Differenz

Ausgewadhlter Ausdruck

Nach der Berechnung

xX=6

2 Y
x:'c=8 x:'c=5

Umformen des Logarithmus eines Produkts in eine Summe von Logarithmen; Umformen eines

potenzierten Logarithmus in ein Produkt.

Ausgewadhlter Ausdruck

Nach der Berechnung

log2 + logx + logy

log2 +logx + logy

loga™

nloga

Umformen eines Logarithmus zu einer Basis mit natirlichen Logarithmen.

Ausgewadhlter Ausdruck

Nach der Berechnung

I'Dg X

logx
log2

Umformen einer Binominalfunktion in einen Ausdruck von Fakultaten

Ausgewadhlter Ausdruck

Nach der Berechnung

)

x!
yx-p!

Einsetzen

Flihrt eine angegebene Substitution durch und vereinfacht dann den Ausdruck. Wenn ein Operator

»,Berechnen” ausgewahlt ist, formt dieser Befehl den Ausdruck in eine Differenz um.
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Ausgewadhlter Ausdruck

Nach der Berechnung

6

x=1

x3|

22|

x=6 x=1

si11{2x)|x —p

sin(2m)

Integrieren

Formt ein ausgewahltes Integral mit einem polynominalen Integranden um. Dieser Befehl formt ein
bestimmtes Integral in ein unbestimmtes Integral um, das zwischen den oberen und unteren
Grenzen berechnet wird. Verwenden Sie , Integrieren” mehrmals, um einen polynominalen

Ausdruck vollstandig zu integrieren.

Ausgewahlter Ausdruck 3
szdx
1
Einmal ausgewertet o 3
J{.ﬁbr:}:mc2
x =
Zweimal ausgewertet 3
3
X
3
x=1

Ableiten

Berechnet eine ausgewdhlte Ableitung und wendet bei Bedarf die Kettenregel auf komplexe
Ausdriicke an. Dieser Befehl berechnet eine partielle Ableitung nur dann, wenn alle Abhangigkeiten

explizit angegeben sind.

Der Befehl behandelt Elemente einer totalen Ableitung, als hingen sie von der Variablen der
Differenzierung ab. Verwenden Sie fiir die Berechnung einer n-ten Ableitung zunachst den Befehl
,Berechnen”, um sie zu entwickeln, bevor Sie den Befehl , Ableiten” anwenden.

Vorher

Nachher

{%(3;&‘ -2x2 -3)

2

Qx° — dx

d
=—secxytanxy

dx

{rysectop+tanyy) tanyytansysecoytansy
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1. Stufe ableiten

Berechnet nur die erste Stufe einer ausgewahlten Ableitung.

Vorher

Nachher

d
3;(3x3+2x2+3)

d. . d. 5, d
3P L2 &
dx * dxzx dx3

Dropdown-Liste fiir Regeln

Die Dropdown-Liste ,, Regeln” auf der Seite ,,Funktionen” dient der Speicherung und Anwendung von
Regeln fur die Umformung von Ausdriicken.

Sie konnten z. B. mithilfe von ,,Regel eingeben” eine Regel wie a = a + 3 speichern. Verwenden Sie dann

»Regel anwenden”, um a in einem anderen Ausdruck durch a + 3 zu ersetzen.

Regel eingeben

Speichert eine Regel fiir das Ersetzen eines Ausdrucks durch einen anderen. Wahlen Sie den
Ausdruck aus, den Sie als Regel speichern mdchten, bevor Sie Regel eingeben wahlen. Sie kdnnen
jeweils nur eine Regel speichern.

Platzhalter festlegen

Legt einen ausgewahlten Term als Platzhalter fest. Ein Platzhalter in einer Regel ermdglicht das
Ersetzen des Ausdrucks auf der rechten Seite der Regel fir jede Variable, nicht nur fiir die explizit
auf der linken Seite genannte Variable. Ein Platzhalter wird in Fettschrift dargestellt. Wenn Sie z. B.
x in der Regel x = a 2 als Platzhalter verwenden, konnen Sie a 2 oder x fir jede Variable in einem

Ausdruck einsetzen.

Wahlen Sie den Term aus, den Sie als Platzhalter verwenden moéchten, bevor Sie Platzhalter
festlegen wahlen. Ersetzen Sie dann mit dem Befehl Regel anwenden einen ausgewahlten

Ausdruck durch den Ausdruck, der dem Platzhalter zugewiesen wurde.

Regel anwenden

Ersetzt in einem ausgewadhlten Ausdruck einen oder mehrere Terme durch einen oder mehrere
andere Terme und verwendet dabei die Regel, die mit dem Befehl Regel eingeben gespeichert

wurde.

Eingegebene Regel

a=at3

Ausgewahlter Ausdruck

a’ —2ab + b?

Nach Anwenden der Regel

(a+3)°-2b(a+3)+b?>
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Bevor Sie eine Regel anwenden, die eine Platzhalter-Variable enthélt, wahlen Sie den Term aus, der
den Platzhalter ersetzen soll. Im folgenden Beispiel ist x der Platzhalter in der Regel.

Eingegebene Regel

Vor Anwenden der Regel

Nach Anwenden der Regel

Andere Rewrites-Dropdown-Liste

Vereinfachen

Vereinfacht den ausgewahlten Ausdruck. Um Briiche zu berechnen, die unendlich sind oder eine
Division durch Null enthalten, verwenden Sie anstelle von , Vereinfachen” den Befehl

,Ausrechnen”.

Die durchgefiihrten Operationen hangen von der Art des Ausdrucks ab. Nachstehend finden Sie

einige Beispiele.

o Ganzzahlen-Arithmetik

Ausgewadhlter Ausdruck Nach der Vereinfachung
c+0 C
4! 24
1,2 11
3 5

Wenn das Ergebnis zu grofs ist, um berechnet zu werden, wird ,,Unendlich” als Ergebnis angezeigt.
. Gruppieren von Termen in einer Summe oder in einem Produkt.

Ausgewadhlter Ausdruck Nach der Vereinfachung
2ab+ 3ab S5ab
ab(ac) abe
a¥gixt? P EL

Dividiert gemeinsame Faktoren in einem Bruch aus.
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Ausgewadhlter Ausdruck Nach der Vereinfachung
(ab)? 1b
2p
2x3y? ng:‘3
6x)° 3

Verwenden Sie den Befehl ,Negative Potenz umwandeln”, um negative Potenzen aus dem Ergebnis
zu entfernen.

Interpretiert die komplexe Zahl j, reprasentiert durch den griechischen Buchstaben lota (y).

Ausgewadhlter Ausdruck Nach der Vereinfachung

w/ab

Lost die Klammer auf, indem der Exponent auf den Ausdruck in der Klammer angewendet wird, falls
es sich dabei um Multiplikation oder Division handelt.

N-ab

Ausgewadhlter Ausdruck Nach der Vereinfachung

(xy)?
5

Vereinfachung ./x? x ergibt das Ergebnis x und nicht |x|.

Teilweise vereinfachen

x2y?

"ﬁ|'<"¢.
Bl

Vereinfacht wie der Befehl ,,Vereinfachen” den ausgewahlten Ausdruck, multipliziert jedoch
Briiche nicht aus.

Ausgewadhlter Ausdruck

Skin + 4k£1 ]21(2
hr hr hr

Nach der Vereinfachung

Term isolieren

Isoliert einen ausgewahlten Ausdruck auf einer Seite des Gleichheitszeichens. Dieser Befehl fasst
keine Terme zusammen und I6st den ausgewahlten Ausdruck nicht auf.
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Ausgewadhlter Ausdruck

Nach der Isolierung

E3+x+2 =0 x={'_x_2}1.'r3
bE+by = ¢ _c—by
x_
b
logh = = x = &

Term herausziehen

Entwickelt den ersten Term einer ausgewahlten Summe oder eines ausgewahlten Produkts.

Ausgewadhlter Ausdruck

Nach dem Entwickeln

4 4
3y, x° Y x*+8
x=1 x=3

5 5

I (x*-2) 6 [T x*-2
x=2 x=73

Alle Terme herausziehen

Entwickelt alle Terme einer ausgewahlten Summe oder eines ausgewahlten Produkts.

Ausgewadhlter Ausdruck

Nach dem Entwickeln

8+27+64

6(25)62(123)
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Marken

Erfahren Sie, was Marken in FrameMaker sind.

FrameMaker-Marken bieten verschiedene Maoglichkeiten zum Markieren Ihrer Dokumente. Sie kdnnen
vordefinierte Marken wie Autor, Kommentar, Bedingungs-Tags, Kontext, Querverweis, Gleichung,
Glossar verwenden oder eigene Marken erstellen.

Das Fenster Marken erleichtert die Arbeit mit Hunderten von Marken in umfangreichen Dokumenten
oder Buchdateien und das Beheben eventueller Probleme. Sie kdnnen alle Marken aus dem aktuellen
Dokument anzeigen, aus allen ge6ffneten Dokumenten, aus einer gewahlten Datei oder aus einem Buch.

Hinzufiigen einer Marke

So fligen Sie beispielsweise eine Marke vom Typ ,,Kommentar” ein:
1) Platzieren Sie den Cursor an der Stelle, an der Sie den Kommentar einfligen mochten.

2)  Waihlen Sie Ansicht > Fenster > Marken, um das Fenster Marken anzuzeigen, wenn es noch nicht
geoffnet ist.

3)  Klicken Sie auf das Symbol Einfiigen.

4)  Wahlen Sie im Feld Markentyp den Eintrag Kommentar.

5)  Geben Sie lhren Kommentar im Feld Markentext ein und klicken Sie auf Neue Marke.
6) Dokument speichern.

HINwEIs: Sie konnen ein Tabulatorzeichen in Markentext einfligen, indem Sie \t oder den hexadezimalen
Code \x08 eingeben. In einer generierten Markenliste werden allerdings nur Tabulatorzeichen, die als
hexadezimaler Code eingegeben wurden, angezeigt. In einem generierten Markenindex erscheinen nur
Tabulatorzeichen, die als \t eingegeben wurden.

So fligen Sie eine Marke zu einem strukturierten Dokument hinzu:

1)  Waihlen Sie Einfiigen > Marke.

2)  Wahlen sie im Elementkatalog ein Markenelement aus, und klicken Sie auf Einfiigen.

3)  Wabhlen Sie einen Markentyp aus der Dropdown-Liste aus. Sie kdnnen alle vordefinierten Marken-
typen auBer bedingte Tags verwenden. Sie kdnnen auch lhre eigenen Markentypen definieren.

HINWEIS: Sprechen mit dem Entwickler, bevor Sie einen Markentyp in strukturierten Dokumenten
andern. Das Dokument enthdlt moglicherweise ein Element fiir jeden benoétigten Markentyp.

4)  Wenn das Dialogfeld Attribute fiir neues Element angezeigt wird, geben Sie Attributwerte fiir das
Markenelement ein und klicken Sie auf Element einfiigen.

Wenn an der gewtlinschten Position kein Markenelement verfiigbar ist, verwenden Sie méglicher-
weise ein ungiiltiges Element. Informieren Sie sich nach Einfiigen des Elements bei lhrem Entwickler
dariiber, wie sich das Element an dieser Position in ein giiltiges Element umwandeln ldsst.

Erstellen einer Markenliste

Erfahren Sie, wie Sie in FrameMaker eine Liste von Marken generieren.
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So erzeugen Sie beispielsweise eine Liste aller lhrer Kommentarmarken:
1)  Wahlen Sie Einfiigen > Liste von > Marken.

2)  Wahlen Sie aus, ob Sie eine eigenstandige Liste von Marken erstellen wollen oder sie zum Buch
hinzugefiigt wollen.

3)  Wahlen Sie im Dialogfeld Liste der Marken einrichten den Markentyp Kommentar in der rechten
Dropdown-Liste, und klicken Sie auf den linken Pfeil, um ihn in die Liste ,EinschlieBen” auf der
linken Seite aufzunehmen.

4)  Aktivieren Sie das Kontrollkdstchen Hypertext-Verbindungen anlegen.

5) Klicken Sie auf ,,O0K“. Alle Ihre Marken vom Typ ,Kommentar” werden in einem neuen Fenster
angezeigt.

Loschen einer Marke

Erfahren Sie, wie Sie eine Marke in FrameMaker l6schen.

Wahlen Sie im Fenster Marken die gewlinschte Marke, und klicken Sie auf das Symbol Loschen. Die
Marke wird aus dem Dokument entfernt.

Erstellen einer benutzerdefinierten Marke

Erfahren Sie, wie Sie eine benutzerdefinierte Marke in FrameMaker erstellen.

Sie kdnnen auch benutzerdefinierte Marken fir Single-Source-Dokumente oder zur Automatisierung
erstellen. Beispielsweise konnen Sie benutzerdefinierte Marken verwenden, um Text zu markieren, der
in ein separates Referenzhandbuch extrahiert werden kann. Sie kdnnen Grafikobjekte markieren, die
besondere Verarbeitung erfordern, wie eine Konvertierung von einem Format in ein anderes. Dann
konnen Sie ein Skript verwenden, um automatisch alle diese Grafiken zur weiteren Verarbeitung zu
extrahieren.

1)  Waéhlen Sie Ansicht > Fenster > Marken.

2)  Klicken Sie auf das Symbol Einfiigen.

3)  Wahlen Sie im Feld Markentyp den Eintrag Bearbeiten.

4)  Geben Sie im Feld Speziellen Markentyp bearbeiten einen Namen fiir die neue Marke ein.

5) Klicken Sie auf Einfligen und anschliefend auf Fertig. Der neue Markentyp wird zur Liste der
Marken hinzugefligt.

Einfligen von benutzerdefinierten Marken in das Dokument

Erfahren Sie, wie Sie in einem Dokument in FrameMaker eine benutzerdefinierte Marke hinzufligen.

1)  Klicken Sie im Fenster Marken auf Einfiigen.
2)  Wahlen Sie den benutzerdefinierten Markentyp.

3) Geben Sie den Markentext ein und klicken Sie auf Neue Marke. Eine benutzerdefinierte Marke wird
zu lhrem Dokument hinzugefligt.
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Veroffentlichungsoptionen

Wenn Sie die Funktion zur Veroffentlichung auf mehreren Kanalen in FrameMaker verwenden, haben Sie
mehrere Optionen, um das Veroffentlichen fir die Online-Hilfe zu verbessern.

Seitenumbriiche mit Seitenumbruchsmarkierungen

Mithilfe der Optionen im Menii ,Veroffentlichungsoptionen” konnen Sie die traditionelle Art der Defini-
tion fiir benutzerdefinierte Marken fiir Seitenumbriiche und Themennamen vermeiden.

Stattdessen konnen Sie Themen, die in separate Hilfethemen konvertiert werden sollen, durch
Seitenumbruchsmarkierungen kennzeichnen und die Themennamen definieren.

Seitenumbruchsmarkierung hinzufiigen

1)  Klicken Sie auf den Uberschriftentext, und wahlen Sie Einfiigen > Veréffentlichungsmarken >
Seitenumbruchmarkierung anwenden.

2)  Geben Sie im Dialogfeld fiir die Seitenumbruchsmarkierung den Thementitel ein. Der Dateiname
wird automatisch anhand des eingegebenen Titeltexts ausgefiillt.

Wenn Sie beispielsweise den Thementitel als FrameMaker-Verdffentlichungsoptionen
eingeben, wird die Datei FrameMaker Veréffentlichungsoptionen.htmgenannt.

Sie kénnen den Dateinamen aber im Feld Dateiname éndern.

Keine Seitenumbruchsmarkierung anwenden

Sie kdnnen aulRerdem eine Markierung angeben, um festzulegen, dass eine Seite nicht an einer
definierten Stelle umgebrochen wird. Wenn Sie beispielsweise zwei miteiander verwandte Uberschriften
auf einer Seite anzeigen wollen. Geben Sie in diesem Fall oben in der zweiten Uberschrift , Keine
Seitenumbruchsmarkierung anwenden” an.

1)  Klicken Sie auf den Uberschriftentext der zweiten Uberschrift.
2)  Wahlen Sie Einfiigen > Veroffentlichungsmarken > Keine Seitenumbruchsmarke anwenden.

Der Markentext fiir die neue Marke lautet <NoSp1lit>. Das weist darauf hin, dass die ausgewabhlte
Uberschrift auf derselben Seite wie die vorangegegangene Uberschrift erscheint.

Alle Seitenumbruchsmarkierungen entfernen

Sie kénnen alle Seitenumbruchsmarkierungen in einem Dokument entfernen.
1)  Offnen Sie das Dokument, aus dem Sie alle Seitenumbruchsmarkierungen entfernen méchten.
2)  Wabhlen Sie Einfiigen > Veroffentlichungsmarken > Alle Seitenumbruchsmarken entfernen.

Kontextsensitive Hilfemarkierungen

Zum Erstellen von kontextsensitiven Hilfemarkierungen missen Sie Markierungen zu Ihrer Dokumenta-
tion hinzufligen, zu denen die Produktentwickler vom entsprechenden Teil des Produkts Verknlipfungen
erstellen kdnnen. Durch die CSH(kontextsensitive Hilfe)-Markierung in FrameMaker kénnen Sie TopicA-
lias-Markierungen in Ihrer Dokumentation anwenden. Die CSH-Markierungen werden dann vom
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,Publisher” dazu verwendet, Anker in die veroffentlichte Ausgabe hinzuzufiigen. Der ,,Publisher” erstellt
auBerdem eine Map-Datei, mit der die Produktentwickler die Anker in der Dokumentation verknipfen.

HiINwEIs: Die besten Ergebnisse erzielen Sie, indem Sie die Zuordnungs-IDs auf Uberschriftenformate
anwenden, fir die Seitenumbriiche definiert sind.

Kontextsensitive Hilfemarkierungen werden in folgenden Ausgabeformaten fiir die Veroffentlichung
verwendet:

. Responsive HTML5

. Microsoft HTML-Hilfe

Kontextsensitive Hilfemarkierungen anwenden

1)  Platzieren Sie den Maus-Cursor an den Beginn des Absatzes, um die kontextsensitive Hilfemark-
ierungeinzufiigen.

2)  Wahlen Sie Einfiigen > Veroffentlichungsmarken > CSH-Marke anwenden.
3) Geben Sie die Zuordnungs-ID ein und klicken Sie auf OK.

Beim Erstellen einer CSH-Markierung in einem Dokument erstellt FrameMaker eine TopicAlias-Mark-
ierung, wobei der Markierungstext die von lhnen angegebene Zuordnungs-ID ist.

WicHTIG: Sie dirfen keine Leerrdume oder folgende Sonderzeichen fiir den Markierungstext der
CSH-Markierung verwenden: ~!@#S%7&* () +-={} | [I\\:\"; '<>?, ./

Erstellen und Verwenden einer kontextsensitiven Hilfe-Map-Datei

Wenden Sie CSH-Markierungen an, um einen kontextspezifischen Hilfespeicherort in Ihrem
FrameMaker-Dokument anzugeben. Als Nachstes missen Sie eine Hilfezuordnungsdatei (mit der
Erweiterung . h) erstellen. Die Anwendungsentwickler verkniipfen mithilfe dieser Map-Datei die bestim-
mten Teile der Anwendung (z. B. Dialogfelder oder Meniielemente) mit den Hilfethemen.

1)  Figen Sie die CSH-Markierungen in der FrameMaker-Quelle hinzu.

2)  Erstellen Sie eine Textdatei in einem beliebigen Texteditor, und nennen Sie die Datei wie folgt:
<Quellbuch oder Dokumentname>.h

3) Platzieren Sie die Zuordnungsdatei in den FrameMaker-Quellordner.

4)  Sie mussen fur jede CSH-Markierung, die Sie auf Ihr Dokument anwenden, eine Position in der
Zuordnungsdatei wie folgt erstellen:

#define <map ID> <map number>

Zuordnungs-ID
Name, den Sie fir die CSH-Markierung angegeben haben

Zuordnungsnummer

Eindeutiger numerischer Bezeichner, der von den Anwendungsentwicklern bereitgestellt wird. Als
Platzhalter kdnnen Sie jedoch eine beliebige Zahl eingeben.
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Zur Referenz wird im FrameMaker-Veréffentlichungsprozess auch eine Beispielzuordnungsdatei er-
stellt:

a)  Fihren Sie den Veroffentlichungsprozess fiir Ihr Dokument aus.
b) Navigieren Sie in Windows Explorer zum Ausgabeordner.

Wenn fiir Ihren Inhalt CSH-Markierungen definiert sind, wird eine Datei <Quel lbuch oder
Dokumentname>. h auf derselben Ordnerebene, auf der sich der Ausgabeordner befindet,
erstellt.

Beispiel: Fiir die Ausgabe eines Buchs mit dem Namen framemaker-publisher.book
lautet die Map-Datei framemaker-publisher. h.

Sie kénnen diese . h-Datei als Referenz verwenden, um lhre Zuordnungsdatei zu erstellen.
Sie miissen lhre Zuordnungsdatei im selben Format wie diese . h-Datei erstellen.

WIcHTIG: Die Datei <Quellbuch oder Dokumentname>.h wird auf derselben Ebene wie der
Ausgabeordner erstellt, nicht im Ausgabeordner selbst.

5)  Nachdem Sie der Zuordnungsdatei alle CHS-Markierungen hinzugefiigt haben, Gbermitteln Sie die
Zuordnungsdatei an das Produktentwicklungsteam.

Das Team kann dann die in der Datei einbezogenen eindeutigen Kennzeichnungen verwenden. An-
sonsten kann das Team die Kennzeichnungen gegebenenfalls dndern und die aktualisierte Datei zu-
riickgeben.

6) Kopieren Sie die aktualisierte Zuordnungsdatei in den FrameMaker-Quellordner.
Achten Sie darauf, dass der Name der Datei <Quellbuch oder Dokumentname>.h lautet.
7)  Fuhren Sie den Prozess zur Veroffentlichung durch.

Die CSH-Markierungen sind jetzt als Anker in der Veréffentlichungsausgabe enthalten. Jetzt kbnnen
Sie die kontextsensitive Hilfe-Funktion testen.

Um kontextsensitive Hilfe in eine Anwendung zu implementieren, missen Sie die CSH-Markierungen in
der Dokumentation (wie oben beschrieben) einbeziehen. Darliber hinaus muss das Produktteam auch
Funktionen in der Anwendung hinzufiigen. Eine ausfiihrliche Beschreibung zum Einbeziehen von
kontextsensitiver Hilfe in Anwendungen finden Sie unter Kontextsensitive-Hilfeinformationen fur
Entwickler im Handbuch ,Verwenden von RoboHelp“.

Indexmarkierungen anwenden

1) Klicken Sie auf den Text des Absatzes, in den Sie die Indexmarkierung einfligen mochten.
2)  Wabhlen Sie Einfiigen > Veroffentlichungsmarken > Indexmarke anwenden.
3)  Geben Sie den Indexeintrag ein und klicken Sie auf OK.

WicHTIG: Sie dirfen fiir den Markentext der Indexmarke weder Leerrdume noch folgende Sonderzeichen
verwenden: ~!'@#S$$7&* () +=={} | [I\\:\";'<>?2, ./

Dynamic HTML-Effekte (DHTML) erstellen

Sie kénnen in FrameMaker-Dokumenten DHTML-Effekte wie Dropdown- und Expanding-Text erstellen,
wenn die veroffentlichte Onlinehilfe diese Optionen enthalten soll.
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Verwenden Sie Dropdown-Texteffekte fiir alternative Aufgabenoptionen, grundlegende Themen, fiir
Zusammenfassungen in FAQs (haufigen Fragen) und um verschachtelte Vorgehensweisen tbersichtli-
cher darzustellen. Als Dropdown-Textkérper formatierter Text wird in der PDF-Ausgabe angezeigt. In der
Onlinehilfe ist dieser Text jedoch nur sichtbar, wenn der Benutzer auf der Hilfeseite auf die Drop-
down-Beschriftung klickt.

Entsprechend kénnen Sie erweiterte Definitionen, Schllisselbegriffe oder in einen Absatz eingebettete
Verkniipfungen zu Uberblicksthemen als DHTML-Expanding-Texte formatieren. Fiir Expanding-Texte
muss eine Beschriftung definiert werden, welche die Verkniipfung enthalt, sowie der Textkorper, der
beim Klicken auf die Verkniipfung angezeigt wird. Der Textkdrper wird in der PDF-Datei nicht angezeigt.
Er ist nur sichtbar, wenn der Benutzer auf der Hilfeseite auf die Expanding-Textverkniipfung klickt.

Fiir diese DHTML-Effekte werden zwei Komponenten bendtigt: Beschriftung und Textkorper. Drop-
down-Texteffekte werden auf Absatze und Expanding-Texteffekte auf Zeichen angewendet. Bei der
Erstellung des Dropdown-Texteffekts werden dem FrameMaker-Dokument die beiden Absatzstile
,DropDownCaption“und ,DropDownBody“ hinzugefligt. Wenn der Expanding-Texteffekt erstellt wurde,
werden die beiden Zeichenstile ,,ExpandingTextCaption“ und ,,ExpandingTextBody“ hinzugefiigt. Diese
Formate werden zusammen mit den FrameMaker-Dokumenten in das RoboHelp-Projekt importiert. Die
Effekte sind in den erstellten HTML-Themen sichtbar.

Wenn das erstellte HTML-Thema nur die Beschriftungen ohne die zugehorigen Textkorperformate
enthalt, werden Verknilpfungen generiert und im HTML-Thema angezeigt. Wenn das erstellte
HTML-Thema Textkdrper ohne Beschriftungen enthilt, werden keine Verknipfungen generiert. Wenn
aulRerdem angegeben wurde, dass ein als Dropdown-Textkorper formatierter Absatz in eine automatisch
nummerierte Liste konvertiert werden soll, wird die Listenkonvertierung ignoriert.

Dropdowntext in einem FrameMaker-Dokument erstellen

1)  Wahlen Sie den Text oder Absatz fir die Dropdown-Beschriftung.

2)  Wahlen Sie Einfiigen > Dynamische HTML-Effekte > Dropdown-Beschriftung.

3) Wahlen Sie den Text, der als Dropdowntext auf der Onlinehilfeseite angezeigt werden soll.
4)  Wahlen Sie Einfligen > Dynamische HTML-Effekte > Dropdown-Text.

Expanding-Text in einem FrameMaker-Dokument erstellen

1)  Wahlen Sie den Begriff oder Ausdruck fiir die Expanding-Textbeschriftung.

2)  Wahlen Sie Einfiigen > Dynamische HTML-Effekte > Expanding-Textbeschriftung.

3) Waihlen Sie den Text, der als Expanding-Text auf der Onlinehilfeseite angezeigt werden soll.
4)  Wahlen Sie Einfligen > Dynamische HTML-Effekte > Expanding-Text.

Anpassen von DHTML-Effekten fiir die HTML5-Ausgabe

Sie kénnen den Dropdown-Text und Expanding-Texteffekte fiir ein nicht strukturiertes
FrameMaker-Dokument anpassen, das im HTML5-Ausgabeformat veroffentlicht wird. So passen Sie die
Ausgabeeinstellungen an:

1)  Wahlen Sie Datei > Veroffentlichen, um das Dialogfeld , Veroffentlichen” zu 6ffnen.
2)  Klicken Sie auf Einstellungen andern.
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3) Wahle Sie in der Dropdown-Liste Einstellungen den Eintrag Bearbeiten.
4)  Wahlen Sie auf der Registerkarte Stilzuordnung die Optionen DHTML-Effekte unter Allgemeine

.
Einstellungen.
Style Mapping  Qutputs
Topic Settings ~
& Paragraph Styles
4 Character Styles
i) Table Styles D Splitinto Topics using Marker: @
# Cross-Reference
+Image Settings [] Cleanup inline HTML styles
“ General Settings
Topic Name Pattern ‘(Default) ~
Use only ASCII characters in generated flenames
ly 9
Glossary
Style: Pop-up 52
Marker Type: GlossaryTerm -]
DHTML Effects
Create Drop Down Twisties
Create Expanding Text Twisties
Use Template: Select
Manage CSS: R~ @
* Not applicable for PDF output. v
< >
Save Save As Save and Close Cancel

J Bei Auswahl der ersten Option wird der Text mit einem Dropdown-Texteffekt als Dropdown-Text
auf der Onlinehilfeseite angezeigt.

] Wenn die zweite Option ausgewahlt ist, wird gleichermafien der Text mit einem Expanding-Textef-
fekt als Expanding-Text auf der Onlinehilfeseite angezeigt.

) Wenn die Auswahl der DHTML-Optionen aufgehoben wird, enthalt die HTML5-Ausgabe keine
DHTML-Effekte, und der Text wird ohne Dropdown- oder Expanding-Effekte als Nur-Text angezeigt.

Sie kdnnen auch die Twisties dndern, die bei den DHTML-Effekten als Symbole angezeigt werden. Wahlen
Sie im Dialogfeld Twisties-Bilder auswihlen die beim Offnen und SchlieRen des Dropdown- oder
Expanding-Texts anzuzeigenden Symbole. Sie kénnen auch die Positionierung der Symbole wahlen.

Select Twisties Images hd
|
OK
Close Image: ©
Cancel
= Clear
Open Image: @

Image Placement:  (®) Start of text

() End of text
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Hypertextbefehle

Fligen Sie Hypertextbefehle in Adobe FrameMaker hinzu, und definieren Sie aktive Hyperlinkbereiche.

Ein Hypertextbefehl in einem Adobe FrameMaker-Dokument definiert einen aktiven Bereich in einem
Dokument. Wenn ein Benutzer auf einen aktiven Bereich in einem schreibgeschiitzten
FrameMaker-Dokument oder in einer Ausgabe wie PDF oder HTML klickt, wird der damit verkntipfte
Hypertextbefehl ausgefihrt.

Sie kdnnen einen Hypertextbefehl in einem Dokument erstellen, damit der Benutzer interagieren kann.
Weitere Informationen finden Sie unter Hypertextbefehle zu Dokumenten hinzufigen.

Sie kdnnen Hypertextbefehle verwenden, um solche Aufgaben wie das Offnen einer Webseite, das
Anzeigen von Warnmeldungen, das Navigieren zu bestimmten Seiten (erste, letzte, Seitenzahlen) im
aktuellen Dokument, Offnen und SchlieRen von externen Anwendungen durchzufiihren. Weitere Infor-
mationen finden Sie unter Verfiighare Hypertextbefehle verwenden.

Dann konnen Sie Ihr Dokument als schreibgeschiitzte PDF speichern oder das Dokument mithilfe der
FrameMaker-Losung zum Veroéffentlichungen auf mehreren Kanélen veréffentlichen.

HINwEIS: Hypertextbefehle funktionieren unterschiedlich in PDF- und HTML-Ausgabe. Weitere Informa-
tionen finden Sie unter .

Sie kdnnen Hypertextbefehle in Bildern verwenden, die zu FrameMaker hinzugefligt wurden, um, die
mehrere klickbare Bereiche in einem einzelnen Bild definiert.

Hypertextbefehle zu Dokumenten hinzufiigen

Fligen Sie Hypertextbefehle in Adobe FrameMaker hinzu, lernen Sie, den aktiven Bereich zu definieren,
definieren Sie einen aktiven Bildbereich, fligen Sie die Hypertext-Befehlsmarkierung in FrameMaker ein.
Um einem Dokument Hypertext-Befehle hinzuzufiigen, miissen Sie zuerst Einen aktiven Bereich in einem

Dokument definiert haben, und dann Hypertextbefehl mit einem aktiven Bereich verkniipfen.

Einen aktiven Bereich in einem Dokument definiert haben,

Sie kdnnen Hypertextbefehle mit Text oder Bilden in einem Dokument verkniipfen. Wenn ein Benutzer
auf einen aktiven Bereich klickt, wird der Bereich markiert, nachdem der Befehl ausgefiihrt wurde.

Bereich mit aktivem Text in einem Dokument erstellen

Sie kénnen ein Wort, eine Wendung, einen Absatz oder mehrere nebeneinanderstehende Worter als
aktive Bereich definieren. Um einen aktiven Textbereich zu identifizieren, verwendet FrameMaker den
Zeichenstil des Texts. Das heif3t, dass der Zeichenstil des aktiven Textbereichs sich vom Stil des umlieg-
enden Texts unterscheiden muss. Wenn der Zeichenstil derselbe wie der des umliegenden Texts ist, wird
der gesamte Text im Abschnitt als aktiv festgelegt.

LAktiven Bereich fiir ein Wort oder eine Wendung definieren”

1)  Wahlen Sie das Wort oder die Wendung aus.
Sie miissen den Zeichenstil des ausgewdhlten Worts oder der ausgewdhlten Wendung dndern.
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2)  Wahlen Sie Format > Zeichen.

3)  Wabhlen Sie aus der Liste der Standardzeichenformatvorlagen aus, die im aktuellen Dokumentkat-
alog verfigbar sind.

Alternativ dazu kénnen Sie die Zeichengestaltung éffnen und ein benutzerdefiniertes Zeichenformat
anwenden.

Hinwels: Die folgenden Zeichenstilanderungen kdnnen nicht zum Definieren eines Bereichs mit aktivem
Text verwendet werden: Unterschneiden, Abstand, Streckung, Anderungsbalken, Sprache und
GroB-/Kleinschreibung.

Tipp: Wenn der Text im aktiven Bereich nicht anders angezeigt werden soll als im umliegenden Text,
verwenden Sie einen anderen Zeichenstil, der die gleichen Formate wie der umliegende Text aufweist.
Sie kdnnen den Zeichenstil des umliegenden Texts mit einem anderen Namen speichern und dann den
Zeichenstil auf den aktiven Bereich anwenden.

»Aktiven Bereich fiir einen Absatz definieren”

Stellen Sie sicher, dass derselbe Zeichenstil auf den gesamten Absatz angewendet wird.

,Separate aktive Bereiche fiir nebeneinanderstehende Woérter oder Wendungen definieren”

Sie konnen verschiedene Hypertextbefehle den nebeneinanderstehenden Woértern oder Wendungen in
einem Absatz zuweisen, indem Sie verschiedene oder gleiche Zeichenstile auf die Worter oder Wend-
ungen anwenden. Sie mussen allerdings sicherstellen, dass die Zeichenstile der Wérter oder Wendungen
nicht dieselben sind wie die des umliegenden Absatztextes. Danach kénnen Sie einen Hypertextbefehl
allen nebeneinanderstehenden Wortern oder Wendungen zuweisen. Ausfihrliche Informationen finden
Sie unter , Hypertextbefehlsmarke einfiigen”.

Definieren Sie einen Bereich mit aktivem Bild

Sie konnen einen aktiven Bereich in einem Bild in einem Dokument definieren. Wenn ein Benutzer auf
das Bild klickt, wird der verkniipfte Hypertextbefehl ausgefihrt.

1)  Ziehen Sie einen Textrahmen, um das Bild in dem Dokument abzudecken.
Vergewissern Sie sich, dass die Grafik nicht so eingestellt ist, dass der Text um sie flief3t.
Platzieren eines Textrahmens liber das Bild:
a)  Offnen Sie die Symbolleiste Grafik (Ansicht > Symbolleisten > Grafiksymbolleiste).
b)  Klicken Sie auf Textrahmen in der Symbolleiste Grafik, und ziehen Sie den Bildrahmen, um das
Bild abzudecken.
2)  Setzen Sie Fill- und Linienmuster des Textrahmens auf Keine.
Festlegen der Textrahmeneigenschaften:

a) Klicken Sie mit der rechten Maustaste auf den Textrahmen und wahlen Sie Objekteigen-
schaften.

Im Dialogfeld Eigenschaften verankerter Rahmen:
b) Navigieren Sie zur Registerkarte Strich und deaktivieren Sie die Option Linienmuster.
c)  Navigieren Sie zur Registerkarte Fiillen und deaktivieren Sie die Option Muster.
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3) Stellen Sie sicher, dass der Textrahmen Uber das Bild platziert wird.

Wenn Sie das Bild nach dem Platzieren des Textrahmens platzieren, wéhlen Sie Grafik > Nach
Vorne, um den Textrahmen vor der Grafik zu platzieren.

Aktiven Bereich auf mehreren Seiten in einem Dokument erstellen

Wenn Sie einen aktiven Bereich auf der Hauptseite eines Dokuments erstellen, wird der Bereich auf allen
Seiten des Dokuments aktiv sein. Beispielsweise kdnnen Sie Text zur Dokumentkopfzeile hinzufiigen und
einen aktiven Bereich in dem Text in der Kopfzeile erstellen.

Hypertextbefehl mit einem aktiven Bereich verkniipfen

Nachdem Sie Einen aktiven Bereich in einem Dokument definiert haben, eingegeben haben, missen Sie
dem Bereich einen Hypertext-Befehl zuweisen. Wenn ein Benutzer auf den aktiven Bereich in lhrem
Dokument klickt, wird der Hypertextbefehl ausgefiihrt.

Schreibgeschiitzte Framemaker-Dokumente unterstiitzen alle FrameMaker-Hypertextbefehle, PDF- und
HTML-Ausgaben von Hypertextdokumenten haben begrenzten Support. Ausfiihrliche Informationen
finden Sie unter .

,Hypertextbefehlsmarke einfiigen”

1) Platzieren Sie die Einfligemarke in den aktiven Bereich.

Wort oder Wendung
Am Anfang des Wortes oder der Wendung.

Absatz
Am Anfang des Wortes oder der Wendung.

Mehrere nebeneinanderstehende Worter oder Wendungen
Am Anfang jedes separaten Wortes jeder Wendung.
Bild

Im einschlieBenden Textrahmen. Weitere Informationen finden Sie unter Definieren Sie einen
Bereich mit aktivem Bild.

2)  Offnen Sie das Hypertext-Dialogfeld Einfiigen > Hypertext.
3) Verwenden Sie das Dialogfeld Hypertext fir Folgendes:

Element-Tag
Wenn Sie einen Hypertextbefehl in einem strukturierten Dokument hinzufligen, wahlen Die den
erforderlichen Hypertextelement-Tag aus.

HINWEIS: Dieses hangt von der strukturierten Anwendung ab, die Sie zur Erstellung Ihrer strukturierten
Dokumente verwenden.
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Befehl
Wahlen Sie die Ausfiihrung des Hypertextbefehls, wenn ein Benutzer auf den aktiven Bereich klickt,
mit dem der aktuelle Hypertextbefehl verknipft ist.

Weitere Informationen finden Sie im aktuellen Satz der Verfiigbare Hypertextbefehle verwenden.

Befehl: Feld ,, Syntax”
Geben Sie die Befehlsparameter ein.
Hypertextbefehle missen immer in Kleinbuchstaben eingegeben werden. Die Parameter kénnen
grol’ oder klein geschrieben werden, aber es wird zwischen GroR- und Kleinschreibung unter-

schieden. Der gesamte Befehl darf bis zu 255 Zeichen enthalten. (Jedes Zeichen einer japanischen
Schriftart zahlt als zwei Zeichen.)

Hinwels: Wenn Sie einen Parameter fir den Dateinamen einer Datei eingeben, die sich nicht in
demselben Ordner befindet wie das aktuelle Dokument, geben Sie einen Pfad zum Dokument an.
HINWEIS: Hypertextmarken unterstiitzen den Unicode-Standard zur Textcodierung.

Weitere Informationen finden Sie im aktuellen Satz der Verfiigbare Hypertextbefehle verwenden.

Befehl beim Einfiigen priifen

FrameMaker Gberpriift die Syntax, wenn Sie den Befehl in das Dokument eingeben.

Schreibgeschiitzt
Legen Sie das aktuelle Dokument als schreibgeschitzt fest.

Sie kdnnen diese Option auRerdem verwenden, um die Hypertextbefehle, die Sie in ein Dokument
eingeben, einzufligen.

4)  Klicken Sie auf Neue Hypertextmarke.

Eine Hypertextmarke wird in das Dokument eingefiigt.

HINWEIS: Wenn Sie einen Hypertextbefehl in einem Texteinschub platzieren mochten, miissen Sie ihn im
Quelldokument des Texteinschubs einfligen.

HinweEls: Befindet sich ein Querverweis im selben Textbereich wie ein Hypertextbefehl, hat der Querver-
weis Vorrang vor dem Hypertextbefehl.

Bearbeiten und Loschen von Hypertextbefehlen

Erfahren Sie, wie Sie Hypertextbefehle in FrameMaker bearbeiten und I6schen.

Hypertextbefehl bearbeiten

1)  Offnen Sie das Hypertext-Dialogfeld und suchen Sie tiber ,,Suchen/Andern” den zu bearbeitenden
Hypertextbefehl.

Widhlen Sie in der Dropdownliste Suchen die Option Beliebige Marke.
Die Marke wird im Dialogfeld Hypertext angezeigt.

325



HYPERTEXTBEFEHLE

2)  Andern Sie die erforderlichen Optionen fiir den Befehl und klicken Sie auf Hypertextmarke bearbe-
iten.

Hypertextbefehl I6schen

1)  Offnen Sie das Hypertext-Dialogfeld und suchen Sie iiber ,Suchen/Andern den zu bearbeitenden
Hypertextbefehl.

Widhlen Sie in der Dropdownliste Suchen die Option Beliebige Marke.
Die Marke wird im Dialogfeld Hypertext angezeigt.
2)  Dricken Sie die Taste Entf, um die Marke zu |6schen.

Verfiigbare Hypertextbefehle verwenden

Kennen Sie die verfligbaren Hypertextbefehle in Adobe FrameMaker.

Der Abschnitt umfasst die verfligbaren Hypertextbefehle fiir Folgendes:
. Anzeigen von Warnmeldungen

J Navigieren zum benannten Ziel

] Navigieren zu einer bestimmten Seite

. Zurtlicknavigieren

. Offnen von Dokumenten

. Feldmatrix

Anzeigen von Warnmeldungen

Sie konnen Warnmeldungen mit einem Klick auf einem aktiven Bereich anzeigen, indem Sie die Befehle
Warnung und Meldungsfenster mit Titel verwenden.

HINWEIS: In der PDF-Ausgabe wird eine Warnmeldung als Anmerkung ohne Titel angezeigt.

Warnung

Zeigt ein Meldungsfenster an.

Syntax:
alert Meldung

Beispiel:

Warnung ,Hello World"“

Anzeigen eines benutzerdefinierten Titels mit der Warnmeldung:
1)  Offnen Sie eine Referenzseite fiir das aktuelle Dokument (Ansicht > Referenzseiten).

2)  Platzieren Sie einen Textrahmen auf die Referenzseite und geben Sie den benutzerdefinierten Titel
in den Textrahmen ein.

3)  Klicken sie mit der rechten Maustaste auf den Textrahmen, und wahlen Sie Objekteigenschaften,
um das Dialogfeld Textrahmeneigenschaften anzuzeigen.
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4)  Navigieren Sie zur Registerkarte ,Textrahmen®, und setzen Sie den Textfluss > -Typ auf
AlertTitle.

Meldungsfenster mit Titel

Zeigt ein Meldungsfenster mit einem vom Benutzer definierten Titel an.

Syntax:
alerttitle Titel:Meldung

Beispiel:
Meldung flur Warnmeldungstitel: Hello World

Navigieren zum benannten Ziel

Sie kdnnen zu einem bestimmten Ziel im aktuellen oder in einem anderen FrameMaker-Dokument navi-
gieren. Dazu missen Sie den Befehl Benanntes Ziel angeben angeben verwenden. Sie kdbnnen dann auf
dieses Ziel verweisen, wenn Sie einen der folgenden Befehle erstellen:

J Zu benanntem Ziel springen

. Zu benanntem Ziel springen und an Seite anpassen
. Dokument 6ffnen

J Dokument 6ffnen und an Seite anpassen

Hinwels: Wenn Sie den Befehl Benanntes Ziel angeben weglassen, wird beim Klicken auf die Befehle Zu
benanntem Ziel springen und Dokument 6ffnen keine Aktion ausgefiihrt, wenn diese nicht auf einen
Dateinamen verweisen. Wenn die Befehle jedoch auf einen Dateinamen Bezug nehmen, wird die betref-
fende Datei gedffnet und die erste Seite angezeigt.

Benanntes Ziel angeben

Geben Sie eine benannte Zielposition ein.
Syntax:

newlink linkname
Beispiel:

newlink available hypertext commands

HINWEIS: Bei dem benannten Zielnamen muss die GroR- und Kleinschreibung beachtet werden und der
Name darf keine Leerzeichen enthalten.

Zu benanntem Ziel springen

Zeiger auf das benannte Ziel, definiert durch Benanntes Ziel angeben. Sie konnen auf ein bestimmtes Ziel
im aktuellen oder in einem anderen FrameMaker-Dokument zeigen.

Syntax:

gotolink filename:linkname
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Beispiel eines benannten Ziels im aktuellen Dokument:

gotolink available hypertext commands

Beispiel fiir ein anderes benanntes FrameMaker(.fm)-Dokument:

gotolink hypertextcommands.fm:available hypertext commands

WICHTIG: Sie miissen die Zieldateierweiterung angeben (Beispielsweise . fm).

Zu benanntem Ziel springen und an Seite anpassen

Zeiger auf das benannte Ziel, definiert durch Benanntes Ziel angeben. Sie kdnnen auf ein bestimmtes Ziel
im aktuellen oder in einem anderen FrameMaker-Dokument zeigen. Die GroBe des neuen Fensters wird
dann an die Zieldokumentseite angepasst.

Syntax:
gotolinkfitwin filename:linkname

Beispiel eines benannten Ziels im aktuellen Dokument:

gotolinkfitwin available hypertext commands

Beispiel fiir ein anderes benanntes FrameMaker(.fm)-Dokument:

gotolinkfitwin hypertextcommands.fm:available hypertext commands

WICHTIG: Sie miissen die Zieldateierweiterung angeben (Beispielsweise . fm).

Dokument 6ffnen

Zeiger auf das benannte Ziel, definiert durch Benanntes Ziel angeben. Wenn das Ziel ein anderes Doku-
ment ist, wird es in einem neuen Fenster gedffnet.

Syntax:
openlink file name:linkname

Beispiel eines benannten Ziels im aktuellen Dokument:

openlink available hypertext commands

Beispiel fiir ein anderes benanntes FrameMaker(.fm)-Dokument:

openlink hypertextcommands.fm:available hypertext commands

WICHTIG: Sie mussen die Zieldateierweiterung angeben.

Dokument éffnen und an Seite anpassen

Zeiger auf das benannte Ziel, definiert durch Benanntes Ziel angeben. Wenn das Ziel ein anderes Doku-
ment ist, wird es in einem neuen Fenster ge6ffnet. Die GroRe des neuen Fensters wird dann an die ange-
zeigte Dokumentseite angepasst.

Syntax:

openlink file name:linkname
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Beispiel eines benannten Ziels im aktuellen Dokument:

openlink available hypertext commands

Beispiel fiir ein anderes benanntes FrameMaker(.fm)-Dokument:

openlink hypertextcommands.fm:available hypertext commands

WICHTIG: Sie mussen die Zieldateierweiterung angeben.

Navigieren zu einer bestimmten Seite

Sie konnen zu einer bestimmten Seite im aktuellen oder in einem anderen FrameMaker-Dokument navi-
gieren.

Zur ersten Seite/letzten Seite springen

Zeigt auf die erste oder letzte Seite des aktuellen oder eines anderen Dokuments. Die Seite wird im
aktiven Fenster angezeigt.

Syntax:
gotolink filename:firstpage
gotolink filename:lastpage

Beispiel eines benannten Ziels im aktuellen Dokument:

gotolink firstpage

Beispiel fiir ein anderes benanntes FrameMaker(.fm)-Dokument:

gotolink hypertextcommands.fm:lastpage

WICHTIG: Sie mussen die Zieldateierweiterung angeben.

Zu bestimmter Seite springen

Zeigt auf eine bestimmte Seite des aktuellen oder eines anderen Dokuments. Die Seite wird im aktiven
Fenster angezeigt.

Syntax:

gotopage filename:pagenumber

Beispiel eines benannten Ziels im aktuellen Dokument:
gotopage 7

Beispiel fiir ein anderes benanntes FrameMaker(.fm)-Dokument:

gotopage hypertextcommands.fm:7

WicHTIG: Verwenden Sie die tatsdchliche Seitennummer im Dokument. Wenn z. B. ein Zieldokument
namens ,MyDoc” rémische Ziffern flr die Seitennummern verwendet und auf Seite v beginnt, lautet der
Befehl zur Anzeige der dritten Seite folgendermalien: openpage MyDoc. fm.vii.
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Zur vorherigen/ndchsten Seite springen
Zeigt auf die nachste Seite des aktuellen Dokuments. Die Seite wird im aktiven Fenster angezeigt.
Syntax:
previouspage
nextpage
Beispiel:
previouspage
nextpage

Tipp: Fligen Sie die Hypertextbefehle flr die vorherige und nachste Seite auf den Hauptseiten eines Doku-
ments hinzu, um diese auf jeder Seite des Dokuments anzuzeigen.

Zuriicknavigieren

Sie konnen Hypertextbefehle auf Seiten platzieren, auf die ein Benutzer klicken kann, um auf die Seite
zuriickzukehren, von der aus er auf die aktuelle Seite zugegriffen hat. Dieses Verhalten dhnelt der Funk-
tion der Schaltflache ,,Zurlick” in Ihrem Browser. Wenn Sie beispielsweise einen Bereich mit aktivem Text
auf einer Seite erstellt haben, damit der Benutzer zu einer anderen Seite im Dokument navigieren kann.
Auf der Zielseite kdnnen Sie einen Befehl Zuriickspringen oder Zurtickspringen und an Seite anpassen
platzieren.

HINWEIS: Wenn der Stapel leer ist und kein Datei- und Verkniipfungsname angegeben wurde, zeigt
FrameMaker weiterhin die aktuelle Seite an.

Zurlickspringen
Navigieren Sie zur vorherigen Seite zurlick. Die Seite wird im aktiven Fenster angezeigt.
Syntax:

previouslink filename:linkname

Beispiel eines benannten Ziels im aktuellen Dokument:

previouslink available hypertext commands

Beispiel fiir ein anderes benanntes FrameMaker(.fm)-Dokument:

previouslink hypertextcommands.fm:available hypertext commands
WICHTIG: Sie mussen die Zieldateierweiterung angeben.
Zurlickspringen und an Seite anpassen

Navigieren Sie zur vorherigen Seite zurlick. Die Seite wird im aktiven Fenster angezeigt. Die GroRe des
neuen Fensters wird dann an die angezeigte Dokumentseite angepasst.
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Syntax:

previouslinkfitwin filename:linkname

Beispiel eines benannten Ziels im aktuellen Dokument:

previouslinkfitwin available hypertext commands

Beispiel fiir ein anderes benanntes FrameMaker(.fm)-Dokument:

previouslinkfitwin hypertextcommands.fm:available hypertext commands

WICHTIG: Sie missen die Zieldateierweiterung angeben.

Offnen von Dokumenten

Sie kdnnen Dokumente als neue FrameMaker-Dokumente 6ffnen (Neues Dokument 6ffnen), das Doku-
ment auf der ersten oder letzten Seite 6ffnen (Dokument auf der ersten/letzten Seite 6ffnen) oder ein
Dokument auf einer bestimmten Seite 6ffnen (Dokument auf bestimmter Seite 6ffnen).

Neues Dokument éffnen

Offnet ein Dokument (definiert im Dateinamenargument) als neues Dokument ohne Titel. Das Dokument
wird in einem neuen Fenster angezeigt und das aktuelle Fenster bleibt gedffnet.

Syntax:
opennew Dateiname

Beispiel:

oopennew hypertextcommands.fm

WICHTIG: Sie missen die Zieldateierweiterung angeben.

Dokument auf der ersten/letzten Seite 6ffnen

Offnet ein Dokument auf der ersten oder letzten Seite des Dokuments. Die Seite wird nur dann in einem
neuen Fenster angezeigt, wenn sie aus einem anderen Dokument stammt (das aktuelle Fenster bleibt
geoffnet).

Syntax:
openlink filename:firstpage
openlink filename:lastpage

Beispiel:

oopenlink hypertextcommands.fm:firstpage

WICHTIG: Sie missen die Zieldateierweiterung angeben.

Dokument auf bestimmter Seite éffnen

Offnet ein Dokument auf einer bestimmten Seite. Die Seite wird nur dann in einem neuen Fenster ange-
zeigt, wenn sie aus einem anderen Dokument stammt (das aktuelle Fenster bleibt gedffnet).
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Syntax:
openpage filename:pagenumber
Beispiel:

oopenpage hypertextcommands.fm:/

WICHTIG: Sie mussen die Zieldateierweiterung angeben.

Feldmatrix
Definiert einen angrenzenden Satz von klickabaren Bereichen in einem Bild und verknipft einen Hyper-

textbefehl mit jedem Bereich.

Sie konnen beispielsweise eine Bildschirmaufnahme einer Symbolleiste in einer Anwendung machen und
dann jeder Schaltfliche auf der Symbolleiste einen Hypertextbefehl zuweisen. Uber den Hypertextbefehl
wird der Benutzer dann zur entsprechenden Hilfe fir die verknlpfte Schaltflache auf dem Bild in der
Symbolleiste geleitet.

Syntax:

matrix Zeilen Spalten ReferencePageFlowName
Beispiel:

matrix 1 3 button matrix flow
Zeilen

Anzahl von Schaltflachenzeilen

Spalten
Anzahl von Schaltflachen in einer Zeile

ReferencePageFlowName

Textrahmen, der auf der Dokumentreferenzseite erstellt wurde, der den Hypertextbefehl fir jede
Schaltflache in der Matrix definiert hat.

Feldmatrix definieren

Definieren Sie eine Schaltflachenmatrix flir die Zuordnung der drei Symbole im folgenden Bild zu den drei
entsprechenden Hypertextbefehlen:
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Mehrstufige Befehle ,,Riickgangig” und ,,Wiederholen”

Erfahren Sie, wie Sie in FrameMaker mehrere Aktionen riickgangig machen und wiederholen.

Sie kdnnen mehrere Aktionen in FrameMaker riickgangig machen und wiederholen. Wenn Sie beispiels-
weise eine . fm-Datei als eine .mi f-Datei speichern, wird der Verlauf nicht geldscht. Einige Aktionen
kénnen jedoch nicht mehr riickgdangig gemacht werden und miissen daher bestatigt werden. Das
Loschen einer leeren Seite aus einem Dokument kann beispielsweise nicht mehr riickgangig gemacht
werden.

Befehle ,Riickgangig” und ,Wiederholen”

Lernen Sie die Befehle zum Rickgangigmachen und Wiederholen in FrameMaker kennen.

Ein Symbol fiir Wiederholen €  wird auf der Symbolleiste neben dem Symbol Riickgéngig machen 2
angezeigt. Wenn Sie auf diese Schaltflache klicken, wird die zuletzt riickgéngig gemachte Aktion wieder-
holt.

Der Befehl ,Wiederholen” steht auch im Meni ,Bearbeiten” und in den Kontextmenis unter dem Befehl
,Ruckgangig” zur Verfligung und zeigt dort den letzten Befehl im jeweiligen Dokument an, der wiederholt
werden kann.

Edit | Insert Format View  Graphics Table  Stru
| Undo Change To Table ctri+Z |
Redo Quick Conditional Text In Shift+ Ctrl+Z

| Repeat Typing Fb

: Revert to Saved Escfr

! Cut Ctrl+X

| Copy Ctrl+C  ?

1 Copy Special >
Paste Ctrl+V
Paste Special...

Smart Paste Escspt

Figure 1: Im Meni ,Bearbeiten” werden der letzte durchgefiihrte sowie der letzte riickgangig gemachte Befehl
angezeigt.

Wenn im aktuellen Dokument keine Aktion ausgefiihrt wurde, auf die der Befehl ,,Riickgangig” oder
,Wiederholen” angewendet werden kann, sind die entsprechenden Menlioptionen und Symbol-
leisten-Schaltflachen nicht verflgbar (abgeblendet).

Das Wahlen von Ansicht > Verlauf oder das Driicken von Strg+K 6ffnet das Befehlsfenster Verlauf, in dem
Sie eine Aktion, die nicht die letzte war, mit allen nachfolgenden Aktionen riickgéngig machen oder
wiederholen kénnen.

Befehlsverlauf auf Dokumentebene

Weitere Informationen finden Sie im Befehlsverlauf auf Dokumentebene in FrameMaker.
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FrameMaker verwaltet einen Verlauf von Befehlen, die rlickgangig gemacht werden kdnnen, sodass Sie
einen oder mehrere kirzlich durchgefiihrte Befehle riickgangig machen oder wiederholen kénnen.

Auf den Befehlsverlauf konnen Sie iber das Menli ,Bearbeiten” und die Kontextmenis zugreifen. Fir
jedes Dokument wird ein eigener Befehlsverlauf gefiihrt, daher wirkt sich das Riickgangigmachen oder
Wiederholen einer Aktion in einem Dokument nicht auf die entsprechende Funktion in anderen geoff-
neten Dokumenten aus.

Cursorbewegungen und die Auswahl von Objekten kdnnen nicht rlickgdangig gemacht werden. Wenn
jedoch ein friherer Zustand wiederhergestellt wird, wird dabei auch die urspriingliche Cursorposition
und Auswahl von Elementen wiederhergestellt.

Befehle, die externe Dateien einbeziehen (beispielsweise Befehle der Rechtschreibpriifung, die das
Benutzerworterbuch aktualisieren), konnen nicht riickgangig gemacht werden.

Letzten Vorgang wiederholen

Erfahren Sie, wie Sie in FrameMaker den letzten Vorgang wiederholen.

FrameMaker verfligt Gber eine leistungsfahige Wiederholen-Funktion, mit deren Hilfe Sie beim Bearbe-
iten eines FrameMaker-Dokuments problemlos den vorherigen Vorgang wiederholen kénnen.

Das Wiederholen des letzten Vorgangs ist an den folgenden Positionen in einem Dokument moglich:

] An der aktuellen Einfligemarke

. In der aktuellen Textauswabhl

. In der aktuellen Objektauswahl

Um den Vorgang ,Wiederholen” durchzufiihren, wahlen Sie im FrameMaker-Men(i Bearbeiten >
[Vorgang/Objektname] wiederholen.

Zusatzlich kénnen Sie den Verlaufspuffer anzeigen, indem Sie Ansicht > Verlauf im FrameMaker-Menii
auswahlen.

Klicken Sie auf einen Eintrag im Puffer, um ihn auszufiihren. Klicken Sie erneut auf den Eintrag, um den
Vorgang riickgangig zu machen.
Das Wiederholen des letzten Vorgangs ist fir die folgenden Aktionen in einem Dokument méglich:
. Eingabe: Im Verlaufspuffer fir das Wiederholen des letzten Vorgangs werden die zuletzt eingege-
benen Zeichen gespeichert. Die Eingabesequenz wird in folgenden Fallen unterbrochen:
- Der Benutzer klickt auf eine Stelle im Dokument.

- Der Benutzer wechselt zwischen in Registerkarten gedffneten Dokumenten.

] Einfligen: Sie kdnnen den letzten Einfligevorgang an der aktuellen Cursorposition wiederholen und
dabei sowohl Text- als auch Grafikobjekte aus der Zwischenablage verwenden. Die folgenden
Grafikobjekte konnen durch Wiederholen des letzten Vorgangs eingefligt werden: Verankerter-
Rahmen, Bogen, Ellipse, Gruppe, Einschub, Linie, FrameMath, Polygon, Polylinie, Rechteck, abge-
rundetes Rechteck, Textrahmen, Textzeile, nicht verankerter Rahmen.

HiINweEIs: Der Kopiervorgang kann nicht wiederholt werden.
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. Loschen: Sie konnen Loschvorgange sowohl fir Textobjekte als auch fiir Grafikobjekte wieder-
holen.

HiNnweEis: Wenn Sie mehrere Zeichen I6schen und anschliefSend den letzten Vorgang wiederholen,
wird nur ein einzelnes Zeichen geléscht. Zeichen- und Objektléschvorgdinge sind austauschbar.
Wenn Sie ein Zeichen I6schen und anschliefSend das Wiederholen des letzten Vorgangs auf ein
Grdfikobjekt anwenden, wird das Grafikobjekt ebenfalls geldscht.

. Zeichenformatanderungen anwenden: Durch Wiederholen des letzten Vorgangs konnen Sie die
Eigenschaften des letzten angewendeten Zeichenformats auf die neue Textauswahl anwenden.

. Absatzformatianderungen anwenden: Durch Wiederholen des letzten Vorgangs kdnnen Sie die
Eigenschaften des letzten angewendeten Absatzformats auf die neue Absatzauswahl anwenden.

] Grafikobjekte einfligen: Durch Wiederholen des letzten Vorgangs kénnen Sie das zuletzt einge-
flgte Grafikobjekt an der aktuellen Cursorposition erneut einfligen. Dieser Vorgang funktioniert
dokumentiibergreifend.

Die Grafikobjekte in der folgenden Liste kénnen eingefligt werden:

o Ein Rahmen, Bogen, Ellipse, Gruppe, Einschub, Zeile, FrameMath, Polygon, Polygonzug, Rechteck,
Abgerundetes Rechteck, Textrahmen, Textzeile, nicht verankerter Rahmen.

. Tabelle einfiigen: Durch Wiederholen des letzten Vorgangs konnen Sie die zuletzt eingefligte
Tabelle an der aktuellen Cursorposition erneut einfligen.

. Objekteigenschaften festlegen: Wenn es sich bei dem zu wiederholenden Vorgang um das
Festlegen von Objekteigenschaften handelt, wendet FrameMaker die zuletzt festgelegten Objek-
teigenschaften auf das neue Objekt an.

. Texteigenschaften festlegen: Wenn es sich bei dem zu wiederholenden Vorgang um das Festlegen
einer Texteigenschaft handelt, wird die zuletzt festgelegte Texteigenschaft, z. B. ,,Standard”, , Fett”,
LKursiv?,  Unterstrichen” oder ,Blocksatz”, auf den zurzeit ausgewahlten Text bzw. Absatz ange-
wendet.

J FuBnote/Verankerten Rahmen einfiigen: Durch Wiederholen des letzten Vorgangs kénnen Sie
eine zuvor eingefligte FuBnote bzw. einen zuvor eingefligten verankerten Rahmen an der aktuellen
Cursorposition erneut einfligen.

. Suchen/Andern: Wenn Sie den Befehl Letzten Vorgang wiederholen auf die Prozedur
,Suchen/Andern”“ anwenden, wendet FrameMaker den Such- und Anderungsvorgang auf alle weit-
eren Vorkommen des angegebenen Texts an.

. Bedingten Text anwenden: Mit Letzten Vorgang wiederholen kénnen Sie das zuletzt angewendete
Bedingungs-Tag auf den zurzeit ausgewahlten Text anwenden.

Der Tastaturbefehl fiir die Aktion , Letzten Vorgang wiederholen” lautet F6. Bei dieser Funktion wird der
letzte Vorgang einer Sitzung und nicht der eines Dokuments ausgefiihrt.

Sie kénnen die Aktionen zum Wiederholen des letzten Vorgangs deaktivieren, indem Sie die Datei

maker.ini bearbeiten. Bearbeiten Sie die folgenden Eintrage:

. RepeatTypingEnabled: Die Standardeinstellung fiir diesen Eintrag lautet ,ON“. Andern Sie den
Eintrag in ,OFF“, um die Funktion der Eingabewiederholung zu deaktivieren.

. RepeatEnabled: Die Standardeinstellung fiir diesen Eintrag lautet ,ON“. Andern Sie den Eintrag in
»OFF“, um die Aktionen zum Wiederholen des letzten Vorgangs zu deaktivieren.
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HINWEIS: Bearbeiten sie die Datei maker.ini mit Vorsicht.

Fenster ,Verlauf”

Lernen Sie das Verlaufsfenster in FrameMaker kennen.

Die Mens Bearbeiten > Riickgangig und Wiederholen zeigen den neuesten Befehl an, aber den vollstan-
digen Befehlsverlauf finden Sie im Fenster Verlauf, verfligbar tiber Ansicht > Verlauf oder durch Driicken
von Strg+K. In diesem Fenster konnen Sie die Aktion auswahlen, die riickgdngig gemacht oder wiederholt
werden soll. Der Befehlsverlauf wird nur fiir das aktive Dokument angezeigt.

Im Fenster Verlauf ist der zuletzt ausgefiihrte Befehl hervorgehoben. Befehle, die oberhalb des zuletzt
ausgeflhrten Befehls angezeigt werden, kdnnen rlickgangig gemacht werden. Unterhalb des zuletzt
ausgefuhrten Befehls aufgefiihrte Befehle konnen riickgangig gemacht werden. Sie sind mit einem
Sternchen (*) gekennzeichnet.

Typing
Insert Image
Cut

Delete Text
Typing

Figure 2:  Das Fenster ,Verlauf”

Aktionen kénnen nur in der Reihenfolge riickgangig gemacht und wiederholt werden, in der sie
ursprunglich durchgefiihrt wurden. Wenn Sie einen Befehl riickgangig machen, werden alle nachfol-
genden Befehle, die mit der ausgewdhlten Aktion zusammenhéangen, ebenfalls riickgangig gemacht.
AuBBerdem werden der ausgewahlte Befehl und alle nachfolgenden Befehle in die Liste ,,Wiederholen”
verschoben. Dementsprechend wird ein Befehl, der wiederholt wird, mit allen nachfolgenden Befehlen
in die Liste ,Rickgangig” verschoben.
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Rechtschreibprifung, Silbentrennung und Thesaurus

Lernen Sie verschiedene Mdglichkeiten kennen, um Rechtschreibpriifungsoptionen und Silbentrennung
in FrameMaker zu andern.

Adobe FrameMaker unterstiitzt das Bearbeiten von Inhalten in praktisch jeder Sprache der Welt und
bietet Funktionen fiir Rechtschreibpriifung, Silbentrennung und Thesaurus fir eine Vielzahl von
Sprachen. Die folgende Tabelle zeigt, fir welche der offiziell unterstiitzten Sprachen FrameMaker Funk-
tionen flir Rechtschreibprifung, Silbentrennung und Thesaurus bietet.

Sprache Rechtschreibpriifung Silbentrennung Thesaurus
Arabisch Ja Nein Nein
Bulgarisch Ja Ja Nein
Katalanisch Ja Ja Nein
Chinesisch Nein Nein Nein
(vereinfacht)

Chinesisch Nein Nein Nein
(traditionell)

Kroatisch Ja Ja Nein
Tschechisch Ja Ja Nein
Dénisch Ja Ja Ja
Niederlandisch Ja Ja Nein
Niederldndisch (Neu) Ja Ja Ja
Englisch (Kanada) Ja Ja Ja
Englisch (UK) Ja Ja Ja
Englisch (US) Ja Ja Ja
Estnisch Ja Ja Nein
Farsi Nein Nein Nein
Finnisch Ja Ja Nein
Franzosisch Ja Ja Ja
Franzosisch (Kanada) Ja Ja Ja
Deutsch (Osterreich) Ja Ja Nein
Deutsch (Deutschland, | Ja Ja Nein
alte Regeln 1901)
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Sprache Rechtschreibpriifung Silbentrennung Thesaurus
Deutsch (Deutschland, | Ja Ja Nein
1996)
Deutsch (Deutschland, | Ja Ja Ja
2006)
Deutsch (Deutschland, | Ja Ja Ja
1901)
Deutsch (Schweiz, Ja Ja Nein
1996)
Deutsch (Schweiz, Ja Ja Ja
2006)
Griechisch Ja Ja Nein
Hebridisch Ja Ja Nein
Ungarisch Ja Ja Nein
Italienisch Ja Ja Ja
Japanisch Nein Nein Nein
Koreanisch Nein Nein Nein
Lettisch Ja Ja Nein
Litauisch Ja Ja Nein
Norwegisch Ja Ja Ja
Neunorwegisch Ja Ja Nein
(Nynorsk)
Polnisch Ja Ja Nein
Portugiesisch Ja Ja Nein
(Portugal)
Portugiesisch Ja Ja Nein
(Brasilien)
Rumanisch Ja Ja Nein
Russisch Ja Ja Nein
Slowakisch Ja Ja Nein
Slowenisch Ja Ja Nein
Spanisch Ja Ja Ja
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Sprache Rechtschreibpriifung Silbentrennung Thesaurus
Schwedisch Ja Ja Ja
Thai Nein Nein Nein
Turkisch Ja Ja Nein
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Rechtschreibhilfe

Die Rechtschreibhilfe sucht nach falscher Schreibweise, ungewéhnlicher Anwendung von Bindestrichen
oder GroRschreibung, Satzzeichenfehlern, geraden Anfiihrungszeichen (wenn typografische verwendet
werden missen) und zusatzlichen Leerzeichen.

Rechtschreibpriifung ausfiihren

Wissen Sie, wie Sie die Rechtschreibprifung in FrameMaker ausfihren.

Die Rechtschreibpriifung kann dabei auf die aktuelle Seite, das gedffnete Dokument, das ganze Buch,
Bookmap oder DITA Map oder die ausgewahlten Dateien im Buch angewendet werden.

HINWEIS: Sie erfolgt jedoch nur fir Seiten des angezeigten Typs, z. B. Vorgabeseiten oder Arbeitsseiten.

HINwEIS: Um die Rechtschreibung innerhalb eines Texteinschubs zu Gberpriifen, 6ffnen Sie den Textein-
schub und lassen Sie die Rechtschreibprifung laufen.

1)  Wahlen Sie Bearbeiten > Rechtschreibhilfe.
Das Dialogfeld ,,Rechtschreibpriifung” wird angezeigt:

Spelling Checker

CEMEELITE “ ‘ Show Hyphenation
Check:
Book [ ] Automatic Correction
Ll Options...
(® Document
(O Current Page Dictionaries...

Start Checking | | Correct Learn Allow in Document  Unlearn

Figure 1:  Das Dialogfeld ,,Rechtschreibprifung”
2)  Klicken Sie auf Priifung beginnen.

FrameMaker beginnt mit der Rechtschreibpriifung an der Position der Einfligemarke im aktiven Do-
kument (bzw. im ersten Dokument des Buchs, falls das Buchfenster aktiv ist).

Wenn ein Fehler gefunden wird, erscheint das Wort oder die Wendung im Feld Falsch?.
FrameMaker versucht alternative Optionen zu finden. Im Feld Korrektur wird die erste verfiigbare
Alternative angezeigt.

3)  Zur Korrektur eines Tippfehlers missen sie die richtige Option aus der Liste wahlen.

Wenn der korrekte Text in der Liste nicht aufgefiihrt wird, kénnen Sie selbst einen Text in das Feld
Korrektur eingeben.

4)  Klicken Sie auf Korrigieren.
5) Sie kdnnen auch die von der Rechtschreibpriifung angebotene Korrektur ignorieren.
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Aufnehmen

Fligen Sie den gekennzeichneten Text in das personliche Worterbuch hinzu. Der Text wird von der
Rechtschreibprifung nicht mehr gekennzeichnet. Wenn Sie ein anderes Dokument 6ffnen oder
wenn Sie FrameMaker neu starten, wird das Wort nicht gekennzeichnet.

Wenn FrameMaker ein Wort mit GroRbuchstaben in ein personliches oder Dokumentworterbuch
aufnimmt und im Dialogfeld ,,Optionen fiir Rechtschreibhilfe” die Option ,,Unlbliche GroR-/Klein-
schreibung” aktiviert ist, werden alle anderen Schreibweisen des Wortes als Fehler angesehen.
Wurde beispielsweise das Wort Trinidad hinzugefligt, wird die Schreibweisetrinidad als Fehler
gemeldet. Wird jedoch trinidad in Kleinbuchstaben hinzugefiigt, gelten alle anderen Schreibweisen
des Worts als zulassig.

Zulassen

Fligen Sie den gekennzeichneten Text in das Worterbuch des Dokuments hinzu. Der Text wird von
der Rechtschreibprifung fiir das aktuelle Dokument nicht mehr gekennzeichnet.

6) Um das aktuelle Vorkommen des Texts zu ignorieren, der vom Priifprogramm gekennzeichnet
wurde, klicken Sie auf Priifung beginnen.

HINwWEIS: FrameMaker prift nicht die Rechtschreibung von hoch- oder tiefgestelltem bzw. manuell
mikropositioniertem Text (z. B. von Text mit einer manuellen Grundlinienverschiebung.

Wenn Sie ein Buch oder eine Map mit der Rechtschreibprifung tberprifen, prift FrameMaker alle Doku-
mente im Buch. Wenn ein Dokument nicht ge6ffnet werden kann, wird das Dokument Gbersprungen,
und eine Nachricht wird im Buchfehlerprotokoll angezeigt.

HinweEls: Bei einer Rechtschreibpriifung in einem ganzen Buch oder einer Map werden Vorgabe- oder
Referenzseiten nicht bericksichtigt.

Eine Warnmeldung fordert Sie auf, das Dokument zu speichern, bevor Sie mit dem nachsten Dokument
fortfahren. Nachdem das letzte Dokument im Buch geprift wurde, wird die Meldung Rechtschreibung
OK bzw. Rechtschreibpriifung beendet angezeigt.

Um die Rechtschreibung in bestimmten Dokumenten eines Buchs oder einer Map zu prifen, wahlen Sie
die Dokumente in der Ressourcenmanager-Ansicht aus. Wahlen Sie dann ,Auswahl”, um die Rechtsch-
reibung nur in diesen Dateien zu priifen, oder Blicher bzw. Maps, um die Rechtschreibung im gesamten
Buch oder Map zu priifen.

FrameMaker kennzeichnet Worter mit einer roten Wellenlinie, um auf Rechtschreibfehler hinzuweisen,
d. h. auf Worter, die nicht im Wérterbuch vorhanden sind. Diese Wellenlinie erscheint, sobald Sie das
gesamte Wort eingegeben und die Leertaste gedriickt haben. Ein mit einer griinen Wellenlinie gekenn-
zeichnetes Wort weist auf einen Satzzeichenfehler hin. Klicken Sie zum Korrigieren mit der rechten
Maustaste auf ein markiertes Wort und wahlen Sie die gewiinschte Option aus.

HINWEIS: Bei griin markierten Wortern sind die Optionen zum Hinzufligen zum Wérterbuch nicht relevant
und daher nicht verfiigbar.

Rechtschreibpriifung so einstellen, das Text libersprungen wird

wissen, wie Sie die Rechtschreibpriifung so einstellen, dass Text in FrameMaker tGbersprungen wird.
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Sie konnen die Rechtschreibpriifung so einstellen, das Teile eines Dokuments lbersprungen werden. So
kdnnen Sie z. B. Absatze mit Computercode von der Priifung ausnehmen.

Andern Sie zum Ignorieren von bestimmtem Text die Eigenschaft Sprache in der Zeichengestaltung auf
Nein.

HINwEIS: Wenn Sie die Sprache von Text auf Nein festlegen, fihrt FrameMaker keine automatische
Silbentrennung mehr durch.

Automatisches Korrigieren von Rechtschreibfehlern

Wissen Sie, wie Man Rechtschreibfehler automatisch in FrameMaker korrigieren kann.

Sie kdnnen FrameMaker anweisen, alle Instanzen von falsch geschriebenen Wortern oder Schreibfehlern
automatisch zu korrigieren. FrameMaker bericksichtigt automatisch zu korrigierende Fehler, bis Sie das
Programm beenden oder die Rechtschreibpriifung abbrechen.

Bevor Sie einen Fehler automatisch korrigieren lassen, sollten Sie genau wissen, welche Anderungen
durchgefiihrt werden. Wenn Sie z. B. die Option ,,Automatische Korrektur” beim Andern eines doppelt
geschriebenen Wortes verwenden, andert FrameMaker alle Wortwiederholungen, auch wenn einige
richtig sind (z. B. die die). Sie sollten auch keine automatische Korrektur verwenden, wenn die Zuordnung
nicht eindeutig ist (z. B. das falsch geschriebene hagt fiir die Worter hast und hart).

1)  Waihlen Sie Bearbeiten > Rechtschreibhilfe, und klicken Sie auf Rechtschreibepriifung starten.

2)  Wenn FrameMaker einen Fehler meldet, wahlen Sie das richtige Wort aus oder geben es ein und
klicken auf Korrigieren.

Andern der Optionen fiir die Rechtschreibhilfe

Verstehen Verschiedenes, wie Sie Rechtschreibprifungsoptionen in FrameMaker dndern kénnen.

Bei der Rechtschreibpriifung eines Dokuments ermittelt FrameMaker auch Fehler, die nicht die
Rechtschreibung betreffen (z. B. Wortwiederholungen, iberfllssige oder falsch gesetzte Leerzeichen
oder uniibliche GroRschreibung). Sie konnen festlegen, welche Schreibfehler bei der Prifung bertick-
sichtigt werden.

342



Sie kdnnen die Rechtschreibpriifung auch so einschranken, dass FrameMaker bestimmte Worter ignor-
iert. So kénnen Sie z. B. Worter mit Ziffern ausschlieBen.

1)  Waihlen Sie Bearbeiten > Rechtschreibhilfe, und klicken Sie auf Optionen.

Preferences X
T Global [/ Auto Spell Check
General
~Graphics
nterface Find Ignore
~Alerts Repeated Words Single-Character Words
Launzh [_]Unusual Hyphenation Words That Are All Uppercase
""" Dropbox
= CMS [l Unusual Capitalization Words Containing: |:|
~ISpelling [v|Two ina Row: [ ] Roman Numerals (NA For Hunspell)
Dictionary
" Smart Quotes Straight Quotes (") Words with Digits
pelling Options [v] Extra Spaces
XML Smart Quotes in Space Before and After
Space Before:
MathML
Space After:
Get Defaults

OK Cancel

Figure 2:  Rechtschreiboptionen im Dialogfeld ,Voreinstellungen”

Automatische Rechtschreibpriifung

Verwenden Sie die Rechtschreibpriifung in einem Dokument direkt beim Schreiben. Wenn ein Wort
falsch geschrieben wurde, erscheint darunter eine rote Schlangellinie.

HINwEIS: Die automatische Rechtschreibpriifung ist sitzungsspezifisch und nicht dokumentspezifisch.
Wenn das gleiche Dokument auf einem anderen Rechner ge6ffnet wird, konnen die Einstellungen fir die
automatische Rechtschreibpriifung anders sein.

Gruppe suchen

Geben Sie in der Gruppe Suchen die Arten von Tippfehlern ein, nach denen Sie suchen méchten.
Waihlen Sie beispielsweise Unubliche GroR-/Kleinschreibung, um nach Waértern mit GroBbuchs-
taben an den falschen Stellen zu suchen (z. B. GRiin).

Gruppe ignorieren

Sie kdnnen angeben, welche Worter bei der Priifung ignoriert werden sollen. Wahlen Sie beispiels-
weise Worter mit Ziffern, wenn Worter nicht beachtet werden sollen, die Ziffern enthalten.

HINwWEIS: Durch das Ignorieren vieler Worter steigt die Wahrscheinlichkeit, dass das Dokument Fehler
enthalt. Wenn Sie beispielsweise festlegen, dass Worter mit Punkten ignoriert werden, wird auch ein
Satz Ubersprungen, der direkt nach einem Punkt beginnt.
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Standardwerte abrufen

Falls Sie Optionen der Rechtschreibhilfe gedandert haben, konnen Sie diese mit Standardwerte
abrufen wieder auf ihre Standardwerte zuriicksetzen. Wenn Sie FrameMaker beenden, ohne die
Standardwerte wiederherzustellen, werden lhre aktuellen Einstellungen als Standardwerte
verwendet.

2)  Klicken Sie auf ,,OK“.

FrameMaker prift nur die Absatze erneut, die seit der letzten Priifung bearbeitet wurden. Wenn Sie nach
dem Priifen eines Dokuments die Optionen dndern, sollten Sie FrameMaker anweisen, alle Absatze zur
erneuten Prifung zu markieren und dann die Rechtschreibprifung noch einmal durchfiihren.

Priifen der Rechtschreibung in verschiedenen Sprachen

Wissen Sie, wie Sie die Rechtschreibung in verschiedenen Sprachen in FrameMaker Gberpriifen.

Jedem Text in einem Dokument ist eine Sprache zugewiesen. Bei der Rechtschreibpriifung verwendet
FrameMaker das Hauptworterbuch der betreffenden Sprache. Durch Zuweisen einer anderen Sprache
konnen Sie festlegen, in welcher Sprache die Rechtschreibung geprift wird. In FrameMaker kdnnen Sie
Benutzerworterblchern und persénlichen Worterblichern Unicode-codierte (UTF-8) Worter hinzufligen.

FrameMaker enthalt Worterblicher fiir alle unterstiitzten Sprachen. Bei der Standardinstallation unter
wird jedoch nur ein Worterbuch in einer einzigen Sprache installiert.

. Verwenden Sie zum Andern der Sprache in einem Dokument die Eigenschaft Sprache in den Eigen-
schaften Standardschrift der Absatzgestaltung, um die Sprache einer der folgenden Optionen zu
andern:

- Fir einen einzelnen Absatz oder alle Absatze in einem Dokument
- Fir einen Textbereich innerhalb eines Absatzes oder eine Textzeile

Wahlen Sie eine der im FrameMaker-Paket enthaltenen 46 Sprachen aus, und fligen Sie sie als Attribut-
wert flir @xm1 : 1ang hinzu. FrameMaker legt die Sprache fiir die Rechtschreibprifung automatisch und
auf Grundlage der Spracheinstellung im xml:lang-Attribut Ihrer XML-Datei fest (siehe Sprach- und
Schrifteinstellungen in strukturierten Dokumenten).

Beachten Sie Folgendes bei Dokumenten in einer asiatischen Sprache:

. In einem asiatischen Dokument mit Zeichenschrift werden moglicherweise einige Sonderzeichen in
der Rechtschreibhilfe nicht wie in einem Dokument mit einer Buchstabenschrift angezeigt. Ein
umgekehrter Schragstrich wird z. B. als Yen-Symbol angezeigt und ein umbruchgeschitzter Binde-
strich erscheint als Leerzeichen.

. Stellen Sie in einem asiatischen Dokument mit lateinischen Buchstaben sicher, dass die Option
L»Anfihrungszeichen” im Dialogfeld ,,Rechtschreibhilfe” deaktiviert ist, damit die Rechtschreibhilfe
nicht bei korrekt geschriebenen Wértern anhalt.
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Worterbiicher

Lernen Sie Gruppenwdrterblicher, persdnliche Worterbiicher und Dokumentwaorterbiicher in Adobe
FrameMaker kennen.

Adobe FrameMaker erstellt automatisch ein personliches Woérterbuch fir Sie und ein Dokumentworter-
buch fiir jedes lhrer Dokumente. Sie kdnnen die Rechtschreibhilfe oder die Optionen der automatischen
Rechtschreibpriifung in diesen Wérterbichern verwenden, um Worter hinzufligen und zu I6schen. Sie
kénnen auch die Worterblicher direkt verwalten. Bei der direkten Arbeit mit einem Wérterbuch kénnen
Sie den Inhalt anzeigen und bearbeiten oder es mit einem anderen Worterbuch zusammenfihren. Sie
konnen mehrere personliche Worterblicher erstellen und sie einzeln verwenden.

Wenn Sie ein personliches Woérterbuch oder ein Dokumentworterbuch d@ndern, markieren Sie alle
Absédtze zur erneuten Priifung, bevor Sie im Dokument eine erneute Rechtschreibpriifung durchfihren.

Viele der folgenden Aufgaben werden im Dialogfeld ,,Woérterbuchfunktionen” durchgefiihrt.

Die Rechtschreibhilfe in FrameMaker verwendet mehrere Worterbicher, um Text auf Rechtschreibfe-
hler zu priifen. Beim Priifen eines Dokuments vergleicht FrameMaker jedes Wort mit den Eintragen in
folgenden Worterblichern:

Hauptworterbuch

Enthalt die Worter eines Standardworterbuchs. Hinzufligen oder Léschen von Eintragen ist in
diesem Worterbuch nicht moglich

Standard-Gruppenwoérterbuch

Enthalt einige technische Begriffe. Sie konnen hier in Ihrer Firma oder Arbeitsgruppe verwendete
Begriffe hinzufligen (z. B. Firmenname und Produktnamen). Das Gruppenworterbuch befindet sich
normalerweise in der Datei site.dict im FrameMaker-Ordner ,dict”.

Personliches Worterbuch

Enthalt Worter, die Sie haufig verwenden. Da es in FrameMaker fiir die Rechtschreibpriifung aller
Dokumente eingesetzt wird, sollten Sie es fir Worter verwenden, die weder dokument- noch grup-
penspezifisch sind (z. B. Eigennamen). Sie kdnnen Worter hinzufliigen und entfernen. Sie kdnnen
auch mehrere persodnliche Worterblicher anlegen und zwischen ihnen wechseln.

Dokumentwéorterbuch

Enthalt die Worter flr ein bestimmtes Dokument. FrameMaker verwendet dieses Worterbuch
unabhangig davon, wer das Dokument bearbeitet. Sie kdnnen in diesem Worterbuch Worter
hinzufiigen und I6schen. Das Dokumentworterbuch ist im Gegensatz zu den anderen Woérter-
blichern Teil des Dokuments und keine eigene Datei.

345



Dialogfeld ,,Worterbuchfunktionen”

Lernen Sie das Dialogfeld ,, Worterbuchfunktionen” und die verschiedenen Arten von Worterblchern in

Adobe FrameMaker kennen.

Wahlen Sie Bearbeiten > Rechtschreibhilfe, um das Dialogfeld Rechtschreibhilfe zu 6ffnen. Klicken Sie

auf Worterblicher, um das Dialogfeld Wérterbuchfunktionen zu 6ffnen.

Dictionary Functions X
(O Personal Dictionary;  |Write to File... &7
(O Document Dictionary ~ |Write to File... v

(O Write All Unknown Words to File...
(® Clear Automatic Corrections

O Mark All Paragraphs for Rechecking
O Rehyphenate Document

Personal Dictionary Path:
C:\Users\Stefan G...NFMUserDictionary

Cancel

Figure 1:  Das Dialogfeld ,, Worterbuchfunktionen”

Personliches Worterbuch

Die Dropdown-Liste bietet folgende Optionen:

Keines: Priifen der Rechtschreibung eines Dokuments ohne Verwendung des personlichen Worter-
buchs

In Datei schreiben: Geben Sie die Datei an, in die Sie den Inhalt des Woérterbuchs kopieren
mochten. Sie konnen die Datei anschlieBend bearbeiten und als neues Worterbuch verwenden.

HinweEls: Wenn bei der Wahl dieses Befehls ein Buchfenster aktiv ist, werden die Dokumentworterbiicher
in eine einzige Datei geschrieben.

Zusammenfiihren aus Datei: Geben Sie die Datei an, die in das aktuelle Worterbuch eingelesen
werden soll.

Worterbuch importieren: Geben Sie den Dateinamen des persoénlichen Woérterbuchs an, das Sie
verwenden mochten, und klicken Sie auf Verwenden.

Dokumentworterbuch

Die Dropdown-Liste bietet folgende Optionen:
Léschen: Loschen des Inhalts des Dokumentworterbuchs

In Datei schreiben: Geben Sie die Datei an, in die Sie den Inhalt des Worterbuchs kopieren
mochten. Sie kdnnen die Datei anschlieRend bearbeiten und als neues Wérterbuch verwenden.

HinweEls: Wenn bei der Wahl dieses Befehls ein Buchfenster aktiv ist, werden die Dokumentworterbiicher
in eine einzige Datei geschrieben.

Zusammenfiihren aus Datei: Geben Sie die Datei an, die in das aktuelle Worterbuch eingelesen
werden soll.
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Unbekannte Woérter in Datei aufzeichnen
Flgen Sie alle Worter im aktuellen Dokument mit falscher Rechtschreibung zum Woérterbuch hinzu.

Liste fiir automatische Korrekturen loschen

Um sicherzustellen, dass FrameMaker beim nachsten Start kein Automatisches Korrigieren von
Rechtschreibfehlern durchflhrt.

Alle Absatze fiir erneute Priifung markieren

FrameMaker prift nur die Absatze erneut, die seit der letzten Prifung bearbeitet wurden. Wenn
Sie nach dem Prifen eines Dokuments die Optionen dndern, sollten Sie FrameMaker anweisen, alle
Absatze zur erneuten Priifung zu markieren und dann die Rechtschreibpriifung noch einmal durch-

fahren.

Dokument neu trennen
Erneutes Durchflihren der automatischen Silbentrennung im gesamten Dokument oder Buch.
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Worterbiicher fiir unterstiitzte Sprachen

Erfahren Sie mehr tber die Unterstiitzung fiir die Rechtschreibpriifung fiir die in Adobe FrameMaker
unterstitzten Sprachen.

In Adobe FrameMaker sind die Worterblicher, die Silbentrennung und der Thesaurus Unicode-aktiviert.

FrameMaker bietet Unterstiitzung fir Wérterbuch und Silbentrennung fiir die folgenden Sprachen:
. Arabisch

. Bulgarisch

J Katalanisch

. Kroatisch

J Tschechisch

. Danisch

. Niederlandisch
. Estnisch

. Finnisch

. Griechisch

] Hebraisch

] Ungarisch

. Italienisch

. Lettisch

. Litauisch

J Norwegisch

. Neunorwegisch (Nynorsk)
] Polnisch

J Portugiesisch

] Rumanisch

J Russisch

. Slowakisch

J Slowenisch

] Spanisch
o Schwedisch
. Tarkisch

HINWEIS: StandardmaRig werden in FrameMaker Worterblicher fur alle unterstitzten Sprachen instal-
liert.

AulRerdem bietet FrameMaker volle Unterstiitzung fir die Erstellung von Dokumenten (ohne Woérter-
blicher und Bindestriche) in Koreanisch, Japanisch, traditionellem und vereinfachtem Chinesisch.

Dartiber hinaus gilt die volle Unterstitzung (einschlieRlich Sprachregeln, Worterbuch, Silbentrennung
und Thesaurus) fir:
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. Englisch (US)

. Englisch (UK)

. Englisch (Kanada)

. Franzosisch

. Franzosisch (Kanada)

. Danisch

. Niederlandisch

. Deutsch — Osterreich (Reform 2006)

] Deutsch — Deutschland (alte Regeln 1901)
. Deutsch — Deutschland (Reform 1996)
. Deutsch — Deutschland (Reform 2006)
. Deutsch — Schweiz (alte Regeln 1901)
. Deutsch — Schweiz (Reform 1996)

. Deutsch — Schweiz (Reform 2006)

. Italienisch

J Norwegisch

. Schwedisch

) Deutsch (Schweiz)

Fiir die deutsche Sprache unterstitzt Adobe FrameMaker verschiedene DUDEN-Rechtschreib- und
Silbentrennungsmodule.

Die folgenden Rechtschreibmodule sind verfligbar:

. Duden

J Duden: Konservativ

. Duden: Presse

. Duden: Tolerant

Die folgenden Silbentrennungsmodule sind verfligbar:
. Duden: Alle

. Duden: Alle auBer unasthetische

. Duden: Asthetisch

. Duden: Bevorzugt asthetisch
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Arbeiten mit persénlichen und Gruppenwérterbiichern

Erfahren Sie, wie Sie in Adobe FrameMaker ein personliches Worterbuch erstellen und ein Gruppenwor-
terbuch verwenden.

Erstellen eines persénlichen Wérterbuchs

Gehen Sie wie folgt vor, um ein personliches Worterbuch zu erstellen:

1)  ErstellenSie ein Dokument mit den Wortern (mit einem Trennstrich an jeder Trennposition). Geben
Sie im Dokument als erste Zeile Folgendes ein: <MakerDictionary 3.0>

2)  Wahlen Sie Datei > Speichern unter. Wahlen Sie im Dialogfeld Dokument speichern einen Ordner,
und definieren Sie einen Dateinamen. Wahlen Sie in der Dropdown-Liste Speichern unter das
Format Nur Text und klicken Sie auf Speichern.

3)  Wabhlen Sie im Dialogfeld Sichern als Text die Option Zeilenschaltung setzen: Nur zwischen
Absatzen, und klicken Sie auf Speichern.

Andern von Gruppenwérterbiichern

Sie kénnen fiir jedes Projekt ein anderes Gruppenwdrterbuch angeben. Gruppenworterblicher kdnnen
auch direkt bearbeitet werden.

Wenn Sie Adobe FrameMaker in einer Arbeitsgruppe im Netzwerk verwenden, wird das Gruppenworter-
buch wahrscheinlich vom Systemadministrator verwaltet.

Geben Sie das Gruppenworterbuch in der Datei maker . ini im Abschnitt [Dateien] an. Die Stan-
dardeinstellung lautet:

SiteDictionary=dict\site.dct
CAUTION: Bearbeiten sie die Datei maker.ini mit Vorsicht.
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Bearbeiten von Worterbuchdateien

Erfahren Sie, wie Sie in Adobe FrameMaker Woérterbuchdateien bearbeiten.

Einfiihrung

Sie haben umfangreiche Steuerungsmoglichkeiten fiir das personliche Woérterbuch, Dokumentworter-
buch und Gruppenwaorterbuch. Sie kénnen auch verschiedene Woérterblcher auswahlen, Woérterblicher
zusammenfiihren, bearbeiten und I6schen.

1)  Wenn Sie ein personliches oder Dokumentworterbuch bearbeiten, verwenden Sie FrameMaker,
um den Worterbuchinhalt in eine Datei zu schreiben.
2)  Andern Sie die Datei. Wenn Sie ein Wérterbuch mithilfe von FrameMaker bearbeiten, gehen Sie
folgendermaRen vor:
- Wenn Sie die Datei 6ffnen, wahlen Sie im Dialogfeld Textdatei einlesen die Option
Zeilenenden als Absatzenden einlesen, und klicken Sie auf Lesen.

- Waihlen Sie beim Speichern der Datei Nur Text und klicken Sie auf Speichern. Klicken Sie dann
auf Nur zwischen Absatzen und Speichern.

3)  Fihren Sie die Datei mit einem anderen Wérterbuch zusammen. Wenn Sie Worter aus dem
Worterbuch entfernt haben, I6schen Sie das Originalwoérterbuch vor dem Einlesen in die Datei.
Andernfalls verbleiben die geldschten Eintrdage im Worterbuch.

Hinzufiigen unbekannter Wérter zu einem Wérterbuch

Enthalt Ihr Dokument viele richtig geschriebene Worter, die FrameMaker als unbekannt meldet, konnen

Sie die Rechtschreibpriifung beschleunigen, indem Sie diese Worter vor Beginn der Prifung in ein

Woérterbuch aufnehmen.

1) Bringen Sie das entsprechende Dokument- oder Buchfenster als aktives Fenster in den Vorder-
grund.

2)  Wabhlen sie Bearbeiten > Rechtschreibhilfe.
3)  Klicken Sie auf Wérterbiicher.
4)  Klicken Sie auf Unbekannte Worter in Datei aufzeichnen und dann auf OK.

5) Geben Sie einen Namen fiir die Worterbuchdatei ein und klicken Sie auf OK oder Speichern. In die
Datei werden keine Schreibfehler wie Wortwiederholungen, unibliche GroBschreibung oder tiber-
flissige Leerzeichen aufgenommen.

6) Bearbeiten Sie die Worterbuchdatei mit einem Texteditor oder in FrameMabker. Entfernen Sie alle
Worter aus der Datei, die nicht in das Woérterbuch aufgenommen werden sollen (z. B. falsch
geschriebene Worter).

7)  Klicken Sie im Dialogfeld ,Rechtschreibhilfe” auf Wérterbiicher.

8) Wabhlen Sie in der Dropdown-Liste Persénliches Worterbuch oder Dokumentwaorterbuch die
Option Aus Datei einlesen und klicken Sie auf OK. Wenn die Worter voraussichtlich in mehreren
Dokumenten auftreten, sollten Sie diese in ein personliches Worterbuch einlesen oder mit allen
Dateien in einem Buch zusammenfihren.

9) Benennen und speichern Sie die Worterbuchdatei.
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HINWEIS: Um einem Worterbuch einzelne Woérter hinzuzufiigen, kénnen Sie im Kontextmen die Option
Wort aufnehmen wahlen. Die obige Methode ist nitzlich, wenn sehr viele Worter mit einer roten
Wellenlinie gekennzeichnet sind.

Hinzufiigen von Komposita mit Bindestrichen zum persénlichen Wérterbuch

Dokumente kdnnen zusammengesetzte Worter (Komposita) enthalten, die durch Bindestriche
verbunden sind. StandardmaRig priift FrameMaker die Rechtschreibung jedes einzelnen Wortes in
einem solchen Kompositum, anstatt alle durch Bindestriche verbundenen Woérter als einen Begriff zu
behandeln. So werden z. B. bei der Rechtschreibprifung des Wortes Kfz-Papiere die Bestandteile Kfzund
Papiere jeweils als einzelne Wérter gepriift. Durch Andern der Standardeinstellungen kénnen Sie zusam-
mengesetzte Worter als ein Wort prifen und in lhr persénliches Worterbuch aufnehmen.

1)  Wahlen Sie Bearbeiten > Rechtschreibhilfe, und klicken Sie auf Optionen.
2)  Wahlen Sie Uniibliche Trennung und klicken Sie auf Zuweisen.

3)  Geben Sie im Dialogfeld , Rechtschreibhilfe” in das Feld ,, Wort” das zusammengesetzte Wort ein,
das in Ihr persénliches Wérterbuch aufgenommen werden soll. Geben Sie am Wortanfang einen
Bindestrich und vor jedem Bindestrich einen umgekehrten Schragstrich (\) ein.

Um beispielsweise das Wort Kfz-Papiere hinzuzufiigen, geben Sie -Kfz\-Papiere ein.
4)  Klicken Sie auf Aufnehmen.
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Silbentrennung

Erfahren Sie, wie Sie die Silbentrennung in FrameMaker steuern.

Wenn Sie einem personlichen Woérterbuch ein Wort hinzufligen, schlagt FrameMaker die Positionen vor,
an denen es getrennt werden kann. Sie kdnnen diese andern, bevor Sie das Wort dem Woérterbuch
hinzuflgen. Sie kdnnen auch festlegen, dass ein Wort immer oder nie getrennt wird. Sie kdnnten
beispielsweise das Wort CD-ROM immer, jedoch lhren Firmennamen nie trennen.

Nachdem Sie die Einstellungen fir die Silbentrennung gedandert haben, sollten Sie die Silbentrennung
erneut auf das Dokument anwenden.

Tipp: Wenn eine genaue Steuerung der Silbentrennung erforderlich ist (z. B. bevor der Probeauszug eines
Buchs gedruckt wird), sollten Sie das gesamte Dokument nach automatisch eingefligten Trennstrichen
durchsuchen. Wahlen Sie Automatischer Trennstrich in der Dropdown-Liste Suchen im Dialogfeld
Suchen/Andern.

Andern der Silbentrennung eines Worts

1) Zeigen Sie die Trennpositionen des Worts an.

2)  Passen Sie die Silbentrennung an und klicken Sie auf Aufnehmen. Sie konnen Trennstriche nach
Bedarf hinzufligen und entfernen.

Unterdriicken der Silbentrennung eines Worts in FrameMaker

1) Geben Sie das gewlinschte Wort in das Feld Korrektur ein.
2)  Klicken Sie auf Trennung anzeigen.

3) Entfernen Sie alle Trennstriche aus dem Wort.

4)  Fugen Sie einen Trennstrich vor dem Wort hinzu.

5)  Klicken Sie auf Aufnehmen.

Erneutes Durchfiihren der automatischen Silbentrennung im gesamten Dokument

1) Bringen Sie das entsprechende Dokument- oder Buchfenster als aktives Fenster in den Vorder-
grund.

2)  Wahlen sie Bearbeiten > Rechtschreibhilfe.
3) Klicken Sie auf Worterbiicher.

4)  Wahlen Sie Dokument neu trennen und klicken Sie auf OK. Diese Option funktioniert fir ein geoff-
netes Dokument.

Wéihlen Sie bei einem Buch die Option Alle Dateien im Buch neu trennen und klicken Sie auf OK.

Portugiesische Trennung

FrameMaker unterstitzt die Portugiesische Trennungsregel. Wenn ein Wort mit Bindestrich am Ende
einer Zeile steht und am Bindestrich umbrochen wird, sollte laut Portugiesischen Trennungsregeln am
Anfang der ndchsten Zeile ein weiterer Bindestrich hinzugefiigt werden.
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Wenn beispielsweise das Wort Estado-membro am Ende einer Zeile steht, fligt FrameMaker einen zusat-
zlichen Bindestrich am Anfang der neuen Zeile hinzu (zusatzlich zu dem Bindestrich des Wortes).

HiNwels: Wenn das Wort mit Bindestrich innerhalb einer Zeile steht, wird kein zusatzlicher Bindestrich
hinzugefligt.

So wenden Sie die Portugiesische Trennung auf einen Text an:

1) Geben Sie den Portugiesischen Text ein.

2)  Waihlen Sie Format > Absatze > Absatzgestaltung, und wahlen Sie in der Dropdown-Liste Sprache
,Portugiesisch” oder ,,Portugiesisch (Brasilien)”.

3)  Wabhlen Sie Anwenden.
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Thesaurus

Erfahren Sie mehr tiber den Thesaurus in FrameMaker.

Im Thesaurus kdnnen Sie Synonyme, dhnliche Begriffe und Antonyme fir angegebene Wérter suchen.
Der Thesaurus ermoglicht Ihnen, einen geeigneteren Begriff flir ein bereits im Dokument vorhandenes
Wort oder ein einzufligendes Wort zu suchen.

Sie kdnnen auch Worter im Suchergebnis auswahlen und wiederum deren Synonyme, dhnliche Begriffe
und Antonyme anzeigen. FrameMaker zeichnet die zehn zuletzt nachgeschlagenen Woérter auf.

Wenn nicht alle Informationen im Dialogfeld Platz finden, kénnen Sie mit den Pfeilfeldern am unteren
Fensterrand weitere Informationen anzeigen. FrameMaker zeigt Synonyme, Antonyme und dhnliche
Begriffe an, deren GroR-/Kleinschreibung der des nachgeschlagenen Wortes entsprechen.

1)  Ein Wort mit der Thesaurus-Funktion nachschlagen:

- Um ein Wort nachzuschlagen, das im Dokumentfenster angezeigt wird, markieren Sie das
Wort und wahlen Sie Bearbeiten > Thesaurus.

- Um ein Wort nachzuschlagen, das im Dokumentfenster nicht angezeigt wird, vergewissern Sie
sich, dass kein Text markiert ist, und wahlen Sie dann Bearbeiten > Thesaurus. Geben Sie das
Wort ein und klicken Sie auf Nachschlagen.

- Um einen Ausdruck nachzuschlagen, stellen Sie sicher, dass kein Text ausgewahlt ist, und
wahlen Sie Bearbeiten > Thesaurus. Geben Sie den Ausdruck einschliefRlich aller Bindestriche
in das Dialogfeld Thesaurus-Referenz ein, und klicken Sie auf Nachschlagen

HINwEIS: Wenn Sie eine Wortverbindung durch Auswahlen im Dokumentfenster angeben,
schlagt FrameMaker nur das erste markierte Wort nach.

- Um ein im Dialogfeld ,, Thesaurus” angezeigtes Synonym, ahnliches Wort oder Antonym zu
suchen, klicken Sie auf das Wort. Die Synonyme, dhnlichen Worter und Antonyme werden in
Fettschrift angezeigt.

- Um ein Wort erneut nachzuschlagen, wahlen Sie das Wort in der Dropdown-Liste Wort im
Dialogfeld Thesaurus.

2)  Wahlen Sie in der Dropdown-Liste Sprache eine andere Sprache.

FrameMaker verwendet beim Nachschlagen die Sprache des aktuellen Textes. Ist kein Wort aus-
gewdhlt oder befindet sich die Einfligemarke nicht in einem Absatz, verwendet FrameMaker die
Sprache der Benutzeroberfliche, die Sie bei der FrameMaker-Installation gewdhlt haben. Sie kén-
nen die Standardsprache fiir neue Dokumente aufer Kraft setzen, indem Sie lhre eigene Vorlage er-
stellen.

HiNweEls: Der Thesaurus fir eine Sprache wird zusammen mit dem Woarterbuch installiert.

3)  Umein Wort in lhrem Dokument zu verwenden, wahlen Sie das Wort aus der Liste Synonyme oder
Siehe auch aus und klicken Sie auf Ersetzen.

Wenn Sie ein Wort beim Offnen des Dialogfelds , Thesaurus“ ausgewihlt haben, wird das Wort durch ein
im Dialogfeld ausgewdhltes Wort ersetzt. Wenn Sie kein Wort ausgewahlt haben, wird das Wort, dass
Sie im Dialogfeld ausgewahlt haben, in die aktuelle Einfligemarke eingefigt.
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SUCHEN

Suchen

Mit der Funktion Suchen/Andern kénnen Sie in einem Dokument, einem Buch oder einer Map nach
Elementen suchen (nicht nur nach Text).

Wenn Sie in einem Dokument suchen (BearbeitenSuchen/Andern), beginnt FrameMaker die Suche an
der Einfigemarke, und durchlauft das Dokument. Es werden nur Seiten des Typs durchsucht, in dem sich
auch die Einfligemarke befindet (z. B. nur Vorgabe- oder Referenzseiten). Bei Erreichen des Dokumen-
tendes setzt FrameMaker die Suche am Anfang fort. Zuerst wird der Haupttextfluss und dann der tbrige
Text im Dokument durchsucht. Da die Suche textflussweise und nicht seitenweise erfolgt, kann der
Eindruck entstehen, dass FrameMaker bei der Suche im Dokument hin- und herspringt.

Beim Durchsuchen eines ganzen Buchs beginnt FrameMaker mit dem aktiven Dokument (bzw. dem
ersten Dokument im Buch, falls das Buchfenster aktiv ist) und fahrt fort, bis alle Dokumente im Buch
durchsucht wurden. Wenn sich ein Dokument nicht 6ffnen lasst, wird es Gibergangen und Sie erhalten
eine entsprechende Meldung im Buchfehlerprotokoll.

HINWEIS: Wenn Sie ein ganzes Buch, eine Bookmap oder DITA Map durchsuchen, ist es nicht moglich, die
Vorgabe- oder Referenzseiten zu durchsuchen.

Dialogfeld ,Suchen/Andern“

So arbeiten Sie mit dem Dialogfeld ,Suchen/Andern” in FrameMaker.

Wihlen Sie zum Offnen des Dialogfelds Suchen/Andern die Option Bearbeiten > Suchen/Andern.

Find/Change

Find Text: pv
(® Simple Search [ ] Consider Case
() Wildcards [ ] Whole Word
(O Regular Expressions [ Find Backward
Change To Text: v
[ | Clone Case

Look in: (® Book Map (O Document () Selection

Change Change & Find Change All

Figure 1:  Suchen/Andern — Dialogfeld

Suchen

Wahlen Sie den Typ von FrameMaker-Element aus, nachdem gesucht werden soll. Sie kdnnen nach
Text und anderem Strukturiertes Authoring suchen.
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SUCHEN

HINWEIS: Der gesuchte Text wird in der Dropdown-Liste Suche gespeichert. Der Suchverlauf wird in allen
FrameMaker-Sitzungen beibehalten.

Einfache Suche

Sucht im Feld ,,Suchen” nach dem eingegebenen Begriff.

Platzhalter

Sucht basierend auf Platzhalterregeln, die im Feld ,Suchen” definiert sind:

Platzhalter

Beschreibung

Beispiel

Stern. Beliebige Anzahl von
Zeichen

*orm sucht nach: Formular
oder informieren

Pipe. Leerzeichen oder
Interpunktion

Punkt. Beliebiges Zeichen

for. sucht nach Form oder
Fort

Caret. Anfang einer Zeile

angegebenen Bereich

S Ende einer Zeile
[ab] Beliebige Zeichen in eckigen f[ao] rmsucht nach Farm
Klammern oder Form
[*ab] Beliebiges Zeichen auller den f [~ao] rmsucht nach f gefolgt
Zeichen in Klammern von einem beliebigen Zeichen
auller den Zeichen a und o
gefolgt von rm
[a-f] Beliebiges Zeichen in einem f [b-e]rmsucht nach Farm

oder Form, aber nicht
beispielsweise nach ferm

HINWEIS: Beim Durchfiihren einer Suche mit Platzhaltern miissen Sie den umgekehrten Schragstrich
verwenden, um ein Zeichen zu finden, das eine besondere Bedeutung fiir die Platzhalter hat. Mit \ *

beispielsweise wird genau nach dem Zeichen * (Sternchen) gesucht.

Reguldre Ausdriicke

Sucht basierend auf dem reguldren Ausdruck, der im Feld ,Suchen” definiert ist.

Regularer Ausdruck

Beschreibung

Beispiel

Stern. Null oder mehr Instanzen

*orm sucht nach: Form oder
informoder frm

Punkt. Beliebiges Zeichen

for. sucht nach Form oder
Fort

357




SUCHEN

Regularer Ausdruck

Beschreibung

Beispiel

+ Plus. Beliebiges Zeichen for. sucht nach Form oder
Fort
? Schrankt die Suche auf das fo.+?msucht nach fo gefolgt
nachste angegebene Zeichen von einem oder mehreren
Zeichen (beliebige) gefolgt von
m
\d Eine Ziffer \ d+ Sucht nach einer Zahl mit
mindestens einer Stelle
{n} Gibt die Anzahl von Instanzen so{1}n sucht nach son, aber
an nicht nach soon
{n,m} Bereich von Instanzen so{1-2}nsuchtnach sonund
soon, aber nicht nach sooon
{n,} Bereich von n bismin so{1-2}nsuchtnach sonund
geschweiften Klammern. soon, aber nicht nach sooon
A Caret. Anfang einer Zeile
S Ende einer Zeile
[ab] Beliebige Zeichen in eckigen f[ao] rmsucht nach Farm
Klammern oder Form
[*ab] Beliebiges Zeichen auller den f [~ao] rmsucht nach f gefolgt
Zeichen in Klammern von einem beliebigen Zeichen
auBer den Zeichen a und o
gefolgt von rm
[a-f] Beliebiges Zeichen in einem f [b—e] rmsucht nach Farm

angegebenen Bereich

oder Form, aber nicht
beispielsweise nach ferm

Hinwels: Beim Durchfiihren einer Suche nach einem reguldaren Ausdruck, missen Sie den umgekehrten
Schragstrich verwenden, wenn Sie ein Zeichen finden, das eine besondere Bedeutung fiir den regularen
Ausdruck hat. Mit \ * beispielsweise wird genau nach dem Zeichen * (Sternchen) gesucht.

GroB-/Kleinschreibung beachten

Suche mit Berlcksichtigung von GroR-/Kleinschreibung

Ganzes Wort

Suchen nach einem ganzen Wort. Sucht beispielsweise nach einigem ganzen Wort so, findet so,

aber nicht soon.
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Riickwarts suchen
StandardmaRig sucht die Funktion ,Suchen” vom Anfang bis zum Ende eines Dokuments/Buchs.
Wahlen Sie diese Option, um riickwarts zu suchen.

Anderung
Wahlen Sie den Elementtyp, um das gesuchte Element zu dndern.

Anderung des reguldren Ausdrucks beinhaltet eine Erfassungsgruppen-Funktionalitit. Um
beispielsweise die Daten in einem Dokument zu suchen und das Format von TT-MM-JJJJ in
MM-TT-JJJJ zu dndern, missen Sie folgenden reguldren Ausdruck verwenden:

(\d{2})-(\d{2})-(\d{4})

Die runden Klammern um Tag, Monat und Jahr als Teil des reguldaren Ausdrucks sind Erfassungs-
gruppen. Jede Erfassungsgruppe wird innerhalb der Variablen fiir reguldare Ausdriicke erfasst: $1,
$2, S3 Usw.

Austauschen der Monatsgruppe gegen die Datumsgruppe:

$2-51-83
Hinweis: Wenn Sie Andern oder Andern & Suchen wihlen und kein Text im Dokument ausgewahlt ist,
nimmt FrameMaker den Austausch an der Position der Einfligemarke vor.
GroR-/Kleinschreibung tibernehmen

Achten Sie darauf, dass das gedanderte Element derselben GroR- und Kleinschreibung wie im
gefunden Element entspricht. Suchen Sie nach so und @ndern Sie die Suche auf soon mit
GroB-/Kleinschreibung tibernehmen, dann dndert sich so in soon und So in Soon.

Suchen in

Suchen Sie nach Elementen in einem Buch, Dokument, einer Map oder in der aktuellen Auswahl.

Typen von Suchelementen

Lernen Sie verschiedene Arten von Suchelementen in FrameMaker kennen.

Zusatzlich zu Text konnen Sie folgende Elemente in der Auswahl, im Dokument oder im ganzen Buch
suchen. Sie kénnen aus der Ansicht Ressourcenmanager auch in einer Map suchen.

Textformate und -stile

Zeichenformateigenschaften oder bestimmte Absatz- oder Zeichenstile. Im strukturierten
FrameMaker-Format wird , Element” direkt nach dem Text angezeigt. So kdnnen Sie einzeln oder
gleichzeitig nach Elementnamen, Attributnamen und Attributwerten suchen.

1) Kopieren Sie den Text mit der Zeichenformatierung, die Sie suchen mochten. FrameMaker berick-
sichtigt aber nur die ersten 126 Zeichen aus der Zwischenablage.

2)  Wihlen Sie Bearbeiten > Suchen/Andern. Wihlen Sie im Dialogfeld Suchen/Andern Text &
Zeichenformat aus Zwischenablage aus der Dropdown-Liste Suchen aus. Geben Sie den gesuchten
Text nicht in das Feld Suchen ein.

3) Klicken Sie auf Suchen.
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Soll FrameMaker eine Einstellung nicht fir den gefundenen Text verwendet werden, setzen Sie
diese auf ,Beibehalten”.

Tipp: Nachdem Sie Anderungen im Dialogfeld Anderungen am Zeichenformat vorgenommen haben,
kdnnen Sie das Dialogfeld auf das Format des aktuellen Textes zurlicksetzen, indem Sie
Strg+Umschalt+F9 driicken.

Marken

FrameMaker verwendet Marken fiir Querverweise, Indizes und andere Zwecke. Sie kdnnen nach
Marken eines beliebigen Typs oder nach einem bestimmten Markentyp suchen. Wenn die Anzeige
von Steuerzeichen aktiviert ist, werden Marken mit einem Symbol T gekennzeichnet.

FrameMaker kann auch nach Marken mit bestimmtem Markentext suchen.

Uber das Dialogfeld ,Suchen/Andern ist es nicht moglich, Markentext zu ndern. Wenn der ange-
gebene Markentext gefunden wird und Sie im Feld ,Andern“ einen anderen Text eingeben und auf
Andern klicken, ersetzt FrameMaker die Marke — nicht den Markentext — durch den Text im Feld
,Andern“. Um den Markentext zu dndern, verwenden Sie den Befehl Befehl Einfiigen > Marke.

1)  Im Textfeld Suchen/Andern:
- Um eine beliebige Marke im Dokument zu suchen, wahlen Sie in der Dropdown-Liste Suchen
den Eintrag Marke — Alle und lassen das Feld ,, Suchen” leer.

- Um einen bestimmten Markentyp zu suchen, wahlen Sie in der Dropdown-Liste Suchen den
Eintrag Marke — Typ und geben den gewiinschten Markentyp in das Feld , Suchen” ein.

- Um eine Marke mit einem bestimmten Text zu suchen, wahlen Sie in der Dropdown-Liste
Suchen den Eintrag Marke — Text und geben den Markentext in das Feld ,Suchen” ein.

2) Klicken Sie auf Suchen. Wenn das Dialogfeld ,,Marke” ge6ffnet ist (Einfligen > Marke), wird der Text
fiir die gefundene Marke im Dialogfeld angezeigt.

WICHTIG: Soll der Text in einer gefundenen Marke ersetzt werden, bearbeiten Sie diesen im Dialogfeld
,Marke“. Wenn Sie das Dialogfeld Suchen/Andern verwenden, ersetzen Sie die Marke statt den Marken-
text.

Querverweise

Beliebige Querverweise, unabhangig vom jeweiligen Format, Querverweise, die ein bestimmtes
Format verwenden, oder ungeldste Querverweise. Letztere kdnnen von FrameMaker nicht aktual-
isiert werden. Bei einem ungeldsten Querverweis wird der Markentext des Querverweises im Feld
»Suchen” angezeigt.

Texteinschiibe

Jeder Text kann durch Verweise importiert werden. Sie kdnnen auch nach ungeldsten Textein-
schiiben, also nach Einschiiben suchen, die nicht aus ihren jeweiligen Quellen aktualisiert werden
konnen. Sie kénnen jedoch nicht nach Grafikabonnenten oder durch OLE verkniipfte Objekte
suchen. (Um OLE-Verknipfungen aufzulisten, wihlen Sie Bearbeiten > Verkniipfungen.)

Variablen
Beliebige Variablen, unabhangig von ihren Namen, oder bestimmte Variablen.
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Rubi
Beliebiger Rubi-Text, wenn japanische Schriften auf Ihrem System installiert sind.

Verankerte Rahmen
Rahmen, der Grafiken enthélt und bei der Suche hilft. Grafiken in unverankerten Rahmen werden
nicht gefunden.

FuBBnoten

Beliebiger Text oder TabellenfulRnoten.

Tabellen

Beliebige Tabellen, unabhangig vom jeweiligen Tabellenstil, oder Tabellen mit einem bestimmten
Stil.

Bedingter Text

Beliebiger bedingter Text, Text eines bestimmten Bedingungs-Tags oder Text ohne Bedingung.
FrameMaker kann nicht nach bedingten Tabellenzeilen oder verborgenem bedingten Text suchen.

Sie kénnen sichtbaren Text mit bestimmten Bedingungs-Tags suchen. Wenn FrameMaker sicht-
baren bedingten Text findet, wird automatisch samtlicher angrenzender Text ausgewahlt, der diese
Bedingungs-Tags verwendet.

FrameMaker kann bedingte Tabellenzeilen nicht finden.

1) Vergewissern Sie sich, dass der Text mit den gesuchten Bedingungs-Tags sichtbar ist.
2)  Waibhlen Sie im Dialogfeld Suchen/Andern Bedingter Text aus der Dropdown-Liste Suchen aus.
3)  Fihren Sie eine der folgenden Aktionen durch:
- Um Text mit einem bestimmten Bedingungs-Tag zu suchen, verschieben Sie das Bedin-
gungs-Tag in die Liste ,Mit"“.

- Um Text ohne ein bestimmtes Bedingungs-Tag zu suchen, verschieben Sie das Tag in die
Auswahlliste Ohne.

- Soll das Bedingungs-Tag bei der Suche nicht berlicksichtigt werden, verschieben Sie es in die
Auswabhlliste Beibehalten.

- Um samtlichen bedingten Text zu finden, verschieben Sie alle Tags in die Liste Beibehalten.
- Um nicht bedingten Text zu finden, wahlen Sie Nicht bedingt aus.
HINwEIS: Zum Verschieben von Bedingungs-Tags aus einer Auswahlliste wahlen Sie das Tag
aus und klicken auf einen Pfeil. Sie konnen auch auf das Tag doppelklicken. Zum Verschieben

aller Bedingungs-Tags aus einer Auswahlliste wahlen Sie ein Tag in der Liste aus und klicken
bei gedrickter Umschalttaste auf einen Pfeil.

4)  Klicken Sie auf Zuweisen und anschlieend auf Suchen.

Automatischer Trennstrich

Automatisch getrennte Worter.
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Text- und Zeichenformate aus Zwischenablage

Text, der exakt mit dem Inhalt der Zwischenablage Gbereinstimmt, einschlieRlich GroR-/Kleinsch-
reibung und Zeichenformatierung.

Unicode-Textsuche

Lernen Sie die Unicode-Textsuche in FrameMaker kennen.

FrameMaker verwendet das UTF-8-Codierungsformat. Daher verwenden alle Zeichen in einem . fm-
oder XML-Dokument, das Unicode-codierten Text enthalt, Multibytezeichen. Dies hat zur Folge, dass nur
die im Feld Suche eingegebene Zeichenfolge zum Durchfiihren der Suche verwendet wird.

Die Suche in einem Bereich kann nur flir Unicode-Zeichen verwendet werden. Benutzer kdnnen nach
allen Zeichen suchen, die zu BMP (Basic Multilingual Plane) gehoren. Codepunkte fiir Unicode kdnnen
ebenfalls fir Suchen und Ersetzen verwendet werden. Geben Sie beispielsweise \uXxXXXx ein, um ein
Zeichen mit dem Codepunkt ,XXXX“ zu suchen. Um nach dem Buchstaben , A” zu suchen, dessen
Codepunkt u+0041 ist, kénnen Sie \u0041 im Dialogfeld Suchen/Andern eingeben.

Ein Codepunkt ist ein beliebiger Wert im Unicode-Codespace, der einem Bereich von Ganzzahlen von 0
bis 10FFFF16 entspricht. Dieser bestimmte Bereich fir den Codespace wird nur im Unicode-Standard
festgelegt. Andere Standards fiir Zeichencodierung konnen andere Codespaces verwenden.

AuBerdem konnen Sie auch Jokerzeichen fiir die Suche nach Unicode-Text verwenden.

HINWEIS: In asiatischen Dokumenten mit Multibytezeichen sind die eckigen Klammern [ ] nicht als
Jokerzeichen verwendbar.

Suche nach Sonderzeichen und nicht druckbaren Symbolen

Erfahren Sie mehr Gber die Suche nach Sonderzeichen und nicht druckbaren Symbolen in FrameMaker.

Sie kdnnen nach beliebigem Text suchen, einschliellich einzelnen Zeichen, Wortverbindungen und
Sonderzeichen, die nicht auf der Tastatur vorhanden sind. Sie missen die mit dem umgekehrten Schrag-
strich beginnende Zeichenfolge eingeben.

Sie konnen z. B. mit \ P\p (Absatzanfang gefolgt vom Absatzende) nach leeren Absatzen suchen.

Die meisten dieser Zeichenfolgen kénnen sowohl beim Suchen als auch beim Ersetzen verwendet
werden, um z. B. einen Zeilenvorschub durch ein Absatzende-Zeichen zu ersetzen. Sie kdnnen Zeichen-
folgen jedoch nicht durch Textflussende, Absatzanfang, Wortanfang oder Wortende ersetzen.

Konfiguration eines reguldren Ausdrucks

Lernen Sie die Konfiguration regularer Ausdriicke in FrameMaker kennen.

FrameMaker verwendet die Boost-Engine fiir Regex. Weitere Informationen zu Boost finden Sie unter
http://www.boost.org/.

Sie kdnnen die reguldren Ausdriicke mithilfe der folgenden Syntax schreiben:
] Perl (Standard): Siehe Perl doc — Regular expressions
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o Grep: Siehe Grep — Regular expressions
. Egrep: Siehe Egrep — Regular expressions
StandardmaRig verwenden Sie die Perl-Syntax fiir regulare Ausdriicke, um reguldre Ausdriicke in

FrameMaker zu schreiben. Um jedoch die Grep- oder Egrep-Syntax fir reguldre Ausdriicke zu
verwenden, mussen Sie das Flag ,,Regular Expression Syntax” in der Datei maker . ini aktualisieren.
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EXPORTIEREN VON TEXT UND GRAFIKEN

Exportieren von Text und Grafiken

Erfahren Sie, wie Sie in Adobe FrameMaker Text und Grafiken exportieren.

Mithilfe folgender Techniken kénnen Sie Text und Grafiken exportieren:

Kopieren Sie die Objekte und fligen Sie diese in eine andere Datei oder Anwendung ein.
Speichern Sie ein Dokument in einem anderen Format.

Verwenden Sie Druckoptionen, um eine PostScript- oder EPS-Datei zu erstellen.

Legen Sie eine PDF-Datei (Portable Document Format) an.

Speichern Sie die Datei im HTML-Format, das die Grafiken in einem Dokument in das GIF-, PNG-

oder JPEG-Format konvertieren kann.

Save as XML.

Senden Sie das Dokument als E-Mail-Anlage.
Verwenden Sie Ziehen-und-Ablegen-Techniken.

RELATED LINKS:

Erstellen einer PostScript-Datei
Importieren von Adobe lllustrator-Dateien
Drag & Drop verwenden

Festlegen der Grafikkonvertierung
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Unicode-Unterstitzung

Erfahren Sie mehr Gber das Authoring in mehreren Sprachen sowie die Unicode-Unterstlitzung in
FrameMaker und die Verwendung von Tastaturen von Drittanbietern.

In diesem Thema

] Unicode

. Unicode in FrameMaker

. Hinzufiigen von mehrsprachigem Text

. Einrichten von Eingabesprachen

. Verwenden von Tastaturanwendungen von Drittanbietern
J Verwenden der Zeichenpalette

J Verwenden der Hex-Eingabepalette

Unicode

Unicode ist ein Branchenstandard, mit dem Computer Text in den meisten Sprachen der Welt auf konsis-
tente Weise anzeigen kdnnen. Er wird implementiert durch unterschiedliche Zeichencodierungen wie
UTF-8, UTF-16 und UTF-32. FrameMaker unterstiitzt alle drei Codierungen, speichert Dateien aber in
UTF-8. Wenn Sie Dateien importieren, die in UTF-16 oder UTF-32 codiert sind, konvertiert FrameMaker
sie automatisch in UTF-8.

In der Textverarbeitung verwendet Unicode eine eindeutige Zahl oder Codepunkt fiir jedes Zeichen in
einer Sprache. Der Unicode-Standard gibt keine Schriften oder die Darstellung der Zeichen an. Dies
geschieht durch Unicode-Schriften, die Darstellungen fiir Tausende der Unicode-Zeichen enthalten
konnen, und auf diese Weise eine Schrift fir mehrsprachige Dokumente bereitstellen.

Unicode in FrameMaker

Der Unicode-Standard ist ein Zeichencodierungssystem fir den Austausch, die Verarbeitung und die
Anzeige von Text in allen Sprachen oder Zeichensatzen. Mit der Unicode-Codierung kénnen Sie Doku-
mente mit Zeichen aus einer beliebigen Zahl von Zeichensatzen erstellen und Dokumente zwischen
unterschiedlichen geografischen oder linguistischen Regionen austauschen.

FrameMaker unterstitzt Unicode-Textcodierung zum Erstellen, Bearbeiten, Speichern und Veroffentli-
chen von Dokumenten in mehreren Sprachen und zum Erstellen von mehrsprachigen Dokumenten.
Unicode-Text wird unterstitzt in Marken, Katalogeintragen und Dialogfeldern von FrameMaker.
PDF-Export unterstitzt Unicode-Text, Lesezeichen, Tags und Kommentare. AuRerdem haben Sie die
Moglichkeit, Unicode-Inhalte aus anderen Anwendungen zu importieren oder zu kopieren.

Unicode weist eine eindeutige Nummer jedem einzelnen Zeichen zu, unabhangig davon, welche Sprache
oder welcher Computertyp verwendet wird.
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Portabel

Buchstaben und Zahlen bleiben unverdndert, wenn Sie die Datei von einer Workstation auf eine
andere verschieben. Es kdnnen problemlos andere Sprachen zum Dokument hinzugefligt werden,
da diese Zeichen Uber eigene Zuweisungen verfiigen und sich nicht auf die Codierung von anderen
Sprachen im gleichen Projekt auswirken.

Stabil

Da die mit Unicode kompatiblen Schriften eine grélRere Anzahl von moglichen Zeichen enthalten,
sind Sonderzeichen sofort verfiigbar.

Flexibel

Bei Unicode-Unterstiitzung flhrt das Ersetzen eines Schriftbilds in einem Projekt nicht zu ersetzten
Zeichen. Bei einer Unicode-kompatiblen Schrift wird ein g immer als g dargestellt, unabhangig vom
verwendeten Schriftbild.

Dadurch kann beispielsweise eine franzosische Firma fir einen Kunden in Korea arbeiten und den
Auftrag an ein Partnerunternehmen in den USA abgeben, ohne dass Probleme in der Textdarstel-
lung auftreten. Der Verfasser oder Designer muss die entsprechende Sprache im Betriebssystem
aktivieren, die Schrift in der entsprechenden Sprache laden und kann dann an dem Projekt weiter-
arbeiten.

1)  Damit Sie auf dem Computer Inhalt in anderen Sprachen als Englisch verfassen kénnen, starten Sie
den Computer mit dem UTF-8-Gebietsschema.

2)  Um Worterbiicher zu aktivieren oder den Thesaurus zu 6ffnen, wahlen Sie die gewiinschte Sprache
aus der Eingabegebietsschema-Leiste (IME).

3) Beginnen Sie mit der Eingabe des Inhalts in der ausgewahlten Sprache.

Bestimmte Funktionen, beispielsweise die Such- und Ersetzfunktion, Marken, Hypertext oder Kata-
logeintrage, unterstiitzen Unicode. Sie kdnnen Dokumente mit Unicode-Lesezeichen, -Tags,
-Kommentaren usw. im PDF-Format exportieren. AuBerdem haben Sie die Moglichkeit,
Unicode-Inhalte aus anderen Anwendungen zu importieren oder in diese zu exportieren. Zusat-
zliche Worterblicher unterstiitzen Sie beim Erstellen von Inhalten in mehreren Sprachen.

Hinzufligen von mehrsprachigem Text

This section needs some rework and update for newer operating systems. | still describes process for
Windows XP and Vista, but Windows 7, 8 and 10 are missing.

Es gibt verschiedene Moglichkeiten, Zeichen in Unicode in ein Dokument einzufiigen. Sie konnen die
Sprach- oder Gebietsschema-Einstellungen des Computers so konfigurieren, dass die erforderlichen
Sprachen fir die Tastatureingabe hinzugefiigt werden. Sie kdnnen auch eine Bildschirmtastatur tber ein
Plug-In eines Drittanbieters konfigurieren und verwenden.

Tastaturlayouts kénnen keine einfache Tastenkombination fiir alle Zeichen enthalten und deshalb bietet
FrameMaker zwei alternative Eingabemethoden, mit denen Sie Zugriff auf alle Unicode-Zeichen haben.
Zum einen kdnnen Sie Zeichen Uber die Hex-Palette eingeben, in der Sie den Codepunkt in einer belieb-
igen der drei UTF-Codierungen angeben kénnen. Zum anderen kénnen Sie die Zeichentabelle
verwenden, eine Tabelle mit aller in der gewahlten Schrift verfligbaren Unicode-Zeichen.
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Microsoft Windows XP Service Pack 2 (SP2) und Windows Vista“verwenden Linder- und Spracheinstel-
lungen. Verwenden Sie diese Einstellungen, um zusatzliche Sprachen zur Tastatureingabe hinzuzufigen.
Diese Sprachen- und Sprachausgabe-Einstellungen werden in der Eingabegebietsschema-Leiste auf dem
Desktop angezeigt. Wenn Sie eine Sprache ausgewahlt und eine lokalisierte Tastatur eingerichtet haben,
kdnnen Sie den gewiinschten Text in das Dokument eingeben. Die Tastaturlayouts werden von Microsoft
festgelegt.

Sie kénnen in der ausgewahlten Sprache Worter eingeben oder die jeweils entsprechenden
Unicode-Zeichen eingeben.

Einrichten von Eingabesprachen

1)  Offnen Sie die Systemsteuerung lhres Computers und doppelklicken Sie auf das Symbol ,,Regions-
und Sprachoptionen®”. Das Dialogfeld Regions- und Sprachoptionen wird angezeigt.

2)  Klicken Sie auf die Registerkarte Sprachen.

3)  Klicken Sie auf die Schaltflache Details. Das Dialogfeld Textdienste und Eingabesprachen wird ange-
zeigt.

4)  Klicken Sie auf der Registerkarte ,,Einstellungen” auf ,, Hinzufligen”. Das Dialogfeld Eingabesprache
hinzufiigen wird angezeigt.

5)  Wabhlen Sie aus der Liste Eingabesprache eine Sprache aus.

6) Klicken Sie auf ,,OK“. Die ausgewahlte Sprache wird in die Liste Installierte Dienste aufgenommen.

7)  Wabhlen Sie aus der Liste Standardeingabesprache die gewiinschte Sprache aus.

8)  Klicken Sie auf Ubernehmen und dann auf OK, um die Einstellungen zu speichern und das Dialog-
feld Textdienste und Eingabesprachen zu schliel3en.

9) Klicken Sie auf die Registerkarte Regionsoptionen, und wahlen Sie dann die Sprache aus, welche Sie
in der Liste Standardeingabesprache ausgewahlt haben.

10) Klicken Sie auf die Schaltfliche zum Ubernehmen der Anderungen und anschlieRend auf ,0K“, um

die Einstellungen zu speichern und das Dialogfeld zu schlieBen. Der Querbalken Sprache oder der
Eingabemethoden-Editors (IME) werden in der Taskleiste Ihres Computers angezeigt.

11) Offnen Sie FrameMaker und geben Sie die gewiinschten Inhalte ein. Der Text wird in der
ausgewahlten Sprache angezeigt.

HINWEIS: Wenn Sie die Sprache in der Liste der Standardeingabesprachen und auf der Registerkarte
»,Regionale Einstellungen” dndern, wird die in der Sprachenleiste ausgewahlte Sprache automatisch
ebenfalls aktualisiert.

Verwenden von Tastaturanwendungen von Drittanbietern

Unter Windows stehen verschiedene Tastatur-Layout-Programme von Drittanbietern fiir die verschie-
densten Sprachen zur Verfligung. Wenn diese Layouts aktiviert werden, beginnt FrameMaker mit dem
Empfang der Eingaben gemaR der Tastenzuweisungen der Drittanbieter-Software.

FrameMaker andert keine Tastendefinitionen.
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Verwenden der Zeichenpalette

Die Zeichenpalette listet alle Unicode-Zeichen in den drei Zeichensatzen auf.

A
Character Palette
Courier
4 5 6 7 8 A
1

1
1
:

TF-32
D0AS
COPYRIGHT SIGH

Figure 1:  Zeichenpalette

A. Wadhlen Sie die Schrift B. Suchen Sie nach dem Zeichen in der gewahlten Schrift

1)
2)
3)

4)

5)

6)

Platzieren Sie den Cursor an der Stelle, an der Sie das Zeichen im Dokument einfligen moéchten.
Wahlen Sie Datei > Dienstprogramme > Zeichenpalette.

Wahlen Sie die Schrift, welche die Sprache unterstiitzt, in der Sie schreiben. Die Zeichenpalette
zeigt alle Zeichen in der gewahlten Schrift an.

Klicken Sie auf das Feld mit dem Zeichen, das Sie einfligen mochten. Verwenden Sie ggf. den Roll-
balken zur Suche in der Zeichenpalette.

Der Codepunkt jedes Zeichens in UTF-32, UTF-16 und UTF-8 wird unten in der Zeichenpalette ange-
zeigt.

Wenn das im Dokument eingefligte Zeichen nicht lhrer Auswahl entspricht, Gberprifen Sie, dass
die Schrift im Dokument dieselbe wie in der Zeichenpalette ist.

Klicken Sie neben die Zeichenpalette, um sie zu schlieen.

Verwenden der Hex-Eingabepalette

Mit der Hex-Eingabepalette kénnen Sie ein Unicode-Zeichen in Ihr Dokument einfligen, indem Sie den
entsprechenden Codepunkt angeben.
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Figure 2: Hex-Eingabepalette

A. Eingabebereich. B. Anzeigebereich. C. Klicken Sie auf ,,UTF-32“, um die Standardcodierung zu andern.
D. Klicken Sie auf die Pfeile, um die Symbole zu durchsuchen.

1)  Platzieren Sie den Cursor an der Stelle, an der Sie das Zeichen im Dokument einfligen mochten.
2)  Wahlen Sie Datei > Dienstprogramme > Hex-Eingabe, um die Hex-Eingabe-Palette anzuzeigen.

3) Geben Sie die Unicode-Nummer des einzufligenden Zeichens ein. Das entsprechende Zeichen wird
auf der rechten Seite angezeigt.

4)  Klicken Sie auf ,,UTF 32“, um zwischen den Unicode-Zeichensatzen zu wechseln.

5)  Wenn Sie das gewtinschte Zeichen nicht finden konnen, klicken Sie entweder auf die Pfeile, um sie
der Reihe nach zu durchsuchen, oder klicken Sie auf das Zeichen, um die Zeichenpalette anzu-
zeigen.

Vergewissern Sie sich ebenfalls, dass Sie die entsprechende Schrift aus der Zeichenpalette aus-
gewdhlt haben. Das Zeichen mit dem gleichen hexadezimalen Wert dndert sich je nach aus-
gewdhlter Schrift.

6) Klicken Sie neben die Hex-Eingabe, um sie zu schlieRen.
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Unterstitzung flir asiatische Sprachen

Erfahren Sie mehr lber die Unterstiitzung asiatischer Sprachen, Zeichensatze und Codierungsmethoden,
Satzregeln sowie das Exportieren in anderen asiatischen Sprachen in Adobe FrameMaker.

Adobe FrameMaker unterstitzt vereinfachtes Chinesisch, traditionelles Chinesisch und Koreanisch. Sie
kénnen chinesische und koreanische Texte anzeigen, eingeben, drucken, suchen und ersetzen sowie
importieren und exportieren.

Im folgenden Abschnitt werden die Funktionen fiir Chinesisch und Koreanisch genauer beschrieben.

Zeichensatze und Codierungsmethoden

Chinesisch (vereinfacht)

FrameMaker unterstiitzt den GBK-Zeichensatz, der eine Ubermenge des Zeichensatzes GB2312-80 ist.
Die Versionen von Windows-Systemen fiir vereinfachtes Chinesisch unterstiitzen GBK. UNIX und Macin-
tosh unterstiitzen den GB2312-80 Standardzeichensatz. Die Zeichen im GBK-Zeichensatz werden unter
Windows im Codebereich 0x8140 und OxFEFE kodiert. Die Zeichen auf Macintosh und UNIX sind mit
O0xA1A1 und OxFEFE kodiert. Da die Zeichen zwischen 0xA1A1 und OxFEFE auf allen Plattformen identisch
sind, sind Dokumente auf allen Plattformen kompatibel. Wenn Sie jedoch die erweiterten Zeichen in GBK
verwenden, werden sie als bedeutungslose Zeichen auf Macintosh und UNIX angezeigt.

Chinesisch (traditionell)

FrameMaker unterstiitzt den Big5-Zeichensatz. Diese Zeichen werden innerhalb von 0xA140 und OxFEFE
unter Windows und Macintosh kodiert. Chinesische UNIX unterstiitzt einen groReren Zeichensatz
(CNS11643-1992) in sieben Code-Ebenen. Die ersten zwei Codeebenen schlieRen dieselben Zeichen wie
im Big5-Zeichensatz ein, obwohl die Codezuordnung anders ist. FrameMaker unterstiitzt nur die ersten
zwei Codeebenen auf UNIX. Wenn sie Zeichen in Code-Ebene 3 und dartiber eingeben, werden sie als
Leerzeichen in FrameMaker angezeigt. Die traditionelle Version des UNIX-Betriebssystems verwendet
EUC-CNS-Kodierung. FrameMaker bietet Codekonvertierung zwischen Big5 und EUC-CNS.

Koreanisch

FrameMaker unterstiitzt den KSC 5601-1992-Zeichensatz. Diese Zeichen werden unter Windows, Macin-
tosh und UNIX im Codebereich OxA1A1 und OxFEFE kodiert. Diese Kodierungsmethode ist als
Wansung-Kodierung bekannt. Die meisten Windows-Versionen umfassen zusatzliche Hangul-Zeichen
(Windows-Codeseite 1361), die Johab-Zeichen genannt werden. Da die Johab-Zeichen nicht haufig
verwendet werden und kein Standard sind, unterstiitzen FrameMaker-Produkte diese Zeichen nicht.
Wenn Sie ein Johab-Zeichen eingeben, kann dieses zu zwei bedeutungslosen Einzelbyte-Zeichen werden.

Inlineeingabe

Chinesische und koreanische Zeichensatze enthalten tausende von Zeichen, mehr als die Tasten auf einer
Standardtastatur. Um diese tausenden von Zeichen von einer Standardtastatur einzugeben, miissen Sie
einen Front-End-Prozessor (FEP) verwenden, der auch als Eingabemethoden-Editor (IME) bekannt ist.
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Lateinische Buchstaben werden verwendet, um die phonetische Aussprache zu bilden oder um den
Schriftzug oder das Bild der chinesischen Zeichen zu bilden. Koreanische Zeichen werden normalerweise
inline durch Kombination von grundlegenden Hangul-Bausteinen erstellt, die Jamo genannt werden.
FrameMaker unterstiitzt Inline (sofortige) Eingabemethoden fiir alle Texte. Das bedeutet, dass Sie chine-
sischen oder koreanischen Text direkt in Dokumente oder Dialogfelder eingeben kénnen.

Im Gleichungseditor ist die Inlineeingabemethode nicht verfiigbar. Sie kénnen asiatischen Text mithilfe
der Eingabe in der unteren Zeile oder der Stammfenster-Methoden eingeben. Weitere Informationen
zum Einfligen eines Textstrings in eine Gleichung finden Sie im FrameMaker-Benutzerhandbuch im
Kapitel zu Gleichungen.

Regeln fiir Typeinstellungen

FrameMaker definiert die Regeln fir die Typeinstellung fir chinesische und koreanische Texte in den
Kumihan-Tabellen in der MIF-Datei (siehe MIF-Online-Referenzhandbuch). Die Kumihan-Spezifikation
definiert die Zeilenumbruchsregel und die Regeln fiir den Zeichenzwischenraum fiir japanische Zeichen.
FrameMaker hat ahnliche Regeln fir chinesische und Koreanische Dokumente implementiert.

Asiatische Silbentrennung

Eine Regel zum Verhindern, dass bestimmte Zeichen am Anfang oder Ende einer Zeile stehen, wird
in der Kumihan-Tabelle definiert. Sie konnen die Kumihan-Tabelle definieren, indem Sie die Tabelle
in MIF modifizieren. Weitere Informationen finden Sie im Abschnitt ,Kumihan-Tabelle” im
Online-Handbuch , MIF-Referenz”.

Einrichten von Abstanden fiir asiatische Interpunktionszeichen

Die Abstandseinstellungen fur asiatische Interpunktionszeichen, Klammern etc. sind im Feld fiir die
asiatische Interpunktion in den asiatischen Eigenschaften des Absatzdesigners definiert.

Westliche/Asiatische Wortabstiande und asiatische Zeichenabstiande

Diese Einstellungen kdnnen in den asiatischen Eigenschaften in der , Absatzgestaltung” definiert
werden.

Weitere Details zu Abstands- und Zeichensetzungseinstellungen finden Sie im Framemaker-Benut-
zerhandbuch.

Kombinierte asiatische und westliche Schriftarten

Kombinierte Schriftarten weisen zwei Komponentenschriftarten einem kombinierten Schriftartnamen
zu. Dies wird deshalb so gemacht, um eine asiatische und eine westliche Schriftart so zu verwalten, als
ob sie zu einer Schriftfamilie gehdren wiirden. In einer kombinierten Schriftart ist die asiatische Schriftart
die Grundschriftart und die lateinische die westliche Schriftart. Weitere Details finden Sie im Frame-
maker-Benutzerhandbuch.

. Wenn ein Dokument mit asiatischen Sprachen mit kombinierten Schriftarten auf einem System
geoffnet ist, das eine andere asiatische Sprache oder eine westliche Sprache verwendet, wird die
westliche Komponentenschriftart fiir alle Texte mit der kombinierten Schriftart verwendet. Text,
de die asiatische Komponentenschriftart verwendet hat, wird nicht lesbar. Wenn das Dokument
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dann auf einem System mit seiner Originalsprache gespeichert und erneut gedffnet wird, wird der
westliche Text richtig angezeigt, aber die Informationen zum asiatischen Originaltext gehen
verloren.

. Wenn Sie lhre Dokumente fiir andere asiatische Sprachen nutzen wollen, diirfen Sie keine asiat-
ischen Zeichen flr Absatz- und Zeichenstile und kombinierte Schriftartnamen verwenden. Sollten
Sie dies tun, kdnnen Daten unerwartet verloren gehen.

. Beim Erstellen eines neuen Dokuments werden zwei kombinierte Schriftarten im neuen Dokument
vordefiniert. Die Namen der kombinierten Schriftarten lauten FMMyungjo und FMGothic fir Kore-
anisch, FMSongTi und FMHeiTi fiir vereinfachtes Chinesisch und FMSungTi und FMHeiTi fir tradi-
tionelles Chinesisch. Die am meisten verwendeten lateinischen und asiatischen Schriftarten
werden als Komponentenschriftarten fir jede kombinierte Schriftart verwendet.

Datums- und Uhrzeit

Es werden keine bestimmten Bausteine flir Datums- und Uhrzeitvariablen bereitgestellt. Namen von
Tagen und Vor- bzw. Nachmittag werden auf Chinesisch und Koreanisch angezeigt.

Einheiten flr Jahr, Monat, Tag, Stunde und Minute werden in eine Standardvorlage libertragen. Weitere
Informationen zum Anpassen von Einheiten finden Sie im FrameMaker-Benutzerhandbuch im Kapitel zu
Variablen.

Automatische Nummerierung

Alphabetische Zeichen mit normaler Breite (westliche Alphabete, die asiatische Schriftarten mit
normaler Breite verwenden), arabische Ziffern und chinesische Ziffern werden fiir Nummern eines Absa-
tzes, Seitenzahlen und FuBnotenzahlen wie folgt angezeigt:

. <full-width a> zeigt alphabetische Zeichen als Kleinbuchstaben mit normaler Breite.
. <full-width A> zeigt alphabetische Zeichen als GroRbuchstaben mit normaler Breite.
. <full-width n> zeigt arabische Ziffern mit normaler Breite.

. <chinese n> zeigt chinesische Zahlen.

Indexsortierung

Chinesisch (vereinfacht)

Indexsortierung fir vereinfachtes Chinesisch basiert auf der Pinyin-Methode fiir die Rechtschreibung von
chinesischen Zeichen mithilfe von westlichen Alphabetzeichen. Diese phonetische methode basiert auf
Mandarin. Es gibt fast 400 Pinyin-Téne. Vier Tonmarkierungen kénnen Uber sechs Vokale platziert
werden. Die Tonmarkierungen kdnnen auch durch Zahlen 1, 2, 3 und 4 angezeigt werden.

Im Folgenden sind Beispiele von Pinyin-Sortierung aufgefihrt.

Chinesische Wortsortierung Pinyin mit Akzentzeichen Pinyin mit Zahlen

] linbié lin2bie2

372



UNTERSTUTZUNG FUR ASIATISCHE SPRACHEN

Chinesische Wortsortierung Pinyin mit Akzentzeichen Pinyin mit Zahlen
e linzhong lin2zhong1l
F 4h lingwai lingdwaid

FrameMaker-Produkte weisen jedem chinesischen Zeichen die am haufigsten verwendeten Pinyin-Laute
zu. Wenn die Zuweisung falsch ist, kdbnnen Sie die richtige Pinyin definieren, indem Sie sie in Klammern
nach dem chinesischen Zeichen im Indexmarkentext einschliefen. Sie miissen Zahlen verwenden, um die
Tonmarkierungen darzustellen, wie in folgendem Beispiel gezeigt wird:

[hang2lied]
151

Das neue Indexschlisselwort <$pinyin> wird zum Absatz SortOrderIX auf der Referenzseite IX
hinzugefligt. Die Sortierreihenfolge kann nicht noch einmal definiert werden.

Gruppentitel fir Indexeintrage werden im Absatz GroupTitlesIX auf der Referenzseite IX definiert.
In Dokumenten mit vereinfachtem Chinesisch sind die Standardgruppentitel dieselben wie in westeu-
ropadischen Sprachdokumenten: Symbole, Ziffern und die Buchstaben von A bis Z.

Chinesisch (traditionell)

Die Strich-Radikal-Sortiermethode wird fiir die Indexsortierung fir traditionelles Chinesisch in
FrameMaker verwendet. Mit dieser Methode wird die Anzahl von Strichen als primares Kriterium
verwendet und der Typ von Radikal wird als sekundarer Sortierungsschliissel verwendet. Die Sortierrei-
henfolge von Radikalen basiert auf dem Kangxi-Radikal-Diagramm.

Das neue Indexschlisselwort <$stroke> wird zum Absatz SortOrderIX auf der Referenzseite IX
hinzugefligt. Die Sortierreihenfolge kann nicht noch einmal definiert werden.

Gruppentitel fir Indexeintrage werden im Absatz GroupTitlesIX auf der Referenzseite IX definiert.
In Dokumenten mit traditionellem Chinesisch lauten die Standardgruppentitel wir folgt:

Symbols[\ ];Numerics([0];A;B;C;D;E;F;6;H;I,J;K;L t;N;0;P;Q;R;S;T;U;7,7,X;
Y;Z,—@-—@=anaiasd i \@hdtd 2 +-@ =@ tnd tEa -t o,
+d@ AR =@ o+—#  =+-@  o+=@  o+mE  SHAaEE

Koreanisch

Koreanisch verwendet Hangul-Zeichen (phonetische Zeichen) und Hanja-Zeichen (chinesische Zeichen).
Ein Hangul-Zeichen ist eine einzelne Silbe, die durch Kombination von Anfangskonsonanten, einem
mittleren Vokal und manchmal einem Endkonsonanten erstellt wurde. Die Sortierung basiert auf diesen
Elementen in der Reihenfolge, in der sie auftreten.

Die Sortierreihenfolge von Hangul-Konsonanten lautet wie folgt:

TT NMUAEC T EVAHUECSEOHMUO L L0OATXRFIEDS

Die Sortierreihenfolge fiir Hangul-Vokale lautet wie folgt:
FRYRiRt =< d=rrddlrdr—-]
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Die Sortierreihenfolge fiir Hanja-Zeichen hangt von der Aussprache ab. Um die Sortierung von
Hanja-Zeichen anzugeben, fligen Sie Hangul-Zeichen, eingeschlossen in Klammern nach den
Hanja-Zeichen im Indexmarkierungstext ein, wie im folgenden Beispiel dargestellt:

@E (T3]

Gruppentitel fir Indexeintrage werden im Absatz GroupTitlesIX auf der Referenzseite IX definiert. In
koreanischen Dokumenten lauten die Standardgruppentitel wir folgt:

Syehols [V ] Wemerdcs[0] A R,C 0 E F & B T J/EL MR 0P0;R; 8,710,703,
¥2:T L ERiD WiLi0% kD E R e

Das neue Indexschlisselwort <$hangul> wird automatisch zum Absatz SortOrderIX auf der
Referenzseite IX hinzugefiigt, wenn der Index erstellt wird. Sie kénnen eine eigene Sortierreihenfolge fir
Hangul-Zeichen angeben, indem Sie <$hangul> durch tatsachliche Zeichen in der von Ihnen gewiin-
schten Reihenfolge ersetzen.

Asiatische Sprachen

Europaische Zeichen mit Akzent und Symbole kdnnen nicht mit chinesischen oder koreanischen Zeichen
verwendet werden, da dieselben Codewerte fiir die Anzeige von Multibyte-Zeichen verwendet werden.

Weitere Informationen zu Indexerstellung finden Sie im FrameMaker-Handbuch im Kapitel zu Inhalten
und Index.

Exportieren von chinesischen, koreanischen oder japanischen Dokumenten in HTML
oder XML

Die Zeichencodierung fir den Export von HTML oder XML wird durch die Einstellungen Exportcodierung
und CSS-Exportcodierung in der HTML-Optionstabelle auf der HTML- oder XML-Referenzseite
bestimmt. Dazu sollten beide Optionen dieselben Einstellungen haben. Weitere Informationen zum
Verwenden von asiatischen und westeuropdischen Sprachen in XML-Funktionen finden Sie im
FrameMaker-Handbuch im Kapitel zum Arbeiten mit strukturierten Dokumenten.

Die Standardkodierungseinstellungen lauten:
. Japanisch: Shift_JIS

. Koreanisch: EUC-KR

] Vereinfachtes Chinesisch: EUC-CN

J Traditionelles Chinesisch: Big5

. Andere Sprachen: UTF-8

Zusatzlich zu den Standardcodierungen kdénnen Sie andere Codierungen wie 1ISO-8859-1 (fiir westeu-
ropaische Sprachsysteme) oder UTF-8 (fur Unicode) festlegen.

Die HTML-Optionstabelle ermoglicht auch die Codierung von Namen, die in FrameMaker werden
(EUC-CNS fir traditionelles Chinesich, GB fiir vereinfachtes Chinesisch), strukturiertem FrameMaker
(JIS8_EUC fiir Japanisch, GB8 EUC fir vereinfachtes Chinesisch, KSC8 EUC fiir Koreanisch), und lasst
MIME-Zeichensatzattribute zu (EUC-JP fir Japanisch, EUC-TW fir traditionelles Chinesisch).

Die Standardvorlagen fiir Japanisch erstellen ein CSS mit japanischen Elementnamen, die von einigen
alteren Browsern moglicherweise nicht erkannt werden. Um dieses Problem zu |6sen, speichern Sie die
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Datei mit der Standardcodierung Shift_JIS anstatt mit UTF-8. Verwenden Sie nach Moéglichkeit lateinische
Buchstaben fiir die Stilnamen und die Namen japanischer Schriftarten. Wenn Sie chinesische und kore-
anische Vorlagen modifizieren und Stilnamen mit chinesischen oder koreanischen Schriftzeichen
verwenden, tritt dasselbe Problem auf. Um dieses Problem zu I6sen, gehen Sie genauso vor wie fiir Japa-
nisch und verwenden Sie die entsprechende Standardcodierung.

Im Allgemeinen werden Dateinamen mit Multibyte-Zeichen nicht fir HTML- und XML-Dateien unter-
stutzt.

Strukturierter FrameMaker

Sie konnen chinesische und koreanische SGML- und XML-Dateien mithilfe des strukturierten Frame-
Makers importieren und exportieren. Geben Sie Folgendes an:

. Multibyte-Zeichen sind nicht zuldssig in Attribut- und Elementnamen.

. Multibyte-Zeichen in Variablennamen werden moglicherweise nicht ordnungsgemal in eine
Entitat in SGML und XML konvertiert.

Weitere Informationen finden Sie im FrameMaker-Handbuch im Kapitel zum Arbeiten mit strukturierten
Dokumenten.

MIF-Anweisung und Schliisselworter

Um die Codierung anzugeben, die beim Schreiben von MIF-Anweisungen auf chinesischen und korean-
ischen Systemen verwendet wurde, anzugeben, wird am Anfang von chinesischen und koreanischen
MIF-Dateien eine MIF-Codierungsanweisung hinzugeflgt:

. Auf chinesischen Systemen gibt die Anweisung entweder traditionelle oder vereinfachte
Kodierungen an:

<MIFEncoding ??> #urspriinglich geschrieben in traditionellem
Chinesisch (Big5/EUC-TW)

oder
<MIFEncoding ??> #urspriinglich geschrieben in vereinfachtem Chinesisch

Die beiden chinesischen Zeichen in der Anweisung bedeuten ,,Chinesisch”. Die hexadezimale An-
zeige fiir diese zwei Zeichen lautet A4A4 A4E5 in Big5, C4E3 C5F3 in EUC-TW und D6DO0 CEC4 in
EUC-CN.

. In koreanischen Systemen lautet die Anweisung:
<MIFEncoding ???> #urspriinglich geschrieben als Koreanisch

Die drei koreanischen Zeichen in der Anweisung bedeuten ,,Koreanisch”. Ihre hexadezimale Anzeige
lautet C7D1 B1B9 BEEE. Auf chinesischen und koreanischen Systemen werden vier MIF-Schliissel-
worter verwendet, um den Nummerierungsstil von automatisch nummerierten Formaten anzuge-
ben.

. <FWLCAlpha> zeigt (westliche) alphabetische Zeichen als Kleinbuchstaben mit normaler Breite.
. <FWUCAlpha> zeigt alphabetische Zeichen als GroRbuchstaben mit normaler Breite.
. <FWArabic> zeigt arabische Ziffern mit normaler Breite.
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. <ChineseNumeric> zeigt chinesische Zahlen.

Informationen zu den entsprechenden Bausteinen finden Sie unter Automatische Nummerierung.

Weitere Hinweise

HINWEIS: Rubi ist ein japanisches System fiir die Darstellung der Aussprache von Wortern als ein String
phonetischer Zeichen, direkt (iber dem entsprechenden Wort. Diese Funktion ist verfligbar, obwohl sie
nur selten in chinesischen und koreanischen Texten verwendet wird.

HiNnweEIS: Wenn Sie ein neues chinesisches oder koreanisches Dokument erstellen, oder eine chinesische
oder koreanische Textdatei mithilfe des Befehl Datei > Offnen erstellen, werden die Einstellungen fiir
Schriftart und Sprache ordnungsgemal fir Chinesisch und Koreanisch definiert. Aus dieser Datei gener-
ierte Dokumente (z. B. Document-Vergleich, Index, Inhaltsverzeichnis, SGML-Fehlerprotokollbericht)
verwenden jedoch lateinische Buchstaben und zeigen asiatische Zeichen maoglicherweise nicht
ordnungsgemadR an. Um dieses Problem zu |6sen, andern Sie die lateinischen Buchstaben der Schriften
in asiatische Schriftzeichen, wenn das generierte Dokument bearbeitbar ist.

HiNweEls: Wenn das Quelldokument kombinierte Schriftarten verwendet, diirfen Sie keine Querverweise
mit Texten, die typografische Anflihrungszeichen beinhalten, einfligen. Die Anfiihrungszeichen werden
zu bedeutungslosen Zeichen und FrameMaker stiirzt moglicherweise ab, wenn Sie die Funktion
,Suchen/Andern“ verwenden, um nach einem Querverweis mit typografischen Anfiihrungszeichen in
einer kombinierten Schriftart zu suchen.
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Irreguldre Formate

Erfahren Sie mehr Gber irreguldre Formate in FrameMaker.

Irregulare Formate

Textformatierungsinformationen fiir ein Dokument kénnen aus Formatregeln in Elementdefinitionen
sowie aus vordefinierten Katalogformaten stammen. Es ist in einem Dokument moglich, fiir beide Infor-
mationsquellen irregulare Formate zu verwenden.

Irreguldre Formatregeln

Eine irregulédre Formatzuweisung ist eine Abweichung von den Formatregeln eines Textelements.
Wenn die Regeln beispielsweise einen Absatzstil fiir ein Element festlegen und Sie ein anderes
Format anwenden oder wenn die Regeln fiir einen Text Fettformatierung definieren und Sie den
Text in kursiv formatieren, tGiberschreiben Sie die Formatregeln des Elements.

Irregulare Formate

Ein irreguldrer Stil ist eine Abweichung von einem Katalogstil fiir einen Text oder eine Tabelle.
Beispielsweise kann ein Absatzstil die Schriftfamilie Times festlegen. Wenn Sie einige Textteile, die
dieses Format verwenden, in die Schriftart Palatino andern (ohne die Anderung im Format zu
andern), verwenden Sie ein irreguldres Format. Formatregeln verwenden haufig einige Katalogfor-
mate und zusatzlich einige irreguldre Formate, um zahlreiche Formatierungsvariationen zu erre-
ichen.

Sie sollten in lhren strukturierten Dokumenten im Allgemeinen die Verwendung irreguldrer Formate
vermeiden. Lassen Sie die Formatierung von lhrem Dokument automatisch erledigen und ziehen Sie
Ihren Anwendungsentwickler zu Rate, wenn Sie Formatierungseigenschaften andern mochten.

Wenn sich in lhrem Dokument irreguldre Formate befinden, kdnnen Sie diese alle gleichzeitig beim
Importieren und Aktualisieren aus dem gesamten Dokument entfernen.

WIcHTIG: Wenn Sie beide Typen von irreguldaren Formaten aus einem Dokument entfernen missen,
importieren Sie die Formate und entfernen Sie die Spezialformate zuerst. Dann importieren Sie die
Elementdefinitionen und entfernen die irreguldaren Formatzuweisungen. Das Entfernen der irregularen
Formatzuweisungen an letzter Stelle stellt sicher, dass die Elemente weiter ihren Formatregeln entspre-
chen.

Suchen und Entfernen irreguldrer Formate

Sie kdnnen mit der Option ,,Suchen” auf Absatz-, Zeichen und Tabellenformatebene nach irreguldren
Formaten suchen und diese entfernen.

1)  Waihlen Sie Bearbeiten > Suchen.

2)  Wahlen Sie in der Dropdown-Liste Suchen einen irregularen Stil fiir Absatz, Zeichen oder Tabelle
aus.

3)  Wiéhlen Sie in der Dropdown-Liste Andern die Option Irregulidres Format entfernen.
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4)  Klicken Sie auf Suchen.
5)  Klicken Sie fiir jede Instanz des irreguldren Formats auf Andern, um es zu entfernen.

RELATED LINKS:
Importieren von Formatierungseigenschaften

Importieren von Formaten in Buchdateien
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Tabellen

Erfahren Sie, wie Sie in Adobe FrameMaker mit Tabellen arbeiten.
Tabellen bieten eine organisierte und strukturierte Moglichkeit, Ihre Inhalte zu prasentieren.

In FrameMaker kdnnen Sie Tabellen aus den vordefinierten Tabellenformaten erstellen oder eigene
benutzerdefinierte Formate erstellen.
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Tabellenstile

Erfahren Sie mehr lber die verschiedenen Tabellenstile in Adobe FrameMaker und die Eigenschaften der
Tabellengestaltung.

Tabellenstile enthalten Einstellungen zum Aussehen der Tabelle. Zum Erstellen einer Tabelle muss die
Formatierung der Tabelle definiert werden, z. B. Randbreite, Schattierung, Kopfzeile, Tabelle und Titel.

Das Format einer Tabelle bestimmt ihre Darstellung. Zum Format gehoren folgende Eigenschaftstypen:

. Eigenschaften im Fenster ,Tabellengestaltung”, z. B. Tabellenposition, Zellenrander, Lineatur,
Schattierung und Titel.

. Drei Arten von Standardeigenschaften:
- Anzahl Text-, Uberschriften- und FuRRzeilen
- Anzahl der Spalten
- Absatzstile fiir Titel, Uberschrift, FuRzeile und Textzellen jeder Spalte

Diese Einstellungen werden beim ersten Einfiigen einer Tabelle verwendet. Anderungen an den
Standardeigenschaften wirken sich nicht auf bereits vorhandene Tabellen aus, die dieses Format
verwenden, beeinflussen jedoch neue, leere Tabellen, die Sie einfiigen.

Eine neue Tabelle wird immer ausgehend von den Stilen erstellt, die im Dokument vorhanden sind.
Ahnlich wie Absatz- und Zeichenstile sind Tabellenstile der Ausgangspunkt fiir neue Tabellen sowie
Bausteine fiir neue Tabellenformate. Nach dem Einfligen einer Tabelle konnen Sie spezielle Formatein-
stellungen vornehmen, z. B. das Verbinden oder Drehen von Zellen oder das Anwenden einer speziellen
Lineatur bzw. Schattierung fur ausgewdhlte Zellen. Spezielle Formatierungen werden nicht als Teil des
Tabellenstils gespeichert. Daher bleiben Spezialformatierungen erhalten, wenn Sie einen Tabellenstil
andern oder erneut anwenden.

Tiep: Klicken Sie mit der rechten Maustaste auf eine Tabelle, um ein Kontextmen fur Tabellen zu 6ffnen.
Auch mithilfe der QuickAccess-Leiste kdnnen Sie allgemeine Operationen mit Tabellen durchfihren.

Wenn Sie eine Seite einfligen, ist diese an der Einfligemarke verankert. Ein Tabellen-Ankersymbol | wird
eingeblendet, wenn die Anzeige der Steuerzeichen aktiviert ist.

A —Table 3.1 Perennials

s Plant Bloem Halghtin cm. Colors

Baylily =% Spring  30-150 White, Yellow
¢ Gatser 5= Fall 50-75 Pink, Violet

Dalux =+ Fall 30-45 Blue, Purple
& Plant Bloom Heightinem. Colors

A. Tabellentitel B. Tabellenkopfzeile C. Tabellenhaupttext D. Tabellenfulizeile

RELATED LINKS:
Symbolleisten
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TEXT UND GRAFIKEN IN TABELLEN

Text und Grafiken in Tabellen

Erfahren Sie mehr Gber das Einfligen von Text und Grafiken in Adobe FrameMaker-Tabellen.

Sie kdnnen Text in einer Tabellenzelle genauso formatieren wie Absatze in einer normalen Textspalte,
z. B. mit Absatz- oder Zeichenstilen.

Jede Tabellenzelle kann Text und verankerte Rahmen enthalten. Verankerte Rahmen kénnen wiederum
Grafiken oder andere Tabellen enthalten. Wenn Sie Text eingeben oder einen verankerten Rahmen in
eine Zelle einfligen, wird die Hohe der Zelle entsprechend angepasst.

Sie kdnnen in eine Tabelle nicht nur Text eingeben, sondern auch Querverweise, TabellenfuRnoten, Vari-
ablen und Marken einfiigen. Nur das Tabulatorzeichen muss auf spezielle Weise eingegeben werden.

Sie kénnen den Inhalt von Zellen genau so kopieren, ausschneiden und einsetzen wie Text oder Grafiken
in jedem anderen Teil eines Dokuments. Mithilfe spezieller Systemvariablen kann bei mehrseitigen
Tabellen festgelegt werden, dass der Text im Titel oder in den Kopfzeilen auf der ndchsten Seite wieder-
holt wird.

Wenn im Katalog

Elemente<der Indikator>TEXTangezeigt wird, kénnen Sie in strukturierten Dokumenten Text in der
aktuellen Zelle eingeben. Dariiber hinaus kdnnen Sie gegebenenfalls auch FuRBnoten, Querverweise und
andere textbezogene Elemente in die Zelle eingeben. Verwenden Sie den Elemente-Katalog als Richtlinie.
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Auswahlen von Text oder Zellen in Tabellen

Erfahren Sie, wie Sie Text oder Zellen in Adobe FrameMaker-Tabellen auswahlen.

In diesem Thema

. Platzieren der Einfiigemarke in einer Tabellenzelle
. Auswdihlen des Inhalts einer Zelle

. Einzelne Zellen auswdhlen

. Auswdéhlen mehrerer Zellen

Platzieren der Einfiigemarke in einer Tabellenzelle

Klicken Sie in die Zelle, oder klicken Sie links neben dem Textausschnitt der Zelle in der Strukturansicht.

HINWEIS: Sie konnen die Pfeiltasten verwenden, um zur gewtlinschten Zelle zu wechseln. Sie kénnen die
Pfeiltasten auch verwenden, um in eine und aus einer Tabelle zu wechseln.

Auswdhlen des Inhalts einer Zelle

Klicken Sie in die Zelle, und driicken Sie die Tastenkombination Esctha, oder doppelklicken Sie in der
Strukturansicht auf das Elementrechteck der Zelle. Wenn die Zelle nur einen Absatz enthalt, kbnnen Sie
auch dreimal auf den Zelleninhalt klicken.

Einzelne Zellen auswiahlen

. Dricken Sie die Strg-Taste und klicken Sie auf die Zelle.

. (Strukturierte Dokumente) Ziehen Sie mit der Maus Uber die Zellenbegrenzung und zuriick oder
klicken Sie in der Strukturansicht auf das Zellenelement.

Auswdhlen mehrerer Zellen

o Ziehen Sie die Maus Uber alle Zellen oder klicken Sie auf die erste Zelle und halten Sie die Umschalt-
taste gedrickt, wenn Sie auf die letzte Zelle der Auswahl klicken.

] Driicken Sie zum Auswahlen einer gesamten Zeile die Tastenkombination Escthr, oder ziehen Sie
mit der Maus Uber die Zellen in der Zeile, oder klicken Sie in der Strukturansicht auf das Elemen-
trechteck der Zeile.

Tipp: Wenn Sie in der Strukturansicht zwischen Tabellenteilelemente (z. B. zwischen zwei Zeilen)
klicken, wird die Einfligemarke in der Strukturansicht angezeigt, nicht aber im Dokumentfenster.
Aneinander grenzende Zellen im Dokumentfenster sind in der Strukturansicht nicht unbedingt
benachbarte Elementrechtecke.

. Um eine ganze Spalte auszuwahlen, driicken Sie die Tastenkombination Escthc, oder ziehen Sie den
Mauszeiger von einer Kopfzelle in die erste Textzelle.

o Wenn Sie die ganze Tabelle auswahlen mochten, driicken Sie Esctht.

RELATED LINKS:
Tabellen durchbldttern
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Tabellentitel hinzufiigen oder entfernen

Erfahren Sie, wie Sie in Adobe FrameMaker einen Tabellentitel hinzufligen oder entfernen.

Unter- oder oberhalb der Tabelle wird der Tabellentitel angezeigt, der bei mehrseitigen Tabellen auf
jeder Seite erscheint. Im Tabellenstil ist definiert, ob eine Tabelle einen Titel aufweist und wie dieser
formatiert ist.

Wenn Sie eine Tabelle mit einem Titel einfligen, wird ein leerer Textrahmen fiir den Titel angezeigt. Ist
im Absatzstil fiir den Titel eine automatische Nummerierung definiert, wird der Text der Nummerierung
angezeigt.

Table 3.1 Perennial Blooms
F

bally 2% Soring Baylily -  Spring

Catser == Fall

Gatser Fall

Dalux =+ Summer
Dalux = Summer

Derana Winter
Parunnial Blooms

Derana ~ Winter

Figure 1:  Titel unten zentriert (links), automatisch nummerierter Titel oben linksblindig (rechts)

Die Elementdefinition einer Tabelle in einen strukturierten Dokument gibt mitunter an, ob die Tabelle
einen Titel haben sollte. Ein Titel kann zu jeder Tabelle hinzugefligt werden. Sie sollten jedoch in der
Strukturansicht priifen, ob der Titel in der Tabelle gliltig ist. Das Titelelement stellt stets das erste unter-
geordnete Element einer strukturierten Tabelle dar, unabhangig davon, ob der Titel tiber oder unter der
Tabelle erscheint.

Gehen Sie wie folgt vor, um in Adobe FrameMaker den Abstand zwischen der Tabelle und dem Tabellen-
titel anzugeben:
1)  Klicken Sie in die Tabelle und wahlen Sie Tabelle > Format > Tabellengestaltung.

2)  Wahlen Sie in den Basis-Eigenschaften in der Tabellengestaltung eine Option in der Drop-
down-Liste Titel.

3) Legen Sie im Feld Abstand den Abstand zwischen der Tabelle und dem Titel fest.
4)  Klicken Sie auf Anwenden.

Wenn der Titel automatisch nummeriert wird, erscheint die Nummer (z. B. Tabelle 1) in der Titel-
zelle. Den Text des Titels geben Sie selbst ein.

Tiep: Wenn Sie den Titel nur auf der ersten Seite einer mehrseitigen Tabelle anzeigen méchten, setzen
Sie die Titelposition auf Kein Titel und verwenden einen Textabsatz als Titel. Um zu verhindern, dass der
Titel von der Tabelle getrennt wird, stellen Sie sicher, dass sich das Ankersymbol im Titeltext befindet und
die Eigenschaft Beginn der Tabelle auf Beliebig gesetzt ist.

RELATED LINKS:
Verankerte Rahmen
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Hinzufiigen von Fortsetzungstext zu Tabellen

Erfahren Sie, wie Sie in FrameMaker Fortsetzungstext zu Tabellen hinzufligen, die (ber mehrere Seiten
laufen.

In diesem Thema

L Einflihrung

] Fortsetzungstext in eine ausgewdhlte Tabelle hinzufiigen

. Hinzufiigen von Fortsetzungstext in mehrere Tabellen in einem Dokument

Einfiihrung

Bei einer mehrseitigen Tabelle kdnnen Sie speziellen Fortsetzungstext in den Titel oder in die Kopf- bzw.
FuRzeile aufnehmen. Zu diesem Zweck sind im Dokument u. U. Variablen definiert, z. B. eine Variable, die
(Fortsetzung) anzeigt, oder eine Variable, welche die Seitenzahl der Tabelle angibt.

A B C

. .
Table 3.1 Perennials: Sheet 1of 3
Plant Bloom Colors

Baylily Spring White, Yellow
Tahle 3.1 Perennials: (continued) Sheet 2 of 3

Catser Fall  Pink,

Mani Bloom Colors

Dalux Fall  Blue,

Derana Winter White

A. und C. Variable , Tabellenabschnitt” B. Variable , Tabellenfortsetzung”

Fortsetzungstext in eine ausgewahlte Tabelle hinzufiigen

Gehen Sie wie folgt vor, um einer ausgewahlten mehrseitigen Tabelle in Adobe FrameMaker Fortsetzu-
ngstext hinzuzufigen:

1) Klicken Sie auf der ersten Seite der Tabelle in den Titel oder die Kopf- oder FuRzeile, je nachdem,
wo Sie die Variable oder das Variablenelement einfligen méchten.

2)  Fuhren Sie eine der folgenden Aktionen aus:

- Doppelklicken Sie entweder auf die Variable Tabellenfortsetzung oder auf die Variable
Tabellenabschnitt im Fenster Variablen.

- Wahlen Sie in strukturierten Dokumenten ein Variablenelement fiir Fortsetzungstext im
Katalog Elemente, und klicken Sie auf Einfiigen.

Auf der ersten Seite der Tabelle wird die Variable als geschiitztes Leerzeichen |y angezeigt angezeigt.
Auf den folgenden Seiten wird der Variablentext angezeigt (z. B. , Fortsetzung”).
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Hinzufiigen von Fortsetzungstext in mehrere Tabellen in einem Dokument

Gehen Sie wie folgt vor, um mehreren Tabellen in Adobe FrameMaker Fortsetzungstext hinzuzufiigen:

1) Um eine Variable fiir Tabellenfortsetzung und Tabellenabschnitt in mehrere Tabellen im aktuellen
Dokument einzubeziehen, wahlen Sie Tabelle > Tabellenvariablen einfiigen.

2)  Waihlen Sieim Dialogfeld Tabellenvariablen den Tabellenvariablentyp (Fortsetzung oder Abschnitt),
der eingefiigt werden soll.

Andernfalls wahlen Sie ein Tabellenformat zum Einfligen der Tabellenvariablen in alle Tabellen in dem
aktuellen Dokument des ausgewdhlten Formats.

385



Platzieren von Grafiken in Tabellenzellen

Erfahren Sie, wie Sie Grafiken in Adobe FrameMaker-Tabellenzellen einfligen oder platzieren.

In diesem Thema
. Platzieren einer Grafik
. Platzieren einer Grafik in einen strukturierten Dokument

Platzieren einer Grafik

Sie kdnnen den verankerten Rahmen jederzeit verschieben oder eine Grafik in eine Zelle einfligen, die
bereits Text enthalt.

HINWEIS: Verwenden Sie keine beschnittenen verankerten Rahmen in den Kopf- oder FulRzeilen einer
Tabelle. Diese Rahmen werden moglicherweise nicht beschnitten, wenn die Zelle auf den nachfolgenden
Seiten wiederholt wird.

Gehen Sie wie folgt vor, um in einem Adobe FrameMaker-Dokument eine Grafik in einer Tabellenzelle zu
platzieren:

1) Klicken Sie in einen Absatz der Zelle, in der Sie die Grafik einfligen mochten.

2)  Fihren Sie eine der folgenden Aktionen aus:

- Wenn Sie einen verankerten Rahmen erstellen méchten, in dem Sie zeichnen kénnen, wahlen
Sie Einfligen > Verankerter Rahmen, um einen verankerter Rahmen zu erstellen, der an der
Einfligemarke verankert ist.

- Wenn Sie einen verankerten Rahmen fir eine importierte Grafik erstellen méchten, wahlen
Sie Datei > Datei > importieren oder Bild > einfiigen, um die Grafik zu importieren.

3)  Wenn der verankerte Rahmen breiter als die Zelle ist, passen Sie die Spalte entsprechend an.

Tipp: Zum Anpassen der Spaltenbreite an den Zelleninhalt platzieren Sie die Einfligemarke in der
Zelle mit der gewiinschten Textlange und driicken Esc+t+w.

4)  Wahlen Sie bei Bedarf Grafik > Anordnen > Zentrieren, um die Grafik im Rahmen zu verankern.

Platzieren einer Grafik in einen strukturierten Dokument

Wenn |lhre Tabellenzellen Grafikelemente zulassen, kénnen Sie Grafiken erstellen oder in Zellen impor-
tieren. Ein neues Grafikelement kann entweder ein leerer verankerter Rahmen sein, in dem Sie zeichnen
kénnen, oder ein verankerter Rahmen mit einer importierten Grafik.

Gehen Sie wie folgt vor, um in einem strukturierten Adobe FrameMaker-Dokument eine Grafik in einer
Tabellenzelle zu platzieren:
1)  Klicken Sie an die Stelle, an der Sie die Grafik in der Zelle platzieren méchten.

2)  Wabhlen Sie im Katalog Elemente ein Grafikelement aus, und klicken Sie auf Einfiigen. Die Element-
definition legt fest, welches Dialogfeld angezeigt wird.

3) Fihren Sie eine der folgenden Aktionen aus:

- Wenn das Dialogfeld Verankerter Rahmen angezeigt wird, wahlen Sie in der Dropdown-Liste
Verankerungsposition den Eintrag An der Einfiigemarke, und klicken Sie auf Neuer Rahmen.
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—  Wenndas Dialogfeld Datei importieren angezeigt wird, wahlen Sie die zu importierende Datei
aus und klicken Importieren.

In der Zelle wird ein verankerter Rahmen angezeigt, und ein Elementrechteck mit dem Tex-
tausschnitt <GRAFIK> wird in der Strukturansicht angezeigt.

4)  Wenn der verankerte Rahmen breiter als die Zelle ist, passen Sie die Spalte entsprechend an.

Tipp: Zum Anpassen der Spaltenbreite an den Zelleninhalt wahlen Sie die Spalte aus und driicken
Esc+t+w.

5)  Wahlen Sie bei Bedarf Grafik > Anordnen > Ausrichten, um die Grafik im Rahmen zu zentrieren.
RELATED LINKS:
Verankerte Rahmen

Tabellenzeilen und -spalten
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Konvertieren zwischen Text und Tabellen

Erfahren Sie, wie Sie in Adobe FrameMaker zwischen Text und Tabellen konvertieren.

In diesem Thema

. Einfiihrung

. Konvertieren von Text in eine Tabelle

. Konvertieren einer Textdatei beim Offnen in eine Tabelle

. Konvertieren einer Textdatei beim Importieren in eine Tabelle
. Uberarbeiten einer Tabelle nach dem Import

J Konvertieren einer Tabelle in Text in FrameMaker

L Konvertieren aller Tabellen eines Dokuments in Text

Einfihrung

In Adobe FrameMaker konnen Sie Text, der sich bereits im Dokument befindet, in eine Tabelle konver-
tieren. Sie kdnnen auch Text in einer Textdatei beim Offnen oder Importieren der Datei in eine Tabelle
konvertieren. In einem strukturierten Dokument ist der Text in eine Struktur von Tabellen und Tabellen-
teil-Elementen eingegliedert.

Nach der Konvertierung sollten Sie die Tabelle tiberpriifen und leere Zellen entfernen oder Text wieder
verbinden, der in mehrere Zellen aufgeteilt wurde. In den meisten Fallen kénnen Sie die Tabelle direkt
im Dokument bearbeiten. Wenn Sie jedoch Text konvertiert haben, der durch Referenz importiert
wurde, miissen Sie den Text in der Originaldatei bearbeiten.

In FrameMaker konnen Sie jede Tabelle in Text konvertieren. Sie kdnnen die Tabelle auch als Text in eine
andere Anwendung kopieren. Es kdnnen auch alle Tabellen eines Dokuments gleichzeitig konvertiert
werden.

Wenn Sie in strukturierten Dokumenten Tabellen in Text konvertieren, werden auller den Zellen alle
Tabellen- und Tabellenteil-Elemente ausgegliedert. Wandeln Sie die Zellen in andere Elemente um oder
nehmen Sie andere Veranderungen vor, um die Struktur des Dokuments zu korrigieren.

Konvertieren von Text in eine Tabelle

Gehen Sie wie folgt vor, um in Adobe FrameMaker Text in eine Tabelle zu konvertieren:
1)  Wahlen Sie den zu konvertierenden Text aus.
2)  Wabhlen Sie Tabelle > In Tabelle konvertieren.

3)  Wenn Sie in einem strukturierten Dokument arbeiten, wahlen Sie in der ein Dropdown-Liste
Element-Tag ein Tabellenelement aus.

4)  Wahlen Sie einen Stil fur die Tabelle aus.
5) Solegen Sie fest, wie Absatze konvertiert werden sollen:

- Um Text zu konvertieren, in dem die Informationen durch Tabulatoren getrennt sind, klicken
Sie auf Tabulatoren.
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- Um Text zu konvertieren, in dem die Informationen durch Leerzeichen getrennt sind, klicken
Sie auf Leerzeichen und geben die Mindestanzahl von Leerzeichen an, aus denen eine Zelle
bestehen muss.

- Um Text zu konvertieren, in dem die Informationen durch andere Zeichen getrennt sind,
klicken Sie auf Sonstiges und geben die betreffenden Trennzeichen ein.

- Um jeden Absatz (z. B. bei einer Aufzahlungsliste) in eine eigene Zelle zu konvertieren, klicken
Sie auf Eine Zelle und geben die gewiinschte Spaltenanzahl ein.

6) Geben Sie in das Feld Kopfzeilen die Anzahl der Kopfzeilen fiir die neue Tabelle ein. Wenn die zu
konvertierenden Absatze keine Kopfzeilen enthalten und Sie spater Text in die Kopfzeilen eingeben
mochten, wahlen Sie Kopfzeilen frei lassen.

7)  Klicken Sie auf Konvertieren.

HINWEIS: In einem strukturierten Dokument weist das Tabellenelement moglicherweise einen
vordefinierten Stil auf. Diesen Stil konnen Sie dndern, ohne dass dies als irreguldre Formatzuweisung
betrachtet wird.

HINwEIS: Beim Arbeiten mit strukturierten Dokumenten enthalt die Strukturansicht Elementrechtecke fir
die neuen Elemente. Wenn das Dialogfeld Attribute fiir neues Element angezeigt wird, geben Sie Attribut-
werte fir das Tabellenelement ein, und klicken Sie auf Element einfiigen.

Konvertieren einer Textdatei beim Offnen in eine Tabelle

Gehen Sie wie folgt vor, um in Adobe FrameMaker eine Textdatei in eine Tabelle zu konvertieren:
1)  Wabhlen Sie Datei > Offnen, und wiahlen Sie die Textdatei aus, die Sie 6ffnen mdchten.

2)  Wenn das Dialogfeld Unbekannter Dateityp angezeigt wird, wahlen Sie Text aus, und klicken Sie
dann auf Konvertieren.

3) Klicken Sie auf In Tabelle konvertieren und anschlieRend auf Einlesen.

4) Befolgen Sie die Anweisungen fiir das Konvertieren von Text in eine Tabelle. Beginnen Sie mit
Schritt 3.

Konvertieren einer Textdatei beim Importieren in eine Tabelle

Gehen Sie wie folgt vor, um in Adobe FrameMaker eine Textdatei in eine Tabelle zu konvertieren:
1) Klicken Sie an die Stelle, an der Sie die Datei importieren mochten.

2)  Wahlen Sie Datei > Datei > importieren, und wéahlen Sie die zu importierende Textdatei und die
Importmethode aus.

3) Klicken Sie auf In Tabelle konvertieren und anschlieBend auf Importieren.

4) Befolgen Sie die Anweisungen fiir das Konvertieren von Text in eine Tabelle. Beginnen Sie mit
Schritt 3.

TieP: Wenn Sie eine Textdatei in eine vorhandene Tabelle einlesen mochten, importieren Sie zuerst die
Textdatei und konvertieren sie dann in eine Tabelle. Kopieren Sie anschlieBend die Zeilen und fligen Sie
diese in die vorhandene Tabelle ein.

389



Uberarbeiten einer Tabelle nach dem Import

Gehen Sie wie folgt vor, um Probleme nach dem Konvertieren von Text in eine Tabelle zu beheben:

o Um Text zusammenzufassen, der auf mehrere Zeilen verteilt ist, schneiden Sie ihn aus den unteren
Zellen aus, figen ihn in die obere Zelle ein und I6schen zum Schluss die (iberzahligen Zeilen.

J Sind nach dem Konvertieren Spalten nur halb gefiillt, kopieren Sie den Text, fligen ihn an der
korrekten Position ein und lI6schen die (iberflissigen Spalten.

. Um gravierende Fehler zu beheben, kénnen Sie zum Originaltext zurlickkehren (wéahlen Sie bei
Bedarf Bearbeiten > Riickgdngig machen), bearbeiten den Text (beispielsweise durch Léschen von
Uberzahligen Tabs und Zeilenumbriichen), und konvertieren den Text erneut in eine Tabelle.

Tipp: Um Text in aneinander grenzenden Zellen schnell zusammenzufiigen, wahlen Sie die Zellen aus,
wahlen Sie Tabelle > Verbinden, und wahlen Sie dann Tabelle > Trennen. Dann kdnnen Sie leere Zeilen
und Spalten entfernen.

Konvertieren einer Tabelle in Text in FrameMaker

Gehen Sie wie folgt vor, um in Adobe FrameMaker eine Tabelle in Text zu konvertieren:

1)  Klicken Sie in die Tabelle, die Sie in Text konvertieren mochten.

2)  Wabhlen Sie Tabelle > In Absadtze konvertieren.

3)  Aktivieren Sie Zeilenweise oder Spaltenweise und klicken Sie anschliefend auf Konvertieren.

Plant Bloom " 1

; ! Plant Plant
Bﬂﬂ"}‘ Sllflﬂﬂ Bloom Baylily
Baylily Catser
Gatser Fall Spring Dalux
Catser Derana
Dalux Fall Fall Bloom
Dalux Spring
. Fall Fall
UEFEI'IH 'I'l'lﬂtﬁf Derana Fall
Winter Winter

Figure 1:  In Text konvertierte Tabelle

A. Zeilenweise B. Spaltenweise

Konvertieren aller Tabellen eines Dokuments in Text

Speichern Sie das Dokument im Format ,,Nur Text” und geben Sie an, wie die Tabellen konvertiert
werden sollen.

RELATED LINKS:
Verschachteln von Tabellen in Tabellenzellen

Unformatierten Text importieren
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Textfluss um Tabellen

Erfahren Sie, wie Sie in Adobe FrameMaker den Textfluss um eine Tabelle ausrichten.

In diesem Thema

] Einfiihrung

. Textfluss um Tabellen in verankerten Rahmen

J Textfluss um Tabellen in verankerten Rahmen (strukturierte Dokumente)
. Textfluss um Tabellen, deren Position auf der Seite fixiert ist

Einfiihrung

In Adobe FrameMaker werden Tabellen, die direkt in einer Textspalte verankert sind, nicht vom Text
umflossen. Sie konnen jedoch Text um eine Tabelle flieRen lassen, die sich in einem verankerten Rahmen
oder einem vom Haupttextfluss getrennten Textrahmen befindet. Strukturierte Dokumente: Priifen Sie,
ob der Entwickler die Anwendung auf diese Weise eingerichtet hat.

Eine Tabelle in einem verankerten Rahmen bewegt sich zusammen mit dem Text, in dem sie verankert

ist. Eine Tabelle in einem abgetrennten Textrahmen behalt ihre Position auf der Seite bei, wobei anderer
Text um sie herumflieBt. Die Tabelle ist von der automatischen Nummerierung der Tabellen im Haupt-

textfluss ausgenommen.

WicHTIG: Der Inhalt eines verankerten Rahmens oder eines nicht verbundenen Textrahmens in einem
strukturierten Dokument ist nicht Teil des strukturierten Haupttextflusses eines Dokuments. Dieser
Inhalt wird standardmaRig nicht in XML exportiert. Wenn Sie einen Export in XML planen, sprechen Sie
mit dem Anwendungsentwickler, um Datenverluste in einer Tabelle zu vermeiden, die nicht Teil des
Hauptflusses ist.

== E=

llh

Figure 1: Tabelle in einem verankerten Rahmen und in einem nicht mit dem Haupttextfluss verbundenen
Textrahmen

Textfluss um Tabellen in verankerten Rahmen

Gehen Sie wie folgt vor, um in einem Adobe FrameMaker-Dokument den Textfluss um eine Tabelle in
einem verankerten Rahmen einzurichten:

1)  Wabhlen Sie Einfiigen > Verankerter Rahmen, um einen verankerten Rahmen mit der Verankerung-
sposition Im Absatz zu erstellen.

2)  Erstellen Sie im verankerten Rahmen einen Textrahmen und fligen Sie die Tabelle ein.
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Textfluss um Tabellen in verankerten Rahmen (strukturierte Dokumente)

Gehen Sie wie folgt vor, um in einem strukturierten Adobe FrameMaker-Dokument den Textfluss um
eine Tabelle in einem verankerten Rahmen einzurichten:

1)
2)

3)

5)

Klicken Sie an die Stelle im Text, an der die Tabelle verankert werden soll.

Wahlen Sie im Katalog Elemente ein Grafikelement fiir einen leeren verankerten Rahmen, und
klicken Sie auf Einfligen.

Sie kénnen zum Einfiigen eines Elements Einfiigen > Verankerter Rahmen verwenden. Wdhlen Sie
im Fenster Verankerter Rahmen aus der Dropdown-Liste Element-Tag ein Rahmenelement.

Wahlen Sie aus der Dropdown-Liste Verankerungsposition die Option Im Absatz, legen Sie Breite
und Hohe des Rahmens fest und klicken Sie auf Neuer Rahmen. Legen Sie den Rahmen nach
Moglichkeit so fest, dass er etwas groRer als die Tabelle ist.

Zeichnen Sie dazu im verankerten Rahmen einen Textrahmen. Wahlen Sie Ansicht > Symbolleisten
> Grafiksymbolleiste, und klicken Sie auf Textrahmen platzieren=. Zeichnen Sie den Rahmen und
klicken Sie im angezeigten Dialogfeld auf Zuweisen.

Klicken Sie in den Textrahmen und verwenden Sie Tabelle > Tabelle einfiigen, um eine nicht struk-
turierte Tabelle einzufiigen.

Textfluss um Tabellen, deren Position auf der Seite fixiert ist

Gehen Sie wie folgt vor, um in Adobe FrameMaker den Textfluss um eine Tabelle mit fixierter Position
einzurichten:

1)

2)
3)

Zeichnen Sie einen Textrahmen direkt auf einer Seite und ziehen Sie den Rahmen mit der Maus an
die gewiinschte Position. Diese Art von Textrahmen ist nicht mit dem Haupttextfluss verbunden.

Wahlen Sie Grafik > Konturlaufeigenschaften, klicken Sie auf Um Bildrahmen und dann Festlegen.
Flihren Sie eine der folgenden Aktionen aus:
- (Unstrukturierte Dokumente) Fligen Sie eine Tabelle in den Textrahmen ein.

- Klicken Sie bei strukturierten Dokumenten in den Textrahmen und wahlen Tabelle > Tabelle
einfiigen.
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Positionierung und automatische Nummerierung von Text in Tabellenzellen

Erfahren Sie, wie Sie in Adobe FrameMaker Text in Tabellenzellen positionieren und automatisch
nummerieren und wie Sie die Zellrander sowie die Richtung der automatischen Nummerierung
festlegen.

In diesem Thema

. Einflihrung

. Festlegen von Standardrdndern fiir Zellen

. Anpassen von Zellenréindern oder Textausrichtung

. Anpassen von Zellenréndern

o Anpassen der vertikalen Ausrichtung von Text in einer Zelle

. Festlegen der Richtung der automatischen Nummerierung in Tabellen

Einfiihrung

Beim Einfligen einer Tabelle werden die Zellenréinder — der Abstand zwischen den Zellenkanten und dem
Zellentextrahmen — durch den Tabellenstil bestimmt. Die Einstellungen fir den Texteinzug in der Zelle,
der von den Zellenrandern gemessen wird, gehdren zum Absatzstil des Texts.
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Figure 1:  Durch den Tabellenstil definierte Zellenrander

A. Linke Zellenrander B. Linker Absatzeinzug

Festlegen von Standardrandern fiir Zellen

Gehen Sie wie folgt vor, um die Standardzellenrander einer Tabelle in Adobe FrameMaker festzulegen:

1) Klicken Sie in die Tabelle, die Sie andern mochten, und wahlen Sie Tabelle > Format > Tabellenge-
staltung.

2)  Geben Sie in den Basis-Eigenschaften der Tabellengestaltung die Werte fir die oberen, unteren,
linken und rechten Rander im Bereich Standardrand der Zellen ein.

3) Klicken Sie auf Anwenden.
Tiep: Wenn der Text vertikal zentriert werden soll, geben Sie flir den oberen Rand einen groRReren Wert

als fir den unteren Rand ein. Legen Sie flr den oberen Rand z. B. 5 Punkt und fiir den unteren Rand 3
Punkt fest.
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Anpassen von Zellenrandern oder Textausrichtung

Wenn Sie die Zellenrdander oder Textausrichtung andern und der Tabelle spater einen anderen Stil
zuweisen, werden die Anderungen nicht durch die Standardeinstellungen des neuen Tabellenstils (iber-
schrieben.

Zellenrander und Textausrichtung sind Teil des Absatzformats und werden daher normalerweise nicht
zusammen mit dem Stil gespeichert. Die Absatzstile des ersten Titelabsatzes und der ersten Abséatze in
den Kopf-, FuRR- und Standardzeilen der einzelnen Spalten werden jedoch gespeichert. Sie kdnnen die
Ausrichtung dieser Absdtze anpassen und den Tabellenstil dann im Katalog speichern. Alle anschlieBend
erstellten Tabellen dieses Tabellenstils weisen diese Einstellungen als Standardwerte auf.

Anpassen von Zellenrandern

Gehen Sie wie folgt vor, um die Zellenrander einer Tabelle in Adobe FrameMaker anzupassen:
1) Klicken Sie in den ersten Absatz der Zelle, deren Rand Sie dndern mochten.

2)  Wahlen Sie Format > Absdtze > Absatzgestaltung, um die Absatzgestaltung anzuzeigen.
3) Wahlen Sie in der Dropdown-Liste Eigenschaften den Eintrag Zelle.

4)  Geben Sie im Bereich Zellenrand die zu dndernden Randeinstellungen an, indem Sie eine der
folgenden Aktionen ausfiihren:

- Um einen Rand relativ zum Standardzellenrand zu erstellen, wahlen Sie in der Drop-
down-Liste den Eintrag Von Tabellenformat, plus und geben einen Wert ein.

- Um einen festen, ab der Zellenkante gemessenen Rand zu erzeugen, wahlen Sie in der Drop-
down-Liste den Eintrag Spezial und geben einen Wert ein.

5) Klicken Sie auf Anwenden.

Anpassen der vertikalen Ausrichtung von Text in einer Zelle

Gehen Sie wie folgt vor, um die vertikale Ausrichtung von Text in einer Tabellenzelle in Adobe
FrameMaker anzupassen:

1) Klicken Sie in die zu dndernde Zelle.
2)  Waihlen Sie Format > Absatze > Absatzgestaltung, um die Absatzgestaltung anzuzeigen.

3)  Wabhlen Sie in der Dropdown-Liste Eigenschaften den Eintrag Zelle Zelle. Wahlen Sie dann in der
Dropdown-Liste Vertikale Zellenausrichtung die Option Oben, Mitte oder Unten.

4)  Klicken Sie auf Anwenden.

HINwWEIS: Die vertikale Ausrichtung einer Zelle bleibt erhalten, auch wenn Sie in der Tabellengestaltung
ein anderes Tabellenformat anwenden.

Festlegen der Richtung der automatischen Nummerierung in Tabellen

Beim Einfligen einer neuen Tabelle wird die Richtung der automatischen Nummerierung in Zellen (nach
Zeilen oder Spalten) durch das Tabellenformat bestimmt. Diese Einstellung legt auch die Richtung der
automatischen Nummerierung fir TabellenfuRnoten fest.
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Gehen Sie folgendermalien vor, um in Adobe FrameMaker die Richtung der automatischen
Nummerierung in einer Tabelle anzugeben:

1) Klicken Sie in die Tabelle, die Sie andern mochten, und wahlen Sie Tabelle > Format > Tabellenge-
staltung.

2)  Wahlen Sie in den Basis-Eigenschaften der Tabellengestaltung in der Dropdown-Liste
Nummerierung die Option Zeilenweise oder Spaltenweise.

3) Klicken Sie auf Anwenden.
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Andern der Textrichtung in einer Tabelle

Erfahren Sie, wie Sie die Textrichtung in einer Adobe FrameMaker-Tabelle dndern.

StandardmaRig wird fiir den Text in einer Tabelle die Richtung (links nach rechts, LNR, oder rechts nach
links, RNL) des aktuellen Dokuments Glbernommen. Sie kdnnen jedoch die Richtung jeder Tabelle in
einem Dokument dndern.

Gehen Sie wie folgt vor, um die Richtung einer Tabelle in Adobe FrameMaker zu andern:

1)  Klicken Sie in die Tabelle.

2)  Wahlen Sie Tabelle > Format > Tabellengestaltung, und wechseln Sie zur Registerkarte Richtung.
3)  Wahlen Sie in der Dropdown-Liste Richtung die Richtung aus.

4)  Um die Richtung des Textes in der ausgewahlten Tabelle zu dndern, klicken Sie auf Anwenden.

Sie kénnen auch die Richtung des Textes in allen Tabellen des aktuellen Tabellenformats dndern.
Widhlen Sie dazu Stil aktualisieren.
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FORMATIEREN VON TABELLEN

Formatieren von Tabellen

Erfahren Sie, wie Sie in FrameMaker Tabellen mit der Tabellengestaltung und dem Tabellenformatkat-
alog formatieren kénnen.

Auf die Tabellengestaltung und den Tabellenkatalog kann Uber Tabelle > Format und Ansicht > Fenster
zugegriffen werden.

Auf zusatzliche Befehle zum Formatieren und Arbeiten mit Tabellen kann aus dem Menii Tabelle zuge-
griffen werden.

Weitere Informationen zum Formatieren von Tabellen finden Sie in den Unterthemen.
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Tabellengestaltung

Erfahren Sie, wie Sie in Adobe FrameMaker Tabellen formatieren und lernen Sie die Tabellengestaltung
kennen.

Mithilfe des Dialogfelds , Tabellengestaltung” und der Befehle des Meniis , Tabelle” kénnen Sie das
Erscheinungsbild von Tabellen dndern, neue Tabellenformate erstellen und Formate global in einem
Dokument andern.

In diesem Thema

. Einfiihrung

J Arbeiten mit der Tabellengestaltung

o Zuriicksetzen von Eigenschaften nach Anderungen im Fenster , Tabellengestaltung”

Einfihrung

Mithilfe der Tabellengestaltung kénnen Sie Einzug, Zellenrander, Abstand, Ausrichtung, Lineatur und
Schattierung einer Tabelle andern Sie kdnnen auch Titelposition, Nummerierung und Anfangsposition
der Tabelle anpassen. Der Abstand lGber und unter einer Tabelle, ihre Ausrichtung sowie der Einzug
werden durch das Tabellenformat bestimmt. Sie kdnnen andere Positionierungseigenschaften wie
Verbindung und Konturlauf tabellenspezifisch steuern.

Das Fenster , Tabellengestaltung” enthalt mehrere Befehle, mit denen Sie Tabellenformate erstellen,
andern und Uberschreiben kénnen. Das Dialogfeld enthdlt mehrere Einstellungsgruppen, die jeweils
einzeln angezeigt werden. In der Abbildung sehen Sie die Basiseinstellungen.

Arbeiten mit der Tabellengestaltung

Um die Tabellengestaltung anzuzeigen, wahlen Sie Tabelle > Format > Tabellengestaltung oder Ansicht
> Fenster > Tabellengestaltung.
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Figure 1: Tabellengestaltung

Grundeinstellungen
Absatzeigenschaften wie Einzug, Abstand und Ausrichtung.

Lineatur

Lineatureigenschaften fiir Kopfzeilen, FuRzeilen, Trennzeichen und Zeilen.

Schattierung
Schattierungseigenschaften fir Kopfzeilen, FuRzeilen und Text.

Richtung

Geben Sie fiir die Richtung des Tabellentextes Folgendes an: , Beibehalten”, Ubernehmen (Stan-
dard), von rechts nach links und von links nach rechts.

Im Tabellenfeld Stil der Tabellengestaltung wahlen Sie ein Tabellenformat und dann eine Eigenschaften-
gruppe aus. In der unteren Halfte der Tabellengestaltung kénnen Sie die Eigenschaften der Tabelle
dndern. Nachdem Sie Anderungen vorgenommen haben, klicken Sie auf Anwenden, um das Aussehen
der Tabelle zu &ndern. Stimmen die durchgefiihrten Anderungen nicht mit einem der vordefinierten
Formate (iberein, werden sie als irregulares Format behandelt.

Wenn Sie im Fenster ,Tabellengestaltung” Formatanderungen durchfiihren, die nicht mit einem
vordefinierten Tabellenformat tibereinstimmen, handelt es sich um ein irreguldres Format. Wenn Sie
das vordefinierte Format wieder auf die Tabelle anwenden, gehen irreguldre Formate verloren.
Anderungen, die tiber Befehle des Meniis , Tabelle” erfolgt sind, gehen nicht verloren.
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Klicken Sie auf Alle anwenden, um die Definition des Tabellenformats zu &ndern und das Aussehen aller
Tabellen, die dieses Format verwenden, global zu andern.

Um alle irreguldaren Formate aus einer Tabelle zu entfernen, setzen Sie den Cursor in die Tabelle und
klicken Sie im Tabellenformatkatalog auf das gewlinschte Tabellenformat.

HiNwEIs: Sie miissen nur dann auf Stil aktualisieren klicken, wenn Sie eine globale Anderung durchfiihren
mochten, um das Tabellenformat und damit alle Tabellen im Dokument mit diesem Format zu dndern.
Verwenden Sie Stil aktualisieren mit Vorsicht, da diese Option die Definition eines Formats andert.

Zuriicksetzen von Eigenschaften nach Anderungen im Fenster ,Tabellengestaltung”

] Um die Eigenschaften auf die Werte der aktuellen Tabelle zuriickzusetzen (einschlieRlich aller irreg-
uldren Formate), klicken Sie in die Tabelle, oder klicken Sie im Popup Befehle der Tabellengestal-
tung auf Fenster auf die Auswahl zuriicksetzen.

. Um die Eigenschaften auf die Werte des gespeicherten Tabellenformats zurlickzusetzen, wahlen
Sie im Popup Befehle der Tabellengestaltung die Option Alle Eigenschaften auf die Standardein-
stellungen setzen, oder wahlen Sie das Format erneut in der Tabellen-Dropdownliste Stil aus.
Flihren Sie diese Aktion auch dann durch, wenn das Format bereits im Feld Stil angezeigt wird.

RELATED LINKS:
Verwalten von Formaten
Formatkatalog

Tabellenposition und Abstinde
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Tabellenformatkatalog

Erfahren Sie, wie Sie in Adobe FrameMaker ein Tabellenformat mit dem Tabellenformatkatalog
anwenden oder andern.

Der Tabellenformatkatalog funktioniert genauso wie der Absatzformat- oder der Zeichenformatkatalog.
Gehen Sie wie folgt vor, um einen Tabellenstil anzuwenden oder zu dndern:

. Wahlen Sie Tabelle > Format > Tabellenformatkatalog, um den Tabellenformatkatalog zu 6ffnen.

o Platzieren Sie den Cursor in einer Tabelle oder wahlen Sie eine oder mehrere Zellen einer Tabelle
aus.

. Klicken Sie im Katalog auf den gewtinschten Stil.

Der Stil wird jetzt auf die Tabelle angewendet.
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Erstellen, Bearbeiten und Loschen von Tabellenstilen

Erfahren Sie, wie Sie in Adobe FrameMaker Tabellenstile erstellen, bearbeiten und 16schen.

In diesem Thema

. Einfiihrung

. Erstellen eines Tabellenstils

. Bearbeiten eines Tabellenstils

. Léschen eines Tabellenstils

] Zuweisen eines anderen Stils zu einer Tabelle

. Zuweisen eines Stils zu mehreren Tabellen

J Neudefinieren von Tabellenstilen

. Andern von Eigenschaften in mehreren Tabellenstilen

Einfiihrung

Sie konnen bei der Vorlagengestaltung Tabellenstile umbenennen oder |6schen. Sie kénnen Tabellenstile
auch umbenennen, wenn Sie einen vollstandigen Katalog aus einer Vorlage kopieren méchten und ein
Stil nicht tGberschrieben werden soll.

Das Loschen eines Stils aus einem Katalog wirkt sich nicht auf Tabellen mit diesem Stil aus; diese Tabellen
weisen einfach einen Stil auf, der nicht im Katalog gespeichert ist. Wenn Sie den Stil dieser Tabellen
andern mochten, konnen Sie ihnen einen anderen Stil zuweisen.

Erstellen eines Tabellenstils

Gehen Sie wie folgt vor, um einen Tabellenstil zu erstellen:

1) Klicken Sie in eine Tabelle, deren Format dem zu erstellenden Format dhnelt. Je ahnlicher das
vorhandene Format dem neuen Format ist, umso weniger Anderungen sind erforderlich.

2)  Richten Sie die Zeilen und Spalten ein, indem Sie, wie erwiinscht, Standard-, Kopf- und FulRzeilen
hinzufligen oder |6schen und Spalten anpassen.

3) Im Fenster ,Tabellengestaltung” lassen sich alle Tabelleneinstellungen andern.

Bei Tabellenstilen miissen alle Eigenschaften angegeben sein. Wenn nicht fiir jede Einstellung ein
Wert angegeben ist, wird eine entsprechende Warnmeldung angezeigt. Andern Sie dann alle auf
Beibehalten gesetzten Einstellungen.

4)  Mithilfe der Absatzgestaltung konnen Sie einen der folgenden Absatzstile erstellen oder dndern,
die als Teil eines Tabellenstils gespeichert sind:

- den Absatzstil des Titelabsatzes

- den ersten Absatz in jeder Zelle der Uberschriftenzeile
- den ersten Absatz in jeder Zelle in den Textzeilen

- den ersten Absatz in jeder Zelle in den FulRzeilen

5)  Wenn die Tabelle Ihren Wiinschen entspricht, geben Sie den Namen des neuen Tabellenstils im
Feld Stile ein.

6) Klicken Sie auf Stil erstellen.
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Bearbeiten eines Tabellenstils

Gehen Sie wie folgt vor, um einen Tabellenstil zu bearbeiten:

1) Klicken Sie in eine Tabelle, deren Format Sie bearbeiten mdchten.

2)  Wahlen Sie in der Tabellengestaltung in der Dropdown-Liste Stil den Stil aus, den Sie dndern
mochten.
Fiihren Sie diesen Schritt unbedingt aus, auch wenn Sie lediglich denselben Stil auswdhlen, der
gerade angezeigt wird. Durch Auswdhlen eines Stils in der Dropdown-Liste wird sichergestellt, dass
die gespeicherten Formateigenschaften angezeigt werden, nicht die irrequldren Formatzuweisun-
gen.

3)  Klicken Sie auf Stil aktualisieren.

Loschen eines Tabellenstils

Gehen Sie wie folgt vor, um einen Tabellenstil zu [6schen:
1)  Klicken Sie im Tabellenformatkatalog auf Loschen.

2)  Wahlen Sie in der Auswabhlliste den gewlinschten Stil aus und klicken Sie auf Loschen. Wenn Sie
mochten, konnen Sie weitere Stile [6schen.

3) Klicken Sie auf ,,OK“.

Zuweisen eines anderen Stils zu einer Tabelle

Wenn Sie einen anderen Tabellenstil zuweisen, andern sich in der Tabelle nur die Eigenschaften, die dem
Tabellenstil zugewiesen sind. Das heil’t, keine der in der Tabelle vorgenommenen speziellen Einstel-
lungen (z. B. Spaltenbreiten, Anzahl der Zeilen und Spalten oder Einstellungen aus dem Meni , Tabelle®)
sind davon betroffen.

Durch den Stil fur ein Tabellenelement wird ein bestimmtes Tabellenformat vorgeschlagen. Sie kénnen
jedoch beim Einfligen der Tabelle oder zu einem spateren Zeitpunkt einen anderen Stil zuweisen, ohne
dass diese Anderung als irreguldre Formatzuweisung gilt. (Wenn Sie irregulire Formatzuweisungen aus
dem Dokument entfernen, wird die Tabelle nicht auf das urspriingliche Format zurilickgesetzt.) Wenn ein
strukturiertes Dokument keinen Stil aufweist, der Ihren Anforderungen entspricht, muss der Entwickler
der strukturierten Anwendung einen Stil neu definieren oder einen neuen Stil erstellen.

WIcHTIG: Wenn ein neuer Tabellenstil der Tabelle einen Titel hinzufligt, die Regeln fiir den Tabelleninhalt
dies aber nicht zulassen, ist der Titel unguiltig.

Table 1; Ligiing Condltons
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Figure 1: Tabelle mit altem (links) und neuem (rechts) Stil; gedrehte Zellen werden beibehalten

1) Klicken Sie in die Tabelle.

2)  Waihlen Sie Tabelle > Format > Tabellengestaltung.

3)  Wabhlen Sie aus der Dropdown-Liste Stil den gewtlinschten Stil aus und klicken Sie auf Zuweisen.

Zuweisen eines Stils zu mehreren Tabellen

Sie konnen allen Tabellen im Dokument, allen Tabellen mit einem anderen Stil als der Auswahl oder allen
Tabellen eines bestimmten Stils einen Stil zuweisen. Zum Beispiel kdnnen Sie allen Tabellen Format B
Zzuweisen, die derzeit Format A aufweisen.

1)  Fidhren Sie eine der folgenden Aktionen aus, um eine Tabelle auszuwahlen:
- Um allen Tabellen im Dokument einen Stil zuzuweisen, klicken Sie in eine beliebige Tabelle.

- Um einigen, aber nicht allen Tabellen einen Stil zuzuweisen, wahlen Sie aufeinander folgende
Tabellen oder Tabellenelemente im Dokument aus. Um mehrere Tabellen auszuwéhlen,
missen Sie deren Ankersymbole auswahlen.

2)  Wahlen Sie Tabelle > Format > Tabellengestaltung.

3)  Wabhlen Sie aus der Dropdown-Liste Stil den gewtinschten Stil aus und wahlen Sie aus der Drop-
down-Liste Befehle den Befehl Optionen fiir globale Aktualisierung.

4)  Wahlen Sie die neu zu formatierenden Tabellen aus, indem Sie eine der folgenden Aktionen
ausfiihren:

- Um allen Tabellen im Dokument ein neues Tag zuzuweisen, klicken Sie auf Alle Tabellen und
Katalogeintrage.

- Um den Tabellen in der Auswahl und allen Tabellen mit dem gleichen Stil ein neues Tag zuzu-
weisen, klicken Sie auf Alle entsprechenden Tags in Auswabhl.

— Um allen Tabellen mit einem bestimmten Stil ein neues Tag zuzuweisen, wahlen Sie in der
Dropdown-Liste Alle des Tags einen Stil aus.

5) Klicken Sie im Bereich Einstellungen der Tabellengestaltung verwenden auf Alle Einstellungen und
dann auf Aktualisieren.

Neudefinieren von Tabellenstilen

Um einen Tabellenstil zu andern, andern Sie die Eigenschaften einer Tabelle und anschliefend den
entsprechenden Stil.

Die Einstellungen, die auf den Stil angewendet werden, umfassen neben den im Fenster Tabellengestal-
tung angegebenen Einstellungen auch die Standardeinstellungen, die nicht in der Tabellengestaltung
festgelegt werden, z. B. die Standardabsatzformate.

Die im Fenster Tabellengestaltung festgelegten Einstellungen (aber nicht die Standardeinstellungen, die
nichtin der Tabellengestaltung gedndert werden) werden zudem fiir vorhandene Tabellen im Dokument
verwendet, die denselben Typ aufweisen.

Tier: Wenn Sie in der Tabellengestaltung Eigenschaften d@ndern und den Stil dann nicht aktualisieren
mochten, konnen Sie den Vorgang abbrechen und die Eigenschaften zurlicksetzen, indem Sie einfach in
den Text klicken.
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Gehen Sie wie folgt vor, um einen Tabellenstil neu zu definieren:

1) Klicken Sie in eine Tabelle, deren Format Sie neu definieren mochten, und wahlen Sie Tabelle >
Format > Tabellengestaltung. Wenn die Tabelle, in die Sie geklickt haben, irregulare Formatzuweis-
ungen enthalt, werden diese in der Tabellengestaltung angezeigt.

2) Soll das gednderte Format auf einem Stil basieren (ohne irreguldare Formatzuweisungen), wahlen
Sie den Stil in der Dropdown-Liste Stil aus, auch wenn der gewlinschte Stil bereits im Feld Tabellen-
stil angezeigt wird.

3)  Fihren Sie eine der folgenden Aktionen durch:

- Verwenden Sie die Tabellengestaltung, um die Einstellungen fir die Eigenschaften Basis,
Lineatur oder Schattierung zu dndern.

- Andern Sie die gewiinschten Standardeinstellungen. z. B. die Anzahl der Zeilen und Spalten,
die Spaltenbreite und den Absatzstil des Titels sowie des jeweils ersten Absatzes einer Spalte.
Diese Einstellungen werden beim ersten Einfligen einer leeren Tabelle verwendet.

4)  Klicken Sie auf Stil aktualisieren. Wenn eine der aktualisierten Tabellen irregulare Formate
aufweist, werden Sie in einem Meldungsfenster gefragt, ob diese entfernt werden sollen.

Andern von Eigenschaften in mehreren Tabellenstilen

Sie kdnnen bestimmte Eigenschaften in mehreren Tabellenstilen gleichzeitig andern. Sie kdnnen z. B. alle
Tabellenstile von zentriert zu linksbindig dndern.
Gehen Sie wie folgt vor, um Eigenschaften in mehreren Tabellenstilen zu andern:

1)  WahlenSie die Tabellen aus, deren Stile Sie neu definieren méchten, indem Sie einen der folgenden
Schritte ausfiihren:

- Um einen oder alle Tabellenstile im Dokument neu zu definieren, klicken Sie in eine beliebige
Tabelle.

— Um einige, aber nicht alle Tabellenstile im Dokument neu zu definieren, wahlen Sie aufein-
ander folgende Tabellen aus, deren Stile Sie neu definieren méchten. (Um mehrere Tabellen
auszuwahlen, wahlen Sie deren Ankersymbole aus.)

2)  Zeigen Sie in der Tabellengestaltung die Gruppe der Eigenschaften an, aus der Sie eine oder zwei
Eigenschaften anwenden wollen.

3) Instrukturierten Dokumenten I6schen Sie den Namen des Stils aus dem Feld Tabellenstil, wenn das
Feld nicht leer ist. Durch Léschen des Stils wird das Feld auf Beibehalten gesetzt. Dadurch wird
verhindert, dass FrameMaker den Stil der zu aktualisierenden Formate andert.

4)  Andern Sie die Einstellungen wie gewiinscht.
5)  Wabhlen Sie Optionen fiir globale Aktualisierung aus der Dropdown-Liste Befehle.
6) Wabhlen Sie die Tabellenstile, denen Sie die Eigenschaften zuweisen méchten.

7)  Klicken Sie im Bereich Einstellungen der Tabellengestaltung verwenden auf die aktuelle Eigen-
schaftengruppe und dann auf Aktualisieren. Wenn eine der aktualisierten Tabellen irreguldre
Formate aufweist, werden Sie in einem Meldungsfenster gefragt, ob diese entfernt werden sollen.

FrameMaker wendet die Eigenschaften auf die von Ihnen angegebenen Formate im Tabellenformatkat-
alog an und auf alle Tabellen im Dokument mit dem gleichen Stil.
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RELATED LINKS:
Zeilen und Spalten

Tabellenposition und Absténde
Tabellentitel hinzufiigen oder entfernen
Lineatur und Schattierung

Arbeiten mit Tabellen in strukturierten Dokumenten

406



Lineatur und Schattierung in Tabellen

Erfahren Sie, wie Sie in Adobe FrameMaker die Lineatur und Schattierung in Tabellen einrichten.

In diesem Thema

. Einfiihrung

. Einrichten von Lineatur und Schattierung in einem Tabellenstil
. Verwalten von Lineaturstilen fiir Tabellen

. Erstellen oder Andern eines Tabellenlineaturstils

. Léschen eines Tabellenlineaturstils

] Verwalten von spezieller Lineatur und Schattierung in Tabellen

J Anzeigen der aktuellen Lineatur- und Schattierungseinstellungen einer Tabellenzeile, -spalte oder
-zelle

Einfiihrung

Beim Einfligen einer neuen Tabelle werden die Standardeinstellungen fiir Lineatur und Schattierung
durch den Tabellenstil bestimmt. Im Fenster Tabellengestaltung konnen Sie die Lineatur und Schat-
tierung eines Stils fiir einzelne Tabellen dndern, die diesen Stil verwenden.

Benutzerdefinierte Lineatur-/Schattierungseinstellungen sind nicht auf Zeilen oder Spalten beschrankt
und gehoren nicht zum Tabellenstil. Wenn Sie die Lineatur oder Schattierung einer Tabelle andern und
der Tabelle spater einen anderen Stil zuweisen, wird die benutzerdefinierte Lineatur oder Schattierung
dadurch nicht tberschrieben.

Einrichten von Lineatur und Schattierung in einem Tabellenstil

Gehen Sie wie folgt vor, um Lineatur und Schattierung in einem Tabellenstil einzurichten:

1) Klicken Sie in die Tabelle, die Sie &ndern mochten, und wahlen Sie Tabelle > Format > Tabellenge-
staltung.

2) Verwenden Sie eine oder mehrere der folgenden Methoden:

- Legen Sie in den Lineatur-Eigenschaften der Tabellengestaltung die Lineatur fir Spalten,
Standard-, Kopf- und FuBzeilen sowie Umrandungen fest.

- Legen Sie in den Eigenschaften flir Schattierung der Tabellengestaltung die Schattierung-
swerte fur Kopf-, Ful3- und Standardzeilen oder -spalten fest.

3) Klicken Sie auf Anwenden.

Verwalten von Lineaturstilen fur Tabellen

Sie kdnnen weitere Lineaturstile (z. B. doppelte, dicke oder diinne Lineaturen) erstellen und bearbeiten
oder vorhandene Lineaturstile Idschen. Wenn Sie einen Lineaturstil bearbeiten, gelten die Anderungen
sowohl fur die Standardlineatur als auch fiir die spezielle Lineatur, die diesen Stil verwendet.

Tipp: Beim Bearbeiten von Lineaturstilen sollten Sie die Darstellung vergrofRern. Dadurch kénnen Sie
geringfligige Unterschiede in Linienstarken leichter erkennen.
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Erstellen oder Andern eines Tabellenlineaturstils

Gehen Sie wie folgt vor, um den Lineaturstil einer Tabelle zu erstellen oder zu dndern:

1)

Wahlen Sie Tabelle > Benutzerdefinierte Lineatur und Schattierung. Daraufhin wird das Fenster
Lineatur/Schattierung angezeigt:

Custom Ruling and Shading

Custom Cell Ruling:

Apply Ruling Style: To Selection:

Eg’r:g Table Qutside Edge:

_ Top Bottom
Thick Left Right
Thin

Very Thin

Inside Borders:

| Edit Ruiing Style... | | EJRow [/ Column

Custom Cell Shading:

Fill: From Table ~  Color:| Asls ~

Apply Show Current Settings...

Figure 1:  Lineatur/Schattierung — Fenster

2)

3)

Wahlen Sie in der Auswahlliste Lineaturstil einen Stil aus, den Sie bearbeiten mochten. Wenn Sie
einen neuen Stil erstellen moéchten, wahlen Sie den Lineaturstil, der Ihren Vorstellungen am nach-
sten kommt.

Klicken Sie auf Lineaturstil andern. Daraufhin wird das Dialoglogfeld Lineaturstil indern angezeigt:

Edit Ruling Style X

Name: ‘My Ruling Style ‘

Color: Pen Pattern: Width:

B Royal Blue v | 70% ~ | |0,5pt

Number of Lines:

@ Single (O Double--Gap:

Set Delete Cancel
(No Undo)

Figure 2:  Lineaturstil andern — Dialogfeld

4)
5)

6)

Wahlen Sie eine Farbe und ein Muster und 